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Preface

Regression is the study of the conditional distribution Y |x of the response
Y given the p × 1 vector of nontrivial predictors x. In a 1D regression
model, Y is conditionally independent of x given a single linear combination
α+ βTx of the predictors, written

Y x|(α+ βT x) or Y x|βTx.

Many of the most used statistical methods are 1D models, including gen-
eralized linear models such as multiple linear regression, logistic regression,
and Poisson regression. Single index models, response transformation mod-
els and many survival regression models are also included. The class of 1D
models offers a unifying framework for these models, and the models can
be presented compactly by defining the population model in terms of the
sufficient predictor SP = α + βT x and the estimated model in terms of the

estimated sufficient predictor ESP = α̂+ β̂
T
x. In particular, the response

plot or estimated sufficient summary plot of the ESP versus Y is used to
visualize the conditional distribution Y |(α + βT x). The residual plot of the
ESP versus the residuals is used to visualize the conditional distribution of
the residuals given the ESP. The goal of this text is to present the applica-
tions of these models in a manner that is accessible to undergraduate and
beginning graduate students.

Response plots are heavily used in this text. With the response plot the
presentation for the p > 1 case is about the same as the p = 1 case. Hence
the text immediately covers models with p ≥ 1, rather than spending 100
pages on the p = 1 case and then covering multiple regression models with
p ≥ 2.

The literature on multiple linear regression is enormous. See Stigler
(1986) and Harter (1974ab, 1975abc, 1976) for history. Draper (2002) is

vi



Preface vii

a good source for more recent literature. Some texts that were “standard” at
one time include Wright (1884), Johnson (1892), Comstock (1895), Bartlett
(1900), Merriman (1910), Weld (1916), Leland (1921), Ezekial (1930), Ben-
nett and Franklin (1954), Ezekial and Fox (1959) and Brownlee (1965).

Draper and Smith (1966) was a breakthrough because it popularized the
use of residual plots, making the earlier texts obsolete. Excellent texts in-
clude Chatterjee and Price (1977), Draper and Smith (1998), Fox (2008),
Hamilton (1992), Kutner, Nachtsheim, Neter and Li (2005), Montgomery,
Peck and Vining (2006), Mosteller and Tukey (1977), Ryan (2009), Sheather
(2009) and Weisberg (2005). Cook and Weisberg (1999a) was a breakthrough
because of its use of response plots.

Other texts of interest include Abraham and Ledolter (2006), Harrell
(2006), Pardoe (2006), Mickey, Dunn and Clark (2004), Cohen, Cohen, West
and Aiken (2003), Kleinbaum, Kupper, Muller and Nizam (1997), Menden-
hall and Sinich (2003), Vittinghoff, Glidden, Shiblski and McCulloch (2005)
and Berk (2003).

The author’s hope is that this text’s use of the response plot will make
other regression texts obsolete much as Draper and Smith (1966) made earlier
texts obsolete by using residual plots. The response plot is much more impor-
tant than a residual plot since 1D regression is the study of the Y |(α+βTx),
and the response plot is used to visualize this conditional distribution. The
response plot emphasizes model goodness of fit and can be used to comple-
ment or even replace goodness of fit tests, while the residual plot of the ESP
versus the residuals emphasizes model lack of fit. In this text the response
plot is used to explain multiple linear regression, logistic regression, Poisson
regression, single index models and models for experimental design. The re-
sponse plot can also be used to explain and complement the ANOVA F and
deviance tests for β = 0.

This text provides an introduction to several of the most used 1D regres-
sion models. Chapter 1 reviews the material to be covered in the text and
can be skimmed and then referred to as needed. Concepts such as interpre-
tation of coefficients and interactions, goodness and lack of fit diagnostics,
and variable selection are all presented in terms of the SP and ESP. The next
few chapters present the multiple linear regression model. Then the one and
two way ANOVA, logistic and Poisson regression models are easy to learn.
Generalized linear models, single index models and general 1D models are
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also presented. Several important survival regression models are 1D models,
but the sliced survival plot is used instead of the response plot to visualize
the model.

The text also uses recent literature to provide answers to the following
important questions.

• How can the conditional distribution Y |(α + βT x) be visualized?

• How can α and β be estimated?

• How can variable selection be performed efficiently?

• How can Y be predicted?

• What happens if a parametric 1D model is unknown or misspecified?

The author’s research on 1D regression models includes visualizing the
models, outlier detection, and extending least squares software, originally
meant for multiple linear regression, to 1D models. Some of the applications
in this text using this research are listed below.

• It is shown how to use the response plot to detect outliers and to
assess the adequacy of linear models for multiple linear regression and
experimental design.

• It is shown how to use the response plot to detect outliers and to assess
the adequacy of very general regression models of the form
Y = m(x) + e.

• A graphical method for selecting a response transformation for linear
models is given. Linear models include multiple linear regression and
many experimental design models.

• A graphical method for assessing variable selection for the multiple
linear regression model is described. It is shown that for submodels
I with k predictors, the widely used screen Cp(I) ≤ k is too narrow.
More good submodels are considered if the screen Cp(I) ≤ min(2k, p)
is used.
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• Fast methods of variable selection for multiple linear regression, includ-
ing an all subsets method, are extended to the 1D regression model.
Plots for comparing a submodel with the full model after performing
variable selection are also given.

• It is shown that least squares partial F tests, originally meant for mul-
tiple linear regression, are useful for exploratory purposes for a much
larger class of 1D regression models.

• Asymptotically optimal prediction intervals for a future response Yf are
given for general regression models of the form Y = m(x) + e where
the errors are iid, unimodal and independent of x.

• Rules of thumb for selecting predictor transformations are given.

• The DD plot is a graphical diagnostic for whether the predictor distri-
bution is multivariate normal or from some other elliptically contoured
distribution. The DD plot is also useful for detecting outliers in the
predictors.

• Graphical aids, including plots for overdispersion, for binomial regres-
sion models such as logistic regression are given.

• Graphical aids, including plots for overdispersion, for Poisson regression
models such as loglinear regression are given.

• Graphical aids for survival regression models, including the Cox pro-
portional hazards regression model and Weibull regression model, are
given.

• Throughout the book there are goodness of fit and lack of fit plots for
examining the model. The response plot is especially important.

The website (www.math.siu.edu/olive/regbk.htm) for this book provides
28 data sets for Arc, and 40 R/Splus programs in the file regpack.txt. The stu-
dents should save the data and program files on a disk. Chapter 17 discusses
how to get the data sets and programs into the software, but the commands
below will work for R/Splus.
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Downloading the book’s R/Splus functions regpack.txt into R or
Splus:

Download regpack.txt onto a disk. Enter R and wait for the cursor to
appear. Then go to the File menu and drag down Source R Code. A window
should appear. Navigate the Look in box until it says 3 1/2 Floppy(A:). In
the Files of type box choose All files(*.*) and then select regpack.txt. The
following line should appear in the main R window.

> source("A:/regpack.txt")

If you use Splus, the command

> source("A:/regpack.txt")

will enter the functions into Splus. Creating a special workspace for the
functions may be useful.

Type ls(). The R/Splus functions from regpack.txt should appear. In
R, enter the command q(). A window asking “Save workspace image?” will
appear. Click on No to remove the functions from the computer (clicking on
Yes saves the functions on R, but you have the functions on your disk).

Similarly, to download the text’s R/Splus data sets, save regdata.txt on a
disk and use the following command.

> source("A:/regdata.txt")

This text is an introduction to 1D regression models for undergraduates
and beginning graduate students, and the prerequisites for this text are lin-
ear algebra and a calculus based course in statistics at the level of Hogg and
Craig (1995), Hogg and Tanis (2005), Rice (2006), Wackerly, Mendenhall
and Scheaffer (2008), or Walpole, Myers, Myers and Ye (2002). The student
should be familiar with vectors, matrices, confidence intervals, expectation,
variance, the normal distribution and hypothesis testing. This text may not
be easy reading for nonmathematical students. Lindsey (2004) and Bower-
man and O’Connell (1990) attempt to present regression models to students
who have not had calculus or linear algebra. Also see Kachigan (1982, ch.
3–5) and Allison (1999).
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This text will help prepare the student for the following courses.
1) Categorical data analysis: Agresti (2002, 2007) and Simonoff (2003).
2) Econometrics: see Greene (2007), Judge, Griffiths, Hill, Lütkepohl and

Lee (1985), Kennedy (2008), and Woolridge (2008).
3) Experimental design: see Box, Hunter and Hunter (2005), Cobb (1998),

Kirk (1982), Kuehl (1994), Ledolter and Swersey (2007), Maxwell and De-
laney(2003), Montgomery (2005) and Oehlert (2000).

4) Exploratory data analysis: this text could be used for a course in
exploratory data analysis, but also see Chambers, Cleveland, Kleiner and
Tukey (1983) and Tukey (1977).

5) Generalized linear models: this text could be used for a course in
generalized linear models, but also see Dobson and Barnett (2008), Fahrmeir
and Tutz (2001), Hoffmann (2004), McCullagh and Nelder (1989) and Myers,
Montgomery and Vining (2002).

6) Large sample theory for linear and econometric models: see White
(1984).

7) Least squares signal processing: see Porat (1993).
8) Linear models: see Christensen (2002), Graybill (2000), Rao (1973),

Ravishanker and Dey (2002), Scheffé (1959), Searle (1971) and Seber and
Lee (2003).

9) Logistic regression: see Collett (2003) or Hosmer and Lemeshow (2000).
10) Poisson regression: see Cameron and Trivedi (1998) or Winkelmann

(2008).
11) Numerical linear algebra: see Gentle (1998), Datta (1995), Golub and

Van Loan (1989) or Trefethen and Bau (1997).
12) Regression graphics: see Cook (1998) and Li (2000).
13) Robust statistics: see Olive (2009a).
14) Survival Analysis: see Klein and Moeschberger (2003), Allison (1995),

Collett (2003), or Hosmer, Lemeshow and May (2008).

15) Time Series: see Brockwell and Davis (2002), Chatfield (2003), Cryer
and Chan (2008) and Shumway and Stoffer (2006).

This text does not give much history of regression, but it should be noted
that many of the most important ideas in statistics are due to Fisher, Ney-
man, E.S. Pearson and K. Pearson. For example, David (2006-7) says that
the following terms were due to Fisher: analysis of variance, confounding,
consistency, covariance, degrees of freedom, efficiency, factorial design, in-
formation, information matrix, interaction, level of significance, likelihood,
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location, maximum likelihood, null hypothesis, pivotal quantity, randomiza-
tion, randomized blocks, sampling distribution, scale, statistic, Student’s t,
test of significance and variance.

David (2006-7) says that terms due to Neyman and E.S. Pearson include
alternative hypothesis, composite hypothesis, likelihood ratio, power, power
function, simple hypothesis, size of critical region, test criterion, test of hy-
potheses, type I and type II errors. Neyman also coined the term confidence
interval.

David (2006-7) says that terms due to K. Pearson include bivariate nor-
mal, goodness of fit, multiple regression, nonlinear regression, random sam-
pling, skewness, standard deviation, and weighted least squares.

Acknowledgements
This work has been partially supported by NSF grant DMS 0202922 and

DMS 0600933. Collaborations with Douglas M. Hawkins and R. Dennis
Cook were extremely valuable. I am very grateful to the developers of useful
mathematical and statistical techniques and to the developers of computer
software and hardware. Cook (1998) and Cook and Weisberg (1999a) influ-
enced this book. Teaching material from this text has been invaluable. Some
of the material in this text has been used in two Math 484 multiple linear
regression and experimental design courses, two Math 485 categorical data
courses, a Math 473 survival analysis course, a Math 583 regression graph-
ics course, a Math 583 experimental design course and a Math 583 robust
statistics course. Chapters 1 to 9 were used in a Fall 2009 Math 484 course.



Chapter 1

Introduction

All models are wrong, but some are useful.
Box (1979)

This chapter provides a preview of the book but is presented in a rather
abstract setting and will be much easier to follow after the reading the rest of
the book. The reader may omit this chapter on first reading and refer back
to it as necessary.

In data analysis, an investigator is presented with a problem and data
from some population. The population might be the collection of all possible
outcomes from an experiment while the problem might be predicting a future
value of the response variable Y or summarizing the relationship between Y
and the p×1 vector of predictor variables x. A statistical model is used to
provide a useful approximation to some of the important underlying charac-
teristics of the population which generated the data. Many of the most used
models for 1D regression, defined below, are families of conditional distribu-
tions Y |x = xo indexed by x = xo. A 1D regression model is a parametric
model if the conditional distribution is completely specified except for a fixed
finite number of parameters, otherwise, the 1D model is a semiparametric
model.

Definition 1.1. Regression investigates how the response variable Y
changes with the value of a p×1 vector x of nontrivial predictors. Often this
conditional distribution Y |x is described by a 1D regression model, where Y
is conditionally independent of x given βT x, written

Y x|βT x or Y x|(α+ βTx). (1.1)

1



CHAPTER 1. INTRODUCTION 2

This class of models is very rich. Generalized linear models (GLMs) are
a special case of 1D regression, and an important class of parametric or
semiparametric 1D regression models has the form

Yi = g(α + βT xi, ei) (1.2)

for i = 1, ..., n where g is a bivariate function, β is a p× 1 unknown vector
of parameters, and ei is a random error. Often the errors e1, ..., en are iid
(independent and identically distributed) from a distribution that is known
except for a scale parameter. For example, the ei’s might be iid from a normal
(Gaussian) distribution with mean 0 and unknown standard deviation σ. For
this Gaussian model, estimation of α, β and σ is important for inference and
for predicting a new value of the response variable Yf given a new vector of
predictors xf .

Notation. Often the index i will be suppressed. For example, model
(1.2) could be written as Y = g(α + βTx, e). More accurately, Y |x =
g(α+ βTx, e), but the conditioning on x will often be suppressed.

Many of the most used statistical models are 1D regression models. A
single index model with additive error uses g(α+βTx, e) = m(α+βTx)+ e,
and thus

Y = m(α+ βTx) + e. (1.3)

An important special case is multiple linear regression

Y = α + βT x + e (1.4)

where m is the identity function. The response transformation model uses

g(α+ βTx, e) = t−1(α+ βTx + e) (1.5)

where t−1 is a one to one (typically monotone) function. Hence

t(Y ) = α + βT x + e. (1.6)

Several important survival models have this form. In a 1D binary regres-
sion model, the Y |x are independent Bernoulli[ρ(α+βTx)] random variables
where

P (Y = 1|x) ≡ ρ(α + βTx) = 1 − P (Y = 0|x) (1.7)
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In particular, the logistic regression model uses

ρ(α + βTx) =
exp(α + βT x)

1 + exp(α + βT x)
.

In a 1D Poisson regression model, the Y |x are independent

Poisson[µ(α+ βTx)]

random variables. In particular, the loglinear regression model uses

µ(α+ βTx) = exp(α + βT x). (1.8)

In the literature, the response variable is sometimes called the dependent
variable while the predictor variables are sometimes called carriers, covari-
ates, explanatory variables, or independent variables. The ith case (Yi,x

T
i )

consists of the values of the response variable Yi and the predictor variables
xT

i = (xi,1, ..., xi,p) where p is the number of predictors and i = 1, ..., n. The
sample size n is the number of cases.

Box (1979) warns that “all models are wrong, but some are useful.” For
example the function g or the error distribution could be misspecified. Di-
agnostics are used to check whether model assumptions such as the form of
g and the proposed error distribution are reasonable. Often diagnostics use
residuals ri. If m is known, then the single index model (1.3) uses

ri = Yi −m(α̂+ β̂
T
xi)

where (α̂, β̂) is an estimate of (α,β).

Exploratory data analysis (EDA) can be used to find useful models when
the form of the regression or multivariate model is unknown. For example,
suppose g is a monotone function t−1 :

Y = t−1(α+ βTx + e). (1.9)

Then the transformation

Z = t(Y ) = α + βT x + e (1.10)

follows a multiple linear regression model.
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Definition 1.2: If the 1D model (1.1) holds, then Y x|(a + cβTx)
for any constants a and c �= 0. The quantity a + cβTx is called a sufficient
predictor (SP), and a sufficient summary plot is a plot of any SP versus Y .

An estimated sufficient predictor (ESP) is α̃+ β̃
T
x where β̃ is an estimator

of cβ for some nonzero constant c. An estimated sufficient summary plot
(ESSP) or response plot is a plot of any ESP versus Y .

Assume that the data has been collected and that a 1D regression model
(1.1) has been fitted. Suppose that the sufficient predictor

SP = α+ βTx = α+ βT
RxR + βT

OxO (1.11)

where the r× 1 vector xR consists of the nontrivial predictors in the reduced
model. Then the investigator will often want to check whether the model is
useful and to perform inference. Several things to consider are listed below.

i) Use the response plot (and/or the sufficient summary plot) to explain
the 1D regression model to consulting clients, students or researchers.

ii) Goodness of fit: use the response plot to show that the model provides
a simple, useful approximation for the relationship between the response
variable Y and the nontrivial predictors x. The response plot is used to
visualize the conditional distribution of Y |(α+βT x) when the 1D regression
model holds.

iii) Check for lack of fit of the model (eg with a residual plot of the ESP
versus the residuals).

iv) Check whether Y is independent of x by testing Ho : β = 0, that is,
check whether the nontrivial predictors x are needed in the model.

v) Test Ho : βO = 0, that is, check whether the reduced model can be
used instead of the full model.

vi) Use variable selection to find a good submodel.

vii) Estimate the mean function E(Yi|xi) = µ(xi) = diτ (xi) or estimate
τ (xi) where the di are known constants.

viii) Predict Yi given xi.

The field of statistics known as regression graphics gives useful results
for examining the 1D regression model (1.1) even when it is unknown or
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misspecified. The following sections show that the sufficient summary plot
is useful for explaining the given 1D model while the response plot can often
be used to visualize the conditional distribution of Y |(α + βT x). If there is
only one predictor x, then the plot of x versus Y is both a sufficient summary
plot and a response plot, but generally β is unknown and only a response
plot can be made. In Definition 1.2, since α̃ can be any constant, α̃ = 0 is
often used.

1.1 Multiple Linear Regression

Suppose that the response variable Y is quantitative and that at least one
predictor variable xi is quantitative. Then the multiple linear regression
(MLR) model is often a very useful model. For the MLR model,

Yi = α+xi,1β1+xi,2β2+· · ·+xi,pβp+ei = α+xT
i β+ei = α+βTxi+ei (1.12)

for i = 1, . . . , n. Here Yi is the response variable, xi is a p × 1 vector of
nontrivial predictors, α is an unknown constant, β is a p×1 vector of unknown
coefficients, and ei is a random variable called the error.

The Gaussian or normal MLR model makes the additional assumption
that the errors ei are iid N(0, σ2) random variables. This model can also be
written as Y = α+ βT x + e where e ∼ N(0, σ2), or Y |x ∼ N(α + βT x, σ2)
or Y |x ∼ N(SP, σ2). The normal MLR model is a parametric model since,
given x, the family of conditional distributions is completely specified by the
parameters α, β and σ2. Since Y |SP ∼ N(SP, σ2), the conditional mean
function E(Y |SP ) ≡ M(SP ) = µ(SP ) = SP = α + βT x. The MLR model
is discussed in detail in Chapters 2, 3 and 4.

A sufficient summary plot (SSP) of the sufficient predictor SP = α+βT xi

versus the response variable Yi with the mean function added as a visual aid
can be useful for describing the multiple linear regression model. This plot
can not be used for real data since α and β are unknown. To make Figure 1.1,
the artificial data used n = 100 cases with k = 5 nontrivial predictors. The
data used α = −1, β = (1, 2, 3, 0, 0)T , ei ∼ N(0, 1) and x from a multivariate
normal distribution x ∼ N5(0, I).

In Figure 1.1, notice that the identity line with unit slope and zero in-
tercept corresponds to the mean function since the identity line is the line
Y = SP = α + βTx = µ(SP ) = E(Y |SP ). The vertical deviation of Yi
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from the line is equal to ei = Yi − (α + βT xi). For a given value of SP ,
Yi ∼ N(SP, σ2). For the artificial data, σ2 = 1. Hence if SP = 0 then
Yi ∼ N(0, 1), and if SP = 5 then Yi ∼ N(5, 1). Imagine superimposing the
N(SP, σ2) curve at various values of SP . If all of the curves were shown,
then the plot would resemble a road through a tunnel. For the artificial data,
each Yi is a sample of size 1 from the normal curve with mean α + βT xi.

The estimated sufficient summary plot (ESSP) is a plot of α̂ + β̂
T
xi

versus Yi with the identity line added as a visual aid. For MLR, the ESP =

α̂ + β̂
T
x and the estimated conditional mean function is µ̂(ESP ) = ESP.

The estimated or fitted value of Yi is equal to Ŷi = α̂ + β̂
T
x. Now the

vertical deviation of Yi from the identity line is equal to the residual ri =

Yi − (α̂+ β̂
T
xi). The interpretation of the ESSP is almost the same as that

of the SSP, but now the mean SP is estimated by the estimated sufficient
predictor (ESP). This plot is also called the response plot and is used as
a goodness of fit diagnostic. The residual plot is a plot of the ESP versus
ri and is used as a lack of fit diagnostic. These two plots should be made
immediately after fitting the MLR model and before performing inference.
Figures 1.2 and 1.3 show the response plot and residual plot for the artificial
data.

The response plot is also a useful visual aid for describing the ANOVA
F test (see

∮
2.4) which tests whether β = 0, that is, whether the nontrivial

predictors x are needed in the model. If the predictors are not needed in the
model, then Yi and E(Yi|xi) should be estimated by the sample mean Y . If
the predictors are needed, then Yi and E(Yi|xi) should be estimated by the

ESP Ŷi = α̂+ β̂
T
xi. If the identity line clearly fits the data better than the

horizontal line Y = Y , then the ANOVA F test should have a small pvalue
and reject the null hypothesis Ho that the predictors x are not needed in the
MLR model. Figure 1.2 shows that the identity line fits the data better than
any horizontal line. Figure 1.4 shows the response plot for the artificial data
when only X4 and X5 are used as predictors with the identity line and the
line Y = Y added as visual aids. In this plot the horizontal line fits the data
about as well as the identity line which was expected since Y is independent
of X4 and X5.

It is easy to find data sets where the response plot looks like Figure 1.4,
but the pvalue for the ANOVA F test is very small. In this case, the MLR
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model is statistically significant, but the investigator needs to decide whether
the MLR model is practically significant.

1.2 Logistic Regression

Multiple linear regression is used when the response variable is quantitative,
but for many data sets the response variable is categorical and takes on
two values: 0 or 1. The binary regression model states that Y1, ..., Yn are
independent random variables with

Yi ≡ Yi|xi ∼ binomial(1, ρ(xi)).

The binary logistic regression model is the special case where

P (Y = 1|xi) = 1 − P (Y = 0|xi) = ρ(xi) =
exp(α + βT xi)

1 + exp(α+ βTxi)
. (1.13)

The artificial data set used in the following discussion used α = −1.5
and β = (1, 1, 1, 0, 0)T . Let Ni be the number of cases where Y = i for
i = 0, 1. For the artificial data, N0 = N1 = 100, and hence the total sample
size n = N1 +N0 = 200.

Again a sufficient summary plot (SSP) of the sufficient predictor SP =
α + βT xi versus the response variable Yi with the mean function added as
a visual aid can be useful for describing the logistic regression (LR) model.
The artificial data described above was used because the plot can not be used
for real data since α and β are unknown.

Unlike the SSP for multiple linear regression where the mean function
is always the identity line, the mean function in the SSP for LR can take a
variety of shapes depending on the range of the SP. For the LR SSP, Y |SP ∼
binomial(1,ρ(SP )) where the mean function is

ρ(SP ) =
exp(SP )

1 + exp(SP )
.

If the SP = 0 then Y |SP ∼ binomial(1,0.5). If the SP = −5, then Y |SP ∼
binomial(1,ρ ≈ 0.007) while if the SP = 5, then Y |SP ∼ binomial(1,ρ ≈
0.993). Hence if the range of the SP is in the interval (−∞,−5), then the
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mean function is flat and ρ(SP ) ≈ 0. If the range of the SP is in the interval
(5,∞), then the mean function is again flat but ρ(SP ) ≈ 1. If −5 < SP < 0
then the mean function looks like a slide. If −1 < SP < 1 then the mean
function looks linear. If 0 < SP < 5 then the mean function first increases
rapidly and then less and less rapidly. Finally, if −5 < SP < 5 then the
mean function has the characteristic “ESS” shape shown in Figure 1.5.

The estimated sufficient summary plot (ESSP or ESS plot or response

plot) is a plot of ESP = α̂ + β̂
T
xi versus Yi with the estimated mean

function

ρ̂(ESP ) =
exp(ESP )

1 + exp(ESP )

added as a visual aid. The interpretation of the ESS plot is almost the same
as that of the SSP, but now the SP is estimated by the estimated sufficient
predictor (ESP).

The response plot is very useful as a goodness of fit diagnostic. Divide
the ESP into J “slices” each containing approximately n/J cases. Compute
the sample mean = sample proportion of the Y ’s in each slice and add the
resulting step function to the response plot. This is done in Figure 1.6 with
J = 10 slices. This step function is a simple nonparametric estimator of the
mean function ρ(SP ). If the step function follows the estimated LR mean
function (the logistic curve) closely, then the LR model fits the data well.
The plot of these two curves is a graphical approximation of the goodness of
fit tests described in Hosmer and Lemeshow (2000, p. 147–156).

The deviance test described in Chapter 10 is used to test whether β = 0,
and is the analog of the ANOVA F test for multiple linear regression. If
the LR model is a good approximation to the data but β = 0, then the
predictors x are not needed in the model and ρ̂(xi) ≡ ρ̂ = Y (the usual
univariate estimator of the success proportion) should be used instead of the
LR estimator

ρ̂(xi) =
exp(α̂ + β̂

T
xi)

1 + exp(α̂+ β̂
T
xi)

.

If the logistic curve clearly fits the step function better than the line Y = Y ,
then Ho will be rejected, but if the line Y = Y fits the step function about
as well as the logistic curve (which should only happen if the logistic curve
is linear with a small slope), then Y may be independent of the predictors.
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Figure 1.7: Response Plot When Y Is Independent Of The Predictors

Figure 1.7 shows the response plot when only X4 and X5 are used as predic-
tors for the artificial data, and Y is independent of these two predictors by
construction. It is possible to find data sets that look like Figure 1.7 where
the pvalue for the deviance test is very small. Then the LR relationship
is statistically significant, but the investigator needs to decide whether the
relationship is practically significant.

For binary data the Yi only take two values, 0 and 1, and the residuals do
not behave very well. Thus the response plot is both a goodness of fit plot
and a lack of fit plot. For binomial regression, described in Chapter 10, the
Yi take on values 0, 1, ..., mi, and residual plots may be useful if mi ≥ 5 for
some of the cases.

1.3 Poisson Regression

If the response variable Y is a count, then the Poisson regression model
is often useful. This model states that Y1, ..., Yn are independent random
variables with

Yi ≡ Yi|xi ∼ Poisson(µ(xi)).
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The loglinear regression model is the special case where

µ(xi) = exp(α+ βTxi). (1.14)

A sufficient summary plot (SSP) of the sufficient predictor SP = α+βT xi

versus the response variable Yi with the mean function added as a visual aid
can be useful for describing the loglinear regression (LLR) model. Artificial
data needs to be used because the plot can not be used for real data since
α and β are unknown. The data used in the discussion below had n = 100,
x ∼ N5(1, I/4) and

Yi ∼ Poisson(exp(α+ βTxi))

where α = −2.5 and β = (1, 1, 1, 0, 0)T .
The shape of the mean function µ(SP ) = exp(SP ) for loglinear regression

depends strongly on the range of the SP. The variety of shapes occurs because
the plotting software attempts to fill the vertical axis. If the range of the
SP is narrow, then the exponential function will be rather flat. If the range
of the SP is wide, then the exponential curve will look flat in the left of the
plot but will increase sharply in the right of the plot. Figure 1.8 shows the
SSP for the artificial data. Notice that Y |SP = 0 ∼ Poisson(1). In general,
Y |SP ∼ Poisson(exp(SP)).

The estimated sufficient summary plot (ESSP or response plot) is a plot

of the ESP = α̂ + β̂
T
xi versus Yi with the estimated mean function

µ̂(ESP ) = exp(ESP )

added as a visual aid. The interpretation of the response plot is almost
the same as that of the SSP, but now the SP is estimated by the estimated
sufficient predictor (ESP).

The response plot is very useful as a goodness of fit diagnostic. The lowess
curve is a nonparametric estimator of the mean function called a “scatterplot
smoother.” The lowess curve is represented as a jagged curve to distinguish
it from the estimated LLR mean function (the exponential curve) in Figure
1.9. If the lowess curve follows the exponential curve closely (except possibly
for the largest values of the ESP), then the LLR model fits the data well. A
useful lack of fit plot is a plot of the ESP versus the deviance residuals that
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Figure 1.10: Response Plot when Y is Independent of the Predictors

are often available from the software. Additional plots are given in Chapter
11.

The deviance test described in Chapter 11 is used to test whether β = 0,
and is the analog of the ANOVA F test for multiple linear regression. If
the LLR model is a good approximation to the data but β = 0, then the
predictors x are not needed in the model and µ̂(xi) ≡ µ̂ = Y (the sample
mean) should be used instead of the LLR estimator

µ̂(xi) = exp(α̂+ β̂
T
xi).

If the exponential curve clearly fits the lowess curve better than the line
Y = Y , then Ho should be rejected, but if the line Y = Y fits the lowess
curve about as well as the exponential curve (which should only happen if the
exponential curve is approximately linear with a small slope), then Y may
be independent of the predictors. Figure 1.10 shows the ESSP when only X4

and X5 are used as predictors for the artificial data, and Y is independent of
these two predictors by construction. It is possible to find data sets that look
like Figure 1.10 where the pvalue for the deviance test is very small. Then
the LLR relationship is statistically significant, but the investigator needs to
decide whether the relationship is practically significant.
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1.4 Single Index Models

The single index model with additive error

Y = m(α+ βTx) + e = m(SP ) + e (1.15)

includes the multiple linear regression model as a special case. In the suffi-
cient summary plot of SP = α+βT x versus Y , the plotted points fall about
the curve m(SP ). The vertical deviation from the curve is Y − m(SP ) = e.
If the ei are iidN(0, 1) random variables, then Y |SP ∼ N(m(SP ), σ2). Often
m and/or the distribution of e is unknown, and then the single index model
is a semiparametric model. See Chapter 15.

The response plot of the ESP versus Y can be used to visualize the
conditional distribution Y |SP and to visualize the conditional mean function
E(Y |SP ) ≡ M(SP ) = m(SP ). The response plot can also be used to
check the goodness of fit of the single index model. If m is known, add the
estimated mean function M̂ (x) = m(ESP ) to the plot. Ifm is unknown, add
a nonparametric estimator of the mean function M̂(x) = m̂(ESP ) such as
lowess to the response plot. If the data randomly scatters about the estimated
mean function, then the single index model may be a useful approximation to
the data. The residual plot of the ESP versus the residuals r = Y −m̂(ESP )
should scatter about the horizonal line r = 0 if the errors are iid with mean
zero and constant variance σ2. The response plot can also be used as a
diagnostic for Ho : β = 0. If the estimated mean function m̂(ESP ) fits the
data better than any horizontal line, then Ho should be rejected.

Suppose that the single index model is appropriate and Y x|βTx. Then
Y x|cβT x for any nonzero scalar c. If Y = m(βTx) + e and both m and
β are unknown, then m(βT x) = ha,c(a + cβTx) where

ha,c(w) = m

(
w − a

c

)
for c �= 0. In other words, if m is unknown, we can estimate cβ but we can
not determine c or β; ie, we can only estimate β up to a constant.

A very useful result is that if y = m(x) for some function m, then m can
be visualized with both a plot of x versus y and a plot of cx versus y if c �= 0.
In fact, there are only three possibilities, if c > 0 then the two plots are nearly
identical: except the labels of the horizontal axis change. (The two plots are
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usually not exactly identical since plotting controls to “fill space” depend on
several factors and will change slightly.) If c < 0, then the plot appears to
be flipped about the vertical axis. If c = 0, then m(0) is a constant, and the
plot is basically a dot plot. Similar results hold if Yi = m(α + βTxi) + ei if
the errors ei are small. Ordinary least squares (OLS) often provides a useful
estimator of cβ where c �= 0, but OLS can result in c = 0 if m is symmetric
about the median of α+ βTx.

The software packages Splus (MathSoft 1999ab) and R, the free version of
Splus available from (www.r-project.org/), can be used to generate artificial
single index model data sets. The R/Splus commands

X <- matrix(rnorm(300),nrow=100,ncol=3)

SP <- X%*%1:3

Y <- (SP)^3 + rnorm(100)

were used to generate 100 trivariate Gaussian predictors x ∼ N3(0, I3) and
the response Y = (βTx)3 + e = (x1 + 2x2 + 3x3)

3 + e where e ∼ N(0, 1).
This is a single index model where m is the cubic function, β = (1, 2, 3)T and
α = 0. Figure 1.11 shows the sufficient summary plot of βT x versus Y , and
Figure 1.12 shows the sufficient summary plot of −βT x versus Y . Notice
that the functional form m appears to be cubic in both plots and that both
plots can be smoothed by eye or with a scatterplot smoother such as lowess.
The two figures were generated with the following R/Splus commands.

plot(SP,Y)

plot(-SP,Y)

An amazing result is that the unknown function m can often be visualized
by the response plot called the “OLS view,” a plot of the OLS ESP (the
OLS fit, possibly ignoring the constant) versus Y generated by the following
commands.

bols <- lsfit(X,Y)$coef[-1]

plot(X %*% bols, Y)

The OLS view, shown in Figure 1.13, can be used to visualize m and
for prediction. Note that Y appears to be a cubic function of the OLS ESP
and that if the OLS ESP = 0, then the graph suggests using Ŷ = 0 as the
predicted value for Y . Since the plotted points cluster about a smooth curve
better than any horizontal line, the OLS view suggests that a single index
model is appropriate and that β �= 0.
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Figure 1.13: OLS View for m(u) = u3

1.5 Survival Regression Models

The most important survival regression models are 1D models, and are de-
scribed in detail in Chapter 16. For these models, the conditional survival
function SY |SP (t) = P (Y > t|βTx) = P (Y > t|SP ) and the conditional
hazard function hY |SP (t) are of great interest. Hence the response plot is no
longer of great interest. Instead, the slice survival plot is used to visualize
SY |SP (t).

The Cox proportional hazards regression model (Cox 1972) is a semipara-
metric model with SP = βT

Cx and

hx(t) ≡ hY |SP (t) = exp(βT
Cx)h0(t) = exp(SP )h0(t)

where the baseline hazard function h0(t) is left unspecified. The survival
function is

Sx(t) ≡ SY |SP (t) = [S0(t)]
exp(β

T

Cx) = [S0(t)]
exp(SP )

where S0(t) is the unspecified baseline survival function.
For parametric proportional hazards regression models, the baseline func-

tion is parametric and the parameters are estimated via maximum likelihood.
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Then as a 1D regression model, SP = βT
Px, and

hY |SP (t) ≡ hx(t) = exp(βT
P x)h0,P (t) = exp(SP )h0,P (t)

where the parametric baseline function depends on k unknown parameters
but does not depend on the predictors x. The survival function is

Sx(t) ≡ SY |SP (t) = [S0,P(t)]exp(βT

P x) = [S0,P(t)]exp(SP ),

and

Ŝx(t) = [Ŝ0,P (t)]exp(
ˆβ

T

Px) = [Ŝ0,P(t)]exp(ESP ).

The Weibull regression model is an important special case.

For a parametric accelerated failure time model,

log(Yi) = α+ βT
Axi + σei

where the ei are iid from a location scale family. Let SP = βT
Ax. Then as

a 1D regression model, log(Y )|SP = α+ SP + e. The parameters are again
estimated by maximum likelihood and the survival function is

Sx(t) ≡ SY |x(t) = S0

(
t

exp(βT
Ax)

)
,

and

Ŝx(t) = Ŝ0

(
t

exp(β̂
T

Ax)

)
where Ŝ0(t) depends on α̂ and σ̂.

1.6 Variable Selection

A standard problem in 1D regression is variable selection, also called subset
or model selection. Assume that Y x|(α+ βT x), that a constant is always
included, that x = (x1, ..., xp−1)

T are the p − 1 nontrivial predictors and
that (1,x)T has full rank. Then variable selection is a search for a subset of
predictor variables that can be deleted without important loss of information.
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To clarify ideas, assume that there exists a subset S of predictor variables
such that if xS is in the 1D model, then none of the other predictors are
needed in the model. Write E for these (‘extraneous’) variables not in S,
partitioning x = (xT

S ,x
T
E)T . Then

SP = α+ βTx = α+ βT
SxS + βT

ExE = α + βT
SxS. (1.16)

The extraneous terms that can be eliminated given that the subset S is in
the model have zero coefficients.

Now suppose that I is a candidate subset of predictors, that S ⊆ I and
that O is the set of predictors not in I . Then

SP = α+ βTx = α+ βT
SxS = α + βT

SxS + βT
(I/S)xI/S + 0TxO = α+ βT

I xI ,

where xI/S denotes the predictors in I that are not in S. Since this is true
regardless of the values of the predictors, βO = 0 if S ⊆ I . Hence for any
subset I that includes all relevant predictors, the population correlation

corr(α + βTxi, α + βT
I xI,i) = 1. (1.17)

This observation, which is true regardless of the explanatory power of
the model, suggests that variable selection for 1D regression models is simple
in principle. For each value of j = 1, 2, ..., p− 1 nontrivial predictors, keep
track of subsets I that provide the largest values of corr(ESP,ESP(I)). Any
such subset for which the correlation is high is worth closer investigation
and consideration. To make this advice more specific, use the rule of thumb
that a candidate subset of predictors I is worth considering if the sample
correlation of ESP and ESP(I) satisfies

corr(α̃ + β̃
T
xi, α̃I + β̃

T

I xI,i) = corr(β̃
T
xi, β̃

T

I xI,i) ≥ 0.95. (1.18)

The difficulty with this approach is that fitting large numbers of possible
submodels involves substantial computation. Fortunately, OLS frequently
gives a useful ESP and methods originally meant for multiple linear regression
using the Mallows’ Cp criterion (see Jones 1946 and Mallows 1973) also work
for more general 1D regression models. As a rule of thumb, the OLS ESP is
useful if |corr(OLS ESP, ESP)| ≥ 0.95 where ESP is the standard ESP (eg, for

generalized linear models, the ESP is α̂+ β̂
T
x where (α̂, β̂) is the maximum

likelihood estimator of (α,β)), or if the OLS response plot suggests that the
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OLS ESP is good. Variable selection will be discussed in much greater detail
in Chapters 3, 10, 11, 12, 15 and 16, but the following methods are useful
for a large class of 1D regression models.

Perhaps the simplest method of variable selection is the t directed search
(see Daniel and Wood 1980, p. 100–101). Let k be the number of predictors
in the model, including the constant. Hence k = p for the full model. Let
X1, ..., Xp−1 denote the nontrivial predictor variables and letW1,W2, ...,Wp−1

be the predictor variables in decreasing order of importance. Use theory if
possible, but if no theory is available then fit the full model using OLS and
let ti denote the t statistic for testing Ho : βi = 0. Let |t|(1) ≤ |t|(2) ≤ · · · ≤
|t|(p−1). Then Wi corresponds to the Xj with |t|(p−i) for i = 1, 2, ..., p − 1.
That is, W1 has the largest t statistic, W2 the next largest, etc. Then use
OLS to compute Cp(Ij) for the p− 1 models Ij where Ij contains W1, ...,Wj

and a constant for j = 1, ..., p− 1.

Forward selection starts with a constant = W0.
Step 1) k = 2: compute Cp for all models containing the constant and a
single predictor Xi. Keep the predictor W1 = Xj , say, that corresponds to
the model with the smallest value of Cp.
Step 2) k = 3: Fit all models with k = 3 that contain W0 and W1. Keep the
predictor W2 that minimizes Cp.
Step j) k = j+1: Fit all models with k = j+1 that contains W0,W1, ...,Wj.
Keep the predictor Wj+1 that minimizes Cp.
Step p− 1) k = p: Fit the full model.

Backward elimination starts with the full model. All models contain
a constant = U0. Hence the full model contains U0, X1, ..., Xp−1. We will also
say that the full model contains U0, U1, ..., Up−1 where Ui need not equal Xi

for i ≥ 1.
Step 1) k = p− 1: fit each model with p− 1 predictors including a constant.
Delete the predictor Up−1, say, that corresponds to the model with the small-
est Cp. Keep U0, ..., Up−2.
Step 2) k = p − 2: fit each model with p − 2 predictors including the con-
stant. Delete the predictor Up−2 that corresponds to the smallest Cp. Keep
U0, U1, ..., Up−3.
Step j) k = p− j: fit each model with p− j predictors and a constant. Delete
the predictor Up−j that corresponds to the smallestCp. Keep U0, U1, ..., Up−j−1.
Step p− 2) k = 2: The current model contains U0, U1 and U2. Fit the model
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U0, U1 and the model U0, U2. Assume that model U0, U1 minimizes Cp. Then
delete U2 and keep U0 and U1.
(Step p− 1) which finds Cp for the model that only contains the constant U0

is often omitted.)

All subsets variable selection examines all subsets and keeps track of
several (up to three, say) subsets with the smallest Cp(I) for each group of
submodels containing k predictors including a constant. This method can be
used for p ≤ 30 by using the efficient “leaps and bounds” algorithms when
OLS and Cp is used (see Furnival and Wilson 1974).

Rule of thumb for variable selection (assuming that the cost of each
predictor is the same): find the submodel Im with the minimum Cp. If Im

uses km predictors including a constant, do not use any submodel that has
more than km predictors. Since the minimum Cp submodel often has too
many predictors, also look at the submodel Io with the smallest value of k,
say ko, such that Cp ≤ 2k. This submodel may have too few predictors.
So look at the predictors in Im but not in Io and see if they can be deleted
or not. (If Im = Io, then it is a good candidate for the best submodel.)

Variable selection with the Cp criterion is closely related to the partial
F test for testing whether a reduced model should be used instead of the
full model. The following results are properties of OLS and hold even if the
data does not follow a 1D model. If the candidate model of xI has k terms
(including the constant), then the partial F test for reduced model I uses
test statistic

FI =
SSE(I) − SSE

(n− k) − (n− p)
/
SSE

n − p
=
n− p

p− k

[
SSE(I)

SSE
− 1

]
where SSE is the residual sum of squares from the full model and SSE(I) is
the residual sum of squares from the candidate submodel. Then

Cp(I) =
SSE(I)

MSE
+ 2k − n = (p− k)(FI − 1) + k (1.19)

where MSE is the residual mean square for the full model. Let ESP(I) =

α̂I + β̂
T

I x be the ESP for the submodel and let VI = Y − ESP (I) so that

VI,i = Yi−α̂I+β̂
T

I xi. Let ESP and V denote the corresponding quantities for
the full model. Then Olive and Hawkins (2005) show that corr(VI , V ) → 1
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forces corr(OLS ESP, OLS ESP(I)) → 1 and that

corr(V, VI) =

√
SSE

SSE(I)
=

√
n− p

Cp(I) + n− 2k
=

√
n− p

(p− k)FI + n− p
.

Also Cp(I) ≤ 2k corresponds to corr(VI , V ) ≥ dn where

dn =

√
1 − p

n
.

Notice that the submodel Ik that minimizes Cp(I) also maximizes corr(V, VI)
among all submodels I with k predictors including a constant. If Cp(I) ≤ 2k
and n ≥ 10p, then 0.948 ≤ corr(V, V (I)), and both corr(V, V (I)) → 1.0 and
corr(OLS ESP, OLS ESP(I)) → 1.0 as n→ ∞.

If a 1D model holds, a common assumption made for variable selection is
that the fitted full model ESP is a good estimator of the sufficient predictor,
and the usual graphical and numerical checks on this assumption should be
made. Also assume that the OLS ESP is useful. This assumption can be
checked by making an OLS response plot or by verifying that |corr(OLS
ESP, ESP)| ≥ 0.95. Then we suggest that submodels I are “interesting” if
Cp(I) ≤ min(2k, p).

Suppose that the OLS ESP and the standard ESP are highly correlated:
|corr(ESP,OLS ESP)| ≥ 0.95. Then often OLS variable selection can be used
for the 1D data, and using the pvalues from OLS output seems to be a useful
benchmark. To see this, suppose that n > 5p and first consider the model
Ii that deletes the predictor Xi. Then the model has k = p − 1 predictors
including the constant, and the test statistic is ti where

t2i = FIi.

Using (1.19) and Cp(Ifull) = p, notice that

Cp(Ii) = (p− (p− 1))(t2i − 1) + (p− 1) = t2i − 1 + Cp(Ifull) − 1,

or
Cp(Ii) = Cp(Ifull) + (t2i − 2).

Using the screen Cp(I) ≤ min(2k, p) suggests that the predictor Xi should
not be deleted if

|ti| >
√

2 ≈ 1.414.
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If |ti| <
√

2 then the predictor can probably be deleted since Cp decreases.
More generally, for the partial F test, notice that by (1.19), Cp(I) ≤ 2k

iff (p− k)FI − p+ 2k ≤ 2k iff (p− k)Fi ≤ p iff

FI ≤ p

p− k
.

Now k is the number of terms in the model including a constant while p− k
is the number of terms set to 0. As k → 0, the partial F test will reject Ho
(ie, say that the full model should be used instead of the submodel I) unless
FI is not much larger than 1. If p is very large and p− k is very small, then
the partial F test will tend to suggest that there is a model I that is about
as good as the full model even though model I deletes p− k predictors.

The Cp(I) ≤ k screen tends to overfit. We simulated multiple linear
regression and single index model data sets with p = 8 and n = 50, 100, 1000
and 10000. The true model S satisfied Cp(S) ≤ k for about 60% of the
simulated data sets, but S satisfied Cp(S) ≤ 2k for about 97% of the data
sets.

1.7 Other Issues

The 1D regression models offer a unifying framework for many of the most
used regression models. By writing the model in terms of the sufficient pre-
dictor SP = α + βTx, many important topics valid for all 1D regression
models can be explained compactly. For example, the previous section pre-
sented variable selection, and equation (1.19) can be used to motivate the
test for whether the reduced model can be used instead of the full model.
Similarly, the sufficient predictor can be used to unify the interpretation of
coefficients and to explain models that contain interactions and factors.

Interpretation of Coefficients
One interpretation of the coefficients in a 1D model is that βi is the rate

of change in the SP associated with a unit increase in xi when all other
predictor variables x1, ..., xi−1, xi+1, ..., xp are held fixed. Denote a model by
SP = α+ βTx = α+ β1x1 + · · · + βpxp. Then

βi =
∂ SP

∂xi
for i = 1, ..., p.
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Of course, holding all other variables fixed while changing xi may not be
possible. For example, if x1 = x, x2 = x2 and SP = α+ β1x+ β2x

2, then x2

can not be held fixed when x1 increases by one unit, but

d SP

dx
= β1 + 2β2x.

The interpretation of βi changes with the model in two ways. First,
the interpretation changes as terms are added and deleted from the SP.
Hence the interpretation of β1 differs for models SP = α + β1x1 and SP =
α + β1x1 + β2x2. Secondly, the interpretation changes as the parametric or
semiparametric form of the model changes. For multiple linear regression,
E(Y |SP ) = SP and an increase in one unit of xi increases the conditional
expectation by βi. For binary logistic regression,

E(Y |SP ) = ρ(SP ) =
exp(SP )

1 + exp(SP )
,

and the change in the conditional expectation associated with a one unit
increase in xi is more complex.

Factors for Qualitative Variables
The interpretation of the coefficients also changes if interactions and fac-

tors are present. Suppose a factor W is a qualitative random variable that
takes on c categories a1, ..., ac. Then the 1D model will use c − 1 indicator
variables Wi = 1 if W = ai and Wi = 0 otherwise, where one of the levels ai

is omitted, eg, use i = 1, ..., c− 1.

Interactions
Suppose X1 is quantitative and X2 is qualitative with 2 levels and X2 = 1

for level a2 and X2 = 0 for level a1. Then a first order model with interaction
is SP = α+β1x1+β2x2+β3x1x2. This model yields two unrelated lines in the
sufficient predictor depending on the value of x2: SP = α+ β2 + (β1 + β3)x1

if x2 = 1 and SP = α + β1x1 if x2 = 0. If β3 = 0, then there are two
parallel lines: SP = α + β2 + β1x1 if x2 = 1 and SP = α + β1x1 if x2 = 0.
If β2 = β3 = 0, then the two lines are coincident: SP = α + β1x1 for
both values of x2. If β2 = 0, then the two lines have the same intercept:
SP = α+ (β1 + β3)x1 if x2 = 1 and SP = α + β1x1 if x2 = 0. In general, as
factors have more levels and interactions have more terms, eg x1x2x3x4, the
interpretation of the model rapidly becomes very complex.
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1.8 Complements

To help explain the given 1D model, use the sufficient summary plot (SSP)
of SP = α+βT xi versus Yi with the mean function added as a visual aid. If
p = 1, then Y x|x and the plot of xi versus Yi is a SSP and has been widely
used to explain the simple linear regression (SLR) model and the logistic
regression model with one predictor. See Agresti (2002, cover illustration
and p. 169) and Collett (1999, p. 74). Replacing x by SP has two major
advantages. First, the plot can be made for k ≥ 1 and secondly, the possible
shapes that the plot can take is greatly reduced. For example, in a plot of
xi versus Yi, the plotted points will fall about some line with slope β and
intercept α if the SLR model holds, but in a plot of SP = α + βTxi versus
Yi, the plotted points will fall about the identity line with unit slope and zero
intercept if the multiple linear regression model holds.

Important theoretical results for the single index model were given by
Brillinger (1977, 1983) and Aldrin, Bφlviken and Schweder (1993). Li and
Duan (1989) extended these results to models of the form

Y = g(α+ βTx, e) (1.20)

where g is a bivariate inverse link function. Olive and Hawkins (2005) discuss
variable selection while Chang (2006) and Chang and Olive (2009) discuss
OLS tests. Severini (1998) discusses when OLS output is relevant for the
Gaussian additive error single index model.

1.9 Problems

1.1. Explain why the model Y = g(α + βTx, e) can also be written as
Y = g(α+ xT β, e).



Chapter 2

Multiple Linear Regression

2.1 The MLR Model

Definition 2.1. The response variable is the variable that you want to
predict. The predictor variables are the variables used to predict the
response variable.

Notation. In this text the response variable will usually be denoted by Y
and the p predictor variables will often be denoted by x1, ..., xp. The response
variable is also called the dependent variable while the predictor variables
are also called independent variables, explanatory variables or covariates.
Often the predictor variables will be collected in a vector x. Then xT is the
transpose of x.

Definition 2.2. Regression is the study of the conditional distribution
Y |x of the response variable Y given the vector of predictors x = (x1, ..., xp)

T .

Definition 2.3. A quantitative variable takes on numerical values
while a qualitative variable takes on categorical values.

Example 2.1. Archeologists and crime scene investigators sometimes
want to predict the height of a person from partial skeletal remains. A
model for prediction can be built from nearly complete skeletons or from
living humans, depending on the population of interest (eg ancient Egyptians
or modern US citizens). The response variable Y is height and the predictor
variables might be x1 ≡ 1, x2 = femur length and x3 = ulna length. The

28
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heights of individuals with x2 = 200mm and x3 = 140mm should be shorter
on average than the heights of individuals with x2 = 500mm and x3 =
350mm. In this example Y , x2 and x3 are quantitative variables. If x4 =
gender is a predictor variable, then gender (coded as male = 1 and female =
0) is qualitative.

Definition 2.4. Suppose that the response variable Y and at least one
predictor variable xi are quantitative. Then the multiple linear regression
(MLR) model is

Yi = xi,1β1 + xi,2β2 + · · · + xi,pβp + ei = xT
i β + ei (2.1)

for i = 1, . . . , n. Here n is the sample size and the random variable ei is the
ith error. Suppressing the subscript i, the model is Y = xTβ + e.

In matrix notation, these n equations become

Y = Xβ + e, (2.2)

where Y is an n × 1 vector of dependent variables, X is an n × p matrix
of predictors, β is a p× 1 vector of unknown coefficients, and e is an n × 1
vector of unknown errors. Equivalently,

Y1

Y2
...
Yn

 =


x1,1 x1,2 . . . x1,p

x2,1 x2,2 . . . x2,p
...

...
. . .

...
xn,1 xn,2 . . . xn,p



β1

β2
...
βp

 +


e1

e2
...
en

 . (2.3)

Often the first column of X is X1 = 1, the n × 1 vector of ones. The ith
case (xT

i , Yi) corresponds to the ith row xT
i of X and the ith element of Y .

In the MLR model Y = xT β + e, the Y and e are random variables, but
we only have observed values Yi and xi. If the ei are iid (independent and
identically distributed) with zero mean and variance σ2, then regression is
used to estimate the unknown parameters β and σ2.

Definition 2.5. The iid error MLR model uses the assumption that
the errors e1, ..., en are iid with E(ei) = 0 and VAR(ei) = σ2 < ∞. Also
assume that the errors are independent of the predictor variables xi. The
predictor variables xi are assumed to be fixed and measured without error.
The cases (xT

i , Yi) are independent for i = 1, ..., n.
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If the predictor variables are random variables, then the above MLR
model is conditional on the observed values of the xi. That is, observe the
xi and then act as if the observed xi are fixed.

Definition 2.6. The iid symmetric error MLR model has the same
assumptions as the iid error MLR model but adds the assumption that the
iid errors come from a symmetric distribution.

Definition 2.7. The normal MLR model or Gaussian MLR model has
the same assumptions as the iid error MLR model but adds the assumption
that the errors e1, ..., en are iid N(0, σ2) random variables. That is, the ei

are iid normal random variables with zero mean and variance σ2.

The unknown coefficients for the above 3 models are usually estimated
using (ordinary) least squares.

Notation. The symbol A ≡ B = f(c) means that A and B are equivalent
and equal, and that f(c) is the formula used to compute A and B.

Definition 2.8. Given an estimate b of β, the corresponding vector of
predicted or fitted values is Ŷ ≡ Ŷ (b) = Xb. Thus the ith fitted value

Ŷi ≡ Ŷi(b) = xT
i b = xi,1b1 + · · · + xi,pbp.

The vector of residuals is r ≡ r(b) = Y − Ŷ (b). Thus ith residual ri ≡
ri(b) = Yi − Ŷi(b) = Yi − xi,1b1 − · · · − xi,pbp.

Most regression methods attempt to find an estimate β̂ of β which min-
imizes some criterion function Q(b) of the residuals.

Definition 2.9. The ordinary least squares (OLS) estimator β̂OLS min-
imizes

QOLS(b) =

n∑
i=1

r2
i (b), (2.4)

and β̂OLS = (XT X)−1XTY .

The vector of predicted or fitted values Ŷ OLS = Xβ̂OLS = HY where the
hat matrix H = X(XT X)−1XT provided the inverse exists. Typically the
subscript OLS is omitted, and the least squares regression equation is
Ŷ = β̂1x1 + β̂2x2 + · · ·+ β̂pxp where x1 ≡ 1 if the model contains a constant.
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There are many statistical models besides the MLR model, and you
should learn how to quickly recognize an MLR model. A “regression” model
has a response variable Y and the conditional distribution of Y given the
predictors x = (x1, ..., xp)

T is of interest. Regression models are used to pre-
dict Y and to summarize the relationship between Y and x. If a constant
xi,1 ≡ 1 (this notation means that xi,1 = 1 for i = 1, ..., n) is in the model,
then xi,1 is often called the trivial predictor, and the MLR model is said to
have a constant or intercept. All nonconstant predictors are called nontrivial
predictors. The term “multiple” is used if the model uses one or more non-
trivial predictors. The simple linear regression model is a special case that
uses exactly one nontrivial predictor. Suppose the response variable is Y and
data has been collected on additional variables x1, ..., xp.

An MLR model is “linear” in the unknown coefficients β. Thus the model
is an MLR model in Y and β if we can write Yi = xT

i β + ei or Yi = wT
i β+ ei

where each wi is a function of x1, ..., xp. Symbols other than w or x may be
used. Alternatively, the model is linear in the parameters β if ∂Y/∂βi does
not depend on the parameters. If Y = xTβ + e = x1β1 + · · ·+xpβp + e, then
∂Y/∂βi = xi. Similarly, if Y = wT β + e, then ∂Y/∂βi = wi.

Example 2.2. a) Suppose that interest is in predicting a function of Z
from functions of w1, ..., wk. If Y = t(Z) = xTβ + e where t is a function
and each xi is some function of w1, ..., wk, then there is an MLR model in Y
and β. Similarly, Z = t(Y ) = wTβ + e is an MLR model in Z and β.

b) To see that Y = β1 + β2x + β3x
2 + e is an MLR model in Y and β,

take w1 = 1, w2 = x and w3 = x2. Then Y = wTβ + e.
c) If Y = β1 + β2 exp(β3x) + e, then the model is a nonlinear regression

model that is not an MLR model in Y and β. Notice that the model can
not be written in the form Y = wTβ + e and that ∂Y/∂β2 = exp(β3x) and
∂Y/∂β3 = β2x exp(β3x) depend on the parameters.

2.2 Checking Goodness of Fit

It is crucial to realize that an MLR model is not necessarily a useful
model for the data, even if the data set consists of a response variable and
several predictor variables. For example, a nonlinear regression model or
a much more complicated model may be needed. Let p be the number of
predictors and n the number of cases. Assume that n > 5p, then plots can
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be used to check whether the MLR model is useful for studying the data.
This technique is known as checking the goodness of fit of the MLR model.

Notation. Plots will be used to simplify regression analysis, and in this
text a plot of W versus Z uses W on the horizontal axis and Z on the vertical
axis.

Definition 2.10. A scatterplot of X versus Y is a plot of X versus Y
and is used to visualize the conditional distribution Y |X of Y given X.

Definition 2.11. A response plot is a plot of a variable wi versus Yi.
Typically wi is a linear combination of the predictors: wi = xT

i η where η is
a known p × 1 vector. The most commonly used response plot is a plot of
the fitted values Ŷi versus the response Yi.

Proposition 2.1. Suppose that the regression estimator b of β is used
to find the residuals ri ≡ ri(b) and the fitted values Ŷi ≡ Ŷi(b) = xT

i b. Then

in the response plot of Ŷi versus Yi, the vertical deviations from the identity
line (that has unit slope and zero intercept) are the residuals ri(b).

Proof. The identity line in the response plot is Y = xT b. Hence the
vertical deviation is Yi − xT

i b = ri(b). �

Definition 2.12. A residual plot is a plot of a variable wi versus the
residuals ri. The most commonly used residual plot is a plot of Ŷi versus ri.

Notation: For MLR, “the residual plot” will often mean the residual
plot of Ŷi versus ri, and “the response plot” will often mean the plot of Ŷi

versus Yi.

If the iid error MLR model as estimated by least squares is useful, then
in the response plot the plotted points should scatter about the identity line
while in the residual plot of Ŷ versus r the plotted points should scatter
about the r = 0 line (the horizontal axis) with no other pattern. Figures 1.2
and 1.3 show what a response plot and residual plot look like for an artificial
MLR data set where the MLR regression relationship is rather strong in that
the sample correlation corr(Ŷ , Y ) is near 1. Figure 1.4 shows a response plot
where the response Y is independent of the nontrivial predictors in the model.
Here corr(Ŷ , Y ) is near 0 but the points still scatter about the identity line.
When the MLR relationship is very weak, the response plot will look like
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Figure 1.4.
The above ideal shapes for the response and residual plots are for when

the iid symmetric error MLR model gives a good approximation for the data.
If the plots have the ideal shapes and n ≥ 5p, then expect inference, except
for prediction intervals, to be approximately correct.

If the response and residual plots suggest a MLR model with iid skewed
errors, then add lowess to both plots. The scatterplot smoother tries to
estimate the mean function E(Y |Ŷ ) or E(r|Ŷ ) without using any model.
If the lowess curve is close to the identity line in the response plot and
close to the r = 0 line in the residual plot, then the iid error MLR model
may be a good approximation to the data, but sample sizes much larger
than n = 5p may be needed before inference is approximately correct. Such
skewed data sets seem rather rare, but see Chen, Bengtsson and Ho (2009)
and see Problem 2.27.

Remark 2.1. For any MLR analysis, always make the response
plot and the residual plot of Ŷi versus Yi and ri, respectively.

Definition 2.13. An outlier is an observation that lies far away from
the bulk of the data.

Remark 2.2. For MLR, the response plot is the single most impor-
tant plot that can be made because MLR is the study of the conditional
distribution of Y |xT β, and the response plot is used to visualize the
conditional distribution of Y |xT β since Ŷ = xT β̂ is a good estimator of
xTβ if β̂ is a good estimator of β.

If the MLR model is useful, then the plotted points in the response plot
should be linear and scatter about the identity line with no gross outliers.
Suppose the fitted values range in value from wL to wH with no outliers. Fix
the fit = w in this range and mentally add a narrow vertical strip centered at
w to the response plot. The plotted points in the vertical strip should have a
mean near w since they scatter about the identity line. Hence Y |fit = w is
like a sample from a distribution with mean w. The following example helps
illustrate this remark.

Example 2.3. Tremearne (1911) presents a data set of about 17 mea-
surements on 115 people of Hausa nationality. We deleted 3 cases (107, 108
and 109) because of missing values and used height as the response variable Y .
Along with a constant xi,1 ≡ 1, the five additional predictor variables used



CHAPTER 2. MULTIPLE LINEAR REGRESSION 34

FIT

Y

1550 1600 1650 1700 1750 1800

1
5

0
0

1
6

0
0

1
7

0
0

1
8

0
0

63
44

3

Response Plot

FIT

R
E

S

1550 1600 1650 1700 1750 1800

-1
0

0
-5

0
0

5
0

63

44

3

Residual Plot

Figure 2.1: Residual and Response Plots for the Tremearne Data
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were height when sitting, height when kneeling, head length, nasal breadth,
and span (perhaps from left hand to right hand). Figure 2.1 presents the
OLS response and residual plots for this data set. These plots show that an
MLR model should be a useful model for the data since the plotted points
in the response plot are linear and follow the identity line while the plotted
points in the residual plot follow the r = 0 line with no other pattern (except
for a possible outlier marked 44).

To use the response plot to visualize the conditional distribution of Y |xT β,
use the fact that the fitted values Ŷ = xT β̂. For example, suppose the height
given fit = 1700 is of interest. Mentally examine the plot about a narrow
vertical strip about fit = 1700, perhaps from 1675 to 1725. The cases in the
narrow strip have a mean close to 1700 since they fall close to the identity
line. Similarly, when the fit = w for w between 1500 and 1850, the cases
have heights near w, on average.

Cases 3, 44 and 63 are highlighted. The 3rd person was very tall while
the 44th person was rather short. Beginners often label too many points
as outliers. Mentally draw a box about the bulk of the data ignoring any
outliers. Double the width of the box (about the identity line for the response
plot and about the horizontal line for the residual plot). Cases outside of this
imaginary doubled box are potential outliers. Alternatively, visually estimate
the standard deviation of the residuals in both plots. In the residual plot
look for residuals that are more than 5 standard deviations from the r = 0
line. In Figure 2.1, the standard deviation of the residuals appears to be
around 10. Hence cases 3 and 44 are certainly worth examining.

The identity line can also pass through or near an outlier or a cluster
of outliers. Then the outliers will be in the upper right or lower left of the
response plot, and there will be a large gap between the cluster of outliers
and the bulk of the data. See Figure 3.14.

2.3 Checking Lack of Fit

The response plot may look good while the residual plot suggests that the iid
error MLR model can be improved. Examining plots to find model violations
is called checking for lack of fit. Again assume that n > 5p.

The iid error MLR model often provides a useful model for the data, but
the following assumptions do need to be checked.
i) Is the MLR model appropriate?
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ii) Are outliers present?
iii) Is the error variance constant or nonconstant? The constant variance
assumption VAR(ei) ≡ σ2 is known as homoscedasticity. The nonconstant
variance assumption VAR(ei) = σ2

i is known as heteroscedasticity.
iv) Are any important predictors left out of the model?
v) Are the errors e1, ..., en iid?
vi) Are the errors ei independent of the predictors xi?

Make the response plot and the residual plot to check i), ii) and iii). An
MLR model is reasonable if the plots look like Figures 1.2, 1.3, 1.4 and 2.1.
A response plot that looks like Figure 1.13 suggests that the model is not
linear. If the plotted points in the residual plot do not scatter about the
r = 0 line with no other pattern (ie if the cloud of points is not ellipsoidal or
rectangular with zero slope), then the iid error MLR model is not sustained.

The ith residual ri is an estimator of the ith error ei. The constant vari-
ance assumption may have been violated if the variability of the point cloud
in the residual plot depends on the value of Ŷ . Often the variability of the
residuals increases as Ŷ increases, resulting in a right opening megaphone
shape. (Figure 4.1b has this shape.) Often the variability of the residu-
als decreases as Ŷ increases, resulting in a left opening megaphone shape.
Sometimes the variability decreases then increases again (like a stretched or
compressed bone), and sometimes the variability increases then decreases
again.

2.3.1 Residual Plots

Remark 2.3. Residual plots magnify departures from the model while the
response plot emphasizes how well the MLR model fits the data.

Since the residuals ri = êi are estimators of the errors, the residual plot
is used to visualize the conditional distribution e|SP of the errors given the

sufficient predictor SP = xTβ, where SP is estimated by Ŷ = xT β̂. For the
iid error MLR model, there should not be any pattern in the residual plot:
as a narrow vertical strip is moved from left to right, the behavior of the
residuals within the strip should show little change.

Notation. A rule of thumb is a rule that often but not always works well
in practice.

Rule of thumb 2.1. If the residual plot would look good after several
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points have been deleted, and if these deleted points were not gross outliers
(points far from the point cloud formed by the bulk of the data), then the
residual plot is probably good. Beginners often find too many things wrong
with a good model. For practice, use the computer to generate several MLR
data sets, and make the response and residual plots for these data sets. This
exercise will help show that the plots can have considerable variability even
when the MLR model is good.

Rule of thumb 2.2. If the plotted points in the residual plot look like
a left or right opening megaphone, the first model violation to check is the
assumption of nonconstant variance. (This is a rule of thumb because it is
possible that such a residual plot results from another model violation such
as nonlinearity, but nonconstant variance is much more common.)

The residual plot of Ŷ versus r should always be made. It is also a
good idea to plot each nontrivial predictor xj versus r and to plot potential
predictors wj versus r. If the predictor is quantitative, then the residual

plot of xj versus r should look like the residual plot of Ŷ versus r. If the
predictor is qualitative, eg gender, then interpreting the residual plot is much
more difficult; however, if each category contains many observations, then the
plotted points for each category should form a vertical line centered at r = 0
with roughly the same variability (spread or range).

Rule of thumb 2.3. Suppose that the MLR model uses predictors xj

and that data has been collected on variables wj that are not included in
the MLR model. To check whether important predictors have been left out,
make residual plots of xj and wj versus r. If these plots scatter about the
r = 0 line with no other pattern, then there is no evidence that x2

j or wj are
needed in the model. If the plotted points scatter about a parabolic curve,
try adding x2

j or wj and w2
j to the MLR model. If the plot of the potential

predictor wj versus r has a linear trend, try adding wj to the MLR model.

Rule of thumb 2.4. To check that the errors are independent of the
predictors, make residual plots of xj versus r. If the plot of xj versus r
scatters about the r = 0 line with no other pattern, then there is no evidence
that the errors depend on xj. If the variability of the residuals changes with
the value of xj, eg if the plot resembles a left or right opening megaphone,
the errors may depend on xj. Some remedies for nonconstant variance are
considered in Chapter 4.
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To study residual plots, some notation and properties of the least squares
estimator are needed. MLR is the study of the conditional distribution of
Yi|xT

i β, and the MLR model is Y = Xβ + e where X is an n × p matrix
of full rank p. Hence the number of predictors p ≤ n. The ith row of X
is xT

i = (xi,1, ..., xi,p) where xi,k is the value of the ith observation on the
kth predictor xk. We will denote the jth column of X by Xj ≡ xj which
corresponds to the jth variable or predictor xj.

Example 2.4. If Y is brain weight in grams, x1 ≡ 1, x2 is age and x3 is
the size of the head in (mm)3, then for the Gladstone (1905-6) data

Y =


3738
4261

...
3306

 , X =


1 39 149.5
1 35 152.5
...

...
...

1 19 141

 .
Hence the first person had brain weight = 3738, age = 39 and size = 149.5.
After deleting observations with missing values, there were n = 267 cases
(people measured on brain weight, age and size), and x267 = (1, 19, 141)T .
The second predictor x2 = age corresponds to the 2nd column of X and is
X2 = (39, 35, ..., 19)T . Notice that X1 ≡ x1 = 1 = (1, ..., 1)T corresponds to
the constant x1.

The results in the following proposition are properties of least squares
(OLS), not of the underlying MLR model. Definitions 2.8 and 2.9 define the
hat matrix H , vector of fitted values Ŷ and vector of residuals r. Parts
f) and g) make residual plots useful. If the plotted points are linear with
roughly constant variance and the correlation is zero, then the plotted points
scatter about the r = 0 line with no other pattern. If the plotted points in
a residual plot of w versus r do show a pattern such as a curve or a right
opening megaphone, zero correlation will usually force symmetry about either
the r = 0 line or the w = median(w) line. Hence departures from the ideal
plot of random scatter about the r = 0 line are often easy to detect.

Warning: If n > p, as is usually the case, X is not square, so (XT X)−1 �=
X−1(XT )−1 since X−1 does not exist.

Proposition 2.2. Suppose that X is an n × p matrix of full rank p.
Then

a) H is symmetric: H = HT .
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b) H is idempotent: HH = H .
c) XT r = 0 so that XT

j r = (xj)T r = 0.
d) If there is a constant X1 ≡ x1 = 1 in the model, then the sum of the

residuals is zero:
∑n

i=1 ri = 0.

e) rT Ŷ = 0.
f) If there is a constant in the model, then the sample correlation of the

fitted values and the residuals is 0: corr(r, Ŷ ) = 0.
g) If there is a constant in the model, then the sample correlation of the

jth predictor with the residuals is 0: corr(r,xj) = 0 for j = 1, ..., p.

Proof. a) XTX is symmetric since (XTX)T = XT (XT )T = XTX.
Hence (XTX)−1 is symmetric since the inverse of a symmetric matrix is
symmetric. (Recall that if A has an inverse then (AT )−1 = (A−1)T .) Thus
using (AT )T = A and (ABC)T = CT BT AT shows that

HT = XT [(XTX)−1]T (XT )T = H .

b) HH = X(XTX)−1XT X(XT X)−1XT = H since (XTX)−1XTX =
Ip, the p× p identity matrix.

c) XTr = XT (Ip − H)Y = [XT − XTX(XT X)−1XT ]Y = [XT −
XT ]Y = 0. Since xj is the jth column of X, (xj)T is the jth row of XT

and (xj)Tr = 0 for j = 1, ..., p.

d) Since x1 = 1, (x1)T r =
∑n

i=1 ri = 0 by c).

e) rT Ŷ = [(In −H)Y ]THY = Y T (In −H)HY = Y T (H −H)Y = 0.

f) The sample correlation between W and Z is corr(W,Z) =∑n
i=1(wi − w)(zi − z)

(n− 1)swsz

=

∑n
i=1(wi − w)(zi − z)√∑n

i=1(wi − w)2
∑n

i=1(zi − z)2

where sm is the sample standard deviation of m for m = z, w. So the result

follows if A =
∑n

i=1(Ŷi − Ŷ )(ri − r) = 0. Now r = 0 by d), and thus

A =
n∑

i=1

Ŷiri − Ŷ
n∑

i=1

ri =
n∑

i=1

Ŷiri

by d) again. But
∑n

i=1 Ŷiri = rT Ŷ = 0 by e).
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g) Following the argument in f), the result follows if A =
∑n

i=1(xi,j −
xj)(ri − r) = 0 where xj is the mean of the jth predictor. Now r = 0 by d),
and thus

A =
n∑

i=1

xi,jri − xj

n∑
i=1

ri =
n∑

i=1

xi,jri

by d) again. But
∑n

i=1 xi,jri = (xj)T r = 0 by c). QED

2.3.2 Other Model Violations

Without loss of generality, E(e) = 0 for the iid error MLR model with a
constant, in that if E(ẽ) = µ �= 0, then the MLR model can always be
written as Y = xT β + e where E(e) = 0 and E(Y ) ≡ E(Y |x) = xTβ. To
see this claim notice that

Y = β̃1 + x2β2 + · · · + xpβp + ẽ = β̃1 + E(ẽ) + x2β2 + · · · + xpβp + ẽ− E(ẽ)

= β1 + x2β2 + · · · + xpβp + e

where β1 = β̃1 + E(ẽ) and e = ẽ−E(ẽ). For example, if the errors ẽi are iid
exponential (λ) with E(ẽi) = λ, use ei = ẽi − λ.

For least squares, it is crucial that σ2 exists. For example, if the ei are iid
Cauchy(0,1), than σ2 does not exist and the least squares estimators tend to
perform very poorly.

The performance of least squares is analogous to the performance of Y .
The sample mean Y is a very good estimator of the population mean µ if
the Yi are iid N(µ, σ2) and Y is a good estimator of µ if the sample size is
large and the Yi are iid with mean µ and variance σ2. This result follows from
the cental limit theorem, but how “large is large” depends on the underlying
distribution. The n > 30 rule tends to hold for distributions that are close
to normal in that they take on many values and σ2 is not huge. Errors
distributions that are highly nonnormal with tiny σ2 often need n >> 30.
For example, if Y1, ..., Yn are iid Gamma(1/m, 1), then n > 25m may be
needed. Another example is distributions that take on one value with very
high probability, eg a Poisson random variable with very small variance.
Bimodal and multimodal distributions and highly skewed distributions with
large variances also need larger n.
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There are central limit type theorems for the least squares estimators
that depend on the error distribution of the iid errors ei. We always assume
that the ei are continuous random variables with a probability density func-
tion. Error distributions that are close to normal may give good results for
moderate n if n > 10p and n − p > 30 where p is the number of predictors.
Error distributions that need large n for the CLT to apply for e, will tend to
need large n for the limit theorems for least squares to apply (to give good
approximations).

Checking whether the errors are iid is often difficult. The iid assumption
is often reasonable if measurements are taken on different objects, eg people.
In industry often several measurements are taken on a batch of material.
For example a batch of cement is mixed and then several small cylinders of
concrete are made from the batch. Then the cylinders are tested for strength.
Experience from such experiments suggests that objects (eg cylinders) from
different batches are independent, but objects from the same batch are not
independent.

One check on independence can also be made if the time order of the
observations is known. Let r[t] be the residual where [t] is the time order of
the trial. Hence [1] was the 1st and [n] was the last trial. Plot the time order
t versus r[t] if the time order is known. Again, trends and outliers suggest
that the model could be improved. A box shaped plot with no trend suggests
that the MLR model is good. A plot similar to the Durbin Watson test plots
r[t−1] versus r[t] for t = 2, ..., n. Linear trend suggests serial correlation while
random scatter suggests that there is no lag 1 autocorrelation. As a rule of
thumb, if the OLS slope b is computed for the plotted points, b > 0.25 gives
some evidence that there is positive correlation between r[t−1] and r[t].

If it is assumed that the error distribution is symmetric, make a histogram
of the residuals. Check whether the histogram is roughly symmetric or clearly
skewed. If it is assumed that the errors ei are iid N(0, σ2) again check
whether the histogram is mound shaped with “short tails.” A commonly
used alternative is to make a normal probability plot of the residuals. Let
r(1) < r(2) < · · · < r(n) denote the residuals ordered from smallest to largest.
Hence r(1) is the value of the smallest residual. The normal probability plot
plots the ẽ(i) versus r(i) where the ẽ(i) are the expected values of the order
statistics from a sample of size n from a N(0, 1) distribution. (Often the ẽ(i)

are the standard normal percentiles that satisfy P (Z ≤ ẽ(i)) = (i − 0.5)/n
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where Z ∼ N(0, 1).)
Rules of thumb: i) if the plotted points scatter about some straight line

in the normal probability plot, then there is no evidence against the normal
assumption. ii) if the plotted points have an “ess shape” (concave up then
concave down) then the error distribution is symmetric with lighter tails
than the normal distribution. iii) If the plot resembles a cubic function,
then the error distribution is symmetric with heavier tails than the normal
distribution. iv) If the plotted points look concave up (eg like x2 where
x > 0), then the error distribution is right skewed.

2.4 The ANOVA F TEST

After fitting least squares and checking the response and residual plot to see
that an MLR model is reasonable, the next step is to check whether there is
an MLR relationship between Y and the nontrivial predictors x2, ..., xp. If

at least one of these predictors is useful, then the OLS fitted values Ŷi should
be used. If none of the nontrivial predictors is useful, then Y will give as
good predictions as Ŷi. Here the sample mean

Y =
1

n

n∑
i=1

Yi. (2.5)

In the definition below, SSE is the sum of squared residuals and a residual
ri = êi = “errorhat.” In the literature “errorhat” is often rather misleadingly
abbreviated as “error.”

Definition 2.14. Assume that a constant is in the MLR model.
a) The total sum of squares

SSTO =
n∑

i=1

(Yi − Y )2. (2.6)

b) The regression sum of squares

SSR =
n∑

i=1

(Ŷi − Y )2. (2.7)

c) The residual sum of squares or error sum of squares is
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SSE =

n∑
i=1

(Yi − Ŷi)
2 =

n∑
i=1

r2
i . (2.8)

The result in the following proposition is a property of least squares
(OLS), not of the underlying MLR model. An obvious application is that
given any two of SSTO, SSE and SSR, the 3rd sum of squares can be found
using the formula SSTO = SSE + SSR.

Proposition 2.3. Assume that a constant is in the MLR model. Then
SSTO = SSE + SSR.

Proof.

SSTO =
n∑

i=1

(Yi − Ŷi + Ŷi − Y )2 = SSE + SSR + 2
n∑

i=1

(Yi − Ŷi)(Ŷi − Y ).

Hence the result follows if

A ≡
n∑

i=1

ri(Ŷi − Y ) = 0.

But

A =
n∑

i=1

riŶi − Y
n∑

i=1

ri = 0

by Proposition 2.2 d) and e). �

Definition 2.15. Assume that a constant is in the MLR model and that
SSTO �= 0. The coefficient of multiple determination

R2 = [corr(Yi, Ŷi)]
2 =

SSR

SSTO
= 1 − SSE

SSTO

where corr(Yi, Ŷi) is the sample correlation of Yi and Ŷi.

Warnings: i) 0 ≤ R2 ≤ 1, but small R2 does not imply that the MLR
model is bad.

ii) If the MLR model contains a constant then there are several equivalent
formulas for R2. If the model does not contain a constant, then R2 depends
on the software package.

iii) R2 does not have much meaning unless the response plot and residual
plot both look good.
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iv) R2 tends to be too high if n is small.
v) R2 tends to be too high if there are two or more separated clusters of

data in the response plot.
vi) R2 is too high if the number of predictors p is close to n.
vii) In large samples R2 will be large (close to one) if σ2 is small compared

to the sample variance S2
Y of the response variable Y . R2 is also large if the

sample variance of Ŷ is close to S2
Y . Thus R2 is sometimes interpreted as

the proportion of the variability of Y explained by conditioning on x, but
warnings i) - v) suggest that R2 may not have much meaning.

The following 2 propositions suggest that R2 does not behave well when
many predictors that are not needed in the model are included in the model.
Such a variable is sometimes called a noise variable and the MLR model is
“fitting noise.” Proposition 2.5, appears, for example, in Cramér (1946, p.
414-415), and suggests that R2 should be considerably larger than p/n if the
predictors are useful.

Proposition 2.4. Assume that a constant is in the MLR model. Adding
a variable to the MLR model does not decrease (and usually increases) R2.

Proposition 2.5. Assume that a constant β1 is in the MLR model, that
β2 = · · · = βp = 0 and that the ei are iid N(0, σ2). Hence the Yi are iid
N(β1, σ

2). Then

a)R2 follows a beta distribution: R2 ∼ beta(p−1
2
, n−p

2
).

b)

E(R2) =
p− 1

n− 1
.

c)

VAR(R2) =
2(p− 1)(n − p)

(n− 1)2(n+ 1)
.

Notice that each SS/n estimates the variability of some quantity. SSTO/n
≈ S2

Y , SSE/n ≈ S2
e and SSR/n ≈ S2

Ŷ
.

Definition 2.16. Assume that a constant is in the MLR model. As-
sociated with each SS in Definition 2.14 is a degrees of freedom (df) and a
mean square = SS/df . For SSTO, df = n− 1 and MSTO = SSTO/(n− 1).
For SSR, df = p − 1 and MSR = SSR/(p − 1). For SSE, df = n − p and
MSE = SSE/(n− p).
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Seber and Lee (2003, p. 44–47) show that when the MLR model holds,
MSE is often a good estimator of σ2. Under regularity conditions, the MSE
is one of the best unbiased quadratic estimators of σ2. For the normal MLR
model, MSE is the uniformly minimum variance unbiased estimator of σ2.
Seber and Lee also give the following theorem that shows that the MSE is
an unbiased estimator of σ2 under very weak assumptions if the MLR model
is appropriate.

Theorem 2.6. If Y = Xβ+e where X is an n×p matrix of full rank p,
if the ei are independent with E(ei) = 0 and VAR(ei) = σ2, then σ̂2 = MSE
is an unbiased estimator of σ2.

The ANOVA F test tests whether any of the nontrivial predictors x2, ..., xp

are needed in the OLS MLR model, that is, whether Yi should be predicted
by the OLS fit Ŷi = β̂1 + xi,2β̂2 + · · · + xi,pβ̂p or with the sample mean Y .
ANOVA stands for analysis of variance, and the computer output needed to
perform the test is contained in the ANOVA table. Below is an ANOVA
table given in symbols. Sometimes “Regression” is replaced by “Model” and
“Residual” by “Error.”

Summary Analysis of Variance Table

Source df SS MS F p-value
Regression p-1 SSR MSR Fo=MSR/MSE for Ho:
Residual n-p SSE MSE β2 = · · · = βp = 0

Remark 2.4. Recall that for a 4 step test of hypotheses, the p–value is
the probability of getting a test statistic as extreme as the test statistic actu-
ally observed and that Ho is rejected if the p–value < δ. As a benchmark for
this textbook, use δ = 0.05 if δ is not given. The 4th step is the nontechnical
conclusion which is crucial for presenting your results to people who are not
familiar with MLR. Replace Y and x2, ..., xp by the actual variables used in
the MLR model. Follow Example 2.5.

Notation. The p–value ≡ pvalue given by output tends to only be
correct for the normal MLR model. Hence the output is usually only giving
an estimate of the pvalue, which will often be denoted by pval. Often

pval − pvalue
P→ 0

(converges to 0 in probability) as the sample size n→ ∞. Then the computer
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output pval is a good estimator of the unknown pvalue.

Be able to perform the 4 step ANOVA F test of hypotheses:
i) State the hypotheses Ho: β2 = · · · = βp = 0 Ha: not Ho
ii) Find the test statistic Fo = MSR/MSE or obtain it from output.
iii) Find the p–value from output or use the F–table: p–value =

P (Fp−1,n−p > Fo).

iv) State whether you reject Ho or fail to reject Ho. If Ho is rejected, conclude
that there is an MLR relationship between Y and the predictors x2, ..., xp. If
you fail to reject Ho, conclude that there is not a MLR relationship between
Y and the predictors x2, ..., xp.

Example 2.5. For the Gladstone (1905-6) data, the response variable
Y = brain weight, x1 ≡ 1, x2 = size of head, x3 = sex, x4 = breadth of head,
x5 = circumference of head. Assume that the response and residual plots
look good and test whether at least one of the nontrivial predictors is needed
in the model using the output shown below.

Summary Analysis of Variance Table

Source df SS MS F p-value

Regression 4 5396942. 1349235. 196.24 0.0000

Residual 262 1801333. 6875.32

Solution: i) Ho: β2 = · · · = β5 = 0 Ha: not Ho
ii) Fo = 196.24 from output.
iii) p–value = 0.0 from output.
iv) The p–value < δ (= 0.05 since δ was not given). So reject Ho. Hence
there is an MLR relationship between brain weight and the predictors size,
sex, breadth, and circumference.

Remark 2.5. There is a close relationship between the response plot
and the ANOVA F test. If n > 10p and n − p > 30 and if the plotted
points follow the identity line, typically Ho will be rejected if the identity
line fits the plotted points better than any horizontal line (in particular, the
line Y = Y ). If a horizontal line fits the plotted points about as well as
the identity line, as in Figure 1.4, this graphical diagnostic is inconclusive
(sometimes the ANOVA F test will reject Ho and sometimes fail to reject
Ho), but the MLR relationship is at best weak. In Figures 1.2 and 2.1, the
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ANOVA F test should reject Ho since the identity line fits the plotted points
better than any horizontal line.

Definition 2.17. An RR plot is a plot of residuals from 2 different
models or fitting methods.

Remark 2.6. If the RR plot of the residuals Yi − Y versus the OLS
residuals ri = Yi − Ŷi shows tight clustering about the identity line, then the
MLR relationship is weak: Y fits the data about as well as the OLS fit.

Example 2.6. Cook and Weisberg (1999a, p. 261, 371) describe a data
set where rats were injected with a dose of a drug approximately proportional
to body weight. The response Y is the fraction of the drug recovered from
the rat’s liver. The three predictors are the body weight of the rat, the dose of
the drug, and the liver weight. A constant was also used. The experimenter
expected the response to be independent of the predictors, and 19 cases
were used. However, the ANOVA F test suggested that the predictors were
important. The third case was an outlier and easily detected in the response
and residual plots (not shown). After deleting the outlier, the response and
residual plots looked ok and the following output was obtained.

Summary Analysis of Variance Table

Source df SS MS F p-value

Regression 3 0.00184396 0.000614652 0.10 0.9585

Residual 14 0.0857172 0.00612265

The 4 step ANOVA F test is
i) Ho: β2 = · · · = β4 = 0 Ha: not Ho
ii) Fo = 0.10.
iii) p–value = 0.9585.
iv) The p–value > δ (= 0.05 since δ was not given). So fail to reject Ho.
Hence there is not an MLR relationship between fraction of drug recovered
and the predictors body weight, dose, and liver weight. (More accurately,
there is not enough statistical evidence to conclude that there is an MLR
relationship: failing to reject Ho is not the same as accepting Ho; however,
it may be a good idea to keep the nontechnical conclusions nontechnical.)

Figure 2.2 shows the RR plot where the residuals from the full model
are plotted against Yi − Y , the residuals from the model using no nontrivial
predictors. This plot reinforces the conclusion that the response Y is inde-
pendent of the nontrivial predictors. The identity line and the OLS line from
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Figure 2.2: RR Plot With Outlier Deleted, Submodel Uses No Predictors
with Ŷ = Y

regressing ri on Yi − Y (that is, use Ỹi = ri, a constant and x̃i,2 = Yi − Y ,
find the OLS line and then plot it) are shown as visual aids. If the OLS line
and identity line nearly coincide in that it is difficult to tell that the two lines
intersect at the origin, then the 2 sets of residuals are “close.”

Some assumptions are needed on the ANOVA F test. Assume that both
the response and residual plots look good. It is crucial that there are no
outliers. Then a rule of thumb is that if n − p is large, then the ANOVA
F test p–value is approximately correct. An analogy can be made with the
central limit theorem, Y is a good estimator for µ if the Yi are iid N(µ, σ2)
and also a good estimator for µ if the data are iid with mean µ and variance
σ2 if n is large enough. More on the robustness and lack of robustness of the
ANOVA F test can be found in Wilcox (2005).

If all of the xi are different (no replication) and if the number of predictors
p = n, then the OLS fit Ŷi = Yi and R2 = 1. Notice that Ho is rejected if the
statistic Fo is large. More precisely, reject Ho if

Fo > Fp−1,n−p,1−δ
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where
P (F ≤ Fp−1,n−p,1−δ) = 1 − δ

when F ∼ Fp−1,n−p. Since R2 increases to 1 while (n− p)/(p − 1) decreases
to 0 as p increases to n, Theorem 2.7a below implies that if p is large then
the Fo statistic may be small even if some of the predictors are very good.
It is a good idea to use n > 10p or at least n > 5p if possible.

Theorem 2.7. Assume that the MLR model has a constant β1.
a)

Fo =
MSR

MSE
=

R2

1 − R2

n− p

p− 1
.

b) If the errors ei are iid N(0, σ2), and if Ho: β2 = · · · = βp = 0 is true,
then Fo has an F distribution with p− 1 numerator and n− p denominator
degrees of freedom: Fo ∼ Fp−1,n−p.

c) If the errors are iid with mean 0 and variance σ2, if the error distribution
is close to normal and if n − p is large enough, and if Ho is true, then
Fo ≈ Fp−1,n−p in that the p-value is approximately correct.

Remark 2.7. When a constant is not contained in the model (ie xi,1 is
not equal to 1 for all i), then the computer output still produces an ANOVA
table with the test statistic and p–value, and nearly the same 4 step test of
hypotheses can be used. The hypotheses are now Ho: β1 = · · · = βp = 0
Ha: not Ho, and you are testing whether or not there is an MLR relationship
between Y and x1, ..., xp. An MLR model without a constant (no intercept)
is sometimes called a “regression through the origin.” See Section 2.10.

2.5 Prediction

This section gives estimators for predicting a future or new value Yf of
the response variable given the predictors xf , and for estimating the mean
E(Yf ) ≡ E(Yf |xf). This mean is conditional on the values of the predictors
xf , but the conditioning is often suppressed.

Warning: All too often the MLR model seems to fit the data

(Y1,x1), ..., (Yn,xn)

well, but when new data is collected, a very different MLR model is needed
to fit the new data well. In particular, the MLR model seems to fit the data
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(Yi,xi) well for i = 1, ..., n, but when the researcher tries to predict Yf for a

new vector of predictors xf , the prediction is very poor in that Ŷf is not close
to the Yf actually observed. Wait until after the MLR model has been
shown to make good predictions before claiming that the model
gives good predictions!

There are several reasons why the MLR model may not fit new data
well. i) The model building process is usually iterative. Data Z, w1, ..., wr

is collected. If the model is not linear, then functions of Z are used as a
potential response and functions of the wi as potential predictors. After trial
and error, the functions are chosen, resulting in a final MLR model using Y
and x1, ..., xp. Since the same data set was used during the model building
process, biases are introduced and the MLR model fits the “training data”
better than it fits new data. Suppose that Y , x1, ..., xp are specified before
collecting data and that the residual and response plots from the resulting
MLR model look good. Then predictions from the prespecified model will
often be better for predicting new data than a model built from an iterative
process.

ii) If (Yf ,xf ) come from a different population than the population of
(Y1,x1), ..., (Yn,xn), then prediction for Yf can be arbitrarily bad.

iii) Even a good MLR model may not provide good predictions for an xf

that is far from the xi (extrapolation).
iv) The MLR model may be missing important predictors (underfitting).
v) The MLR model may contain unnecessary predictors (overfitting).

Two remedies for i) are a) use previously published studies to select an
MLR model before gathering data. b) Do a trial study. Collect some data,
build an MLR model using the iterative process. Then use this model as the
prespecified model and collect data for the main part of the study. Better
yet, do a trial study, specify a model, collect more trial data, improve the
specified model and repeat until the latest specified model works well. Un-
fortunately, trial studies are often too expensive or not possible because the
data is difficult to collect. Also often the population from a published study
is quite different from the population of the data collected by the researcher.
Then the MLR model from the published study is not adequate. If the data
set is large enough, using a random sample of < n/4 of the cases to build a
model may help reduce biases.

Definition 2.18. Consider the MLR model Y = Xβ + e and the hat
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matrix H = X(XT X)−1XT . Let hi = hii be the ith diagonal element of H
for i = 1, ..., n. Then hi is called the ith leverage and hi = xT

i (XTX)−1xi.
Suppose new data is to be collected with predictor vector xf . Then the
leverage of xf is hf = xT

f (XT X)−1xf . Extrapolation occurs if xf is far
from the x1, ...,xn.

Rule of thumb 2.5. Predictions based on extrapolation are not reliable.
A rule of thumb is that extrapolation occurs if hf > max(h1, ..., hn). This
rule works best if the predictors are linearly related in that a plot of xi versus
xj should not have any strong nonlinearities. If there are strong nonlinearities
among the predictors, then xf could be far from the xi but still have hf <
max(h1, ..., hn).

Example 2.7. Consider predicting Y = weight from x = height and a
constant from data collected on men between 18 and 24 where the minimum
height was 57 and the maximum height was 79 inches. The OLS equation
was Ŷ = −167 + 4.7x. If x = 70 then Ŷ = −167 + 4.7(70) = 162 pounds.
If x = 1 inch, then Ŷ = −167 + 4.7(1) = −162.3 pounds. It is impossible
to have negative weight, but it is also impossible to find a 1 inch man. This
MLR model should not be used for x far from the interval (57, 79).

Definition 2.19. Consider the iid error MLR model Y = xT β+ e where
E(e) = 0. Then regression function is the hyperplane

E(Y ) ≡ E(Y |x) = x1β1 + x2β2 + · · · + xpβp = xTβ. (2.9)

Assume OLS is used to find β̂. Then the point estimator of Yf given x = xf

is
Ŷf = xf,1β̂1 + · · · + xf,pβ̂p = xT

f β̂. (2.10)

The point estimator of E(Yf ) ≡ E(Yf |xf ) given x = xf is also Ŷf = xT
f β̂.

Assume that the MLR model contains a constant β1 so that x1 ≡ 1. The large
sample 100 (1 − δ)% confidence interval (CI) for E(Yf |xf ) = xT

f β = E(Ŷf )
is

Ŷf ± tn−p,1−δ/2se(Ŷf) (2.11)

where P (T ≤ tn−p,δ) = δ if T has a t distribution with n − p degrees of

freedom. Generally se(Ŷf) will come from output, but

se(Ŷf) =
√
MSE hf =

√
MSE xT

f (XT X)−1xf .
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Recall the interpretation of a 100 (1 − δ)% CI for a parameter µ is that
if you collect data then form the CI, and repeat for a total of k times where
the k trials are independent from the same population, then the probability
that m of the CIs will contain µ follows a binomial(k, ρ = 1−δ) distribution.
Hence if 100 95% CIs are made, ρ = 0.95 and about 95 of the CIs will contain
µ while about 5 will not. Any given CI may (good sample) or may not (bad
sample) contain µ, but the probability of a “bad sample” is δ.

The following theorem is analogous to the central limit theorem and the
theory for the t–interval for µ based on Y and the sample standard deviation
(SD) SY . If the data Y1, ..., Yn are iid with mean 0 and variance σ2, then Y is
asymptotically normal and the t–interval will perform well if the sample size
is large enough. The result below suggests that the OLS estimators Ŷi and
β̂ are good if the sample size is large enough. The condition max hi → 0 in
probability usually holds if the researcher picked the design matrix X or if
the xi are iid random vectors from a well behaved population. Outliers can

cause the condition to fail. Convergence in probability, Yn
P→ c, is similar to

other types of convergence: Yn is likely to be close to c if the sample size n
is large enough.

Theorem 2.8: Huber (1981, p. 157-160). Consider the MLR model
Yi = xT

i β + ei and assume that the errors are independent with zero mean
and the same variance: E(ei) = 0 and VAR(ei) = σ2. Also assume that
maxi(h1, ..., hn) → 0 in probability as n→ ∞. Then

a) Ŷi = xT
i β̂ → E(Yi|xi) = xiβ in probability for i = 1, ..., n as n→ ∞.

b) All of the least squares estimators aT β̂ are asymptotically normal
where a is any fixed constant p× 1 vector.

Definition 2.20. A large sample 100(1 − δ)% prediction interval (PI)

has the form (L̂n, Ûn) where P (L̂n < Yf < Ûn)
P→ 1 − δ as the sample size

n→ ∞. For the Gaussian MLR model, assume that the random variable Yf

is independent of Y1, ..., Yn. Then the 100 (1 − δ)% PI for Yf is

Ŷf ± tn−p,1−δ/2se(pred) (2.12)

where P (T ≤ tn−p,δ) = δ if T has a t distribution with n − p degrees of
freedom. Generally se(pred) will come from output, but

se(pred) =
√
MSE (1 + hf ).
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The interpretation of a 100 (1−δ)% PI for a random variable Yf is similar
to that of a CI. Collect data, then form the PI, and repeat for a total of k
times where k trials are independent from the same population. If Yfi is the
ith random variable and PIi is the ith PI, then the probability that Yfi ∈ PIi

for m of the PIs follows a binomial(k, ρ = 1 − δ) distribution. Hence if 100
95% PIs are made, ρ = 0.95 and Yfi ∈ PIi happens about 95 times.

There are two big differences between CIs and PIs. First, the length of
the CI goes to 0 as the sample size n goes to ∞ while the length of the PI
converges to some nonzero number J , say. Secondly, the CI for E(Yf |xf )
given in Definition 2.19 tends to work well for the iid error MLR model if
the sample size is large while the PI in Definition 2.20 is made under the
assumption that the ei are iid N(0, σ2) and may not perform well if the
normality assumption is violated.

To see this, consider xf such that the heights Y of women between 18
and 24 is normal with a mean of 66 inches and an SD of 3 inches. A 95%
CI for E(Y |xf ) should be centered at about 66 and the length should go
to zero as n gets large. But a 95% PI needs to contain about 95% of the
heights so the PI should converge to the interval 66 ± 1.96(3)). This result
follows because if Y ∼ N(66, 9) then P (Y < 66 − 1.96(3)) = P (Y > 66 +
1.96(3)) ≈ 0.025. In other words, the endpoints of the PI estimate the 97.5
and 2.5 percentiles of the normal distribution. However, the percentiles of a
parametric error distribution depend heavily on the parametric distribution
and the parametric formulas are violated if the assumed error distribution is
incorrect.

Assume that the iid error MLR model is valid so that e is from some
distribution with 0 mean and variance σ2. Olive (2007) shows that if 1−γ is
the asymptotic coverage of the classical nominal (1− δ)100% PI (2.12), then

1 − γ = P (−σz1−δ/2 < e < σz1−δ/2) ≥ 1 − 1

z2
1−δ/2

(2.13)

where the inequality follows from Chebyshev’s inequality. Hence the asymp-
totic coverage of the nominal 95% PI is at least 73.9%. The 95% PI (2.12)
was often quite accurate in that the asymptotic coverage was close to 95% for
a wide variety of error distributions. The 99% and 90% PIs did not perform
as well.
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Let ξδ be the δ percentile of the error e, ie, P (e ≤ ξδ) = δ. Let ξ̂δ be
the sample δ percentile of the residuals. Then the results from Theorem
2.8 suggest that the residuals ri estimate the errors ei, and that the sample
percentiles of the residuals ξ̂δ estimate ξδ. For many error distributions,

E(MSE) = E

(
n∑

i=1

r2
i

n− p

)
= σ2 = E

(
n∑

i=1

e2
i

n

)
.

This result suggests that √
n

n − p
ri ≈ ei.

Using

an =

(
1 +

15

n

)√
n

n− p

√
(1 + hf ), (2.14)

a large sample semiparametric 100(1 − δ)% PI for Yf is

(Ŷf + anξ̂δ/2, Ŷf + anξ̂1−δ/2). (2.15)

This PI is very similar to the classical PI except that ξ̂δ is used instead of
σzδ to estimate the error percentiles ξδ . The large sample coverage 1 − γ of
this nominal 100(1 − δ)% PI is asymptotically correct: 1 − γ = 1 − δ.

Example 2.8. For the Buxton (1920) data suppose that the response Y
= height and the predictors were a constant, head length, nasal height, bigonal
breadth and cephalic index. Five outliers were deleted leaving 82 cases. Figure
2.3 shows a response plot of the fitted values versus the response Y with the
identity line added as a visual aid. The plot suggests that the model is good
since the plotted points scatter about the identity line in an evenly populated
band although the relationship is rather weak since the correlation of the
plotted points is not very high. The triangles represent the upper and lower
limits of the semiparametric 95% PI (2.15). For this example, 79 (or 96%)
of the Yi fell within their corresponding PI while 3 Yi did not. A plot using
the classical PI (2.12) would be very similar for this data.

Given output showing β̂i and given xf , se(pred) and se(Ŷf), Example

2.9 shows how to find Ŷf , a CI for E(Yf |xf ) and a PI for Yf . Below is shown
typical output in symbols. Sometimes “Label” is replaced by “Predictor”
and “Estimate” by “coef” or “Coefficients.”
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Figure 2.3: 95% PI Limits for Buxton Data

Label Estimate Std. Error t-value p-value

Constant β̂1 se(β̂1) to,1 for Ho: β1 = 0

x2 β̂2 se(β̂2) to,2 = β̂2/se(β̂2) for Ho: β2 = 0
...

xp β̂p se(β̂p) to,p = β̂p/se(β̂p) for Ho: βp = 0

Example 2.9. The Rouncefield (1995) data are female and male life
expectancies from n = 91 countries. Suppose that it is desired to predict
female life expectancy Y from male life expectancy X. Suppose that if Xf =

60, then se(pred) = 2.1285, and se(Ŷf) = 0.2241. Below is some output.

Label Estimate Std. Error t-value p-value

Constant -2.93739 1.42523 -2.061 0.0422

mlife 1.12359 0.0229362 48.988 0.0000

a) Find Ŷf if Xf = 60.

Solution: In this example, xf = (1, Xf )
T since a constant is in the output

above. Thus Ŷf = β̂1 + β̂2Xf = −2.93739 + 1.12359(60) = 64.478.
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b) If Xf = 60, find a 90% confidence interval for E(Y ) ≡ E(Yf |xf ).

Solution: The CI is Ŷf ± tn−2,1−δ/2se(Ŷf) = 64.478 ± 1.645(0.2241) =
64.478 ± 0.3686 = (64.1094, 64.8466). To use the t–table on the last page of
Chapter 17, use the 2nd to last row marked by Z since d = df = n − 2 =
89 > 30. In the last row find CI = 90% and intersect the 90% column and
the Z row to get the value of t89,0.95 ≈ z.95 = 1.645.

c) If Xf = 60, find a 90% prediction interval for Yf .

Solution: The PI is Ŷf ± tn−2,1−δ/2se(pred) = 64.478 ± 1.645(2.1285)
= 64.478 ± 3.5014 = (60.9766, 67.9794).

2.6 The Partial F or Change in SS TEST

Suppose that there is data on variables Z, w1, ..., wr and that a useful MLR
model has been made using Y = t(Z), x1 ≡ 1, x2, ..., xp where each xi is some
function of w1, ..., wr. This useful model will be called the full model. It is
important to realize that the full model does not need to use every variable
wj that was collected. For example, variables with outliers or missing values
may not be used. Forming a useful full model is often very difficult, and it is
often not reasonable to assume that the candidate full model is good based
on a single data set, especially if the model is to be used for prediction.

Even if the full model is useful, the investigator will often be interested in
checking whether a model that uses fewer predictors will work just as well.
For example, perhaps xp is a very expensive predictor but is not needed given
that x1, ..., xp−1 are in the model. Also a model with fewer predictors tends
to be easier to understand.

Definition 2.21. Let the full model use Y , x1 ≡ 1, x2, ..., xp and let
the reduced model use Y , x1, xi2, ..., xiq where {i2, ..., iq} ⊂ {2, ..., p}.

The change in SS F test or partial F test is used to test whether the
reduced model is good in that it can be used instead of the full model. It
is crucial that the reduced model be selected before looking at the data.
If the reduced model is selected after looking at output and discarding the
worst variables, then the p–value for the partial F test will be too high. For
(ordinary) least squares, usually a constant is used, and we are assuming
that both the full model and the reduced model contain a constant. The
partial F test has null hypothesis Ho : βiq+1 = · · · = βip = 0, and alternative
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hypothesis HA : at least one of the βij �= 0 for j > q. The null hypothesis is
equivalent to Ho: “the reduced model is good.” Since only the full model and
reduced model are being compared, the alternative hypothesis is equivalent
to HA: “the reduced model is not as good as the full model, so use the full
model,” or more simply, HA : “use the full model.”

To perform the change in SS or partial F test, fit the full model and the
reduced model and obtain the ANOVA table for each model. The quanti-
ties dfF , SSE(F) and MSE(F) are for the full model and the corresponding
quantities from the reduced model use an R instead of an F . Hence SSE(F)
and SSE(R) are the residual sums of squares for the full and reduced models,
respectively. Shown below is output only using symbols.

Full model

Source df SS MS Fo and p-value
Regression p− 1 SSR MSR Fo=MSR/MSE

Residual dfF = n− p SSE(F) MSE(F) for Ho:β2 = · · · = βp = 0

Reduced model

Source df SS MS Fo and p-value
Regression q − 1 SSR MSR Fo=MSR/MSE

Residual dfR = n − q SSE(R) MSE(R) for Ho: β2 = · · · = βq = 0

Be able to perform the 4 step change in SS F test = partial F
test of hypotheses: i) State the hypotheses. Ho: the reduced model is
good Ha: use the full model
ii) Find the test statistic. FR =[

SSE(R) − SSE(F )

dfR − dfF

]
/MSE(F )

iii) Find the p–value = P(FdfR−dfF ,dfF
> FR). (On exams typically an F

table is used. Here dfR − dfF = p− q = number of parameters set to 0, and
dfF = n− p).
iv) State whether you reject Ho or fail to reject Ho. Reject Ho if the p–value
< δ and conclude that the full model should be used. Otherwise, fail to reject
Ho and conclude that the reduced model is good.
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Sometime software has a shortcut. For example the R/Splus software uses
the anova command. As an example, assume that the full model uses x2 and
x3 while the reduced models uses x2. Both models contain a constant. Then
the following commands will perform the partial F test. (On the computer
screen the 1st command looks more like red < − lm(y∼x1).)

full <- lm(y~x2+x3)

red <- lm(y~x2)

anova(red,full)

For an n× 1 vector a, let

‖a‖ =
√
a2

1 + · · · + a2
n =

√
aTa

be the Euclidean norm of a. If r and rR are the vector of residuals from
the full and reduced models, respectively, notice that SSE(F ) = ‖r‖2 and
SSE(R) = ‖rR‖2.

The following proposition suggests that Ho is rejected in the partial F
test if the change in residual sum of squares SSE(R) − SSE(F ) is large
compared to SSE(F ). If the change is small, then FR is small and the test
suggests that the reduced model can be used.

Proposition 2.9. Let R2 and R2
R be the multiple coefficients of determi-

nation for the full and reduced models, respectively. Let Ŷ and Ŷ R be the
vectors of fitted values for the full and reduced models, respectively. Then
the test statistic in the partial F test is

FR =

[
SSE(R) − SSE(F )

dfR − dfF

]
/MSE(F ) =

[
‖Ŷ ‖2 − ‖Ŷ R‖2

dfR − dfF

]
/MSE(F ) =

SSE(R) − SSE(F )

SSE(F )

n− p

p− q
=
R2 −R2

R

1 −R2

n− p

p− q
.

Definition 2.22. An FF plot is a plot of fitted values from 2 different
models or fitting methods.
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Six plots are useful diagnostics for the partial F test: the RR plot with
the residuals from the full model on the vertical axis, the FF plots with the
fitted values from the full model on the vertical axis, and always make the
response and residual plots for the full and reduced models. Suppose that
the full model is a useful MLR model. If the reduced model is good, then
the response plots from the full and reduced models should be very similar,
visually. Similarly, the residual plots (of the fitted values versus the residuals)
from the full and reduced models should be very similar, visually. Finally,
the correlation of the plotted points in the RR and FF plots should be high,
≥ 0.95, say, and the plotted points in the RR and FF plots should cluster
tightly about the identity line. Add the identity line to both the RR and FF
plots as a visual aid. Also add the OLS line from regressing r on rR to the
RR plot (the OLS line is the identity line in the FF plot). If the reduced
model is good, then the OLS line should nearly coincide with the identity
line in that it should be difficult to see that the two lines intersect at the
origin, as in Figure 2.2. If the FF plot looks good but the RR plot does not,
the reduced model may be good if the main goal of the analysis is to predict
Y.

In Chapter 3, Example 3.8 describes the Gladstone (1905-1906) data. Let
the reduced model use a constant, (size)1/3, sex and age. Then Figure 3.7
shows the response and residual plots for the full and reduced models, and
Figure 3.9 shows the RR and FF plots.

Summary Analysis of Variance Table for the Full Model

Source df SS MS F p-value

Regression 6 260467. 43411.1 87.41 0.0000

Residual 69 34267.4 496.629

Summary Analysis of Variance Table for the Reduced Model

Source df SS MS F p-value

Regression 2 94110.5 47055.3 17.12 0.0000

Residual 73 200623. 2748.27

Example 2.10. For the Buxton (1920) data, n = 76 after 5 outliers and
6 cases with missing values are removed. Assume that the response variable
Y is height, and the explanatory variables are x2 = bigonal breadth, x3 =
cephalic index, x4 = finger to ground, x5 = head length, x6 = nasal height,
x7 = sternal height. Suppose that the full model uses all 6 predictors plus a
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constant (x1) while the reduced model uses the constant, cephalic index and
finger to ground. Test whether the reduced model can be used instead of the
full model using the above output.

Solution: The 4 step partial F test is shown below.
i) Ho: the reduced model is good Ha: use the full model
ii)

FR =

[
SSE(R) − SSE(F )

dfR − dfF

]
/MSE(F ) =

[
200623.0 − 34267.4

73 − 69

]
/496.629

= 41588.9/496.629 = 83.742.
iii) p–value = P (F4,69 > 83.742) = 0.00.
iv) The p–value < δ (= 0.05, since δ was not given), so reject Ho. The full
model should be used instead of the reduced model. (Bigonal breadth, head
length, nasal height, and sternal height are needed in the MLR for height
given that cephalic index and finger to ground are in the model.)

Using a computer to get the p–value makes sense, but for exams you
may need to use a table. In ARC, you can use the Calculate probability
option from the ARC menu, enter 83.742 as the value of the statistic, 4
and 69 as the degrees of freedom, and select the F distribution. To use the
table near the end of Chapter 17, use the bottom row since the denominator
degrees of freedom 69 > 30. Intersect with the column corresponding to k = 4
numerator degrees of freedom. The cutoff value is 2.37. If the FR statistic
was 2.37, then the p–value would be 0.05. Since 83.472 > 2.37, the p–value
< 0.05, and since 83.472 >> 2.37, we can say that the p–value ≈ 0.0.

Example 2.11. Now assume that the reduced model uses the constant,
sternal height, finger to ground and head length. Using the output below, test
whether the reduced model is good.

Summary Analysis of Variance Table for Reduced Model

Source df SS MS F p-value

Regression 3 259704. 86568. 177.93 0.0000

Residual 72 35030.1 486.528

Solution: The 4 step partial F test follows.
i) Ho: the reduced model is good Ha: use the full model
ii)

FR =

[
SSE(R) − SSE(F )

dfR − dfF

]
/MSE(F ) =

[
35030.1.0 − 34267.4

72 − 69

]
/496.629
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= 254.2333/496.629 = 0.512.
iii) The p–value = P (F3,69 > 0.512) = 0.675.
iv) The p–value > δ, so reject fail to reject Ho. The reduced model is good.

To use the F table near the end of Chapter 17, use the bottom row
since the denominator degrees of freedom 69 > 30. Intersect with the column
corresponding to k = 3 numerator degrees of freedom. The cutoff value is
2.61. Since 0.512 < 2.61, the p–value > 0.05, and this is enough information
to fail to reject Ho.

2.7 The Wald t Test

Often investigators hope to examine βk in order to determine the importance
of the predictor xk in the model; however, βk is the coefficient for xk given
that the other predictors are in the model. Hence βk depends strongly on
the other predictors in the model. Suppose that the model has an intercept:
x1 ≡ 1. The predictor xk is highly correlated with the other predictors if
the OLS regression of xk on x1, ..., xk−1, xk+1, ..., xp has a high coefficient of
determination R2

k. If this is the case, then often xk is not needed in the model
given that the other predictors are in the model. If at least one R2

k is high
for k ≥ 2, then there is multicollinearity among the predictors.

As an example, suppose that Y = height, x1 = 1, x2 = left leg length, and
x3 = right leg length. Then x2 should not be needed given x3 is in the model
and β2 = 0 is reasonable. Similarly β3 = 0 is reasonable. On the other hand,
if the model only contains x1 and x2, then x2 is extremely important with β2

near 2. If the model contains x1, x2, x3, x4 = height at shoulder, x5 = right
arm length, x6 = head length and x7 = length of back, then R2

i may be high
for each i ≥ 2. Hence xi is not needed in the MLR model for Y given that
the other predictors are in the model.

Definition 2.23. The 100 (1 − δ) % CI for βk is β̂k ± tn−p,1−δ/2 se(β̂k).
If the degrees of freedom d = n− p > 30, use the N(0,1) cutoff z1−δ/2.

Know how to do the 4 step Wald t–test of hypotheses.
i) State the hypotheses Ho: βk = 0 Ha: βk �= 0.
ii) Find the test statistic to,k = β̂k/se(β̂k) or obtain it from output.
iii) Find the p–value from output or use the t–table: p–value =

2P (tn−p < −|to,k|).
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Use the normal table or ν = ∞ in the t–table if the degrees of freedom
ν = n− p > 30.
iv) State whether you reject Ho or fail to reject Ho and give a nontechnical
sentence restating your conclusion in terms of the story problem.

Recall that Ho is rejected if the p–value < δ. As a benchmark for this
textbook, use δ = 0.05 if δ is not given. If Ho is rejected, then conclude that
xk is needed in the MLR model for Y given that the other predictors are in
the model. If you fail to reject Ho, then conclude that xk is not needed in
the MLR model for Y given that the other predictors are in the model. Note
that xk could be a very useful individual predictor, but may not be needed
if other predictors are added to the model. It is better to use the output to
get the test statistic and p–value than to use formulas and the t–table, but
exams may not give the relevant output.

Definition 2.24. Assume that there is a constant x1 ≡ 1 in the model,
and let x(k) = (x1, ..., xk−1, xk+1, ..., xp)

T be the vector of predictors with the
kth predictor xk deleted. Let r(k) be the residuals from regressing Y on x(k),
that is, on all of the predictor variables except xk. Let r(xk|x(k)) denote the
residuals from regressing xk on x(k). Then an added variable plot for xk

is a plot of r(xk|x(k)) versus r(k) for k = 2, ..., p.

The added variable plot (also called a partial regression plot) is used to
give information about the test Ho : βk = 0. The points in the plot cluster
about a line through the origin with slope = β̂k. An interesting fact is that the
residuals from this line, ie the residuals from regressing r(k) on r(xk|x(k)), are
exactly the same as the usual residuals from regressing Y on x. The range
of the horizontal axis gives information about the collinearity of xk with the
other predictors. Small range implies that xk is well explained by the other
predictors. The r(xk|x(k)) represent the part of xk that is not explained by
the remaining variables while the r(k) represent the part of Y that is not
explained by the remaining variables.

An added variable plot with a clearly nonzero slope and tight clustering
about a line implies that xk is needed in the MLR for Y given that the other
predictors x2, ..., xk−1, xk+1, ..., xp are in the model. Slope near zero in the
added variable plot implies that xk may not be needed in the MLR for Y
given that all other predictors x2, ..., xi−1, xk+1, ..., xp are in the model.

If the zero line with 0 slope and 0 intercept and the OLS line are added to
the added variable plot, the variable is probably needed if it is clear that the
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two lines intersect at the origin. Then the point cloud should be tilted away
from the zero line. The variable is probably not needed if the two lines nearly
coincide near the origin in that you can not clearly tell that they intersect at
the origin.

Shown below is output only using symbols and the following example
shows how to use output to perform the Wald t–test.

Response = Y
Coefficient Estimates

Label Estimate Std. Error t-value p-value

Constant β̂1 se(β̂1) to,1 for Ho: β1 = 0

x2 β̂2 se(β̂2) to,2 = β̂2/se(β̂2) for Ho: β2 = 0
...

xp β̂p se(β̂p) to,p = β̂p/se(β̂p) for Ho: βp = 0

Label Estimate Std. Error t-value p-value

Constant -7736.26 2660.36 -2.908 0.0079

x2 0.180225 0.00503871 35.768 0.0000

x3 -1.89411 2.65789 -0.713 0.4832

R Squared: 0.987584, Sigma hat: 4756.08, Number of cases: 26

Summary Analysis of Variance Table

Source df SS MS F p-value

Regression 2 41380950140. 20690475070. 914.69 0.0000

Residual 23 520265969. 22620260.

Example 2.12. The output above was collected from 26 districts in
Prussia in 1843. See Hebbler (1847). The goal is to study the relationship
between Y = the number of women married to civilians in the district with
the predictors x2 = the population of the district and x3 = military women
= number of women married to husbands in the military.

a) Find a 95% confidence interval for β2 corresponding to population.

The CI is β̂k ± tn−p,1−δ/2 se(β̂k). Since n = 26, df = n− p = 26 − 3 = 23.
From the t–table at the end of Chapter 17, intersect the df = 23 row with
the column that is labelled by 95% on the bottom. Then tn−p,1−δ/2 = 2.069.
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Using the output shows that the 95% CI is 0.180225 ± 2.069(0.00503871) =
(0.16980, 0.19065).

b) Perform a 4 step test for Ho: β2 = 0 corresponding to population.
i) Ho: β2 = 0 HA : β2 �= 0
ii) to2 = 35.768
iii) p–value = 0.0
iv) Reject Ho, the population is needed in the MLR model for the number

of women married to civilians if number of military women is in the model.

c) Perform a 4 step test for Ho: β3 = 0 corresponding to military women.
i) Ho: β3 = 0 HA : β3 �= 0
ii) to2 = −0.713
iii) p–value = 0.4883
iv) Fail to reject Ho, the number of military women is not needed in the

MLR model for the number of women married to civilians if population is in
the model.

Figure 2.4 shows the added variable plots for x2 and x3. The plot for x2

strongly suggests that x2 is needed in the MLR model while the plot for x3

indicates that x3 does not seem to be very important. The slope of the OLS
line in a) is 0.1802 while the slope of the line in b) is −1.894.

If the predictor xk is categorical, eg gender, the added variable plot may
look like two spheres, but if the OLS line is added to the plot, it will have
slope equal to β̂k.

2.8 The OLS Criterion

The OLS estimator β̂ minimizes the OLS criterion

QOLS(η) =
n∑

i=1

r2
i (η)

where the residual ri(η) = Yi − xT
i η. In other words, let ri = ri(β̂) be the

OLS residuals. Then
∑n

i=1 r
2
i ≤ ∑n

i=1 r
2
i (η) for any p × 1 vector η, and the

equality holds iff η = β̂ if the n× p design matrix X is of full rank p ≤ n. In
particular, if X has full rank p, then

∑n
i=1 r

2
i <

∑n
i=1 r

2
i (β) =

∑n
i=1 e

2
i even

if the MLR model Y = Xβ + e is a good approximation to the data.
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Figure 2.4: Added Variable Plots for x2 and x3

Example 2.13. When a model depends on the predictors x only through
the linear combination xTβ, then xTβ is called a sufficient predictor and
xT β̂ is called an estimated sufficient predictor (ESP). For OLS the model
is Y = xT β + e, and the fitted value Ŷ = ESP . To illustrate the OLS
criterion graphically, consider the Gladstone (1905-6) data where we used
brain weight as the response. A constant, x2 = age, x3 = sex and x4 =
(size)1/3 were used as predictors after deleting five “infants” from the data
set. In Figure 2.5a, the OLS response plot of the OLS ESP = Ŷ ver-
sus Y is shown. The vertical deviations from the identity line are the
residuals, and OLS minimizes the sum of squared residuals. If any other
ESP xTη is plotted versus Y , then the vertical deviations from the iden-
tity line are the residuals ri(η). For this data, the OLS estimator β̂ =
(498.726,−1.597, 30.462, 0.696)T . Figure 2.5b shows the response plot using
the ESP xT η where η = (498.726,−1.597, 30.462, 0.796)T . Hence only the
coefficient for x4 was changed; however, the residuals ri(η) in the resulting
plot are much larger on average than the residuals in the OLS response plot.
With slightly larger changes in the OLS ESP, the resulting η will be such
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Figure 2.5: The OLS Fit Minimizes the Sum of Squared Residuals
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that the squared residuals are massive.

Proposition 2.10. The OLS estimator β̂ is the unique minimizer of the
OLS criterion if X has full rank p ≤ n.

Proof: Seber and Lee p. 36-37. Recall that the hat matrix H =
X(XTX)−1XT and notice that (I − H)T = I − H , that (I − H)H = 0
and that HX = X. Let η be any p× 1 vector. Then

(Y − Xβ̂)T (Xβ̂ − Xη) = (Y − HY )T (HY − HXη) =

Y T (I − H)H(Y − Xη) = 0.

Thus QOLS(η) =

‖Y − Xη‖2 = ‖Y − Xβ̂ + Xβ̂ −Xη‖2 =

‖Y − Xβ̂‖2 + ‖Xβ̂ − Xη‖2 + 2(Y − Xβ̂)T (Xβ̂ −Xη).

Hence
‖Y − Xη‖2 = ‖Y − Xβ̂‖2 + ‖Xβ̂ −Xη‖2. (2.16)

So
‖Y −Xη‖2 ≥ ‖Y − Xβ̂‖2

with equality iff
X(β̂ − η) = 0

iff β̂ = η since X is full rank. �

Alternatively calculus can be used. Notice that ri(η) = Yi − xi,1η1 −
xi,2η2 − · · · − xi,pηp. Recall that xT

i is the ith row of X while xj is the jth
column. Since QOLS(η) =

n∑
i=1

(Yi − xi,1η1 − xi,2η2 − · · · − xi,pηp)
2,

the jth partial derivative

∂QOLS(η)

∂ηj
= −2

n∑
i=1

xi,j(Yi−xi,1η1−xi,2η2−· · ·−xi,pηp) = −2(xj)T (Y −Xη)

for j = 1, ..., p. Combining these equations into matrix form, setting the
derivative to zero and calling the solution β̂ gives

XTY − XTXβ̂ = 0,
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or
XT Xβ̂ = XT Y . (2.17)

Equation (2.17) is known as the normal equations. If X has full rank then
β̂ = (XT X)−1XT Y . To show that β̂ is the global minimizer of the OLS
criterion, use the argument following Equation (2.16).

2.9 Two Important Special Cases

When studying a statistical model, it is often useful to try to understand
the model that contains a constant but no nontrivial predictors, then try to
understand the model with a constant and one nontrivial predictor, then the
model with a constant and two nontrivial predictors and then the general
model with many predictors. In this text, most of the models are such that
Y is independent of x given xTβ, written

Y x|xT β.

Then wi = xT
i β̂ is a scalar, and trying to understand the model in terms

of xT
i β̂ is about as easy as trying to understand the model in terms of one

nontrivial predictor. In particular, the plot of xT
i β̂ versus Yi is essential.

For MLR, the two main benefits of studying the MLR model with one
nontrivial predictor X are that the data can be plotted in a scatterplot of Xi

versus Yi and that the OLS estimators can be computed by hand with the
aid of a calculator if n is small.

2.9.1 The Location Model

The location model
Yi = µ+ ei, i = 1, . . . , n (2.18)

is a special case of the multiple linear regression model where p = 1, X = 1
and β = β1 = µ. This model contains a constant but no nontrivial predictors.

In the location model, β̂OLS = β̂1 = µ̂ = Y . To see this, notice that

QOLS(η) =

n∑
i=1

(Yi − η)2 and
dQOLS(η)

dη
= −2

n∑
i=1

(Yi − η).
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Setting the derivative equal to 0 and calling the solution µ̂ gives
∑n

i=1 Yi = nµ̂
or µ̂ = Y . The second derivative

d2QOLS(η)

dη2
= 2n > 0,

hence µ̂ is the global minimizer.

2.9.2 Simple Linear Regression

The simple linear regression (SLR) model is

Yi = β1 + β2Xi + ei = α+ βXi + ei

where the ei are iid with E(ei) = 0 and VAR(ei) = σ2 for i = 1, ..., n.
The Yi and ei are random variables while the Xi are treated as known
constants. The parameters β1, β2 and σ2 are unknown constants that
need to be estimated. (If the Xi are random variables, then the model is
conditional on the Xi’s provided that the errors ei are independent of the
Xi. Hence the Xi’s are still treated as constants.)

The SLR model is a special case of the MLR model with p = 2, xi,1 ≡ 1
and xi,2 = Xi. The normal SLR model adds the assumption that the ei are
iid N(0, σ2). That is, the error distribution is normal with zero mean and
constant variance σ2. The response variable Y is the variable that you want
to predict while the predictor variable X is the variable used to predict the
response.

For SLR, E(Yi) = β1+β2Xi and the lineE(Y ) = β1+β2X is the regression
function. VAR(Yi) = σ2.

For SLR, the least squares estimators β̂1 and β̂2 minimize the least
squares criterion Q(η1, η2) =

∑n
i=1(Yi − η1 − η2Xi)

2. For a fixed η1 and η2, Q
is the sum of the squared vertical deviations from the line Y = η1 + η2X.

The least squares (OLS) line is Ŷ = β̂1 + β̂2X where the slope

β̂2 ≡ β̂ =

∑n
i=1(Xi −X)(Yi − Y )∑n

i=1(Xi −X)2

and the intercept β̂1 ≡ α̂ = Y − β̂2X.
By the chain rule,

∂Q

∂η1
= −2

n∑
i=1

(Yi − η1 − η2Xi)
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and
∂2Q

∂η2
1

= 2n.

Similarly,
∂Q

∂η2
= −2

n∑
i=1

Xi(Yi − η1 − η2Xi)

and
∂2Q

∂η2
1

= 2

n∑
i=1

X2
i .

Setting the first partial derivatives to zero and calling the solutions β̂1 and
β̂2 shows that the OLS estimators β̂1 and β̂2 satisfy the normal equations:

n∑
i=1

Yi = nβ̂1 + β̂2

n∑
i=1

Xi and

n∑
i=1

XiYi = β̂1

n∑
i=1

Xi + β̂2

n∑
i=1

X2
i .

The first equation gives β̂1 = Y − β̂2X.
There are several equivalent formulas for the slope β̂2.

β̂2 ≡ β̂ =

∑n
i=1(Xi −X)(Yi − Y )∑n

i=1(Xi −X)2
=

∑n
i=1 XiYi − 1

n
(
∑n

i=1Xi)(
∑n

i=1 Yi)∑n
i=1 X

2
i − 1

n
(
∑n

i=1 Xi)2

=

∑n
i=1(Xi −X)Yi∑n
i=1(Xi −X)2

=

∑n
i=1XiYi − nX Y∑n

i=1 X
2
i − n(X)2

= ρ̂sY /sX .

Here the sample correlation ρ̂ ≡ ρ̂(X, Y ) = corr(X, Y ) =∑n
i=1(Xi −X)(Yi − Y )

(n− 1)sXsY
=

∑n
i=1(Xi −X)(Yi − Y )√∑n

i=1(Xi −X)2
∑n

i=1(Yi − Y )2

where the sample standard deviation

sW =

√√√√ 1

n− 1

n∑
i=1

(Wi −W )2
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for W = X, Y. Notice that the term n− 1 that occurs in the denominator of
ρ̂, s2

Y and s2
X can be replaced by n as long as n is used in all 3 quantities.

Also notice that the slope β̂2 =
∑n

i=1 kiYi where the constants

ki =
Xi −X∑n

j=1(Xj −X)2
. (2.19)

2.10 The No Intercept MLR Model

The no intercept MLR model, also known as regression through the origin, is
still Y = Xβ + e, but there is no intercept β1 in the model, so X does not
contain a column of ones 1. Software gives output for this model if the “no
intercept” or “intercept = F” option is selected. For the no intercept model,
the assumption E(e) = 0 is important, and this assumption is rather strong.

Many of the usual MLR results still hold: β̂OLS = (XTX)−1XTY , the

vector of predicted fitted values Ŷ = Xβ̂OLS = HY where the hat matrix
H = X(XTX)−1XT provided the inverse exists, and the vector of residuals

is r = Y − Ŷ . The response plot and residual plot are made in the same way
and should be made before performing inference.

The main difference in the output is the ANOVA table. The ANOVA F
test in Section 2.4 tests Ho : β2 = · · · = βp = 0. The test in this section tests
Ho : β1 = · · · = βp = 0 ≡ Ho : β = 0. The following definition and test
follows Guttman (1982, p. 147) closely.

Definition 2.25. Assume that Y = Xβ+e where the ei are iid. Assume
that it is desired to test Ho : β = 0 versus HA : β �= 0.

a) The uncorrected total sum of squares

SST =

n∑
i=1

Y 2
i . (2.20)

b) The model sum of squares

SSM =

n∑
i=1

Ŷ 2
i . (2.21)

c) The residual sum of squares or error sum of squares is



CHAPTER 2. MULTIPLE LINEAR REGRESSION 72

SSE =

n∑
i=1

(Yi − Ŷi)
2 =

n∑
i=1

r2
i . (2.22)

d) The degrees of freedom (df) for SSM is p, the df for SSE is n− p and
the df for SST is n. The mean squares are MSE = SSE/(n− p) and MSM =
SSM/p.

The ANOVA table given for the “no intercept” or “intercept = F” option
is below.

Summary Analysis of Variance Table

Source df SS MS F p-value
Model p SSM MSM Fo=MSM/MSE for Ho:

Residual n-p SSE MSE β = 0

The 4 step no intercept ANOVA F test for β = 0 is below.
i) State the hypotheses Ho: β = 0, Ha: β �= 0.
ii) Find the test statistic Fo = MSM/MSE or obtain it from output.
iii) Find the p–value from output or use the F–table: p–value =

P (Fp,n−p > Fo).

iv) State whether you reject Ho or fail to reject Ho. If Ho is rejected, conclude
that there is an MLR relationship between Y and the predictors x1, ..., xp. If
you fail to reject Ho, conclude that there is not a MLR relationship between
Y and the predictors x1, ..., xp.

Warning: Several important models can be cast in the no intercept
MLR form, but often a different test than Ho : β = 0 is desired. For
example, when the generalized or weighted least squares models of Chapter
4 are transformed into no intercept MLR form, the test of interest is Ho:
β2 = · · · = βp = 0. The one way ANOVA model of Chapter 5 is equivalent
to the cell means model, which is in no intercept MLR form, but the test of
interest is Ho : β1 = · · · = βp.

Proposition 2.11. Suppose Y = Xβ + e where X may or may not
contain a column of ones. Then the partial F test of Section 2.6 can be used
for inference.
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Example 2.14. Consider the Gladstone (1905-6) data described in Ex-
ample 2.5. If the file of data sets regdata is downloaded into R/Splus, then
the ANOVA F statistic for testing β2 = · · · = β4 = 0 can be found with the
following commands. The command lsfit adds a column of ones to x which
contains the variables size, sex, breadth and circumference. Three of these
predictor variables are head measurements. Then the response Y is brain
weight, and the model contains a constant (intercept).

> y <- cbrainy

> x <- cbrainx[,c(11,10,3,6)]

> ls.print(lsfit(x,y))

F-statistic (df=4, 262)=196.2433

The ANOVA F test can also be found with the no intercept model by
adding a column of ones to R/Splus matrix x and then performing the partial
F test with the full model and the reduced model that only uses the column
of ones. Notice that the “intercept=F” option needs to be used to fit both
models. The residual standard error = RSE =

√
MSE. Thus SSE = (n −

k)(RSE)2 where n− k is the denominator degrees of freedom for the F test
and k is the numerator degrees of freedom = number of variables in the
model. The column of ones xone is counted as a variable. The last line of
output computes the partial F statistic and is again ≈ 196.24.

> xone <- 1 + 0*1:267

> x <- cbind(xone,x)

> ls.print(lsfit(x,y,intercept=F))

Residual Standard Error=82.9175

F-statistic (df=5, 262)=12551.02

Estimate Std.Err t-value Pr(>|t|)

xone 99.8495 171.6189 0.5818 0.5612

size 0.2209 0.0358 6.1733 0.0000

sex 22.5491 11.2372 2.0066 0.0458

breadth -1.2464 1.5139 -0.8233 0.4111

circum 1.0255 0.4719 2.1733 0.0307

> ls.print(lsfit(x[,1],y,intercept=F))

Residual Standard Error=164.5028
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F-statistic (df=1, 266)=15744.48

Estimate Std.Err t-value Pr(>|t|)

X 1263.228 10.0674 125.477 0

> ((266*(164.5028)^2 - 262*(82.9175)^2)/4)/(82.9175)^2

[1] 196.2435

2.11 Summary

1) The response variable is the variable that you want to predict. The pre-
dictor variables are the variables used to predict the response variable.

2) Regression is the study of the conditional distribution Y |x.

3) The MLR model is

Yi = xi,1β1 + xi,2β2 + · · · + xi,pβp + ei = xT
i β + ei

for i = 1, . . . , n. Here n is the sample size and the random variable ei is the ith
error. Assume that the errors are iid withE(ei) = 0 and VAR(ei) = σ2 <∞.
Assume that the errors are independent of the predictor variables xi.

4) In matrix notation, these n equations become

Y = Xβ + e,

where Y is an n × 1 vector of dependent variables, X is an n × p matrix
of predictors, β is a p× 1 vector of unknown coefficients, and e is an n × 1
vector of unknown errors.

5) The OLS estimators are β̂OLS = (XTX)−1XTY and σ̂2 = MSE =∑n
i=1 r

2
i /(n − p). Thus σ̂ =

√
MSE. The vector of predicted or fitted values

Ŷ OLS = Xβ̂OLS = HY where the hat matrix H = X(XTX)−1XT . The
ith fitted value Ŷi = xT

i β̂. The ith residual ri = Yi − Ŷi and the vector of
residuals r = Y − Ŷ = (I −H)Y . The least squares regression equation for
a model containing a constant is Ŷ = β̂1 + β̂2x2 + · · · + β̂pxp.

6) Always make the response plot of Ŷ versus Y and residual plot of Ŷ
versus r for any MLR analysis. The response plot is used to visualize the
MLR model, that is, to visualize the conditional distribution of Y |xTβ. If the
iid constant variance MLR model is useful, then i) the plotted points in the
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response plot should scatter about the identity line with no other pattern,
and ii) the plotted points in the residual plot should scatter about the r = 0
line with no other pattern. If either i) or ii) is violated, then the iid constant
variance MLR model is not sustained. In other words, if the plotted points in
the residual plot show some type of dependency, eg increasing variance or a
curved pattern, then the multiple linear regression model may be inadequate.

7) Use xf < maxhi for valid predictions.

8) If the MLR model contains a constant, then SSTO = SSE + SSR where
SSTO =

∑n
i=1(Yi−Y )2, SSR =

∑n
i=1(Ŷi−Y )2 and SSE =

∑n
i=1(Yi−Ŷi)

2 =∑n
i=1 r

2
i .

9) If the MLR model contains a constant, then R2 = [corr(Yi, Ŷi)]
2 =

SSR

SSTO
= 1 − SSE

SSTO
.

Source df SS MS F p-value
Regression p-1 SSR MSR Fo=MSR/MSE for Ho:
Residual n-p SSE MSE β2 = · · · = βp = 0

10) Be able to perform the 4 step ANOVA F test of hypotheses:
i) State the hypotheses Ho: β2 = · · · = βp = 0 Ha: not Ho.
ii) Find the test statistic Fo = MSR/MSE or obtain it from output.
iii) Find the p–value from output or use the F–table: p–value =

P (Fp−1,n−p > Fo).

iv) State whether you reject Ho or fail to reject Ho. If Ho is rejected, conclude
that there is an MLR relationship between Y and the predictors x2, ..., xp. If
you fail to reject Ho, conclude that there is a not a MLR relationship between
Y and the predictors x2, ..., xp.

11) The large sample 100 (1 − δ)% CI for E(Yf |xf ) = xT
f β = E(Ŷf ) is

Ŷf ± tn−p,1−δ/2se(Ŷf) where P (T ≤ tn−p,δ) = δ if T has a t distribution with
n− p degrees of freedom.

12) The 100 (1 − δ)% PI for Yf is Ŷf ± tn−p,1−δ/2se(pred).
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Full model

Source df SS MS Fo and p-value
Regression p− 1 SSR MSR Fo=MSR/MSE

Residual dfF = n− p SSE(F) MSE(F) for Ho:β2 = · · · = βp = 0

Reduced model

Source df SS MS Fo and p-value
Regression q − 1 SSR MSR Fo=MSR/MSE

Residual dfR = n − q SSE(R) MSE(R) for Ho: β2 = · · · = βq = 0

13) Be able to perform the 4 step partial F test = change in SS F
test of hypotheses: i) State the hypotheses Ho: the reduced model is good
Ha: use the full model.
ii) Find the test statistic FR =[

SSE(R) − SSE(F )

dfR − dfF

]
/MSE(F )

iii) Find the p–value = P(FdfR−dfF ,dfF
> FR). (On exams typically an F

table is used. Here dfR − dfF = p− q = number of parameters set to 0, and
dfF = n− p).
iv) State whether you reject Ho or fail to reject Ho. Reject Ho if the p–value
< δ and conclude that the full model should be used. Otherwise, fail to reject
Ho and conclude that the reduced model is good.

Label Estimate Std. Error t-value p-value

Constant β̂1 se(β̂1) to,1 for Ho: β1 = 0

x2 β̂2 se(β̂2) to,2 = β̂2/se(β̂2) for Ho: β2 = 0
...

xp β̂p se(β̂p) to,p = β̂p/se(β̂p) for Ho: βp = 0

14) The 100 (1 − δ) % CI for βk is β̂k ± tn−p,1−δ/2 se(β̂k). If the degrees
of freedom d = n− p > 30, use the N(0,1) cutoff z1−δ/2.

15) The corresponding 4 step t–test of hypotheses has the following steps:
i) State the hypotheses Ho: βk = 0 Ha: βk �= 0.
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ii) Find the test statistic to,k = β̂k/se(β̂k) or obtain it from output.
iii) Find the p–value from output or use the t–table: p–value =

2P (tn−p < −|to,k|).
Use the normal table or ν = ∞ in the t–table if the degrees of freedom
ν = n− p > 30.
iv) State whether you reject Ho or fail to reject Ho and give a nontechnical
sentence restating your conclusion in terms of the story problem. If Ho is
rejected, then conclude that xk is needed in the MLR model for Y given that
the other predictors are in the model. If you fail to reject Ho, then conclude
that xk is not needed in the MLR model for Y given that the other predictors
are in the model.

16) Given
∑n

i=1(Xi − X)(Yi − Y ),
∑n

i=1(Xi − X)2, X, and Y , find the

least squares line Ŷ = β̂1 + β̂2X where

β̂2 =

∑n
i=1(Xi −X)(Yi − Y )∑n

i=1(Xi −X)2

and β̂1 = Y − β̂2X.

17) Given ρ̂, sX , sY , X , and Y , find the least squares line Ŷ = β̂1 + β̂2X
where β̂2 = ρ̂sY /sX and β̂1 = Y − β̂2X.

2.12 Complements

Under regularity conditions, the least squares (OLS) estimator β̂ satisfies

√
n(β̂ − β)

D→ Np(0, σ
2 W ) (2.23)

when
XT X

n
→ W −1.

This large sample result is analogous to the central limit theorem and is often
a good approximation if n > 5p and the error distribution has “light tails,”
ie, the probability of an outlier is nearly 0 and the tails go to zero at an
exponential rate or faster. For error distributions with heavier tails, much
larger samples are needed, and the assumption that the variance σ2 exists is
crucial, eg, Cauchy errors are not allowed.
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Under the regularity conditions, much of the inference that is valid for
the normal MLR model is approximately valid for the iid error MLR model
when the sample size is large. For example, confidence intervals for βi are
asymptotically correct, as are t tests for βi = 0 (see Li and Duan 1989, p.
1035), the MSE is an estimator of σ2 by Theorem 2.6 and variable selection
procedures perform well (see Chapter 3 and Olive and Hawkins 2005).

Algorithms for OLS are described in Datta (1995), Dongarra, Moler,
Bunch and Stewart (1979), and Golub and Van Loan (1989). See Harter
(1974a,b, 1975a,b,c, 1976) for a historical account of multiple linear regres-
sion. Draper (2000) provides a bibliography of more recent references.

Cook and Weisberg (1997, 1999 ch. 17) call a plot that emphasizes model
agreement a model checking plot.

Anscombe (1961) and Anscombe and Tukey (1963) suggested graphi-
cal methods for checking multiple linear regression and experimental design
methods that were the “state of the art” at the time.

The rules of thumb given in this chapter for residual plots are not perfect.
Cook (1998, p. 4–6) gives an example of a residual plot that looks like a
right opening megaphone, but the MLR assumption that was violated was
linearity, not constant variance. Ghosh (1987) gives an example where the
residual plot shows no pattern even though the constant variance assumption
is violated. Searle (1988) shows that residual plots will have parallel lines if
several cases take on each of the possible values of the response variable, eg
if the response is a count.

Several authors have suggested using the response plot to visualize the
coefficient of determination R2 in multiple linear regression. See for example
Chambers, Cleveland, Kleiner, and Tukey (1983, p. 280). Anderson-Sprecher
(1994) provides an excellent discussion about R2. Kachigan (1982, p. 174
– 177) also gives a good explanation of R2. Also see Kv̊alseth (1985) and
Freedman (1983).

Hoaglin and Welsh (1978) discuss the hat matrix H , and Brooks, Carroll
and Verdini (1988) recommend using xf < maxhi for valid predictions. Si-
multaneous prediction intervals are given by Sadooghi-Alvandi (1990). Olive
(2007) suggests three large sample prediction intervals for MLR that are valid
under the iid error MLR model. Also see Schoemoyer (1992).

Sall (1990) discusses the history of added variable plots while Darlington
(1969) provides an interesting proof that β̂ minimizes the OLS criterion.
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2.12.1 Lack of Fit Tests

Label Estimate Std. Error t-value p-value

Constant β̂1 se(β̂1) to,1 for Ho: β1 = 0

x2 β̂2 se(β̂2) to,2 = β̂2/se(β̂2) for Ho: β2 = 0
...

xp β̂p se(β̂p) to,p = β̂p/se(β̂p) for Ho: βp = 0

R Squared: R2

Sigma hat:
√
MSE

Number of cases: n
Degrees of Freedom : n− p

Source df SS MS F p-value
Regression p-1 SSR MSR Fo=MSR/MSE for Ho:
Residual n-p SSE MSE β2 = · · · = βp = 0

The typical “relevant OLS output” has the form given above, but occa-
sionally software also includes output for a lack of fit test as shown below.

Source df SS MS Fo
Regression p− 1 SSR MSR Fo=MSR/MSE
Residual n− p SSE MSE
lack of fit c− p SSLF MSLF FLF = MSLF/MSPE
pure error n− c SSPE MSPE

The lack of fit test assumes that

Yi = m(xi) + ei (2.24)

where E(Yi|xi) = m(xi), m is some possibly nonlinear function, and that
the ei are iid N(0, σ2). Notice that the MLR model is the special case with
m(xi) = xT

i β. The lack of fit test needs at least one replicate: 2 or more Ys
with the same value of predictors x. Then there a c “replicate groups” with
nj observations in the jth group. Each group has the vector of predictors
xj, say, and at least one nj > 1. Also,

∑c
j=1 nj = n. Denote the Ys in the

jth group by Yij , and let the sample mean of the Ys in the jth group be Y j.
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Then
1

nj − 1

nj∑
i=1

(Yij − Y j)
2

is an estimator of σ2 for each group with nj > 1. Let

SSPE =
c∑

j=1

nj∑
i=1

(Yij − Y j)
2.

Then MSPE = SSPE/(n − c) is an unbiased estimator of σ2 when model
(2.24) holds, regardless of the form of m. The PE in SSPE stands for “pure
error.”

Now SSLF = SSE − SSPE =
∑c

j=1 nj(Y j − Ŷj)
2. Notice that Y j is an

unbiased estimator of m(xj) while Ŷj is an estimator of m if the MLR model
is appropriate: m(xj) = xT

j β. Hence SSLF and MSLF can be very large if
the MLR model is not appropriate.

The 4 step lack of fit test is i) Ho: no evidence of MLR lack of fit, HA:
there is lack of fit for the MLR model.
ii) FLF = MSLF/MSPE .
iii) The p–value = P (Fc−p,n−c > FLF).
iv) Reject Ho if p–value < δ and state the HA claim that there is lack of fit.
Otherwise, fail to reject Ho and state that there is not enough evidence to
conclude that there is MLR lack of fit.

Although the lack of fit test seems clever, examining the response plot and
residual plot is a much more effective method for examining whether or not
the MLR model fits the data well provided that n > 10p. A graphical version
of the lack of fit test would compute the Y j and see whether they scatter
about the identity line in the response plot. When there are no replicates,
the range of Ŷ could be divided into several narrow nonoverlapping intervals
called slices. Then the mean Y j of each slice could be computed and a step
function with step height Y j at the jth slice could be plotted. If the step
function follows the identity line, then there is no evidence of lack of fit.
However, it is easier to check whether the Yi are scattered about the identity
line. Examining the residual plot is useful because it magnifies deviations
from the identity line that may be difficult to see until the linear trend is
removed. The lack of fit test may be sensitive to the assumption that the
errors are iid N(0, σ2).
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When Y x|xTβ, then the response plot of the estimated sufficient
predictor (ESP) xT β̂ versus Y is used to visualize the conditional distribution
of Y |xTβ, and will often greatly outperform the corresponding lack of fit test.
When the response plot can be combined with a good lack of fit plot such as
a residual plot, using a one number summary of lack of fit such as the test
statistic FLF makes little sense.

Nevertheless, the literature for lack of fit tests for various statistical meth-
ods is enormous. See Joglekar, Schuenemeyer and LaRiccia (1989), Cheng
and Wu (1994), Kauermann and Tutz (2001), Peña and Slate (2006) and Su
and Yang (2006) for references.

For the following homework problems, Cody and Smith (2006) is useful
for SAS, Cook and Weisberg (1999) for Arc. Becker, Chambers and Wilks
(1988) and Crawley (2007) are useful for R and Splus.

2.13 Problems

Problems with an asterisk * are especially important.

Output for Problem 2.1

Full Model Summary Analysis of Variance Table

Source df SS MS F p-value

Regression 6 265784. 44297.4 172.14 0.0000

Residual 67 17240.9 257.327

Reduced Model Summary Analysis of Variance Table

Source df SS MS F p-value

Regression 1 264621. 264621. 1035.26 0.0000

Residual 72 18403.8 255.608

2.1. Assume that the response variable Y is height, and the explanatory
variables are X2 = sternal height, X3 = cephalic index, X4 = finger to ground,
X5 = head length, X6 = nasal height, X7 = bigonal breadth. Suppose that
the full model uses all 6 predictors plus a constant (= X1) while the reduced
model uses the constant and sternal height. Test whether the reduced model
can be used instead of the full model using the output above. The data set
had 74 cases.
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Output for Problem 2.2

Full Model Summary Analysis of Variance Table

Source df SS MS F p-value

Regression 9 16771.7 1863.52 1479148.9 0.0000

Residual 235 0.29607 0.0012599

Reduced Model Summary Analysis of Variance Table

Source df SS MS F p-value

Regression 2 16771.7 8385.85 6734072.0 0.0000

Residual 242 0.301359 0.0012453

Coefficient Estimates, Response = y, Terms = (x2 x2^2)

Label Estimate Std. Error t-value p-value

Constant 958.470 5.88584 162.843 0.0000

x2 -1335.39 11.1656 -119.599 0.0000

x2^2 421.881 5.29434 79.685 0.0000

2.2. The above output comes from the Johnson (1996) STATLIB data
set bodyfat after several outliers are deleted. It is believed that Y = β1 +
β2X2 + β3X

2
2 + e where Y is the person’s bodyfat and X2 is the person’s

density. Measurements on 245 people were taken. In addition to X2 and X2
2 ,

7 additional measurements X4, ..., X10 were taken. Both the full and reduced
models contain a constant X1 ≡ 1.

a) Predict Y if X2 = 1.04. (Use the reduced model Y = β1 + β2X2 +
β3X

2
2 + e.)

b) Test whether the reduced model can be used instead of the full model.

2.3. The output on the next page was produced from the file mussels.lsp
in Arc. See Cook and Weisberg (1999a). Let Y = log(M) where M is the
muscle mass of a mussel. Let X1 ≡ 1, X2 = log(H) where H is the height
of the shell, and let X3 = log(S) where S is the shell mass. Suppose that it
is desired to predict Yf if log(H) = 4 and log(S) = 5, so that xT

f = (1, 4, 5).

Assume that se(Ŷf ) = 0.410715 and that se(pred) = 0.467664.

a) If xT
f = (1, 4, 5) find a 99% confidence interval for E(Yf ).

b) If xT
f = (1, 4, 5) find a 99% prediction interval for Yf .
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Output for Problem 2.3

Label Estimate Std. Error t-value p-value

Constant -5.07459 1.85124 -2.741 0.0076

log[H] 1.12399 0.498937 2.253 0.0270

log[S] 0.573167 0.116455 4.922 0.0000

R Squared: 0.895655 Sigma hat: 0.223658 Number of cases: 82

(log[H] log[S]) (4 5)

Prediction = 2.2872, s(pred) = 0.467664,

Estimated population mean value = 2.2872, s = 0.410715

Output for Problem 2.4 Coefficient Estimates Response = height

Label Estimate Std. Error t-value p-value

Constant 227.351 65.1732 3.488 0.0008

sternal height 0.955973 0.0515390 18.549 0.0000

finger to ground 0.197429 0.0889004 2.221 0.0295

R Squared: 0.879324 Sigma hat: 22.0731

Summary Analysis of Variance Table

Source df SS MS F p-value

Regression 2 259167. 129583. 265.96 0.0000

Residual 73 35567.2 487.222

2.4. The output above is from the multiple linear regression of the re-
sponse Y = height on the two nontrivial predictors sternal height = height at
shoulder and finger to ground = distance from the tip of a person’s middle
finger to the ground.

a) Consider the plot with Yi on the vertical axis and the least squares
fitted values Ŷi on the horizontal axis. Sketch how this plot should look if
the multiple linear regression model is appropriate.

b) Sketch how the residual plot should look if the residuals ri are on the
vertical axis and the fitted values Ŷi are on the horizontal axis.

c) From the output, are sternal height and finger to ground useful for
predicting height? (Perform the ANOVA F test.)

2.5. Suppose that it is desired to predict the weight of the brain (in
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grams) from the cephalic index measurement. The output below uses data
from 267 people.

predictor coef Std. Error t-value p-value

Constant 865.001 274.252 3.154 0.0018

cephalic 5.05961 3.48212 1.453 0.1474

Do a 4 step test for β2 �= 0.

2.6. Suppose that the scatterplot of X versus Y is strongly curved rather
than ellipsoidal. Should you use simple linear regression to predict Y from
X? Explain.

2.7. Suppose that the 95% confidence interval for β2 is (−17.457, 15.832).
In the simple linear regression model, is X a useful linear predictor for Y ?
If your answer is no, could X be a useful predictor for Y ? Explain.

2.8. Suppose it is desired to predict the yearly return from the stock
market from the return in January. Assume that the correlation ρ̂ = 0.496.
Using the table below, find the least squares line Ŷ = β̂1 + β̂2X.

variable mean X or Y standard deviation s
January return 1.75 5.36
yearly return 9.07 15.35

2.9. Suppose that
∑

(Xi −X)(Yi − Y ) = 70690.0,∑
(Xi −X)2 = 19800.0, X = 70.0 and Y = 312.28.

a) Find the least squares slope β̂2.

b) Find the least squares intercept β̂1.

c) Predict Y if X = 80.



CHAPTER 2. MULTIPLE LINEAR REGRESSION 85

xi yi xi − x yi − y (xi − x)(yi − y) (xi − x)2

38 41

56 63

59 70

64 72

74 84

2.10. In the above table, xi is the length of the femur and yi is the
length of the humerus taken from five dinosaur fossils (Archaeopteryx) that
preserved both bones. See Moore (2000, p. 99).

a) Complete the table and find the least squares estimators β̂1 and β̂2.

b) Predict the humerus length if the femur length is 60.

2.11. Suppose that the regression model is Yi = 7+βXi+ei for i = 1, ..., n
where the ei are iid N(0, σ2) random variables. The least squares criterion

is Q(η) =
n∑

i=1

(Yi − 7 − ηXi)
2.

a) What is E(Yi)?

b) Find the least squares estimator β̂ of β by setting the first derivative
d

dη
Q(η) equal to zero.

c) Show that your β̂ is the global minimizer of the least squares criterion

Q by showing that the second derivative
d2

dη2
Q(η) > 0 for all values of η.

2.12. The location model is Yi = µ+ei for i = 1, ..., n where the ei are iid
with mean E(ei) = 0 and constant variance VAR(ei) = σ2. The least squares

estimator µ̂ of µ minimizes the least squares criterion Q(η) =
n∑

i=1

(Yi − η)2.

To find the least squares estimator, perform the following steps.
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a) Find the derivative
d

dη
Q, set the derivative equal to zero and solve for

η. Call the solution µ̂.

b) To show that the solution was indeed the global minimizer of Q, show

that
d2

dη2
Q > 0 for all real η. (Then the solution µ̂ is a local min and Q is

convex, so µ̂ is the global min.)

2.13. The normal error model for simple linear regression through the
origin is

Yi = βXi + ei

for i = 1, ..., n where e1, ..., en are iid N(0, σ2) random variables.

a) Show that the least squares estimator for β is

β̂ =

∑n
i=1XiYi∑n
i=1 X

2
i

.

b) Find E(β̂).

c) Find VAR(β̂).

(Hint: Note that β̂ =
∑n

i=1 kiYi where the ki depend on the Xi which are
treated as constants.)

2.14. Suppose that the regression model is Yi = 10+2Xi2 +β3Xi3 +ei for
i = 1, ..., n where the ei are iid N(0, σ2) random variables. The least squares

criterion is Q(η3) =
n∑

i=1

(Yi − 10 − 2Xi2 − η3Xi3)
2. Find the least squares es-

timator β̂3 of β3 by setting the first derivative
d

dη3

Q(η3) equal to zero. Show

that your β̂3 is the global minimizer of the least squares criterion Q by show-

ing that the second derivative
d2

dη2
3

Q(η3) > 0 for all values of η3.

Minitab Problems
“Double click” means press the rightmost “mouse” button twice in rapid

succession. “Drag” means hold the mouse button down. This technique is
used to select “menu” options.
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After your computer is on get into Minitab, often by double clicking an
icon marked “shortcut to math programs” or “math progs” and then double
clicking on the icon marked “Student Minitab.”
i) In a few seconds, the Minitab session and worksheet windows fill the screen.
At the top of the screen there is a menu. The upper left corner has the menu
option “File.” Move your cursor to “File” and drag down the option “Open
Worksheet.” A window will appear. Double click on the icon “Student.” This
will display a large number of data sets.
ii) In the middle of the screen there is a “scroll bar,” a gray line with left and
right arrow keys. Use the right arrow key to make the data file “ Prof.mtw”
appear. Double click on “Prof.mtw.” A window will appear. Click on “OK.”
iii) The worksheet window will now be filled with data. The top of the screen
has a menu. Go to “Stat” and drag down “Regression.” Another window will
appear: drag down Regression (write this as Stat>Regression>Regression).
iv) A window will appear with variables to the left and the response vari-
able and predictors (explanatory variables) to the right. Double click on
“instrucrs” to make it the response. Double click on “manner” to make it
the (predictor) explanatory variable. Then click on “OK.”
v) The required output will appear in the session window. You can view the
output by using the vertical scroll bar on the right of the screen.
vi) Copy and paste the output into Word, or to print your single page of
output, go to “File,” and drag down the option “Print Session Window.” A
window will appear. Click on “ok.” Then get your output from the printer.

Use the F3 key to clear entries from a dialog window if you make a
mistake or want a new plot.

To get out of Minitab, move your cursor to the “x” in the upper right
corner of the screen. When asked whether to save changes, click on “no.”

2.15 (Minitab problem.) See the instructions above for using Minitab.
Get the data set prof.mtw. Assign the response variable to be instrucr (the
instructor rating from course evaluations) and the explanatory variable (pre-
dictor) to be manner (the manner of the instructor). Run a regression on
these variables.

a) Place the computer output into Word.

b) Write the regression equation.
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c) Predict instrucr if manner = 2.47.

d) To get residual and response plots you need to store the residuals and
fitted values. Use the menu commands “Stat>Regression>Regression” to
get the regression window. Put instrucr in the Response and manner in
the Predictors boxes. The click on Storage. From the resulting window
click on Fits and Residuals. Then click on OK twice.

To get a response plot, use the commands “Graph>Plot,” (double click)
place instrucr in the Y box, and Fits1 in the X box. Then click on OK.
Print the plot by clicking on the graph and then clicking on the printer icon.

e) To make a residual plot, use the menu commands “Graph>Plot” to
get a window. Place “Resi1” in the Y box and “Fits1” in the X box. Then
click on OK. Print the plot by clicking on the graph and then clicking on
the printer icon.

2.16. a) Enter the following data on the Minitab worksheet:

x y

30 73

20 50

60 128

80 170

40 87

50 108

60 135

30 60

70 148

60 132

To enter the data click on the C1 column header and enter x. Then click
on the C2 header and enter y. Then enter the data. Alternatively, copy the
data from Problem 2.17 obtained from (www.math.siu.edu/olive/regsas.txt).
Then in Minitab, use the menu commands “Edit>Paste Cells” and click on
“OK.” Obtain the regression output from Minitab with the menu commands
“Stat>Regression>Regression”.

b) Place the output into Word.

c) Write down the least squares equation.
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To save your output on your diskette, use the Word menu commands
“File > Save as.” In the Save in box select “3 1/2 Floppy a:” and in the
“File name box” enter HW2d16.doc. To get a Word printout, click on the
printer icon or use the menu commands “File>Print.”

d) To get residual and response plots you need to store the residuals and
fitted values. Use the menu commands “Stat>Regression>Regression” to get
the regression window. Put Y in the Response and X in the Predictors
boxes. The click on Storage. From the resulting window click on Fits and
Residuals. Then click on OK twice.

To make a response plot, use the menu commands “Graph>Plot” to get
a window. Place “Y” in the Y box and “Fits1” in the X box. Then click on
OK. Print the plot by clicking on the graph and then clicking on the printer
icon.

e) To make a residual plot of the fitted values versus the residuals, use the
menu commands “Graph>Plot” to get a window. Place “Resi1” in the Y
box and “Fits1” in the X box. Then click on OK. Print the plot by clicking
on the graph and then clicking on the printer icon.

f) To save your Minitab data on your diskette, use the menu commands
“File>Save Current Worksheet as.” In the resulting dialog window, the top
box says Save in and there is an arrow icon to the right of the top box. Click
several times on the arrow icon until the Save in box reads “My computer”,
then click on 3 1/2 Floppy(A:). In the File name box, enter H2d16.mtw.
Then click on OK.

SAS Problems

SAS is a statistical software package widely used in industry. You will
need a disk. Referring to the program in Problem 2.17, the semicolon “;”
is used to end SAS commands and the “options ls = 70;” command makes
the output readable. (An “*” can be used to insert comments into the SAS
program. Try putting an * before the options command and see what it does
to the output.) The next step is to get the data into SAS. The command
“data wcdata;” gives the name “wcdata” to the data set. The command
“input x y;” says the first entry is variable x and the 2nd variable y. The
command “cards;” means that the data is entered below. Then the data
in entered and the isolated semicolon indicates that the last case has been
entered. The command “proc print;” prints out the data. The command
“proc corr;” will give the correlation between x and y. The commands “proc
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plot; plot y*x;” makes a scatterplot of x and y. The commands “proc reg;
model y=x; output out = a p =pred r =resid;” tells SAS to perform a simple
linear regression with y as the response variable. The output data set is
called “a” and contains the fitted values and residuals. The command “proc
plot data = a;” tells SAS to make plots from data set “a” rather than data
set “wcdata.” The command “plot resid*(pred x);” will make a residual plot
of the fitted values versus the residuals and a residual plot of x versus the
residuals. The following plot command makes a response plot.

To use SAS on windows (PC), use the following steps.

i) Get into SAS, often by double clicking on an icon for programs such
as a “Math Progs” icon and then double clicking on a SAS icon. If your
computer does not have SAS, go to another computer.

ii) A window should appear with 3 icons. Double click on The SAS System
for ....

iii) Like Minitab, a window with a split screen will open. The top screen
says Log-(Untitled) while the bottom screen says Editor-Untitled1. Press the
spacebar and an asterisk appears: Editor-Untitled1*.
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2.17. a) Copy and paste the program for this problem from
(www.math.siu.edu/olive/reghw.txt), or enter the SAS program given below
in Notepad or Word. The ls stands for linesize so l is a lowercase L, not the
number one.

When you are done entering the program, save your file as h2d17.sas on
your diskette (A: drive). (On the top menu of the editor, use the commands
“File > Save as”. A window will appear. Use the upper right arrow to locate
“31/2 Floppy A” and then type the file name in the bottom box. Click on
OK.)

options ls = 70;

data wcdata;

input x y;

cards;

30 73

20 50

60 128

80 170

40 87

50 108

60 135

30 60

70 148

60 132

;

proc print;

proc corr;

proc plot; plot y*x;

proc reg;

model y=x;

output out =a p = pred r = resid;

proc plot data = a;

plot resid*(pred x);

plot y*pred;

run;

b) Get back into SAS, and from the top menu, use the “File> Open”
command. A window will open. Use the arrow in the upper right cor-
ner of the window to navigate to “31/2 Floppy(A:)”. (As you click on the
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arrow, you should see My Documents, C: etc, then 31/2 Floppy(A:).) Dou-
ble click on h2d17.sas. (Alternatively cut and paste the program into the
SAS editor window.) To execute the program, use the top menu commands
“Run>Submit”. An output window will appear if successful.

If you were not successful, look at the log window for hints on errors.
A single typo can cause failure. Reopen your file in Word or Notepad and
make corrections. Occasionally you can not find your error. Then find your
instructor or wait a few hours and reenter the program.

c) To copy and paste relevant output into Word or Notepad, click on the
output window and use the top menu commands “Edit>Select All” and then
the menu commands “Edit>Copy”.

In Notepad use the commands “Edit>Paste”. Then use the mouse to
highlight the relevant output. Then use the commands “Edit>Copy”.

Finally, in Word, use the commands “Edit>Paste”. You can also cut
output from Word and paste it into Notepad.

You may want to save your SAS output as the file HW2d17.doc on your
disk.

d) To save your output on your disk, use the Word menu commands “File
> Save as.” In the Save in box select “3 1/2 Floppy a:” and in the “File
name box” enter HW2d17.doc. To get a Word printout, click on the printer
icon or use the menu commands “File>Print.”

Save the output giving the least squares coefficients in Word.

e) Predict Y if X = 40.

f) What is the residual when X = 40?
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2.18. This problem shows how to use SAS for MLR. The data are from
Kutner, Nachtsheim, Neter and Li (2005, problem 6.5). The response is
“brand liking,” a measurement for whether the consumer liked the brand.
The variable X1 is “moisture content” and the variable X2 is “sweetness.”
Enter the program below as file h2d18.sas, or copy and paste the program
for this problem from (www.math.siu.edu/olive/reghw.txt).

options ls = 70;

data brand;

input y x1 x2;

cards;

64.0 4.0 2.0

73.0 4.0 4.0

61.0 4.0 2.0

76.0 4.0 4.0

72.0 6.0 2.0

80.0 6.0 4.0

71.0 6.0 2.0

83.0 6.0 4.0

83.0 8.0 2.0

89.0 8.0 4.0

86.0 8.0 2.0

93.0 8.0 4.0

88.0 10.0 2.0

95.0 10.0 4.0

94.0 10.0 2.0

100.0 10.0 4.0

;

proc print;

proc corr;

proc plot; plot y*(x1 x2);

proc reg;

model y=x1 x2;

output out =a p = pred r = resid;

proc plot data = a;

plot resid*(pred x1 x2);

plot y*pred;

run;
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a) Execute the SAS program and copy the output file into Notepad. Scroll
down the output that is now in Notepad until you find the regression coeffi-
cients and ANOVA table. Then cut and paste this output into Word.

b) Do the 4 step ANOVA F test.

You should scroll through your SAS output to see how it made the re-
sponse plot and various residual plots, but cutting and pasting these plots
is tedious. So we will use Minitab to get these plots. Find the program
for this problem from (www.math.siu.edu/olive/regsas.txt). Then copy and
paste the numbers (between “cards;” and the semicolon “;”) into Minitab.
Use the mouse commands “Edit>Paste Cells”. This should enter the data
in the Worksheet (bottom part of Minitab). Under C1 enter Y and under
C2 enter X1 under C3 enter X2. Use the menu commands
“Stat>Regression>Regression” to get a dialog window. Enter Y as the re-
sponse variable and X1 and X2 as the predictor variable. Click on Storage
then on Fits, Residuals and OK OK.

c) To make a response plot, enter the menu commands “Graph>Plot”
and place “Y” in the Y–box and “FITS1” in the X–box. Click on OK. Then
use the commands “Edit>Copy Graph” to copy the plot. Include the plot
in Word with the commands “Edit> Paste.” If these commands fail, click on
the graph and then click on the printer icon.

d) Based on the response plot, does a linear model seem reasonable?

e) To make a residual plot, enter the menu commands “Graph>Plot” and
place “RESI 1” in the Y–box and “FITS1” in the X–box. Click on OK. Then
use the commands “Edit>Copy Graph” to copy the plot. Include the plot
in Word with the commands “Edit> Paste.” If these commands fail, click on
the graph and then click on the printer icon.

f) Based on the residual plot does a linear model seem reasonable?

Problems using ARC

To quit Arc, move the cursor to the x in the upper right corner and click.

2.19∗. (Scatterplot in Arc.) Get cbrain.lsp from
(www.math.siu.edu/olive/regbk.htm), and save the file on a disk. Activate
the cbrain.lsp dataset with the menu commands “File > Load > 3 1/2
Floppy(A:) > cbrain.lsp.” Scroll up the screen to read the data description.

a) Make a plot of age versus brain weight brnweight. The commands
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“Graph&Fit > Plot of” will bring down a menu. Put age in the H box and
brnweight in the V box. Put sex in the Mark by box. Click OK. Make the
lowess bar on the plot read .1. Open Word.

In Arc, use the menu commands “Edit > Copy.” In Word, use the menu
commands “Edit > Paste.” This should copy the graph into the Word doc-
ument.

b) For a given age, which gender tends to have larger brains?

c) At what age does the brain weight appear to be decreasing?

2.20. (SLR in Arc.) Activate cbrain.lsp as in Problem 2.19. Brain weight
and the cube root of size should be linearly related. To add the cube root of
size to the data set, use the menu commands “cbrain > Transform.” From
the window, select size and enter 1/3 in the p: box. Then click OK. Get
some output with commands “Graph&Fit > Fit linear LS.” In the dialog
window, put brnweight in Response, and (size)1/3 in terms.

a) Cut and paste the output (from Coefficient Estimates to Sigma hat)
into Word. Write down the least squares equation Ŷ = b1 + b2x.

b) If (size)1/3 = 15, what is the estimated brnweight?

c) Make a residual plot of the fitted values versus the residuals. Use
the commands “Graph&Fit > Plot of” and put “L1:Fit-values” in H and
“L1:Residuals” in V. Put sex in the Mark by box. Move the OLS bar to 1.
Put the plot into Word. Does the plot look ellipsoidal with zero mean?

d) Make a response plot of the fitted values versus y = brnweight. Use
the commands “Graph&Fit > Plot of” and put “L1:Fit-values in H and
brnweight in V. Put sex in Mark by. Move the OLS bar to 1. Put the plot
into Word. Does the plot look linear?

2.21. In Arc enter the menu commands “File>Load>Data>ARCG” and
open the file mussels.lsp. This data set is from Cook and Weisberg (1999a).

The response variable Y is the mussel muscle mass M, and the explanatory
variables are X2 = S = shell mass, X3 = H = shell height, X4 = L = shell
length and X5 = W = shell width.

Enter the menu commands “Graph&Fit>Fit linear LS” and fit the model:
enter S, H, L, W in the “Terms/Predictors” box, M in the “Response” box
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and click on OK.

a) To get a response plot, enter the menu commands
“Graph&Fit>Plot of” and place L1:Fit-Values in the H–box and M in the
V–box. Copy the plot into Word.

b) Based on the response plot, does a linear model seem reasonable?

c) To get a residual plot, enter the menu commands “Graph&Fit>Plot
of” and place L1:Fit-Values in the H–box and L1:Residuals in the V–box.
Copy the plot into Word.

d) Based on the residual plot, what MLR assumption seems to be vio-
lated?

e) Include the regression output in Word.

f) Ignoring the fact that an important MLR assumption seems to have
been violated, do any of predictors seem to be needed given that the other
predictors are in the model?

g) Ignoring the fact that an important MLR assumption seems to have
been violated, perform the ANOVA F test.

2.22. Get cyp.lsp from (www.math.siu.edu/olive/regbk.htm), and save
the file on a disk: you can open the file in Notepad and then save it on a
disk using the Notepad menu commands “File>Save As” and clicking the top
checklist then click “Floppy 3 1/2 A:”. You could also save the file on the
desktop, load it in Arc from the desktop, and then delete the file (sending it
to the Recycle Bin).

a) In Arc enter the menu commands “File>Load>3 1/2 Floppy(A:)” and
open the file cyp.lsp. This data set consists of various measurements taken
on men from Cyprus around 1920. Let the response Y = height and X =
cephalic index = 100(head breadth)/(head length). Use Arc to get the least
squares output and include the relevant output in Word.

b) Intuitively, the cephalic index should not be a good predictor for a
person’s height. Perform a 4 step test of hypotheses with Ho: β2 = 0.

2.23. a) In Arc enter the menu commands “File>Load>3 1/2 Floppy(A:)”
and open the file cyp.lsp (obtained as in Problem 2.22).
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The response variable Y is height, and the explanatory variables are a
constant, X2 = sternal height (probably height at shoulder) and X3 = finger
to ground.

Enter the menu commands “Graph&Fit>Fit linear LS” and fit the model:
enter sternal height and finger to ground in the “Terms/Predictors” box,
height in the “Response” box and click on OK.

Include the output in Word. Your output should certainly include the
lines from “Response = height” to the ANOVA table.

b) Predict Y if X2 = 1400 and X3 = 650.

c) Perform a 4 step ANOVA F test of the hypotheses with
Ho: β2 = β3 = 0.

d) Find a 99% CI for β2.

e) Find a 99% CI for β3.

f) Perform a 4 step test for β2 = 0.

g) Perform a 4 step test for β3 = 0.

h) What happens to the conclusion in g) if δ = 0.01?

i) The Arc menu “L1” should have been created for the regression. Use
the menu commands “L1>Prediction” to open a dialog window. Enter 1400
650 in the box and click on OK. Include the resulting output in Word.

j) Let Xf,2 = 1400 and Xf,3 = 650 and use the output from i) to find a

95% CI for E(Yf ). Use the last line of the output, that is, se = S(Ŷf ).

k) Use the output from i) to find a 95% PI for Yf . Now se(pred) = s(pred).

l) Make a residual plot of the fitted values versus the residuals and make
the response plot of the fitted values versus Y . Include both plots in Word.
(See Problem 2.24.)

m) Do the plots suggest that the MLR model is appropriate? Explain.

2.24. In Arc enter the menu commands “File>Load>3 1/2 Floppy(A:)”
and open the file cyp.lsp (obtained as in Problem 2.22).
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The response variable Y is height, and the explanatory variables are
X2 = sternal height (probably height at shoulder) and X3 = finger to ground.

Enter the menu commands “Graph&Fit>Fit linear LS” and fit the model:
enter sternal height and finger to ground in the “Terms/Predictors” box,
height in the “Response” box and click on OK.

a) To get a response plot, enter the menu commands
“Graph&Fit>Plot of” and place L1:Fit-Values in the H–box and height in
the V–box. Copy the plot into Word.

b) Based on the response plot, does a linear model seem reasonable?

c) To get a residual plot, enter the menu commands “Graph&Fit>Plot
of” and place L1:Fit-Values in the H–box and L1:Residuals in the V–box.
Copy the plot into Word.

d) Based on the residual plot, does a linear model seem reasonable?

2.25. In Arc enter the menu commands “File>Load>3 1/2 Floppy(A:)”
and open the file cyp.lsp (obtained as in Problem 2.22).

The response variable Y is height, and the explanatory variables are X2

= sternal height, X3 = finger to ground, X4 = bigonal breadth X5 = cephalic
index X6 = head length and X7 = nasal height. Enter the menu commands
“Graph&Fit>Fit linear LS” and fit the model: enter the 6 predictors (in
order: X2 1st and X7 last) in the “Terms/Predictors” box, height in the
“Response” box and click on OK. This gives the full model. For the reduced
model, only use predictors 2 and 3.

a) Include the ANOVA tables for the full and reduced models in Word.

b) Use the menu commands “Graph&Fit>Plot of...” to get a dialog win-
dow. Place L2:Fit-Values in the H–box and L1:Fit-Values in the V–box.
Place the resulting plot in Word.

c) Use the menu commands “Graph&Fit>Plot of...” to get a dialog win-
dow. Place L2:Residuals in the H–box and L1:Residuals in the V–box. Place
the resulting plot in Word.

d) Both plots should cluster tightly about the identity line if the reduced
model is about as good as the full model. Is the reduced model good?
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e) Perform the 4 step partial F test (of Ho: the reduced model is good)
using the 2 ANOVA tables from part a).

2.26. a) Activate the cbrain.lsp data set in ARC. Fit least squares with
age, sex, size1/3, and headht as terms and brnweight as the response. As-
sume that the multiple linear regression model is appropriate (this may be
a reasonable assumption, 5 infants appear as outliers but the data set has
hardly any cases that are babies. If age was uniformly represented, the babies
might not be outliers anymore). Assuming that ARC makes the menu “L1”
for this regression, select “AVP-All 2D.” A window will appear. Move the
OLS slider bar to 1 and click on the ”zero line box”. The window will show
the added variable plots for age, sex, size1/3, and headht as you move along
the slider bar that is below “case deletions”. Include all 4 added variable
plots in Word.

b) What information do the 4 plots give? For example, which variables
do not seem to be needed?

(If it is clear that the zero and OLS lines intersect at the origin, then the
variable is probably needed, and the point cloud should be tilted away from
the zero line. If it is difficult to see where the two lines intersect since they
nearly coincide near the origin, then the variable may not be needed, and
the point cloud may not tilt away from the zero line.)

R/Splus Problem

2.27. a) Use the command source(“A:/regdata.txt”) to download the
data. See Preface or Section 17.1. You may also copy and paste
regdata.txt from (www.math.siu.edu/olive/regdata.txt) into R. You can
copy and paste the R following commands for this problem from
(www.math.siu.edu/olive/reghw.txt).

For the Buxton (1920) data suppose that the response Y = height and
the predictors were a constant, head length, nasal height, bigonal breadth and
cephalic index. There are 87 cases.

Type the following commands

zbux <- cbind(buxx,buxy)

zbux <- as.data.frame(zbux)

zfull <- lm(buxy~len+nasal+bigonal+cephalic,data=zbux)

zred <- lm(buxy~len+nasal,data=zbux)

anova(zred,zfull)
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b) Include the output in Word: press the Ctrl and c keys as the same
time. Then use the menu commands “Edit>Paste” in Word (or copy and
paste the output).

c) Use the output to perform the partial F test where the full model is
described in a) and the reduced model uses a constant, head length and nasal
height. The output from the anova(zred,zfull) command produces the
correct partial F statistic.

d) Use the following commands to make the response plot for the reduced
model. Include the plot in Word

plot(zred$fit,buxy)

abline(0,1)

e) Use the following command to make the residual plot for the reduced
model. Include the plot in Word.

plot(zred$fit,zred$resid)

f) The plots look bad because of 5 massive outiers. The following com-
mands remove the outliers. Include the output in Word.

zbux <- zbux[-c(60,61,62,63,64,65),]

zfull <- lm(buxy~len+nasal+bigonal+cephalic,data=zbux)

zred <- lm(buxy~len+nasal,data=zbux)

anova(zred,zfull)

g) Redo the partial F test.
h) Use the following commands to make the response plot for the reduced

model without the outliers. Include the plot in Word.

plot(zred$fit,zbux[,5])

abline(0,1)

i) Use the following command to make the residual plot for the reduced
model without the outliers. Include the plot in Word.

plot(zred$fit,zred$resid)
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j) Do the plots look ok?

2.28. Get the R commands for this problem from
(www.math.siu.edu/olive/reghw.txt). The data is such that Y = 2 + x2 +
x3 + x4 + e where the zero mean errors are iid [exponential(2) - 2]. Hence
the residual and response plots should show high skew. Note that β =
(2, 1, 1, 1)T . The R code uses 3 nontrivial predictors and a constant, and the
sample size n = 1000.

a) Copy and paste the commands for part a) of this problem into R.
Include the response plot im Word. Is the lowess curve fairly close to the
identity line?

b) Copy and paste the commands for part b) of this problem into R.
Include the residual plot im Word: press the Ctrl and c keys as the same
time. Then use the menu commands “Edit>Paste” in Word. Is the lowess
curve fairly close to the r = 0 line?

c) The output out$coef gives β̂. Write down β̂. Is β̂ close to β?

2.29. a) Download the R/Splus functions piplot and pisim from reg-
pack.txt.

b) The command pisim(n=100, type = 1)will produce the mean length
of the classical, semiparametric, conservative and asymptotically optimal PIs
when the errors are normal, as well as the coverage proportions. Give the
simulated lengths and coverages.

c) Repeat b) using the command pisim(n=100, type = 3). Now the
errors are EXP(1) - 1.

d) Download regdata.txt and type the command
piplot(cbrainx,cbrainy). This command gives the semiparametric PI
limits for the Gladstone data. Include the plot in Word.

e) The infants are in the lower left corner of the plot. Do the PIs seem
to be better for the infants or the bulk of the data. Explain briefly.



Chapter 3

Building an MLR Model

Building a multiple linear regression (MLR) model from data is one of the
most challenging regression problems. The “final full model” will have re-
sponse variable Y = t(Z), a constant x1 and predictor variables x2 =
t2(w2, ..., wr), ..., xp = tp(w2, ..., wr) where the initial data consists of Z,w2, ...,
wr. Choosing t, t2, ..., tp so that the final full model is a useful MLR approx-
imation to the data can be difficult.

Model building is an iterative process. Given the problem and data but
no model, the model building process can often be aided by graphs that help
visualize the relationships between the different variables in the data. Then
a statistical model can be proposed. This model can be fit and inference per-
formed. Then diagnostics from the fit can be used to check the assumptions
of the model. If the assumptions are not met, then an alternative model
can be selected. The fit from the new model is obtained, and the cycle is
repeated. This chapter provides some tools for building a good full model.

Warning: Researchers often have a single data set and tend to expect
statistics to provide far more information from the single data set than is
reasonable. MLR is an extremely useful tool, but MLR is at its best when
the final full model is known before collecting and examining the data. But
it is very common for researchers to build their final full model by using
the iterative process until the final model “fits the data well.” Researchers
should not expect that all or even many of their research questions can be
answered from such a full model. If the final MLR full model is built from
a single data set in order to fit that data set well, then typically inference
from that model will not be valid. The model may be useful for describing

102
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the data, but may perform very poorly for prediction of a future response.
The model may suggest that some predictors are much more important than
others, but a model that is chosen prior to collecting and examining the data
is generally much more useful for prediction and inference. A single data
set is a great place to start an analysis, but can be a terrible way
to end the analysis.

Often a final full model is built after collecting and examining the data.
This procedure is called “data snooping,” and such models can not be ex-
pected to be reliable. If possible, spend about 1/8 of the budget to collect
data and build an initial MLR model. Spend another 1/8 of the budget to
collect more data to check the initial MLR model. If changes are necessary,
continue this process until no changes from the previous step are needed,
resulting in a tentative MLR model. Then spend between 3/4 and 1/2 of the
budget to collect data assuming that the tentative model will be useful.

After obtaining a final full model, researchers will typically find a final
submodel after performing variable selection. Even if the final full model was
selected before collecting data, the final submodel, obtained after performing
variable selection, may not be useful for inference.

Rule of thumb 3.1. If the MLR model is built using the variable
selection methods from Section 3.4, then the final submodel can be used for
description but will often not be useful for inference and prediction.

3.1 Predictor Transformations

As a general rule, inferring about the distribution of Y |X from a lower
dimensional plot should be avoided when there are strong nonlinearities

among the predictors.
Cook and Weisberg (1999b, p. 34)

Predictor transformations are used to remove gross nonlinearities in the
predictors, and this technique is often very useful. Power transformations are
particularly effective, and the techniques of this section are often useful for
general regression problems, not just for multiple linear regression. A power
transformation has the form x = tλ(w) = wλ for λ �= 0 and x = t0(w) =
log(w) for λ = 0. Often λ ∈ ΛL where

ΛL = {−1,−1/2,−1/3, 0, 1/3, 1/2, 1} (3.1)



CHAPTER 3. BUILDING AN MLR MODEL 104

is called the ladder of powers. Often when a power transformation is needed,
a transformation that goes “down the ladder”, eg from λ = 1 to λ = 0 will
be useful. If the transformation goes too far down the ladder, eg if λ = 0 is
selected when λ = 1/2 is needed, then it will be necessary to go back “up
the ladder.” Additional powers such as ±2 and ±3 can always be added.

Definition 3.1. A scatterplot of x versus Y is used to visualize the
conditional distribution of Y |x. A scatterplot matrix is an array of scat-
terplots. It is used to examine the marginal relationships of the predictors
and response.

In this section we will only make a scatterplot matrix of the predictors.
Often nine or ten variables can be placed in a scatterplot matrix. The names
of the variables appear on the diagonal of the scatterplot matrix. The soft-
ware Arc gives two numbers, the minimum and maximum of the variable,
along with the name of the variable. The software R/Splus labels the values
of each variable in two places, see Example 3.2 below. Let one of the vari-
ables be W . All of the marginal plots above and below W have W on the
horizontal axis. All of the marginal plots to the left and the right of W have
W on the vertical axis.

There are several rules of thumb that are useful for visually selecting a
power transformation to remove nonlinearities from the predictors.

Rule of thumb 3.2. a) If strong nonlinearities are apparent in the
scatterplot matrix of the predictors w2, ..., wp, it is often useful to remove the
nonlinearities by transforming the predictors using power transformations.

b) Use theory if available.

c) Suppose that variable X2 is on the vertical axis and X1 is on the
horizontal axis and that the plot of X1 versus X2 is nonlinear. The unit rule
says that if X1 and X2 have the same units, then try the same transformation
for both X1 and X2.

Assume that all values of X1 and X2 are positive. Then the following six
rules are often used.

d) The log rule states that a positive predictor that has the ratio between
the largest and smallest values greater than ten should be transformed to logs.
So X > 0 and max(X)/min(X) > 10 suggests using log(X).
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e) The range rule states that a positive predictor that has the ratio
between the largest and smallest values less than two should not be trans-
formed. So X > 0 and max(X)/min(X) < 2 suggests keeping X.

f) The bulging rule states that changes to the power of X2 and the power
of X1 can be determined by the direction that the bulging side of the curve
points. If the curve is hollow up (the bulge points down), decrease the power
of X2. If the curve is hollow down (the bulge points up), increase the power
of X2 If the curve bulges towards large values of X1 increase the power of
X1. If the curve bulges towards small values of X1 decrease the power of X1.
See Tukey (1977, p. 173–176).

g) The ladder rule appears in Cook and Weisberg (1999a, p. 86).
To spread small values of a variable, make λ smaller.
To spread large values of a variable, make λ larger.

h) If it is known that X2 ≈ Xλ
1 and the ranges of X1 and X2 are such

that this relationship is one to one, then

Xλ
1 ≈ X2 and X

1/λ
2 ≈ X1.

Hence either the transformation Xλ
1 or X

1/λ
2 will linearize the plot. Note that

log(X2) ≈ λ log(X1), so taking logs of both variables will also linearize the
plot. This relationship frequently occurs if there is a volume present. For
example let X2 be the volume of a sphere and let X1 be the circumference
of a sphere.

i) The cube root rule says that if X is a volume measurement, then cube
root transformation X1/3 may be useful.

In the literature, it is sometimes stated that predictor transformations
that are made without looking at the response are “free.” The reasoning is
that the conditional distribution of Y |(x2 = a2, ..., xp = ap) is the same as
the conditional distribution of Y |[t2(x2) = t2(a2), ..., tp(xp) = tp(ap)]: there is
simply a change of labelling. Certainly if Y |x = 9 ∼ N(0, 1), then Y |√x =
3 ∼ N(0, 1). To see that Rule of thumb 3.2a does not always work, suppose
that Y = β1+β2x2+· · ·+βpxp+e where the xi are iid lognormal(0,1) random
variables. Then wi = log(xi) ∼ N(0, 1) for i = 2, ..., p and the scatterplot
matrix of the wi will be linear while the scatterplot matrix of the xi will
show strong nonlinearities if the sample size is large. However, there is an
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MLR relationship between Y and the xi while the relationship between Y
and the wi is nonlinear: Y = β1 + β2e

w2 + · · ·+ βpe
wp + e �= βTw + e. Given

Y and the wi with no information of the relationship, it would be difficult
to find the exponential transformation and to estimate the βi. The moral
is that predictor transformations, especially the log transformation, can and
often do greatly simplify the MLR analysis, but predictor transformations
can turn a simple MLR analysis into a very complex nonlinear analysis.

Theory, if available, should be used to select a transformation. Frequently
more than one transformation will work. For example if W = weight and X1

= volume = (X2)(X3)(X4), thenW versusX
1/3
1 and log(W ) versus log(X1) =

log(X2) + log(X3) + log(X4) may both work. Also if W is linearly related
with X2, X3, X4 and these three variables all have length units mm, say, then
the units of X1 are (mm)3. Hence the units of X

1/3
1 are mm.

Suppose that all values of the variable w to be transformed are positive.
The log rule says use log(w) if max(wi)/min(wi) > 10. This rule often works
wonders on the data and the log transformation is the most used (modified)
power transformation. If the variable w can take on the value of 0, use
log(w + c) where c is a small constant like 1, 1/2, or 3/8.

To use the ladder rule, suppose you have a scatterplot of two variables
xλ1

1 versus xλ2
2 where both x1 > 0 and x2 > 0. Also assume that the plotted

points follow a nonlinear one to one function. Consider the ladder of powers

ΛL = {−1,−1/2,−1/3, 0, 1/3, 1/2, 1, }.

To spread small values of the variable, make λi smaller. To spread large
values of the variable, make λi larger.

For example, if both variables are right skewed, then there will be many
more cases in the lower left of the plot than in the upper right. Hence small
variables need spreading. Figures 1.8 and 10.4 b), 11.1 b) and 15.11 a) have
this shape.

Consider the ladder of powers. Often no transformation (λ = 1) is best,
then the log transformation, then the square root transformation, then the
reciprocal transformation.

Example 3.1. Examine Figure 3.1. Let X1 = w and X2 = x. Since w is
on the horizontal axis, mentally add a narrow vertical slice to the plot. If a
large amount of data falls in the slice at the left of the plot, then small values
need spreading. Similarly, if a large amount of data falls in the slice at the
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Figure 3.1: Plots to Illustrate the Bulging and Ladder Rules

right of the plot (compared to the middle and left of the plot), then large
values need spreading. For the variable on the vertical axis, make a narrow
horizontal slice. If the plot looks roughly like the northwest corner of a square
then small values of the horizontal and large values of the vertical variable
need spreading. Hence in Figure 3.1a, small values of w need spreading.
Notice that the plotted points bulge up towards small values of the horizontal
variable. If the plot looks roughly like the northeast corner of a square, then
large values of both variables need spreading. Hence in Figure 3.1b, large
values of x need spreading. Notice that the plotted points bulge up towards
large values of the horizontal variable. If the plot looks roughly like the
southwest corner of a square, as in Figure 3.1c, then small values of both
variables need spreading. Notice that the plotted points bulge down towards
small values of the horizontal variable. If the plot looks roughly like the
southeast corner of a square, then large values of the horizontal and small
values of the vertical variable need spreading. Hence in Figure 3.1d, small
values of x need spreading. Notice that the plotted points bulge down towards
large values of the horizontal variable.

Example 3.2: Mussel Data. Cook and Weisberg (1999a, p. 351, 433,
447) gave a data set on 82 mussels sampled off the coast of New Zealand.
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Figure 3.2: Scatterplot Matrix for Original Mussel Data Predictors
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The response is muscle mass M in grams, and the predictors are a constant,
the length L and height H of the shell in mm, the shell width W and the
shell mass S. Figure 3.2 shows the scatterplot matrix of the predictors L,
H, W and S. Examine the variable length. Length is on the vertical axis
on the three top plots and the right of the scatterplot matrix (made with
R), labels this axis from 150 to 300. Length is on the horizontal axis on
the three leftmost marginal plots, and this axis is labelled from 150 to 300
on the bottom of the scatterplot matrix. The marginal plot in the bottom
left corner has length on the horizontal and shell on the vertical axis. The
marginal plot that is second from the top and second from the right has
height on the horizontal and width on the vertical axis.

Nonlinearity is present in several of the plots. For example, width and
length seem to be linearly related while length and shell have a nonlinear
relationship. The minimum value of shell is 10 while the max is 350. Since
350/10 = 35 > 10, the log rule suggests that logS may be useful. If logS
replaces S in the scatterplot matrix, then there may be some nonlinearity
present in the plot of logS versus W with small values of W needing spread-
ing. Hence the ladder rule suggests reducing λ from 1 and we tried log(W ).
Figure 3.3 shows that taking the log transformations of W and S results in
a scatterplot matrix that is much more linear than the scatterplot matrix of
Figure 3.2. Notice that the plot of W versus L and the plot of log(W ) versus
L both appear linear.

The plot of shell versus height in Figure 3.2 is nonlinear, and small values
of shell need spreading since if the plotted points were projected on the
horizontal axis, there would be too many points at values of shell near 0.
Similarly, large values of height need spreading.

3.2 Graphical Methods for Response Trans-

formations

If the ratio of largest to smallest value of y is substantial, we usually begin
by looking at log y.

Mosteller and Tukey (1977, p. 91)

The applicability of the multiple linear regression model can be expanded
by allowing response transformations. An important class of response trans-
formation models adds an additional unknown transformation parameter λo,
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such that

Yi = tλo(Zi) ≡ Z
(λo)
i = E(Yi|xi) + ei = xT

i β + ei. (3.2)

If λo was known, then Yi = tλo(Zi) would follow a multiple linear regression
model with p predictors including the constant. Here, β is a p × 1 vector
of unknown coefficients depending on λo, x is a p × 1 vector of predictors
that are assumed to be measured with negligible error, and the errors ei are
assumed to be iid with zero mean.

Definition 3.2. Assume that all of the values of the “response” Zi are
positive. A power transformation has the form Y = tλ(Z) = Zλ for λ �= 0
and Y = t0(Z) = log(Z) for λ = 0 where

λ ∈ ΛL = {−1,−1/2,−1/3, 0, 1/3, 1/2, 1}.

Definition 3.3. Assume that all of the values of the response variable
Yi are positive. Then the modified power transformation family

tλ(Zi) ≡ Z
(λ)
i =

Zλ
i − 1

λ
(3.3)

for λ �= 0 and Z
(0)
i = log(Zi). Generally λ ∈ Λ where Λ is some interval such

as [−1, 1] or a coarse subset such as ΛL. This family is a special case of the
response transformations considered by Tukey (1957).

A graphical method for response transformations computes the “fitted
values” Ŵi = xT

i β̂λ from the multiple linear regression model using Wi =
tλ(Zi) as the “response.” Then a “response plot” of the Ŵ versus W is made
for each of the seven values of λ ∈ ΛL. The plotted points follow the identity
line in a (roughly) evenly populated band if the iid error MLR model is
reasonable for Y = W and x.

By adding the “response” Z to the scatterplot matrix, the methods of
the previous section can also be used to suggest good values of λ, and it is
usually a good idea to use predictor transformations to remove nonlineari-
ties from the predictors before selecting a response transformation. Notice
that the graphical method is equivalent to making “response plots” for the
seven values of W = tλ(Z), and choosing the “best response plot” where the
MLR model seems “most reasonable.” The seven “response plots” are called
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transformation plots below. Recall our convention that a plot of X versus Y
means that X is on the horizontal axis and Y is on the vertical axis.

Warning: The Rule of thumb 3.2 does not always work. For example,
the log rule may fail. If the relationships in the scatterplot matrix are al-
ready linear or if taking the transformation does not increase the linearity
(especially in the row containing the response), then no transformation may
be better than taking a transformation. For the Arc data set evaporat.lsp,
the log rule suggests transforming the response variable Evap, but no trans-
formation works better.

Definition 3.4. A transformation plot is a plot of Ŵ versus W with the
identity line added as a visual aid.

There are several reasons to use a coarse grid of powers. First, several
of the powers correspond to simple transformations such as the log, square
root, and cube root. These powers are easier to interpret than λ = .28,
for example. According to Mosteller and Tukey (1977, p. 91), the most
commonly used power transformations are the λ = 0 (log), λ = 1/2,
λ = −1 and λ = 1/3 transformations in decreasing frequency of use. Sec-
ondly, if the estimator λ̂n can only take values in ΛL, then sometimes λ̂n will
converge (eg in probability) to λ∗ ∈ ΛL. Thirdly, Tukey (1957) showed that
neighboring power transformations are often very similar, so restricting the
possible powers to a coarse grid is reasonable. Note that powers can always
be added to the grid ΛL. Useful powers are ±1/4,±2/3,±2, and ±3. Powers
from numerical methods can also be added.

Application 3.1. This graphical method for selecting a response trans-
formation is very simple. Let Wi = tλ(Zi). Then for each of the seven values
of λ ∈ ΛL, perform OLS on (Wi,xi) and make the transformation plot of
Ŵi versus Wi. If the plotted points follow the identity line for λ∗, then take
λ̂o = λ∗, that is, Y = tλ∗(Z) is the response transformation. (Note that this
procedure can be modified to create a graphical diagnostic for a numerical
estimator λ̂ of λo by adding λ̂ to ΛL.)

If more than one value of λ ∈ ΛL gives a linear plot, take the simplest or
most reasonable transformation or the transformation that makes the most
sense to subject matter experts. Also check that the corresponding “residual
plots” of Ŵ versus W − Ŵ look reasonable. The values of λ in decreasing
order of importance are 1, 0, 1/2,−1 and 1/3. So the log transformation
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would be chosen over the cube root transformation if both transformation
plots look equally good.

After selecting the transformation, the usual checks should be made. In
particular, the transformation plot for the selected transformation is the
response plot, and a residual plot should also be made. The following example
illustrates the procedure. In the following example, the plots show tλ(Z) on
the vertical axis. The label “TZHAT” of the horizontal axis are the “fitted
values” that result from using tλ(Z) as the “response” in the OLS software.

Example 3.3: Textile Data. In their pioneering paper on response
transformations, Box and Cox (1964) analyze data from a 33 experiment
on the behavior of worsted yarn under cycles of repeated loadings. The “re-
sponse” Z is the number of cycles to failure and a constant is used along with
the three predictors length, amplitude and load. Using the normal profile log
likelihood for λo, Box and Cox determine λ̂o = −0.06 with approximate 95
percent confidence interval −0.18 to 0.06. These results give a strong indi-
cation that the log transformation may result in a relatively simple model,
as argued by Box and Cox. Nevertheless, the numerical Box–Cox transfor-
mation method provides no direct way of judging the transformation against
the data.

Shown in Figure 3.4 are transformation plots of Ẑ versus Zλ for four
values of λ except log(Z) is used if λ = 0. The plots show how the trans-
formations bend the data to achieve a homoscedastic linear trend. Perhaps
more importantly, they indicate that the information on the transformation
is spread throughout the data in the plot since changing λ causes all points
along the curvilinear scatter in Figure 3.4a to form along a linear scatter in
Figure 3.4c. Dynamic plotting using λ as a control seems quite effective for
judging transformations against the data and the log response transformation
does indeed seem reasonable.

Note the simplicity of the method: Figure 3.4a shows that a response
transformation is needed since the plotted points follow a nonlinear curve
while Figure 3.4c suggests that Y = log(Z) is the appropriate response
transformation since the plotted points follow the identity line. If all 7
plots were made for λ ∈ ΛL, then λ = 0 would be selected since this plot
is linear. Also, Figure 3.4a suggests that the log rule is reasonable since
max(Z)/min(Z) > 10.

The essential point of the next example is that observations that influence
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the choice of the usual Box–Cox numerical power transformation are often
easily identified in the transformation plots. The transformation plots are
especially useful if the bivariate relationships of the predictors, as seen in the
scatterplot matrix of the predictors, are linear.

Example 3.4: Mussel Data. Consider the mussel data of Example
3.2 where the response is muscle mass M in grams, and the predictors are
the length L and height H of the shell in mm, the logarithm logW of the
shell width W, the logarithm logS of the shell mass S and a constant. With
this starting point, we might expect a log transformation of M to be needed
because M and S are both mass measurements and logS is being used as
a predictor. Using logM would essentially reduce all measurements to the
scale of length. The Box–Cox likelihood method gave λ̂0 = 0.28 with ap-
proximate 95 percent confidence interval 0.15 to 0.4. The log transformation
is excluded under this inference leading to the possibility of using different
transformations of the two mass measurements.

Shown in Figure 3.5 are transformation plots for four values of λ. A strik-
ing feature of these plots is the two points that stand out in three of the four
plots (cases 8 and 48). The Box–Cox estimate λ̂ = 0.28 is evidently influenced
by the two outlying points and, judging deviations from the identity line in
Figure 3.5c, the mean function for the remaining points is curved. In other
words, the Box–Cox estimate is allowing some visually evident curvature in
the bulk of the data so it can accommodate the two outlying points. Recom-
puting the estimate of λo without the highlighted points gives λ̂o = −0.02,
which is in good agreement with the log transformation anticipated at the
outset. Reconstruction of the transformation plots indicated that now the
information for the transformation is consistent throughout the data on the
horizontal axis of the plot.

Note that in addition to helping visualize λ̂ against the data, the transfor-
mation plots can also be used to show the curvature and heteroscedasticity in
the competing models indexed by λ ∈ ΛL. Example 3.4 shows that the plot
can also be used as a diagnostic to assess the success of numerical methods
such as the Box–Cox procedure for estimating λo.

Example 3.5: Mussel Data Again. Return to the mussel data, this
time considering the regression of M on a constant and the four untrans-
formed predictors L, H, W and S. Figure 3.2 shows the scatterplot matrix
of the predictors L, H, W and S. Again nonlinearity is present. Figure
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3.3 shows that taking the log transformations of W and S results in a linear
scatterplot matrix for the new set of predictors L, H, logW , and log S. Then
the search for the response transformation can be done as in Example 3.4.

3.3 Main Effects, Interactions and Indicators

Section 1.7 explains interactions, factors and indicator variables in an ab-
stract setting when Y x|xTβ where xTβ is the sufficient predictor (SP).
MLR is such a model. The interpretations given Section 1.7 in terms of the
SP can be given in terms of E(Y |x) for MLR since E(Y |x) = xT β = SP
for MLR.

Definition 3.5. Suppose that the explanatory variables have the form
x2, ..., xk, xjj = x2

j , xij = xixj, x234 = x2x3x4, et cetera. Then the variables
x2, ..., xk are main effects. A product of two or more different main effects is
an interaction. A variable such as x2

2 or x3
7 is a power. An x2x3 interaction

will sometimes also be denoted as x2 : x3 or x2 ∗ x3.

Definition 3.6. A factor W is a qualitative random variable. Suppose
W has c categories a1, ..., ac. Then the factor is incorporated into the MLR
model by using c − 1 indicator variables xWi = 1 if W = ai and xWi = 0
otherwise, where one of the levels ai is omitted, eg, use i = 1, ..., c− 1. Each
indicator variable has 1 degree of freedom. Hence the degrees of freedom of
the c− 1 indicator variables associated with the factor is c− 1.

Rule of thumb 3.3. Suppose that the MLR model contains at least one
power or interaction. Then the corresponding main effects that make up the
powers and interactions should also be in the MLR model.

Rule of thumb 3.3 suggests that if x2
3 and x2x7x9 are in the MLR model,

then x2, x3, x7 and x9 should also be in the MLR model. A quick way to check
whether a term like x2

3 is needed in the model is to fit the main effects models
and then make a scatterplot matrix of the predictors and the residuals, where
the residuals are on the top row. Then the top row shows plots of xk versus
r, and if a plot is parabolic, then x2

k should be added to the model. Potential
predictors wj could also be added to the scatterplot matrix. If the plot of
wj versus r shows a positive or negative linear trend add wj to the model.
If the plot is quadratic, add wj and w2

j to the model. This technique is for
quantitative variables xk and wj.
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The simplest interaction to interpret is the interaction between a quanti-
tative variable x2 and a qualitative variable x3 with 2 levels. Suppose that
x3 = 1 for level a2 and x3 = 0 for level a1. Then a first order model with
interaction is SP = E(Y |x) = β1 + β2x2 + β3x3 + β4x2x3. This model yields
two unrelated lines in the conditional expectation depending on the value of
x3: E(Y |x) = β1 + β3 + (β2 + β4)x2 if x3 = 1 and E(Y |x) = β1 + β2x2 if
x3 = 0. If β4 = 0, then there are two parallel lines: E(Y |x) = β1 +β3 +β2x2

if x2 = 1 and E(Y |x) = β1 + β2x2 if x3 = 0. If β3 = β4 = 0, then the two
lines are coincident: E(Y |x) = β1 + β2x2 for both values of x3. If β3 = 0,
then the two lines have the same intercept: E(Y |x) = β1 + (β2 + β4)x2 if
x3 = 1 and E(Y |x) = β1 + β2x2 if x3 = 0.

Notice that β4 = 0 corresponds to no interaction. The estimated slopes
of the two lines will not be exactly identical, so the two estimated lines will
not be parallel even if there is no interaction. If the two estimated lines
have similar slopes and do not cross, there is evidence of no interaction,
while crossing lines is evidence of interaction provided that the two lines
are not nearly coincident. Two lines with very different slopes also suggests
interaction. In general, as factors have more levels and interactions have
more terms, eg x2x3x4x5, the interpretation of the model rapidly becomes
very complex.

Example 3.6. Two varieties of cement that replace sand with coal waste
products were compared to a standard cement mix. The response Y was the
compressive strength of the cement measured after 7, 28, 60, 90 or 180 days
of curing time = x2. This cement was intended for sidewalks and barriers
but not for construction. The data is likely from small batches of cement
prepared in the lab, and is likely correlated; however, MLR can be used for
exploratory and descriptive purposes. Actually using the different cement
mixtures in the field (eg as sidewalks), would be very expensive. The factor
mixture had 3 levels, 2 for the standard cement and 0 and 1 for the coal based
cements. A plot of x2 versus Y (not shown but see Problem 3.15), resembled
the left half of a quadratic Y = −c(x2 − 180)2. Hence x2 and x2

2 were added
to the model.

Figure 3.6 shows the response plot and residual plots from this model.
The standard cement mix uses the symbol + while the coal based mixes use
an inverted triangle and square. OLS lines based on each mix are added
as visual aids. The lines from the two coal based mixes do not intersect,
suggesting that there may not be an interaction between these two mixes.
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Figure 3.6: Plots to Illustrate Interaction for the Cement Data

There is an interaction between the standard mix and the two coal mixes
since these lines do intersect. All three types of cement become stronger
with time, but the standard mix has the greatest strength at early curing
times while the coal based cements become stronger than the standard mix at
the later times. Notice that the interaction is more apparent in the residual
plot. Problem 3.15 adds a factor Fx3 based on mix as well as the x2 ∗ Fx3

and x2
2 ∗Fx3 interactions. The resulting model is an improvement, but there

is still some curvature in the residual plot, and one case is not fit very well.

3.4 Variable Selection

Variable selection, also called subset or model selection, is the search for a
subset of predictor variables that can be deleted without important loss of
information. A model for variable selection in multiple linear regression can
be described by

Y = xTβ + e = βTx + e = xT
SβS + xT

EβE + e = xT
SβS + e (3.4)
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where e is an error, Y is the response variable, x = (xT
S ,x

T
E)T is a p × 1

vector of predictors, xS is a kS × 1 vector and xE is a (p − kS) × 1 vector.
Given that xS is in the model, βE = 0 and E denotes the subset of terms
that can be eliminated given that the subset S is in the model.

Since S is unknown, candidate subsets will be examined. Let xI be the
vector of k terms from a candidate subset indexed by I , and let xO be the
vector of the remaining predictors (out of the candidate submodel). Then

Y = xT
I βI + xT

OβO + e. (3.5)

Definition 3.7. The model Y = xT β + e that uses all of the predictors
is called the full model. A model Y = xT

I βI + e that only uses a subset
xI of the predictors is called a submodel. The full model is always a
submodel. The sufficient predictor (SP) is the linear combination of the
predictor variables used in the model. Hence the full model has SP = xTβ
and the submodel has SP = xT

I βI .

The estimated sufficient predictor (ESP) is xT β̂ and the following re-
marks suggest that a submodel I is worth considering if the correlation
corr(ESP,ESP (I)) ≥ 0.95. Suppose that S is a subset of I and that model
(3.4) holds. Then

SP = xT β = xT
SβS = xT

SβS + xT
I/Sβ(I/S) + xT

O0 = xT
I βI (3.6)

where xI/S denotes the predictors in I that are not in S. Since this is true
regardless of the values of the predictors, βO = 0 and the sample correlation
corr(xT

i β,xT
I,iβI) = 1.0 for the population model if S ⊆ I .

All too often, variable selection is performed and then the researcher tries
to use the final submodel for inference as if the model was selected before
gathering data. At the other extreme, it could be suggested that variable
selection should not be done because inferences after variable selection are
not valid. Neither of these two extremes is useful.

Ideally the model is known before collecting the data. After the data
is collected, the MLR assumptions are checked and then the model is used
for inference. Alternatively, a preliminary study can be used to collect data.
Then the predictors and response can be transformed until a full model is
built that seems to be a useful MLR approximation of the data. Then variable
selection can be performed, suggesting a final model. Then this final model is
the known model used before collecting data for the main part of the study.



CHAPTER 3. BUILDING AN MLR MODEL 120

In practice, the researcher often has one data set, builds the full model
and performs variable selection to obtain a final submodel. In other words,
an extreme amount of data snooping was used to build the final model. A
major problem with the final MLR model (chosen after variable selection
or data snooping) is that it is not valid for inference in that the p-values
for the OLS t-tests and ANOVA F test are likely to be too small, while
the p-value for the partial F test that uses the final model as the reduced
model is likely to be too high. Similarly, the actual coverage of the nominal
100(1 − δ)% prediction intervals tends to be too small and unknown (eg the
nominal 95% PIs may only contain 83% of the future responses Yf ). Thus
the model is likely to fit the data set from which it was built much better
than future observations. Call the data set from which the MLR model was
built the “training data,” consisting of cases (Yi,xi) for i = 1, ..., n. Then
the future predictions tend to be poor in that |Yf − Ŷf | tends to be larger

on average than |Yi − Ŷi|. To summarize, a final MLR model selected after
variable selection can be useful for description and exploratory analysis: the
tests and intervals can be used for exploratory purposes, but are not valid
for inference.

Generally the research paper should state that the model was built with
one data set, and is useful for description and exploratory purposes, but
should not be used for inference. The research paper should only suggest
that the model is useful for inference if the model has been shown to be
useful on data collected after the model was built. For example, if
the researcher can collect new data and show that the model produces valid
inferences (eg 97 out of 100 95% prediction intervals contained the future
response Yf ), then the researcher can perhaps claim to have found a model
that is useful for inference.

Other problems exist even if the full MLR model Y = xT β + e is good.
Let I ⊂ {1, ..., p} and let xI be the final vector of predictors. If xI is missing
important predictors contained in the full model, sometimes called underfit-
ting, then the final model Y = xT

I βI + e may be a very poor approximation
to the data, in particular the full model may be linear while the final model
may be nonlinear. Similarly the full model may satisfy V (ei) = σ2 while
the constant variance assumption is violated by the submodel: V (ei) = σ2

i .
These two problems are less severe if the joint distribution of (Y,xT )T is
multivariate normal, since then Y = xT

I βI + e satisfies the constant variance
MLR model regardless of the subset I used.
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In spite of these problems, if the researcher has a single data set with
many predictors, then usually variable selection must be done. Let p − 1 be
the number of nontrivial predictors and assume that the model also contains
a constant. Also assume that n > 10p. If the MLR model found after variable
selection has good response and residual plots, then the model may be very
useful for descriptive and exploratory purposes.

Simpler models are easier to explain and use than more complicated mod-
els, and there are several other important reasons to perform variable selec-
tion. First, an MLR model with unnecessary predictors has a mean square
error for prediction that is too large. Let xS contain the necessary predictors,
let x be the full model, and let xI be a submodel. If (3.4) holds and S ⊆ I ,
then E(Y |xI) = xT

I βI = xT
SβS = xT β. Hence OLS applied to Y and xI

yields an unbiased estimator β̂I of βI . If (3.4) holds, S ⊆ I , βS is a k × 1
vector and βI is a j × 1 vector with j > k, then it is shown in Chapter 13
that

1

n

n∑
i=1

V (ŶIi) =
σ2j

n
>
σ2k

n
=

1

n

n∑
i=1

V (ŶSi). (3.7)

In particular, the full model has j = p. Hence having unnecessary predic-
tors decreases the precision for prediction. Fitting unnecessary predictors is
sometimes called fitting noise or overfitting. As an extreme case, suppose
that the full model contains p = n predictors, including a constant, so that
the hat matrix H = In, the n × n identity matrix. Then Ŷ = Y so that
VAR(Ŷ |x) = VAR(Y ).

Secondly, often researchers are interested in examining the effects of cer-
tain predictors on the response. Recall that β̂i measures the effect of xi

given that all of the other predictors x1, ..., xi−1, xi+1, ..., xp are in the model.
If some of the predictors are highly correlated, then these predictors may
not be needed in the MLR model given that the other predictors are in the
model. Hence it will not be possible to examine the effects of these predictors
on the response unless the MLR model is changed.

Thirdly, there may be an extremely expensive predictor xp that researchers
would like to omit. If xp is not needed in the MLR model given that
x1, ..., xp−1 are in the model, then xp can be removed from the model, saving
money.

A major assumption before performing variable selection is that the full
model is good. A factor with c levels can be incorporated into the full
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model by creating c − 1 indicator variables. Sometimes the categories can
be combined into fewer categories. For example, if the factor is race with
levels white, black and other, new levels white and nonwhite may be useful
for some data sets. Two rules of thumb are useful for building a full model.
Notice that Rule of thumb 3.4 uses data snooping. Hence the full model and
the submodels chosen after variable selection can be used for description and
exploratory analysis, but should not be used for inference.

Rule of thumb 3.4. Remove strong nonlinearities from the predictors by
making scatterplot matrices of the predictors and the response. If necessary,
transform the predictors and the response using methods from Sections 3.1
and 3.2. Do not transform indicator variables. Each scatterplot matrix
should contain the response entered as the last variable. Do not use more
than 10 variables per scatterplot matrix. Hence if there are 90 predictor
variables, make 10 scatterplot matrices. The first will contain x1, ..., x9, Y
and the last will contain x81, ..., x90, Y.

Often a variable xi does not need to be transformed if the transformation
does not increase the linearity of the plot of xi versus Y . If the plot of xi

versus xj is nonlinear for some xj, try to transform one or both of xi and xj

in order to remove the nonlinearity, but be careful that the transformation
do not cause a nonlinearity to appear in the plots of xi and xj versus Y .

Rule of thumb 3.5. Let xw1, ..., xw,c−1 correspond to the indicator vari-
ables of a factor W. Either include all of the indicator variables in the model
or exclude all of the indicator variables from the model. If the model contains
powers or interactions, also include all main effects in the model (see Section
3.3).

Next we suggest methods for finding a good submodel. We make the
simplifying assumptions that the full model is good, that all predictors have
the same cost, that each submodel contains a constant and that there is
no theory requiring that a particular predictor must be in the model. Also
assume that n ≥ 5p and that the response and residual plots of the full model
are good. Rule of thumb 3.5 should be used for the full model and for all
submodels.

The basic idea is to obtain fitted values from the full model and the
candidate submodel. If the candidate model is good, then the plotted points
in a plot of the submodel fitted values versus the full model fitted values
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should follow the identity line. In addition, a similar plot should be made
using the residuals.

A problem with this idea is how to select the candidate submodel from
the nearly 2p potential submodels. One possibility would be to try to order
the predictors in importance, say x1, ..., xp. Then let the kth model contain
the predictors x1, x2, ..., xk for k = 1, ..., p. If the predicted values from the
submodel are highly correlated with the predicted values from the full model,
then the submodel is “good.” All subsets selection, forward selection and
backward elimination can be used (see Section 1.6), but criteria to separate
good submodels from bad are needed.

Two important summaries for submodel I are R2(I), the proportion of
the variability of Y explained by the nontrivial predictors in the model, and
MSE(I) = σ̂2

I , the estimated error variance. See Definitions 2.15 and 2.16.
Suppose that model I contains k predictors, including a constant. Since
adding predictors does not decrease R2, the adjusted R2

A(I) is often used,
where

R2
A(I) = 1 − (1 − R2(I))

n

n− k
= 1 −MSE(I)

n

SST
.

See Seber and Lee (2003, p. 400-401). Hence the model with the maximum
R2

A(I) is also the model with the minimum MSE(I).

For multiple linear regression, recall that if the candidate model of xI

has k terms (including the constant), then the partial F statistic for testing
whether the p− k predictor variables in xO can be deleted is

FI =
SSE(I) − SSE

(n− k) − (n− p)
/
SSE

n − p
=
n− p

p− k
[
SSE(I)

SSE
− 1]

where SSE is the error sum of squares from the full model and SSE(I) is the
error sum of squares from the candidate submodel. An extremely important
criterion for variable selection is the Cp criterion.

Definition 3.7.

Cp(I) =
SSE(I)

MSE
+ 2k − n = (p− k)(FI − 1) + k

where MSE is the error mean square for the full model.

From Section 1.6, recall that all subsets selection, forward selection and
backward elimination produce one or more submodels of interest for k =
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2, ..., p where the submodel contains k predictors including a constant. The
following proposition helps explain why Cp is a useful criterion and suggests
that for subsets I with k terms, submodels with Cp(I) ≤ min(2k, p) are es-
pecially interesting. Olive and Hawkins (2005) show that this interpretation
of Cp can be generalized to 1D regression models such as generalized lin-
ear models. Denote the residuals and fitted values from the full model by
ri = Yi − xT

i β̂ = Yi − Ŷi and Ŷi = xT
i β̂ respectively. Similarly, let β̂I be the

estimate of βI obtained from the regression of Y on xI and denote the cor-
responding residuals and fitted values by rI,i = Yi − xT

I,iβ̂I and ŶI,i = xT
I,iβ̂I

where i = 1, ..., n.

Proposition 3.1. Suppose that a numerical variable selection method
suggests several submodels with k predictors, including a constant, where
2 ≤ k ≤ p.

a) The model I that minimizes Cp(I) maximizes corr(r, rI).

b) Cp(I) ≤ 2k implies that corr(r, rI) ≥
√

1 − p

n
.

c) As corr(r, rI) → 1,

corr(xTβ̂,xT
I β̂I) = corr(ESP,ESP(I)) = corr(Ŷ, ŶI) → 1.

Proof. These results are a corollary of Proposition 3.2 below. QED

Remark 3.1. Consider the model Ii that deletes the predictor xi. Then
the model has k = p − 1 predictors including the constant, and the test
statistic is ti where

t2i = FIi.

Using Definition 3.7 and Cp(Ifull) = p, it can be shown that

Cp(Ii) = Cp(Ifull) + (t2i − 2).

Using the screen Cp(I) ≤ min(2k, p) suggests that the predictor xi should
not be deleted if

|ti| >
√

2 ≈ 1.414.

If |ti| <
√

2 then the predictor can probably be deleted since Cp decreases.
The literature suggests using the Cp(I) ≤ k screen, but this screen tends to
overfit: too many unimportant predictors are included in the model.
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More generally, it can be shown that Cp(I) ≤ 2k iff

FI ≤ p

p− k
.

Now k is the number of terms in the model including a constant while p− k
is the number of terms set to 0. As k → 0, the partial F test will reject Ho:
βO = 0 (ie, say that the full model should be used instead of the submodel
I) unless FI is not much larger than 1. If p is very large and p − k is very
small, then the partial F test will tend to suggest that there is a model I
that is about as good as the full model even though model I deletes p − k
predictors.

Six graphs will be used to compare the full model and the candidate
submodel. Let β̂ be the estimate of β obtained from the regression of Y on
all of the terms x.

Definition 3.8. The “fit–fit” or FF plot is a plot of ŶI,i versus Ŷi while
a “residual–residual” or RR plot is a plot rI,i versus ri. A response plot is a

plot of ŶI,i versus Yi. An EE plot is a plot of ESP(I) versus ESP. For MLR,
the EE and FF plots are equivalent.

Many numerical methods such as forward selection, backward elimina-
tion, stepwise and all subset methods using the Cp(I) criterion (Jones 1946,
Mallows 1973), have been suggested for variable selection. We will use the
FF plot, RR plot, the response plots from the full and submodel, and the
residual plots (of the fitted values versus the residuals) from the full and
submodel. These six plots will contain a great deal of information about
the candidate subset provided that Equation (3.4) holds and that a good
estimator (such as OLS) for β̂ and β̂I is used.

For these plots to be useful, it is crucial to verify that a multiple lin-
ear regression (MLR) model is appropriate for the full model. Both the
response plot and the residual plot for the full model need to be
used to check this assumption. The plotted points in the response plot
should cluster about the identity line (that passes through the origin with
unit slope) while the plotted points in the residual plot should cluster about
the horizontal axis (the line r = 0). Any nonlinear patterns or outliers in
either plot suggests that an MLR relationship does not hold. Similarly, be-
fore accepting the candidate model, use the response plot and the residual
plot from the candidate model to verify that an MLR relationship holds for
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the response Y and the predictors xI . If the submodel is good, then the
residual and response plots of the submodel should be nearly identical to the
corresponding plots of the full model. Assume that all submodels contain a
constant.

Application 3.2. To visualize whether a candidate submodel using pre-
dictors xI is good, use the fitted values and residuals from the submodel and
full model to make an RR plot of the rI,i versus the ri and an FF plot of ŶI,i

versus Ŷi. Add the OLS line to the RR plot and identity line to both plots as
visual aids. The subset I is good if the plotted points cluster tightly about
the identity line in both plots. In particular, the OLS line and the identity
line should nearly coincide near the origin in the RR plot.

To verify that the six plots are useful for assessing variable selection,
the following notation will be useful. Suppose that all submodels include
a constant and that X is the full rank n × p design matrix for the full
model. Let the corresponding vectors of OLS fitted values and residuals be
Ŷ = X(XTX)−1XTY = HY and r = (I − H)Y , respectively. Sup-
pose that XI is the n × k design matrix for the candidate submodel and
that the corresponding vectors of OLS fitted values and residuals are Ŷ I =
XI(X

T
I X I)

−1XT
I Y = HIY and rI = (I − HI)Y , respectively.

A plot can be very useful if the OLS line can be compared to a reference
line and if the OLS slope is related to some quantity of interest. Suppose
that a plot of w versus z places w on the horizontal axis and z on the vertical
axis. Then denote the OLS line by ẑ = a + bw. The following proposition
shows that the plotted points in the FF, RR and response plots will cluster
about the identity line. Notice that the proposition is a property of OLS and
holds even if the data does not follow an MLR model. Let corr(x, y) denote
the correlation between x and y.

Proposition 3.2. Suppose that every submodel contains a constant and
that X is a full rank matrix.
Response Plot: i) If w = ŶI and z = Y then the OLS line is the identity
line.
ii) If w = Y and z = ŶI then the OLS line has slope b = [corr(Y, ŶI)]

2 = R2(I)
and intercept a = Y (1 − R2(I)) where Y =

∑n
i=1 Yi/n and R2(I) is the

coefficient of multiple determination from the candidate model.
FF or EE Plot: iii) If w = ŶI and z = Ŷ then the OLS line is the identity
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line. Note that ESP (I) = ŶI and ESP = Ŷ .
iv) If w = Ŷ and z = ŶI then the OLS line has slope b = [corr(Ŷ , ŶI)]

2 =
SSR(I)/SSR and intercept a = Y [1 − (SSR(I)/SSR)] where SSR is the
regression sum of squares.
RR Plot: v) If w = r and z = rI then the OLS line is the identity line.
vi) If w = rI and z = r then a = 0 and the OLS slope b = [corr(r, rI)]

2 and

corr(r, rI) =

√
SSE

SSE(I)
=

√
n− p

Cp(I) + n− 2k
=

√
n− p

(p− k)FI + n − p
.

Proof: Recall that H and HI are symmetric idempotent matrices and
that HHI = HI . The mean of OLS fitted values is equal to Y and the
mean of OLS residuals is equal to 0. If the OLS line from regressing z on w
is ẑ = a + bw, then a = z − bw and

b =

∑
(wi − w)(zi − z)∑

(wi −w)2
=
SD(z)

SD(w)
corr(z, w).

Also recall that the OLS line passes through the means of the two variables
(w, z).

(*) Notice that the OLS slope from regressing z on w is equal to one if
and only if the OLS slope from regressing w on z is equal to [corr(z, w)]2.

i) The slope b = 1 if
∑
ŶI,iYi =

∑
Ŷ 2

I,i. This equality holds since Ŷ
T

I Y =

Y T HIY = Y T HIHIY = Ŷ
T

I Ŷ I . Since b = 1, a = Y − Y = 0.

ii) By (*), the slope

b = [corr(Y, ŶI)]
2 = R2(I) =

∑
(ŶI,i − Y )2∑
(Yi − Y )2

= SSR(I)/SSTO.

The result follows since a = Y − bY .

iii) The slope b = 1 if
∑
ŶI,iŶi =

∑
Ŷ 2

I,i. This equality holds since

Ŷ
T
Ŷ I = Y T HHIY = Y THIY = Ŷ

T

I Ŷ I . Since b = 1, a = Y − Y = 0.

iv) From iii),

1 =
SD(Ŷ )

SD(ŶI)
[corr(Ŷ , ŶI)].
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Hence

corr(Ŷ , ŶI) =
SD(ŶI)

SD(Ŷ )

and the slope

b =
SD(ŶI)

SD(Ŷ )
corr(Ŷ , ŶI) = [corr(Ŷ , ŶI)]

2.

Also the slope

b =

∑
(ŶI,i − Y )2∑
(Ŷi − Y )2

= SSR(I)/SSR.

The result follows since a = Y − bY .

v) The OLS line passes through the origin. Hence a = 0. The slope
b = rT rI/r

Tr. Since rT rI = Y T (I−H)(I−HI)Y and (I−H)(I −HI) =
I − H , the numerator rTrI = rTr and b = 1.

vi) Again a = 0 since the OLS line passes through the origin. From v),

1 =

√
SSE(I)

SSE
[corr(r, rI)].

Hence

corr(r, rI) =

√
SSE

SSE(I)

and the slope

b =

√
SSE

SSE(I)
[corr(r, rI)] = [corr(r, rI)]

2.

Algebra shows that

corr(r, rI) =

√
n − p

Cp(I) + n− 2k
=

√
n− p

(p− k)FI + n− p
. QED

A standard model selection procedure will often be needed to suggest
models. For example, forward selection or backward elimination could be
used. If p < 30, Furnival and Wilson (1974) provide a technique for selecting
a few candidate subsets after examining all possible subsets.
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Remark 3.2. Daniel and Wood (1980, p. 85) suggest using Mallows’
graphical method for screening subsets by plotting k versus Cp(I) for models
close to or under the Cp = k line. Proposition 3.2 vi) implies that if Cp(I) ≤ k
or FI < 1, then corr(r, rI) and corr(ESP,ESP (I)) both go to 1.0 as n→ ∞.
Hence models I that satisfy the Cp(I) ≤ k screen will contain the true model
S with high probability when n is large. This result does not guarantee that
the true model S will satisfy the screen, hence overfit is likely (see Shao
1993). Let d be a lower bound on corr(r, rI). Proposition 3.2 vi) implies that
if

Cp(I) ≤ 2k + n

[
1

d2
− 1

]
− p

d2
,

then corr(r, rI) ≥ d. The simple screen Cp(I) ≤ 2k corresponds to

dn ≡
√

1 − p

n
.

To reduce the chance of overfitting, consider models I with Cp(I) ≤ min(2k, p).
Models under both the Cp = k line and the Cp = 2k line are of interest.

Rule of thumb 3.6. a) After using a numerical method such as forward
selection or backward elimination, let Imin correspond to the submodel with
the smallest Cp. Find the submodel II with the fewest number of predictors
such that Cp(II) ≤ Cp(Imin) + 1. Then II is the initial submodel that should
be examined. It is possible that II = Imin or that II is the full model.

b) Models I with fewer predictors than II such that Cp(I) ≤ Cp(Imin)+4
are interesting and should also be examined.

c) Models I with k predictors, including a constant and with fewer predic-
tors than II such that Cp(Imin) + 4 < Cp(I) ≤ min(2k, p) should be checked
but often underfit: important predictors are deleted from the model. Under-
fit is especially likely to occur if a predictor with one degree of freedom is
deleted (recall that if the c− 1 indicator variables corresponding to a factor
are deleted, then the factor has c − 1 degrees of freedom) and the jump in
Cp is large, greater than 4, say.

d) If there are no models I with fewer predictors than II such that Cp(I) ≤
min(2k, p), then model II is a good candidate for the best subset found by
the numerical procedure.

Rule of thumb 3.7. Assume that the full model has good response and
residual plots and that n > 5p. Let subset I have k predictors, including a
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constant. Know how to find good models from output. The following rules of
thumb (roughly in order of decreasing importance) may be useful. It is often
not possible to have all 10 rules of thumb to hold simultaneously. Let Imin

be the minimum Cp model and let II be the model with the fewest predictors
satisfying Cp(II) ≤ Cp(Imin) + 1. Do not use more predictors than model II

to avoid overfitting. Then the submodel I is good if
i) the response and residual plots for the submodel looks like the response
and residual plots for the full model.
ii) corr(ESP,ESP(I)) = corr(Ŷ, ŶI) ≥ 0.95.
iii) The plotted points in the FF plot (= EE plot for MLR) cluster tightly
about the identity line.
iv) Want the p-value ≥ 0.01 for the partial F test that uses I as the reduced
model.
v) Want k ≤ n/10.
vi) The plotted points in the RR plot cluster tightly about the identity line.
vii) Want R2(I) > 0.9R2 and R2(I) > R2−0.07 (recall that R2(I) ≤ R2(full)
since adding predictors to I does not decrease R2(I)).
viii) Want Cp(Imin) ≤ Cp(I) ≤ min(2k, p) with no big jumps in Cp (the
increase should be less than four) as variables are deleted.
ix) Want hardly any predictors with p-values > 0.05.
x) Want few predictors with p-values between 0.01 and 0.05.

The following description of forward selection and backward elimina-
tion modifies the description of Section 1.6 slightly. Criterion such as AIC,
MSE(I) or R2

A(I) are sometimes used instead of Cp. For forward selection,
the numerical method may add the predictor not yet in the model that has
the smallest pvalue for the t test. For backward elimination, the numerical
method may delete the variable in the model (that is not a constant) that
has the largest pvalue for the t test.

Forward selection Step 1) k = 1: Start with a constant w1 = x1. Step
2) k = 2: Compute Cp for all models with k = 2 containing a constant and
a single predictor xi. Keep the predictor w2 = xj, say, that minimizes Cp.
Step 3) k = 3: Fit all models with k = 3 that contain w1 and w2. Keep the
predictor w3 that minimizes Cp. ...
Step j) k = j: Fit all models with k = j that contains w1, w2, ..., wj−1. Keep
the predictor wj that minimizes Cp. ...
Step p): Fit the full model.
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Backward elimination: All models contain a constant = u1. Step 0)
k = p: Start with the full model that contains x1, ..., xp. We will also say
that the full model contains u1, ..., up where u1 = x1 but ui need not equal
xi for i > 1.
Step 1) k = p − 1: Fit each model with k = p − 1 predictors including a
constant. Delete the predictor up, say, that corresponds to the model with
the smallest Cp. Keep u1, ..., up−1.
Step 2) k = p−2: Fit each model with p−2 predictors including a constant.
Delete the predictor up−1 corresponding to the smallest Cp. Keep u1, ..., up−2.
...
Step j) k = p − j: fit each model with p − j predictors including a con-
stant. Delete the predictor up−j+1 corresponding to the smallest Cp. Keep
u1, ..., up−j. ...
Step p− 2) k = 2. The current model contains u1, u2 and u3. Fit the model
u1, u2 and the model u1, u3. Assume that model u1, u2 minimizes Cp. Then
delete u3 and keep u1 and u2.

Heuristically, backward elimination tries to delete the variable that will
increase Cp the least. An increase in Cp greater than 4 (if the predictor has 1
degree of freedom) may be troubling in that a good predictor may have been
deleted. In practice, the backward elimination program may use some other
criterion: eg, delete the variable such that the submodel I with j predictors
has a) the smallest Cp(I) or b) the biggest p–value in the test Ho βi = 0
versus HA βi �= 0 where the model with j + 1 terms from the previous step
(using the j predictors in I and the variable x∗j+1) is treated as the full model.

Heuristically, forward selection tries to add the variable that will decrease
Cp the most. A decrease in Cp less than 4 (if the predictor has 1 degree of
freedom) may be troubling in that a bad predictor may have been added.
In practice, the forward selection program may use some other criterion, eg,
add the variable such that the submodel I with j nontrivial predictors has
a) the smallest Cp(I) or b) the smallest p–value in the test Ho βi = 0 versus
HA βi �= 0 where the current model with j terms plus the predictor xi is
treated as the full model (for all variables xi not yet in the model).

Suppose that the full model is good and is stored in M1. Let M2, M3,
M4 and M5 be candidate submodels found after forward selection, backward
elimination, et cetera. Recall that ESP (I) = ŶI . Make a scatterplot matrix
of the ESPs for M1, M2, M3, M4, M5 and Y . Good candidates should have
estimated sufficient predictors that are highly correlated with the full model
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ESP (the correlation should be at least 0.9 and preferably greater than 0.95).
Similarly, make a scatterplot matrix of the residuals for M1, M2, M3, M4
and M5.

To summarize, the final submodel should have few predictors, few vari-
ables with large OLS t test p–values (0.01 to 0.05 is borderline), good re-
sponse and residual plots and an FF plot (= EE plot) that clusters tightly
about the identity line. If a factor has c− 1 indicator variables, either keep
all c − 1 indicator variables or delete all c − 1 indicator variables, do not
delete some of the indicator variables.

Example 3.7. The pollution data of McDonald and Schwing (1973) can
be obtained from STATLIB or the text’s website. The response Y = mort
is the mortality rate and most of the independent variables were related to
pollution. A scatterplot matrix of the first 9 predictors and Y was made
and then a scatterplot matrix of the remaining predictors with Y . The log
rule suggested making the log transformation with 4 of the variables. The
summary output is shown on the following page. The response and residual
plots were good. Notice that p = 16 and n = 60 < 5p. Also many p-values
are too high.

Response = MORT

Label Estimate Std. Error t-value p-value

Constant 1881.11 442.628 4.250 0.0001

DENS 0.00296328 0.00396521 0.747 0.4588

EDUC -19.6669 10.7005 -1.838 0.0728

log[HC] -31.0112 15.5615 -1.993 0.0525

HOUS -0.401066 1.64372 -0.244 0.8084

HUMID -0.445403 1.06762 -0.417 0.6786

JANT -3.58522 1.05355 -3.403 0.0014

JULT -3.84292 2.12079 -1.812 0.0768

log[NONW] 27.2397 10.1340 2.688 0.0101

log[NOX] 57.3041 15.4764 3.703 0.0006

OVR65 -15.9444 8.08160 -1.973 0.0548

POOR 3.41434 2.74753 1.243 0.2206

POPN -131.823 69.1908 -1.905 0.0633

PREC 3.67138 0.778135 4.718 0.0000

log[SO] -10.2973 7.38198 -1.395 0.1700

WWDRK 0.882540 1.50954 0.585 0.5618
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R Squared: 0.787346 Sigma hat: 33.2178

Number of cases: 60 Degrees of freedom: 44

Summary Analysis of Variance Table

Source df SS MS F p-value

Regression 15 179757. 11983.8 10.86 0.0000

Residual 44 48550.5 1103.42

Shown below this paragraph is some output from forward selection. The
minimum Cp model had Cp = 7.353 with 7 predictors. Deleting JANT from
this model increased Cp to 17.763, suggesting that JANT is an important
predictor. Notice that Cp > 2k = 12 for the model that deletes JANT.

Base terms: (log[NONW] EDUC log[SO] PREC)

df RSS | k C_I

Add: log[NOX] 54 72563.9 | 6 17.763

Add: JANT 54 72622. | 6 17.815

Add: HOUS 54 74884.8 | 6 19.866

Add: POPN 54 75350.2 | 6 20.288

Add: log[HC] 54 75373.4 | 6 20.309

Add: JULT 54 75405.8 | 6 20.338

Add: OVR65 54 75692.2 | 6 20.598

Add: HUMID 54 75747.4 | 6 20.648

Add: DENS 54 75872.1 | 6 20.761

Add: POOR 54 75938.4 | 6 20.821

Add: WWDRK 54 75971.8 | 6 20.851

Base terms: (log[NONW] EDUC log[SO] PREC log[NOX])

df RSS | k C_I

Add: JANT 53 58871. | 7 7.353

Add: log[HC] 53 69233.3 | 7 16.744

Add: HOUS 53 70774.1 | 7 18.141

Add: POPN 53 71424.7 | 7 18.730

Add: POOR 53 72049.4 | 7 19.296

Add: OVR65 53 72337.1 | 7 19.557

Add: JULT 53 72348.6 | 7 19.568

Add: WWDRK 53 72483.1 | 7 19.690



CHAPTER 3. BUILDING AN MLR MODEL 134

Add: DENS 53 72494.9 | 7 19.700

Add: HUMID 53 72563.9 | 7 19.763

Output for backward elimination is shown below, and the minimum Cp

model had Cp = 6.284 with 6 predictors. Deleting EDUC increased Cp to
10.800 > 2k = 10. Since Cp increased by more than 4, EDUC is probably
important.

Current terms: (EDUC JANT log[NONW] log[NOX] OVR65 PREC)

df RSS | k C_I

Delete: OVR65 54 59897.9 | 6 6.284

Delete: EDUC 54 66809.3 | 6 12.547

Delete: log[NONW] 54 73178.1 | 6 18.319

Delete: JANT 54 76417.1 | 6 21.255

Delete: PREC 54 83958.1 | 6 28.089

Delete: log[NOX] 54 86823.1 | 6 30.685

Current terms: (EDUC JANT log[NONW] log[NOX] PREC)

df RSS | k C_I

Delete: EDUC 55 67088.1 | 5 10.800

Delete: JANT 55 76467.4 | 5 19.300

Delete: PREC 55 87206.7 | 5 29.033

Delete: log[NOX] 55 88489.6 | 5 30.196

Delete: log[NONW] 55 95327.5 | 5 36.393

Taking the minimum Cp model from backward elimination gives the out-
put shown below. The response and residual plots were OK although the
correlation in the RR and FF plots was not real high. The R2 in the sub-
model decreased from about 0.79 to 0.74 while σ̂ =

√
MSE was 33.22 for

the full model and 33.31 for the submodel. Removing nonlinearities from
the predictors by using two scatterplots and the log rule, and then using
backward elimination and forward selection, seems to be very effective for
finding the important predictors for this data set. See Problem 3.17 in order
to reproduce this example with the essential plots.

Response = MORT

Label Estimate Std. Error t-value p-value

Constant 943.934 82.2254 11.480 0.0000
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EDUC -15.7263 6.17683 -2.546 0.0138

JANT -1.86899 0.483572 -3.865 0.0003

log[NONW] 33.5514 5.93658 5.652 0.0000

log[NOX] 21.7931 4.29248 5.077 0.0000

PREC 2.92801 0.590107 4.962 0.0000

R Squared: 0.737644 Sigma hat: 33.305

Number of cases: 60 Degrees of freedom: 54

Summary Analysis of Variance Table

Source df SS MS F p-value

Regression 5 168410. 33681.9 30.37 0.0000

Residual 54 59897.9 1109.22

Example 3.8. The FF and RR plots can be used as a diagnostic for
whether a given numerical method is including too many variables. Glad-
stone (1905-1906) attempts to estimate the weight of the human brain (mea-
sured in grams after the death of the subject) using simple linear regression
with a variety of predictors including age in years, height in inches, head
height in mm, head length in mm, head breadth in mm, head circumference
in mm, and cephalic index. The sex (coded as 0 for females and 1 for males)
of each subject was also included. The variable cause was coded as 1 if the
cause of death was acute, 3 if the cause of death was chronic, and coded as 2
otherwise. A variable ageclass was coded as 0 if the age was under 20, 1 if the
age was between 20 and 45, and as 3 if the age was over 45. Head size, the
product of the head length, head breadth, and head height, is a volume mea-
surement, hence (size)1/3 was also used as a predictor with the same physical
dimensions as the other lengths. Thus there are 11 nontrivial predictors and
one response, and all models will also contain a constant. Nine cases were
deleted because of missing values, leaving 267 cases.

Figure 3.7 shows the response plots and residual plots for the full model
and the final submodel that used a constant, size1/3, age and sex. The five
cases separated from the bulk of the data in each of the four plots correspond
to five infants. These may be outliers, but the visual separation reflects the
small number of infants and toddlers in the data. A purely numerical variable
selection procedure would miss this interesting feature of the data. We will
first perform variable selection with the entire data set, and then examine the
effect of deleting the five cases. Using forward selection and the Cp statistic
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Figure 3.7: Gladstone data: comparison of the full model and the submodel.

on the Gladstone data suggests the subset I5 containing a constant, (size)1/3,
age, sex, breadth, and cause with Cp(I5) = 3.199. The p–values for breadth
and cause were 0.03 and 0.04, respectively. The subset I4 that deletes cause
has Cp(I4) = 5.374 and the p–value for breadth was 0.05. Figure 3.8d shows
the RR plot for the subset I4. Note that the correlation of the plotted points
is very high and that the OLS and identity lines nearly coincide.

A scatterplot matrix of the predictors and response suggests that (size)1/3

might be the best single predictor. First we regressed Y = brain weight on
the eleven predictors described above (plus a constant) and obtained the
residuals ri and fitted values Ŷi. Next, we regressed Y on the subset I
containing (size)1/3 and a constant and obtained the residuals rI,i and the

fitted values ŷI,i. Then the RR plot of rI,i versus ri, and the FF plot of ŶI,i

versus Ŷi were constructed.
For this model, the correlation in the FF plot (Figure 3.8b) was very high,

but in the RR plot the OLS line did not coincide with the identity line (Figure
3.8a). Next sex was added to I , but again the OLS and identity lines did not
coincide in the RR plot (Figure 3.8c). Hence age was added to I. Figure 3.9a
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Figure 3.8: Gladstone data: submodels added (size)1/3, sex, age and finally
breadth.

SRES3

F
R

E
S

-200 -100 0 100 200

-2
00

-1
00

0
10

0
20

0

a) RR Plot

SFIT3

F
F

IT

400 600 800 1000 1200 1400

40
0

60
0

80
0

10
00

12
00

14
00

b) FF Plot

Figure 3.9: Gladstone data with Predictors (size)1/3, sex, and age
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Figure 3.10: RR and FF Plots for Rat Data

shows the RR plot with the OLS and identity lines added. These two lines
now nearly coincide, suggesting that a constant plus (size)1/3, sex, and age
contains the relevant predictor information. This subset has Cp(I) = 7.372,
R2

I = 0.80, and σ̂I = 74.05. The full model which used 11 predictors and a
constant has R2 = 0.81 and σ̂ = 73.58. Since the Cp criterion suggests adding
breadth and cause, the Cp criterion may be leading to an overfit.

Figure 3.9b shows the FF plot. The five cases in the southwest corner
correspond to five infants. Deleting them leads to almost the same conclu-
sions, although the full model now has R2 = 0.66 and σ̂ = 73.48 while the
submodel has R2

I = 0.64 and σ̂I = 73.89.

Example 3.9. Cook and Weisberg (1999a, p. 261, 371) describe a data
set where rats were injected with a dose of a drug approximately proportional
to body weight. The data set is included as the file rat.lsp in the Arc soft-
ware and can be obtained from the website (www.stat.umn.edu/arc/). The
response Y is the fraction of the drug recovered from the rat’s liver. The
three predictors are the body weight of the rat, the dose of the drug, and the
liver weight. The experimenter expected the response to be independent of
the predictors, and 19 cases were used. However, the Cp criterion suggests
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using the model with a constant, dose and body weight, both of whose co-
efficients were statistically significant. The RR and FF plots are shown in
Figure 3.10. The identity line was added to both plots and the OLS line was
added to the RR plot. The FF plot shows one outlier, the third case, that is
clearly separated from the rest of the data.

We deleted this case and again searched for submodels. The Cp statistic
is less than one for all three simple linear regression models, and the RR and
FF plots look the same for all submodels containing a constant. Figure 2.2
shows the RR plot where the residuals from the full model are plotted against
Y −Y , the residuals from the model using no nontrivial predictors. This plot
suggests that the response Y is independent of the nontrivial predictors.

The point of this example is that a subset of outlying cases can cause
numeric second-moment criteria such as Cp to find structure that does not
exist. The FF and RR plots can sometimes detect these outlying cases,
allowing the experimenter to run the analysis without the influential cases.
The example also illustrates that global numeric criteria can suggest a model
with one or more nontrivial terms when in fact the response is independent
of the predictors.

Numerical variable selection methods for MLR are very sensitive to “in-
fluential cases” such as outliers. Olive and Hawkins (2005) show that a plot
of the residuals versus Cook’s distances (see Section 3.5) can be used to de-
tect influential cases. Such cases can also often be detected from response,
residual, RR and FF plots.

Warning: deleting influential cases and outliers will often lead to
better plots and summary statistics, but the cleaned data may no
longer represent the actual population. In particular, the resulting
model may be very poor for prediction.

Multiple linear regression data sets with cases that influence numerical
variable selection methods are common. Table 3.1 shows results for seven
interesting data sets. The first two rows correspond to the Ashworth (1842)
data, the next 2 rows correspond to the Gladstone Data in Example 3.8, and
the next 2 rows correspond to the Gladstone data with the 5 infants deleted.
Rows 7 and 8 are for the Buxton (1920) data while rows 9 and 10 are for
the Tremearne (1911) data. These data sets are available from the book’s
website. Results from the final two data sets are given in the last 4 rows. The
last 2 rows correspond to the rat data described in Example 3.9. Rows 11
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Table 3.1: Summaries for Seven Data Sets

influential cases submodel I p, Cp(I), Cp(I, c)
file, response transformed predictors

14, 55 log(x2) 4, 12.665, 0.679
pop, log(y) log(x1), log(x2), log(x3)

118, 234, 248, 258 (size)1/3, age, sex 10, 6.337, 3.044
cbrain,brnweight (size)1/3

118, 234, 248, 258 (size)1/3, age, sex 10, 5.603, 2.271
cbrain-5,brnweight (size)1/3

11, 16, 56 sternal height 7, 4.456, 2.151
cyp,height none

3, 44 x2, x5 6, 0.793, 7.501
major,height none

11, 53, 56, 166 log(LBM), log(Wt), sex 12, −1.701, 0.463

ais,%Bfat log(Ferr), log(LBM), log(Wt),
√
Ht

3 no predictors 4, 6.580, −1.700
rat,y none

and 12 correspond to the Ais data that comes with Arc (Cook and Weisberg,
1999a).

The full model used p predictors, including a constant. The final sub-
model I also included a constant, and the nontrivial predictors are listed in
the second column of Table 3.1. For a candidate submodel I , let Cp(I, c)
denote the value of the Cp statistic for the clean data that omits influential
cases and outliers. The third column lists p, Cp(I) and Cp(I, c) while the
first column gives the set of influential cases. Two rows are presented for
each data set. The second row gives the response variable and any predictor
transformations. For example, for the Gladstone data p = 10 since there
were 9 nontrivial predictors plus a constant. Only the predictor size was
transformed, and the final submodel is the one given in Example 3.8. For
the rat data, the final submodel is the one given in Example 3.9: none of the
3 nontrivial predictors was used.

Table 3.1 and simulations suggest that if the subset I has k predictors,
then using the Cp(I) ≤ min(2k, p) screen is better than using the conventional
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Cp(I) ≤ k screen. The major and ais data sets show that deleting the
influential cases may increase the Cp statistic. Thus interesting models from
the entire data set and from the clean data set should be examined.

Example 3.10. Conjugated linoleic acid (CLA), occurs in beef and
dairy products and appears to have many human health benefits. Joanne
Numrich provided four data sets where the response was the amount of CLA
(or related compounds) and the explanatory variables were feed components
from the cattle diet. The data was to be used for descriptive and exploratory
purposes. Several data sets had outliers with unusually high levels of CLA.
These outliers were due to one researcher and may be the most promising
cases in the data set. However, to describe the bulk of the data with OLS
MLR, the outliers were omitted. In one of the data sets there are 33 cases
and 25 predictors, including a constant. Regressing Y on all of the predictors
gave R2 = .84 and an ANOVA F test p-value of 0.223, suggesting that none of
the predictors are useful. From Proposition 2.5, an R2 > (p−1)/(n−1) = .75
is not very surprising. Remarks above Theorem 2.7 help explain why R2 can
be high with a high ANOVA F test p-value.

Of course just fitting the data to the collected variables is a poor way
to proceed. Only variables x1, x2, x5, x6, x20 and x21 took on more than a
few values. Taking log(Y ) and using variables x2, x9, x23, and x24 seemed to
result in an adequate model, although the number of distinct fitted values
was rather small. See Problem 3.18 for more details.

3.5 Diagnostics

Automatic or blind use of regression models, especially in exploratory work,
all too often leads to incorrect or meaningless results and to confusion

rather than insight. At the very least, a user should be prepared to make
and study a number of plots before, during, and after fitting the model.

Chambers, Cleveland, Kleiner, and Tukey (1983, p. 306)

Diagnostics are used to check whether model assumptions are reasonable.
This section focuses on diagnostics for the multiple linear regression model
with iid constant variance symmetric errors. Under this model,

Yi = xT
i β + ei
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for i = 1, ..., n where the errors are iid from a symmetric distribution with
E(ei) = 0 and VAR(ei) = σ2. The zero mean and symmetry assumptions are
often not very important.

It is often useful to use notation to separate the constant from the non-
trivial predictors. Assume that xi = (1, xi,2, ..., xi,p)

T ≡ (1,uT
i )T where the

(p−1)×1 vector of nontrivial predictors ui = (xi,2, ..., xi,p)
T . In matrix form,

Y = Xβ + e,

X = [X1, X2, ..., Xp] = [1,U ],

1 is an n × 1 vector of ones, and U = [X2, ..., Xp] is the n × (p− 1) matrix
of nontrivial predictors. The kth column of U is the n × 1 vector of the
jth predictor Xj = (x1,j, ..., xn,j)

T where j = k + 1. The sample mean and
covariance matrix of the nontrivial predictors are

u =
1

n

n∑
i=1

ui (3.8)

and

C = Cov(U ) =
1

n− 1

n∑
i=1

(ui − u)(ui − u)T , (3.9)

respectively.

Some important numerical quantities that are used as diagnostics measure
the distance of ui from u and the influence of case i on the OLS fit β̂ ≡ β̂OLS.
Recall that the vector of fitted values =

Ŷ = Xβ̂ = X(XT X)−1XTY = HY

where H is the hat matrix. Recall that the ith residual ri = Yi− Ŷi. Case (or
leave one out or deletion) diagnostics are computed by omitting the ith case
from the OLS regression. Following Cook and Weisberg (1999a, p. 357), let

Ŷ (i) = Xβ̂(i) (3.10)

denote the n× 1 vector of fitted values from estimating β with OLS without
the ith case. Denote the jth element of Ŷ (i) by Ŷ(i),j. It can be shown that
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the variance of the ith residual VAR(ri) = σ2(1 − hi). The usual estimator
of the error variance is

σ̂2 =

∑n
i=1 r

2
i

n− p
.

The (internally) studentized residual

êi =
ri

σ̂
√

1 − hi

has zero mean and unit variance.

Definition 3.9. The ith leverage hi = H ii is the ith diagonal element of
the hat matrix H . The ith squared (classical) Mahalanobis distance

MD2
i = (ui − u)TC−1(ui − u).

The ith Cook’s distance

CDi =
(β̂(i) − β̂)T XTX(β̂(i) − β̂)

pσ̂2
=

(Ŷ (i) − Ŷ )T (Ŷ (i) − Ŷ )

pσ̂2
(3.11)

=
1

pσ̂2

n∑
j=1

(Ŷ(i),j − Ŷj)
2.

Proposition 3.3. a) (Rousseeuw and Leroy 1987, p. 225)

hi =
1

n− 1
MD2

i +
1

n
.

b) (Cook and Weisberg 1999a, p. 184)

hi = xT
i (XT X)−1xi = (xi − x)T (UT U)−1(xi − x) +

1

n
.

c) (Cook and Weisberg 1999a, p. 360)

CDi =
r2
i

pσ̂2(1 − hi)

hi

1 − hi
=
ê2

i

p

hi

1 − hi
.

When the statistics CDi, hi and MDi are large, case i may be an outlier or
influential case. Examining a stem plot or dot plot of these three statistics for
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unusually large values can be useful for flagging influential cases. Cook and
Weisberg (1999a, p. 358) suggest examining cases with CDi > 0.5 and that
cases with CDi > 1 should always be studied. Since H = HT and H = HH ,
the hat matrix is symmetric and idempotent. Hence the eigenvalues of H are
zero or one and trace(H) =

∑n
i=1 hi = p. It can be shown that 0 ≤ hi ≤ 1.

Rousseeuw and Leroy (1987, p. 220 and p. 224) suggest using hi > 2p/n
and MD2

i > χ2
p−1,0.95 as benchmarks for leverages and Mahalanobis distances

where χ2
p−1,0.95 is the 95th percentile of a chi–square distribution with p− 1

degrees of freedom.
Note that Proposition 3.3c) implies that Cook’s distance is the product

of the squared residual and a quantity that becomes larger the farther ui is
from u. Hence influence is roughly the product of leverage and distance of
Yi from Ŷi (see Fox 1991, p. 21). Mahalanobis distances and leverages both
define ellipsoids based on a metric closely related to the sample covariance
matrix of the nontrivial predictors. All points ui on the same ellipsoidal
contour are the same distance from u and have the same leverage (or the
same Mahalanobis distance).

Cook’s distances, leverages, and Mahalanobis distances can be effective
for finding influential cases when there is a single outlier, but can fail if
there are two or more outliers. Nevertheless, these numerical diagnostics
combined with response and residual plots are probably the most effective
techniques for detecting cases that effect the fitted values when the multiple
linear regression model is a good approximation for the bulk of the data. In
fact, these diagnostics may be useful for perhaps up to 90% of such data
sets while residuals from robust regression and Mahalanobis distances from
robust estimators of multivariate location and dispersion may be helpful for
perhaps another 3% of such data sets.

A scatterplot of x versus y (recall the convention that a plot of x versus
y means that x is on the horizontal axis and y is on the vertical axis) is
used to visualize the conditional distribution y|x of y given x (see Cook and
Weisberg 1999a, p. 31). For the simple linear regression model (with one
nontrivial predictor x2), by far the most effective technique for checking the
assumptions of the model is to make a scatterplot of x2 versus Y and a
residual plot of x2 versus ri. Departures from linearity in the scatterplot
suggest that the simple linear regression model is not adequate. The points
in the residual plot should scatter about the line r = 0 with no pattern. If
curvature is present or if the distribution of the residuals depends on the
value of x2, then the simple linear regression model is not adequate.
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Similarly if there are two nontrivial predictors, say x2 and x3, make a
three-dimensional (3D) plot with Y on the vertical axis, x2 on the horizontal
axis and x3 on the out of page axis. Rotate the plot about the vertical
axis, perhaps superimposing the OLS plane. As the plot is rotated, linear
combinations of x2 and x3 appear on the horizontal axis. If the OLS plane
b1 +b2x2+b3x3 fits the data well, then the plot of b2x2 +b3x3 versus Y should
scatter about a straight line. See Cook and Weisberg (1999a, ch. 8).

In general there are more than two nontrivial predictors and in this set-
ting two plots are crucial for any multiple linear regression analysis,
regardless of the regression estimator (eg OLS, L1 etc.). The first plot is the

residual plot of the fitted values Ŷi versus the residuals ri, and the second
plot is the response plot of the fitted values Ŷi versus the response Yi.

Recalling Definitions 2.11 and 2.12, residual and response plots are plots
of wi = xT

i η versus ri and Yi, respectively, where η is a known p × 1 vec-

tor. The most commonly used residual and response plots takes η = β̂.
Plots against the individual predictors xj and potential predictors are also
used. If the residual plot is not ellipsoidal with zero slope, then the multi-
ple linear regression model with iid constant variance symmetric errors is not
sustained. In other words, if the variables in the residual plot show some type
of dependency, eg increasing variance or a curved pattern, then the multiple
linear regression model may be inadequate. Proposition 2.1 showed that the
response plot simultaneously displays the fitted values, response, and residu-
als. The plotted points in the response plot should scatter about the identity
line if the multiple linear regression model holds. Recall that residual plots
magnify departures from the model while the response plot emphasizes how
well the model fits the data.

When the bulk of the data follows the MLR model, the following rules of
thumb are useful for finding influential cases and outliers form the response
and residual plots. Look for points with large absolute residuals and for
points far away from Y . Also look for gaps separating the data into clusters.
To determine whether small clusters are outliers or good leverage points, give
zero weight to the clusters, and fit a MLR estimator to the bulk of the data.
Denote the weighted estimator by β̂w. Then plot Ŷw versus Y using the entire
data set. If the identity line passes through the bulk of the data but not the
cluster, then the cluster points may be outliers.

To see why gaps are important, recall that the coefficient of determination
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R2 is equal to the squared correlation (corr(Y, Ŷ ))2. R2 over emphasizes the
strength of the MLR relationship when there are two clusters of data since
much of the variability of Y is due to the smaller cluster.

Information from numerical diagnostics can be incorporated into the re-
sponse plot by highlighting cases that have large absolute values of the di-
agnostic. For example, the Cook’s distance CDi for the ith case tends to be
large if Ŷi is far from the sample mean Y and if the corresponding absolute
residual |ri| is not small. If Ŷi is close to Y then CDi tends to be small unless
|ri| is large. An exception to these rules of thumb occurs if a group of cases
form a cluster and the OLS fit passes through the cluster. Then the CDi’s
corresponding to these cases tend to be small even if the cluster is far from
Y . Thus cases with large Cook’s distances can often be found by examining
the response and residual plots.

Example 3.11. Tremearne (1911) presents a data set of about 17 mea-
surements on 115 people of Hausa nationality. We deleted 3 cases (107, 108
and 109) because of missing values and used height as the response variable
Y . The five predictor variables used were height when sitting, height when
kneeling, head length, nasal breadth, and span (perhaps from left hand to right
hand). Figure 2.1 presents the OLS residual and response plots for this data
set. Points corresponding to cases with Cook’s distance > min(0.5, 2p/n) are
shown as highlighted squares (cases 3, 44 and 63). The 3rd person was very
tall while the 44th person was rather short. From the plots, the standard
deviation of the residuals appears to be around 10. Hence cases 3 and 44 are
certainly worth examining. Two other cases have residuals near fifty.

Data sets like this one are very common. The majority of the cases seem
to follow a multiple linear regression model with iid Gaussian errors, but
a small percentage of cases seem to come from an error distribution with
heavier tails than a Gaussian distribution.

3.6 Outlier Detection

Do not attempt to build a model on a set of poor data! In human surveys,
one often finds 14–inch men, 1000–pound women, students with “no” lungs,
and so on. In manufacturing data, one can find 10,000 pounds of material

in a 100 pound capacity barrel, and similar obvious errors. All the
planning, and training in the world will not eliminate these sorts of
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problems. ... In our decades of experience with “messy data,” we have yet
to find a large data set completely free of such quality problems.

Draper and Smith (1981, p. 418)

There is an enormous literature on outlier detection in multiple linear re-
gression. Typically a numerical measure such as Cook’s distance or a residual
plot based on resistant fits is used. The following terms are frequently en-
countered.

Definition 3.10. Outliers are cases that lie far from the bulk of the
data. Hence Y outliers are cases that have unusually large vertical distances
from the MLR fit to the bulk of the data while x outliers are cases with
predictors x that lie far from the bulk of the xi. Suppose that some analysis
to detect outliers is performed. Masking occurs if the analysis suggests that
one or more outliers are in fact good cases. Swamping occurs if the analysis
suggests that one or more good cases are outliers.

The residual and response plots are very useful for detecting outliers. If
there is a cluster of cases with outlying Y s, the identity line will often pass
through the outliers. If there are two clusters with similar Y s, then the two
plots may fail to show the clusters. Then using methods to detect x outliers
may be useful.

Let the q continuous predictors in the MLR model be collected into vec-
tors ui for i = 1, ..., n. Let the n × q matrix W have n rows uT

1 , ...,u
T
n . Let

the q× 1 column vector T (W ) be a multivariate location estimator, and let
the q×q symmetric positive definite matrix C(W ) be a covariance estimator.
Often q = p− 1 and only the constant is omitted from xi to create ui.

Definition 3.11. The ith squared Mahalanobis distance is

D2
i = D2

i (T (W ),C(W )) = (ui − T (W ))TC−1(W )(ui − T (W )) (3.12)

for each point ui. Notice that D2
i is a random variable (scalar valued).

The classical Mahalanobis distance corresponds to the sample mean and
sample covariance matrix

T (W ) = u =
1

n

n∑
i=1

ui,
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and

C(W ) = S =
1

n− 1

n∑
i=1

(ui − T (W ))(ui − T (W ))T

and will be denoted by MDi. When T (W ) and C(W ) are robust estimators,
Di =

√
D2

i will sometimes be denoted by RDi. We suggest using the Olive
(2009) FCH estimator as the robust estimator. The sample Mahalanobis
distance Di =

√
D2

i is an analog of the absolute value of the sample z-score
|zi| = |(Yi − Y )/σ̂|. Also notice that the Euclidean distance of ui from the
estimate of center T (W ) is Di(T (W ), Iq) where Iq is the q × q identity
matrix. Plot the MDi versus the RDi to detect outlying u.

Definition 3.12: Rousseeuw and Van Driessen (1999). The DD
plot is a plot of the classical Mahalanobis distances MDi versus robust Ma-
halanobis distances RDi.

Olive (2002) shows that the plotted points in the DD plot will follow the
identity line with zero intercept and unit slope if the predictor distribution
is multivariate normal (MVN), and will follow a line with zero intercept but
non–unit slope if the distribution is elliptically contoured with nonsingular
covariance matrix but not MVN. (Such distributions have linear scatterplot
matrices. See Chapter 14.) Hence if the plotted points in the DD plot follow
some line through the origin, then there is some evidence that outliers and
strong nonlinearities have been removed from the predictors.

Example 3.12. Buxton (1920, p. 232-5) gives 20 measurements of 88
men. We chose to predict stature using an intercept, head length, nasal
height, bigonal breadth, and cephalic index. Observation 9 was deleted since
it had missing values. Five individuals, numbers 62-66, were reported to be
about 0.75 inches tall with head lengths well over five feet! This appears to
be a clerical error; these individuals’ stature was recorded as head length and
the integer 18 or 19 given for stature, making the cases massive outliers with
enormous leverage.

Figure 3.11 shows the response plot and residual plot for the Buxton
data. Although an index plot of Cook’s distance CDi may be useful for
flagging influential cases, the index plot provides no direct way of judging
the model against the data. As a remedy, cases in the response plot with
CDi > min(0.5, 2p/n) were highlighted. Notice that the OLS fit passes
through the outliers, but the response plot is resistant to Y –outliers since Y
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Figure 3.11: Residual and Response Plots for Buxton Data

is on the vertical axis. Also notice that although the outlying cluster is far
from Y , only two of the outliers had large Cook’s distance. Hence masking
occurred for both Cook’s distances and for OLS residuals, but not for OLS
fitted values.

Figure 3.12a shows the DD plot made from the four predictors head length,
nasal height, bigonal breadth, and cephalic index. The five massive outliers
correspond to head lengths that were recorded to be around 5 feet. Fig-
ure 3.12b is the DD plot computed after deleting these points and suggests
that the predictor distribution is now much closer to a multivariate normal
distribution.

High leverage outliers are a particular challenge to conventional numer-
ical MLR diagnostics such as Cook’s distance, but can often be visualized
using the response and residual plots. The following techniques are useful for
detecting outliers when the multiple linear regression model is appropriate.

1. Find the OLS residuals and fitted values and make a response plot and
a residual plot. Look for clusters of points that are separated from the
bulk of the data and look for residuals that have large absolute values.
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Figure 3.12: DD Plots for Buxton Data

Beginners frequently label too many points as outliers. Try to estimate
the standard deviation of the residuals in both plots. In the residual
plot, look for residuals that are more than 5 standard deviations away
from the r = 0 line. The identity line and r = 0 line may pass right
through a cluster of outliers, but the cluster of outliers can often be
detected because there is a large gap between the cluster and the bulk
of the data, as in Figure 3.11.

2. Make a DD plot of the predictors that take on many values (the con-
tinuous predictors).

3. Make a scatterplot matrix of several diagnostics such as leverages,
Cook’s distances and studentized residuals.

Detecting outliers is much easier than deciding what to do with them.
After detection, the investigator should see whether the outliers are recording
errors. The outliers may become good cases after they are corrected. But
frequently there is no simple explanation for why the cases are outlying.
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Typical advice is that outlying cases should never be blindly deleted and that
the investigator should analyze the full data set including the outliers as well
as the data set after the outliers have been removed (either by deleting the
cases or the variables that contain the outliers).

Typically two methods are used to find the cases (or variables) to delete.
The investigator computes OLS diagnostics and subjectively deletes cases,
or a resistant multiple linear regression estimator is used that automatically
gives certain cases zero weight. A third, much more effective method, is to
use the response and residual plots.

Suppose that the data has been examined, recording errors corrected, and
impossible cases deleted. For example, in the Buxton (1920) data, 5 people
with heights of 0.75 inches were recorded. For this data set, these heights
could be corrected. If they could not be corrected, then these cases should
be discarded since they are impossible. If outliers are present even after
correcting recording errors and discarding impossible cases, then we can add
an additional rough guideline.

If the purpose is to display the relationship between the predictors and the
response, make a response plot using the full data set (computing the fitted
values by giving the outliers weight zero) and using the data set with the
outliers removed. Both plots are needed if the relationship that holds for
the bulk of the data is obscured by outliers. The outliers are removed from
the data set in order to get reliable estimates for the bulk of the data. The
identity line should be added as a visual aid and the proportion of outliers
should be given.

3.7 Summary

1) Suppose you have a scatterplot of two variables xλ1
1 versus xλ2

2 , x1, x2 > 0
and that the plotted points follow a nonlinear one to one function. Consider
the ladder of powers −1,−0.5,−1/3, 0, 1/3, 0.5, and 1. The ladder rule
says to spread small values of the variable, make λi smaller. To spread large
values of the variable, make λi larger.

2) Suppose w is positive. The log rule says use log(w) if
max(wi)/min(wi) > 10.

3) There are several guidelines for choosing power transformations. First,
see the rule 1) and 2) above. Suppose that all values of the variable w to
be transformed are positive. The log rule often works wonders on the data.
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If the variable w can take on the value of 0, use log(w + c) where c is a
small constant like 1, 1/2, or 3/8. The unit rule says that if Xi and y
have the same units, then use the same transformation of Xi and y. The
cube root rule says that if w is a volume measurement, then cube root
transformation w1/3 may be useful. Consider the ladder of powers given in
point 1). No transformation (λ = 1) is best, then the log transformation,
then the square root transformation. Theory, if available, should be used to
select a transformation. Frequently more than one transformation will work.
For example if y = weight, X1 = volume = X2 ∗X3 ∗X4, then y vs. X

1/3
1 or

log(y) vs. log(X1) = log(X2) + log(X3) + log(X4) may both work. Also if y
is linearly related with X2, X3, X4 and these three variables all have length
units mm, say, then the units of X1 are (mm)3. Hence the units of X

1/3
1 are

mm.
4) To find a response transformation, make the transformation plots

and choose a transformation such that the transformation plot is linear.
5) A factor (with c levels a1, ..., ac) is incorporated into the MLR model

by using c− 1 indicator variables xWi = 1 if W = ai and xWi = 0 otherwise,
where one of the levels ai is omitted, eg, use i = 1, ..., c− 1.

6) For variable selection, the model Y = xTβ + e that uses all of
the predictors is called the full model. A model Y = xT

I βI + e that only
uses a subset xI of the predictors is called a submodel. The full model is
always a submodel. The full model has SP = xTβ and the submodel has
SP = xT

I βI.
7) Make scatterplot matrices of the predictors and the response. Then

remove strong nonlinearities from the predictors using power trans-
formations. The log rule is very useful.

8) Either include all of the indicator variables for a factor in the model
or exclude all of them. If the model contains powers or interactions, also
include all main effects in the model.

9) After selecting a submodel I , make the response and residual plots for
the full model and the submodel. Make the RR plot of rI,i versus ri and the

FF plot of ŶI,i versus Yi. The submodel is good if the plotted points in the
FF and RR plots cluster tightly about the identity line. In the RR plot, the
OLS line and identity line can be added to the plot as visual aids. It should
be difficult to see that the OLS and identity lines intersect at the origin, so
the two lines should nearly coincide at the origin. If the FF plot looks good
but the RR plot does not, the submodel may be good if the main goal of the
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analysis is for prediction.
10) Forward selection Step 1) k = 1: Start with a constant w1 = x1.

Step 2) k = 2: Compute Cp for all models with k = 2 containing a constant
and a single predictor xi. Keep the predictor w2 = xj, say, that minimizes
Cp.
Step 3) k = 3: Fit all models with k = 3 that contain w1 and w2. Keep the
predictor w3 that minimizes Cp. ...
Step j) k = j: Fit all models with k = j that contains w1, w2, ..., wj−1. Keep
the predictor wj that minimizes Cp. ...
Step p): Fit the full model.

Backward elimination: All models contain a constant = u1. Step 0)
k = p: Start with the full model that contains x1, ..., xp. We will also say
that the full model contains u1, ..., up where u1 = x1 but ui need not equal
xi for i > 1.
Step 1) k = p − 1: Fit each model with k = p − 1 predictors including a
constant. Delete the predictor up, say, that corresponds to the model with
the smallest Cp. Keep u1, ..., up−1.
Step 2) k = p−2: Fit each model with p−2 predictors including a constant.
Delete the predictor up−1 corresponding to the smallest Cp. Keep u1, ..., up−2.
...
Step j) k = p − j: fit each model with p − j predictors including a con-
stant. Delete the predictor up−j+1 corresponding to the smallest Cp. Keep
u1, ..., up−j. ...
Step p− 2) k = 2. The current model contains u1, u2 and u3. Fit the model
u1, u2 and the model u1, u3. Assume that model u1, u2 minimizes Cp. Then
delete u3 and keep u1 and u2.

11) Let Imin correspond to the submodel with the smallest Cp. Find
the submodel II with the fewest number of predictors such that Cp(II) ≤
Cp(Imin) + 1. Then II is the initial submodel that should be examined. It
is possible that II = Imin or that II is the full model. Models I with fewer
predictors than II such that Cp(I) ≤ Cp(Imin)+ 4 are interesting and should
also be examined. Models I with k predictors, including a constant and with
fewer predictors than II such that Cp(Imin) + 4 < Cp(I) ≤ min(2k, p) should
be checked.

12) There are several guidelines for building a MLR model. Suppose that
variable Z is of interest and variables W1, ...,Wr have been collected along
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with Z. Make a scatterplot matrix of W1, ...,Wr and Z. (If r is large, several
matrices may need to be made. Each one should include Z.) Remove or
correct any gross outliers. It is often a good idea to transform the Wi to re-
move any strong nonlinearities from the predictors. Eventually you
will find a response variable Y = tZ(Z) and predictor variable X1, ..., Xp−1

for the full model. Interactions such as Xk = WiWj and powers such as
Xk = W 2

i may be of interest. Indicator variables are often used in interac-
tions but do not transform an indicator variable. The response plot for the
full model should be linear and the residual plot should be ellipsoidal with
zero trend. Find the LS output. The statistic R2 gives the proportion of
the variance of Y explained by the predictors and is of great importance.
Use backwards elimination and forward selection with the Cp(I) statistic to
suggest candidate models I . As a rule of thumb, (assuming that the sample
size n is much larger than the pool of predictors, eg n > 5p), make sure that
R2

I > 0.9R2 or R2
I > R2 − 0.07. Often want the number of predictors k in

the submodel to be small. We will almost always include a constant in the
submodel. If the submodel seems to be good, make the response plot and
residual plot for the submodel. They should be linear and ellipsoidal with
zero trend, respectively. From the output, see if any terms can be eliminated
(are there any predictors Xi such that the p–value for Ho:βi = 0 > 0.01?)

13) Assume that the full model has good response and residual plots and
than n > 5p. Let subset I have k predictors, including a constant. The
following rules of thumb may be useful, but may not all hold simultaneously.
Let Imin be the minimum Cp model and let II be the model with the fewest
predictors satisfying Cp(II) ≤ Cp(Imin)+ 1. Do not use more predictors than
model II to avoid overfitting. Then the submodel I is good if
i) the response and residual plots for the submodel looks like the response
and residual plots for the full model.
ii) corr(ESP,ESP(I)) = corr(Ŷ, ŶI) ≥ 0.95.
iii) The plotted points in the FF plot cluster tightly about the identity line.
iv) Want the p-value ≥ 0.01 for the partial F test that uses I as the reduced
model.
v) Want k ≤ n/10.
vi) The plotted points in the RR plot cluster tightly about the identity line.
vii) Want R2(I) > 0.9R2 and R2(I) > R2−0.07 (recall that R2(I) ≤ R2(full)
since adding predictors to I does not decrease R2(I)).
viii) Want Cp(Imin) ≤ Cp(I) ≤ min(2k, p) with no big jumps in Cp (the
increase should be less than four) as variables are deleted.
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ix) Want hardly any predictors with p-values > 0.05.
x) Want few predictors with p-values between 0.01 and 0.05.

14) Always check that the full model is good. If the candidate model
seems to be good, the usual MLR checks should still be made. In particular,
the response plot and residual plot need to be made for the submodel.

15) Influence is roughly (leverage)(discrepancy). The leverages hi are
the diagonal elements of the hat matrix H and measure how far xi is from
the sample mean of the predictors. Cook’s distance is widely used, but the
response plot and residual plot are the most effective tools for detecting
outliers and influential cases.

3.8 Complements

With one data set, OLS is a great place to start but a bad place to end. If
n = 5kp where k > 2, it may be useful to take a random sample of n/k cases
to build the MLR model. Then check the model on the full data set.

Predictor Transformations

One of the most useful techniques in regression is to remove
gross nonlinearities in the predictors by using predictor transfor-
mations. The log rule is very useful for transforming highly skewed
predictors. The linearizing of the predictor relationships could be done by
using marginal power transformations or by transforming the joint distri-
bution of the predictors towards an elliptically contoured distribution. The
linearization might also be done by using simultaneous power transformations

λ = (λ2, . . . , λp)
T of the predictors so that the vector wλ = (x

(λ2)
2 , ..., x

(λp)
p )T

of transformed predictors is approximately multivariate normal. A method
for doing this was developed by Velilla (1993). (The basic idea is the same
as that underlying the likelihood approach of Box and Cox for estimating a
power transformation of the response in regression, but the likelihood comes

from the assumed multivariate normal distribution of wλ.) The Cook and
Nachtsheim (1994) procedure can cause the distribution to be closer to ellip-
tical symmetry. Marginal Box-Cox transformations also seem to be effective.
Power transformations can also be selected with slider bars in Arc. More will
be said about predictor transformations in Section 15.3.

Suppose that it is thought that the model Y = xT β + e could be im-
proved by transforming xj. Let xTβ = uTη + βjxj where uT η = x1β1 +
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· · ·+ xj−1βj−1 + xj+1βj+1 + · · ·+ xpβp. Let τ (xj) denote the unknown trans-
formation.

Definition 3.13. Consider the OLS residuals ri(j) = Yi −uT
i η̂ obtained

from the OLS regression of Y on u. A partial residual plot or component
plus residual plot or ceres plot with linear augmentation is a plot of the ri(j)
versus xj and is used to visualize τ .

Cook (1993) shows that partial residual plots are useful for visualizing τ
provided that the plots of xi versus xj are linear. More general ceres plots,
in particular ceres plots with smooth augmentation, can be used to visualize
τ if Y = uT η + τ (xj) + e but the linearity condition fails.

The assumption that all values of x1 and x2 are positive for power trans-
formation can be removed by using the modified power transformations of
Yeo and Johnson (2000).

Response Transformations

Application 3.1 was suggested by Olive (2004b) and Olive and Hawkins
(2009a). An advantage of this graphical method is that it works for linear
models: that is, for multiple linear regression and for many experimental
design models. Notice that if the plotted points in the transformation plot
follow the identity line, then the plot is also a response plot. The method is
also easily performed for MLR methods other than least squares.

A variant of the method would plot the residual plot or both the response
and the residual plot for each of the seven values of λ. Residual plots are also
useful, but they no not distinguish between nonlinear monotone relationships
and nonmonotone relationships. See Fox (1991, p. 55).

Cook and Olive (2001) also suggest a graphical method for selecting and
assessing response transformations under model (3.2). Cook and Weisberg
(1994) show that a plot of Z versus xT β̂ (swap the axis on the transformation
plot for λ = 1) can be used to visualize t if Y = t(Z) = xTβ + e, suggesting
that t−1 can be visualized in a plot of xT β̂ versus Z.

If there is nonlinearity present in the scatterplot matrix of the nontrivial
predictors, then transforming the predictors to remove the nonlinear-
ity will often be a useful procedure. More will be said about response
transformations for experimental designs in Section 5.3.

There has been considerable discussion on whether the response transfor-
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mation parameter λ should be selected with maximum likelihood (see Bickel
and Doksum 1981), or selected by maximum likelihood and then rounded to
a meaningful value on a coarse grid ΛL (see Box and Cox 1982 and Hinkley
and Runger 1984). Suppose that no strong nonlinearities are present among
the predictors x and that if predictor transformations were used, then the
transformations were chosen without examining the response. Also assume
that

Y = tλo(Z) = xT β + e.

Suppose that a transformation tλ̂ is chosen without examining the response.
Results in Li and Duan (1989), Chen and Li (1998) and Chang and Olive
(2009) suggest that if x has an approximate multivariate normal distribution,
then the OLS ANOVA F, partial F and Wald t tests will have the correct
level asymptotically, even if λ̂ �= λo.

Now assume that the response is used to choose λ̂. For example assume
that the numerical Box Cox method is used. Then λ̂ is likely to be variable
unless the sample size is quite large, and considerable bias can be introduced,
as observed by Bickel and Doksum (1981). Now assume that λ̂ is chosen with
the graphical method (and assume that ties are broken by using theory or by
using the following list in decreasing order of importance 1, 0, 1/2,−1 and 1/3
so that the log transformation is chosen over the cube root transformation if
both look equally good). Then λ̂ will often rapidly converge in probability
to a value λ∗ ∈ ΛL. Hence for moderate sample sizes, it may be reasonable
to assume that the OLS tests have approximately the correct level. Let
W = tλ̂(Z) and perform the OLS regression of W on x. If the response and
residual plots suggest that the MLR model is appropriate, then the response
transformation from the graphical method will be useful for description and
exploratory purposes, and may be useful for prediction and inference.

The MLR assumptions always need to be checked after making a response
transformation. Since the graphical method uses a response plot to choose
the transformation, the graphical method should be much more reliable than
a numerical method. Transformation plots should be made if a numerical
method is used, but numerical methods are not needed to use the graphical
method.

Variable Selection and Multicollinearity

The literature on numerical methods for variable selection in the OLS
multiple linear regression model is enormous. Three important papers are
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Jones (1946), Mallows (1973), and Furnival and Wilson (1974). Chatterjee
and Hadi (1988, p. 43-47) give a nice account on the effects of overfitting
on the least squares estimates. Also see Claeskins and Hjort (2003), Hjort
and Claeskins (2003) and Efron, Hastie, Johnstone and Tibshirani (2004).
Texts include Burnham and Anderson (2002), Claeskens and Hjort (2008)
and Linhart and Zucchini (1986).

Cook and Weisberg (1999, p. 264-265) give a good discussion of the effect
of deleting predictors on linearity and the constant variance assumption.
Walls and Weeks (1969) note that adding predictors increases the variance
of a predicted response. Also R2 gets large. See Freedman (1983).

Discussion of biases introduced by variable selection and data snooping
include Hurvich and Tsai (1990), Selvin and Stuart (1966) and Hjort and
Claeskins (2003). This theory assumes that the full model is known before
collecting the data, but in practice the full model is often built after collecting
the data. Freedman (2005, p. 192–195) gives an interesting discussion on
model building and variable selection.

Olive and Hawkins (2005) discuss influential cases in variable selection,
as do Léger and Altman (1993).

The interpretation of Mallows Cp given in Proposition 3.2 is due to Olive
and Hawkins (2005) and can be generalized to other 1D regression models.
Other interpretations of the Cp statistic specific to MLR can be given. See
Gilmour (1996). The Cp statistic is due to Jones (1946). Also see Kenard
(1971).

The AIC(I) statistic is often used instead of Cp(I). The full model and
the model Imin found with the smallest AIC are always of interest. Burnham
and Anderson (2004) suggest that if ∆(I) = AIC(I) − AIC(Imin), then
models with ∆(I) ≤ 2 are good, models with 4 ≤ ∆(I) ≤ 7 are borderline,
and models with ∆(I) > 10 should not be used as the final submodel. Find
the submodel II with the smallest number of predictors such that ∆(II) ≤ 2.
Then II is the initial submodel to examine, and often II = Imin. Also examine
submodels I with fewer predictors than II with ∆(I) ≤ 7.

When there are strong linear relationships among the predictors, multi-
collinearity is present. Let R2

k be the coefficient of multiple determination
when xk is regressed on the remaining predictor variables, including a con-
stant. The variance inflation factor is VIF(k) = 1/(1 − R2

k). Both R2
k and

VIF(k) are large when multicollinearity is present. Following Cook and Weis-
berg (1999, p. 274), if sk is the sample standard deviation of xk, than the



CHAPTER 3. BUILDING AN MLR MODEL 159

standard error of β̂k is

se(β̂k) =

√
MSE

sk

√
n− 1

1

1 − R2
k

=

√
MSE

sk

√
n− 1

√
V IF (k).

Hence βk becomes more difficult to estimate when multicollinearity is present.
Variable selection is a useful way to reduce multicollinearity, and alternatives
such as ridge regression are discussed in Gunst and Mason (1980). Belsley
(1984) shows that centering the data before diagnosing the data for multi-
collinearity is not necessarily a good idea.

We note that the pollution data of Example 3.7 has been heavily analyzed
in the ridge regression literature, but this data was easily handled by the log
rule combined with variable selection. The pollution data can be obtained
from this text’s website, or from the STATLIB website:
(http://lib.stat.cmu.edu/).

The leaps function in Splus and Proc Rsquare in SAS can be used to
perform all subsets variable selection with the Cp criterion. The step func-
tion in R/Splus can be used for forward selection and backward elimination.

Diagnostics

Excellent introductions to OLS diagnostics include Fox (1991) and Cook
and Weisberg (1999, p. 161-163, 183-184, section 10.5, section 10.6, ch.
14, ch. 15, ch. 17, ch. 18, and section 19.3). More advanced works include
Belsley, Kuh, and Welsch (1980), Cook and Weisberg (1982), Atkinson (1985)
and Chatterjee and Hadi (1988). Hoaglin and Welsh (1978) examines the
hat matrix while Cook (1977) introduces Cook’s distance. Also see Velleman
and Welsch (1981). Cook and Weisberg (1997, 1999 ch. 17) call a plot that
emphasizes model agreement a model checking plot.

Outliers

Olive (2009) is an authoritative introduction to outlier detection. Some
useful properties of the DD plot are given in Olive (2002). Theory for the
FCH estimators is given in Olive (2009, ch. 10) and Olive and Hawkins
(2009b).
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3.9 Problems

Problems with an asterisk * are especially important.

Output for problem 3.1.

Current terms: (finger to ground nasal height sternal height)

df RSS | k C_I

Delete: nasal height 73 35567.2 | 3 1.617

Delete: finger to ground 73 36878.8 | 3 4.258

Delete: sternal height 73 186259. | 3 305.047

3.1. From the output from backward elimination given on the previous
page, what terms should be used in the MLR model to predict Y ? (You can
tell that the nontrivial variables are finger to ground, nasal height and sternal
height from the “delete lines.” DON’T FORGET THE CONSTANT!)

Output for Problem 3.2.
L1 L2 L3 L4

# of predictors 10 6 4 3
# with 0.01 ≤ p-value ≤ 0.05 0 0 0 0

# with p-value > 0.05 6 2 0 0
R2(I) 0.774 0.768 0.747 0.615

corr(Ŷ , ŶI) 1.0 0.996 0.982 0.891
Cp(I) 10.0 3.00 2.43 22.037√
MSE 63.430 61.064 62.261 75.921

p-value for partial F test 1.0 0.902 0.622 0.004

3.2. The above table gives summary statistics for 4 MLR models con-
sidered as final submodels after performing variable selection. The response
plot and residual plot for the full model L1 was good. Model L3 was the min-
imum Cp model found. Which model should be used as the final submodel?
Explain briefly why each of the other 3 submodels should not be used.
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Output for Problem 3.3.
L1 L2 L3 L4

# of predictors 10 5 4 3
# with 0.01 ≤ p-value ≤ 0.05 0 1 0 0

# with p-value > 0.05 8 0 0 0
R2(I) 0.655 0.650 0.648 0.630

corr(Ŷ , ŶI) 1.0 0.996 0.992 0.981
Cp(I) 10.0 4.00 5.60 13.81√
MSE 73.548 73.521 73.894 75.187

p-value for partial F test 1.0 0.550 0.272 0.015

3.3. The above table gives summary statistics for 4 MLR models con-
sidered as final submodels after performing variable selection. The response
plot and residual plot for the full model L1 was good. Model L2 was the
minimum Cp model found.

a) Which model is II , the initial submodel to look at?
b) What other model or models, if any, should be examined?
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Output for Problem 3.4.

ADJUSTED 99 cases 2 outliers

k CP R SQUARE R SQUARE RESID SS MODEL VARIABLES

-- ----- -------- -------- --------- --------------

1 760.7 0.0000 0.0000 185.928 INTERCEPT ONLY

2 12.7 0.8732 0.8745 23.3381 B

2 335.9 0.4924 0.4976 93.4059 A

2 393.0 0.4252 0.4311 105.779 C

3 12.2 0.8748 0.8773 22.8088 B C

3 14.6 0.8720 0.8746 23.3179 A B

3 15.7 0.8706 0.8732 23.5677 A C

4 4.0 0.8857 0.8892 20.5927 A B C

ADJUSTED 97 cases after deleting the 2 outliers

k CP R SQUARE R SQUARE RESID SS MODEL VARIABLES

-- ----- -------- -------- --------- --------------

1 903.5 0.0000 0.0000 183.102 INTERCEPT ONLY

2 0.7 0.9052 0.9062 17.1785 B

2 406.6 0.4944 0.4996 91.6174 A

2 426.0 0.4748 0.4802 95.1708 C

3 2.1 0.9048 0.9068 17.0741 A C

3 2.6 0.9043 0.9063 17.1654 B C

3 2.6 0.9042 0.9062 17.1678 A B

4 4.0 0.9039 0.9069 17.0539 A B C

3.4. The output above is from software that does all subsets variable
selection. The data is from Ashworth (1842). The predictors were A =
log(1692 property value), B = log(1841 property value) and C = log(percent
increase in value) while the response variable is Y = log(1841 population).

a) The top output corresponds to data with 2 small outliers. From this
output, what is the best model? Explain briefly.

b) The bottom output corresponds to the data with the 2 outliers re-
moved. From this output, what is the best model? Explain briefly.

Problems using R/Splus.

Warning: Use the command source(“A:/regpack.txt”) to download
the programs. See Preface or Section 17.1. Typing the name of the
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regpack function, eg tplot, will display the code for the function. Use the
args command, eg args(tplot), to display the needed arguments for the func-
tion.

3.5∗. You may also copy and paste R commands for this problem from
(www.math.siu.edu/olive/reghw.txt).

a) Download the R/Splus function tplot that makes the transformation
plots for λ ∈ ΛL.

b) Use the following R/Splus command to make a 100 × 3 matrix. The
columns of this matrix are the three nontrivial predictor variables.

nx <- matrix(rnorm(300),nrow=100,ncol=3)

Use the following command to make the response variable Y.

y <- exp( 4 + nx%*%c(1,1,1) + 0.5*rnorm(100) )

This command means the MLR model log(Y ) = 4 + X2 + X3 + X4 + e
will hold where e ∼ N(0, 0.25).

To find the response transformation, you need the program tplot given
in a). Type ls() to see if the programs were downloaded correctly.

c) To make the transformation plots type the following command.

tplot(nx,y)

The first plot will be for λ = −1. Move the cursor to the plot and hold the
rightmost mouse key down (and in R, highlight stop) to go to the next
plot. Repeat these mouse operations to look at all of the plots. The identity
line is included in each plot. When you get a plot where the plotted points
cluster about the identity line with no other pattern, include this transfor-
mation plot in Word by pressing the Ctrl and c keys simultaneously. This
will copy the graph. Then in Word use the menu commands “File>Paste”.
You should get the log transformation.

d) Type the following commands.

out <- lsfit(nx,log(y))

ls.print(out)
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Use the mouse to highlight the created output and include the output in
Word.

e) Write down the least squares equation for ̂log(Y ) using the output in
d).

3.6. Download cbrainx and cbrainy from
(www.math.siu.edu/olive/regdata.txt) into R. Either use the source com-
mand on regdata.txt if it is saved on a disk, or copy and paste the two files
into R. Copy and paste the R commands for this problem from
(www.math.siu.edu/olive/reghw.txt).

The data is the brain weight data from Gladstone (1905-6). The response
Y is brain weight while the predictors are age, breadth, cephalic, circum,
headht, height, len, sex and a constant. The step function can be used to
perform forward selection and backward elimination in R.

a) Copy and paste the commands for this problem into R. The commands
fit the full model, display the LS output and perform backward elimination
using the AIC criterion. Copy and paste the output for backward elimination
into Word (one page of output).

zx <- cbrainx[,c(1,3,5,6,7,8,9,10)]

zbrain <- as.data.frame(cbind(cbrainy,zx))

zfull <- lm(cbrainy~.,data=zbrain)

summary(zfull)

back <- step(zfull)

b) Want low AIC and as few predictors as possible. Backward elimination
starts with the full model then deletes one nontrivial predictor at a time. The
term <None> corresponds to the current model that does not eliminate any
terms. The terms listed above <None> correspond to models that have
smaller AIC than the current model. R stops when eliminating terms makes
the AIC higher than the current model. Which terms, including a constant,
were in this minimum AIC model?

c) Copy and paste the commands for this problem into R. The commands
fit the null model that only contains a constant. Forward selection starts at
the null model (corresponding to lower) and considers 8 nontrivial predictors
(given by upper).

Copy and paste the output for forward selection into Word (two pages of
output).
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zint <- lm(cbrainy~1,data=zbrain)

forw <- step(zint,scope=list(lower=~1,

upper=~age+breadth+cephalic+circum+headht+height+len+sex),

direction="forward")

d) Forward selection in R starts with the null model and then adds a
predictor circum to the model. Forward selection in R allows you to consider
models with fewer predictors than the minimum AIC model (unlike backward
elimination). Which terms, including a constant, were in the minimum AIC
model?

Problems using ARC

To quit Arc, move the cursor to the x in the northeast corner and click.
Problems 3.7–3.11 use data sets that come with Arc (Cook and Weisberg
1999a).

3.7∗. a) In Arc enter the menu commands “File>Load>Data>ARCG”
and open the file big-mac.lsp. Next use the menu commands “Graph&Fit>
Plot of” to obtain a dialog window. Double click on TeachSal and then
double click on BigMac. Then click on OK. These commands make a plot
of x = TeachSal = primary teacher salary in thousands of dollars versus y =
BigMac = minutes of labor needed to buy a Big Mac and fries. Include the
plot in Word.

Consider transforming y with a (modified) power transformation

y(λ) =

{
(yλ − 1)/λ, λ �= 0

log(y), λ = 0

b) Should simple linear regression be used to predict y from x? Explain.

c) In the plot, λ = 1. Which transformation will increase the linearity of
the plot, log(y) or y(2)? Explain.

3.8∗. In Arc enter the menu commands “File>Load>Data>ARCG” and
open the file mussels.lsp. Use the commands “Graph&Fit>Scatterplot Ma-
trix of.” In the dialog window select H, L, W, S and M (so select M last).
Click on “OK” and include the scatterplot matrix in Word. The response M
is the edible part of the mussel while the 4 predictors are shell measurements.
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Are any of the marginal predictor relationships nonlinear? Is E(M |H) linear
or nonlinear?

3.9∗. The file wool.lsp has data from a 33 experiment on the behavior
of worsted yarn under cycles of repeated loadings. The response Y is the
number of cycles to failure and the three predictors are the length, amplitude
and load. Make five transformation plots by using the following commands.

From the menu “Wool” select “transform” and double click on Cycles.
Select “modified power” and use p = −1,−0.5, 0 and 0.5. Use the menu
commands “Graph&Fit>Fit linear LS” to obtain a dialog window. Next fit
LS five times. Use Amp, Len and Load as the predictors for all 5 regres-
sions, but use Cycles−1, Cycles−0.5, log[Cycles], Cycles0.5 and Cycles as the
response.

Use the menu commands “Graph&Fit>Plot of” to create a dialog window.
Double click on L5:Fit-Values and double click on Cycles, double click on
L4:Fit-Values and double click on Cycles0.5, double click on L3:Fit-Values and
double click on log[Cycles], double click on L2:Fit-Values and double click on
Cycles−0.5, double click on L1:Fit-Values and double click on Cycles−1.

a) You may stop when the resulting plot in linear. Let Z = Cycles.

Include the plot of Ŷ versus Y = Z(λ) that is linear in Word. Move the OLS
slider bar to 1. What response transformation do you end up using?

b) Use the menu commands “Graph&Fit>Plot of” and put L5:Fit-Values
in the H box and L3:Fit-Values in the V box. Is the plot linear?

3.10. In Arc enter the menu commands “File>Load>Data>ARCG” and
open the file bcherry.lsp. The menu Trees will appear. Use the menu com-
mands “Trees>Transform” and a dialog window will appear. Select terms
Vol, D, and Ht. Then select the log transformation. The terms log Vol, log D
and log H should be added to the data set. If a tree is shaped like a cylinder
or a cone, then V ol ∝ D2Ht and taking logs results in a linear model.

a) Fit the full model with Y = log V ol, X1 = logD and X2 = logHt.
Add the output that has the LS coefficients to Word.

b) Fitting the full model will result in the menu L1. Use the commands
“L1>AVP–All 2D.” This will create a plot with a slider bar at the bottom
that says log[D]. This is the added variable plot for log(D). To make an added
variable plot for log(Ht), click on the slider bar. Add the OLS line to the
AV plot for log(Ht) by moving the OLS slider bar to 1, and add the zero line
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by clicking on the “Zero line box”. Include the resulting plot in Word.

c) Fit the reduced model that drops log(Ht). Make an RR plot with
the residuals from the full model on the V axis and the residuals from the
submodel on the H axis. Add the LS line and the identity line as visual aids.
(Click on the Options menu to the left of the plot and type “y=x” in the
resulting dialog window to add the identity line.) Include the plot in Word.

d) Similarly make an FF plot using the fitted values from the two models.
Add the OLS line which is the identity line. Include the plot in Word.

e) Next put the residuals from the submodel on the V axis and log(Ht)
on the H axis. Move the OLS slider bar to 1, and include this residual plot
in Word.

f) Next put the residuals from the submodel on the V axis and the fitted
values from the submodel on the H axis. Include this residual plot in Word.

g) Next put log(Vol) on the V axis and the fitted values from the submodel
on the H axis. Move the OLS slider bar to 1, and include this response plot
in Word.

h) Does log(Ht) seem to be an important term? If the only goal is to
predict volume, will much information be lost if log(Ht) is omitted? Beside
each of the 6 plots, remark on the information given by the plot.
(Some of the plots will suggest that log(Ht) is needed while others will suggest
that log(Ht) is not needed.)

3.11∗. a) In this problem we want to build a MLR model to predict
Y = t(BigMac) where t is some power transformation. In Arc enter the
menu commands “File>Load>Data>Arcg” and open the file big-mac.lsp.
Make a scatterplot matrix of the variate valued variables and include the
plot in Word.

b) The log rule makes sense for the BigMac data. From the scatterplot
matrix, use the “Transformations” menu and select “Transform to logs”.
Include the resulting scatterplot matrix in Word.

c) From the “Mac” menu, select “Transform”. Then select all 10 vari-
ables and click on the “Log transformations” button. Then click on “OK”.
From the “Graph&Fit” menu, select “Fit linear LS.” Use log[BigMac] as the
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response and the other 9 “log variables” as the Terms. This model is the full
model. Include the output in Word.

d) Make a response plot (L1:Fit-Values in H and log(BigMac) in V) and
residual plot (L1:Fit-Values in H and L1:Residuals in V) and include both
plots in Word.

e) Using the “L1” menu, select “Examine submodels” and try forward
selection and backward elimination. Using the Cp ≤ min(2k, p) rule suggests
that the submodel using log[service], log[TeachSal] and log[TeachTax] may be
good. From the “Graph&Fit” menu, select “Fit linear LS”, fit the submodel
and include the output in Word.

f) Make a response plot (L2:Fit-Values in H and log(BigMac) in V) and
residual plot (L2:Fit-Values in H and L2:Residuals in V) for the submodel
and include the plots in Word.

g) Make an RR plot (L2:Residuals in H and L1:Residuals in V) and
FF plot (L2:Fit-Values in H and L1:Fit-Values in V) for the submodel and
include the plots in Word. Move the OLS slider bar to 1 in each plot to
add the identity line. For the RR plot, click on the Options menu then type
y = x in the long horizontal box near the bottom of the window and click on
OK to add the identity line.

h) Do the plots and output suggest that the submodel is good? Explain.

Warning: The following problems uses data from the book’s
webpage. Save the data files on a disk. Get in Arc and use the menu
commands “File> Load” and a window with a Look in box will appear. Click
on the black triangle and then on 3 1/2 Floppy(A:). Then click twice on the
data set name.

3.12∗. The following data set has 5 babies that are “good leverage
points:” they look like outliers but should not be deleted because they follow
the same model as the bulk of the data.

a) In Arc enter the menu commands “File>Load>3 1/2 Floppy(A:)” and
open the file cbrain.lsp. Select transform from the cbrain menu, and add
size1/3 using the power transformation option (p = 1/3). From
Graph&Fit, select Fit linear LS. Let the response be brnweight and as terms
include everything but size and Obs. Hence your model will include size1/3.
This regression will add L1 to the menu bar. From this menu, select Examine
submodels. Choose forward selection. You should get models including k =



CHAPTER 3. BUILDING AN MLR MODEL 169

2 to 12 terms including the constant. Find the model with the smallest
Cp(I) = CI statistic and include all models with the same k as that model
in Word. That is, if k = 2 produced the smallest CI , then put the block
with k = 2 into Word. Next go to the L1 menu, choose Examine submodels
and choose Backward Elimination. Find the model with the smallest CI and
include all of the models with the same value of k in Word.

b) What was the minimum Cp model was chosen by forward selection?

c) What was the minimumCp model was chosen by backward elimination?

d) Which minimum Cp model do you prefer? Explain.

e) Give an explanation for why the two models are different.

f) Pick a submodel and include the regression output in Word.

g) For your submodel in f), make an RR plot with the residuals from the
full model on the V axis and the residuals from the submodel on the H axis.
Add the OLS line and the identity line y=x as visual aids. Include the RR
plot in Word.

h) Similarly make an FF plot using the fitted values from the two models.
Add the OLS line which is the identity line. Include the FF plot in Word.

i) Using the submodel, include the response plot (of Ŷ versus Y ) and
residual plot (of Ŷ versus the residuals) in Word.

j) Using results from f)-i), explain why your submodel is a good model.

3.13. Activate the cyp.lsp data set. Choosing no more than 3 nonconstant
terms, try to predict height with multiple linear regression. Include a plot
with the fitted values on the horizontal axis and height on the vertical axis. Is
your model linear? Also include a plot with the fitted values on the horizontal
axis and the residuals on the vertical axis. Does the residual plot suggest that
the linear model may be inappropriate? (There may be outliers in the plot.
These could be due to typos or because the error distribution has heavier
tails than the normal distribution.) State which model you use.

3.14. Activate the insulation data, contributed by Elizabeth Spector,
with the commands “File>Load>3 1/2 Floppy (A:)>insulation.lsp.”
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The data description should appear in the “Listener” window.
Then go to the “Graph&Fit” menu and choose “Plot of ...” and select

“time” for the “H box” “y” for the “V box” and “type” for the “Mark by
box”. Then click on “OK” and a window with a plot should open.

a) The OLS popdown menu is the triangle below OLS. Select “Fit by
marks–general” and then use the cursor to mover the small black box to 2 on
the OLS slider bar. Then copy and paste the plot to Word. This command
fits least squares quadratic functions to the data from each of the 5 types of
insulation.

b) If there is no interaction, then the 5 curves will be roughly parallel
and will not cross. The curves will cross if there is interaction. Is there
interaction?

c) The top curve corresponds to no insulation and the temperature rapidly
rose and then rapidly cooled off. Corn pith corresponds to curve 2. Is corn
pith comparable to the more standard types of insulation 3–5?

3.15. Activate the cement.lsp data, contributed by Alyass Hossin. Act
as if 20 different samples were used to collect this data. If 5 measurements
on 4 different samples were used, then experimental design with repeated
measures or longitudinal data analysis may be a better way to analyze this
data.

a) From Graph&Fit select Plot of, place x1 in H, y in V and x2 in the
Mark by box. From the OLS menu, select Fit by marks–general and move
the slider bar to 2. Include the plot in Word.

b) A quadratic seems to be a pretty good MLR model. From the cement
menu, select Transform, select x1, and place a 2 in the p box. This should
add x12 to the data set. From Graph&Fit select Fit linear LS, select x1 and
x12 as the terms and y as the response. Include the output in Word.

c) Make the response plot. Again from the OLS menu, select Fit by
marks–general and move the slider bar to 1. Include the plot in Word. This
plot suggests that there is an interaction: the CM cement is stronger for
low curing times and weaker for higher curing times. The plot suggests that
there may not be an interaction between the two new types of cement.

d) Place the residual plot in Word. (Again from the OLS menu, select Fit
by marks–general and move the slider bar to 1.) The residual plot is slightly
fan shaped.

e) From the cement menu, select Make factors and select x2. From the
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cement menu, select Make interactions and select x1 and (F)x2. Repeat,
selecting x12 and (F)x2. From Graph&Fit select Fit linear LS, select x1, x12,
(F)x2, x1*(F)x2 and x12*(F)x2 as the terms and y as the response. Include
the output in Word.

f) Include the response plot and residual plot in Word.

g) Next delete the standard cement in order to compare the two coal
based cements. From Graph&Fit select Scatterplot–matrix of, then select x1,
x2 and y. Hold down the leftmost mouse button and highlight the x2 = 2
cases. Then from the Case deletions menu, select Delete selection from data
set. From Graph&Fit select Fit linear LS, select x1, x12, x2 as the terms and
y as the response. Include the output in Word. The output suggests that
the MA brand is about 320 psi less strong than the ME brand. (May need
to add x2*x1 and x2*x12 interactions.)

h) Include the response plot and residual plot in Word. The residual plot
is not particularly good.

3.16. This problem gives a slightly simpler model than Problem 3.15 by
using the indicator variable x3 = 1 if standard cement (if x2 = 2) and x3 =
0 otherwise (if x2 is 0 or 1). Activate the cement.lsp data.

a) From the cement menu, select Transform, select x1, and place a 2 in
the p box. This should add x12 to the data set. From the cement menu,
select Make interactions and select x1 and x3.

b) From Graph&Fit select Fit linear LS, select x1, x12, x3 and x1*x3 as
the terms and y as the response. Include the output in Word.

c) Make the response and residual plots. When making these plots, place
x2 in the Mark by box. Include the plots in Word. Does the model seem ok?

3.17∗. Get the McDonald and Schwing (1973) data pollution.lsp from
(www.math.siu.edu/olive/regbk.htm), and save the file on a disk. Activate
the pollution.lsp dataset with the menu commands “File > Load > 3 1/2
Floppy(A:)> pollution.lsp.” Scroll up the screen to read the data description.
Often simply using the log rule on the predictors with max(x)/min(x) > 10
works wonders.

a) Make a scatterplot matrix of the first nine predictor variables and
the response Mort. The commands “Graph&Fit > Scatterplot-Matrix of”
will bring down a Dialog menu. Select DENS, EDUC, HC, HOUS, HUMID,
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JANT, JULT, NONW, NOX and MORT. Then click on OK.
A scatterplot matrix with slider bars will appear. Move the slider bars

for NOX, NONW and HC to 0, providing the log transformation. In Arc, the
diagonals have the min and max of each variable, and these were the three
predictor variables satisfying the log rule. Open Word.

In Arc, use the menu commands “Edit > Copy.” In Word, use the menu
commands “Edit > Paste.” This should copy the scatterplot matrix into the
Word document. Print the graph.

b) Make a scatterplot matrix of the last six predictor variables and the
response Mort. The commands “Graph&Fit > Scatterplot-Matrix of” will
bring down a Dialog menu. Select OVR65, POOR, POPN, PREC, SO,
WWDRK and MORT. Then click on OK. Move the slider bar of SO to 0
and copy the plot into Word. Print the plot as described in a).

c) Click on the pollution menu and select Transform. Click on the log
transformations button and select HC, NONW, NOX and SO. Click on OK.

Then fit the full model with the menu commands “Graph&Fit > Fit lin-
ear LS”. Select MORT for the response. For the terms, select DENS, EDUC,
log[HC], HOUS, HUMID, JANT, JULT, log[NONW], log[NOX], OVR65,
POOR, POPN, PREC, log[SO] and WWDRK. Click on OK.

This model is the full model. To make the response plot use the menu
commands “Graph&Fit >Plot of”. Select MORT for the V-box and L1:Fit-
Values for the H-box. Click on OK. When the graph appears, move the OLS
slider bar to 1 to add the identity line. Copy the plot into Word.

To make the residual plot use the menu commands “Graph&Fit >Plot
of”. Select L1:Residuals for the V-box and L1:Fit-Values for the H-box. Click
on OK. Copy the plot into Word. Print the two plots.

d) Using the “L1” menu, select “Examine submodels” and try forward
selection. Using the “L1” menu, select “Examine submodels” and try back-
ward elimination. You should get a lot of output including that shown in
Example 3.7.

Fit the submodel with the menu commands “Graph&Fit > Fit linear
LS”. Select MORT for the response. For the terms, select EDUC, JANT,
log[NONW], log[NOX], and PREC. Click on OK.

This model is the submodel suggested by backward elimination. To make
the response plot use the menu commands “Graph&Fit >Plot of”. Select
MORT for the V-box and L2:Fit-Values for the H-box. Click on OK. When
the graph appears, move the OLS slider bar to 1 to add the identity line.
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Copy the plot into Word.
To make the residual plot use the menu commands “Graph&Fit >Plot

of”. Select L2:Residuals for the V-box and L2:Fit-Values for the H-box. Click
on OK. Copy the plot into Word. Print the two plots.

e) To make an RR plot use the menu commands “Graph&Fit >Plot of”.
Select L1:Residuals for the V-box and L2:Residuals for the H-box. Click on
OK. Move the OLS slider bar to one. On the window for the plot, click on
Options. A window will appear. Type y = x and click on OK to add the
identity line. Copy the plot into Word. Print the plot.

f) To make an FF plot use the menu commands “Graph&Fit >Plot of”.
Select L1:Fit-Values for the V-box and L2:Fit-Values for the H-box. Click
on OK. Move the OLS slider bar to one and click on OK to add the identity
line. Copy the plot into Word.

g) Using the response and residual plots from the full model and submodel
along with the RR and FF plots, does the submodel seem ok?

3.18. Get the Joanne Numrich data c12.lsp from
(www.math.siu.edu/olive/regbk.htm), and save the file on a disk. Acti-
vate the c12.lsp dataset with the menu commands “File > Load > 3 1/2
Floppy(A:) > c12.lsp.” Scroll up the screen to read the data description.
This data set is described in Example 3.10.

a) A bad model uses Y1 and all 24 nontrivial predictors. There are many
indicator variables. Click on the CLA menu and select Transform. Click on
the log transformations button and select y1. Click on OK.

b) Use the menu commands “Graph&Fit > Fit linear LS”. Select log[y1]
for the response. For the terms, select x1, x2, x8, x9, x10, x11, x18, x20, x23
and x24. Click on OK.

This model will be used as the full model. To make the response plot use
the menu commands “Graph&Fit >Plot of”. Select log[y1] for the V-box
and L1:Fit-Values for the H-box. Click on OK. When the graph appears,
move the OLS slider bar to 1 to add the identity line. Copy the plot into
Word.

To make the residual plot use the menu commands “Graph&Fit >Plot
of”. Select L1:Residuals for the V-box and L1:Fit-Values for the H-box. Click
on OK. Copy the plot into Word. Print the two plots.

c) As in Problem 3.17, use forward selection, backward elimination and
plots to find a good submodel.
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Using material learned in Chapters 2–3, analyze the data sets described
in Problems 3.19–3.29. Assume that the response variable Y = t(Z) and
that the predictor variable X2, ..., Xp are functions of remaining variables
W2, ...,Wr. Unless told otherwise, the full model Y,X1, X2, ..., Xp (where
X1 ≡ 1) should use functions of every variable W2, ...,Wr (and often p = r).
(In practice, often some of the variables and some of the cases are deleted,
but we will use all variables and cases, unless told otherwise, primarily so
that the instructor has some hope of grading the problems in a reasonable
amount of time.)

Read the description of the data provided by Arc. Once you have a
good full model, perform forward selection and backward elimination. Find
the model Imin that minimizes Cp(I), find the model II with the fewest
number of predictors such that Cp(II) ≤ Cp(Imin) + 1 (it is possible that
II = Imin), and find the smallest value of k such that Cp(I) ≤ min(p, 2k).
Model II often has too many terms while the 2nd model often has too few
terms.

a) Give the output for your full model, including Y = t(Z) and R2. If it
is not obvious from the output what your full model is, then write down the
full model. Include a response plot for the full model. (This plot should be
linear). Also include a residual plot.

b) Give the output for your final submodel. If it is not obvious from the
output what your submodel is, then write down the final submodel.

c) Give between 3 and 5 plots that justify that your multiple linear re-
gression submodel is reasonable. Below or beside each plot, give a brief
explanation for how the plot gives support for your model.

3.19. For the file bodfat.lsp, described in Problem 2.2, use Z = Y =
bodyfat but do not use X1 = density as a predictor in the full model. You
may use the remaining 13 nontrivial predictor variables. Do parts a), b) and
c) above.

3.20∗. For the file boston2.lsp, described in Examples 15.6 and 15.7 use
Z = (y =) CRIM. Do parts a), b) and c) above Problem 3.19.

Note: Y = log(CRIM), X4, X8, is an interesting submodel, but more
predictors are probably needed.

3.21∗. For the file major.lsp, described in Example 2.3, use Z = Y . Do
parts a), b) and c) above Problem 3.19.

Note: there are 1 or more outliers that affect numerical methods of vari-
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able selection.
3.22. For the file marry.lsp, described below, use Z = Y . This data set

comes from Hebbler (1847). The census takers were not always willing to
count a woman’s husband if he was not at home. Do not use the predictor
X2 in the full model. Do parts a), b) and c) above Problem 3.19.

3.23∗. For the file museum.lsp, described below, use Z = Y . Do parts
a), b) and c) above Problem 3.19.

This data set consists of measurements taken on skulls at a museum and
was extracted from tables in Schaaffhausen (1878). There are at least three
groups of data: humans, chimpanzees and gorillas. The OLS fit obtained
from the humans passes right through the chimpanzees. Since Arc numbers
cases starting at 0, cases 47–59 are apes. These cases can be deleted by
highlighting the cases with small values of Y in the scatterplot matrix and
using the case deletions menu. (You may need to maximize the window
containing the scatterplot matrix in order to see this menu.)

i) Try variable selection using all of the data.
ii) Try variable selection without the apes.
If all of the cases are used, perhaps only X1, X2 and X3 should be used

in the full model. Note that
√
Y and X2 have high correlation.

3.24∗. For the file pop.lsp, described below, use Z = Y . Do parts a), b)
and c) above Problem 3.19.

This data set comes from Ashworth (1842). Try transforming all variables
to logs. Then the added variable plots show two outliers. Delete these
two cases. Notice the effect of these two outliers on the p–values for the
coefficients and on numerical methods for variable selection.

Note: then log(Y ) and log(X2) make a good submodel.

3.25∗. For the file pov.lsp, described below, use i) Z = flife and ii)
Z = gnp2 = gnp + 2. This dataset comes from Rouncefield (1995). Making
loc into a factor may be a good idea. Use the commands poverty>Make
factors and select the variable loc. For ii), try transforming to logs and
deleting the 6 cases with gnp2 = 0. (These cases had missing values for gnp.
The file povc.lsp has these cases deleted.) Try your final submodel on the
data that includes the 6 cases with gnp2 = 0. Do parts a), b) and c) above
Problem 3.19.



CHAPTER 3. BUILDING AN MLR MODEL 176

3.26∗. For the file skeleton.lsp, described below, use Z = y.
This data set is also from Schaaffhausen (1878). At one time I heard

or read a conversation between a criminal forensics expert with his date. It
went roughly like “If you wound up dead and I found your femur, I could tell
what your height was to within an inch.” Two things immediately occurred
to me. The first was “no way” and the second was that the man must not
get many dates! The files cyp.lsp and major.lsp have measurements including
height, but their R2 ≈ 0.9. The skeleton data set has at least four groups:
stillborn babies, newborns and children, older humans and apes.

a) Take logs of each variable and fit the regression on log(Y) on log(X1),
..., log(X13). Make a residual plot and highlight the case with the smallest
residual. From the Case deletions menu, select Delete selection from data
set. Go to Graph&Fit and again fit the regression on log(Y) on log(X1), ...,
log(X13) (you should only need to click on OK). The output should say that
case 37 has been deleted. Include this output for the full model in Word.

b) Do part b) above Problem 3.19.
c) Do part c) above Problem 3.19.

3.27. Activate big-mac.lsp in Arc. Assume that a multiple linear regres-
sion model holds for t(y) and some terms (functions of the predictors) where
y is BigMac = hours of labor to buy Big Mac and fries. Using techniques
you have learned in class find such a model. (Hint: Recall from Problem 3.11
that transforming all variables to logs and then using the model constant,
log(service), log(TeachSal) and log(TeachTax) was ok but the residuals did
not look good. Try adding a few terms from the minimal Cp model.)

a) Write down the full model that you use (eg a very poor full model is
exp(BigMac) = β1 + β2 exp(EngSal) + β3(TeachSal)

3 + e) and include a
response plot for the full model. (This plot should be linear). Give R2 for
the full model.

b) Write down your final model (eg a very poor final model is
exp(BigMac) = β1 + β2 exp(EngSal) + β3(TeachSal)

3 + e).

c) Include the least squares output for your model and between 3 and
5 plots that justify that your multiple linear regression model is reasonable.
Below or beside each plot, give a brief explanation for how the plot gives
support for your model.
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3.28. This is like Problem 3.27 with the BigMac data. Assume that
a multiple linear regression model holds for Y = t(Z) and for some terms
(usually powers or logs of the predictors). Using the techniques learned in
class, find such a model. Give output for the full model, output for the final
submodel and use several plots to justify your choices. These data sets, as
well as the BigMac data set, come with Arc. See Cook and Weisberg (1999a).
(INSTRUCTOR: Allow 2 hours for each part.)

file "response" Z

a) allomet.lsp BRAIN

b) casuarin.lsp W

c) evaporat.lsp Evap

d) hald.lsp Y

e) haystack.lsp Vol

f) highway.lsp rate

(from the menu Highway, select ‘‘Add a variate" and type

sigsp1 = sigs + 1. Then you can transform sigsp1.)

g) landrent.lsp Y

h) ozone.lsp ozone

i) paddle.lsp Weight

j) sniffer.lsp Y

k) water.lsp Y

i) Write down the full model that you use and include the full model
residual plot and response plot in Word. Give R2 for the full model.

ii) Write down the final submodel that you use.

iii) Include the least squares output for your model and between 3 and
5 plots that justify that your multiple linear regression model is reasonable.
Below or beside each plot, give a brief explanation for how the plot gives
support for your model.
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3.29∗. a) Activate buxton.lsp (you need to download the file onto your
disk Floppy 3 1/2 A:). From the “Graph&Fit” menu, select “Fit linear LS.”
Use height as the response variable and bigonal breadth, cephalic index, head
length and nasal height as the predictors. Include the output in Word.

b) Make a response plot (L1:Fit-Values in H and height in V) and residual
plot (L1:Fit-Values in H and L1:Residuals in V) and include both plots in
Word.

c) In the residual plot use the mouse to move the cursor just above and
to the left of the outliers. Hold the leftmost mouse button down and move
the mouse to the right and then down. This will make a box on the residual
plot that contains the outliers. Go to the “Case deletions menu” and click
on Delete selection from data set. From the “Graph&Fit” menu, select “Fit
linear LS” and fit the same model as in a) (the model should already be
entered, just click on “OK”). Include the output in Word.

d) Make a response plot (L2:Fit-Values in H and height in V) and residual
plot (L2:Fit-Values in H and L2:Residuals in V) and include both plots in
Word.

e) Explain why the outliers make the MLR relationship seem much stronger
than it actually is. (Hint: look at R2.)
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Variable Selection in SAS
3.30. Copy and paste the SAS program for this problem from

(www.math.siu.edu/olive/reghw.txt) into the SAS editor. Then perform the
menu commands “Run>Submit” to obtain about 15 pages of output. Do
not print out the output.

The key SAS code is shown below.

proc reg data=fitness;

model Oxygen=Age Weight RunTime RunPulse RestPulse MaxPulse;

output out =a p = pred r = resid;

model Oxygen=Age Weight RunTime RunPulse RestPulse MaxPulse

/ selection=forward;

model Oxygen=Age Weight RunTime RunPulse RestPulse MaxPulse

/ selection=backward;

model Oxygen=Age Weight RunTime RunPulse RestPulse MaxPulse

/ selection=cp best = 10;

proc rsquare cp data = fitness;

model Oxygen=Age Weight RunTime RunPulse RestPulse MaxPulse;

proc plot data = a;

plot resid*(pred);

plot Oxygen*pred;

proc reg data=fitness;

model Oxygen=Age RunTime RunPulse MaxPulse;

output out =sub p = pred r = resid;

proc plot data = sub;

plot resid*(pred);

plot Oxygen*pred;

run;

The data is from SAS Institute (1985, p. 695-704, 717-718). Aerobic
fitness is being measured by the ability to consume oxygen. The response
Y = Oxygen (uptake rate) is expensive to measure, and it is hoped that
the OLS Ŷ can be used instead. The variables are Age in years, Weight in
kg, RunTime = time in minutes to run 1.5 miles, RunPulse = heart rate
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when Y is measured, RestPulse = heart rate while running and MaxPulse =
maximum heart rate recorded while running.

The selection commands do forward selection, backward elimination and
all subset selection where the best ten models with the lowest Cp are recorded.
The proc rsquare command also does all subsets regression with the Cp cri-
terion.

The plots give the response and residual plots for the full model and the
submodel that used Age, RunTime, RunPulse, MaxPulse and a constant.

a) Was the above plot for the minimum Cp model?
b) Do the plots suggest that the submodel was good?

Variable Selection in Minitab
3.31. Get the data set prof.mtb as described in Problem 2.15. The data is

described in McKenzie and Goldman (1999, p. ED-22-ED-23). Assign the re-
sponse variable to be instrucr (the instructor rating from course evaluations)
and the predictors to be interest in the course, manner of the instructor, and
course = rating of the course.

a) To get residual and response plots you need to store the residuals
and fitted values. Use the menu commands “Stat>Regression>Regression”
to get the regression window. Put instrucr in the Response and interest,
manner and course in the Predictors boxes. The click on Storage. From
the resulting window click on Fits and Residuals. Then click on OK twice.

b) To get a response plot, use the commands “Graph>Plot,” (double
click) place instrucr in the Y box, and Fits1 in the X box. Then click on
OK. Print the plot by clicking on the graph and then clicking on the printer
icon.

c) To make a residual plot, use the menu commands “Graph>Plot” to
get a window. Place “Resi1” in the Y box and “Fits1” in the X box. Then
click on OK. Print the plot by clicking on the graph and then clicking on
the printer icon.

d) To perform all subsets regression, use the menu commands
“Stat>Regression>Best Subsets” to get the regression window. Put instrucr
in the Response and interest, manner and course in the Free predictors
boxes. Which submodel is good?



Chapter 4

WLS and Generalized Least
Squares

4.1 Random Vectors

The concepts of a random vector, the expected value of a random vector and
the covariance of a random vector are needed before covering generalized least
squares. Recall that for random variables Yi and Yj , the covariance of Yi and
Yj is Cov(Yi, Yj) ≡ σi,j = E[(Yi−E(Yi))(Yj −E(Yj)] = E(YiYj)−E(Yi)E(Yj)
provided the second moments of Yi and Yj exist.

Definition 4.1. Y = (Y1, ..., Yn)
T is an n × 1 random vector if Yi is

a random variable for i = 1, ..., n. Y is a discrete random vector if each Yi

is discrete and Y is a continuous random vector if each Yi is continuous. A
random variable Y1 is the special case of a random vector with n = 1.

Definition 4.2. The population mean of a random n × 1 vector Y =
(Y1, ..., Yn)

T is
E(Y ) = (E(Y1), ..., E(Yn))

T

provided that E(Yi) exists for i = 1, ..., n. Otherwise the expected value does
not exist. The n× n population covariance matrix

Cov(Y ) = E[(Y − E(Y ))(Y − E(Y ))T ] = ((σi,j))

where the ij entry of Cov(Y ) is Cov(Yi, Yj) = σi,j provided that each σi,j

exists. Otherwise Cov(Y ) does not exist.

181
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The covariance matrix is also called the variance–covariance matrix and
variance matrix. Sometimes the notation Var(Y ) is used. Note that Cov(Y )
is a symmetric positive semidefinite matrix. If Z and Y are n × 1 random
vectors, a a conformable constant vector and A and B are conformable
constant matrices, then

E(a + Y ) = a + E(Y ) and E(Y + Z) = E(Y ) + E(Z) (4.1)

and
E(AY ) = AE(Y ) and E(AY B) = AE(Y )B. (4.2)

Also
Cov(a + AY ) = Cov(AY ) = ACov(Y )AT . (4.3)

Example 4.1. Consider the OLS model Y = Xβ + e where the ei are
iid with mean 0 and variance σ2. Then Y and e are random vectors while
a = Xβ is a constant vector. Notice that E(e) = 0. Thus

E(Y ) = Xβ + E(e) = Xβ.

Since the ei are iid,
Cov(Y ) = Cov(e) = σ2In (4.4)

where In is the n × n identity matrix. This result makes sense because the
Yi are independent with Yi = xT

i β + ei. Hence VAR(Yi) = VAR(ei) = σ2.
Recall that β̂OLS = (XT X)−1XTY . Hence

E(β̂OLS) = (XT X)−1XTE(Y ) = (XT X)−1XT Xβ = β.

That is, β̂OLS is an unbiased estimator of β. Using (4.3) and (4.4),

Cov(β̂OLS) = (XT X)−1XT Cov(Y )X(XTX)−1

= σ2(XTX)−1XTX(XT X)−1 = σ2(XTX)−1.

Recall that Ŷ OLS = Xβ̂OLS = X(XT X)−1XT Y = HY . Hence

E(Ŷ OLS) = X(XT X)−1XTE(Y ) = X(XT X)−1XT Xβ = Xβ = E(Y ).

Using (4.3) and (4.4),

Cov(Ŷ OLS) = HCov(Y )HT = σ2H
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since HT = H and HH = H .
Recall that the vector of residuals rOLS = (I−H)Y = Y − Ŷ OLS. Hence

E(rOLS) = E(Y ) − E(Ŷ OLS) = E(Y ) − E(Y ) = 0. Using (4.3) and (4.4),

Cov(r̂OLS) = (I − H)Cov(Y )(I − H)T = σ2(I − H)

since I − H is symmetric and idempotent: (I − H)T = I − H and (I −
H)(I − H) = I − H .

4.2 GLS, WLS and FGLS

Definition 4.3. Suppose that the response variable and at least one of the
predictor variables is quantitative. Then the generalized least squares (GLS)
model is

Y = Xβ + e, (4.5)

where Y is an n × 1 vector of dependent variables, X is an n × p matrix
of predictors, β is a p× 1 vector of unknown coefficients, and e is an n × 1
vector of unknown errors. Also E(e) = 0 and Cov(e) = σ2V where V is a
known n × n positive definite matrix.

Definition 4.4. The GLS estimator

β̂GLS = (XTV −1X)−1XT V −1Y . (4.6)

The fitted values are Ŷ GLS = Xβ̂GLS .

Definition 4.5. Suppose that the response variable and at least one
of the predictor variables is quantitative. Then the weighted least squares
(WLS) model with weights w1, ..., wn is the special case of the GLS model
where V is diagonal: V = diag(v1, ..., vn) and wi = 1/vi. Hence

Y = Xβ + e, (4.7)

E(e) = 0 and Cov(e) = σ2diag(v1, ..., vn) = σ2diag(1/w1, ..., 1/wn).

Definition 4.6. The WLS estimator

β̂WLS = (XT V −1X)−1XT V −1Y . (4.8)

The fitted values are Ŷ WLS = Xβ̂WLS.
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Definition 4.7. The feasible generalized least squares (FGLS) model is
the same as the GLS estimator except that V = V (θ) is a function of an
unknown q×1 vector of parameters θ. Let the estimator of V be V̂ = V (θ̂).
Then the FGLS estimator

β̂FGLS = (XT V̂
−1

X)−1XT V̂
−1

Y . (4.9)

The fitted values are Ŷ FGLS = Xβ̂FGLS . The feasible weighted least squares
(FWLS) estimator is the special case of the FGLS estimator where V =
V (θ) is diagonal. Hence the estimated weights ŵi = 1/v̂i = 1/vi(θ̂). The
FWLS estimator and fitted values will be denoted by β̂FWLS and Ŷ FWLS ,
respectively.

Notice that the ordinary least squares (OLS) model is a special case of
GLS with V = In, the n× n identity matrix. It can be shown that the GLS
estimator minimizes the GLS criterion

QGLS(η) = (Y − Xη)T V −1(Y − Xη).

Notice that the FGLS and FWLS estimators have p+ q+1 unknown param-
eters. These estimators can perform very poorly if n < 10(p + q + 1).

The GLS and WLS estimators can be found from the OLS regression
(without an intercept) of a transformed model. Typically there will be a
constant in the model: the first column of X is a vector of ones. Following
Seber and Lee (2003, p. 66-68), there is a nonsingular n× n matrix K such
that V = KKT . Let Z = K−1Y , U = K−1X and ε = K−1e. This method
uses the Cholesky decomposition and is numerically unstable.

Proposition 4.1 a)
Z = Uβ + ε (4.10)

follows the OLS model since E(ε) = 0 and Var(ε) = σ2In.

b) The GLS estimator β̂GLS can be obtained from the OLS regression
(without an intercept) of Z on U .

c) For WLS, Yi = xT
i β + ei. The corresponding OLS model Z = Uβ + ε

is equivalent to Zi = uT
i β + εi for i = 1, ..., n where uT

i is the ith row of U .
Then Zi =

√
wi Yi and ui =

√
wi xi. Hence β̂WLS can be obtained from the

OLS regression (without an intercept) of Zi =
√
wi Yi on ui =

√
wi xi.

Proof. a) E(ε) = K−1E(e) = 0 and

Cov(ε) = K−1Cov(e)(K−1)T = σ2K−1V (K−1)T
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= σ2K−1KKT (K−1)T = σ2In.

Notice that OLS without an intercept needs to be used since U does not
contain a vector of ones. The first column of U is K−11 �= 1.

b) Let β̂ZU denote the OLS estimator obtained by regressing Z on U .
Then

β̂ZU = (UT U)−1UT Z = (XT (K−1)TK−1X)−1XT (K−1)TK−1Y

and the result follows since V −1 = (KKT )−1 = (KT )−1K−1 = (K−1)TK−1.

c) The result follows from b) if Zi =
√
wi Yi and ui =

√
wi xi. But for

WLS, V = diag(v1, ..., vn) and hence K = KT = diag(
√

v1, ...,
√

vn). Hence

K−1 = diag(1/
√

v1, ..., 1/
√

vn) = diag(
√

w1, ...,
√

wn)

and Z = K−1Y has ith element Zi =
√
wi Yi. Similarly, U = K−1X has

ith row uT
i =

√
wi xT

i . QED

Following Johnson and Wichern (1988, p. 51) and Freedman (2005, p.
54), there is a symmetric, nonsingular n × n matrix R such that V = RR.
Let Z = R−1Y , U = R−1X and ε = R−1e. This method uses the spec-
tral theorem (singular value decomposition) and has better computational
properties than transformation based on the Cholesky decomposition.

Proposition 4.2 a)
Z = Uβ + ε (4.11)

follows the OLS model since E(ε) = 0 and Var(ε) = σ2In.

b) The GLS estimator β̂GLS can be obtained from the OLS regression
(without an intercept) of Z on U .

c) For WLS, Yi = xT
i β + ei. The corresponding OLS model Z = Uβ + ε

is equivalent to Zi = uT
i β + εi for i = 1, ..., n where uT

i is the ith row of U .
Then Zi =

√
wi Yi and ui =

√
wi xi. Hence β̂WLS can be obtained from the

OLS regression (without an intercept) of Zi =
√
wi Yi on ui =

√
wi xi.

Proof. a) E(ε) = R−1E(e) = 0 and

Cov(ε) = R−1Cov(e)(R−1)T = σ2R−1V (R−1)T

= σ2R−1RR(R−1) = σ2In.
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Notice that OLS without an intercept needs to be used since U does not
contain a vector of ones. The first column of U is R−11 �= 1.

b) Let β̂ZU denote the OLS estimator obtained by regressing Z on U .
Then

β̂ZU = (UTU )−1UT Z = (XT (R−1)TR−1X)−1XT (R−1)TR−1Y

and the result follows since V −1 = (RR)−1 = R−1R−1 = (R−1)T R−1.

c) The result follows from b) if Zi =
√
wi Yi and ui =

√
wi xi. But for

WLS, V = diag(v1, ..., vn) and hence R = diag(
√

v1, ...,
√

vn). Hence

R−1 = diag(1/
√

v1, ..., 1/
√

vn) = diag(
√

w1, ...,
√

wn)

and Z = R−1Y has ith element Zi =
√
wi Yi. Similarly, U = R−1X has ith

row uT
i =

√
wi xT

i . QED

Remark 4.1. Standard software produces WLS output and the ANOVA
F test and Wald t tests are performed using this output.

Remark 4.2. The FGLS estimator can also be found from the OLS re-
gression (without an intercept) of Z on U where V (θ̂) = RR. Similarly the
FWLS estimator can be found from the OLS regression (without an inter-
cept) of Zi =

√
ŵiYi on ui =

√
ŵixi. But now U is a random matrix instead

of a constant matrix. Hence these estimators are highly nonlinear. OLS
output can be used for exploratory purposes, but the p–values are generally
not correct.

Under regularity conditions, the OLS estimator β̂OLS is a consistent es-
timator of β when the GLS model holds, but β̂GLS should be used because
it generally has higher efficiency.

Definition 4.8. Let β̂ZU be the OLS estimator from regressing Z on
U . The vector of fitted values is Ẑ = Uβ̂ZU and the vector of residuals
is rZU = Z − Ẑ. Then β̂ZU = β̂GLS for GLS, β̂ZU = β̂FGLS for FGLS,
β̂ZU = β̂WLS for WLS and β̂ZU = β̂FWLS for FWLS. For GLS, FGLS, WLS
and FWLS, a residual plot is a plot of Ẑi versus rZU,i and a response plot is

a plot of Ẑi versus Zi.

Notice that the residual and response plots are based on the OLS output
from the OLS regression without intercept of Z on U . If the model is good,
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Figure 4.1: Plots for Draper and Smith Data

then the plotted points in the response plot should follow the identity line
in an evenly populated band while the plotted points in the residual plot
should follow the line rZU,i = 0 in an evenly populated band (at least if the
distribution of ε is not highly skewed).

Plots based on ŶGLS = Xβ̂ZU and on ri,GLS = Yi − Ŷi,GLS should be

similar to those based on β̂OLS. Although the plot of Ŷi,GLS versus Yi should
be linear, the plotted points will not scatter about the identity line in an
evenly populated band. Hence this plot can not be used to check whether
the GLS model with V is a good approximation to the data. Moreover, the
ri,GLS and Ŷi,GLS may be correlated and usually do not scatter about the
r = 0 line in an evenly populated band. The plots in Definition 4.8 are both
a check on linearity and on whether the model using V (or V̂ ) gives a good
approximation of the data, provided that n > k(p + q + 1) where k ≥ 5 and
preferably k ≥ 10.

For GLS and WLS (and for exploratory purposes for FGLS and FWLS),
plots and model building and variable selection should be based on Z and
U . Form Z and U and then use OLS software for model selection and
variable selection. If the columns of X are x1, ...,xp, then the columns of
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U are U1, ..., Up where Uj = R−1xj corresponds to the jth predictor xj. For
example, the analog of the OLS residual plot of jth predictor versus the
residuals is the plot of the jth predictor Uj versus rZU . The notation is
confusing but the idea is simple: form Z and U , then use OLS software and
the OLS techniques from Chapters 2 and 3 to build the model.

Example 4.2. Draper and Smith (1981, p. 112-114) presents a FWLS
example with n = 35 and p = 2. Hence Y = β1 + β2x+ e. Let v̂i = vi(θ̂) =
1.5329 − 0.7334xi + 0.0883x2

i . Thus θ̂ = (1.5329,−0.7334, 0.0883)T . Figure
4.1a and b show the response and residual plots based on the OLS regression
of Y on x. The residual plot has the shape of the right opening megaphone,
suggesting that the variance is not constant. Figure 4.1c and d show the
response and residual plots based on FWLS with weights ŵi = 1/v̂i. See
Problem 4.2 to reproduce these plots. Software meant for WLS needs the
weights. Hence FWLS can be computed using WLS software with the es-
timated weights, but the software may print WLS instead of FWLS, as in
Figure 4.1c and d.

Warning. A problem with the response and residual plots for GLS and
FGLS given in Definition 4.8 is that some of the transformed cases (Zi,u

T
i )T

can be outliers or high leverage points.

Remark 4.3. If the response Yi is the sample mean or sample median of
ni cases where the ni are not all equal, then use WLS with weights wi = ni.
See Sheather (2009, p. 121).

4.3 Inference for GLS

Inference for the GLS model Y = Xβ + e can be performed by using the
partial F test for the equivalent no intercept OLS model Z = Uβ + ε.
Following Section 2.10, create Z and U , fit the full and reduced model using
the “no intercept” or “intercept = F” option.

The 4 step partial F test of hypotheses: i) State the hypotheses Ho:
the reduced model is good Ha: use the full model
ii) Find the test statistic FR =[

SSE(R) − SSE(F )

dfR − dfF

]
/MSE(F )
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iii) Find the p–value = P(FdfR−dfF ,dfF
> FR). (On exams often an F table

is used. Here dfR − dfF = p − q = number of parameters set to 0, and
dfF = n− p.)
iv) State whether you reject Ho or fail to reject Ho. Reject Ho if the p–value
< δ and conclude that the full model should be used. Otherwise, fail to reject
Ho and conclude that the reduced model is good.

Assume that the GLS model contains a constant β1. The GLS ANOVA
F test of Ho : β2 = · · · = βp versus Ha: not Ho uses the reduced model that
contains the first column of U . The GLS ANOVA F test of Ho : βi = 0
versus Ho : βi �= 0 uses the reduced model with the ith column of U deleted.
For the special case of WLS, the software will often have a weights option
that will also give correct output for inference.

Example 4.3. Suppose that the data from Example 4.2 has valid weights,
so that WLS can be used instead of FWLS. The R/Splus commands below
perform WLS.

> ls.print(lsfit(dsx,dsy,wt=dsw))

Residual Standard Error=1.137

R-Square=0.9209

F-statistic (df=1, 33)=384.4139

p-value=0

Estimate Std.Err t-value Pr(>|t|)

Intercept -0.8891 0.3004 -2.9602 0.0057

X 1.1648 0.0594 19.6065 0.0000

Alternative R/Splus commands given below produce similar output.

zout<-lm(dsy~dsx,weights=dsw)

summary(zout)

anova(zout)

zoutr<-lm(dsy~1,weights=dsw)

anova(zoutr,zout)

The F statistic 384.4139 tests Ho : β2 = 0 since weights were used. The
WLS ANOVA F test for Ho : β2 = 0 can also be found with the no intercept
model by adding a column of ones to x, form U and Z and compute the
partial F test where the reduced model uses the first column of U . Notice
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that the “intercept=F” option needs to be used to fit both models. The
residual standard error = RSE =

√
MSE. Thus SSE = (n − k)(RSE)2

where n − k is the denominator degrees of freedom for the F test and k
is the numerator degrees of freedom = number of variables in the model.
The column of ones xone is counted as a variable. The last line of output
computes the partial F statistic and is again ≈ 384.4.

> xone <- 1 + 0*1:35

> x <- cbind(xone,dsx)

> z <- as.vector(diag(sqrt(dsw))%*%dsy)

> u <- diag(sqrt(dsw))%*%x

> ls.print(lsfit(u,z,intercept=F))

Residual Standard Error=1.137

R-Square=0.9817

F-statistic (df=2, 33)=886.4982

p-value=0

Estimate Std.Err t-value Pr(>|t|)

xone -0.8891 0.3004 -2.9602 0.0057

dsx 1.1648 0.0594 19.6065 0.0000

> ls.print(lsfit(u[,1],z,intercept=F))

Residual Standard Error=3.9838

R-Square=0.7689

F-statistic (df=1, 34)=113.1055

p-value=0

Estimate Std.Err t-value Pr(>|t|)

X 4.5024 0.4234 10.6351 0

> ((34*(3.9838)^2-33*(1.137)^2)/1)/(1.137)^2

[1] 384.4006

The WLS t-test for this data has t = 19.6065 which corresponds to F =
t2 = 384.4 since this test is equivalent to the WLS ANOVA F test when there
is only one predictor. The WLS t-test for the intercept has F = t2 = 8.76.
This test statistic can be found from the no intercept OLS model by leaving
the first column of Uout of the model, then perform the partial F test as
shown below.
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> ls.print(lsfit(u[,2],z,intercept=F))

Residual Standard Error=1.2601

F-statistic (df=1, 34)=1436.300

Estimate Std.Err t-value Pr(>|t|)

X 1.0038 0.0265 37.8985 0

> ((34*(1.2601)^2-33*(1.137)^2)/1)/(1.137)^2

[1] 8.760723

4.4 Complements

The theory for GLS and WLS is similar to the theory for the OLS MLR
model, but the theory for FGLS and FWLS is often lacking or huge sample
sizes are needed. However, FGLS and FWLS are often used in practice
because usually V is not known and V̂ must be used instead. Kariya and
Kurata (2004) is a PhD level text covering FGLS.

Shi and Chen (2009) describe numerical diagnostics for GLS. Long and
Ervin (2000) discuss methods for obtaining standard errors when the constant
variance assumption is violated.

Following Sheather (2009, ch. 9, ch. 10) many linear models with serially
correlated errors (eg AR(1) errors) and many linear mixed models can be fit
with FGLS. Both Sheather (2009) and Houseman, Ryan and Coull (2004)
use the Cholesky decomposition and make the residual plots based on the
Cholesky residuals Z − Ẑ where V (θ̂) = KKT . Plots should be based on
Z−Ẑ where V (θ̂) = RR. In other words, use transformation corresponding
to Proposition 4.2 instead of the transformation corresponding to Proposition
4.1.

4.5 Problems

Problems with an asterisk * are especially important.

R/Splus Problems

Use the command source(“A:/regpack.txt”) to download the func-
tions and the command source(“A:/regdata.txt”) to download the data.
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See Preface or Section 17.1. Typing the name of the regpack function,
eg wlsplot, will display the code for the function. Use the args command, eg
args(wlsplot), to display the needed arguments for the function.

4.1. Generalized and weighted least squares are each equivalent to a least
squares regression without intercept. Let V = diag(1, 1/2, 1/3, ..., 1/9) =
diag(1/wi) where n = 9 and the weights wi = i for i = 1, ..., 9. Let xT =
(1, x1, x2, x3). Then the weighted least squares with weight vector wT =
(1, 2, ..., 9) should be equivalent to the OLS regression of

√
wi Yi = Zi on

u where uT =
√
wix = (

√
wi,

√
wix1,

√
wix2,

√
wix3). There is no intercept

because the vector of ones has been replaced by a vector of the
√
wi’s. Type

the following commands in R/Splus and include the output from both lsfit
commands. The coefficients from both lsfit commands should be the same.
The commands can also be copied and pasted from
(www.math.siu.edu/olive/reghw.txt).

e <- rnorm(9)

x <- matrix(rnorm(27),nrow=9,ncol=3)

sqrtv <- sqrt(diag(1/1:9))

Y <- 4 + x%*%c(1,2,3) + sqrtv%*%e

wtt <- 1:9

lsfit(x,Y,wtt)$coef

kinv <- sqrt(diag(1:9))

Z <- kinv%*%Y

X <- 1 + 0*1:9

X <- cbind(X,x)

U <- kinv%*%X

lsfit(U,Z,int=F)$coef

4.2. Download the wlsplot function and the Draper and Smith (1981)
data dsx, dsy, dsw.

a) Enter the R/Splus command wlsplot(x=dsx, y = dsy, w = dsw)
to reproduce Figure 4.1. Once you have the plot you can print it out directly,
but it will generally save paper by placing the plots in the Word editor.

b) Activate Word (often by double clicking on a Word icon). Click on the
screen and type “Problem 4.2.” In R/Splus, click on the plot and then press
the keys Ctrl and c simultaneously. This procedure makes a temporary copy
of the plot. In Word, move the pointer to Edit and hold down the leftmost
mouse button. This will cause a menu to appear. Drag the pointer down to
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Paste. In the future, these menu commands will be denoted by “Edit>Paste.”
The plot should appear on the screen. To save your output on your diskette,
use the Word menu commands “File > Save as.” In the Save in box select
“3 1/2 Floppy(A:)” and in the File name box enter HW4d2.doc. To exit
from Word, click on the “X” in the upper right corner of the screen. In Word
a screen will appear and ask whether you want to save changes made in your
document. Click on No. To exit from R/Splus, type “q()” or click on the
“X” in the upper right corner of the screen and then click on No.

4.3. Download the fwlssim function. This creates WLS data if “type”
is 1 or 3 and FWLS data if “type” is 2 or 4. Let the sufficient predictor
SP = 25 + 2x2 + · · ·+ 2xp. Then Y = SP + |SP − 25k|σe where the xij and
ei are iid N(0, 1). Thus Y |SP ∼ N(SP, (SP − 25k)2σ2). If “type” is 1 or 2
then k = 1/5, but k = 1 if “type” is 3 or 4. The default has σ2 = 1.

The function creates the OLS response and residual plots and the FWLS
(or WLS) response and residual plots.

a) Type the following command several times. The OLS and WLS plots
tend to look the same.

fwlssim(type=1)

b) Type the following command several times. Now the FWLS plots often
have outliers.

fwlssim(type=2)

c) Type the following command several times. The OLS residual plots
have a saddle shape, but the WLS plots tend to have highly skewed fitted
values.

fwlssim(type=3)

d) Type the following command several times. The OLS residual plots
have a saddle shape, but the FWLS plots tend to have outliers and highly
skewed fitted values.

fwlssim(type=4)



Chapter 5

One Way ANOVA

5.1 Introduction

Definition 5.1. Models in which the response variable Y is quantitative,
but all of the predictor variables are qualitative are called analysis of vari-
ance (ANOVA) models, experimental design models or design of experiments
(DOE) models. Each combination of the levels of the predictors gives a dif-
ferent distribution for Y . A predictor variable W is often called a factor and
a factor level ai is one of the categories W can take.

Definition 5.2. A lurking variable is not one of the variables in the
study, but may affect the relationships among the variables in the study.
A unit is the experimental material assigned treatments, which are the
conditions the investigator wants to study. The unit is experimental if it was
randomly assigned to a treatment, and the unit is observational if it was not
randomly assigned to a treatment.

Definition 5.3. In an experiment, the investigators use randomiza-
tion to assign treatments to units. To assign p treatments to n = n1+· · ·+np

experimental units, draw a random permutation of {1, ..., n}. Assign the first
n1 units treatment 1, the next n2 units treatment 2, ..., and the final np units
treatment p.

Randomization allows one to do valid inference such as F tests of hypothe-
ses and confidence intervals. Randomization also washes out the effects of
lurking variables and makes the p treatment groups similar except for the
treatment. The effects of lurking variables are present in observational stud-

194
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ies defined in Definition 5.4.

Definition 5.4. In an observational study, investigators simply ob-
serve the response, and the treatment groups need to be p random samples
from p populations (the levels) for valid inference.

Example 5.1. Consider using randomization to assign the following nine
people (units) to three treatment groups.

Carroll, Collin, Crawford, Halverson, Lawes,
Stach, Wayman, Wenslow, Xumong

Balanced designs have the group sizes the same: ni ≡ m = n/p. Label
the units alphabetically so Carroll gets 1, ..., Xumong gets 9. The R/Splus
function sample can be used to draw a random permutation. Then the first
3 numbers in the permutation correspond to group 1, the next 3 to group 2
and the final 3 to group 3. Using the output shown below, gives the following
3 groups.

group 1: Stach, Wayman, Xumong
group 2: Lawes, Carroll, Halverson
group 3: Collin, Wenslow, Crawford

> sample(9)

[1] 6 7 9 5 1 4 2 8 3

Often there is a table or computer file of units and related measurements,
and it is desired to add the unit’s group to the end of the table. The regpack
function rand reports a random permutation and the quantity groups[i] =
treatment group for the ith person on the list. Since persons 6, 7 and 9 are in
group 1, groups[7] = 1. Since Carroll is person 1 and is in group 2, groups[1]
= 2, et cetera.

> rand(9,3)

$perm

[1] 6 7 9 5 1 4 2 8 3

$groups

[1] 2 3 3 2 2 1 1 3 1



CHAPTER 5. ONE WAY ANOVA 196

Definition 5.5. Replication means that for each treatment, the ni

response variables Yi,1, ..., Yi,ni are approximately iid random variables.

Example 5.2. a) If ten students work two types of paper mazes three
times each, then there are 60 measurements that are not replicates. Each
student should work the six mazes in random order since speed increases
with practice. For the ith student, let Zi1 be the average time to complete
the three mazes of type 1, let Zi2 be the average time for mazes of type 2
and let Di = Zi1 − Zi2. Then D1, ..., D10 are replicates.

b) Cobb (1998, p. 126) states that a student wanted to know if the shapes
of sponge cells depends on the color (green or white). He measured hundreds
of cells from one white sponge and hundreds of cells from one green sponge.
There were only two units so n1 = 1 and n2 = 1. The student should have
used a sample of n1 green sponges and a sample of n2 white sponges to get
more replicates.

c) Replication depends on the goals of the study. Box, Hunter and Hunter
(2005, p. 215-219) describes an experiment where the investigator times how
long it takes him to bike up a hill. Since the investigator is only interested in
his performance, each run up a hill is a replicate (the time for the ith run is a
sample from all possible runs up the hill by the investigator). If the interest
had been on the effect of eight treatment levels on student bicyclists, then
replication would need n = n1 + · · · + n8 student volunteers where ni ride
their bike up the hill under the conditions of treatment i.

5.2 Fixed Effects One Way ANOVA

Definition 5.6. Let fZ(z) be the pdf of Z. Then the family of pdfs fY (y) =
fZ(y−µ) indexed by the location parameter µ, −∞ < µ <∞, is the location
family for the random variable Y = µ+ Z with standard pdf fZ(z).

Definition 5.7. A one way fixed effects ANOVA model has a single
qualitative predictor variable W with p categories a1, ..., ap. There are p
different distributions for Y , one for each category ai. The distribution of

Y |(W = ai) ∼ fZ(y − µi)

where the location family has second moments. Hence all p distributions
come from the same location family with different location parameter µi and
the same variance σ2.



CHAPTER 5. ONE WAY ANOVA 197

Definition 5.8. The one way fixed effects normal ANOVA model is the
special case where

Y |(W = ai) ∼ N(µi, σ
2).

Example 5.3. The pooled 2 sample t–test is a special case of a one
way ANOVA model with p = 2. For example, one population could be ACT
scores for men and the second population ACT scores for women. Then W =
gender and Y = score.

Notation. It is convenient to relabel the response variable Y1, ..., Yn as
the vector Y = (Y11, ..., Y1,n1, Y21, ..., Y2,n2, ..., Yp1, ..., Yp,np)

T where the Yij are
independent and Yi1, ..., Yi,ni are iid. Here j = 1, ..., ni where ni is the number
of cases from the ith level where i = 1, ..., p. Thus n1+· · ·+np = n. Similarly
use double subscripts on the errors. Then there will be many equivalent
parameterizations of the one way fixed effects ANOVA model.

Definition 5.9. The cell means model is the parameterization of the one
way fixed effects ANOVA model such that

Yij = µi + eij

where Yij is the value of the response variable for the jth trial of the ith
factor level. The µi are the unknown means and E(Yij) = µi. The eij are
iid from the location family with pdf fZ(z) and unknown variance σ2 =
VAR(Yij) = VAR(eij). For the normal cell means model, the eij are iid
N(0, σ2) for i = 1, ..., p and j = 1, ..., ni.

The cell means model is a linear model (without intercept) of the form
Y = Xcβc + e =

Y11
...

Y1,n1

Y21
...

Y2,n2

...
Yp,1
...

Yp,np



=



1 0 0 . . . 0
...

...
...

...
1 0 0 . . . 0
0 1 0 . . . 0
...

...
...

...
0 1 0 . . . 0
...

...
...

...
0 0 0 . . . 1
...

...
...

...
0 0 0 . . . 1




µ1

µ2
...
µp

 +



e11
...

e1,n1

e21
...

e2,n2

...
ep,1
...

ep,np



. (5.1)
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Notation. Let Yi0 =
∑ni

j=1 Yij and let

µ̂i = Y i0 = Yi0/ni =
1

ni

ni∑
j=1

Yij. (5.2)

Hence the “dot notation” means sum over the subscript corresponding to the
0, eg j. Similarly, Y00 =

∑p
i=1

∑ni

j=1 Yij is the sum of all of the Yij.

Notice that the indicator variables used in the cell means model (5.1) are
xk

h = 1 if the hth case has W = ak, and xk
h = 0, otherwise, for k = 1, ..., p

and h = 1, ..., n. So Yij has xk
h = 1 only if i = k and j = 1, ..., ni. Here xk is

the kth column of Xc. The model can use p indicator variables for the factor
instead of p − 1 indicator variables because the model does not contain an
intercept. Also notice that

E(Y ) = Xcβc = (µ1, ..., µ1, µ2, ..., µ2, ..., µp, ..., µp)
T ,

(XT
c Xc) = diag(n1, ..., np) and XT

c Y = (Y10, ..., Y10, Y20, ..., Y20, ..., Yp0, ..., Yp0)
T .

Hence (XT
c Xc)

−1 = diag(1/n1, ..., 1/np) and the OLS estimator

β̂c = (XT
c Xc)

−1XT
c Y = (Y 10, ..., Y p0)

T = (µ̂1, ..., µ̂p)
T .

Thus Ŷ = Xcβ̂c = (Y 10, ..., Y 10, ..., Y p0, ..., Y p0)
T . Hence the ijth fitted value

is
Ŷij = Y i0 = µ̂i (5.3)

and the ijth residual is

rij = Yij − Ŷij = Yij − µ̂i. (5.4)

Since the cell means model is a linear model, there is an associated re-
sponse plot and residual plot. However, many of the interpretations of the
OLS quantities for ANOVA models differ from the interpretations for MLR
models. First, for MLR models, the conditional distribution Y |x makes sense
even if x is not one of the observed xi provided that x is not far from the xi.
This fact makes MLR very powerful. For MLR, at least one of the variables
in x is a continuous predictor. For the one way fixed effects ANOVA model,
the p distributions Y |xi make sense where xT

i is a row of Xc.
Also, the OLS MLR ANOVA F test for the cell means model tests H0 :

β = 0 ≡ H0 : µ1 = · · · = µp = 0, while the one way fixed effects ANOVA F
test given after Definition 5.13 tests H0 : µ1 = · · · = µp.



CHAPTER 5. ONE WAY ANOVA 199

Definition 5.10. Consider the one way fixed effects ANOVA model. The
response plot is a plot of Ŷij ≡ µ̂i versus Yij and the residual plot is a plot of

Ŷij ≡ µ̂i versus rij .

The points in the response plot scatter about the identity line and the
points in the residual plot scatter about the r = 0 line, but the scatter need
not be in an evenly populated band. A dot plot of Z1, ..., Zm consists of an
axis and m points each corresponding to the value of Zi. The response plot
consists of p dot plots, one for each value of µ̂i. The dot plot corresponding
to µ̂i is the dot plot of Yi1, ..., Yi,ni. The p dot plots should have roughly the
same amount of spread, and each µ̂i corresponds to level ai. If a new level
af corresponding to xf was of interest, hopefully the points in the response
plot corresponding to af would form a dot plot at µ̂f similar in spread to
the other dot plots, but it may not be possible to predict the value of µ̂f .
Similarly, the residual plot consists of p dot plots, and the plot corresponding
to µ̂i is the dot plot of ri1, ..., ri,ni.

Assume that each ni ≥ 10. Under the assumption that the Yij are from
the same location scale family with different parameters µi, each of the p
dot plots should have roughly the same shape and spread. This assumption
is easier to judge with the residual plot. If the response plot looks like the
residual plot, then a horizontal line fits the p dot plots about as well as the
identity line, and there is not much difference in the µi. If the identity line is
clearly superior to any horizontal line, then at least some of the means differ.

Definition 5.11. An outlier corresponds to a case that is far from the
bulk of the data. Look for a large vertical distance of the plotted point from
the identity line or the r = 0 line.

Rule of thumb 5.1. Mentally add 2 lines parallel to the identity line
and 2 lines parallel to the r = 0 line that cover most of the cases. Then a
case is an outlier if it is well beyond these 2 lines.

This rule often fails for large outliers since often the identity line goes
through or near a large outlier so its residual is near zero. A response that is
far from the bulk of the data in the response plot is a “large outlier” (large
in magnitude). Look for a large gap between the bulk of the data and the
large outlier.

Suppose there is a dot plot of nj cases corresponding to level aj that is
far from the bulk of the data. This dot plot is probably not a cluster of “bad
outliers” if nj ≥ 4 and n ≤ 50. If nj = 1, such a case may be a large outlier.



CHAPTER 5. ONE WAY ANOVA 200

Rule of thumb 5.2. Often an outlier is very good, but more often an
outlier is due to a measurement error and is very bad.

The assumption of the Yij coming from the same location scale family
with different location parameters µi and the same constant variance σ2

is a big assumption and often does not hold. Another way to check this
assumption is to make a box plot of the Yij for each i. The box in the box
plot corresponds to the lower, middle and upper quartiles of the Yij . The
middle quartile is just the sample median of the data mij: at least half of the
Yij ≥ mij and at least half of the Yij ≤ mij. The p boxes should be roughly
the same length and the median should occur in roughly the same position
(eg in the center of each box). The “whiskers” in each plot should also be
roughly similar. Histograms for each of the p samples could also be made.
All of the histograms should look similar in shape.

Example 5.4. Kuehl (1994, p. 128) gives data for counts of hermit crabs
on 25 different transects in each of six different coastline habitats. Let Z be
the count. Then the response variable Y = log10(Z + 1/6). Although the
counts Z varied greatly, each habitat had several counts of 0 and often there
were several counts of 1, 2 or 3. Hence Y is not a continuous variable. The
cell means model was fit with ni = 25 for i = 1, ..., 6. Each of the six habitats
was a level. Figure 5.1a and b shows the response plot and residual plot.
There are 6 dot plots in each plot. Because several of the smallest values in
each plot are identical, it does not always look like the identity line is passing
through the six sample means Y i0 for i = 1, ..., 6. In particular, examine the
dot plot for the smallest mean (look at the 25 dots furthest to the left that
fall on the vertical line FIT ≈ 0.36). Random noise (jitter) has been added to
the response and residuals in Figure 5.1c and d. Now it is easier to compare
the six dot plots. They seem to have roughly the same spread.

The plots contain a great deal of information. The response plot can be
used to explain the model, check that the sample from each population (treat-
ment) has roughly the same shape and spread, and to see which populations
have similar means. Since the response plot closely resembles the residual
plot in Figure 5.1, there may not be much difference in the six populations.
Linearity seems reasonable since the samples scatter about the identity line.
The residual plot makes the comparison of “similar shape” and “spread”
easier.
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Figure 5.1: Plots for Crab Data

Definition 5.12. a) The total sum of squares

SSTO =

p∑
i=1

ni∑
j=1

(Yij − Y 00)
2.

b) The treatment sum of squares

SSTR =

p∑
i=1

ni(Y i0 − Y 00)
2.

c) The residual sum of squares or error sum of squares

SSE =

p∑
i=1

ni∑
j=1

(Yij − Y io)
2.

Definition 5.13. Associated with each SS in Definition 5.12 is a degrees
of freedom (df) and a mean square = SS/df. For SSTO, df = n − 1 and
MSTO = SSTO/(n−1). For SSTR, df = p−1 and MSTR = SSTR/(p−1).
For SSE, df = n− p and MSE = SSE/(n − p).

Let S2
i =

∑ni

j=1(Yij − Y i0)
2/(ni − 1) be the sample variance of the ith

group. Then the MSE is a weighted sum of the S2
i :

σ̂2 = MSE =
1

n− p

p∑
i=1

ni∑
j=1

r2
ij =

1

n− p

p∑
i=1

ni∑
j=1

(Yij − Y i0)
2 =
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1

n− p

p∑
i=1

(ni − 1)S2
i = S2

pool

where S2
pool is known as the pooled variance estimator.

The ANOVA table is the same as that for MLR, except that SSTR re-
places the regression sum of squares. The MSE is again an estimator of σ2.
The ANOVA F test tests whether all p means µi are equal. Shown below is
an ANOVA table given in symbols. Sometimes “Treatment” is replaced by
“Between treatments,” “Between Groups,” “Model,” “Factor” or “Groups.”
Sometimes “Error” is replaced by “Residual,” or “Within Groups.” Some-
times “p-value” is replaced by “P”, “Pr(> F )” or “PR > F.”

Summary Analysis of Variance Table

Source df SS MS F p-value
Treatment p-1 SSTR MSTR Fo=MSTR/MSE for Ho:

Error n-p SSE MSE µ1 = · · · = µp

Be able to perform the 4 step fixed effects one way ANOVA F
test of hypotheses:
i) State the hypotheses Ho: µ1 = µ2 = · · · = µp and Ha: not Ho.
ii) Find the test statistic Fo = MSTR/MSE or obtain it from output.
iii) Find the p–value from output or use the F–table: p–value =

P (Fp−1,n−p > Fo).

iv) State whether you reject Ho or fail to reject Ho. If the p–value < δ, reject
Ho and conclude that the mean response depends on the level of the factor.
Otherwise fail to reject Ho and conclude that the mean response does not
depend on the level of the factor. Give a nontechnical sentence.

Rule of thumb 5.3. If

max(S1, ..., Sp) ≤ 2min(S1, ..., Sp),

then the one way ANOVA F test results will be approximately correct if
the response and residual plots suggest that the remaining one way ANOVA
model assumptions are reasonable. See Moore (1999, p. 512).

Remark 5.1. If the units are a representative sample of some population
of interest, then randomization of units into groups makes the assumption
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that Yi1, ..., Yi,ni are iid hold to a useful approximation. Random sampling
from populations also induces the iid assumption. Linearity can be checked
with the response plot, and similar shape and spread of the location families
can be checked with both the response and residual plots. Also check that
outliers are not present. If the p dot plots in the response plot are approx-
imately symmetric, then the sample sizes ni can be smaller than if the dot
plots are skewed.

Remark 5.2. When the assumption that the p groups come from the
same location family with finite variance σ2 is violated, the one way ANOVA
F test may not make much sense because unequal means may not imply the
superiority of one category over another. Suppose Y is the time in minutes
until relief from a headache and that Y1j ∼ N(60, 1) while Y2j ∼ N(65, σ2).
If σ2 = 1, then the type 1 medicine gives headache relief 5 minutes faster, on
average, and is superior, all other things being equal. But if σ2 = 100, then
many patients taking medicine 2 experience much faster pain relief than those
taking medicine 1, and many experience much longer time until pain relief.
In this situation, predictor variables that would identify which medicine is
faster for a given patient would be very useful.

fat1 fat2 fat3 fat4 One way Anova for Fat1 Fat2 Fat3 Fat4

64 78 75 55 Source DF SS MS F P

72 91 93 66 treatment 3 1636.5 545.5 5.41 0.0069

68 97 78 49 error 20 2018.0 100.9

77 82 71 64

56 85 63 70

95 77 76 68

Example 5.5. The output above represents grams of fat (minus 100
grams) absorbed by doughnuts using 4 types of fat. See Snedecor and
Cochran (1967, p. 259). Let µi denote the mean amount of fati absorbed by
doughnuts, i = 1, 2, 3 and 4. a) Find µ̂1. b) Perform a 4 step Anova F test.

Solution: a) β̂1c = µ̂1 = Y 10 = Y10/n1 =
∑n1

j=1 Y1j/n1 =
(64 + 72 + 68 + 77 + 56 + 95)/6 = 432/6 = 72.

b) i) H0 : µ1 = µ2 = µ3 = µ4 Ha: not H0

ii) F = 5.41
iii) pvalue = 0.0069
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iv) Reject H0, the mean amount of fat absorbed by doughnuts depends
on the type of fat.

Definition 5.14. A contrast C =
∑p

i=1 kiµi where
∑p

i=1 ki = 0. The

estimated contrast is Ĉ =
∑p

i=1 kiY i0.

If the null hypothesis of the fixed effects one way ANOVA test is not
true, then not all of the means µi are equal. Researchers will often have
hypotheses, before examining the data, that they desire to test. Often such
a hypothesis can be put in the form of a contrast. For example, the contrast
C = µi−µj is used to compare the means of the ith and jth groups while the
contrast µ1 − (µ2 + · · ·+µp)/(p− 1) is used to compare the last p− 1 groups
with the 1st group. This contrast is useful when the 1st group corresponds
to a standard or control treatment while the remaining groups correspond to
new treatments.

Assume that the normal cell means model is a useful approximation to
the data. Then the Y i0 ∼ N(µi, σ

2/ni) are independent, and

Ĉ =

p∑
i=1

kiY i0 ∼ N

(
C, σ2

p∑
i=1

k2
i

ni

)
.

Hence the standard error

SE(Ĉ) =

√√√√MSE

p∑
i=1

k2
i

ni
.

The degrees of freedom is equal to the MSE degrees of freedom = n− p.
Consider a family of null hypotheses for contrasts {Ho :

∑p
i=1 kiµi = 0

where
∑p

i=1 ki = 0 and the ki may satisfy other constraints}. Let δS denote
the probability of a type I error for a single test from the family where a type
I error is a false rejection. The family level δF is an upper bound on the
(usually unknown) size δT . Know how to interpret δF ≈ δT =
P(of making at least one type I error among the family of contrasts).

Two important families of contrasts are the family of all possible con-
trasts and the family of pairwise differences Cij = µi − µj where i �= j. The
Scheffé multiple comparisons procedure has a δF for the family of all possible
contrasts while the Tukey multiple comparisons procedure has a δF for the
family of all

(
p
2

)
pairwise contrasts.
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To interpret output for multiple comparisons procedures, the underlined
means or blocks of letters besides groups of means indicate that the group
of means are not significantly different.

Example 5.6. The output below uses data from SAS Institute (1985,
p. 126-129). The mean nitrogen content of clover depends on the strain of
clover (3dok1, 3dok5, 3dok7, compos, 3dok4, 3dok13). Recall that means
µ1 and µ2 are significantly different if you can conclude that µ1 �= µ2 while
µ1 and µ2 are not significantly different if there is not enough evidence to
conclude that µ1 �= µ2 (perhaps because the means are approximately equal
or perhaps because the sample sizes are not large enough).

Notice that the strain of clover 3dok1 appears to have the highest mean
nitrogen content. There are 4 pairs of means that are not significantly differ-
ent. The letter B suggests 3dok5 and 3dok7, the letter C suggests 3dok7 and
compos, the letter D suggests compos and 3dok4, while the letter E suggests
3dok4 and 3dok13 are not significantly different.

Means with the same letter are not significantly different.

Waller Grouping Mean N strain

A 28.820 5 3dok1

B 23.980 5 3dok5

B

C B 19.920 5 3dok7

C

C D 18.700 5 compos

D

E D 14.640 5 3dok4

E

E 13.260 5 3dok13

Definition 5.15. Graphical Anova for the one way model uses the
residuals as a reference set instead of a t, F or normal distribution. The
scaled treatment deviations or scaled effect c(Y i0 − Y 00) = c(µ̂i − Y 00)
are scaled to have the same variability as the residuals. A dot plot of the
scaled deviations is placed above the dot plot of the residuals. Assume that
ni ≡ m = n/p for i = 1, ..., p. For small n ≤ 40, suppose the distance be-
tween two scaled deviations (A and B, say) is greater than the range of the
residuals = max(rij)−min(rij). Then declare µA and µB to be significantly



CHAPTER 5. ONE WAY ANOVA 206

−0.04 0.00 0.02 0.04 0.06

10
12

14
16

18
20

Residuals

gr
ap

hi
ca

la
no

va

Scaled Treatment Deviations

Figure 5.2: Graphical Anova

different. If the distance is less than the range, do not declare µA and µB to
be significantly different. Scaled deviations that lie outside the range of the
residuals are significant (so significantly different from the overall mean).

For n ≥ 100, let r(1) ≤ r(2) ≤ · · · ≤ r(n) be the order statistics of the resid-
uals. Then instead of the range, use r(�0.975n�)−r(�0.025n�) as the distance where
�x� is the smallest integer ≥ x, eg �7.7� = 8. So effects outside of the interval
(r(�0.025n�), r(�0.975n�)) are significant. See Box, Hunter and Hunter (2005, p.

136, 166). A derivation of the scaling constant c =
√

(n− p)/(p− 1) is given
in Section 5.6.

ganova(x,y)

sdev 0.02955502 0.06611268 -0.05080048 -0.04486722

Treatments "A" "B" "C" "D"

Example 5.7. Cobb (1998, p. 160) describes a one way Anova design
used to study the amount of calcium in the blood. For many animals, the
body’s ability to use calcium depends on the level of certain hormones in
the blood. The response was 1/(level of plasma calcium). The four groups
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were A: Female controls, B: Male controls, C: Females given hormone and
D: Males given hormone. There were 10 birds of each gender, and five from
each gender were given the hormone. The output above uses the regpack

function ganova to produce Figure 5.2.
In Figure 5.2, the top dot plot has the scaled treatment deviations. From

left to right, these correspond to C, D, A and B since the output shows that
the deviation corresponding to C is the smallest with value −0.050. Since the
deviations corresponding to C and D are much closer than the range of the
residuals, the C and D effects yielded similar mean response values. A and
B appear to be significantly different from C and D. The distance between
the scaled A and B treatment deviations is about the same as the distance
between the smallest and largest residuals, so there is only marginal evidence
that the A and B effects are significantly different.

Since all 4 scaled deviations lie outside of the range of the residuals, all
effects A, B, C and D appear to be significant.

5.3 Random Effects One Way ANOVA

Definition 5.16. For the random effects one way Anova, the levels of
the factor are a random sample of levels from some population of levels ΛF .
The cell means model for the random effects one way Anova is Yij = µi + eij

for i = 1, ..., p and j = 1, ..., ni. The µi are randomly selected from some
population Λ with mean µ and variance σ2

µ, where i ∈ ΛF is equivalent to
µi ∈ Λ. The eij and µi are independent, and the eij are iid from a location
family with pdf f , mean 0 and variance σ2. The Yij|µi ∼ f(y − µi), the
location family with location parameter µi and variance σ2. Unconditionally,
E(Yij) = µ and V (Yij) = σ2

µ + σ2.

For the random effects model, the µi are independent random variables
with E(µi) = µ and V (µi) = σ2

µ. The cell means model for fixed effects one
way Anova is very similar to that for the random effects model, but the µi

are fixed constants rather than random variables.

Definition 5.17. For the normal random effects one way Anova model,
Λ ∼ N(µ, σ2

µ). Thus the µi are independent N(µ, σ2
µ) random variables. The

eij are iid N(0, σ2) and the eij and µi are independent. For this model,
Yij|µi ∼ N(µi, σ

2) for i = 1, ..., p. Note that the conditional variance σ2 is
the same for each µi ∈ Λ. Unconditionally, Yij ∼ N(µ, σ2

µ + σ2).
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The fixed effects one way Anova tested Ho : µ1 = · · · = µp. For the
random effects one way Anova, interest is in whether µi ≡ µ for every µi in
Λ where the population Λ is not necessarily finite. Note that if σ2

µ = 0, then
µi ≡ µ for all µi ∈ Λ. In the sample of p levels, the µi will differ if σ2

µ > 0.

Be able to perform the 4 step random effects one way ANOVA
F test of hypotheses:
i) Ho : σ2

µ = 0 Ha : σ2
µ > 0

ii) Fo = MSTR/MSE is usually obtained from output.
iii) The p-value = P (Fp−1,n−p > Fo) is usually obtained from output.
iv) If p–value < δ reject Ho, conclude that σ2

µ > 0 and that the mean response
depends on the level of the factor. Otherwise, fail to reject Ho, conclude that
σ2

µ = 0 and that the mean response does not depend on the level of the factor.

The ANOVA tables for the fixed and random effects one way Anova mod-
els are exactly the same, and the two F tests are very similar. The main
difference is that the conclusions for the random effects model can be gen-
eralized to the entire population of levels. For the fixed effects model, the
conclusions only hold for the p fixed levels. If Ho : σ2

µ = 0 is true and the
random effect model holds, then the Yij are iid with pdf f(y − µ). So the F
statistic for the random effects test has an approximate Fp−1,n−p distribution
if the ni are large by the results for the fixed effects one way Anova test. For
both tests, the output p-value is an estimate of the population p-value.

Source df SS MS F P

brand 5 854.53 170.906 238.71 0.0000

error 42 30.07 0.716

Example 5.8. Data is from Kutner, Nachtsheim, Neter and Li (2005,
problem 25.7). A researcher is interested in the amount of sodium in beer.
She selects 6 brands of beer at random from 127 brands and the response is
the average sodium content measured from 8 cans of each brand.

a) State whether this is a random or fixed effects one way Anova. Explain
briefly.

b) Using the output above, perform the appropriate 4 step Anova F test.

Solution: a) Random effects since the beer brands were selected at random
from a population of brands.
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b) i) H0 : σ2
µ = 0 Ha : σ2

µ > 0
ii) F0 = 238.71
iii) pvalue = 0.0
iv) Reject H0, so σ2

µ > 0 and the mean amount of sodium depends on the
beer brand.

Remark 5.3. The response and residual plots for the random effects
models are interpreted in the same way as for the fixed effects model, except
that the dot plots are from a random sample of p levels instead of from p
fixed levels.

5.4 Response Transformations for Experimen-

tal Design

A model for an experimental design is Yi = E(Yi) + ei for i = 1, ..., n where
the error ei = Yi − E(Yi) and E(Yi) ≡ E(Yi|xi) is the expected value of the
response Yi for a given vector of predictors xi. Many models can be fit with
least squares (OLS or LS) and are linear models of the form

Yi = xi,1β1 + xi,2β2 + · · · + xi,pβp + ei = xT
i β + ei

for i = 1, . . . , n. Often xi,1 ≡ 1 for all i. In matrix notation, these n equations
become

Y = Xβ + e,

where Y is an n × 1 vector of dependent variables, X is an n × p design
matrix of predictors, β is a p × 1 vector of unknown coefficients, and e is
an n × 1 vector of unknown errors. If the fitted values are Ŷi = xT

i β̂, then
Yi = Ŷi + ri where the residuals ri = Yi − Ŷi.

The applicability of an experimental design model can be expanded by
allowing response transformations. An important class of response transfor-
mation models adds an additional unknown transformation parameter λo,
such that

Yi = tλo(Zi) ≡ Z
(λo)
i = E(Yi) + ei = xT

i β + ei.

If λo was known, then Yi = tλo(Zi) would follow the linear model for the
experimental design.
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Figure 5.3: Transformation Plots for Crab Data

Definition 5.18. Assume that all of the values of the “response” Zi are
positive. A power transformation has the form Y = tλ(Z) = Zλ for λ �= 0
and Y = t0(Z) = log(Z) for λ = 0 where λ ∈ ΛL = {−1,−1/2, 0, 1/2, 1}.

A graphical method for response transformations computes the fitted val-
ues Ŵi from the experimental design model using Wi = tλ(Zi) as the “re-
sponse.” Then a plot of the Ŵ versus W is made for each of the five values
of λ ∈ ΛL. The plotted points follow the identity line in a (roughly) evenly
populated band if the experimental design model is reasonable for (Ŵ ,W ).
If more than one value of λ ∈ ΛL gives a linear plot, consult subject matter
experts and use the simplest or most reasonable transformation. Note that
ΛL has 5 models, and the graphical method selects the model with the best
response plot. After selecting the transformation, the usual checks should be
made. In particular, the transformation plot is also the response plot, and a
residual plot should be made.

Definition 5.19. A transformation plot is a plot of (Ŵ ,W ) with the
identity line added as a visual aid.

In the following example, the plots show tλ(Z) on the vertical axis. The
label “TZHAT” of the horizontal axis are the fitted values that result from
using tλ(Z) as the “response” in the software.

For one way Anova models with ni ≡ m ≥ 5, look for a transformation
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plot that satisfies the following conditions. i) The p dot plots scatter about
the identity line with similar shape and spread. ii) Dot plots with more skew
are worse than dot plots with less skew or dot plots that are approximately
symmetric. iii) Spread that increases or decreases with TZHAT is bad.

Example 5.4, continued. Following Kuehl (1994, p. 128), let C be
the count of crabs and let the “response” Z = C + 1/6. Figure 5.3 shows
the five transformation plots. The transformation log(Z) results in dot plots
that have roughly the same shape and spread. The transformations 1/Z and
1/
√
Z do not handle the 0 counts well, and the dot plots fail to cover the

identity line. The transformations
√
Z and Z have variance that increases

with the mean.

Remark 5.4. The graphical method for response transformations can
be used for design models that are linear models, not just one way Anova
models. The method is nearly identical to that of Chapter 3, but ΛL only has

5 values. The log rule states that if all of the Zi > 0 and if
max(Zi)

min(Zi)
≥ 10,

then the response transformation Y = log(Z) will often work.

5.5 Summary

1) The fixed effects one way Anova model has one qualitative explanatory
variable called a factor and a quantitative response variable Yij . The factor
variable has p levels, E(Yij) = µi and V (Yij) = σ2 for i = 1, ..., p and
j = 1, ..., ni. Experimental units are randomly assigned to the treatment
levels.

2) Let n = n1+· · ·+np. In an experiment, the investigators use random-
ization to randomly assign n units to treatments. Draw a random permuta-
tion of {1, ..., n}. Assign the first n1 units to treatment 1, the next n2 units
to treatment 2, ..., and the final np units to treatment p. Use ni ≡ m = n/p
if possible. Randomization washes out the effect of lurking variables.

3) The 4 step fixed effects one way Anova F test has steps
i) Ho: µ1 = µ2 = · · · = µp and Ha: not Ho.
ii) Fo = MSTR/MSE is usually given by output.
iii) The p-value = P(Fp−1,n−p > Fo) is usually given by output.
iv) If the p–value< δ, reject Ho and conclude that the mean response depends
on the level of the factor. Otherwise fail to reject Ho and conclude that the
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mean response does not depend on the level of the factor. Give a nontechnical
sentence.

Summary Analysis of Variance Table

Source df SS MS F p-value
Treatment p-1 SSTR MSTR Fo=MSTR/MSE for Ho:

Error n-p SSE MSE µ1 = · · · = µp

4) Shown is an ANOVA table given in symbols. Sometimes “Treatment”
is replaced by “Between treatments,” “Between Groups,” “Model,” “Fac-
tor” or “Groups.” Sometimes “Error” is replaced by “Residual,” or “Within
Groups.” Sometimes “p-value” is replaced by “P”, “Pr(> F )” or “PR > F.”

5) Boxplots and dot plots for each level are useful for this test. A dot plot
of Z1, ..., Zm consists of an axis and m points each corresponding to the value
of Zi. If all of the boxplots or dot plots are about the same, then probably
the Anova F test will fail to reject Ho. If Ho is true, then Yij = µ+ eij where
the eij are iid with 0 mean and constant variance σ2. Then µ̂ = Y 00 and the
factor doesn’t help predict Yij .

6) Let fZ(z) be the pdf of Z. Then the family of pdfs fY (y) = fZ(y − µ)
indexed by the location parameter µ, −∞ < µ < ∞, is the location family
for the random variable Y = µ+Z with standard pdf fZ(y). A one way fixed
effects ANOVA model has a single qualitative predictor variable W with p
categories a1, ..., ap. There are p different distributions for Y , one for each
category ai. The distribution of

Y |(W = ai) ∼ fZ(y − µi)

where the location family has second moments. Hence all p distributions
come from the same location family with different location parameter µi and
the same variance σ2. The one way fixed effects normal ANOVA model is the
special case where Y |(W = ai) ∼ N(µi, σ

2).

7) The response plot is a plot of Ŷ versus Y . For the one way Anova model,
the response plot is a plot of Ŷij = µ̂i versus Yij. Often the identity line with
unit slope and zero intercept is added as a visual aid. Vertical deviations
from the identity line are the residuals rij = Yij − Ŷij = Yij − µ̂i. The plot
will consist of p dot plots that scatter about the identity line with similar
shape and spread if the fixed effects one way ANOVA model is appropriate.
The ith dot plot is a dot plot of Yi,1, ..., Yi,ni. Assume that each ni ≥ 10. If
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the response plot looks like the residual plot, then a horizontal line fits the p
dot plots about as well as the identity line, and there is not much difference
in the µi. If the identity line is clearly superior to any horizontal line, then
at least some of the means differ.

8) The residual plot is a plot of Ŷ versus residual r = Y − Ŷ . The plot
will consist of p dot plots that scatter about the r = 0 line with similar shape
and spread if the fixed effects one way ANOVA model is appropriate. The
ith dot plot is a dot plot of ri,1, ..., ri,ni. Assume that each ni ≥ 10. Under
the assumption that the Yij are from the same location scale family with
different parameters µi, each of the p dot plots should have roughly the same
shape and spread. This assumption is easier to judge with the residual plot
than with the response plot.

9) Rule of thumb: If max(S1, ..., Sp) ≤ 2min(S1, ..., Sp), then the one way
ANOVA F test results will be approximately correct if the response and resid-
ual plots suggest that the remaining one way ANOVA model assumptions are
reasonable.

10) In an experiment, the investigators assign units to treatments. In
an observational study, investigators simply observe the response, and
the treatment groups need to be p random samples from p populations (the
levels). The effects of lurking variables are present in observational studies.

11) If a qualitative variable has c levels, represent it with c − 1 or c
indicator variables. Given a qualitative variable, know how to represent the
data with indicator variables.

12) The cell means model for the fixed effects one way Anova is Yij =
µi + eij where Yij is the value of the response variable for the jth trial of the
ith factor level for i = 1, ..., p and j = 1, ..., ni. The µi are the unknown means
and E(Yij) = µi. The eij are iid from the location family with pdf fZ(z), zero
mean and unknown variance σ2 = V (Yij) = V (eij). For the normal cell means

model, the eij are iid N(0, σ2). The estimator µ̂i = Y i0 =
∑ni

j=1 Yij/ni = Ŷij.

The ith residual is rij = Yij−Y i0, and Y 00 is the sample mean of all of the Yij

and n =
∑p

i=1 ni. The total sum of squares SSTO =
∑p

i=1

∑ni

j=1(Yij − Y 00)
2,

the treatment sum of squares SSTR =
∑p

i=1 ni(Y i0 − Y 00)
2, and the error

sum of squares SSE =
∑p

i=1

∑ni

j=1(Yij − Y i0)
2. The MSE is an estimator of

σ2. The Anova table is the same as that for multiple linear regression, except
that SSTR replaces the regression sum of squares and that SSTO, SSTR and
SSE have n− 1, p− 1 and n− p degrees of freedom.
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13) Let Yi0 =
∑ni

j=1 Yij and let

µ̂i = Y i0 = Yi0/ni =
1

ni

ni∑
j=1

Yij.

Hence the “dot notation” means sum over the subscript corresponding to the
0, eg j. Similarly, Y00 =

∑p
i=1

∑ni

j=1 Yij is the sum of all of the Yij . Be able
to find µ̂i from data.

14) If the p treatment groups have the same pdf (so µi ≡ µ in the location
family) with finite variance σ2, and if the one way ANOVA F test statistic is

computed from all
n!

n1! · · ·np!
ways of assigning ni of the response variables

to treatment i, then the histogram of the F test statistic is approximately
Fp−1,n−p for large ni.

15) For the one way Anova, the fitted values Ŷij = Y i0 and the residuals

rij = Yij − Ŷij .
16) Know that for the random effects one way Anova, the levels of

the factor are a random sample of levels from some population of levels ΛF .
Assume the µi are iid with mean µ and variance σ2

µ. The cell means model
for the random effects one way Anova is Yij = µi + eij for i = 1, ..., p and
j = 1, ..., ni. The sample size n = n1 + · · ·+ np and often ni ≡ m so n = pm.
The µi and eij are independent. The eij have mean 0 and variance σ2. The
Yij|µi ∼ f(y − µi), a location family with variance σ2 while eij ∼ f(y). In
the test below, if H0 : σ2

µ = 0 is true, then the Yij are iid with pdf f(y − µ),
so the F statistic ≈ Fp−1,n−p if the ni are large.

17) Know that the 4 step random effects one way Anova test is
i) H0 σ

2
µ = 0 HA σ2

µ > 0
ii) F0 = MSTR/MSE is usually obtained from output.
iii) The pvalue = P (Fp−1,n−p > F0) is usually obtained from output.
iv) If pvalue < δ reject Ho, conclude that σ2

µ > 0 and that the mean response
depends on the level of the factor. Otherwise, fail to reject Ho, conclude
that σ2

µ = 0 and that the mean response does not depend on the level of the
factor.

18) Know how to tell whether the experiment is a fixed or random effects
one way Anova. (Were the levels fixed or a random sample from a population
of levels?)

19) The applicability of a DOE (design of experiments) model can be ex-
panded by allowing response transformations. An important class of response
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transformation models is

Y = tλo(Z) = E(Y ) + e = xT β + e

where the subscripts (eg Yij) have been suppressed. If λo was known, then
Y = tλo(Z) would follow the DOE model. Assume that all of the values
of the “response” Z are positive. A power transformation has the form
Y = tλ(Z) = Zλ for λ �= 0 and Y = t0(Z) = log(Z) for λ = 0 where
λ ∈ ΛL = {−1,−1/2, 0, 1/2, 1}.

20) A graphical method for response transformations computes the fitted
values Ŵ from the DOE model using W = tλ(Z) as the “response” for each
of the five values of λ ∈ ΛL. Let T̂ = Ŵ = TZHAT and plot TZHAT vs
tλ(Z) for λ ∈ {−1,−1/2, 0, 1/2, 1}. These plots are called transformation
plots. The residual or error degrees of freedom used to compute the MSE
should not be too small. Choose the transformation Y = tλ∗(Z) that has the
best plot. Consider the one way Anova model with ni > 4 for i = 1, ..., p.
i) The dot plots should spread about the identity line with similar shape
and spread. ii) Dot plots that are approximately symmetric are better than
skewed dot plots. iii) Spread that increases or decreases with TZHAT (the
shape of the plotted points is similar to a right or left opening megaphone)
is bad.

21) The transformation plot for the selected transformation is also the
response plot for that model (eg for the model that uses Y = log(Z) as the
response). Make all of the usual checks on the DOE model (residual and
response plots) after selecting the response transformation.

22) The log rule says try Y = log(Z) if max(Z)/min(Z) > 10 where
Z > 0 and the subscripts have been suppressed (so Z ≡ Zij for the one way
Anova model).

23) A contrast C =
∑p

i=1 kiµi where
∑p

i=1 ki = 0. The estimated contrast

is Ĉ =
∑p

i=1 kiY i0.

24) Consider a family of null hypotheses for contrasts {Ho :
∑p

i=1 kiµi = 0
where

∑p
i=1 ki = 0 and the ki may satisfy other constraints }. Let δS denote

the probability of a type I error for a single test from the family. The family
level δF is an upper bound on the (usually unknown) size δT . Know how to
interpret δF ≈ δT = P(of making at least one type I error among the family
of contrasts) where a type I error is a false rejection.

25) Two important families of contrasts are the family of all possible
contrasts and the family of pairwise differences Cij = µi − µj where i �= j.
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The Scheffé multiple comparisons procedure has a δF for the family of all
possible contrasts while the Tukey multiple comparisons procedure has a δF

for the family of all
(

p
2

)
pairwise contrasts.

26) Know how to interpret output for multiple comparisons procedures.
Underlined means or blocks of letters besides groups of means indicates that
the group of means are not significantly different.

27) Graphical Anova for the one way Anova model makes a dot plot
of scaled treatment deviations (effects) above a dot plot of the residuals. For
small n ≤ 40, suppose the distance between two scaled deviations (A and B,
say) is greater than the range of the residuals = max(rij) − min(rij). Then
declare µA and µB to be significantly different. If the distance is less than
the range, do not declare µA and µB to be significantly different. Assume
the ni ≡ m for i = 1, ..., p. Then the ith scaled deviation is c(Y i0 − Y 00) =

cα̂i = α̃i where c =
√
dfe/dftreat =

√
n− p

p− 1
.

28) The analysis of the response, not that of the residuals, is of primary
importance. The response plot can be used to analyze the response in the
background of the fitted model. For linear models such as experimental
designs, the estimated mean function is the identity line and should be added
as a visual aid.

29) Assume that the residual degrees of freedom are large enough for
testing. Then the response and residual plots contain much information.
Linearity and constant variance may be reasonable if the p dot plots have
roughly the same shape and spread, and the dot plots scatter about the
identity line. The p dot plots of the residuals should have similar shape and
spread, and the dot plots scatter about the r = 0 line. It is easier to check
linearity with the response plot and constant variance with the residual plot.
Curvature is often easier to see in a residual plot, but the response plot can
be used to check whether the curvature is monotone or not. The response
plot is more effective for determining whether the signal to noise ratio is
strong or weak, and for detecting outliers or influential cases.

5.6 Complements

Often the data does not consist of samples from p populations, but consists
of a group of n = mp units where m units are randomly assigned to each
of the p treatments. Then the ANOVA models can still be used to compare



CHAPTER 5. ONE WAY ANOVA 217

treatments, but statistical inference to a larger population can not be made.
Of course a nonstatistical generalization to larger populations can be made.
The nonstatistical generalization from the group of units to a larger popula-
tion is most compelling if several experiments are done with similar results.
For example, generalizing the results of an experiment for psychology stu-
dents to the population of all of the university students is less compelling
than the following generalization. Suppose one experiment is done for psy-
chology students, one for engineers and one for English majors. If all three
experiments give similar results, then generalize the results to the population
of all of the university’s students.

Four good tests on the design and analysis of experiments are Box, Hunter
and Hunter (2005), Cobb (1998), Kuehl (1994) and Ledolter and Swersey
(2007). Also see Dean and Voss (2000), Kirk (1982), Montgomery (2005)
and Oehlert (2000).

A randomization test has H0: the different treatments have no effect.
This null hypothesis is also true if all p pdfs Y |(W = ai) ∼ fZ(y − µ) are
the same. An impractical randomization test uses all M = n!

n1!···np !
ways of

assigning ni of the Yij to treatment i for i = 1, ..., p. Let F0 be the usual F
statistic. The F statistic is computed for each of the M permutations and
H0 is rejected if the proportion of the M F statistics that are larger than
F0 is less than δ. The distribution of the M F statistics is approximately
Fp−1,n−p for large n when H0 is true. The power of the randomization test is
also similar to that of the usual F test. See Hoeffding (1952). These results
suggest that the usual F test is semiparametric: the pvalue is approximately
correct if n is large and if all p pdfs Y |(W = ai) ∼ fZ(y − µ) are the same.

Let [x] be the integer part of x, eg [7.7] = 7. Olive (2009c) shows that prac-
tical randomization tests that use a random sample of max(1000, [n log(n)])
permutations have level and power similar to the tests that use all M possi-
ble permutations. See Ernst (2009) and the regpack function rand1way for R
code.

All of the parameterizations of the one way fixed effects ANOVA model
yield the same predicted values, residuals and ANOVA F test, but the inter-
pretations of the parameters differ. The cell means model is a linear model
(without intercept) of the form Y = Xcβc + e = that can be fit using OLS.
The OLS MLR output gives the correct fitted values and residuals but an
incorrect Anova table. An equivalent linear model (with intercept) with cor-
rect OLS MLR Anova table as well as residuals and fitted values can be
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formed by replacing any column of the cell means model by a column of ones
1. Removing the last column of the cell means model and making the first
column 1 gives the model Y = β0 +β1x1 + · · ·+βp−1xp−1 + e given in matrix
form by (5.5).

It can be shown that the OLS estimators corresponding to (5.5) are β̂0 =
Y p0 = µ̂p, and β̂i = Y i0 − Y p0 = µ̂i − µ̂p for i = 1, ..., p− 1. The cell means

model has β̂i = µ̂i = Y i0.



Y11
...

Y1,n1

Y21
...

Y2,n2

...
Yp,1
...

Yp,np



=



1 1 0 . . . 0
...

...
...

...
1 1 0 . . . 0
1 0 1 . . . 0
...

...
...

...
1 0 1 . . . 0
...

...
...

...
1 0 0 . . . 1
...

...
...

...
1 0 0 . . . 1
1 0 0 . . . 0
...

...
...

...
1 0 0 . . . 0




β0

β1
...

βp−1

 +



e11
...

e1,n1

e21
...

e2,n2

...
ep,1
...

ep,np



. (5.5)

Wilcox (2005) gives an excellent discussion of the problems that outliers
and skewness can cause for the one and two sample t–intervals, the t–test,
tests for comparing 2 groups and the ANOVA F test. Wilcox (2005) replaces
ordinary population means by truncated population means and uses trimmed
means to create analogs of one way ANOVA and multiple comparisons.

Graphical Anova uses scaled treatment effects = scaled treatment de-
viations d̃i = cdi = c(Y i0 − Y 00) for i = 1, ..., p. Following Box, Hunter
and Hunter (2005, p. 166), suppose ni ≡ m = n/p for i = 1, ..., n. If Ho
µ1 = · · · = µp is true, want the sample variance of the scaled deviations
to be approximately equal to the sample variance of the residuals. So want

1 ≈
1
p

∑p
i=1 c

2d2
i

1
n

∑n
i=1 r

2
i

= F0 =
MSTR

MSE
=

SSTR/(p− 1)

SSE/(n − p)
=

∑p
i=1md

2
i /(p− 1)∑n

i=1 r
2
i /(n − p)
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since SSTR =
∑p

i=1 m(Y i0 − Y 00)
2 =

∑p
i=1md

2
i . So

F0 =

∑p
i=1 c

2 n
p
d2

i∑n
i=1 r

2
i

=

∑p
i=1

m(n−p)
p−1

d2
i∑n

i=1 r
2
i

.

Equating numerators gives

c2 =
mp

n

(n− p)

(p− 1)
=

(n− p)

(p− 1)

since mp/n = 1. Thus c =
√

(n− p)/(p− 1).
For Graphical Anova, see Box, Hunter and Hunter (2005, p. 136, 150,

164, 166) and Hoaglin, Mosteller, and Tukey (1991). The R package granova,
available from (http://streaming.stat.iastate.edu/CRAN/) and authored by
R.M. Pruzek and J.E. Helmreich, may be useful.

The modified power transformation family

Yi = tλ(Zi) ≡ Z
(λ)
i =

Zλ
i − 1

λ

for λ �= 0 and t0(Zi) = log(Zi) for λ = 0 where λ ∈ ΛL.
Box and Cox (1964) give a numerical method for selecting the response

transformation for the modified power transformations. Although the method
gives a point estimator λ̂o, often an interval of “reasonable values” is gen-
erated (either graphically or using a profile likelihood to make a confidence
interval), and λ̂ ∈ ΛL is used if it is also in the interval.

There are several reasons to use a coarse grid ΛL of powers. First, several
of the powers correspond to simple transformations such as the log, square
root, and reciprocal. These powers are easier to interpret than λ = .28,
for example. Secondly, if the estimator λ̂n can only take values in ΛL, then
sometimes λ̂n will converge in probability to λ∗ ∈ ΛL. Thirdly, Tukey (1957)
showed that neighboring modified power transformations are often very sim-
ilar, so restricting the possible powers to a coarse grid is reasonable.

The graphical method for response transformations is due to Olive (2004)
and Olive and Hawkins (2009a). A variant of the method would plot the
residual plot or both the response and the residual plot for each of the five
values of λ. Residual plots are also useful, but they do not distinguish be-
tween nonlinear monotone relationships and nonmonotone relationships. See
Fox (1991, p. 55). Alternative methods are given by Cook and Olive (2002)
and Box, Hunter and Hunter (2005, p. 321).
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An alternative to one way ANOVA is to use FWLS (see Chapter 4) on
the cell means model with σ2V = diag(σ2

1, ..., σ
2
p) where σ2

i is the variance

of the ith group for i = 1, ..., p. Then V̂ = diag(S2
1 , ..., S

2
p) where S2

i =
1

ni−1

∑ni

j=1(Yij − Y i0)
2 is the sample variance of the Yij . Hence the estimated

weights for FWLS are ŵij ≡ ŵi = 1/S2
i . Then the FWLS cell means model

has Y = Xcβc + e as in (5.1) except Cov(e) = diag(σ2
1, ..., σ

2
p).

Hence Z = U cβc + ε. Then UT
c U c = diag(n1ŵ1, ..., npŵp), (UT

c U c)
−1 =

diag(S2
1/n1, ..., S

2
p/np) = (XV̂

−1
XT )−1, and UT

c Z = (ŵ1Y10, ..., ŵpYp0)
T .

Thus
β̂FWLS = (Y 10, ..., Y p0)

T = β̂c.

That is, the FWLS estimator equals the one way ANOVA estimator of β
based on OLS applied to the cell means model. The ANOVA F test gener-
alizes the pooled t test in that the two tests are equivalent for p = 2. The
FWLS procedure is also known as the Welch one way ANOVA and general-
izes the Welch t test. The Welch t test is thought to be much better than
the pooled t test. See Brown and Forsythe (1974ab), Kirk (1982, p. 100,
101, 121, 122),Welch (1947, 1951) and Problem 5.11.

In matrix form Z = U cβc + ε becomes

√
ŵ1Y1,1

...√
ŵ1Y1,n1√
ŵ2Y21

...√
ŵ2Y2,n2

...√
ŵpYp,1

...√
ŵpYp,np



=



√
ŵ1 0 0 . . . 0
...

...
...

...√
ŵ1 0 0 . . . 0
0

√
ŵ2 0 . . . 0

...
...

...
...

0
√
ŵ2 0 . . . 0

...
...

...
...

0 0 0 . . .
√
ŵp

...
...

...
...

0 0 0 . . .
√
ŵp




µ1

µ2
...
µp

 +



ε11
...

ε1,n1

ε21
...

ε2,n2

...
εp,1
...

εp,np



. (5.6)

Four tests for Ho : µ1 = · · · = µp can be used if Rule of Thumb 5.1:
max(S1, ..., Sp) ≤ 2min(S1, ..., Sp) fails. Let Y = (Y1, ..., Yn)

T , and let Y(1) ≤
Y(2) · · · ≤ Y(n) be the order statistics. Then the rank transformation of the
response is Z = rank(Y ) where Zi = j if Yi = Y(j) is the jth order statistic.
For example, if Y = (7.7, 4.9, 33.3, 6.6)T , then Z = (3, 1, 4, 2)T . The first test
performs the one way ANOVA F test with Z replacing Y . See Montgomery
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(1984, p. 117-118). Two of the next three tests are described in Brown and
Forsythe (1974b). Let �x� be the smallest integer ≥ x, eg �7.7� = 8. Then
the Welch (1951) ANOVA F test uses test statistic

FW =

∑p
i=1wi(Y i0 − Ỹ00)

2/(p− 1)

1 + 2(p−2)
p2−1

∑p
i=1(1 − wi

u
)2/(ni − 1)

where wi = ni/S
2
i , u =

∑p
i=1wi and Ỹ00 =

∑p
i=1wiY i0/u. Then the test

statistic is compared to an Fp−1,dW
distribution where dW = �f� and

1/f =
3

p2 − 1

p∑
i=1

(1 − wi

u
)2/(ni − 1).

For the modified Welch (1947) test, the test statistic is compared to an
Fp−1,dMW

distribution where dMW = �f� and

f =

∑p
i=1(S

2
i /ni)

2∑p
i=1

1
ni−1

(S2
i /ni)2

=

∑p
i=1(1/wi)

2∑p
i=1

1
ni−1

(1/wi)2
.

Some software uses f instead of dW or dMW , and variants on the denominator
degrees of freedom dW or dMW are common.

The modified ANOVA F test uses test statistic

FM =

∑p
i=1 ni(Y i0 − Y 00)

2∑p
i=1(1 − ni

n
)S2

i

The test statistic is compared to an Fp−1,dM
distribution where dM = �f�

and

1/f =

p∑
i=1

c2i/(ni − 1)

where

ci = (1 − ni

n
)S2

i /[

p∑
i=1

(1 − ni

n
)S2

i ].

The regpack function anovasim can be used to compare the five tests.
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5.7 Problems

Problems with an asterisk * are especially important.

Output for Problem 5.1.

A B C D E

9.8 9.8 8.5 7.9 7.6 Analysis of Variance for Time

10.3 12.3 9.6 6.9 10.6 Source DF SS MS F P

13.6 11.1 9.5 6.6 5.6 Design 4 44.88 11.22 5.82 0.002

10.5 10.6 7.4 7.6 10.1 Error 25 48.17 1.93

8.6 11.6 7.6 8.9 10.5 Total 29 93.05

11.1 10.9 9.9 9.1 8.6

5.1. In a psychology experiment on child development, the goal is to
study how different designs of mobiles vary in their ability to capture the
infants’ attention. Thirty 3-month-old infants are randomly divided into five
groups of six each. Each group was shown a mobile with one of five designs
A, B, C, D or E. The time that each infant spent looking at the design is
recorded in the output above along with the Anova table. Data is taken from
McKenzie and Goldman (1999, p. 234). See the above output.

a) Find µ̂2 = µ̂B .

b) Perform a 4 step Anova F test.

Output for Problem 5.2.

Variable MEAN SAMPLE SIZE GROUP STD DEV

NONE 10.650 4 2.0535

N1000 10.425 4 1.4863

N5000 5.600 4 1.2437

N10000 5.450 4 1.7711

TOTAL 8.0312 16 1.6666

One Way Analysis of Variance Table

Source df SS MS F p-value

Treatments 2 100.647 33.549 12.08 0.0006

Error 28 33.328 2.777

Total 15 133.974
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Bonferroni Comparison of Means

Homogeneous

Variable Mean Groups

----------------------------

NONE 10.650 I

N1000 10.425 I

N5000 5.600 .. I

N10000 5.450 .. I

5.2. Moore (2000, p. 526): Nematodes are microscopic worms. A
botanist desires to learn how the presence of the nematodes affects tomato
growth. She uses 16 pots each with a tomato seedling. Four pots get 0 ne-
matodes, four get 1000, four get 5000, and four get 10000. These four groups
are denoted by “none,” “n1000,” “n5000” and “n10000” respectively. The
seedling growths were all recorded and the table on the previous page gives
the one way ANOVA results.

a) What is µ̂none?

b) Do a four step test for whether the four mean growths are equal.
(So Ho: µnone = µn1000 = µn5000 = µn10000.)

c) Examine the Bonferroni comparison of means. Which groups of means
are not significantly different?

5.3. According to Cobb (1998, p. 9) when the famous statistician W. G.
Cochran was starting his career, the experiment was to study rat nutrition
with two diets: ordinary rat food and rat food with a supplement. It was
thought that the diet with the supplement would be better. Cochran and his
coworker grabbed rats out of a cage, one at a time, and Cochran assigned
the smaller less healthy rats to the better diet because he felt sorry for them.
The results were as expected for the rats chosen by Cochran’s coworker, but
the better diet looked bad for Cochran’s rats.

a) What were the units?

b) Suppose rats were taken from the cage one at a time. How should the
rats have been assigned to the two diets?
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5.4. Use the output from the command below

> sample(11)

[1] 7 10 9 8 1 6 3 11 2 4 5

to assign the following 11 people to three groups of size n1 = n2 = 4 and
n3 = 3.

Anver, Arachchi, Field, Haenggi, Hazaimeh,
Liu, Pant, Tosun, Yi, Zhang, Zhou

5.5. Sketch a good response plot if there are 4 levels with Y 10 = 2,
Y 20 = 4, Y 30 = 6, Y 40 = 7, and ni = 5.

output for problem 5.6

level 1 2 3 4 5

15 percent 20 percent 25 percent 30 percent 35 percent

y1 y5 y2 y3 y4

9.8 10.8 15.4 17.6 21.6
—– —– —– —–

5.6. The tensile strength of a cotton nylon fiber used to make women’s
shirts is believed to be affected by the percentage of cotton in the fiber. The 5
levels of cotton percentage that are of interest are tabled above. Also shown
is a (Tukey pairwise) comparison of means. Which groups of means are not
significantly different? Data is from Montgomery (1984. p. 51, 66).

output for problem 5.7

Source df SS MS F P

color 2 7.60 3.80 0.390 0.684

error 12 116.40 9.70

5.7. A researcher is interested in whether the color (red, blue or green)
of a paper maze effects the time to complete the maze.

a) State whether this is a random or fixed effects one way Anova. Explain
briefly.

b) Using the output above, perform the appropriate 4 step Anova F test.
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A B C Output for problem 5.8.

9.5 8.5 7.7 Analysis of Variance for Time

3.2 9.0 11.3 Source DF SS MS F P

4.7 7.9 9.7 Design 2 49.168 24.584 4.4625 0.0356

7.5 5.0 11.5 Error 12 66.108 5.509

8.3 3.2 12.4

5.8. Ledolter and Swersey (2007, p. 49) describe a one way Anova design
used to study the effectiveness of 3 product displays (A, B and C). Fifteen
stores were used and each display was randomly assigned to 5 stores. The
response Y was the sales volume for the week during which the display was
present compared to the base sales for that store.

a) Find µ̂2 = µ̂B .

b) Perform a 4 step Anova F test.
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Scaled Treatment Deviations

Figure 5.4: Graphical Anova for Problem 5.9
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ganova(x,y)

smn -3.233326 -3.037367 6.270694

Treatments "A" "B" "C"

5.9. Ledolter and Swersey (2007, p. 49) describe a one way Anova design
used to study the effectiveness of 3 product displays (A, B and C). Fifteen
stores were used and each display was randomly assigned to 5 stores. The
response Y was the sales volume for the week during which the display was
present compared to the base sales for that store. Figure 5.4 is the Graphical
Anova plot found using the function ganova.

a) Which two displays (from A, B and C) yielded similar mean sales
volume?

b) Which effect (from A, B and C) appears to be significant?

Source df SS MS F P

treatment 3 89.19 29.73 15.68 0.0002

error 12 22.75 1.90

5.10. A textile factory weaves fabric on a large number of looms. They
would like to obtain a fabric of uniform strength. Four looms are selected
at random and four samples of fabric are obtained from each loom. The
strength of each fabric sample is measured. Data is from Montgomery (1984,
p. 74-75).

a) State whether this is a random or fixed effects one way Anova. Explain
briefly.

b) Using the output above, perform the appropriate 4 step Anova F test.

Problems using R/Splus.

Warning: Use the command source(“A:/regpack.txt”) to download
the programs, and source(“A:/regdata.txt”) to download the data. See
Preface or Section 17.1. Typing the name of the regpack function, eg
pcisim, will display the code for the function. Use the args command, eg
args(pcisim), to display the needed arguments for the function.

5.11. The pooled t procedures are a special case of one way Anova with
p = 2. Consider the pooled t CI for µ1−µ2. LetX1, ..., Xn1 be iid with mean µ1

and variance σ2
1. Let Y1, ..., Yn2 be iid with mean µ2 and variance σ2

2. Assume
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that the two samples are independent (or that n1 + n2 units were randomly
assigned to two groups) and that ni → ∞ for i = 1, 2 in such a way that
ρ̂ = n1

n1+n2
→ ρ ∈ (0, 1). Let θ = σ2

2/σ
2
1, and let the pooled sample variance

S2
p = [(n1−1)S2

1 +(n2−1)S2
2 ]/[n1+n2−2] and τ 2 = (1−ρ+ρθ)/[ρ+(1−ρ)θ].

Then
X − Y − (µ1 − µ2)√

S2
1

n1
+

S2
2

n2

D→ N(0, 1)

and √
S2

1

n1
+

S2
2

n2

Sp

√
1
n1

+ 1
n2

X − Y − (µ1 − µ2)√
S2

1

n1
+

S2
2

n2

=
X − Y − (µ1 − µ2)

Sp

√
1
n1

+ 1
n2

D→ N(0, τ 2).

Now let θ̂ = S2
2/S

2
1 and τ̂ 2 = (1 − ρ̂ + ρ̂ θ̂)/(ρ̂ + (1 − ρ̂) θ̂). Notice that

τ̂ = 1 if ρ̂ = 1/2, and τ̂ = 1 if θ̂ = 1. The usual large sample (1 − α)100%
pooled t CI for (µ1 − µ2) is

X − Y ± tn1+n2−2,1−α/2 Sp

√
1

n1

+
1

n2

(5.7)

is valid if τ = 1. The large sample (1 − α)100% modified pooled t CI for
(µ1 − µ2) is

X − Y ± tn1+n2−4,1−α/2 τ̂ Sp

√
1

n1

+
1

n2

. (5.8)

The large sample (1 − α)100% Welch CI for (µ1 − µ2) is

X − Y ± td,1−α/2

√
S2

1

n1
+
S2

2

n2
(5.9)

where d = max(1, [d0]), and

d0 =
(

S2
1

n1
+

S2
2

n2
)2

1
n1−1

(
S2

1

n1
)2 + 1

n2−1
(

S2
2

n2
)2
.

Suppose n1/(n1 + n2) → ρ. It can be shown that if the CI length is mul-
tiplied by

√
n1, then the scaled length of the pooled t CI converges in proba-

bility to 2z1−α/2

√
ρ

1−ρ
σ2

1 + σ2
2 while the scaled lengths of the modified pooled
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t CI and Welch CI both converge in probability to 2z1−α/2

√
σ2

1 + ρ
1−ρ

σ2
2. The

pooled t CI should have coverage that is too low if

ρ

1 − ρ
σ2

1 + σ2
2 < σ2

1 +
ρ

1 − ρ
σ2

2 .

See Olive (2009b, Example 9.23).
a) Download the function pcisim.
b) Type the command

pcisim(n1=100,n2=200,var1=10,var2=1) to simulate the CIs for N(µi, σ
2
i )

data for i = 1, 2. The terms pcov, mpcov and wcov are the simulated coverages
for the pooled, modified pooled and Welch 95% CIs. Record these quantities.
Are they near 0.95?

5.12. From the end of Section 5.6, four tests for Ho : µ1 = · · · = µk can
be used if Rule of Thumb: max(S1, ..., Sk) ≤ 2min(S1, ..., Sk) fails. In R, get
the function anovasim. When H0 is true, the coverage = proportion of times
the test rejects H0 has a nominal value of 0.05. The terms faovcov is for the
usual F test, modfcov is for a modified F test, wfcov is for the Welch test,
mwfcov for the modified Welch test and rfcov for the rank test. The function
generates 1000 data sets with k = 4, ni = ni = 20, mi = µi and sdi = σi.

a) Get the coverages for the following command. Since the four popula-
tion means and the four population standard deviations are equal, want the
coverages to be near or less than 0.05. Are they? anovasim(m1 = 0, m2 =
0, m3 = 0, m4 = 0, sd1 = 1, sd2 = 1, sd3 = 1, sd4 = 1)

b) Get the coverages for the following command. The population means
are equal, but the population standard deviations are not. Are the coverages
near or less than 0.05? anovasim(m1 = 0, m2 = 0, m3 = 0, m4 = 0, sd1 =
1, sd2 = 2, sd3 = 3, sd4 = 4)

c) Now use the following command where H0 is false: the four population
means are not all equal. Want the coverages near 1. Are they?
anovasim(m1 = 1, m2 = 0, m3 = 0, m4 = 1)

d) Now use the following command where H0 is false. Want the coverages
near 1. Since the σi are not equal, the Anova F test is expected to perform
poorly. Is the Anova F test the best?
anovasim(m4 = 1, s4 = 9)

5.13. This problem uses data from Kuehl (1994, p. 128).
a) Get regdata and regpack into R. Type the following commands. Then
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simultaneously press the Ctrl and c keys. In Word use the menu command
“Edit>Paste.” Print out the figure.

y <- ycrab+1/6

aovtplt(crabhab,y)

b) From the figure, what response transformation should be used: Y =
1/Z, Y = 1/

√
Z, Y = log(Z), Y =

√
Z, or Y = Z?

5.14. The following data set considers the number of warp breaks per
loom, where the factor is tension (low, medium or high). The commands for
this problem can be found at (www.math.siu.edu/olive/reghw.txt).

a) Type the following commands:

help(warpbreaks)

out <- aov(breaks ~ tension, data = warpbreaks)

out

summary(out)

plot(out$fit,out$residuals)

title("Residual Plot")

Highlight the ANOVA table by pressing the left mouse key and dragging
the cursor over the ANOVA table. Then use the menu commands “Edit>
Copy.” Enter Word and use the menu commands “Edit>Paste.”

b) To place the residual plot in Word, get into R and click on the plot,
hit the Ctrl and c keys at the same time. Enter Word and use the menu
commands “Edit>Paste.”

c) Type the following commands:

warpbreaks[1,]

plot(out$fit,warpbreaks[,1])

abline(0,1)

title("Response Plot")

Click on the response plot, hit the Ctrl and c keys at the same time.
Enter Word and use the menu commands “Edit>Paste.”

5.15. Obtain the Box, Hunter and Hunter (2005, p. 134) blood coagu-
lation data from (www.math.siu.edu/olive/regdata.txt) and the R program
ganova from (www.math.siu.edu/olive/regpack.txt). The program does
graphical Anova for the one way Anova model.
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a) Enter the following commands and include the plot in Word by si-
multaneously pressing the Ctrl and c keys, then using the menu commands
“Copy>Paste” in Word.

ganova(bloodx,bloody)

The scaled treatment deviations are on the top of the plot. As a rule
of thumb, if all of the scaled treatment deviations are within the spread of
the residuals, then population treatment means are not significantly different
(they all give response near the grand mean). If some deviations are outside of
the spread of the residuals, then not all of the population treatment means are
equal. Box, Hunter and Hunter (2005, p. 137) state ‘The graphical analysis
discourages overreaction to high significance levels and avoids underreaction
to “very nearly” significant differences.’

b) From the output, which two treatments means were approximately the
same?

c) To perform a randomization F test in R, get the program rand1way

from (www.math.siu.edu/olive/regpack.txt), and type the following com-
mands. The output z$rdist is the randomization distribution, z$Fpval is the
pvalue of the usual F test, and z$randpval is the pvalue of the randomized F
test.

z<-rand1way(y=bloody,group=bloodx,B=1000)

hist(z$rdist)

z$Fpval

z$randpval

d) Include the histogram in Word.

One Way Anova in SAS

To get into SAS, often you click on a SAS icon, perhaps something like
The SAS System for .... A window with a split screen will open. The top
screen says Log-(Untitled) while the bottom screen says Editor-Untitled1.
Press the spacebar and an asterisk appears: Editor-Untitled1*.

For problem 5.16, consider saving your file as hw5d16.sas on your diskette
(A: drive). (On the top menu of the editor, use the commands “File > Save
as”. A window will appear. Use the upper right arrow to locate “31/2 Floppy
A” and then type the file name in the bottom box. Click on OK.) From the
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top menu in SAS, use the “File> Open” command. A window will open. Use
the arrow in the NE corner of the window to navigate to “31/2 Floppy(A:)”.
(As you click on the arrow, you should see My Documents, C: etc, then 31/2
Floppy(A:).) Double click on hw5d16.sas.

This point explains the SAS commands. The semicolon “;” is used to
end SAS commands and the “options ls = 70;” command makes the output
readable. (An “*” can be used to insert comments into the SAS program.
Try putting an * before the options command and see what it does to the
output.) The next step is to get the data into SAS. The command “data
clover;” gives the name “clover” to the data set. The command “input strain
$ nitrogen @ @;” says the first entry is variable strain and the $ means
it is categorical, the second variable is nitrogen and the @@ means read 2
variables, then 2, ..., until the end of the data. The command “cards;” means
that the data is entered below. Then the data in entered and the isolated
semicolon indicates that the last case has been entered.

The commands “proc glm; class = strain; model nitrogen = strain;” tells
SAS to perform one way Anova with nitrogen as the response variable and
strain as the factor.

5.16. Cut and paste the SAS program from
(www.math.siu.edu/olive/reghw.txt) for 5.16 into the SAS Editor.

To execute the program, use the top menu commands “Run>Submit”.
An output window will appear if successful.

(If you were not successful, look at the log window for hints on errors.
A single typo can cause failure. Reopen your file in Word or Notepad and
make corrections. Occasionally you can not find your error. Then find your
instructor or wait a few hours and reenter the program.)

Data is from SAS Institute (1985, p. 126-129). See Example 5.6.

a) In SAS, use the menu commands “Edit>Select All” then “Edit>Copy.”
In Word, use the menu commands “Edit>Paste.” Highlight the first page of
output and use the menu commands “Edit>Cut.” (SAS often creates too
much output. These commands reduce the output from 4 pages to 3 pages.)

You may want to save your SAS output as the file HW5d16.doc on your
disk.

b) Perform the 4 step test for Ho µ1 = µ2 = · · · = µ6.

c) From the residual and response plots, does the assumption of equal
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population standard deviations (σi = σ for i = 1, ..., 6) seem reasonable?

One Way Anova in ARC

5.17. To get in ARC, you need to find the ARC icon. Suppose the ARC icon
is in a math progs folder. Move the cursor to the math progs folder, click
the right mouse button twice, move the cursor to ARC, double click, move the
cursor to ARC, double click. These menu commands will be written “math
progs > ARC > ARC.” To quit ARC, move cursor to the x in the northeast
corner and click.

This Cook and Weisberg (1999, p. 289) data set contains IQ scores on
27 pairs of identical twins, one raised by foster parents IQf and the other
by biological parents IQb. C gives the social class of the biological parents:
C = 1 for upper class, 2 for middle class and 3 for lower class. Hence the
Anova test is for whether mean IQ depends on class.

a) Activate twins.lsp dataset with the menu commands
“File > Load > Data > ARCG > twins.lsp”.

b) Use the menu commands “Twins>Make factors”, select C and click
on OK. The line “{F}C Factor 27 Factor–first level dropped” should appear
on the screen.

c) Use the menu commands “Twins>Description” to see a description of
the data.

d) Enter the menu commands “Graph&Fit>Fit linear LS” and select
{F}C as the term and IQb as the response. Highlight the output by pressing
the left mouse key and dragging the cursor over the output. Then use the
menu commands “Edit> Copy.” Enter Word and use the menu commands
“Edit>Paste.”

e) Enter the menu commands “Graph&Fit>Boxplot of” and enter IQb in
the selection box and C in the Condition on box. Click on OK. When the
boxplots appear, click on the Show Anova box. Click on the plot, hit the
Ctrl and c keys at the same time. Enter Word and use the menu commands
“Edit>Paste.” Include the output in Word. Notice that the regression and
Anova F statistic and p-value are the same.

f) Residual plot: Enter the menu commands “Graph&Fit>Plot of,” select
“L1:Fit-Values” for the “H” box and “L1:Residuals” for the “V” box, and
click on “OK.” Click on the plot, hit the Ctrl and c keys at the same time.
Enter Word and use the menu commands “Edit>Paste.”

g) Response plot: Enter the menu commands “Graph&Fit>Plot of,” se-
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lect “L1:Fit-Values” for the “H” box and “IQb” for the “V” box, and click
on “OK.” When the plot appears, move the OLS slider bar to 1 to add the
identity line. Click on the plot, hit the Ctrl and c keys at the same time.
Enter Word and use the menu commands “Edit>Paste.”

h) Perform the 4 step test for Ho µ1 = µ2 = µ3.

One Way Anova in Minitab

5.18. a) In Minitab, use the menu command “File>Open Worksheet”
and double click on Baby.mtw. A window will appear. Click on “OK.”

This McKenzie and Goldman (1999, p. T-234) data set has 30 three
month old infants randomized into five groups of 6 each. Each infant is
shown a mobile of one of five multicolored designs, and the goal of the study
is to see if the infant attention span varies with type of design of mobile. The
times that each infant spent watching the mobile are recorded.

b) Choose “Stat>Basic Statistics>Display Descriptive Statistics,” select
“C1 Time” as the “Variable,” click the “By variable” option and press Tab.
Select “C2 Design” as the “By variable.”

c) From the window in b), click on “Graphs” the “Boxplots of data”
option, and “OK” twice. Click on the plot and then click on the printer icon
to get a plot of the boxplots.

d) Select “Stat>ANOVA>One-way,” select “C1-time” as the response
and “C2-Design” as the factor. Click on “Store residuals” and click on “Store
fits.” Then click on “OK.” Click on the output and then click on the printer
icon.

e) To make a residual plot, select “Graph>Plot.” Select “Resi1” for “Y”
and “Fits1” for “X” and click on “OK.” Click on the plot and then click on
the printer icon to get the residual plot.

f) To make a response plot, select “Graph>Plot.” Select “C1 Time” for
“Y” and “Fits1” for “X” and click on “OK.” Click on the plot and then click
on the printer icon to get the response plot.

g) Do the 4 step test for Ho µ1 = µ2 = · · · = µ5.

To get out of Minitab, move your cursor to the “x” in the NE corner of
the screen. When asked whether to save changes, click on “no.”
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K Way ANOVA

6.1 Two Way ANOVA

Definition 6.1. The fixed effects two way Anova model has two factors
A and B plus a response Y . Factor A has a levels and factor B has b levels.
There are ab treatments.

Definition 6.2. The cell means model for two way Anova is Yijk =
µij +eijk where i = 1, ..., a; j = 1, ..., b; and k = 1, ..., m. The sample size n =
abm. The µij are constants and the eijk are iid from a location family with
mean 0 and variance σ2. Hence the Yijk ∼ f(y − µij) come from a location

family with location parameter µij . The fitted values are Ŷijk = Y ij0 = µ̂ij

while the residuals rijk = Yijk − Ŷijk.

For one way Anova models, the cell sizes ni need not be equal. For K way
Anova models with K ≥ 2 factors, the statistical theory is greatly simplified
if all of the cell sizes are equal. Such designs are called balanced designs.

Definition 6.3. A balanced design has all of the cell sizes equal: for
the two way Anova model, nij ≡ m.

In addition to randomization of units to treatments, another key principle
of experimental design is factorial crossing. Factorial crossing allows for
estimation of main effects and interactions.

234
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Definition 6.4. A two way Anova design uses factorial crossing if
each combination of an A level and a B level is used and called a treatment.
There are ab treatments for the two way Anova model.

Experimental two way Anova designs randomly assign m of the n =
mab units to each of the ab treatments. Observational studies take random
samples of size m from ab populations.

Definition 6.5. The main effects are A and B. The AB interaction is
not a main effect.

Remark 6.1. If A and B are factors, then there are 5 possible models.
i) The two way Anova model has terms A, B and AB.
ii) The additive model or main effects model has terms A and B.
iii) The one way Anova model that uses factor A.
iv) The one way Anova model that uses factor B.
v) The null model does not use any of the three terms A, B or AB. If the

null model holds, then Yijk ∼ f(y−µ00) so the Yijk form a random sample of
size n from a location family and the factors have no effect on the response.

Remark 6.2. The response plot, residual plot and transformation plots
for response transformations are used in the same way as Chapter 5. The
plots work best if the MSE degrees of freedom > max(10, n/5). The model
is overfitting if 1 < MSE df ≤ max(10, n/5), and then the plots may only
be useful for detecting large deviations from the model. For the model that
contains A, B and AB, there will be ab dot plots of size m, and need m ≥ 5
to check for similar shape and spread. For the additive model, the response
and residual plots often look like those for multiple linear regression. Then
the plotted points should scatter about the identity line or r = 0 line in
a roughly evenly populated band if the additive two way Anova model is
reasonable.

Shown is an ANOVA table for the two way Anova model given in symbols.
Sometimes “Error” is replaced by “Residual,” or “Within Groups.” A and
B are the main effects while AB is the interaction. Sometimes “p-value”
is replaced by “P”, “Pr(> F )” or “PR > F.” The p-value corresponding
to FA is for Ho: µ10 = · · · = µa0. The p-value corresponding to FB is for
Ho: µ01 = · · · = µ0b. The p-value corresponding to FAB is for Ho: there is
no interaction. The sample pvalue ≡ pval is an estimator of the population
pvalue.
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Source df SS MS F p-value
A a-1 SSA MSA FA=MSA/MSE pval
B b-1 SSB MSB FB=MSB/MSE pval

AB (a− 1)(b− 1) SSAB MSAB FAB=MSAB/MSE pval
Error n− ab = ab(m− 1) SSE MSE

Be able to perform the 4 step test for AB interaction:
i) Ho no interaction HA there is an interaction
ii) FAB is obtained from output.
iii) The pvalue is obtained from output.
iv) If pvalue < δ reject Ho and conclude that there is an interaction between
A and B, otherwise fail to reject Ho and conclude that there is no interaction
between A and B.

Remark 6.3. i) KeepA and B in the model if there is an AB interaction.
The two tests for main effects (below) make the most sense if we fail to reject
the test for interaction. Rejecting Ho for main effects makes sense when
there is an AB interaction because the main effects tend to be larger than
the interaction effects.

ii) The main effects tests are just like the F test for the fixed effects
one way Anova model. If populations means are close, then larger sample
sizes are needed for the F test to reject Ho with high probability. If Ho is
not rejected and the means are equal, then it is possible that the factor is
unimportant, but it is also possible that the factor is important but
the level is not. For example, factor A might be type of catalyst. The
yield may be equally good for each type of catalyst, but there would be no
yield if no catalyst was used.

Be able to perform the 4 step test for A main effects:
i) Ho µ10 = · · · = µa0 HA not Ho
ii) FA is obtained from output.
iii) The pvalue is obtained from output.
iv) If pvalue < δ reject Ho and conclude that the mean response depends
on the level of A, otherwise fail to reject Ho and conclude that the mean
response does not depend on the level of A.

Be able to perform the 4 step test for B main effects:
i) Ho µ01 = · · · = µ0b HA not Ho
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ii) FB is obtained from output.
iii) The pvalue is obtained from output.
iv) If pvalue < δ reject Ho and conclude that the mean response depends
on the level of B, otherwise fail to reject Ho and conclude that the mean
response does not depend on the level of B.

Remark 6.4. One could do a one way Anova on p = ab treatments, but
this procedure loses information about A, B and the AB interaction.

Definition 6.6. An interaction plot is made by plotting the levels
of one factor (either 1, ..., a or 1, ..., b) versus the cell sample means Y ij0.
Typically the factor with more levels (eg A if a > b) is used on the horizontal
axis. If the levels of A are on the horizontal axis, use line segments to join
the a means that have the same j. There will be b curves on the plot. If the
levels of B are on the horizontal axis, use line segments to join the b means
that have the same i. There will be a curves on the plot. If no interaction
is present, then the curves should be roughly parallel.

The interaction plot is rather hard to use, especially if the nij = m are
small. For small m, the curves can be far from parallel, even if there is no
interaction. The further the curves are from being parallel, the greater the
evidence of interaction. Intersection of curves suggests interaction unless the
two curves are nearly the same. The two curves may be nearly the same if
two levels of one factor give nearly the same mean response for each level
of the other factor. Then the curves could cross several times even though
there is no interaction. Software fills space. So the vertical axis needs to
be checked to see whether the sample means for two curves are “close” with
respect to the standard error

√
MSE/m for the means.

The interaction plot is the most useful if the conclusions for the plot agree
with the conclusions for the F test for no interaction.

Definition 6.7. The overparameterized two way Anova model has Yijk =
µij + eijk with µij = µ00 + αi + βj + (αβ)ij where the interaction parameters
(αβ)ij = µij − µi0 − µ0j + µ00. The A main effects are αi = µi0 − µ00 for
i = 1, ..., a. The B main effects are βj = µ0j − µ00 for j = 1, ..., b. Here∑

i αi = 0,
∑

j βj = 0,
∑

i(αβ)ij = 0 for j = 1, ..., b and
∑

j(αβ)ij = 0 for
i = 1, ..., a. Thus

∑
i

∑
j(αβ)ij = 0.

The mean parameters have the following meaning. The parameter µij

is the population mean response for the ijth treatment. The means µ0j =
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Figure 6.1: Interaction Plot for Example 6.1.

∑a
i=1 µij/a, and the means µi0 =

∑b
j=1 µij/b.

As was the case for multiple linear regression, interaction is rather difficult
to understand. Note that if all of the interaction parameters (αβ)ij = 0, then
the factor effects are additive: µij = µ00 + αi + βj. Hence “no interaction”
implies that the factor effects are additive while “interaction” implies that
the factor effects are not additive. When there is no interaction, µ1j =
µ00 + α1 + βj, µ2j = µ00 + α2 + βj, ..., µaj = µ00 + αa + βj. Consider a plot
with the µij on the vertical axis and the levels 1, 2, ..., a of A on the horizontal
axis. If there is no interaction and if the µij with the same j are connected
with line segments, then there will be b parallel curves with curve “height”
depending on βj. If there is interaction, then not all of the p curves will be
parallel. The interaction plot replaces the µij by the µ̂ij = Y ij0.

Example 6.1. Cobb (1998, p. 200-212) describes an experiment on
weight gain for baby pigs. The response Y was the average daily weight gain
in pounds for each piglet (over a period of time). Factor A consisted of 0 mg
of an antibiotic or 40 mg an antibiotic while factor B consisted of 0 mg of
vitamin B12 or 5 mg of B12. Hence there were 4 diets (A,B) = (0,0), (40,0),
(0,5) or (40,5). Hence level 1 corresponds to 0 mg and level 2 to more than
0 mg.
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The interaction plot shown in Figure 6.1 suggests that there is an inter-
action. If no vitamin B12 is given, then the pigs given the antibiotic have
less mean weight gain than the pigs not given the antibiotic. For pigs given
the diet with 5 mg of B12, the antibiotic was useful, with a mean gain near
1.6. Pigs with A = 1 (no antibiotic in the diet) had similar mean weight
gains, but pigs with A = 2 (antibiotic in the diet) had greatly different mean
weight gains. The best diet had both vitamin B12 and the antibiotic, while
the worst diet had the antibiotic but no vitamin B12.

Source DF SS MS F P

A 2 220.0200 110.0100 1827.86 0.000

B 2 123.6600 61.8300 1027.33 0.000

Interaction 4 29.4250 7.3562 122.23 0.000

Error 27 1.6250 0.0602

Example 6.2. The above output uses data from Kutner, Nachtsheim,
Neter and Li (2005, problems 19.14-15). The output above is from an exper-
iment on hay fever, and 36 volunteers were given medicine. The two active
ingredients (factors A and B) in the medicine were varied at three levels each
(low, medium, and high). The response is the number of hours of relief. (The
factor names for this problem are “A” and “B.”)

a) Give a four step test for the “A*B” interaction.
b) Give a four step test for the A main effects.
c) Give a four step test for the B main effects.

Solution: a) Ho no interaction HA there is an interaction
FAB = 122.23
pval = 0.0
Reject Ho, there is an interaction between the active ingredients A and B.

b) Ho µ10 = µ20 = µ30 HA not Ho
FA = 1827.86
pval = 0.0
Reject Ho, the mean hours of relief depends on active ingredient A.

c) Ho µ01 = µ02 = µ03 HA not Ho
FB = 1027.33
pval = 0.0
Reject Ho, the mean hours of relief depends on active ingredient B.
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6.2 k Way Anova Models

Use factorial crossing to compare the effects (main effects, pairwise inter-
actions, ..., k-fold interaction if there are k factors) of two or more factors. If
A1, ..., Ak are the factors with li levels for i = 1, ..., k; then there are l1l2 · · · lk
treatments where each treatment uses exactly one level from each factor.

Below is a partial Anova table for a k way Anova design with the degrees
of freedom left blank. For A, use H0 : µ10···0 = · · · = µl10···0. The other main
effect have similar null hypotheses. For interaction, use H0 : no interaction.

Source df SS MS F p-value
k main effects eg SSA = MSA FA pA(

k
2

)
2 factor interactions eg SSAB = MSAB FAB pAB(

k
3

)
3 factor interactions eg SSABC = MSABC FABC pABC

...
...

...
...

...(
k

k−1

)
k − 1 factor interactions

the k factor interaction SSA· · ·L = MSA· · ·L FA···L pA···L
Error SSE MSE

These models get complex rapidly as k and the number of levels li in-
crease. As k increases, there are a large number of models to consider. For
experiments, usually the 3 way and higher order interactions are not signif-
icant. Hence a full model that includes all k main effects and

(
k
2

)
2 way

interactions is a useful starting point for response, residual and transforma-
tion plots. The higher order interactions can be treated as potential terms
and checked for significance. As a rule of thumb, significant interactions tend
to involve significant main effects.

The sample size n = m
∏k

i=1 li ≥ m 2k is minimized by taking li = 2 for
i = 1, ..., k. Hence the sample size grows exponentially fast with k. Designs
that use the minimum number of levels 2 are discussed in Section 8.1.

6.3 Summary

1) The fixed effects two way Anova model has two factors A and B plus
a response Y . Factor A has a levels and factor B has b levels. There are
ab treatments. The cell means model is Yijk = µij + eijk where i = 1, ..., a;
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j = 1, ..., b; and k = 1, ..., m. The sample size n = abm. The µij are constants
and the eijk are iid with mean 0 and variance σ2. Hence the Yijk ∼ f(y−µij)
come from a location family with location parameter µij . The fitted values

are Ŷijk = Y ijo = µ̂ij while the residuals rijk = Yijk − Ŷijk.
2) Know that the 4 step test for AB interaction is

i) Ho no interaction HA there is an interaction
ii) FAB is obtained from output.
iii) The pvalue is obtained from output.
iv) If pvalue < δ reject Ho, and conclude that there is an interaction between
A and B, otherwise fail to reject Ho, and conclude that there is no interaction
between A and B.

3) Keep A and B in the model if there is an AB interaction.
4) Know that the 4 step test for A main effects is

i) Ho µ10 = · · · = µa0 HA not Ho
ii) FA is obtained from output.
iii) The p–value is obtained from output.
iv) If pvalue < δ reject Ho and conclude that the mean response depends
on the level of A, otherwise fail to reject Ho and conclude that the mean
response does not depend on the level of A.

5) Know that the 4 step test for B main effects is
i) Ho µ01 = · · · = µ0b HA not Ho
ii) FB is obtained from output.
iii) The pvalue is obtained from output.
iv) If p–value < δ reject Ho and conclude that the mean response depends
on the level of B, otherwise fail to reject Ho and conclude that the mean
response does not depend on the level of B.

The tests for main effects (points 4) and 5)) do not always make sense if
the test for interactions is rejected.

6) Shown is an ANOVA table for the two way Anova model given in sym-
bols. Sometimes “Error” is replaced by “Residual,” or “Within Groups.” A
and B are the main effects while AB is the interaction. Sometimes “p-value”
is replaced by “P”, “Pr(> F )” or “PR > F.” The p-value corresponding to
FA is for Ho: µ10 = · · · = µa0. The p-value corresponding to FB is for Ho:
µ01 = · · · = µ0b. The p-value corresponding to FAB is for Ho: there is no
interaction.
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Source df SS MS F p-value
A a-1 SSA MSA FA=MSA/MSE pval
B b-1 SSB MSB FB=MSB/MSE pval

AB (a− 1)(b− 1) SSAB MSAB FAB=MSAB/MSE pval
Error n− ab = ab(m− 1) SSE MSE

7) An interaction plot is made by plotting the levels of one factor (either
1, ..., a or 1, ..., b) versus the cell sample means Y ij0. Typically the factor with
more levels (eg A if a > b) is used on the horizontal axis. If the levels of A
are on the horizontal axis, use line segments to join the a means that have
the same j. There will be b curves on the plot. If the levels of B are on the
horizontal axis, use line segments to join the b means that have the same i.
There will be a curves on the plot. If no interaction is present, then the
curves should be roughly parallel.

8) The interaction plot is rather hard to use, especially if the nij = m are
small. For small m, the curves could be far from parallel even if there is no
interaction, but the further the curves are from being parallel, the greater
the evidence of interaction. Intersection of curves suggests interaction unless
the two curves are nearly the same. The two curves may be nearly the same
if two levels of one factor give nearly the same mean response for each level
of the other factor. Then the curves could cross several times even though
there is no interaction. Software fills space. So the vertical axis needs to
be checked to see whether the sample means for two curves are “close” with
respect to the standard error

√
MSE/m for the means.

9) The interaction plot is the most useful if the conclusions for the plot
agree with the conclusions for the F test for no interaction.

10) The µij of the cell means model can be parameterized as µij = µ00 +
αi + βj + (αβ)ij for i = 1, ..., a and j = 1, ..., b. Here the αi are the A main
effects and

∑
i αi = 0. The βi are the B main effects and

∑
j βj = 0. The

(αβ)ij are the interaction effects and satisfy
∑

i(αβ)ij = 0,
∑

j(αβ)ij = 0 and∑
i

∑
j(αβ)ij = 0. The interaction effect (αβ)ij = µij − µi0 − µ0j + µ00. Here

the row factor means µi0 =
∑

j µij/b, the column factor means µ0j =
∑

i µij/a
and µ00 =

∑
i

∑
j µij/(ab).

11) If there is no interaction, then the factor effects are additive: µij =
µ00 + αi + βj.
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12) If A and B are factors, then there are 5 possible models.
i) The two way Anova model has terms A, B and AB.
ii) The additive model or main effects model has terms A and B.
iii) The one way Anova model that uses factor A.
iv) The one way Anova model that uses factor B.
v) The null model does not use any of the three terms A, B or AB. If the

null model holds, then Yijk ∼ f(y−µ00) so the Yijk form a random sample of
size n from a location family and the factors have no effect on the response.

13) A two way Anova model could be fit as a one way Anova model with
k = ab treatments, but for balanced models where nij ≡ m, this procedure
loses information about A, B and the interaction AB.

14) Response, residual and transformation plots are used in the same way
for the two way Anova model as for the one way Anova model.

6.4 Complements

Four good tests on the design and analysis of experiments are Box, Hunter
and Hunter (2005), Cobb (1998), Kuehl (1994) and Ledolter and Swersey
(2007). Also see Dean and Voss (2000), Kirk (1982), Montgomery (2005)
and Oehlert (2000).

The software for k way Anova is often used to fit block designs. Each
block is entered as if it were a factor and the main effects model is fit. The
one way block design treats the block like one factor and the treatment factor
as another factor and uses two way Anova software without interaction to get
the correct sum of squares, F statistic and p-value. The Latin square design
treats the row block as one factor, the column block as a second factor and
the treatment factor as another factor. Then the three way Anova software
for main effects is used to get the correct sum of squares, F statistic and
p-value. These two designs are described in Chapter 7. The k way software
is also used to get output for the split plot designs described in Chapter 9.

6.5 Problems

Problems with an asterisk * are especially important.
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Output for 6.1.

Source df SS MS F P

A 2 24.6 12.3 0.24 0.791

B 2 28.3 14.2 0.27 0.763

Interaction 4 1215.3 303.8 5.84 0.001

Error 36 1872.4 52.0

6.1. The above output uses data from Kutner, Nachtsheim, Neter and
Li (2005, problems 19.16-17). A study measured the number of minutes to
complete a repair job at a large dealership. The two explanatory variables
were “A = technician” and “B = make of drive.” The output is given above.

a) Give a four step test for no interaction.

b) Give a four step test for the B main effects.

6.2. Suppose A has 5 levels and B has 4 levels. Sketch an interaction
plot if there is no interaction.

Two Way Anova in SAS

In SAS, Y = A|B is equivalent to Y = A B A∗B. Thus the SAS model
statement could be written in either of the following two forms.

proc glm;

class material temp;

model mvoltage = material|temp;

output out =a p = pred r = resid;

proc glm;

class material temp;

model mvoltage = material temp material*temp;

output out =a p = pred r = resid;

6.3. Cut and paste the SAS program from
(www.math.siu.edu/olive/reghw.txt) for 6.3 into the SAS Editor.

To execute the program, use the top menu commands “Run>Submit”.
An output window will appear if successful. The data is from Montgomery
(1984, p. 198) and gives the maximum output voltage for a typical type of
storage battery. The two factors are material (1,2,3) and temperature (50,
65, 80 ◦F).



CHAPTER 6. K WAY ANOVA 245

a) Copy and paste the SAS program into SAS, use the file command
“Run>Submit.”

b) Click on the “Graph1” window and scroll down to the second interac-
tion plot of “tmp” vs “ymn.” Press the printer icon to get the plot.

c) Is interaction present?
d) Click on the output window then click on the printer icon. This will

produce 5 pages of output, but only hand in the Anova table, response plot
and residual plots.

(Cutting and pasting the output into Word resulted in bad plots. Using
Notepad gave better plots, but the printer would not easily put the Anova
table and two plots on one page each.)

e) Do the residual and response plots look ok?

Two Way Anova in Minitab

6.4. a) Copy the SAS data for problem 6.3 into Notepad. Then hit
“Enter” every three numbers so that the data is in 3 columns.

1 50 130

1 50 155

1 50 74

1 50 180

1 65 34

. . .

. . .

. . .

3 80 60

b) Copy and paste the data into Minitab using the menu commands
Edit>Paste Cells and click on “OK.” Right below C1 type “material”, below
C2 type “temp” and below C3 type “mvoltage”.

c) Select Stat>ANOVA>Two-way, select “C3 mvoltage” as the response
and “C1 material” as the row factor and “C2 temp” as the column factor.
Click on “Store residuals” and click on “Store fits.” Then click on “OK.”
Click on the output and then click on the printer icon.

d) To make a residual plot, select Graph>Plot. Select “Resi1” for “Y”
and “Fits1” for “X” and click on “OK.” Click on the printer icon to get a
plot of the graph.

e) To make a response plot, select Graph>Plot. Select “C3 mvoltage” for
“Y” and “Fits1” for “X” and click on “OK.” Click on the printer icon to get
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a plot of the graph.

f) Use the menu commands “Stat>ANOVA>Interaction Plots” enter
mvoltage in the “Responses” box and material and temp in the “Factors”
box. Click on “OK” and print the plot.

g) Use the menu commands “Stat>ANOVA>Interaction Plots” enter
mvoltage in the “Responses” box and material and temp in the “Factors”
box. Click on “OK” and print the plot.

h) Do the 4 step test for interaction.

Problems using R/Splus.

In R,

Y ~ A + B is equivalent to Y ~ . so the period indicates

use all main effects. Y ~ A:B is equivalent to Y ~ A + B + A*B

and Y ~ A*B and Y ~ .^2 which means fit all main effects and all

two way interactions. A problem is that A and B need to be of

type factor.

6.5. The Box, Hunter, and Hunter (2005, p. 318) poison data has 4
types of treatments (1,2,3,4) and 3 types of poisons (1,2,3). Each animal is
given a poison and a treatment, and the response is survival in hours. Get
the poison data from (www.math.siu.edu/olive/regdata.txt). Commands can
also be found in (www.math.siu.edu/olive/reghw.txt).

a) Type the following commands to see that the output for the three
models is the same. Print the output.

out1<-aov(stime~ptype*treat,poison)

summary(out1)

out2<-aov(stime~ptype + treat + ptype*treat,poison)

summary(out2)

out3<-aov(stime~.^2,poison)

summary(out3)

#The three models are the same.

b) Type the following commands to see the residual plot. Include the
plot in Word.

plot(fitted(out1),resid(out1))

title("Residual Plot")
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c) Type the following commands to see the response plot. Include the
plot in Word.

FIT <- poison$stime - out1$resid

plot(FIT,poison$stime)

abline(0,1)

title("Response Plot")

d) Why is the two way Anova model inappropriate?
e) Now the response Y = 1/stime will be used. Type the following

commands to get the output. Copy the output into Word.

attach(poison)

out4 <- aov((1/stime)~ptype*treat,poison)

summary(out4)

f) Type the following commands to get the residual plot. Copy the plot
into Word.

plot(fitted(out4),resid(out4))

title("Residual Plot")

g) Type the following commands to get the response plot. Copy the plot
into Word.

FIT <- 1/poison$stime - out4$resid

plot(FIT,(1/poison$stime))

abline(0,1)

title("Response Plot")

h) Type the following commands to get the interaction plot. Copy the
plot into Word.

interaction.plot(treat,ptype,(1/stime))

detach(poison)

i) Test whether there is an interaction using the output from e).



Chapter 7

Block Designs

Definition 7.1. A block is a group of k similar or homogenous units.
In a block design, each unit in a block is randomly assigned to one of k
treatments. The meaning of “similar” is that the units are likely to have
similar values of the response when given identical treatments.

In agriculture, adjacent plots of land are often used as blocks since ad-
jacent plots tend to give similar yields. Litter mates, siblings, twins, time
periods (eg different days) and batches of material are often used as blocks.

Following Cobb (1998, p. 247), there are 3 ways to get blocks. i) Sort
units into groups (blocks) of k similar units. ii) Divide large chunks of ma-
terial (blocks) into smaller pieces (units). iii) Reuse material or subjects
(blocks) several times. Then the time slots are the units.

Example 7.1. For i), to study the effects of k different medicines, sort
people into groups of size k according to similar age and weight. For ii)
suppose there are b plots of land. Divide each plot into k subplots. Then
each plot is a block and the subplots are units. For iii), give the k different
treatments to each person over k months. Then each person has a block of
time slots and the ith month = time slot is the unit.

Suppose there are b blocks and n = kb. The one way Anova design ran-
domly assigns b of the units to each of the k treatments. Blocking places
a constraint on the randomization, since within each block of units, exactly
one unit is randomly assigned to each of the k treatments.

Hence a one way Anova design would use the R command sample(n)

and the first b units would be assigned to treatment 1, the second b units to

248
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treatment 2, ... and the last b units would be assigned to treatment k.
For the completely randomized block designs described in the following

section, the command sample(k) is done b times: once for each block. The
ith command is for the units of the ith block. If k = 5 and the sample(5)

command yields 2 5 3 1 4, then the 2nd unit in the ith block is assigned
to treatment 1, the 5th unit to treatment 2, the 3rd unit to treatment 3, the
1st unit to treatment 4 and the 4th unit to treatment 5.

Remark 7.1. Blocking and randomization often makes the iid error
assumption hold to a useful approximation.

For example, if grain is planted in n plots of land, yields tend to be similar
(correlated) in adjacent identically treated plots, but the yields from all of
the plots vary greatly, and the errors are not iid. If there are 4 treatments
and blocks of 4 adjacent plots, then randomized blocking makes the errors
approximately iid.

7.1 One Way Block Designs

Definition 7.2. For the one way block design or completely random-
ized block design (CRBD), there is a factor A with k levels and there are
b blocks. The CRBD model is

Yij = µij + eij = µ+ τi + βj + eij

where τi is the ith treatment effect and
∑k

i=1 τi = 0, βj is the jth block effect

and
∑b

j=1 βj = 0. The indices i = 1, ..., k and j = 1, ..., b. Then

µi ≡ µio

b
=

1

b

b∑
j=1

(µ + τi + βj) = µ+ τi.

So the µi are all equal if the τi are all equal. The errors eij are iid with 0
mean and constant variance σ2.

Notice that the CRBD model is additive: there is no block treatment
interaction. The ANOVA table for the CRBD is like the ANOVA table for a
two way Anova main effects model. Shown below is a CRBD ANOVA table in
symbols. Sometimes “Treatment” is replaced by “Factor” or “Model.” Some-
times “Blocks” is replaced by the name of the blocking variable. Sometimes
“Error” is replaced by “Residual.”
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Source df SS MS F p-value
Blocks b-1 SSB MSB “Fblock” “pblock”
Treatment k-1 SSTR MSTR F0=MSTR/MSE pval for Ho
Error (k − 1)(b− 1) SSE MSE

Be able to perform the 4 step completely randomized block
design ANOVA F test of hypotheses. This test is similar to the fixed
effects one way Anova F test.
i) Ho: µ1 = µ2 = · · · = µk and HA: not Ho.
ii) Fo = MSTR/MSE is usually given by output.
iii) The p-value = P(Fk−1,(k−1)(b−1) > Fo) is usually given by output.
iv) If the p–value< δ, reject Ho and conclude that the mean response depends
on the level of the factor. Otherwise fail to reject Ho and conclude that the
mean response does not depend on the level of the factor. Give a nontechnical
sentence.

Rule of thumb 7.1. If pblock ≥ 0.1, then blocking was not useful. If
0.05 ≤ pblock < 0.1, then the usefulness was borderline. If pblock < 0.05, then
blocking was useful.

Remark 7.2. The response, residual and transformation plots are almost
used in the same way as for the one and two way Anova model, but all of
the dot plots have sample size m = 1. Look for the plotted points falling in
roughly evenly populated bands about the identity line and r = 0 line.

Definition 7.3. The block response scatterplot plots blocks versus
the response. The plot will have b dot plots of size k with a symbol corre-
sponding to the treatment. Dot plots with clearly different means suggest
that blocking was useful. A symbol pattern within the blocks suggests that
the response depends on the factor.

Definition 7.4. Graphical Anova for the CRBD model uses the resid-
uals as a reference set instead of a F distribution. The scaled treatment
deviations

√
b− 1(Y i0 − Y 00) have about the same variability as the residu-

als if Ho is true. The scaled block deviations
√
k − 1(Y 0j − Y 00) also have

about the same variability as the residuals if blocking is ineffective. A dot
plot of the scaled block deviations is placed above the dot plot of the scaled
treatment deviations which is placed above the dot plot of the residuals. For
small n ≤ 40, suppose the distance between two scaled deviations (A and B,
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say) is greater than the range of the residuals = max(rij) − min(rij). Then
declare µA and µB to be significantly different. If the distance is less than
the range, do not declare µA and µB to be significantly different. Scaled
deviations that lie outside the range of the residuals are significant: the cor-
responding treatment means are significantly different from the overall mean.

For n ≥ 100, let r(1) ≤ r(2) ≤ · · · ≤ r(n) be the order statistics of the
residuals. Then instead of the range, use r(�0.975n�)−r(�0.025n�) as the distance
where �x� is the smallest integer ≥ x, eg �7.7� = 8. So effects outside of the
interval (r(�0.025n�), r(�0.975n�)) are significant. See Box, Hunter and Hunter
(2005, p. 150-151).

Output for Example 7.2.

Df Sum Sq Mean Sq F value Pr(>F)

block 3 79308210 26436070 54.310 4.348e-06

treatment 3 1917416 639139 1.313 0.3292

Residuals 9 4380871 486763

> ganova2(x,block,y) scaled block deviations

-3790.377 4720.488 2881.483 -3811.594

block 1 2 3 4

scaled treatment deviations

-266.086 -833.766 733.307 366.545

Treatments "A" "B" "C" "D"

Example 7.2. Ledolter and Swersey (2007, p. 60) give completely ran-
domized block design data. The block variable = market had 4 levels (1
Binghamton, 2 Rockford, 3 Albuquerque, 4 Chattanooga) while the treat-
ment factor had 4 levels (A no advertising, B $6 million, C $12 million, D
$18 million advertising dollars in 1973). The response variable was average
cheese sales (in pounds per store) sold in a 3 month period.

a) From the graphical Anova in Figure 7.1, were the blocks useful?
b) Perform an appropriate 4 step test for whether advertising helped

cheese sales.

Solution: a) In Figure 7.1, the top dot plot is for the scaled block de-
viations. The leftmost dot corresponds to blocks 4 and 1, the middle dot
to block 3 and the rightmost dot to block 1 (see output from the regpack
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Figure 7.1: Graphical Anova for a One Way Block Design

function ganova2). Yes, the blocks were useful since some (actually all) of
the dots corresponding to the scaled block deviations fall outside the range
of the residuals. This result also agrees with pblock = 4.348e–06 < 0.05.

b) i) Ho: µ1 = µ2 = µ3 = µ4 HA: not Ho
ii) Fo = 1.313
iii) pval = 0.3292
iv) Fail to reject Ho, the mean sales does not depend on advertising level.

In Figure 7.1, the middle dot plot is for the scaled treatment deviations.
From left to right, these correspond to B, A, D and C since the output shows
that the deviation corresponding to C is the largest with value 733.3. Since
the four scaled treatment deviations all lie within the range of the residuals,
the four treatments again do not appear to be significant.

Example 7.3. Snedecor and Cochran (1967, p. 300) give a data set with
5 types of soybean seed. The response frate = number of seeds out of 100
that failed to germinate. Five blocks were used. On the following page is a
block response plot where A, B, C, D and E refer to seed type. The 2 in the
second block indicates that A and C both had values 10. Which type of seed
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frate Block Response Plot for Example 7.3

-
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+------+------+------+------+------+--block
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has the highest germination failure rate?
a) A b) B c) C d) D e) E

Solution: a) A since A is on the top for blocks 2–5 and second for block
1. (The Bs and Es suggest that there may be a block treatment interaction.)

7.2 Blocking with the K Way Anova Design

Blocking is used to reduce the MSE so that inference such as tests and
confidence intervals are more precise. On the following page is a partial
Anova table for a k way Anova design with one block where the degrees of
freedom are left blank. For A, use H0 : µ10···0 = µ20···0. The other main effects
have similar null hypotheses. For interaction, use H0 : no interaction.

These models get complex rapidly as k and the number of levels li in-
crease. As k increases, there are a large number of models to consider. For
experiments, usually the 3 way and higher order interactions are not signif-
icant. Hence a full model that includes the blocks, all k main effects and
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all
(

k
2

)
two way interactions is a useful starting point for response, residual

and transformation plots. The higher order interactions can be treated as
potential terms and checked for significance. As a rule of thumb, significant
interactions tend to involve significant main effects.

Source df SS MS F p-value
block SSblock MSblock “Fblock” “pblock”

k main effects eg SSA = MSA FA pA(
k
2

)
2 way interactions eg SSAB = MSAB FAB pAB(

k
3

)
3 way interactions eg SSABC = MSABC FABC pABC

...
...

...
...

...(
k

k−1

)
k − 1 way interactions

the k way interaction SSA· · ·L = MSA· · ·L FA···L pA···L
Error SSE MSE

The following example has one block and 3 factors. Hence there are 3
two way interactions and 1 three way interaction.

Source df SS MS F pvalue

block 1 0.1334 0.1334 4.85 0.0379

L 3 0.0427 0.0142 0.5164 0.6751

M 2 0.0526 0.0263 0.9564 0.3990

P 1 0.5355 0.5355 19.47 0.0002

LM 6 0.2543 0.0424 1.54 0.2099

LP 3 0.2399 0.0800 2.91 0.0562

MP 2 0.0821 0.0410 1.49 0.2463

LMP 6 0.0685 0.0114 0.4145 0.8617

error 23 0.6319 0.0275

Example 7.4. Snedecor and Cochran (1967, p. 361-364) describe a
block design (2 levels) with three factors: food supplements Lysine (4 lev-
els), Methionine (3 levels) and Protein (2 levels). Male pigs were fed the
supplements in a 4× 3× 2 factorial arrangement and the response was aver-
age daily weight gain. The ANOVA table is shown above. The model could
be described as Yijkl = µijkl + eijkl for i = 1, 2, 3, 4; j = 1, 2, 3; k = 1, 2 and
l = 1, 2 where i, j, k are for L,M,P and l is for block. Note that µi000 is the
mean corresponding to the ith level of L.
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a) There were 24 pigs in each block. How were they assigned to the 24 =
4 × 3 × 2 runs (a run is a L,M,P combination forming a pig diet)?

b) Was blocking useful?
c) Perform a 4 step test for the significant main effect.
d) Which, if any, of the interactions were significant?

Solution: a) Randomly.
b) Yes, 0.0379 < 0.05.
c) H0 µ0010 = µ0020 HA not H0

FP = 19.47
pval = 0.0002
Reject H0, the mean weight gain depends on the protein.
d) None.

Remark 7.3. There are 3 basic principles of DOE. Randomization,
factorial crossing and blocking can be used to create many DOE models.

i) Use randomization to assign units to treatments.
ii) Use factorial crossing to compare the effects of 2 or more factors in

the same experiment: if A1, A2, ..., Ak are the k factors where the ith factor
Ai has li levels, then there are (l1)(l2) · · · (lk) treatments where a treatment
has one level from each factor.

iii) Use blocking to increase precision. Divide units into blocks of similar
homogeneous units where “similar” implies that the units are likely to have
similar values of the response if given the same treatment. Within each block,
randomly assign units to treatments.

7.3 Latin Square Designs

Latin square designs have a lot of structure. The design contains a row block
factor, a column block factor and a treatment factor, each with a levels. The
two blocking factors and the treatment factor are crossed, but it is assumed
that there is no interaction. A capital letter is used for each of the a treatment
levels. So a = 3 uses A,B,C while a = 4 uses A,B,C,D.

Definition 7.5. In an a × a Latin square, each letter appears exactly
once in each row and in each column. A standard Latin square has letters
written in alphabetical order in the first row and in the first column.
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Five Latin squares are shown below. The first, third and fifth are stan-
dard. If a = 5, there are 56 standard Latin squares.

A B C A B C A B C D A B C D E A B C D E

B C A C A B B A D C E A B C D B A E C D

C A B B C A C D A B D E A B C C D A E B

D C B A C D E A B D E B A C

B C D E A E C D B A

Definition 7.6. The model for the Latin square design is

Yijk = µ + τi + βj + γk + eijk

where τi is the ith treatment effect, βj is the jth row block effect, γk is the
kth column block effect with i, j and k = 1, ..., a. The errors eijk are iid with
0 mean and constant variance σ2. The ith treatment mean µi = µ + τi.

Shown below is an ANOVA table for the Latin square model given in
symbols. Sometimes “Error” is replaced by “Residual,” or “Within Groups.”
Sometimes rblocks and cblocks are replaced by the names of the blocking
factors. Sometimes “p-value” is replaced by “P”, “Pr(> F )” or “PR > F.”

Source df SS MS F p-value
rblocks a− 1 “SSRB” “MSRB” “Frow” “prow”
cblocks a− 1 “SSCB” “MSCB” “Fcol” “pcol”

treatments a− 1 SSTR MSTR Fo=MSTR/MSE pval
Error (a− 1)(a− 2) SSE MSE

Rule of thumb 7.2. Let pblock be prow or pcol. If pblock ≥ 0.1, then
blocking was not useful. If 0.05 ≤ pblock < 0.1, then the usefulness was
borderline. If pblock < 0.05, then blocking was useful.

Be able to perform the 4 step Anova F test for the Latin square
design. This test is similar to the fixed effects one way Anova F test.
i) Ho: µ1 = µ2 = · · · = µa and HA: not Ho.
ii) Fo = MSTR/MSE is usually given by output.
iii) The p-value = P(Fa−1,(a−1)(a−2) > Fo) is usually given by output.
iv) If the p–value< δ, reject Ho and conclude that the mean response depends
on the level of the factor. Otherwise fail to reject Ho and conclude that the
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mean response does not depend on the level of the factor. Give a nontechnical
sentence. Use δ = 0.05 if δ is not given.

Remark 7.4. The response, residual and transformation plots are almost
used in the same way as for the one and two way Anova models, but all of
the dot plots have sample size m = 1. Look for the plotted points falling in
roughly evenly populated bands about the identity line and r = 0 line.

Source df SS MS F P

rblocks 3 774.335 258.1117 2.53 0.1533

cblocks 3 133.425 44.4750 0.44 0.7349

fertilizer 3 1489.400 496.4667 4.87 0.0476

error 6 611.100 101.8500

Example 7.5. Dunn and Clark (1974, p. 129) examine a study of four
fertilizers on yields of wheat. The row blocks were 4 types of wheat. The
column blocks were 4 plots of land. Each plot was divided into 4 subplots
and a Latin square design was used. (Ignore the fact that the data had an
outlier.)

a) Were the row blocks useful? Explain briefly.

b) Were the column blocks useful? Explain briefly.

c) Do an appropriate 4 step test.

Solution:
a) No, prow = 0.1533 > 0.1.
b) No, pcol = 0.7349 > 0.1.
c) i) H0 µ1 = µ2 = µ3 = µ4 HA not H0

ii) F0 = 4.87
iii) pval = 0.0476
iv) Reject H0. The mean yield depends on the fertilizer.

Remark 7.5. The Latin square model is additive, but the model is often
incorrectly used to study “nuisance factors” that can interact. Factorial or
fractional factorial designs should be used when interaction is possible.

Remark 7.6. The randomization is done in 3 steps. Draw 3 random
permutations of 1, ..., a. Use the 1st permutation to randomly assign row
block levels to the numbers 1, ..., a. Use the 2nd permutation to randomly
assign column block levels to the numbers 1, ..., a. Use the 3rd permutation
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to randomly assign treatment levels to the 1st a letters (A, B, C and D if
a = 4).

Example 7.6. In the social sciences, often a blocking factor is time: the
levels are a time slots. Following Cobb (1998, p. 254), a Latin square design
was used to study the response Y = blood sugar level, where the row blocks
were 4 rabbits, the column blocks were 4 time slots, and the treatments were
4 levels of insulin. Label the rabbits as I, II, III and IV; the dates as 1, 2, 3,
4; and the 4 insulin levels i1 < i2 < i3 < i4 as 1, 2, 3, 4. Suppose the random
permutation for the rabbits was 3, 1, 4, 2; the permutation for the dates 1,
4, 3, 2; and the permutation for the insulin levels was 2, 3, 4, 1. Then i2
is treatment A, i3 is treatment B, i4 is treatment C and i1 is treatment D.
Then the data are as shown below on the left. The data is rearranged for
presentation on the right.

raw data presentation data

date date

rabbit 4/23 4/27 4/26 4/25 rabbit 4/23 4/25 4/26 4/27

III 57A 45B 60C 26D I 24B 46C 34D 48A

I 24B 48A 34D 46C II 33D 58A 57B 60C

IV 46C 47D 61A 34B III 57A 26D 60C 45B

II 33D 60C 57B 58A IV 46C 34B 61A 47D

Example 7.7. Following Cobb (1998, p. 255), suppose there is a rect-
angular plot divided into 5 rows and 5 columns to form 25 subplots. There
are 5 treatments which are 5 varieties of a plant, labelled 1, 2, 3, 4, 5; and
the response Y is yield. Adjacent subplots tend to give similar yields under
identical treatments, so the 5 rows form the row blocks and the 5 columns
form the column blocks. To perform randomization, three random permuta-
tions are drawn. Shown on the following page are 3 Latin squares. The one
on the left is an unrandomized Latin square.

Suppose 2, 4, 3, 5, 1 is the permutation drawn for rows. The middle
Latin square with randomized rows has 1st row which is the 2nd row from
the original unrandomized Latin square. The middle square has 2nd row
that is the 4th row from the original, the 3rd row is the 3rd row from the
original, the 4th row is the 5th row from the original, and the 5th row is the
1st row from the original.
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unrandomized randomized rows randomized Latin square

rows columns rows columns rows columns

1 2 3 4 5 1 2 3 4 5 1 4 2 5 3

1 A B C D E 2 B C D E A 2 B E C A D

2 B C D E A 4 D E A B C 4 D B E C A

3 C D E A B 3 C D E A B 3 C A D B E

4 D E A B C 5 E A B C D 5 E C A D B

5 E A B C D 1 A B C D E 1 A D B E C

Suppose 1, 4, 2, 5, 3 is the permutation drawn for columns. Then the
randomized Latin square on the right has 1st column which is the 1st column
from the middle square, the 2nd column is the 4th column from the middle
square, the 3rd column is the 2nd column from the middle square, the 4th
column is the 5th column from the middle square, and the 5th column is the
3rd column from the middle square.

Suppose 3, 2, 5, 4, 1 is the permutation drawn for variety. Then variety
3 is treatment A, 2 is B, 5 is C , 4 is D and variety 1 is E. Now sow each
subplot with the variety given by the randomized Latin square on the right.
Hence the northwest corner gets B = variety 2, the northeast corner gets
D = variety 4, the southwest corner gets A = variety 3, the southeast corner
gets C = variety 5, et cetera.

7.4 Summary

1) A block is a group of similar (homogeneous) units in that the units in a
block are expected to give similar values of the response if given the same
treatment.

2) In agriculture, adjacent plots of land are often used as blocks since
adjacent plots tend to give similar yields. Litter mates, siblings, twins, time
periods (eg different days) and batches of material are often used as blocks.

3) The completely randomized block design with k treatments and b blocks
of k units uses randomization within each block to assign exactly one of the
block’s k units to each of the k treatments. This design is a generalization
of the matched pairs procedure.

4) The Anova F test for the completely randomized block design with k
treatments and b blocks is nearly the same as the fixed effects one way Anova
F test.
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i) Ho: µ1 = µ2 = · · · = µk and HA: not Ho.
ii) Fo = MSTR/MSE is usually given by output.
iii) The p-value = P(Fk−1,(k−1)(b−1) > Fo) is usually given by output.
iv) If the p–value< δ, reject Ho and conclude that the mean response depends
on the level of the factor. Otherwise fail to reject Ho and conclude that the
mean response does not depend on the level of the factor. Give a nontechnical
sentence.

5) Shown below is an ANOVA table for the completely randomized block
design.

Source df SS MS F p-value
Blocks b-1 SSB MSB “Fblock” “pblock”
Treatment k-1 SSTR MSTR F0=MSTR/MSE pval for Ho
Error (k − 1)(b− 1) SSE MSE

6) Rule of thumb: If pblock ≥ 0.1, then blocking was not useful. If 0.05 ≤
pblock < 0.1, then the usefulness was borderline. If pblock < 0.05, then blocking
was useful.

7) The response, residual and transformation plots are used almost in the
same way as for the one and two way Anova model, but all of the dot plots
have sample size m = 1. Look for the plotted points falling in roughly evenly
populated bands about the identity line and r = 0 line.

8) The block response scatterplot plots blocks versus the response.
The plot will have b dot plots of size k with a symbol corresponding to
the treatment. Dot plots with clearly different means suggest that blocking
was useful. A symbol pattern within the blocks suggests that the response
depends on the factor.

9) Shown is an ANOVA table for the Latin square model given in sym-
bols. Sometimes “Error” is replaced by “Residual,” or “Within Groups.”
Sometimes rblocks and cblocks are replaced by the blocking factor name.
Sometimes “p-value” is replaced by “P”, “Pr(> F )” or “PR > F.”

Source df SS MS F p-value
rblocks a− 1 “SSRB” “MSRB” “Frow” “prow”
cblocks a− 1 “SSCB” “MSCB” “Fcol” “pcol”

treatments a− 1 SSTR MSTR Fo=MSTR/MSE pval
Error (a− 1)(a− 2) SSE MSE
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10) Let pblock be prow or pcol. Rule of thumb: If pblock ≥ 0.1, then blocking
was not useful. If 0.05 ≤ pblock < 0.1, then the usefulness was borderline. If
pblock < 0.05, then blocking was useful.

11) The Anova F test for the Latin square design with a treatments is
nearly the same as the fixed effects one way Anova F test.
i) Ho: µ1 = µ2 = · · · = µa and HA: not Ho.
ii) Fo = MSTR/MSE is usually given by output.
iii) The p-value = P(Fa−1,(a−1)(a−2) > Fo) is usually given by output.
iv) If the p–value< δ, reject Ho and conclude that the mean response depends
on the level of the factor. Otherwise fail to reject Ho and conclude that the
mean response does not depend on the level of the factor. Give a nontechnical
sentence.

12) The response, residual and transformation plots are almost used in
the same way as for the one and two way Anova models, but all of the dot
plots have sample size m = 1. Look for the plotted points falling in roughly
evenly populated bands about the identity line and r = 0 line.

13) The randomization is done in 3 steps. Draw 3 random permutations
of 1, ..., a. Use the 1st permutation to randomly assign row block levels to
the numbers 1, ..., a. Use the 2nd permutation to randomly assign column
block levels to the numbers 1, ..., k. Use the 3rd permutation to randomly
assign treatment levels to the 1st a letters (A, B, C and D if a = 4).

14) Graphical Anova for the completely randomized block design
makes a dotplot of the scaled block deviations β̃j =

√
k − 1β̂j =

√
k − 1(y0j0−

y000) on top, a dotplot of scaled treatment deviations (effects) α̃i =
√
b− 1α̂i =√

b− 1(yi00−y000) in the middle and a dotplot of the residuals on the bottom.
Here k is the number of treatments and b is the number of blocks.

15) Graphical Anova uses the residuals as a reference distribution. Sup-
pose the dotplot of the residuals looks good. Rules of thumb: i) An effect is
marginally significant if its scaled deviation is as big as the biggest residual
or as negative as the most negative residual. ii) An effect is significant if it is
well beyond the minimum or maximum residual. iii) Blocking was effective
if at least one scaled block deviation is beyond the range of the residuals. iv)
The treatments are different if at least one scaled treatment effect is beyond
the range of the residuals. (These rules depend on the number of residuals
n. If n is very small, say 8, then the scaled effect should be well beyond
the range of the residuals to be significant. If the n is 40, the value of the
minimum residual and the value of the maximum residual correspond to a
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1/40 + 1/40 = 1/20 = 0.05 critical value for significance.)

7.5 Complements

Box, Hunter and Hunter (2005, p. 150-156) explain Graphical Anova for the
CRBD and why randomization combined with blocking often makes the iid
error assumption hold to a reasonable approximation.

The R package granova may be useful for graphical Anova. It is avail-
able from (http://streaming.stat.iastate.edu/CRAN/) and authored by R.M.
Pruzek and J.E. Helmreich. Also see Hoaglin, Mosteller, and Tukey (1991).

Matched pairs tests are a special case of CRBD with k = 2.
A randomization test has H0: the different treatments have no effect.

This null hypothesis is also true if within each block, all k pdfs are from the
same location family. Let j = 1, ..., b index the b blocks. There are b pdfs, one
for each block, that come from the same location family but possibly different
location parameters: fZ(y−µ0j). Let A be the treatment factor with k levels
ai. Then Yij|(A = ai) ∼ fZ(y − µ0j) where j is fixed and i = 1, ..., k. Thus
the levels ai have no effect on the response, and the Yij are iid within each
block if H0 holds. Note that there are k! ways to assign Y1j, ...Ykj to the
k treatments within each block. An impractical randomization test uses
all M = [k!]b ways of assigning responses to treatments. Let F0 be the
usual CRBD F statistic. The F statistic is computed for each of the M
permutations and H0 is rejected if the proportion of the M F statistics that
are larger than F0 is less than δ. The distribution of the M F statistics is
approximately Fk−1,(k−1)(b−1) for large n under H0. The randomization test
and the usual CBRD F test also have the same power, asymptotically. See
Hoeffding (1952) and Robinson (1973). These results suggest that the usual
CRBD F test is semiparametric: the pvalue is approximately correct if n is
large and if all k pdfs Yij |(A = ai) ∼ fZ(y− µ0j) are the same for each block
where j is fixed and i = 1, ..., k. If H0 does not hold, then there are kb pdfs
Yij|(A = ai) ∼ fZ(y−µij) from the same location family. Hence the location
parameter depends on both the block and treatment.

Olive (2009b) shows that practical randomization tests that use a random
sample of max(1000, [n log(n)]) randomizations have level and power similar
to the tests that use all M possible randomizations. Here each “randomiza-
tion” uses b randomly drawn permutations of 1, ..., k.

Hunter (1989) discusses some problems with the Latin square design.
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7.6 Problems

Problems with an asterisk * are especially important.

Output for 7.1.

source Df Sum Sq Mean Sq F value Pr(>F)

block 4 49.84 12.46 2.3031 0.10320

seed 4 83.84 20.96 3.8743 0.02189

Residuals 16 86.56 5.41

7.1. Snedecor and Cochran (1967, p. 300) give a data set with 5 types
of soybean seed. The response frate = number of seeds out of 100 that failed
to germinate. Five blocks were used. Assume the appropriate model can be
used (although this assumption may not be valid due to a possible interaction
between the block and the treatment).

a) Did blocking help? Explain briefly.

b) Perform the appropriate 4 step test using the output above.

Output for 7.2.

Source df SS MS F P

blocks 3 197.004 65.668 9.12 0.001

treatment 5 201.316 40.263 5.59 0.004

error 15 108.008 7.201

7.2. Current nitrogen fertilization recommendations for wheat include
applications of specified amounts at specified stages of plant growth. The
treatment consisted of six different nitrogen application and rate schedules.
The wheat was planted in an irrigated field that had a water gradient in one
direction as a result of the irrigation. The field plots were grouped into four
blocks, each consisting of six plots, such that each block occurred in the same
part of the water gradient. The response was the observed nitrogen content
from a sample of wheat stems from each plot. The experimental units were
the 24 plots. Data is from Kuehl (1994, p. 263).

a) Did blocking help? Explain briefly.

b) Perform the appropriate 4 step test using the output above.
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7.3. An experimenter wants to test 4 types of an altimeter. There are
eight helicopter pilots available for hire with from 500 to 3000 flight hours
of experience. The response variable is the altimeter reading error. Perform
the appropriate 4 step test using the output below. Data is from Kirk (1982,
p. 244).

Output for Problem 7.3

Source df SS MS F P

treatment 3 194.50 64.833 47.78 0.000

blocks 7 12.50 1.786 1.32

error 21 28.50 1.357

One way randomized block designs in SAS, Minitab and R

7.4. This problem is for a one way block design and uses data from Box,
Hunter and Hunter (2005, p. 146).

a) Copy and paste the SAS program for this problem from
(www.math.siu.edu/olive/reghw.txt). Print out the output but only turn in
the Anova table, residual plot and response plot.

b) Do the plots look ok?
c) Copy the SAS data into Minitab much as done for Problem 6.4. Right

below C1 type “block”, below C2 type “treat” and below C3 type “yield”.
d) Select Stat>ANOVA>Two-way, select “C3 yield” as the response and

“C1 block” as the row factor and “C2 treat” as the column factor. Click
on “Fit additive model,” click on “Store residuals” and click on “Store fits.”
Then click on “OK.”

e) block response scatterplot: Use file commands “Edit>Command
Line Editor” and write the following lines in the window.
GSTD
LPLOT ’yield’ vs ’block’ codes for ’treat’

f) Click on the submit commands box and print the plot. Click on the
output and then click on the printer icon.

g) Copy (www.math.siu.edu/olive/regdata.txt) into R.
Type the following commands to get the following Anova table.

z<-aov(yield~block+treat,pen)

summary(z)
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Df Sum Sq Mean Sq F value Pr(>F)

block 4 264.000 66.000 3.5044 0.04075 *

treat 3 70.000 23.333 1.2389 0.33866

Residuals 12 226.000 18.833

h) Did blocking appear to help?
i) Perform a 4 step F test for whether yield depends on treatment.

Latin Square Designs in SAS and R
(Latin square designs can be fit by Minitab, but not with Students’ version

of Minitab.)

7.5. This problem is for a Latin square design and uses data from Box,
Hunter and Hunter (2005, p. 157-160).

Copy and paste the SAS program for this problem from
(www.math.siu.edu/olive/reghw.txt).

a) Click on the output and use the menu commands “Edit>Select All”
and “Edit>Copy. In Word use the menu commands “Edit>Paste” then use
the left mouse button to highlight the first page of output. Then use the menu
command “Edit>Cut.” Then there should be one page of output including
the Anova table. Print out this page.

b) Copy the data for this problem from
(www.math.siu.edu/olive/regdata.txt)
into R. Use the following commands to create a residual plot. Copy and paste
the plot into Word. (Click on the plot and simultaneously hit the Ctrl and c
buttons. Then go to Word and use the menu commands “Edit>Paste.”)

z<-aov(emissions~rblocks+cblocks+additives,auto)

summary(z)

plot(fitted(z),resid(z))

title("Residual Plot")

abline(0,0)

c) Use the following commands to create a response plot. Copy and paste
the plot into Word. (Click on the plot and simultaneously hit the Ctrl and c
buttons. Then go to Word and use the menu commands “Edit>Paste.”)

attach(auto)

FIT <- auto$emissions - z$resid
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plot(FIT,auto$emissions)

title("Response Plot")

abline(0,1)

detach(auto)

d) Do the plots look ok?

e) Were the column blocks useful? Explain briefly.

f) Were the row blocks useful? Explain briefly.

g) Do an appropriate 4 step test.

7.6. Obtain the Box, Hunter and Hunter (2005, p. 146) penicillin data
from (www.math.siu.edu/olive/regdata.txt) and the R program ganova2 from
(www.math.siu.edu/olive/regpack.txt). The program does graphical Anova
for completely randomized block designs.

a) Enter the following commands and include the plot in Word by si-
multaneously pressing the Ctrl and c keys, then using the menu commands
“Copy>Paste” in Word.

attach(pen)

ganova2(pen$treat,pen$block,pen$yield)

detach(pen)

b) Blocking seems useful because some of the scaled block deviations are
outside of the spread of the residuals. The scaled treatment deviations are in
the middle of the plot. Do the treatments appear to be significantly different?



Chapter 8

Orthogonal Designs

Orthogonal designs for factors with two levels can be fit using least squares.
The orthogonality of the contrasts allows each coefficient to be estimated
independently of the other variables in the model.

This chapter covers 2k factorial designs, 2k−f
R fractional factorial designs

and Plackett Burman PB(n) designs. The entries in the design matrix X
are either −1 or 1. The columns of the design matrix X are orthogonal:
cT

i cj = 0 for i �= j where ci is the ith column of X. Also cT
i ci = n, and the

absolute values of the column entries sum to n.
The first column of X is 1, the vector of ones, but the remaining columns

of X are the coefficients of a contrast. Hence the ith column ci has entries
that are −1 or 1, and the entries of the ith column ci sum to 0 for i > 1.

8.1 Factorial Designs

Factorial designs are a special case of the k way Anova designs of Chapter 6,
and these designs use factorial crossing to compare the effects (main effects,
pairwise interactions, ..., k-fold interaction) of the k factors. If A1, ..., Ak are
the factors with li levels for i = 1, ..., k; then there are l1l2 · · · lk treatments
where each treatment uses exactly one level from each factor. The sample
size n = m

∏k
i=1 li ≥ m 2k. Hence the sample size grows exponentially fast

with k. Often the number of replications m = 1.

Definition 8.1. An experiment has n runs where a run is used to
measure a response. A run is a treatment = a combination of k levels. So
each run uses exactly one level from each of the k factors.

267
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Often each run is expensive, for example, in industry and medicine. A
goal is to improve the product in terms of higher quality or lower cost. Often
the subject matter experts can think of many factors that might improve the
product. The number of runs n is minimized by taking li = 2 for i = 1, ..., k.

Definition 8.2. A 2k factorial design is a k way Anova design where
each factor has two levels: low = −1 and high = 1. The design uses n = m2k

runs. Often the number of replications m = 1. Then the sample size n = 2k.

A 2k factorial design is used to screen potentially useful factors. Usually
at least k = 3 factors are used, and then 23 = 8 runs are needed. Often
the units are time slots, and each time slot is randomly assigned to a run
= treatment. The subject matter experts should choose the two levels. For
example, a quantitative variable such as temperature might be set at 80oF
coded as −1 and 100oF coded as 1, while a qualitative variable such at type
of catalyst might have catalyst A coded as −1 and catalyst B coded as 1.

Improving a process is a sequential, iterative process. Often high values
of the response are desirable (eg yield), but often low values of the response
are desirable (eg number of defects). Industrial experiments have a budget.
The initial experiment may suggest additional factors that were omitted,
suggest new sets of two levels, and suggest that many initial factors were not
important or that the factor is important, but the level of the factor is not.

Suppose k = 5 and A,B,C,D and E are factors. Assume high response
is desired and high levels of A and C correspond to high response where A
is qualitative (eg 2 brands) and C is quantitative but set at two levels (eg
temperature at 80 and 100oF ). Then the next stage may use an experiment
with factor A at its high level and at a new level (eg a new brand) and
C at the highest level from the previous experiment and at a higher level
determined by subject matter experts (eg at 100 and 120oF ).

Rule of thumb 8.1. Do not spend more than 25% of the budget on the
initial experiment. It may be a good idea to plan for four experiments, each
taking 25% of the budget.

Definition 8.3. Recall that a contrast C =
∑p

i=1 diµi where
∑p

i=1 di =

0, and the estimated contrast is Ĉ =
∑p

i=1 diY i0 where µi and Y i0 are ap-
propriate population and sample means. In a table of contrasts, the co-
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efficients di of the contrast are given where a − corresponds to −1 and a +
corresponds to 1. Sometimes a column I corresponding to the overall mean
is given where each entry is a +. The column corresponding to I is not a
contrast.

To make a table of contrasts there is a rule for main effects and a rule for
interactions.

a) In a table of contrasts, the column for A starts with a − then a + and
the pattern repeats. The column for B starts with 2 −’s and then 2 +’s and
the pattern repeats. The column for C starts with 4 −’s and then 4 +’s and
the pattern repeats. The column for the ith main effects factor starts with
2i−1 −’s and 2i−1 +’s and the pattern repeats where i = 1, ..., k.

b) In a table of contrasts, a column for an interaction containing several
factors is obtained by multiplying the columns for each factor where + = 1
and − = −1. So the column for ABC is obtained by multiplying the column
for A, the column for B and the column for C.

A table of contrasts for a 23 design is shown below. The first column
is for the mean and is not a contrast. The last column corresponds to the
cell means. Note that y1110 = y111 if m = 1. So y might be replaced by
y if m = 1. Each row corresponds to a run. Only the levels of the main
effects A,B and C are needed to specify each run. The first row of the table
corresponds to the low levels of A,B and C . Note that the divisors are 2k−1

except for the divisor of I which is 2k where k = 3.

I A B C AB AC BC ABC y
+ − − − + + + − y1110

+ + − − − − + + y2110

+ − + − − + − + y1210

+ + + − + − − − y2210

+ − − + + − − + y1120

+ + − + − + − − y2120

+ − + + − − + − y1220

+ + + + + + + + y2220

divisor 8 4 4 4 4 4 4 4

The table of contrasts for a 24 design is below. The column of ones
corresponding to I was omitted. Again rows correspond to runs and the
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levels of the main effects A,B,C and D completely specify the run. The
first row of the table corresponds to the low levels of A,B, C and D. In
the second row, the level of A is high while B, C and D are low. Note that
the interactions are obtained by multiplying the component columns where
+ = 1 and − = −1. Hence the first row of the column corresponding to the
ABC entry is (−)(−)(−) = −.

run A B C D AB AC AD BC BD CD ABC ABD ACD BCD ABCD

1 - - - - + + + + + + - - - - +

2 + - - - - - - + + + + + + - -

3 - + - - - + + - - + + + - + -

4 + + - - + - - - - + - - + + +

5 - - + - + - + - + - + - + + -

6 + - + - - + - - + - - + - + +

7 - + + - - - + + - - - + + - +

8 + + + - + + - + - - + - - - -

9 - - - + + + - + - - - + + + -

10 + - - + - - + + - - + - - + +

11 - + - + - + - - + - + - + - +

12 + + - + + - + - + - - + - - -

13 - - + + + - - - - + + + - - +

14 + - + + - + + - - + - - + - -

15 - + + + - - - + + + - - - + -

16 + + + + + + + + + + + + + + +

Randomization for a 2k design: The runs are determined by the levels
of the k main effects in the table of contrasts. So a 23 design is determined
by the levels of A, B and C. Similarly, a 24 design is determined by the levels
of A, B, C and D. Randomly assign units to the m2k runs. Often the units
are time slots. If possible, perform the m2k runs in random order.

Genuine run replicates need to be used. A common error is to take m
measurements per run, and act as if the m measurements are from m runs.
If as a data analyst you encounter this error, average the m measurements
into a single value of the response.

Definition 8.4. If the response depends on the two levels of the factor,
then the factor is called active. If the response does not depend on the two
levels of the factor, then the factor is called inert.
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Active factors appear to change the mean response as the level of the
factor changes from −1 to 1. Inert factors do not appear to change the
response as the level of the factor changes from −1 to 1. An inert factor
could be needed but the level low or high is not important, or the inert
factor may not be needed and so can be omitted from future studies. Often
subject matter experts can tell whether the inert factor is needed or not.

The 2k designs are used for exploratory data analysis: they provide
answers to the following questions.

i) Which combinations of levels are best?
ii) Which factors are active and which are inert? That is, use the 2k

design to screen for factors where the response depends on whether the level
is high or low.

iii) How should the levels be modified to improve the response?

If all 2k runs give roughly the same response, then choose the levels that
are cheapest to increase profit. Also the system is robust to changes in the
factor space so managers do not need to worry about the exact values of the
levels of the factors.

In an experiment, there will be an interaction between management, sub-
ject matter experts (often engineers) and the data analyst (statistician).

Remark 8.1. If m = 1, then there is one response per run but k main
effects,

(
k
2

)
2 factor interactions,

(
k
j

)
j factor interactions, and 1 k way in-

teraction. Then the MSE df = 0 unless at least one high order interaction
is assumed to be zero. A full model that includes all k main effects and
all

(
k
2

)
two way interactions is a useful starting point for response, residual

and transformation plots. The higher order interactions can be treated as
potential terms and checked for significance. As a rule of thumb, significant
interactions tend to involve significant main effects.

Definition 8.5. An outlier corresponds to a case that is far from the
bulk of the data.

Rule of thumb 8.2. Mentally add 2 lines parallel to the identity line
and 2 lines parallel to the r = 0 line that cover most of the cases. Then a
case is an outlier if it is well beyond these 2 lines. This rule often fails for
large outliers since often the identity line goes through or near a large outlier
so its residual is near zero. A response that is far from the bulk of the data
in the response plot is a “large outlier” (large in magnitude).
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Rule of thumb 8.3. Often an outlier is very good, but more often an
outlier is due to a measurement error and is very bad.

Definition 8.6. A critical mix is a single combination of levels, out of
2k, that gives good results. Hence a critical mix is a good outlier.

Be able to pick out active and inert factors and good (or the best) combi-
nations of factors (cells or runs) from the table of contrasts = table of runs.
Often the table will only contain the contrasts for the main effects. If high
values of the response are desirable, look for high values of y for m > 1. If
m = 1, then y = y. The following two examples help illustrate the process.

O H C y
− − − 5.9
+ − − 4.0
− + − 3.9
+ + − 1.2
− − + 5.3
+ − + 4.8
− + + 6.3
+ + + 0.8

Example 8.1. Box, Hunter and Hunter (2005, p. 209-210) describes a 23

experiment with the goal of reducing the wear rate of deep groove bearings.
Here m = 1 so n = 8 runs were used. The 23 design employed two levels
of osculation (O), two levels of heat treatment (H), and two different cage
designs (C). The response Y is the bearing failure rate and low values of the
observed response y are better than high values.

a) Which two combinations of levels are the best?
b) If two factors are active, which factor is inert?

Solution: a) The two lowest values of y are 0.8 and 1.2 which correspond
to +++ and ++−. (Note that if the 1.2 was 4.2, then +++ corresponding
to 0.8 would be a critical mix.)

b) C would be inert since O and H should be at their high + levels.
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run R T C D y
1 − − − − 14
2 + − − − 16
3 − + − − 8
4 + + − − 22
5 − − + − 19
6 + − + − 37
7 − + + − 20
8 + + + − 38
9 − − − + 1
10 + − − + 8
11 − + − + 4
12 + + − + 10
13 − − + + 12
14 + − + + 30
15 − + + + 13
16 + + + + 30

Example 8.2. Ledolter and Swersey (2007, p. 80) describes a 24 exper-
iment for a company that manufactures clay plots to hold plants. For one of
the company’s newest products, there had been an unacceptably high num-
ber of cracked pots. The production engineers believed that the following
factors are important: R = rate of cooling (slow or fast), T = kiln temper-
ature (2000oF or 2060oF), C = coefficient of expansion of the clay (low or
high), and D = type of conveyor belt (metal or rubberized) used to allow
employees to handle the pots. The response y is the percentage of cracked
pots per run (so small y is good).

a) For fixed levels of R, T and C, is the D+ level or D− level of D better
(compare run 1 with run 9, 2 with 10, ..., 8 with 16).

b) Fix D at the better level. Is the C− or C+ level better?
c) Fix C and D at the levels found in a) and b). Is the R− or R+ level

better?
d) Which factor seems to be inert?
Solution: a) D+ since for fixed levels of R, T and C , the number of cracks

is lower if D = + than if D = −.
b) C−
c) R− d) T .
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A 2k design can be fit with least squares. In the table of contrasts let
a “+ = 1” and a “− = −1.” Need a row for each response: can’t use the
mean response for each fixed combination of levels. Let x0 correspond to I ,
the column of 1s. Let xi correspond to the ith main effect for i = 1, ..., k.
Let xij correspond to 2 factor interactions, and let xi1,...,iG correspond to
G way interactions for G = 2, ..., k. Let the design matrix X have columns
corresponding to the x. Then X will have n = m2k rows. Let y be the
vector of responses.

The table below relates the quantities in the 23 table of contrasts with
the quantities used in least squares. The design matrix

X = [x0,x1,x2,x3,x12,x13,x23,x123].

Software often does not need the column of ones x0.

x0 x1 x2 x3 x12 x13 x23 x123 y
I A B C AB AC BC ABC y

The table below relates quantities in the 24 table of contrasts with the
quantities used in least squares. Again x0 corresponds to I , the column of
ones, while y is the vector of responses.
x1 x2 x3 x4 x12 x13 x14 x23 x24 x34 x123 x124 x134 x234 x1234

A B C D AB AC AD BC BD CD ABC ABD ACD BCD ABCD

Definition 8.7. The least squares model for a 2k design contains a
least squares population coefficient β for each x in the model. The model
can be written as Y = xT β + e with least squares fitted values Ŷ = xT β̂.
In matrix form the model is Y = Xβ + e and the vector of fitted values is
Ŷ = Xβ̂. The biggest possible model contains all of the terms. The second
order model contains β0, all main effects and all second order interactions,
and is recommended as the initial full model for k ≥ 4. The main effects
model removes all interactions. If a model contains an interaction, then the
model should also contain all of the corresponding main effects. Hence if a
model contains x123, the model should contain x1, x2 and x3.

Definition 8.8. The coefficient β0 corresponding to I is equal to the
population “I effect” of x0, and the (sample) I effect = β̂0. For an x other
than x0, the population effect for x is 2β, the change in Y as x changes two
units from −1 to 1, and the (sample) effect is 2β̂. The (sample) coefficient
β̂ estimates the population coefficient β.
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Suppose the model using all of the columns of X is used. If some columns
are removed (eg those corresponding to the insignificant effects), then for 2k

designs the following quantities remain unchanged for the terms that were
not deleted: the effects, the coefficients, SS(effect) = MS(effect). The MSE,
SE(effect), F and t statistics, pvalues, fitted values and residuals do change.

The regression equation corresponding to the significant effects (eg found
with a QQ plot of Definition 8.9) can be used to form a reduced model. For
example, suppose the full (least squares) fitted model is Ŷi = β̂0 + β̂1xi1 +
β̂2xi2 + β̂3xi3 + β̂12xi12 + β̂13xi13 + β̂23xi23 + β̂123xi123. Suppose the A, B and
AB effects are significant. Then the reduced (least squares) fitted model is
Ŷi = β̂0 + β̂1xi1 + β̂2xi2 + β̂12xi12 where the coefficients (β̂’s) for the reduced
model can be taken from the full model since the 2k design is orthogonal.

The coefficient β̂0 corresponding to I is equal to the I effect, but the
coefficient of a factor x corresponding to an effect is β̂ = 0.5 effect. Consider
significant effects and assume interactions can be ignored.

i) If a large response Y is desired and β̂ > 0, use x = 1. If β̂ < 0, use
x = −1.

ii) If a small response Y is desired and β̂ > 0, use x = −1. If β̂ < 0, use
x = 1.

Rule of thumb 8.4. To predict Y with Ŷ , the number of coefficients =
the number of β̂’s in the model should be ≤ n/2, where the sample size n =
number of runs. Otherwise the model is overfitting.

From the regression equation Ŷ = xT β̂, be able to predict Y given x. Be
able to tell whether x = 1 or x = −1 should be used. Given the x values
of the main effects, get the x values of the interactions by multiplying the
columns corresponding to the main effects.

Least squares output in symbols is shown on the following page. Often
“Estimate” is replaced by “Coef” or “Coefficient”. Often “Intercept” is re-
placed by “Constant”. The t statistic and pvalue are for whether the term
or effect is significant. So t12 and p12 are for testing whether the x12 term or
AB effect is significant.

The least squares coefficient = 0.5 (effect). The sum of squares for an x
corresponding to an effect is equal to SS(effect). SE(coef) = SE(β̂) = 0.5
SE(effect) =

√
MSE/n. Also SE(β̂0) =

√
MSE/n.
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Coef or Est. Std.Err t pvalue

Intercept or constant β̂0 SE(coef) t0 p0

x1 β̂1 SE(coef) t1 p1

x2 β̂2 SE(coef) t2 p2

x3 β̂3 SE(coef) t3 p3

x12 β̂12 SE(coef) t12 p12

x13 β̂13 SE(coef) t13 p13

x23 β̂23 SE(coef) t23 p23

x123 β̂123 SE(coef) t123 p123

Example 8.3. a) The biggest possible model for the 23 design is Y =
β0 + β1x1 + β2x2 + β3x3 + β12x12 + β13x13 + β23x23 + β123x123 + e with least
squares fitted or predicted values given by Ŷi = β̂0 + β̂1xi1 + β̂2xi2 + β̂3xi3 +
β̂12xi12 + β̂13xi13 + β̂23xi23 + β̂123xi123.

The second order model is Y = β0+β1x1 +β2x2 +β3x3+β12x12 +β13x13+
β23x23 + e. The main effects model is Y = β0 + β1x1 + β2x2 + β3x3 + e.

b) A typical least squares output for the 23 design is shown below. Often
“Estimate” is replaced by “Coef”.

Residual Standard Error=2.8284 = sqrt(MSE)

R-Square=0.9763 F-statistic (df=7, 8)=47.0536 p-value=0

Estimate Std.Err t-value Pr(>|t|)

Intercept 64.25 0.7071 90.8632 0.0000

x1 11.50 0.7071 16.2635 0.0000

x2 -2.50 0.7071 -3.5355 0.0077

x3 0.75 0.7071 1.0607 0.3198

x12 0.75 0.7071 1.0607 0.3198

x13 5.00 0.7071 7.0711 0.0001

x23 0.00 0.7071 0.0000 1.0000

x123 0.25 0.7071 0.3536 0.7328

c) i) The least squares coefficient or “estimate” = effect/2. So in the
above table, the A effect = 2(11.5) = 23. If x corresponds to the least
squares coefficient, then the coefficient = (xTy)/(xTx).

ii) The sum of squares = means square corresponding to an x is equal to



CHAPTER 8. ORTHOGONAL DESIGNS 277

the sum of squares = mean square of the corresponding effect. If x corre-
sponds to the least squares coefficient, then the SS = MS = (xT y)2/(xT x).

iii) Supposem ≥ 2. Then SE(coef) = SE(effect)/2 = 0.5
√
MSE/(m2k−2).

Hence in the above table, SE(effect) = 2(.7071) = 1.412.
iv) The t statistic t0 = coef/SE(coef), and t20 = F0 where t0 ≈ tdfe and

F0 ≈ F1,dfe where dfe = (m − 1)2k is the MSE df. Hence the pvalues for
least squares and the 2k software are the same. For example, the pvalue for
testing the significance of x1 = pvalue for testing significance of A effect =
0.000 in the above table. Also tA = 16.2635 and t2A = FA = 264.501.

v) The MSE, fitted values and residuals are the same for the least squares
output and the 2k software.

Suppose the two levels of the quantitative variable are a < b and x is

the actual value used. Then code x as c ≡ cx =
2x− (a + b)

b− a
. Note that

the code gives c = −1 for x = a and c = 1 for x = b. Thus if the 2
levels are a = 100 and b = 200 but x = 187 is observed, then code x as
c = [2(187) − (100 + 200)]/[200 − 100] = 0.74.

There are several advantages to least squares over 2k software. The dis-
advantage of the following four points is that the design will no longer be
orthogonal: the estimated coefficients β̂ and hence the estimated effects will
depend on the terms in the model. i) If there are several missing values or
outliers, delete the corresponding rows from the design matrix X and the
vector of responses y as long as the number of rows of the design matrix ≥
the number of columns. ii) If the exact quantitative levels are not observed,
replace them by the observed levels cx in the design matrix. iii) If the wrong
levels are used in a run, replace the corresponding row in the design ma-
trix by a row corresponding to the levels actually used. iv) The number of
replications per run i can be mi, that is, do not need mi ≡ m.

Definition 8.9. A normal QQ plot is a plot of the effects versus standard
normal percentiles. There are L = 2k − 1 effects for a 2k design.

Rule of thumb 8.5. The nonsignificant effects tend to follow a line
closely in the middle of the plot while the significant effects do not follow the
line closely. Significant effects will be the most negative or the most positive
effects.

Know how to find the effect, the standard error of the effect, the sum
of squares for an effect and a confidence interval for the effect from a table
of contrasts using the following rules.
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Let c be a column from the table of contrasts where + = 1 and − = −1.
Let y be the column of cell means. Then the effect corresponding to c is

effect =
cT y

2k−1
. (8.1)

If the number of replicationsm ≥ 2, then the standard error for the effect
is

SE(effect) =

√
MSE

m2k−2
. (8.2)

Sometimes MSE is replaced by σ̂2.

SE(mean) =

√
MSE

m2k
(8.3)

where m2k = n, m ≥ 2 and sometimes MSE is replaced by σ̂2.

The sum of squares for an effect is also the mean square for the effect
since df = 1.

MS(effect) = SS(effect) = m2k−2(effect)2 (8.4)

for m ≥ 1.

A 95% confidence interval (CI) for an effect is

effect± tdfe,0.975 SE(effect) (8.5)

where dfe is the MSE degrees of freedom. Use tdfe,0.975 ≈ z0.975 = 1.96 if
dfe > 30. The effect is significant if the CI does not contain 0, while the
effect is not significant if the CI contains 0.

Rule of thumb 8.6. Suppose there is no replication so m = 1. Find J
interaction mean squares that are small compared to the bulk of the mean
squares. Add them up to make MSE with dfe = J . So

MSE =
sum of small MS′s

J
.

This method uses data snooping and MSE tends to underestimate σ2. So
the F test statistics are too large and the pvalues too small. Use this method
for exploratory data analysis, not for inference based on the F distribution.
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Rule of thumb 8.7. MS(effect) = SS(effect) ≈ σ2χ2
1 ≈ MSEχ2

1 if the
effect is not significant. MSE ≈ σ2χ2

dfe
/dfe if the model holds. A rule of

thumb is that an effect is significant if MS > 5MSE. The rule comes from
the fact that χ2

1,0.975 ≈ 5.

Below is the Anova table for a 23 design. Suppose m = 1. For A, use
H0 : µ100 = µ200. For B, use H0 : µ010 = µ020. For C, use H0 : µ001 = µ002.
For interaction, use H0 : no interaction. If m > 1, the subscripts need an
additional 0, eg H0 : µ1000 = µ2000.

Source df SS MS F p-value
A 1 SSA MSA FA pA

B 1 SSB MSB FB pB

C 1 SSC MSC FC pC

AB 1 SSAB MSAB FAB pAB

AC 1 SSAC MSAC FAC pAC

BC 1 SSBC MSBC FBC pBC

ABC 1 SSABC MSA FABC pABC

Error (m− 1)2k SSE MSE

Following Rule of thumb 8.6, if m = 1, pool J interaction mean squares
that are small compared to the bulk of the data into an MSE with dfe = J .
Such tests are for exploratory purposes only: the MSE underestimates σ2,
so the F test statistics are too large and the pvalues = P (F1,J > F0) are too
small. For example F0 = FA = MSA/MSE. As a convention for using an
F table, use the denominator df closest to dfe = J , but if dfe = J > 30 use
denominator df = ∞.

Below is the Anova table for a 2k design. For A, use H0 : µ10···0 = µ20···0.
The other main effect have similar null hypotheses. For interaction, use H0 :
no interaction. If m = 1 use a procedure similar to Rule of Thumb 8.6 for
exploratory purposes.

One can use t statistics for effects with t0 =
effect

SE(effect)
≈ tdfe where dfe

is the MSE df. Then t20 = MS(effect)/MSE = F0 ≈ F1,dfe.
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Source df SS MS F p-value
k main effects 1 eg SSA = MSA FA pA(

k
2

)
2 factor interactions 1 eg SSAB = MSAB FAB pAB(

k
3

)
3 factor interactions 1 eg SSABC = MSABC FABC pABC

...
...

...
...

...(
k

k−1

)
k − 1 factor interactions

the k factor interaction 1 SSA· · ·L = MSA· · ·L FA···L pA···L
Error (m− 1)2k SSE MSE

I A B C AB AC BC ABC y
+ − − − + + + − 6.333
+ + − − − − + + 4.667
+ − + − − + − + 9.0
+ + + − + − − − 6.667
+ − − + + − − + 4.333
+ + − + − + − − 2.333
+ − + + − − + − 7.333
+ + + + + + + + 4.667

divisor 8 4 4 4 4 4 4 4

Example 8.4. Box, Hunter and Hunter (2005, p. 189) describes a 23

experiment designed to investigate the effects of planting depth (0.5 or 1.4
in.), watering (once or twice daily) and type of lima bean (baby or large)
on yield. The table of contrasts is shown above. The number of replications
m = 3.

a) Find the A effect.
b) Find the AB effect.
c) Find SSA = MSA.
d) Find SSAB = MSAB.
e) If MSE = 0.54, find SE(effect).
Solution: a) The A effect =

−6.333 + 4.667 − 9 + 6.667 − 4.333 + 2.333 − 7.333 + 4.667

4
= −8.665/4

= −2.16625. Note that the appropriate + and − signs are obtained from the
A column.
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Figure 8.1: QQ plot for Example 8.4

b) The AB effect =

6.333 − 4.667 − 9 + 6.667 + 4.333 − 2.333 − 7.333 + 4.667

4
= −1.333/4

= −0.33325.
c) SSA = m2k−2(effect)2 = 3(2)(−2.16625)2 = 28.1558.
d) SSAB = 6(effect)2 = 6(−0.33325)2 = 0.6663.
e)

SE(effect) =

√
MSE

m2k−2
=

√
0.54

3(2)
=

√
0.09 = 0.3.

The regpack functions twocub and twofourth can be used to find the
effects, SE(effect), and QQ plots for 23 and 24 designs. The twofourth

function also makes the response and residual plots based on the second
order model for 24 designs.

For the data in Example 8.4, the output on the following page shows that
the A and C effects have values −2.166 and −2.000 while the B effect is
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2.500. These are the three significant effects shown in the QQ plot in Figure
8.1. The two commands below produced the output.

z<-c(6.333,4.667,9,6.667,4.333,2.333,7.333,4.667)

twocub(z,m=3,MSE=0.54)

$Aeff

[1] -2.16625

$Beff

[1] 2.50025

$Ceff

[1] -2.00025

$ABeff

[1] -0.33325

$ACeff

[1] -0.16675

$BCeff

[1] 0.16675

$ABCeff

[1] 0.00025

$MSA

[1] 28.15583

$MSB

[1] 37.5075

$MSC

[1] 24.006

$MSAB

[1] 0.6663334

$MSAC

[1] 0.1668334

$MSABC

[1] 3.75e-07

$MSE

[1] 0.54

$SEeff

[1] 0.3
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8.2 Fractional Factorial Designs

Definition 8.10. A 2k−f
R fractional factorial design has k factors and

takes m2k−f runs where the number of replications m is usually 1. The
design is an orthogonal design and each factor has two levels low = −1 and
high = 1. R is the resolution of the design.

Definition 8.11. A main effect or q factor interaction is confounded
or aliased with another effect if it is not possible to distinguish between the
two effects.

Remark 8.2. A 2k−f
R design has no q factor interaction (or main effect for

q = 1) confounded with any other effect consisting of less than R− q factors.
So a 2k−f

III design has R = 3 and main effects are confounded with 2 factor
interactions. In a 2k−f

IV design, R = 4 and main effects are not confounded
with 2 factor interactions but 2 factor interactions are confounded with other
2 factor interactions. In a 2k−f

V design, R = 5 and main effects and 2 factor
interactions are only confounded with 4 and 3 way or higher interactions
respectively. The R = 4 and R = 5 designs are good because the 3 way
and higher interactions are rarely significant, but these designs are more
expensive than the R = 3 designs.

In a 2k−f
R design, each effect is confounded or aliased with 2f−1 other

effects. Thus the Mth main effect is really an estimate of the Mth main effect
plus 2f−1 other effects. If R ≥ 3 and none of the two factor interactions are
significant, then the Mth main effect is typically a useful estimator of the
population Mth main effect.

Rule of thumb 8.8. Main effects tend to be larger than q factor inter-
action effects, and the lower order interaction effects tend to be larger than
the higher order interaction effects. So two way interaction effects tend to
be larger than three way interaction effects.

Rule of thumb 8.9. Significant interactions tend to have significant
component main effects. Hence if A,B,C and D are factors, B and D are
inert and A and C are active, then the AC effect is the two factor interaction
most likely to be active. If only A was active, then the two factor interactions
containing A (AB,AC, and AD) are the ones most likely to be active.

Suppose each run costs $1000 and m = 1. The 2k factorial designs need 2k

runs while fractional factorial designs need 2k−f runs. These designs use the
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fact that three way and higher interactions tend to be inert for experiments.

Remark 8.3. Let ko = k− f . Some good fractional factorial designs for
ko = 3 are shown below. The designs shown use the same table of contrasts
as the 23 design and can be fit with 23 software.

23 A B C AB AC BC ABC
24−1

IV A B C AB+ AC+ BC+ D
25−2

III A B C D E BC+ BE+
26−3

III A B C D E F AF+
27−4

III A B C D E F G

Consider the 24−1
IV design. It has 4 factors A,B,C and D. The D main

effect is confounded with the ABC three way interaction, which is likely to
be inert. The “D effect” is the D effect plus the ABC effect. But if the
ABC effect is not significant, then the “D effect” is a good estimator of the
population D effect. Confounding = aliasing is the price to pay for using
fractional factorial desings instead of the more expensive factorial designs.

If m = 1, the 24−1
IV design uses 8 runs while a 24 factorial design uses 16

runs. The runs for the 24−1
IV are defined by the 4 main effects: use the first

3 columns and the last column of the table of contrasts for the 23 design to
define the runs. Randomly assign the units (often time slots) to the runs.

Remark 8.4. Some good fractional factorial designs for ko = k − f = 4
are shown below. The designs shown use the same table of contrasts as the
24 design and can be fit with 24 software. Here the designs are i) 24, and the
fractional factorial designs ii) 25−1

V , iii) 26−2
IV , iv) 27−3

IV , v) 28−4
IV , vi) 29−5

III and
vii) 215−11

III .

design

i) A B C D AB AC AD BC BD CD ABC ABD ACD BCD ABCD

ii) A B C D AB AC AD BC BD CD DE CE BE AE E

iii) A B C D AB+ AC+ AD+ BC+ BD+ CD+ E 3int 3int F AF+

iv) A B C D AB+ AC+ AD+ BC+ BD+ CD+ E 3int F G AG+

v) A B C D AB+ AC+ AD+ BC+ BD+ CD+ E F G H AH+

vi) A B C D AB+ AC+ AD+ BC+ BD+ CD+ E F G H J

vii) A B C D E F G H J K L M N O P
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Remark 8.5. Let ko = k − f for a 2k−f
R design. The QQ plot for 2k−f

R

designs is used in a manner similar to that of 2k designs where k = ko. The
formulas for effects and mean squares are like the formulas for a 2ko design.
Let c be a column from the table of contrasts where + = 1 and − = −1. Let
y be the column of cell means. Need MSE = σ̂2 to be given or estimated by
setting high order interactions to 0 for m = 1. Typically m = 1 for fractional
factorial designs. The following formulas ignore the “I effect.”

a) The effect corresponding to c is effect =
cTy

2ko−1
.

b) The standard error for the effect is SE(effect) =

√
MSE

m2ko−2
.

c) SE(mean) =

√
MSE

m2ko
where m2ko = n.

d) The sum of squares and mean square for an effect are
MS(effect) = SS(effect) = m2ko−2(effect)2.

Consider the designs given in Remarks 8.3 and 8.4. Least squares esti-
mates for the 2k−f

R designs with ko = 3 use the design matrix corresponding to
a 23 design while the designs with ko = 4 use the design matrix corresponding
to the 24 design given in Section 8.1.

Randomly assign units to runs. Do runs in random order if possible.
In industry, units are often time slots (periods of time), so randomization
consists of randomly assigning time slots to units, which is equivalent to
doing the runs in random order. For the above 2k−f

R designs, fix the main
effects using the corresponding columns in the two tables of contrasts given
in Section 8.1 to determine the levels needed in the m2k−f runs.

The fractional factorial designs can be fit with least squares, and the
model can be written as Y = xTβ + e with least squares fitted values Ŷ =
xT β̂. In matrix form the model is Y = Xβ + e and the vector of fitted
values is Ŷ = Xβ̂.

The biggest possible model for a 2k−f
R design where k − f = 3 is

Yi = β0 +β1xi1 +β2xi2 +β3xi3 +β12xi12 +β13xi13 +β23xi23 +β123xi123+ei with
least squares fitted or predicted values given by Ŷi = β̂0 + β̂1xi1 + β̂2xi2 +
β̂3xi3 + β̂12xi12 + β̂13xi13 + β̂23xi23 + β̂123xi123.

The regression equation corresponding to the significant effects (eg found
with a QQ plot) can be used to form a reduced model. For example, suppose
the full (least squares) fitted model is Ŷi = β̂0+β̂1xi1+β̂2xi2+β̂3xi3+β̂12xi12+
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β̂13xi13 + β̂23xi23 + β̂123xi123. Suppose the A, B and AB effects are significant.
Then the reduced (least squares) fitted model is Ŷi = β̂0 + β̂1xi1 + β̂2xi2 +
β̂12xi12 where the coefficients (β̂’s) for the reduced model can be taken from
the full model since fractional factorial designs are orthogonal.

For the fractional factorial designs, the coefficient β̂0 corresponding to I
is equal to the I effect, but the coefficient of a factor x corresponding to an
effect is β̂ = 0.5 effect. Consider significant effects and assume interactions
can be ignored.

i) If a large response Y is desired and β̂ > 0, use x = 1. If β̂ < 0, use
x = −1.

ii) If a small response Y is desired and β̂ > 0, use x = −1. If β̂ < 0, use
x = 1.

From the regression equation Ŷ = xT β̂, be able to predict Y given x. Be
able to tell whether x = 1 or x = −1 should be used. Given the x values of the
main effects, get the x values of the interactions by multiplying the columns
corresponding to the main effects in the interaction. Least squares output
is similar to that in Section 8.1. The least squares coefficient = 0.5 (effect).
The sum of squares for an x corresponding to an effect is equal to SS(effect).
SE(coef) = SE(β̂) = 0.5 SE(effect) =

√
MSE/n. Also SE(β̂0) =

√
MSE/n.

Assume none of the interactions are significant. Then the 27−4
III fractional

factorial design allows estimation of 7 main effects in 23 = 8 runs. The 215−11
III

fractional factorial design allows estimation of 15 main effects in 24 = 16 runs.
The 231−26

III fractional factorial design allows estimation of 31 main effects in
25 = 32 runs.

Fractional factorial designs with k − f = ko can be fit with software
meant for 2ko designs. Hence the regpack functions twocub and twofourth

can be used for the ko = 3 and ko = 4 designs that use the standard table
of contrasts. The response and residual plots given by twofourth are not
appropriate, but the QQ plot and the remaining output is relevant. Some
of the interactions will correspond to main effects for the fractional factorial
design.

For example, if the Example 8.4 data was from a 24−1
IV design, then the

A,B and C effects would be the same, but the D effect is the effect labelled
ABC . So the D effect ≈ 0.
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Figure 8.2: QQ plot for Example 8.5

Aeff Beff Ceff ABeff ACeff BCeff ABCeff

20.625 38.375 -0.275 28.875 -0.275 -0.625 -2.425

Example 8.5. Montgomery (1984, p 344-346) gives data from a 27−4
III

design with the QQ plot shown in Figure 8.2. The goal was to study eye
focus time with factors A = sharpness of vision, B = distance of target from
eye, C = target shape, D = illumination level, E = target size, F = target
density and G = subject. The R function twocub gave the effects above.

a) What is the D effect?
b) What effects are significant?
Solution: By the last line in the table given in Remark 8.3, note that for

this design, A,B,C,AB,AC,BC,ABC correspond to A,B,C,D,E, F,G. So
the AB effect from the output is the D effect.

a) 28.875, since the D effect is the AB effect.
b) A,B and D since these are the effects that do not follow the line in

the QQ plot shown in Figure 8.2.
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I A B C AB AC BC ABC y
+ − − − + + + − 86.8
+ + − − − − + + 85.9
+ − + − − + − + 79.4
+ + + − + − − − 60.0
+ − − + + − − + 94.6
+ + − + − + − − 85.4
+ − + + − − + − 84.5
+ + + + + + + + 80.3

Example 8.6. The above table of 23 contrasts is for 25−2
III data.

a) Estimate the B effect.
b) Estimate the D effect.
Solution: a)

−86.8 − 85.9 + 79.4 + 60 − 94.6 − 85.4 + 84.5 + 80.3

4

= −48.5/4 = −12.125.
b) Use Remark 8.3 to see that the D effect corresponds to the ABC

column. So the D effect =

86.8 − 85.9 − 79.4 + 60 + 94.6 − 85.4 − 84.5 + 80.3

4

= −13.5/4 = −3.375.

8.3 Plackett Burman Designs

Definition 8.12. The Plackett Burman PB(n) designs have k factors where
2 ≤ k ≤ n − 1. The factors have 2 levels and orthogonal contrasts like
the 2k and 2k−f

R designs. The PB(n) designs are resolution 3 designs, but the
confounding of main effects with 2 factor interactions is complex. The PB(n)
designs use n runs where n is a multiple of 4. The values n = 12, 20, 24, 28
and 36 are especially common.

Fractional factorial designs need at least 2ko runs. Hence if there are 17
main effects, 32 runs are needed for a 217−12

III design while a PB(20) design only
needs 20 runs. The price to pay is that the confounding pattern of the main
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effects with the two way interactions is complex. Thus the PB(n) designs
are usually used with main effects, and it is assumed that all interactions
are insignificant. So the Plackett Burman designs are main effects designs
used to screen k main effects when the number of runs n is small. Often
k = n− 4, n − 3, n − 2 or n − 1 is used. We will assume that the number of
replications m = 1.

A contrast matrix for the PB(12) design is shown below. Again the
column of plusses corresponding to I is omitted. If k = 8 then effects A to
H are used but effects J, K and L are “empty.” As a convention the mean
square and sum of squares for factor E will be denoted as MSe and SSe while
MSE = σ̂2.

run A B C D E F G H J K L

1 + - + - - - + + + - +

2 + + - + - - - + + + -

3 - + + - + - - - + + +

4 + - + + - + - - - + +

5 + + - + + - + - - - +

6 + + + - + + - + - - -

7 - + + + - + + - + - -

8 - - + + + - + + - + -

9 - - - + + + - + + - +

10 + - - - + + + - + + -

11 - + - - - + + + - + +

12 - - - - - - - - - - -

The PB(n) designs are k factor 2 level orthogonal designs. So finding ef-
fects, MS, SS, least squares estimates et cetera for PB(n) designs is similar to
finding the corresponding quantities for the 2k and 2k−f

R designs. Randomize
units (often time slots) to runs and least squares can be used.

Remark 8.6. For the PB(n) design, let c be a column from the table of
contrasts where + = 1 and − = −1. Let y be the column of responses since
m = 1. If k < n − 1, pool the last J = n − 1 − k “empty” effects into the
MSE with df = J as the full model. This procedure is done before looking
at the data, so is not data snooping. The MSE can also be given or found
by pooling insignificant MS’s into the MSE, but the latter method uses data
snooping. This pooling needs to be done if k = n− 1 since then there is no
df for MSE. The following formulas ignore the I effect.
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Figure 8.3: QQ Plot for Example 8.7

a) The effect corresponding to c is effect =
cT y

n/2
=

2cT y

n
.

b) The standard error for the effect is SE(effect) =

√
MSE

n/4
=

√
4MSE

n
.

c) SE(mean) =

√
MSE

n
.

d) The sum of squares and mean sum of squares for an effect is

MS(effect) = SS(effect) =
n

4
(effect)2.

For the PB(n) design, the least squares coefficient = 0.5 (effect). The sum
of squares for an x corresponding to an effect is equal to SS(effect). SE(coef)
= SE(β̂) = 0.5 SE(effect) =

√
MSE/n. Also SE(β̂0) =

√
MSE/n.

Example 8.7. On the following page is least squares output using
PB(12) data from Ledolter and Swersey (2007, p. 244-256). There were
k = 10 factors so the MSE has 1 df and there are too many terms in the
model. In this case the QQ plot shown in Figure 8.7 is more reliable for
finding significant effects.

a) Which effects, if any, appear to be significant from the QQ plot?

b) Let the reduced model Ŷ = β̂0 + β̂r1xr1 + · · · + β̂rjxrj where j is the
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number of significant terms found in a). Write down the reduced model.

c) Want large Y . Using the model in b), choose the x values that will
give large Y , and predict Y .

Estimate Std.Err t-value Pr(>|t|)

Intercept 6.7042 2.2042 3.0416 0.2022

c1 8.5792 2.2042 3.8922 0.1601

c2 -1.7958 2.2042 -0.8147 0.5648

c3 2.3125 2.2042 1.0491 0.4847

c4 4.1208 2.2042 1.8696 0.3127

c5 3.1542 2.2042 1.4310 0.3883

c6 -3.3958 2.2042 -1.5406 0.3665

c7 0.9542 2.2042 0.4329 0.7399

c8 -1.1208 2.2042 -0.5085 0.7005

c9 1.3125 2.2042 0.5955 0.6581

c10 1.7875 2.2042 0.8110 0.5662

Solution: a) The most significant effects are either in the top right or
bottom left corner. Although the points do not all scatter closely about
the line, the point in the bottom left is not significant. So none of the
effects corresponding to the bottom left of the plot are significant. A is the
significant effect with value 2(8.5792) = 17.1584. See the top right point of
Figure 8.7.

b) Ŷ = 6.7042 + 8.5792x1.
c) Ŷ = 6.7042 + 8.5792(1) = 15.2834.

The regpack function pb12 can be used to to find effects and MS(effect)
for PB(12) data. Least squares output and a QQ plot are also given.

8.4 Summary

1) In a table of contrasts, the contrast for A starts with a − then a + and
the pattern repeats. The contrast for B starts with 2 −’s and then 2 +’s and
the pattern repeats. The contrast for C starts with 4 −’s and then 4+’s and
the pattern repeats. The contrast for the ith main effects factor starts with
2i−1 −’s and 2i−1 +’s and the pattern repeats for i = 1, ..., k.

2) In a table of contrasts, a column for an interaction containing several
factors is obtained by multiplying the columns for each factor where + = 1
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and − = −1. So the column for ABC is obtained by multiplying the column
for A, the column for B and the column for C.

3) Let c be a column from the table of contrasts where + = 1 and − = −1.
Let y be the column of cell means. Then the effect corresponding to c is

effect =
cTy

2k−1
.

4) If the number of replications m ≥ 2, then the standard error for the
effect is

SE(effect) =

√
MSE

m2k−2
.

Sometimes MSE is replaced by σ̂2.

5)

SE(mean) =

√
MSE

m2k

where m2k = n, m ≥ 2 and sometimes MSE is replaced by σ̂2.

6) Since df = 1, the sum of squares and mean square for an effect is

MS(effect) = SS(effect) = m2k−2(effect)2

for m ≥ 1.

7) If a single run out of 2k cells gives good values for the response, then
that run is called a critical mix.

8) A factor is active if the response depends on the two levels of the factor,
and is inert, otherwise.

9) Randomization for a 2k design: randomly assign units to the m2k runs.
The runs are determined by the levels of the k main effects in the table of
contrasts. So a 23 design is determined by the levels of A, B and C. Similarly,
a 24 design is determined by the levels of A, B, C and D. Perform the m2k

runs in random order if possible.

10) A table of contrasts for a 23 design is shown on the following page.
The first column is for the mean and is not a contrast. The last column
corresponds to the cell means. Note that y1110 = y111 if m = 1. So y might
be replaced by y if m = 1.
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I A B C AB AC BC ABC y
+ − − − + + + − y1110

+ + − − − − + + y2110

+ − + − − + − + y1210

+ + + − + − − − y2210

+ − − + + − − + y1120

+ + − + − + − − y2120

+ − + + − − + − y1220

+ + + + + + + + y2220

divisor 8 4 4 4 4 4 4 4

11) Be able to pick out active and inert factors and good (or the best)
combinations of factors (cells or runs) from the table of contrasts = table of
runs.

12) Plotted points far away from the identity line and r = 0 line are
potential outliers, but often the identity line goes through or near an outlier
that is large in magnitude. Then the case has a small residual.

13) A 95% confidence interval (CI) for an effect is

effect± tdfe,0.975SE(effect)

where dfe is the MSE degrees of freedom. Use tdfe,0.975 ≈ z0.975 = 1.96 if
dfe > 30. The effect is significant if the CI does not contain 0, while the
effect is not significant if the CI contains 0.

14) Suppose there is no replication so m = 1. Find J interaction mean
squares that are small compared to the bulk of the mean squares. Add them
up to make MSE with dfe = J . So

MSE =
sum of small MS′s

J
.

This method uses data snooping and MSE tends to underestimate σ2. So
the F test statistics are too large and the pvalues too small. Use this method
for exploratory data analysis, not for inference based on the F distribution.

15) MS = SS ≈ σ2χ2
1 ≈ MSEχ2

1 if the effect is not significant. MSE ≈
σ2χ2

dfe
/dfe if the model holds. A rule of thumb is that an effect is significant

if MS > 5MSE. The rule comes from the fact that χ2
1,.975 ≈ 5.
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16) The table of contrasts for a 24 design is below. The column of ones
corresponding to I was omitted.

run A B C D AB AC AD BC BD CD ABC ABD ACD BCD ABCD

1 - - - - + + + + + + - - - - +

2 + - - - - - - + + + + + + - -

3 - + - - - + + - - + + + - + -

4 + + - - + - - - - + - - + + +

5 - - + - + - + - + - + - + + -

6 + - + - - + - - + - - + - + +

7 - + + - - - + + - - - + + - +

8 + + + - + + - + - - + - - - -

9 - - - + + + - + - - - + + + -

10 + - - + - - + + - - + - - + +

11 - + - + - + - - + - + - + - +

12 + + - + + - + - + - - + - - -

13 - - + + + - - - - + + + - - +

14 + - + + - + + - - + - - + - -

15 - + + + - - - + + + - - - + -

16 + + + + + + + + + + + + + + +

17) Below is the Anova table for a 23 design. Let m = 1. For A, use
H0 : µ100 = µ200. For B, use H0 : µ010 = µ020. For C, use H0 : µ001 = µ002.
For interaction, use H0 : no interaction.

Source df SS MS F p-value
A 1 SSA MSA FA pA

B 1 SSB MSB FB pB

C 1 SSC MSC FC pC

AB 1 SSAB MSAB FAB pAB

AC 1 SSAC MSAC FAC pAC

BC 1 SSBC MSBC FBC pBC

ABC 1 SSABC MSA FABC pABC

Error (m− 1)2k SSE MSE

18) If m = 1, pool J interaction mean squares that are small compared to
the bulk of the data into an MSE with dfe = J . Such tests are for exploratory
purposes only: the MSE underestimates σ2, so the F test statistics are too
large and the pvalues = P (F1,J > F0) are too small. For example F0 = FA =
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MSA/MSE. As a convention for using an F table, use the denominator df
closest to dfe = J , but if dfe = J > 30 use denominator df = ∞.

19) Below is the Anova table for a 2k design. For A, use H0 : µ10···0 =
µ20···0. The other main effect have similar null hypotheses. For interaction,
use H0 : no interaction. If m = 1 use a procedure similar to point 18) for
exploratory purposes.

Source df SS MS F p-value
k main effects 1 eg SSA = MSA FA pA(

k
2

)
2 factor interactions 1 eg SSAB = MSAB FAB pAB(

k
3

)
3 factor interactions 1 eg SSABC = MSABC FABC pABC

...
...

...
...

...(
k

k−1

)
k − 1 factor interactions

the k factor interaction 1 SSA· · ·L = MSA· · ·L FA···L pA···L
Error (m− 1)2k SSE MSE

20) Genuine run replicates need to be used. A common error is to take m
measurements per run, and act as if the m measurements are from m runs.
If as a data analyst you encounter this error, average the m measurements
into a single value of the response.

21) One can use t statistics for effects with t0 =
effect

SE(effect)
≈ tdfe where

dfe is the MSE df. Then t20 = MS(effect)/MSE = F0 ≈ F1,dfe.
22) A 2k design can be fit with least squares. In the table of contrasts

let a “+ = 1” and a “− = −1.” Need a row for each response: can’t use the
mean response for each fixed combination of levels. Let x0 correspond to I ,
the column of 1s. Let xi correspond to the ith main effect for i = 1, ..., k.
Let xij correspond to 2 factor interactions, and let xi1,...,iG correspond to
G way interactions for G = 2, ..., k. Let the design matrix X have columns
corresponding to the x. Let y be the vector of responses.

23) The table below relates the quantities in the 23 table of contrasts with
the quantities used in least squares. The design matrix

X = [x0,x1,x2,x3,x12,x13,x23,x123].

Software often does not need the column of ones x0.

x0 x1 x2 x3 x12 x13 x23 x123 y
I A B C AB AC BC ABC y
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24) The table below relates quantities in the 24 table of contrasts with
the quantities used in least squares. Again x0 corresponds to I , the column
of ones, while y is the vector of responses.
x1 x2 x3 x4 x12 x13 x14 x23 x24 x34 x123 x124 x134 x234 x1234

A B C D AB AC AD BC BD CD ABC ABD ACD BCD ABCD

25) A typical least squares output for the 23 design is shown below. Often
“Estimate” is replaced by “Coef”.

Estimate Std.Err t-value Pr(>|t|)

Intercept 64.25 0.7071 90.8632 0.0000

x1 11.50 0.7071 16.2635 0.0000

x2 -2.50 0.7071 -3.5355 0.0077

x3 0.75 0.7071 1.0607 0.3198

x12 0.75 0.7071 1.0607 0.3198

x13 5.00 0.7071 7.0711 0.0001

x23 0.00 0.7071 0.0000 1.0000

x123 0.25 0.7071 0.3536 0.7328

26) i) The least squares coefficient or “estimate” = effect/2. So in the
above table, the A effect = 2(11.5) = 23. If x corresponds to the least squares
coefficient, then the coefficient = (xT y)/(xT x).

ii) The sum of squares = means square corresponding to an xi··· is equal
to the sum of squares = mean square of the corresponding effect. If x corre-
sponds to the least squares coefficient, then the SS = MS = (xT y)2/(xT x).

iii) Supposem ≥ 2. Then SE(coef) = SE(effect)/2 = 0.5
√
MSE/(m2k−2).

Hence in the above table, SE(effect) = 2(.7071) = 1.412.
iv) The t statistic t0 = coef/SE(coef), and t20 = F0 where t0 ≈ tdfe and

F0 ≈ F1,dfe where dfe = (m − 1)2k is the MSE df. Hence the pvalues for
least squares and the 2k software are the same. For example, the pvalue for
testing the significance of x1 = pvalue for testing significance of A effect =
0.000 in the above table. Also tA = 16.2635 and t2A = FA = 264.501.

v) The MSE, fitted values and residuals are the same for the least squares
output and the 2k software.

27) There are several advantages to least squares over 2k software. i) If
there are several missing values or outliers, delete the corresponding rows
from the design matrix X and the vector of responses y as long as the
number of rows of the design matrix ≥ the number of columns. ii) If the exact
quantitative levels are not observed, replace them by the observed levels in
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the design matrix. See point 28). iii) If the wrong levels are used in a run,
replace the corresponding row in the design matrix by a row corresponding
to the levels actually used.

28) Suppose the two levels of the quantitative variable are a < b and x is

the actual value used. Then code x as c =
2x− (a+ b)

b− a
. Note that the code

gives c = −1 for x = a and c = 1 for x = b.

29) A normal QQ plot is a plot of the effects versus standard normal
percentiles. There are L = 2k − 1 effects for a 2k design. A rule of thumb is
that nonsignificant effects tend to follow a line closely in the middle of the
plot while the significant effects do not follow the line closely. Significant
effects will be the most negative or the most positive effects.

30) A 2k−f
R fractional factorial design has k factors and takes m2k−f runs

where the number of replications m is usually 1.

31) Let ko = k − f . Some good fractional factorial designs for ko = 3 are
shown below. The designs shown use the same table of contrasts as the 23

design given in point 10), and can be fit with 23 software.

23 A B C AB AC BC ABC
24−1

IV A B C AB+ AC+ BC+ D
25−2

III A B C D E BC+ BE+
26−3

III A B C D E F AF+
27−4

III A B C D E F G

32) Some good fractional factorial designs for ko = k − f = 4 are shown
below. The designs shown use the same table of contrasts as the 24 design
given in point 16), and can be fit with 24 software. Here the designs are i)
24, and the fractional factorial designs ii) 25−1

V , iii) 26−2
IV , iv) 27−3

IV , v) 28−4
IV , vi)

29−5
III and vii) 215−11

III .

design

i) A B C D AB AC AD BC BD CD ABC ABD ACD BCD ABCD

ii) A B C D AB AC AD BC BD CD DE CE BE AE E

iii) A B C D AB+ AC+ AD+ BC+ BD+ CD+ E 3int 3int F AF+

iv) A B C D AB+ AC+ AD+ BC+ BD+ CD+ E 3int F G AG+

v) A B C D AB+ AC+ AD+ BC+ BD+ CD+ E F G H AH+

vi) A B C D AB+ AC+ AD+ BC+ BD+ CD+ E F G H J

vii) A B C D E F G H J K L M N O P
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33) Let ko = k − f for a 2k−f
R design. Then the formulas for effects and

mean squares are like the formulas for a 2ko design. Let c be a column from
the table of contrasts where + = 1 and − = −1. Let y be the column of
cell means. Need MSE = σ̂2 to be given or estimated by setting high order
interactions to 0 for m = 1. Typically m = 1 for fractional factorial designs.

a) The effect corresponding to c is effect =
cTy

2ko−1
.

b) The standard error for the effect is SE(effect) =

√
MSE

m2ko−2
.

c) SE(mean) =

√
MSE

m2ko
where m2ko = n.

d) The mean square and sum of squares for an effect are
MS(effect) = SS(effect) = m2ko−2(effect)2.

34) Least squares estimates for the 2k−f
R designs in points 31) and 32) are

obtained by using the design matrix corresponding to the table of contrasts
in point 10) for ko = 3 and point 16) for ko = 4.

35) The QQ plot for 2k−f
R designs is used in a manner similar to point

29).

36) Randomly assign units to runs. Do runs in random order if possible.
In industry, units are often time slots (periods of time), so randomization
consists of randomly assigning time slots to units, which is equivalent to
doing the runs in random order. For the 2k−f

R designs in points 31) and 32),
fix the main effects using the corresponding columns of contrasts given in
points 10) and 16) to determine the levels needed in the m2k−f runs.

37) Active factors appear to change the mean response as the level of
the factor changes from −1 to 1. Inert factors do not appear to change the
response as the level of the factor changes from −1 to 1. An inert factor could
be needed but the level low or high is not important, or the inert factor may
not be needed and so can be omitted from future studies. Often subject
matter experts can tell whether the inert factor is needed or not.

38) A 2k−f
R design has no q factor interaction (or main effect for q = 1)

confounded with any other effect consisting of less than R − q factors. So
a 2k−f

III design has R = 3 and main effects are confounded with 2 factor
interactions. In a 2k−f

IV design, R = 4 and main effects are not confounded
with 2 factor interactions but 2 factor interactions are confounded with other
2 factor interactions. In a 2k−f

V design, R = 5 and main effects and 2 factor
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interactions are only confounded with 4 and 3 way or higher interactions
respectively.

39) In a 2k−f
R design, each effect is confounded or aliased with 2f−1 other

effects. Thus the Mth main effect is really an estimate of the Mth main effect
plus 2f−1 other effects. If R ≥ 3 and none of the two factor interactions are
significant, then the Mth main effect is typically a useful estimator of the
population Mth main effect.

40) The R = 4 and R = 5 designs are good because the 3 way and higher
interactions are rarely significant, but these designs are more expensive than
the R = 3 designs.

41) In this text, most of the DOE models can be fit with least squares,
and the model can be written as Y = xT β+e with least squares fitted values
Ŷ = xT β̂. In matrix form the model is Y = Xβ +e and the vector of fitted
values is Ŷ = Xβ̂.

42) The full model for a 23 or 2k−f
R design where k − f = 3 is

Yi = β0 + β1xi1 + β2xi2 + β3xi3 + β12xi12 + β13xi13 + β23xi23 + β123xi123 + ei

with least squares fitted or predicted values given by
Ŷi = β̂0 + β̂1xi1 + β̂2xi2 + β̂3xi3 + β̂12xi12 + β̂13xi13 + β̂23xi23 + β̂123xi123.

43) An interaction such as xi123 satisfies xi123 = (xi1)(xi2)(xi3).

44) For orthogonal designs like 2k, 2k−f
R or PB(n) (described in point 52)),

the x value of an effect takes on values −1 or 1. The columns of the design
matrix X are orthogonal: cT

i cj = 0 for i �= j where ci is the ith column of
X.

45) Suppose the full model using all of the columns of X is used. If the
some columns are removed (eg those corresponding to the insignificant ef-
fects), then for orthogonal designs in point 44) the following quantities remain
unchanged for the terms that were not deleted: the effects, the coefficients,
SS(effect) = MS(effect). The MSE, SE(effect), F and t statistics, pvalues,
fitted values and residuals do change.

46) The regression equation corresponding to the significant effects (eg
found with a QQ plot) can be used to form a reduced model. For example,
suppose the full (least squares) fitted model is Ŷi = β̂0 + β̂1xi1 + β̂2xi2 +
β̂3xi3 + β̂12xi12 + β̂13xi13 + β̂23xi23 + β̂123xi123. Suppose the A, B and AB
effects are significant. Then the reduced (least squares) fitted model is Ŷi =
β̂0 + β̂1xi1 + β̂2xi2 + β̂12xi12 where the coefficients (β̂’s) for the reduced model
are taken from the full model.
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47) For the designs in 44), the coefficient β̂0 corresponding to I is equal
to the I effect, but the coefficient of a factor x corresponding to an effect is
β̂ = 0.5 effect. Consider significant effects and assume interactions can be
ignored.
i) If a large response Y is desired and β̂ > 0, use x = 1. If β̂ < 0, use x = −1.

ii) If a small response Y is desired and β̂ > 0, use x = −1. If β̂ < 0, use
x = 1.

48) Rule of thumb: to predict Y with Ŷ , the number of coefficients =
the number of β̂’s in the model should be ≤ n/2, where the sample size n =
number of runs.

49) From the regression equation Ŷ = xT β̂, be able to predict Y given x.
Be able to tell whether x = 1 or x = −1 should be used. Given the x values
of the main effects, get the x values of the interactions using 43).

50) Least squares output for an example and in symbols are shown below
and on the following page for the designs in 44). Often “Estimate” is replaced
by “Coef” or “Coefficient”. Often “Intercept” is replaced by “Constant”. The
t statistic and pvalue are for whether the term or effect is significant. So t12

and p12 are for testing whether the x12 term or AB effect is significant.

Residual Standard Error=2.8284 = sqrt(MSE)

R-Square=0.9763 F-statistic (df=7, 8)=47.0536 p-value=0

Estimate Std.Err t-value Pr(>|t|)

Intercept 64.25 0.7071 90.8632 0.0000

x1 11.50 0.7071 16.2635 0.0000

x2 -2.50 0.7071 -3.5355 0.0077

x3 0.75 0.7071 1.0607 0.3198

x12 0.75 0.7071 1.0607 0.3198

x13 5.00 0.7071 7.0711 0.0001

x23 0.00 0.7071 0.0000 1.0000

x123 0.25 0.7071 0.3536 0.7328
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Coef or Est. Std.Err t pvalue

Intercept or constant β̂0 SE(coef) t0 p0

x1 β̂1 SE(coef) t1 p1

x2 β̂2 SE(coef) t2 p2

x3 β̂3 SE(coef) t3 p3

x12 β̂12 SE(coef) t12 p12

x13 β̂13 SE(coef) t13 p13

x23 β̂23 SE(coef) t23 p23

x123 β̂123 SE(coef) t123 p123

51) The least squares coefficient = 0.5 (effect). The sum of squares for
an x corresponding to an effect is equal to SS(effect). SE(coef) = SE(β̂) =
0.5 SE(effect) =

√
MSE/n. Also SE(β̂0) =

√
MSE/n.

52) The Plackett Burman PB(n) designs have k factors where 2 ≤ k ≤
n−1. The factors have 2 levels and orthogonal contrasts like the 2k and 2k−f

R

designs. The PB(n) designs are resolution 3 designs, but the confounding of
main effects with 2 factor interactions is complex. The PB(n) designs use
n runs where n is a multiple of 4. The values n = 12, 20, 24, 28 and 36 are
especially common.

53) The PB(n) designs are usually used with main effects so assume
that all interactions are insignificant. So they are main effects designs used
to screen k main effects when the number of runs n is small. Often k =
n − 4, n − 3, n − 2 or n − 1 is used. We will assume that the number of
replications m = 1.

54) If k = n − 1 there is no df for MSE. If k < n − 1, pool the last
J = n− 1 − k “empty” effects into the MSE with df = J as the full model.
This procedure is done before looking at the data, so is not data snooping.

55) The contrast matrix for the PB(12) design is shown on the following
page. Again the column of plusses corresponding to I is omitted. If k = 8
then effects A to H are used but effects J, K and L are “empty.” As a
convention the mean square and sum of squares for factor E will be denoted
as MSe and SSe while MSE = σ̂2.
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run A B C D E F G H J K L

1 + - + - - - + + + - +

2 + + - + - - - + + + -

3 - + + - + - - - + + +

4 + - + + - + - - - + +

5 + + - + + - + - - - +

6 + + + - + + - + - - -

7 - + + + - + + - + - -

8 - - + + + - + + - + -

9 - - - + + + - + + - +

10 + - - - + + + - + + -

11 - + - - - + + + - + +

12 - - - - - - - - - - -

56) The PB(n) designs are k factor 2 level orthogonal designs. So finding
effects, MS, SS, least squares estimates et cetera for PB(n) designs is similar
to finding the corresponding quantities for the 2k and 2k−f

R designs.

57) For the PB(n) design, let c be a column from the table of contrasts
where + = 1 and − = −1. Let y be the column of responses since m = 1.
For k < n− 1, MSE can be found for the full model as in 54). MSE can also
be given or found by pooling insignificant MS’s into the MSE, but the latter
method uses data snooping.

a) The effect corresponding to c is effect =
cT y

n/2
=

2cT y

n
.

b) The standard error for the effect is SE(effect) =

√
MSE

n/4
=

√
4MSE

n
.

c) SE(mean) =

√
MSE

n
.

d) The sum of squares and mean square for an effect is

MS(effect) = SS(effect) =
n

4
(effect)2.

58) For the PB(n) design, the least squares coefficient = 0.5 (effect). The
sum of squares for an x corresponding to an effect is equal to SS(effect).
SE(coef) = SE(β̂) = 0.5 SE(effect) =

√
MSE/n. Also SE(β̂0) =

√
MSE/n.
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8.5 Complements

Box, Hunter and Hunter (2005) and Ledolter and Swersey (2007) are excellent
references for k factor 2 level orthogonal designs.

Suppose it is desired to increase the response Y and that A,B,C, ... are
the k factors. The main effects for A,B, ... measure

∂Y

∂A
,
∂Y

∂B
,

et cetera. The interaction effect AB measures

∂Y

∂A∂B
.

Hence
∂Y

∂A
≈ 0,

∂Y

∂B
≈ 0 and

∂Y

∂A∂B
large

implies that the design is in the neighborhood of a maximum of a response
that looks like a ridge.

An estimated contrast is Ĉ =
∑p

i=1 diY i0, and

SE(Ĉ) =

√√√√MSE

p∑
i=1

d2
i

ni
.

If di = ±1, p = 2k and ni = m, then SE(Ĉ) =
√
MSE 2k/m. For a 2k

design, an effect can be written as a contrast with di = ±1/2k−1, p = 2k and
ni = m. Thus

SE(effect) =

√√√√MSE
2k∑
i=1

1

m

1

22k−2
=

√
MSE

m2k−2
.

There is an “ algebra” for computing confounding patterns for fractional
factorial designs. Let M be any single letter effect (A,B,C et cetera), and
let I be the identity element. Then i) IM = M , ii) MM = I and iii)
multiplication is commutative: LM = ML.

For a 2k−1
R design, set one main effect equal to an interaction, eg D =

ABC . The equation D = ABC is called a “generator.” Note that DD = I =
DABC = ABCD. The equation I = ABCD is the generating relationship.
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Then MI = M = ABCDM , so M is confounded or aliased with ABCDM .
So A = AI = AABCD = BCD and A is confounded with BCD. Similarly,
BD = BDI = BDABCD = AC , so BD is confounded with AC .

For a 2k−2
R design, 2 main effects L and M are set equal to an interaction.

Thus L2 = I and M2 = I , but it is also true that L2M2 = I. As an illus-
tration, consider the 26−2

IV design with E = ABC and F = BCD. So E2 =
I = ABCE, F 2 = I = BCDF and F 2E2 = I = ABCEBCDF = ADEF.
Hence the generating relationship I = ABCE = BCDF = ADEF has 3
“words,” and each effect is confounded with 3 other effects. For example,
AI = AABCE = ABCDF = AADEF or A = BCE = ABCDF = DEF .

For a 2k−f
R design, f main effects L1, ..., LF are set equal to interactions.

There are
(

f
1

)
equations of the form L2

i = I,
(

f
2

)
equations of the form L2

iL
2
j =

I,
(

f
3

)
equations of the form L2

i1L
2
i2L

2
i3 = I, ...,

(
f
f

)
equations of the form

L2
1L

2
2 · · ·L2

f = I . These equations give a generating relationship with 2f − 1

“words,” so each effect is confounded with 2f − 1 other effects.
If the generating relationship is I = W1 = W2 = · · · = W2f−1, then the

resolution R is equal to the length of the smallest word. So I = ABC and
I = ABCE = ABC = ADEF both have R = 3.

The convention is to ignore 3 way or higher order interactions. So the
alias patterns for the k main effects and the

(
k
2

)
2 way interactions with other

main effects and 2 way interactions is of interest.

8.6 Problems

Problems with an asterisk * are especially important.

Output for 8.1: Residual Standard Error=2.8284 R-Square=0.9763

F-statistic (df=7, 8)=47.0536 p-value=0

Estimate Std.Err t-value Pr(>|t|)

Intercept 64.25 0.7071 90.8632 0.0000

x1 11.50 0.7071 16.2635 0.0000

x2 -2.50 0.7071 -3.5355 0.0077

x3 0.75 0.7071 1.0607 0.3198

x12 0.75 0.7071 1.0607 0.3198

x13 5.00 0.7071 7.0711 0.0001

x23 0.00 0.7071 0.0000 1.0000

x123 0.25 0.7071 0.3536 0.7328
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8.1. From the least squares output on the previous page, what is the AB
effect?

I A B C AB AC BC ABC Y
+ − − − + + + − 3.81
+ + − − − − + + 4.28
+ − + − − + − + 3.74
+ + + − + − − − 4.10
+ − − + + − − + 3.75
+ + − + − + − − 3.66
+ − + + − − + − 3.82
+ + + + + + + + 3.68

8.2. Ledolter and Swersey (2007, p. 108 - 109) describes a 23 experi-
ment designed to increase subscriptions of the magazine Ladies’ Home Jour-
nal. The 2005 campaign made 8 brochures containing an order card. Each
brochure was mailed to 15042 households, and the response Y was the per-
centage of orders. Factor A was front side of order card with (−1) highlight-
ing “Double our Best Offer” and (+1) highlighting “We never had a bigger
sale.” Factor B was back side of order card with (−1) emphasizing “Two
extra years free,” while (+1) featured magazine covers of a previous issue.
Factor C was brochure cover with (−1) featuring Kelly Ripa and (+1) Dr.
Phil. Assume m = 1.

a) Find the A effect.

b) Find the C effect.

c) Find SSC = MSC.

d) If two of the three factors A, B and C are active, which is inactive?

I A B C AB AC BC ABC y
+ − − − + + + − 86.8
+ + − − − − + + 85.9
+ − + − − + − + 79.4
+ + + − + − − − 60.0
+ − − + + − − + 94.6
+ + − + − + − − 85.4
+ − + + − − + − 84.5
+ + + + + + + + 80.3
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8.3. The table of 23 contrasts on the previous page is for 25−2
III data.

a) Estimate the B effect.

b) Estimate the D effect.

8.4. Suppose that for 23 data with m = 2, the MSE = 407.5625. Find
SE(effect).

I A B C AB AC BC ABC y
+ − − − + + + − 63.6
+ + − − − − + + 76.8
+ − + − − + − + 60.3
+ + + − + − − − 80.3
+ − − + + − − + 67.2
+ + − + − + − − 71.3
+ − + + − − + − 68.3
+ + + + + + + + 74.3

divisor 8 4 4 4 4 4 4 4

8.5. Ledolter and Swersey (2007, p. 131) describe a 27−4
III data set shown

with the table of 23 contrasts above. Estimate the D effect.

I A B C AB AC BC ABC y
+ − − − + + + − 32
+ + − − − − + + 35
+ − + − − + − + 28
+ + + − + − − − 31
+ − − + + − − + 48
+ + − + − + − − 39
+ − + + − − + − 28
+ + + + + + + + 29

divisor 8 4 4 4 4 4 4 4

8.6. Kuehl (1994, p. 361-366) describes a 23 experiment designed to
investigate the effects of furnace temperature (1840 or 1880oF), heating time
(23 or 25 sec) and transfer time (10 or 12 sec) on the quality of a leaf spring
used for trucks. (The response Y was a measure of the quality.) The table
of contrasts is shown above.
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a) Find the A effect.
b) Find the B effect.
c) Find the AB effect.
d) If m = 1, find SSA.
e) If m = 1, find SSB.
f) If m = 1, find SSAB.
g) If m = 2 and MSE = 9, find SE(effect).

(The SE is the same regardless of the effect.)
h) Suppose high Y = y is desirable. If two of the factors A, B and C are

inert and one is active, then which is active and which are inert. (Hint: look
at the 4 highest values of y. Is there a pattern?)

i) If one of the factors has an interaction with the active factor, what is
the interaction (eg AB, AC or BC)?

8.7. Suppose the B effect = −5, SE(effect) =
√

2 and dfe = 8.
i) Find a 95% confidence interval for the B effect.
ii) Is the B effect significant? Explain briefly.

8.8. Copy the Box, Hunter and Hunter (2005, p. 199) product develop-
ment data from (www.math.siu.edu/olive/regdata.txt) into R.

Then type the following commands.

out <- aov(conversion~K*Te*P*C,devel)

summary(out)

a) Include the output in Word.
b) What are the five effects with the biggest mean squares?

Note: an AB interaction is denoted by A:B in R.

8.9. Get the SAS program from (www.math.siu.edu/olive/reghw.txt) for
this problem. The data is the pilot plant example from Box, Hunter and
Hunter (2005, p. 177-186). The response varible is Y=yield, while the three
predictors (T = temp, C = concentration, K = catalyst) are at two levels.

a) Print out the output but do not turn in the first page.
b) Do the residual and response plots look ok?

8.10. Get the data from (www.math.siu.edu/olive/reghw.txt) for this
problem. The data is the pilot plant example from Box, Hunter and Hunter
(2005, p. 177-186) examined in Problem 8.9. Minitab needs the levels for
the factors and the interactions.
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Highlight the data and use the menu commands “Edit>Copy.” In Minitab,
use the menu command “Edit>PasteCells.” After a window appears, click
on ok.

Below C1 type “A”, below C2 type “B”, below C3 type “C” and below
C8 type “yield.”

a) Use the menu command “STAT>ANOVA>BalancedAnova” put “yield”
in the responses box and

A|B|C
in the Model box. Click on “Storage.” When a window appears, click on
“Fits” and “Residuals.” Then click on “OK”. This window will disappear.
Click on “OK.”

b) Next highlight the bottom 8 lines and use the menu commands
“Edit>Delete Cells”. Then the data set does not have replication. Use
the menu command “STAT>ANOVA>Balanced Anova” put “yield” in the
responses box and

A B C A*C
in the Model box. Click on “Storage.” When a window appears, click on
“Fits” and “Residuals.” Then click on “OK”. This window will disappear.
Click on “OK.”

(The model A|B|C would have resulted in an error message, not enough
data.)

c) Print the output by clicking on the top window and then clicking on
the printer icon.

d) Make a response plot with the menu commands “Graph>Plot” with
yield in the Y box and FIT2 in the X box. Print by clicking on the printer
icon.

e) Make a residual plot with the menu commands “Graph>Plot” with
RESI2 in the Y box and FIT2 in the X box. Print by clicking on the printer
icon.

f) Do the plots look ok?

8.11. Get the R code and data for this problem from
(www.math.siu.edu/olive/reghw.txt). The data is the pilot plant example
from Box, Hunter and Hunter (2005, p. 177-186) examined in Problems 8.9
and 8.10.

a) Copy and paste the code into R. Then copy and paste the output into
Notepad. Print out the page of output.
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b) The least squares estimate = coefficient for x1 is half the A effect. So
what is the A effect?

8.12. a) Obtain and the R program twocub from
(www.math.siu.edu/olive/regpack.txt). To get the effects, mean squares and
SE(effect) for the Box, Hunter and Hunter (2005, p. 177) pilot plant data,
type the following commands and include the output in Word.

mns <- c(60,72,54,68,52,83,45,80)

twocub(mns,m=2,MSE=8)

b) Which effects appear to be significant from the QQ plot? (Match the
effects on the plot with the output on the screen.)

8.13. Box, Hunter and Hunter (2005, p. 237) describe a 24−1
IV fractional

factorial design. Assuming that you downloaded the twocub function in the
previous problem, type the following commands.

mns <- c(20,14,17,10,19,13,14,10)

twocub(mns,m=1)

a) Include the output in Word, print out the output and label the effects
on the output with the corresponding effects from a 24−1

IV fractional factorial
design.

b) Include the QQ plot in Word. Print out the plot. Which effects (from
the fractional factorial design) seem to be significant?

8.14. a) Download (www.math.siu.edu/olive/regpack.txt) into R, and
type the following commands.

mns <- c(14,16,8,22,19,37,20,38,1,8,4,10,12,30,13,30)

twofourth(mns)

This is the Ledolter and Swersey (2007, p. 80) cracked pots 24 data and
the response and residual plots are from the model without 3 and 4 factor
interactions.

b) Copy the plots into Word and print the plots. Do the response and
residual plots look ok?

8.15. Download (www.math.siu.edu/olive/regpack.txt) into R. The data
is the PB(12) example from Box, Hunter and Hunter (2005, p. 287).

a) Type the following commands. Copy and paste the QQ plot into Word
and print the plot.
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resp <- c(56,93,67,60,77,65,95,49,44,63,63,61)

pb12(resp,k=5)

b) Copy and paste the output into Notepad and print the output.

c) As a 25 design, the effects B, D, BD, E and DE were thought to be real.
The PB(12) design works best when none of the interactions is significant.
From the QQ plot and the output for the PB(12) design, which factors, if
any, appear to be significant?

d) The output gives the A, B, C, D and E effects along with the cor-
responding least squares coefficients β̂1, ..., β̂5. What is the relationship
between the coefficients and the effects?

For parts e) to g), act as if the PB(12) design with 5 factors is
appropriate.

e) The full model has Ŷ = β̂0 + β̂1x1 + β̂2x2 + β̂3x3 + β̂4x4 + β̂5x5. The
reduced model is Ŷ = β̂0 + β̂jxj where xj is the significant term found in c).
Give the numerical formula for the reduced model.

f) Compute Ŷ using the full model if xi = 1 for i = 1, ..., 5. Then compute
Ŷ using the reduced model if xj = 1.

g) If the goal of the experiment is to produce large values of Y , should
xj = 1 or xj = −1 in the reduced model? Explain briefly.



Chapter 9

More on Experimental Designs

The one and two way Anova designs, completely randomized block design
and split plot designs are the building blocks for more complicated designs.
Some split plot designs can be written as a linear model, Y = xT β + e, but
the errors are dependent with a complicated correlation structure.

9.1 Split Plot Designs

Definition 9.1. Split plot designs have two units. The large units are
called whole plots and contain blocks of small units called subplots. The
whole plots get assigned to Factor A while the subplots get assigned to factor
B (randomly if the units are experimental but not randomly if the units are
observational). A and B are crossed so the AB interaction can be studied.

The split plot design depends on how whole plots are assigned to A. Three
common methods are described below, and methods a) and b) are described
in more detail in the following subsections. The randomization and split plot
Anova table depend on the design used for assigning the whole plots to factor
A.

a) The whole plots are assigned to A completely at random, as in a one
way Anova.

b) The whole plots are assigned to A and to a blocking variable as in
a completely randomized block design (if the whole plots are experimental,
but a complete block design is used if the whole plots are observational).

c) The whole plots are assigned to A, to row blocks and to column blocks
as in a Latin Square.

311
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The key feature of a split plot design is that there are two units of different
sizes: one size for each of the 2 factors of interest. The larger units are
assigned to A. The large units contain blocks of small units assigned to
factor B. Also factors A and B are crossed.

9.1.1 Whole Plots Randomly Assigned to A

Shown below is the split plot Anova table when the whole plots are as-
signed to factor A as in a one way Anova design. The whole plot er-
ror is error(W) and can be obtained as an A*replication interaction. The
subplot error is error(S). FA = MSA/MSEW, FB = MSB/MSES and
FAB = MSAB/MSES. R computes the three test statistics and pvalues
correctly, but for SAS FA and the pvalue pA need to be computed using
MSA, MSEW, dfA and dfeW

obtained from the Anova table. Sometimes “er-
ror(W)” is also denoted as “residuals.” There are ma whole plots, and each
whole plot contains b subplots. Thus there are mab subplots.

Source df SS MS F p-value
A a− 1 SSA MSA FA pA

error(W) or A*repl a(m− 1) SSEW MSEW
B b− 1 SSB MSB FB pB

AB (a− 1)(b− 1) SSAB MSAB FAB pAB

residuals or error(S) a(m− 1)(b − 1) SSES MSES

The tests of interest for this split plot design are nearly identical to those
of a two way Anova model. Yijk has i = 1, ..., a, j = 1, ..., b and k = 1, ..., m.
Keep A and B in the model if there is an AB interaction.

a) The 4 step test for AB interaction is
i) Ho there is no interaction HA there is an interaction
ii) FAB is obtained from output.
iii) The pvalue is obtained from output.
iv) If pvalue < δ reject Ho and conclude that there is an interaction between
A and B, otherwise fail to reject Ho and conclude that there is no interaction
between A and B.

b) The 4 step test for A main effects is
i) Ho µ100 = · · · = µa00 HA not Ho
ii) FA is obtained from output.
iii) The pvalue is obtained from output.
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iv) If pvalue < δ reject Ho and conclude that the mean response depends
on the level of A, otherwise fail to reject Ho and conclude that the mean
response does not depend on the level of A.

c) The 4 step test for B main effects is
i) Ho µ010 = · · · = µ0b0 HA not Ho
ii) FB is obtained from output.
iii) The pvalue is obtained from output.
iv) If pvalue < δ reject Ho and conclude that the mean response depends
on the level of B, otherwise fail to reject Ho and conclude that the mean
response does not depend on the level of B.

Source df SS MS F p-value
variety 7 763.16 109.02 1.232 0.3421
MSEW 16 1415.83 88.49

treatment 3 30774.3 10258.1 423.44 0.00
variety*treatment 21 2620.1 124.8 5.150 0.00

error(S) 48 1162.8 24.2

Example 9.1. This split plot data is from Chambers and Hastie (1993,
p. 158). There are 8 varieties of guayule (rubber plant) and 4 treatments
were applied to seeds. The response was the rate of germination. The whole
plots were greenhouse flats and the subplots were 4 subplots of the flats. Each
flat received seeds of one variety (A). Each subplot contained 100 seeds and
was treated with one of the treatments (B). There were m = 3 replications
so each variety was planted in 3 flats for a total of 24 flats and 4(24) = 96
observations.

Factorial crossing: Variety and treatments (A and B) are crossed since
all combinations of variety and treatment occur. Hence the AB interaction
can be measured.

Blocking: The whole plots are the 24 greenhouse flats. Each flat is a
block of 4 subplots. Each of the 4 subplots gets one of the 4 treatments.

Randomization: The 24 flats are assigned to the 8 varieties completely at
random. Use the sample(24) command to generate a random permutation.
The first 3 numbers of the permutation get variety one, the next 3 get variety
2, ..., the last 3 get variety 8. The use the sample(4) command 24 times,
once for each flat. If 2, 4, 1, 3 was the permutation for the ith flat, then
the 1st subplot gets treatment 3, the 2nd gets treatment 1, the 3rd gets
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treatment 4, and the 4th subplot gets treatment 2.

a) Perform the test corresponding to A.

b) Perform the test corresponding to B.

c) Perform the test corresponding to AB.

Solution: a) Ho µ100 = · · · = µ800 Ha not Ho
FA = 1.232
pval = 0.3421
Fail to reject Ho, the mean rate of germination does not depend on va-

riety. (This test would make more sense if there was no variety * treatment
interaction.)

b) Ho µ010 = · · · = µ040 Ha not Ho
FB = 423.44
pval = 0.00
Reject Ho, the mean rate of germination depends on treatment.
c) Ho no interaction Ha there is an interaction
FAB = 5.15
pval = 0.00
Reject Ho, there is a variety * treatment interaction.

9.1.2 Whole Plots Assigned to A as in a CRBD

Shown below is the split plot Anova table when the whole plots are as-
signed to factor A and a blocking variable as in a completely randomized
block design. The whole plot error is error(W) and can be obtained as an
block*A interaction. The subplot error is error(S). FA = MSA/MSEW,
FB = MSB/MSES and FAB = MSAB/MSES. Factor A has a levels and
factor B has b levels. There are r blocks of a whole plots. Each whole
plot contains b subplots, and each block contains a whole plots and thus ab
subplots. Hence there are ra whole plots and rab subplots.

SAS computes the last two test statistics and pvalues correctly, and the
last line of SAS output gives FA and the pvalue pA. The initial line of output
for A is not correct. The output for blocks is probably not correct.
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Source df SS MS F p-value
blocks r − 1

A a− 1 SSA MSA FA pA

error(W) or block*A (r − 1)(a− 1) SSEW MSEW
B b− 1 SSB MSB FB pB

AB (a− 1)(b− 1) SSAB MSAB FAB pAB

error(S) a(r − 1)(b− 1) SSES MSES

The tests of interest for this split plot design are nearly identical to those
of a two way Anova model. Yijk has i = 1, ..., a, j = 1, ..., b and k = 1, ..., r.
Keep A and B in the model if there is an AB interaction.

a) The 4 step test for AB interaction is
i) Ho there is no interaction HA there is an interaction
ii) FAB is obtained from output.
iii) The pvalue is obtained from output.
iv) If pvalue < δ reject Ho and conclude that there is an interaction between
A and B, otherwise fail to reject Ho and conclude that there is no interaction
between A and B.

b) The 4 step test for A main effects is
i) Ho µ100 = · · · = µa00 HA not Ho
ii) FA is obtained from output.
iii) The pvalue is obtained from output.
iv) If pvalue < δ reject Ho and conclude that the mean response depends
on the level of A, otherwise fail to reject Ho and conclude that the mean
response does not depend on the level of A.

c) The 4 step test for B main effects is
i) Ho µ010 = · · · = µ0b0 HA not Ho
ii) FB is obtained from output.
iii) The pvalue is obtained from output.
iv) If pvalue < δ reject Ho and conclude that the mean response depends
on the level of B, otherwise fail to reject Ho and conclude that the mean
response does not depend on the level of B.
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Source df SS MS F p-value
Block 5 4.150 0.830

Variety 2 0.178 0.089 0.65 0.5412
Block*Variety 10 1.363 0.136

Date 3 1.962 0.654 23.39 0.00
Variety*Date 6 0.211 0.035 1.25 0.2973

error(S) 45 1.259 0.028

Example 9.2. The Anova table above is for the Snedecor and Cochran
(1967, p. 369-372) split plot data where the whole plots are assigned to
factor A and to blocks in a completely randomized block design. Factor A =
variety of alfalfa (ladak, cossack, ranger). Each field had two cuttings, with
the second cutting on July 7, 1943. Factor B = date of third cutting (none,
Sept. 1, Sept. 20, Oct. 7) in 1943. The response variable was yield (tons per
acre) in 1944. The 6 blocks were fields of land divided into 3 plots of land,
one for each variety. Each of these 3 plots was divided into 4 subplots for
date of third cutting. So each block had 3 whole plots and 12 subplots.

a) Perform the test corresponding to A.

b) Perform the test corresponding to B.

c) Perform the test corresponding to AB.

Solution: a) Ho µ100 = · · · = µ300 Ha not Ho
FA = 0.65
pval = 0.5412
Fail to reject Ho, the mean yield does not depend on variety.
b) Ho µ010 = · · · = µ040 Ha not Ho
FB = 23.39
pval = 0.0
Reject Ho, the mean yield depends on cutting date.
c) Ho no interaction Ha there is an interaction
FAB = 1.25
pval = 0.2973
Fail to reject Ho, there is no interaction between variety and cutting date.

Warning: Although the split plot model can be written as a linear model,
the errors are not iid and have a complicated correlation structure. It is also
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difficult to get fitted values and residuals from the software, so the model
can’t be easily checked with response and residual plots. These facts make
the split plot model very hard to use for most researchers.

9.2 Review of the DOE Models

The three basic principles of DOE (design of experiments) are
i) use randomization to assign treatments to units.
ii) Use factorial crossing to compare the effects (main effects, pairwise

interactions, ..., J-fold interaction) of J ≥ 2 factors. If A1, ..., AJ are the
factors with li levels for i = 1, ..., J ; then there are l1l2 · · · lJ treatments
where each treatment uses exactly one level from each factor.

iii) Blocking is used to divide units into blocks of similar units where
“similar” means the units are likely to have similar values of the response
when given the same treatment. Within each block randomly assign units to
treatments.

Next the 10 designs of Chapter 5 to Section 9.1 are summarized. If the
randomization can not be done as described, then much stronger assumptions
on the data are needed for inference to be approximately correct. There are
three common ways of assigning units. For inference i) requires the least
assumptions and iii) the most.

i) Experimental units are randomly assigned.
ii) Observational units are a random sample of units from a population

of units. Each combination of levels determines a population. So a two way
Anova design has ab populations.

iii) Units (such as time slots) can be assigned systematically due to con-
straints (eg physical, cost or time constraints).

I) One way Anova: Factor A has p levels.
a) For a fixed effects one way Anova model, the levels are fixed.
b) For a random effects one way Anova model, the levels are a random

sample from a population of levels.
Randomization: Let n =

∑p
i=1mi and do the sample(n) command. As-

sign the first m1 units to treatment (level) 1, the next m2 units to treatment
2, ..., the last mp units to treatment p.

II) Two way Anova: Factor A has a levels and factor B has b levels. The
two factors are crossed, forming ab cells.
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Randomization: Let n = mab and do the sample(n) command. Ran-
domly assign m units to each of the ab cells. Assign the first m units to the
(A,B) = (1, 1) cell, the next m units to the (1,2) cell, ..., the last m units to
the (a, b) cell.

III) k way Anova: There are k factors A1, ..., Ak with a1, ..., ak levels,
respectively. The k factors are crossed, forming

∏k
i=1 ai cells.

Randomization: Let n = m
∏k

i=1 ai and do the sample(n) command.
Randomly assign m units to each cell. Each cell is a combination of levels,
so the (1, 1, ..., 1, 1) cell gets the 1st m units.

IV) Completely randomized block design: Factor A has k levels (treat-
ments), and there are b blocks (a blocking variable has b levels) of k units.

Randomization: Let n = kb and do the sample(k) command b times.
Within each block of k units, randomly assign 1 unit to each treatment.

V) Latin squares: Factor A has a levels (treatments), the row blocking
variable has a blocks of a units and the column blocking variable has a blocks
of a units. There are a2 units since the row and column blocking variables are
crossed. The treatment factor, row blocking variable and column blocking
variable are also crossed. A Latin square is such that each of the a treatments
occurs once in each row and once in each column.

Randomization: Pick an a×a Latin square. Use the sample(a) command
to assign row levels to numbers 1 to a. Use the sample(a) command to assign
column levels to numbers 1 to a. Use the sample(a) command to assign
treatment levels to the first a capital letters. If possible, use the sample(a2)

command to assign units, 1 unit to each cell of the Latin square.

VI) 2k factorial design: There are k factors, each with 2 levels.
Randomization: Let n = m2k and do the sample(n) command. Ran-

domly assign m units to each cell. Each cell corresponds to a run which is
determined by a string of k +’s and −’s corresponding to the k main effects.

VII) 2k−f
R fractional factorial design: There are k factors, each with 2

levels.
Randomization: Let n = 2k−f and do the sample(n) command. Ran-

domly assign 1 unit to each run which is determined by a string of k +’s
and −’s corresponding to the k main effects.

VIII) Plackett Burman PB(n) design: There are k factors, each with 2
levels.

Randomization: Let n = 4J for some J . Do the sample(n) command.
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Randomly assign 1 unit to each run which is a string of n− 1 +’s and −’s.
(Each run corresponds to a row in the design matrix, so we are ignoring the
column of 1’s corresponding to I in the design matrix.)

IX) Split plot design where the whole plots are assigned to A as in a one
way Anova design: The whole plot factor A has a levels and each whole plot
is a block of b subplots used to study factor B which has b levels. Split plot
designs have two types of units: the whole plots are the larger units and the
subplots are the smaller units.

Randomization: a) Suppose there are n = ma whole plots. Randomly
assign m whole plots to each level of A with the sample(n) command. Assign
the first m units (whole plots) to treatment (level) 1, the next m units to
treatment 2, ..., the last m units to treatment a.

b) Do the sample(b) command ma times, once for each whole plot.
Within each whole plot, randomly assign 1 subplot (unit) to each of the
b levels of B.

X) Split plot design where the whole plots are assigned toA and a blocking
variable as in a completely randomized block design: The whole plot factor A
has a levels and each whole plot is a block of b subplots used to study factor
B which has b levels. Split plot designs have two types of units: the whole
plots are the larger units and the subplots are the smaller units. There are
also r blocks of a whole plots. Each whole plot has b subplots. Thus there
are ra whole plots and rab subplots.

Randomization: a) Do the sample(a) command r times, once for each
block. For each block of a whole plots, randomly assign 1 whole plot to each
of the a levels of A.

b) Do the sample(b) command ra times, once for each whole plot. Within
each whole plot, randomly assign 1 subplot to each of the b levels of B.

Try to become familiar with the designs and their randomization so that
you can recognize a design given a story problem.

Example 9.3. Cobb (1998, p. 200-212) describes an experiment on
weight gain for baby pigs. The response Y was the average daily weight gain
in pounds for each piglet (over a period of time). Factor A consisted of 0
mg of an antibiotic or 40 mg of an antibiotic while factor B consisted of 0
mg of vitamin B12 or 5 mg of B12. Hence there were 4 diets (A,B) = (0,0),
(40,0), (0,5) or (40,5). If there were 12 piglets and 3 were randomly assigned
to each diet, what type of experimental design was used?
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Solution: A and B are crossed with each combination of (A,B) levels
forming a diet. So the two way Anova (or 22 factorial) design was used.

Example 9.4. In 2008, a PhD student was designing software to analyze
a complex image. 100 portions of the image need to be analyzed correctly,
and the response variable is the proportion of errors. Sixteen test images are
available and thought to be representative. The goal is to achieve an average
error rate of less than 0.3 if many images were examined. The student has
identified 3 factors to reduce the error rate. Each factor has 2 levels. Thus
there are 8 versions of the software that analyze images.

The student selects a single test image and runs a 23 design with 8 time
slots as units. Factor A is active but factors B and C are inert. When
A was at the (+) level the error rate was about 0.27. Briefly explain why
this experiment does not give much information about how the software will
behave on many images.

Solution: More images are needed, 1 image is not enough.
(A better design is a completely randomized block design that uses each

of the 16 images as a block and factor A = “software version” with 8 levels.
The units for the block are 8 time slots so each of the 8 versions of the
software is tested on each test image.)

9.3 Summary

1) The analysis of the response, not that of the residuals, is of primary
importance. The response plot can be used to analyze the response in the
background of the fitted model. For linear models such as experimental
designs, the estimated mean function is the identity line and should be added
as a visual aid.

2) Assume that the residual degrees of freedom are large enough for test-
ing. Then the response and residual plots contain much information. Lin-
earity and constant variance may be reasonable if the plotted points scatter
about the identity line in a (roughly) evenly populated band. Then the resid-
uals should scatter about the r = 0 line in an evenly populated band. It is
easier to check linearity with the response plot and constant variance with
the residual plot. Curvature is often easier to see in a residual plot, but the
response plot can be used to check whether the curvature is monotone or
not. The response plot is more effective for determining whether the signal
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to noise ratio is strong or weak, and for detecting outliers, influential cases
or a critical mix.

3) The three basic principles of DOE (design of experiments) are
i) use randomization to assign units to treatments.
ii) Use factorial crossing to compare the effects (main effects, pairwise

interactions, ..., J-fold interaction) for J ≥ 2 factors. If A1, ..., AJ are the
factors with li levels for i = 1, ..., J ; then there are l1l2 · · · lJ treatments where
each treatment uses exactly one level from each factor.

iii) Blocking is used to divide units into blocks of similar units where
“similar” means the units are likely to have similar values of the response
when given the same treatment. Within each block randomly assign units to
treatments.

4) Split plot designs have two units. The large units are called whole
plots and contain blocks of small units called subplots. The whole plots get
assigned to Factor A while the subplots get assigned to factor B (randomly if
the units are experimental but not randomly if the units are observational).
A and B are crossed so the AB interaction can be studied.

5) The split plot design depends on how whole plots are assigned to A.
Three common methods are a) the whole plots are assigned to A completely
at random, as in a one way Anova, b) the whole plots are assigned to A
and to a blocking variable as in a completely randomized block design (if the
whole plots are experimental, a complete block design is used if the whole
plots are observational), c) the whole plots are assigned to A, to row blocks
and to column blocks as in a Latin Square.

6) The split plot Anova table when whole plots are assigned to levels of
A as in a one way Anova is shown on the following page. The whole plot
error is error(W) and can be obtained as an A*replication interaction. The
subplot error is error(S). FA = MSA/MSEW, FB = MSB/MSES and
FAB = MSAB/MSES. R computes the three test statistics and pvalues
correctly, but for SAS FA and the pvalue pA need to be computed using
MSA, MSEW, dfA and dfeW

obtained from the Anova table.



CHAPTER 9. MORE ON EXPERIMENTAL DESIGNS 322

Source df SS MS F p-value
A a− 1 SSA MSA FA pA

error(W) or A*repl a(m− 1) SSEW MSEW
B b− 1 SSB MSB FB pB

AB (a− 1)(b− 1) SSAB MSAB FAB pAB

residuals or error(S) a(m− 1)(b − 1) SSES MSES

7) The tests of interest corresponding to 6) are nearly identical to those
of a two way Anova model. Yijk has i = 1, ..., a, j = 1, ..., b and k = 1, ..., m.
Keep A and B in the model if there is an AB interaction.

a) The 4 step test for AB interaction is
i) Ho there is no interaction HA there is an interaction
ii) FAB is obtained from output.
iii) The pvalue is obtained from output.
iv) If pvalue < δ reject Ho and conclude that there is an interaction between
A and B, otherwise fail to reject Ho and conclude that there is no interaction
between A and B.

b) The 4 step test for A main effects is
i) Ho µ100 = · · · = µa00 HA not Ho
ii) FA is obtained from output.
iii) The pvalue is obtained from output.
iv) If pvalue < δ reject Ho and conclude that the mean response depends
on the level of A, otherwise fail to reject Ho and conclude that the mean
response does not depend on the level of A.

c) The 4 step test for B main effects is
i) Ho µ010 = · · · = µ0b0 HA not Ho
ii) FB is obtained from output.
iii) The pvalue is obtained from output.
iv) If pvalue < δ reject Ho and conclude that the mean response depends
on the level of B, otherwise fail to reject Ho and conclude that the mean
response does not depend on the level of B.

8) The split plot Anova table when whole plots are assigned to levels
of A as in a completely randomized block design is shown on the follow-
ing page. The whole plot error is error(W) and can be obtained as an
block*A interaction. The subplot error is error(S). FA = MSA/MSEW,
FB = MSB/MSES and FAB = MSAB/MSES. SAS computes the last
two test statistics and pvalues correctly, and the last line of SAS output
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gives FA and the pvalue pA. The initial line of output for A is not correct.
The output for blocks is probably not correct.

Source df SS MS F p-value
blocks r − 1

A a− 1 SSA MSA FA pA

error(W) or block*A (r − 1)(a− 1) SSEW MSEW
B b− 1 SSB MSB FB pB

AB (a− 1)(b− 1) SSAB MSAB FAB pAB

error(S) a(r − 1)(b− 1) SSES MSES

9) The tests of interest corresponding to 8) are nearly identical to those
of a two way Anova model and point 7). Yijk has i = 1, ..., a, j = 1, ..., b and
k = 1, ..., r. Keep A and B in the model if there is an AB interaction.

a) The 4 step test for AB interaction is
i) Ho there is no interaction HA there is an interaction
ii) FAB is obtained from output.
iii) The pvalue is obtained from output.
iv) If pvalue < δ reject Ho and conclude that there is an interaction between
A and B, otherwise fail to reject Ho and conclude that there is no interaction
between A and B.

b) The 4 step test for A main effects is
i) Ho µ100 = · · · = µa00 HA not Ho
ii) FA is obtained from output.
iii) The pvalue is obtained from output.
iv) If pvalue < δ reject Ho and conclude that the mean response depends
on the level of A, otherwise fail to reject Ho and conclude that the mean
response does not depend on the level of A.

c) The 4 step test for B main effects is
i) Ho µ010 = · · · = µ0b0 HA not Ho
ii) FB is obtained from output.
iii) The pvalue is obtained from output.
iv) If pvalue < δ reject Ho and conclude that the mean response depends
on the level of B, otherwise fail to reject Ho and conclude that the mean
response does not depend on the level of B.
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9.4 Complements

See Robinson, Brenneman and Myers (2009) for a comparison of completely
randomized designs, completely randomized block designs and split plot de-
signs. Some history of experimental designs is given by Box (1980, 1984).
Also see David (1995, 2006-7) and Hahn (1982).

The importance of DOE is discussed in Gelman (2005), and a review
is given by Steinberg and Hunter (1984). For experiments done as class
projects, see Hunter (1977).

9.5 Problems

Problems with an asterisk * are especially important.

Source df SS MS F p-value
Block 2 77.55 38.78

Method 2 128.39 64.20 7.08 0.0485
Block*Method 4 36.28 9.07

Temp 3 434.08 144.69 41.94 0.00
Method*Temp 6 75.17 12.53 2.96 0.0518

error(S) 12 50.83 4.24

9.1. The Anova table above is for the Montgomery (1984, p. 386-389)
split plot data where the whole plots are assigned to factor A and to blocks
in a completely randomized block design. The response variable is tensile
strength of paper. Factor A is (preparation) method with 3 levels (1, 2, 3).
Factor B is temperature with 4 levels (200, 225, 250, 275). The pilot plant
can make 12 runs a day and the experiment is repeated each day, with days
as blocks. A batch of pulp is made by one of the 3 preparation methods.
Then the batch of pulp is divided into 4 samples, and each sample is cooked
at one of the four temperatures.

a) Perform the test corresponding to A.

b) Perform the test corresponding to B.

c) Perform the test corresponding to AB.
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Source df SS MS F p-value
Block 1 0.051 0.051

Nitrogen 3 37.32 12.44 29.62 0.010
Block*Nitrogen 3 1.26 0.42

Thatch 2 3.82 1.91 9.10 0.009
Nitrogen*Thatch 6 4.15 0.69 3.29 0.065

error(S) 12 1.72 0.21

9.2. The Anova table above is for the Kuehl (1994, p. 473-481) split
plot data where the whole plots are assigned to factor A and to blocks in a
completely randomized block design. The response variable is the average
chlorophyll content (mg/gm of turf grass clippings). Factor A is nitrogen
fertilizer with 4 levels (1, 2, 3, 4). Factor B is length of time that thatch was
allowed to accumulate with 3 levels (2, 5, or 8 years).

There were 2 blocks of 4 whole plots to which the levels of Factor A were
assigned. The 2 blocks formed a golf green which was seeded with turf grass.
The 8 whole plots were plots of golf green. Each whole plot had 3 subplots
to which the levels of Factor B were randomly assigned.

a) Perform the test corresponding to A.

b) Perform the test corresponding to B.

c) Perform the test corresponding to AB.

Source df SS MS F p-value
Block 5 4.150 0.830

Variety 2 0.178 0.089 0.65 0.5412
Block*Variety 10 1.363 0.136

Date 3 1.962 0.654 23.39 0.00
Variety*Date 6 0.211 0.035 1.25 0.2973

error(S) 45 1.259 0.028

9.3. The Anova table above is for the Snedecor and Cochran (1967, p.
369-372) split plot data where the whole plots are assigned to factor A and
to blocks in a completely randomized block design. Factor A = variety of
alfalfa (ladak, cossack, ranger). Each field had two cuttings, with the second
cutting on July 7, 1943. Factor B = date of third cutting (none, Sept. 1,
Sept. 20, Oct. 7) in 1943. The response variable was yield (tons per acre)
in 1944. The 6 blocks were fields of land divided into 3 plots of land, one for
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each variety. Each of these 3 plots was divided into 4 subplots for date of
third cutting. So each block had 3 whole plots and 12 subplots.

a) Perform the test corresponding to A.

b) Perform the test corresponding to B.

c) Perform the test corresponding to AB.

9.4. Following Montgomery (1984, p. 386-389), suppose the response
variable is tensile strength of paper. One factor is (preparation) method
with 3 levels (1, 2, 3). Another factor is temperature with 4 levels (200, 225,
250, 275).

a) Suppose the pilot plant can make 12 runs a day and the experiment is
repeated each day, with days as blocks. A batch of pulp is made by one of
the 3 preparation methods. Then the batch of pulp is divided into 4 samples,
and each sample is cooked at one of the four temperatures. Which factor,
method or temperature is assigned to subplots?

b) Suppose the pilot plant could make 36 runs in one day. Suppose that 9
batches of pulp are made, that each batch of pulp is divided into 4 samples,
and each sample is cooked at one of the four temperatures. How should the
9 batches be allocated to the three preparation methods and how should the
4 samples be allocated to the four temperatures?

c) Suppose the pilot plant can make 36 runs in one day and that the units
are 36 batches of material to be made into pulp. Each of the 12 method tem-
perature combinations is to be replicated 3 times. What type of experimental
design should be used? (Hint: not a split plot.)

9.5. a) Download (www.math.siu.edu/olive/regdata.txt) into R, and
type the following commands. Then copy and paste the output into Notepad
and print the output.

attach(guay)

out <- aov(plants~variety*treatment + Error(flats),guay)

summary(out)

detach(guay)

This split plot data is from Chambers and Hastie (1993, p. 158). There
are 8 varieties of guayule (rubber plant) and 4 treatments were applied to
seeds. The response was the rate of germination. The whole plots were
greenhouse flats and the subplots were subplots of the flats. Each flat received
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seeds of one variety (A). Each subplot contained 100 seeds and was treated
with one of the treatments (B). There werem = 3 replications so each variety
was planted in 3 flats for a total of 24 flats and 4(24) = 96 observations.

b) Use the output to test whether the response depends on variety.

9.6. Download (www.math.siu.edu/olive/regdata.txt) into R, and type
the following commands. Then copy and paste the output into Notepad and
print the output.

attach(steel)

out <- aov(resistance~heat*coating + Error(wplots),steel)

summary(out)

detach(steel)

This split plot steel data is from Box, Hunter and Hunter (2005, p. 336).
The whole plots are time slots to use a furnace, which can hold 4 steel bars
at one time. Factor A = heat has 3 levels (360, 370, 380o F). Factor B =
coating has 4 levels (4 types of coating: c1, c2, c3 and c4). The response was
corrosion resistance.

a) Perform the test corresponding to A.

b) Perform the test corresponding to B.

c) Perform the test corresponding to AB.

9.7. This is the same data as in Problem 9.6, using SAS. Copy and paste
the SAS program from (www.math.siu.edu/olive/reghw.txt) into SAS, run
the program, then print the output. Only include the second page of output.

To get the correct F statistic for heat, you need to divide MS heat by MS
wplots.

9.8. a) Copy and paste the SAS program from
(www.math.siu.edu/olive/reghw.txt) into SAS, run the program, then print
the output. Only include the second page of output.

This data is from the SAS Institute (1985, p. 131-132). The B and AB
Anova table entries are correct, but the correct entry for A is the last line of
output where Block*A is used as the error.

b) Perform the test corresponding to A.

c) Perform the test corresponding to B.

d) Perform the test corresponding to AB.
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9.9. Suppose the response variable is tensile strength of paper. One factor
is preparation method with 3 levels (1, 2, 3). Another factor is temperature
with 4 levels (200, 225, 250, 275). Suppose the pilot plant can make 36 runs
in one day and that the units are 36 batches of material to be made into
pulp. Each of the 12 method temperature combinations is to be replicated 3
times. What type of experimental design should be used?



Chapter 10

Logistic Regression

Multiple linear regression is used when the response variable is quantitative,
but for many data sets the response variable is categorical and takes on two
values: 0 or 1. The occurrence of the category that is counted is labelled as
a 1 or a “success,” while the nonoccurrence of the category that is counted is
labelled as a 0 or a “failure.” For example, a “success” = “occurrence” could
be a person who contracted lung cancer and died within 5 years of detection.
Often the labelling is arbitrary, eg, if the response variable is gender taking
on the two categories female and male. If males are counted then Y = 1
if the subject is male and Y = 0 if the subject is female. If females are
counted then this labelling is reversed. For a binary response variable, a
binary regression model is often appropriate.

10.1 Binary Regression

Definition 10.1. The binary regression model states that Y1, ..., Yn are
independent random variables with

Yi ∼ binomial(1, ρ(xi)).

The binary logistic regression (LR) model is the special case of binary
regression where

P (success|xi) = ρ(xi) =
exp(α+ βTxi)

1 + exp(α+ βTxi)
. (10.1)

329
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Definition 10.2. The sufficient predictor SP = α + βT x while the

estimated sufficient predictor ESP = α̂+ β̂
T
x.

Thus the binary regression model says that

Y |SP ∼ binomial(1, ρ(SP ))

where

ρ(SP ) =
exp(SP )

1 + exp(SP )

for the LR model. Note that the conditional mean function E(Y |SP ) =
ρ(SP ) and the conditional variance function V (Y |SP ) = ρ(SP )(1− ρ(SP )).
For the LR model, the Y are independent and

Y ≈ binomial

(
1,

exp(ESP )

1 + exp(ESP )

)
,

or Y |SP ≈ Y |ESP ≈ binomial(1, ρ(ESP )).
Another important binary regression model is the discriminant func-

tion model. See Hosmer and Lemeshow (2000, p. 43–44). Assume that
πj = P (Y = j) and that x|Y = j ∼ Nk(µj ,Σ) for j = 0, 1. That is,
the conditional distribution of x given Y = j follows a multivariate normal
distribution with mean vector µj and covariance matrix Σ which does not
depend on j. Notice that Σ = Cov(x|Y ) �= Cov(x). Then as for the binary
logistic regression model,

P (Y = 1|x) = ρ(x) =
exp(α + βT x)

1 + exp(α + βT x)
.

Definition 10.3. Under the conditions above, the discriminant func-
tion parameters are given by

β = Σ−1(µ1 − µ0) (10.2)

and

α = log

(
π1

π0

)
− 0.5(µ1 − µ0)

TΣ−1(µ1 + µ0).

Using Definitions 10.1 and 10.3 makes simulation of logistic regression
data straightforward. To use Definition 10.3, set π0 = π1 = 0.5, Σ = I,
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and µ0 = 0. Then α = −0.5µT
1 µ1 and β = µ1. The artificial data set used

to make Figure 1.6 had β = (1, 1, 1, 0, 0)T and hence α = −1.5. Let Ni

be the number of cases where Y = i for i = 0, 1. For the artificial data,
N0 = N1 = 100, and hence the total sample size n = N1 + N0 = 200.
The discriminant function estimators α̂D and β̂D are found by replacing the
population quantities π1, π0, µ1, µ0 and Σ by sample quantities.

To visualize the LR model, the response plot will be useful.

Definition 10.4. The response plot or estimated sufficient summary plot

or ESS plot is the plot of the ESP = α̂+ β̂
T
xi versus Yi with the estimated

mean function

ρ̂(ESP ) =
exp(ESP )

1 + exp(ESP )

added as a visual aid.

A scatterplot smoother such as lowess is also added as a visual aid. Alter-
natively, divide the ESP into J slices with approximately the same number
of cases in each slice. Then compute the sample mean = sample proportion
in slice s: ρ̂s = Y s =

∑
s Yi/

∑
s mi where mi ≡ 1 and the sum is over the

cases in slice s. Then plot the resulting step function.
Suppose that x is a k × 1 vector of predictors, N1 =

∑
Yi = the num-

ber of 1s and N0 = n − N1 = the number of 0s. Also assume that k ≤
min(N0, N1)/5. Then if the parametric estimated mean function ρ̂(ESP )
looks like a smoothed version of the step function, then the LR model is likely
to be useful. In other words, the observed slice proportions should scatter
fairly closely about the logistic curve ρ̂(ESP ) = exp(ESP )/[1+ exp(ESP )].

The response plot is a powerful method for assessing the adequacy of the
binary LR regression model. Suppose that both the number of 0s and the
number of 1s is large compared to the number of predictors k, that the ESP
takes on many values and that the binary LR model is a good approximation
to the data. Then Y |ESP ≈ binomial(1, ρ̂(ESP ). Unlike the response plot
for multiple linear regression where the mean function is always the identity
line, the mean function in the response plot for LR can take a variety of
shapes depending on the range of the ESP. For LR, the (estimated) mean
function is

ρ̂(ESP ) =
exp(ESP )

1 + exp(ESP )
.

If the ESP = 0 then Y |SP ≈ binomial(1,0.5). If the ESP = −5, then Y |SP ≈
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binomial(1,ρ ≈ 0.007) while if the ESP = 5, then Y |SP ≈ binomial(1,ρ ≈
0.993). Hence if the range of the ESP is in the interval (−∞,−5) then the
mean function is flat and ρ̂(ESP ) ≈ 0. If the range of the ESP is in the
interval (5,∞) then the mean function is again flat but ρ̂(ESP ) ≈ 1. If
−5 < ESP < 0 then the mean function looks like a slide. If −1 < ESP < 1
then the mean function looks linear. If 0 < ESP < 5 then the mean function
first increases rapidly and then less and less rapidly. Finally, if −5 < ESP <
5 then the mean function has the characteristic “ESS” shape shown in Figure
1.6.

This plot is very useful as a goodness of fit diagnostic. Divide the ESP into
J “slices” each containing approximately n/J cases. Compute the sample
mean = sample proportion of the Y s in each slice and add the resulting step
function to the ESS plot. This is done in Figure 1.6 with J = 10 slices.
This step function is a simple nonparametric estimator of the mean function
ρ(SP ). If the step function follows the estimated LR mean function (the
logistic curve) closely, then the LR model fits the data well. The plot of
these two curves is a graphical approximation of the goodness of fit tests
described in Hosmer and Lemeshow (2000, p. 147–156).

The deviance test described in Section 10.3 is used to test whether β = 0,
and is the analog of the ANOVA F test for multiple linear regression. If
the LR model is a good approximation to the data but β = 0, then the
predictors x are not needed in the model and ρ̂(xi) ≡ ρ̂ = Y (the usual
univariate estimator of the success proportion) should be used instead of the
LR estimator

ρ̂(xi) =
exp(α̂ + β̂

T
xi)

1 + exp(α̂+ β̂
T
xi)

.

If the logistic curve clearly fits the step function better than the line Y = Y ,
then Ho will be rejected, but if the line Y = Y fits the step function about
as well as the logistic curve (which should only happen if the logistic curve
is linear with a small slope), then Y may be independent of the predictors.
Figure 1.7 shows the ESS plot when only X4 and X5 are used as predic-
tors for the artificial data, and Y is independent of these two predictors by
construction. It is possible to find data sets that look like Figure 1.7 where
the p–value for the deviance test is very small. Then the LR relationship
is statistically significant, but the investigator needs to decide whether the
relationship is practically significant.

For binary data the Yi only take two values, 0 and 1, and the residuals do
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Figure 10.1: Plots for Museum Data

not behave very well. Hence the ESS plot will be used both as a goodness of
fit plot and as a lack of fit plot.

The logistic regression (maximum likelihood) estimator also tends to per-
form well the discriminant function model above Definition 10.3. An excep-
tion is when the Y = 0 cases and Y = 1 cases can be perfectly or nearly

perfectly classified by the ESP. Let the logistic regression ESP = α̂ + β̂
T
x.

Consider the ESS plot of the ESP versus Y . If the Y = 0 values can be
separated from the Y = 1 values by the vertical line ESP = 0, then there
is perfect classification. In this case the maximum likelihood estimator for
the logistic regression parameters (α,β) does not exist because the logistic
curve can not approximate a step function perfectly. See Atkinson and Riani
(2000, p. 251-254). If only a few cases need to be deleted in order for the
data set to have perfect classification, then the amount of “overlap” is small
and there is nearly “perfect classification.”

Example 10.1. Schaaffhausen (1878) gives data on skulls at a museum.
The 1st 47 skulls are humans while the remaining 13 are apes. The response
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variable ape is 1 for an ape skull. The left plot in Figure 10.1 uses the
predictor face length. The model fits very poorly since the probability of a 1
decreases then increases. The middle plot uses the predictor head height and
perfectly classifies the data since the ape skulls can be separated from the
human skulls with a vertical line at ESP = 0. The right plot uses predictors
lower jaw length, face length, and upper jaw length. None of the predictors is
good individually, but together provide a good LR model since the observed
proportions (the step function) track the model proportions (logistic curve)
closely.

Example 10.2. Is There a Gender Gap? In the United States,
there does not appear to be a gender gap in math and science ability in
that the average score and the percentage passing standardized tests appear
to be about the same for both genders for math and science until after 8th
grade. For example, in Illinois all students take standardized exams at various
times, and the Nov. 16, 2001 Chicago Tribune reported that the percentage
of Illinois students meeting or exceeding state standards for math was 61%
for M and 62% for F 5th graders. For science it was 72% for both M and F
7th graders. After 8th grade, differences in gender scores are likely due to
different gender choices (males take more math in high school) rather than
to differences in ability. In recent years, the gap for high school juniors has
greatly decreased in the United States, and may not have been statistically
significant in 2008.

In many other countries, there does seem to be a difference in average gen-
der scores. The TIMSS data is from Beaton, Martin, Mullis, Gonzales, Smith,
and Kelly (1996). The variable Y was a 1 if there was a statistically signif-
icant gender difference in the nation’s TIMSS test, and Y was 0 otherwise.
Two predictors were x1 = percent of 8th graders whose friends think it is im-
portant to do well in science and x2 = percent of 8th graders taught by female
teachers. The horizontal axis is the ESP = 6.9668 − 0.05684x1 − 0.03609x2.

Logistic regression was used to estimate the probability that Y = 1 given
the values of the predictors. The estimated probability is given by the smooth
curve in Figure 10.2. For example, in Japan 83% of the students thought
that it was important to do well in the sciences and 20% of the 8th grade
science teachers were female. Hence Japan had Y = 1, x1 = 83 and x2 = 20.
This corresponds to ESP = 1.527 and an estimated probability of 0.8216. In
contrast, the USA had Y = 0, x1 = 69 and x2 = 54. Then the ESP = 1.096
and an estimated probability of 0.7495. In general, draw a vertical line to
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Figure 10.2: Visualizing TIMSS Data

the smooth curve and then a horizontal line to the vertical axis to estimate
the probability.

The jagged curve is the scatterplot smoother lowess. Since it is close to
the solid line, then the LR model is likely to be useful. Hence nations with
low percentages of female science teachers and of motivated students were
more likely to have a gender difference in the TIMSS science scores than
nations with high percentages.

10.2 Binomial Regression

Definition 10.5. The binomial regression model states that Y1, ..., Yn

are independent random variables with

Yi ∼ binomial(mi, ρ(xi)).

The binary regression model is the special case where mi ≡ 1 for i =
1, ..., n while the logistic regression (LR) model is the special case of
binomial regression where

P (success|xi) = ρ(xi) =
exp(α+ βTxi)

1 + exp(α+ βTxi)
. (10.3)
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If the sufficient predictor SP = α + βTx, then the most used binomial
regression models are such that Y1, ..., Yn are independent random variables
with

Yi ∼ binomial(mi, ρ(α+ βTxi)),

or
Yi|SPi ∼ binomial(mi, ρ(SPi)). (10.4)

Note that the conditional mean function E(Yi|SPi) = miρ(SPi) and the
conditional variance function V (Yi|SPi) = miρ(SPi)(1 − ρ(SPi)). Note that
the LR model has

ρ(SP ) =
exp(SP )

1 + exp(SP )
.

For binomial regression, the ESS plot needs to be modified and a check for
overdispersion (described on the following page) is needed.

Definition 10.6. Let Zi = Yi/mi. Then the conditional distribution
Zi|xi of the LR binomial regression model can be visualized with an ESS

plot or response plot of the ESP = α̂ + β̂
T
xi versus Zi with the estimated

mean function

ρ̂(ESP ) =
exp(ESP )

1 + exp(ESP )

added as a visual aid. Divide the ESP into J slices with approximately the
same number of cases in each slice. Then compute ρ̂s =

∑
s Yi/

∑
s mi where

the sum is over the cases in slice s. Then plot the resulting step function.
For binary data the step function is simply the sample proportion in each
slice.

Either the step function or the lowess curve could be added to the ESS
plot. Both the lowess curve and step function are simple nonparametric
estimators of the mean function ρ(SP ). If the lowess curve or step function
tracks the logistic curve (the estimated mean) closely, then the LR mean
function is a reasonable approximation to the data.

Checking the LR model in the nonbinary case is more difficult because
the binomial distribution is not the only distribution appropriate for data
that takes on values 0, 1, ..., m if m ≥ 2. Hence both the mean and variance
functions need to be checked. Often the LR mean function is a good ap-
proximation to the data, the LR MLE is a consistent estimator of β, but the



CHAPTER 10. LOGISTIC REGRESSION 337

LR model is not appropriate. The problem is that for many data sets where
E(Yi|xi) = miρ(SPi), it turns out that V (Yi|xi) > miρ(SPi)(1 − ρ(SPi)).
This phenomenon is called overdispersion.

A useful alternative to the binomial regression model is a beta–binomial
regression (BBR) model. Following Simonoff (2003, p. 93-94) and Agresti
(2002, p. 554-555), let δ = ρ/θ and ν = (1 − ρ)/θ, so ρ = δ/(δ + ν) and
θ = 1/(δ + ν). Let

B(δ, ν) =
Γ(δ)Γ(ν)

Γ(δ + ν)
.

If Y has a beta–binomial distribution, Y ∼ BB(m, ρ, θ), then the probability
mass function of Y is

P (Y = y) =

(
m

y

)
B(δ + y, ν +m− y)

B(δ, ν)

for y = 0, 1, 2, ..., m where 0 < ρ < 1 and θ > 0. Hence δ > 0 and ν > 0.
Then E(Y ) = mδ/(δ+ν) = mρ and V(Y ) = mρ(1−ρ)[1+(m−1)θ/(1+θ)].
If Y |π ∼ binomial(m, π) and π ∼ beta(δ, ν), then Y ∼ BB(m, ρ, θ).

Definition 10.7. The BBR model states that Y1, ..., Yn are independent
random variables where Yi|SPi ∼ BB(mi, ρ(SPi), θ).

The BBR model has the same mean function as the binomial regression
model, but allows for overdispersion. Note that E(Yi|SPi) = miρ(SPi) and

V (Yi|SPi) = miρ(SPi)(1 − ρ(SPi))[1 + (mi − 1)θ/(1 + θ)].

As θ → 0, it can be shown that V (π) → 0 and the BBR model converges to
the binomial regression model.

For both the LR and BBR models, the conditional distribution of Y |x
can still be visualized with an ESS plot of the ESP versus Yi/mi with the
estimated mean function

ρ̂(ESP )

and a step function or lowess curve added as visual aids.
Since binomial regression is the study of Zi|xi (or equivalently of Yi|xi),

the ESS plot is crucial for analyzing LR models. The ESS plot is a special
case of the model checking plot and emphasizes goodness of fit.

Since the binomial regression model is simpler than the BBR model,
graphical diagnostics for the goodness of fit of the LR model would be useful.
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The following plot was suggested by Olive (2007b) to check for overdisper-
sion.

Definition 10.8. To check for overdispersion, use the OD plot of the
estimated model variance V̂mod ≡ V̂ (Y |SP ) versus the squared residuals V̂ =
[Y − Ê(Y |SP )]2. For the LR model, V̂ (Yi|SP ) = miρ(ESPi)(1 − ρ(ESPi))
and Ê(Yi|SP ) = miρ(ESPi).

Numerical summaries are also available. The deviance G2 is a statistic
used to assess the goodness of fit of the logistic regression model much as R2

is used for multiple linear regression. When the counts mi are small, G2 may
not be reliable but the ESS plot is still useful. If the mi are not small, if the
ESS and OD plots look good, and the devianceG2 satisfies G2/(n−k−1) ≈ 1,
then the LR model is likely useful. If G2 > (n− k − 1) + 3

√
n− k + 1, then

a more complicated count model may be needed.
Combining the ESS plot with the OD plot is a powerful method for as-

sessing the adequacy of the LR model. To motivate the OD plot, recall that
if a count Y is not too small, then a normal approximation is good for the
binomial distribution. Notice that if Yi = E(Y |SP ) + 2

√
V (Y |SP ), then

[Yi − E(Y |SP )]2 = 4V (Y |SP ). Hence if both the estimated mean and es-
timated variance functions are good approximations, and if the counts are
not too small, then the plotted points in the OD plot will scatter about a
wedge formed by the V̂ = 0 line and the line through the origin with slope 4:
V̂ = 4V̂ (Y |SP ). Only about 5% of the plotted points should be above this
line.

If the data are binary, the ESS plot is enough to check the binomial
regression assumption. When the counts are small, the OD plot is not wedge
shaped, but if the LR model is correct, the least squares (OLS) line should
be close to the identity line through the origin with unit slope.

Suppose the bulk of the plotted points in the OD plot fall in a wedge.
Then the identity line, slope 4 line and OLS line will be added to the plot as
visual aids. It is easier to use the OD plot to check the variance function than
the ESS plot since judging the variance function with the straight lines of
the OD plot is simpler than judging the variability about the logistic curve.
Also outliers are often easier to spot with the OD plot. The evidence of
overdispersion increases from slight to high as the scale of the vertical axis
increases from 4 to 10 times that of the horizontal axis. There is considerable
evidence of overdispersion if the scale of the vertical axis is more than 10 times
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Figure 10.3: Visualizing the Death Penalty Data
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that of the horizontal, or if the percentage of points above the slope 4 line
through the origin is much larger than 5%.

If the binomial LR OD plot is used but the data follows a beta–binomial
regression model, then V̂mod = V̂ (Yi|SP ) ≈ miρ(ESP )(1 − ρ(ESP )) while
V̂ = [Yi−miρ(ESP )]2 ≈ (Yi−E(Yi))

2. HenceE(V̂ ) ≈ V (Yi) ≈ miρ(ESP )(1−
ρ(ESP ))[1 + (mi − 1)θ/(1 + θ)], so the plotted points with mi = m should
scatter about a line with slope ≈

1 + (m− 1)
θ

1 + θ
=

1 +mθ

1 + θ
.

Example 10.3. Abraham and Ledolter (2006, p. 360-364) describe
death penalty sentencing in Georgia. The predictors are aggravation level
from 1 to 6 (treated as a continuous variable) and race of victim coded as
1 for white and 0 for black. There were 362 jury decisions and 12 level
race combinations. The response variable was the number of death sentences
in each combination. The ESS plot in Figure 10.3a shows that the Yi/mi

are close to the estimated LR mean function (the logistic curve). The step
function based on 5 slices also tracks the logistic curve well. The OD plot
is shown in Figure 10.3b with the identity, slope 4 and OLS lines added as
visual aids. The vertical scale is less than the horizontal scale and there is
no evidence of overdispersion.

Example 10.4. Collett (1999, p. 216-219) describes a data set where
the response variable is the number of rotifers that remain in suspension in
a tube. A rotifer is a microscopic invertebrate. The two predictors were the
density of a stock solution of Ficolli and the species of rotifer coded as 1 for
polyarthra major and 0 for keratella cochlearis. Figure 10.4a shows the ESS
plot. Both the observed proportions and the step function track the logistic
curve well, suggesting that the LR mean function is a good approximation to
the data. The OD plot suggests that there is overdispersion since the vertical
scale is about 30 times the horizontal scale. The OLS line has slope much
larger than 4 and two outliers seem to be present.

10.3 Inference

This section gives a brief discussion of inference for the logistic regression
(LR) model. Inference for this model is very similar to inference for the
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multiple linear regression, survival regression and Poisson regression models.
For all of these models, Y is independent of the k × 1 vector of predictors
x = (x1, ..., xk)

T given the sufficient predictor α+ βTx:

Y x|(α+ βTx).

To perform inference for LR, computer output is needed. The following
page shows output using symbols and Arc output from a real data set with
k = 2 nontrivial predictors. This data set is the banknote data set described
in Cook and Weisberg (1999a, p. 524). There were 200 Swiss bank notes of
which 100 were genuine (Y = 0) and 100 counterfeit (Y = 1). The goal of the
analysis was to determine whether a selected bill was genuine or counterfeit
from physical measurements of the bill.

Point estimators for the mean function are important. Given values of
x = (x1, ..., xk)

T , a major goal of binary logistic regression is to estimate the
success probability P (Y = 1|x) = ρ(x) with the estimator

ρ̂(x) =
exp(α̂ + β̂

T
x)

1 + exp(α̂+ β̂
T
x)
. (10.5)

For tests, the p–value is an important quantity. Recall that Ho is rejected
if the p–value < δ. A p–value between 0.07 and 1.0 provides little evidence
that Ho should be rejected, a p–value between 0.01 and 0.07 provides moder-
ate evidence and a p–value less than 0.01 provides strong statistical evidence
that Ho should be rejected. Statistical evidence is not necessarily practical
evidence, and reporting the p–value along with a statement of the strength
of the evidence is more informative than stating that the p–value is less
than some chosen value such as δ = 0.05. Nevertheless, as a homework
convention, use δ = 0.05 if δ is not given.

Investigators also sometimes test whether a predictor Xj is needed in the
model given that the other k − 1 nontrivial predictors are in the model with
a 4 step Wald test of hypotheses:
i) State the hypotheses Ho: βj = 0 Ha: βj �= 0.

ii) Find the test statistic zo,j = β̂j/se(β̂j) or obtain it from output.
iii) The p–value = 2P (Z < −|zoj|) = 2P (Z > |zoj|). Find the p–value from
output or use the standard normal table.
iv) State whether you reject Ho or fail to reject Ho and give a nontechnical
sentence restating your conclusion in terms of the story problem.
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Response = Y
Coefficient Estimates

Label Estimate Std. Error Est/SE p-value
Constant α̂ se(α̂) zo,0 for Ho: α = 0

x1 β̂1 se(β̂1) zo,1 = β̂1/se(β̂1) for Ho: β1 = 0
...

...
...

...
...

xk β̂k se(β̂k) zo,k = β̂k/se(β̂k) for Ho: βk = 0

Number of cases: n

Degrees of freedom: n - k - 1

Pearson X2:

Deviance: D = G^2

-------------------------------------

Binomial Regression

Kernel mean function = Logistic

Response = Status

Terms = (Bottom Left)

Trials = Ones

Coefficient Estimates

Label Estimate Std. Error Est/SE p-value

Constant -389.806 104.224 -3.740 0.0002

Bottom 2.26423 0.333233 6.795 0.0000

Left 2.83356 0.795601 3.562 0.0004

Scale factor: 1.

Number of cases: 200

Degrees of freedom: 197

Pearson X2: 179.809

Deviance: 99.169

If Ho is rejected, then conclude that Xj is needed in the LR model for Y
given that the other k − 1 predictors are in the model. If you fail to reject
Ho, then conclude that Xj is not needed in the LR model for Y given that
the other k − 1 predictors are in the model. Note that Xj could be a very
useful LR predictor, but may not be needed if other predictors are added to
the model.
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The Wald confidence interval (CI) for βj can also be obtained from the

output: the large sample 100 (1 − δ) % CI for βj is β̂j ± z1−δ/2 se(β̂j).

The Wald test and CI tend to give good results if the sample size n
is large. Here 1 − δ refers to the coverage of the CI. Recall that a 90%
CI uses z1−δ/2 = 1.645, a 95% CI uses z1−δ/2 = 1.96, and a 99% CI uses
z1−δ/2 = 2.576.

For a LR, often 3 models are of interest: the full model that uses all k of
the predictors xT = (xT

R,x
T
O), the reduced model that uses the r predictors

xR, and the saturated model that uses n parameters θ1, ..., θn where n is
the sample size. For the full model the k + 1 parameters α, β1, ..., βk are
estimated while the reduced model has r+1 parameters. Let lSAT (θ1, ..., θn)
be the likelihood function for the saturated model and let lFULL(α,β) be the
likelihood function for the full model. Let

LSAT = log lSAT (θ̂1, ..., θ̂n)

be the log likelihood function for the saturated model evaluated at the max-
imum likelihood estimator (MLE) (θ̂1, ..., θ̂n) and let

LFULL = log lFULL(α̂, β̂)

be the log likelihood function for the full model evaluated at the MLE (α̂, β̂).
Then the deviance

D = G2 = −2(LFULL − LSAT ).

The degrees of freedom for the deviance = dfFULL = n − k − 1 where n is
the number of parameters for the saturated model and k + 1 is the number
of parameters for the full model.

The saturated model for logistic regression states that Y1, ..., Yn are inde-
pendent binomial(mi, ρi) random variables where ρ̂i = Yi/mi. The saturated
model is usually not very good for binary data (all mi = 1) or if the mi are
small. The saturated model can be good if all of the mi are large or if ρi is
very close to 0 or 1 whenever mi is not large.

If X ∼ χ2
d then E(X) = d and VAR(X) = 2d. An observed value of

x > d + 3
√
d is unusually large and an observed value of x < d − 3

√
d is

unusually small.
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When the saturated model is good, a rule of thumb is that the logistic
regression model is ok if G2 ≤ n−k−1 (or if G2 ≤ n−k−1+3

√
n− k − 1).

For binary LR, the χ2
n−k+1 approximation for G2 is rarely good even for large

sample sizes n. For LR, the ESS plot is often a much better diagnostic for
goodness of fit, especially when ESP = α+ βTxi takes on many values and
when k + 1 << n.

The Arc output on the following page, shown in symbols and for a real
data set, is used for the deviance test described after the output. Assume
that the ESS plot has been made and that the logistic regression model fits
the data well in that the nonparametric step function follows the estimated
model mean function closely. The deviance test is used to test whether β = 0.
If this is the case, then the predictors are not needed in the LR model. If
Ho : β = 0 is not rejected, then for logistic regression

ρ̂ =
n∑

i=1

Yi/
n∑

i=1

mi

should be used. Note that ρ̂ = Y for binary logistic regression.

The 4 step deviance test is
i) Ho : β = 0 HA : β �= 0
ii) test statistic G2(o|F ) = G2

o −G2
FULL.

iii) The p–value = P (χ2 > G2(o|F )) where χ2 ∼ χ2
k has a chi–square

distribution with k degrees of freedom. Note that k = k + 1 − 1 = dfo −
dfFULL = n − 1 − (n− k − 1).

iv) Reject Ho if the p–value < δ and conclude that there is a LR rela-
tionship between Y and the predictors X1, ..., Xk. If p–value ≥ δ, then fail
to reject Ho and conclude that there is not a LR relationship between Y and
the predictors X1, ..., Xk.
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Response = Y
Terms = (X1, ..., Xk)
Sequential Analysis of Deviance

Total Change
Predictor df Deviance df Deviance

Ones n− 1 = dfo G2
o

X1 n− 2 1
X2 n− 3 1
...

...
...

...
Xk n− k − 1 = dfFULL G2

FULL 1

-----------------------------------------

Data set = cbrain, Name of Fit = B1

Response = sex

Terms = (cephalic size log[size])

Sequential Analysis of Deviance

Total Change

Predictor df Deviance | df Deviance

Ones 266 363.820 |

cephalic 265 363.605 | 1 0.214643

size 264 315.793 | 1 47.8121

log[size] 263 305.045 | 1 10.7484

The output shown on the following page, both in symbols and for a real
data set, can be used to perform the change in deviance test. If the re-
duced model leaves out a single variable Xi, then the change in deviance
test becomes Ho : βi = 0 versus HA : βi �= 0. This likelihood ratio test is a
competitor of the Wald test. The likelihood ratio test is usually better than
the Wald test if the sample size n is not large, but the Wald test is currently
easier for software to produce. For large n the test statistics from the two
tests tend to be very similar (asymptotically equivalent tests).

If the reduced model is good, then the EE plot of ESP (R) = α̂R+β̂
T

RxRi

versus ESP = α̂ + β̂
T
xi should be highly correlated with the identity line

with unit slope and zero intercept.
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Response = Y Terms = (X1, ..., Xk) (Full Model)

Label Estimate Std. Error Est/SE p-value
Constant α̂ se(α̂) zo,0 for Ho: α = 0

x1 β̂1 se(β̂1) zo,1 = β̂1/se(β̂1) for Ho: β1 = 0
...

...
...

...
...

xk β̂k se(β̂k) zo,k = β̂k/se(β̂k) for Ho: βk = 0
Degrees of freedom: n - k - 1 = dfFULL

Deviance: D = G2
FULL

Response = Y Terms = (X1, ..., Xr) (Reduced Model)

Label Estimate Std. Error Est/SE p-value
Constant α̂ se(α̂) zo,0 for Ho: α = 0

x1 β̂1 se(β̂1) zo,1 = β̂1/se(β̂1) for Ho: β1 = 0
...

...
...

...
...

xr β̂r se(β̂r) zo,r = β̂k/se(β̂r) for Ho: βr = 0
Degrees of freedom: n - r - 1 = dfRED

Deviance: D = G2
RED

(Full Model) Response = Status, Terms = (Diagonal Bottom Top)

Label Estimate Std. Error Est/SE p-value

Constant 2360.49 5064.42 0.466 0.6411

Diagonal -19.8874 37.2830 -0.533 0.5937

Bottom 23.6950 45.5271 0.520 0.6027

Top 19.6464 60.6512 0.324 0.7460

Degrees of freedom: 196

Deviance: 0.009

(Reduced Model) Response = Status, Terms = (Diagonal)

Label Estimate Std. Error Est/SE p-value

Constant 989.545 219.032 4.518 0.0000

Diagonal -7.04376 1.55940 -4.517 0.0000

Degrees of freedom: 198

Deviance: 21.109



CHAPTER 10. LOGISTIC REGRESSION 347

After obtaining an acceptable full model where

SP = α+ β1x1 + · · · + βkxk = α+ βTx = α+ βT
RxR + βT

OxO

try to obtain a reduced model

SP = α+ βR1xR1 + · · · + βRrxRr = αR + βT
RxR

where the reduced model uses r of the predictors used by the full model and
xO denotes the vector of k − r predictors that are in the full model but not
the reduced model. For logistic regression, the reduced model is Yi|xRi ∼
independent Binomial(mi, ρ(xRi)).

Assume that the ESS plot looks good. Then we want to test Ho: the
reduced model is good (can be used instead of the full model) versus HA:
use the full model (the full model is significantly better than the reduced
model). Fit the full model and the reduced model to get the deviances
G2

FULL and G2
RED.

The 4 step change in deviance test is
i) Ho: the reduced model is good HA: use the full model
ii) test statistic G2(R|F ) = G2

RED −G2
FULL.

iii) The p–value = P (χ2 > G2(R|F )) where χ2 ∼ χ2
k−r has a chi–square

distribution with k degrees of freedom. Note that k is the number of non-
trivial predictors in the full model while r is the number of nontrivial pre-
dictors in the reduced model. Also notice that k − r = (k + 1) − (r + 1) =
dfRED − dfFULL = n− r − 1 − (n− k − 1).

iv) Reject Ho if the p–value < δ and conclude that the full model should
be used. If p–value ≥ δ, then fail to reject Ho and conclude that the reduced
model is good.

Interpretation of coefficients: if x1, ..., xi−1, xi+1, ..., xk can be held fixed,
then increasing xi by 1 unit increases the sufficient predictor SP by βi units.
Let ρ(x) = P (success|x) = 1 − P(failure|x) where a “success” is what is
counted and a “failure” is what is not counted (so if the Yi are binary, ρ(x) =
P (Yi = 1|x)). Then the estimated odds of success is

Ω̂(x) =
ρ̂(x)

1 − ρ̂(x)
= exp(α̂+ β̂

T
x).

In logistic regression, increasing a predictor xi by 1 unit (while holding all
other predictors fixed) multiplies the estimated odds of success by a factor
of exp(β̂i).
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Output for Full Model, Response = gender, Terms =

(age log[age] breadth circum headht height length size log[size])

Number of cases: 267, Degrees of freedom: 257, Deviance: 234.792

Logistic Regression Output for Reduced Model,

Response = gender, Terms = (height size)

Label Estimate Std. Error Est/SE p-value

Constant -6.26111 1.34466 -4.656 0.0000

height -0.0536078 0.0239044 -2.243 0.0249

size 0.00282146 0.000507935 5.555 0.0000

Number of cases: 267, Degrees of freedom: 264

Deviance: 313.457

Example 10.5. Let the response variable Y = gender = 0 for F and 1
for M. Let x1 = height (in inches) and x2 = size of head (in mm3). Logistic
regression is used, and data is from Gladstone (1905-6).

a) Predict ρ̂(x) if height = x1 = 65 and size = x2 = 3500.

b) The full model uses the predictors listed above to the right of Terms.
Perform a 4 step change in deviance test to see if the reduced model can be
used. Both models contain a constant.

Solution: a) ESP = α̂ + β̂1x1 + β̂2x2 = −6.26111 − 0.0536078(65) +
0.0028215(3500) = 0.1296. So

ρ̂(x) =
eESP

1 + eESP
=

1.1384

1 + 1.1384
= 0.5324.

b) i) Ho the reduced model is good HA use the full model
ii) G2(R|F ) = 313.457 − 234.792 = 78.665
iii) Now df = 264 − 257 = 7, and comparing 78.665 with χ2

7,0.999 = 24.32
shows that the pval = 0 < 1 − 0.999 = 0.001.

iv) Reject Ho, use the full model.

Example 10.6. Suppose that Y is a 1 or 0 depending on whether the
person is or is not credit worthy. Let x1 through x6 be the predictors and
use the following output to perform a 4 step deviance test. The credit data is
available from the text’s website as file credit.lsp, and is from Fahrmeir and
Tutz (1996).
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Response = y

Sequential Analysis of Deviance

All fits include an intercept.

Total Change

Predictor df Deviance | df Deviance

Ones 999 1221.73 |

x1 998 1177.11 | 1 44.6148

x2 997 1176.55 | 1 0.561629

x3 996 1168.33 | 1 8.21723

x4 995 1168.20 | 1 0.137583

x5 994 1163.44 | 1 4.75625

x6 993 1158.22 | 1 5.21846

Solution: i) Ho β1 = · · · = β6 HA not H0
ii) G2(0|F ) = 1221.73 − 1158.22 = 63.51
iii) Now df = 999 − 993 = 6, and comparing 63.51 with χ2

6,0.999 = 22.46
shows that the pval = 0 < 1 − 0.999 = 0.001.

iv) Reject Ho, there is a LR relationship between Y = credit worthiness
and the predictors x1, ..., x6.

Coefficient Estimates

Label Estimate Std. Error Est/SE p-value

Constant -5.84211 1.74259 -3.353 0.0008

jaw ht 0.103606 0.0383650 ? ??

Example 10.7. A museum has 60 skulls, some of which are human
and some of which are from apes. Consider trying to estimate whether the
skull type is human or ape from the height of the lower jaw. Use the above
logistic regression output to answer the following problems. The museum
data is available from the text’s website as file museum.lsp, and is from
Schaaffhausen (1878).

a) Predict ρ̂(x) if x = 40.0.
b) Find a 95% CI for β.
c) Perform the 4 step Wald test for Ho : β = 0.
Solution: a) exp[ESP ] = exp[α̂+β̂(40)] = exp[−5.84211+0.103606(40)] =

exp[−1.69787] = 0.1830731. So

ρ̂(x) =
eESP

1 + eESP
=

0.1830731

1 + 0.1830731
= 0.1547.
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b) β̂ ± 1.96SE(β̂) = 0.103606 ± 1.96(0.03865) = 0.103606 ± 0.0751954 =
(0.02841, 0.1788).

c) i) Ho β = 0 HA β �= 0

ii) Z0 =
β̂

SE(β̂)
=

0.103606

0.038365
= 2.7005.

iii) Using a standard normal table, pval = 2P (Z < −2.70) = 2(0.0035) =
0.0070.

iv) Reject Ho, jaw height is a useful LR predictor for whether the skull
is human or ape (so is needed in the LR model).

10.4 Variable Selection

This section gives some rules of thumb for variable selection for logistic re-
gression. Before performing variable selection, a useful full model needs to
be found. The process of finding a useful full model is an iterative process.
Given a predictor x, sometimes x is not used by itself in the full model.
Suppose that Y is binary. Then to decide what functions of x should be in
the model, look at the conditional distribution of x|Y = i for i = 0, 1. The
rules shown in Table 10.1 are used if x is an indicator variable or if x is a
continuous variable. See Cook and Weisberg (1999a, p. 501) and Kay and
Little (1987) .

The full model will often contain factors and interaction. If w is a nominal
variable with J levels, make w into a factor by using use J − 1 (indicator or)
dummy variables x1,w, ..., xJ−1,w in the full model. For example, let xi,w = 1 if

Table 10.1: Building the Full Logistic Regression Model

distribution of x|y = i variables to include in the model
x|y = i is an indicator x
x|y = i ∼ N(µi, σ

2) x
x|y = i ∼ N(µi, σ

2
i ) x and x2

x|y = i has a skewed distribution x and log(x)
x|y = i has support on (0,1) log(x) and log(1 − x)
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w is at its ith level, and let xi,w = 0, otherwise. An interaction is a product
of two or more predictor variables. Interactions are difficult to interpret.
Often interactions are included in the full model, and then the reduced model
without any interactions is tested. The investigator is often hoping that the
interactions are not needed.

A scatterplot of x versus Y is used to visualize the conditional distri-
bution of Y |x. A scatterplot matrix is an array of scatterplots and is used
to examine the marginal relationships of the predictors and response. Place
Y on the top or bottom of the scatterplot matrix. Variables with outliers,
missing values or strong nonlinearities may be so bad that they should not be
included in the full model. Suppose that all values of the variable x are posi-
tive. The log rule says add log(x) to the full model if max(xi)/min(xi) > 10.
For the binary logistic regression model, mark the plotted points by a 0 if
Y = 0 and by a + if Y = 1.

To make a full model, use the above discussion and then make an ESS
plot to check that the full model is good. The number of predictors in the
full model should be much smaller than the number of data cases n. Suppose
that the Yi are binary for i = 1, ..., n. Let N1 =

∑
Yi = the number of 1s and

N0 = n−N1 = the number of 0s. A rough rule of thumb is that the full model
should use no more than min(N0, N1)/5 predictors and the final submodel
should have r predictor variables where r is small with r ≤ min(N0, N1)/10.

Variable selection, also called subset or model selection, is the search for
a subset of predictor variables that can be deleted without important loss of
information. A model for variable selection for LR can be described by

SP = α+ βTx = α+ βT
SxS + βT

ExE = α+ βT
SxS (10.6)

where x = (xT
S ,x

T
E)T is a k× 1 vector of nontrivial predictors, xS is a rS × 1

vector and xE is a (k − rS) × 1 vector. Given that xS is in the model,
βE = 0 and E denotes the subset of terms that can be eliminated given that
the subset S is in the model.

Since S is unknown, candidate subsets will be examined. Let xI be the
vector of r terms from a candidate subset indexed by I , and let xO be the
vector of the remaining terms (out of the candidate submodel). Then

SP = α + βT
I xI + βT

OxO. (10.7)
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Definition 10.9. The model with SP = α + βTx that uses all of the
predictors is called the full model. A model with SP = α + βT

I xI that only
uses the constant and a subset xI of the nontrivial predictors is called a
submodel. The full model is always a submodel.

Suppose that S is a subset of I and that model (10.6) holds. Then

SP = α + βT
SxS = α+ βT

SxS + βT
(I/S)xI/S + 0T xO = α+ βT

I xI (10.8)

where xI/S denotes the predictors in I that are not in S. Since this is true
regardless of the values of the predictors, βO = 0 if the set of predictors S is
a subset of I. Let (α̂, β̂) and (α̂I , β̂I) be the estimates of (α,β) obtained from
fitting the full model and the submodel, respectively. Denote the ESP from

the full model by ESP = α̂ + β̂
T
xi and denote the ESP from the submodel

by ESP (I) = α̂I + β̂IxIi.

Definition 10.10. An EE plot is a plot of ESP (I) versus ESP .

Variable selection is closely related to the change in deviance test for
a reduced model. You are seeking a subset I of the variables to keep in
the model. The AIC(I) statistic is used as an aid in backward elimination
and forward selection. The full model and the model Imin found with the
smallest AIC are always of interest. Burnham and Anderson (2004) suggest
that if ∆(I) = AIC(I)− AIC(Imin), then models with ∆(I) ≤ 2 are good,
models with 4 ≤ ∆(I) ≤ 7 are borderline, and models with ∆(I) > 10 should
not be used as the final submodel. Create a full model. The full model has
a deviance at least as small as that of any submodel. The final submodel
should have an EE plot that clusters tightly about the identity line. As a
rough rule of thumb, a good submodel I has corr(ESP (I), ESP ) ≥ 0.95.
Look at the submodel II with the smallest number of predictors such that
∆(II) ≤ 2, and also examine submodels I with fewer predictors than II with
∆(I) ≤ 7. II is the initial submodel to examine.

Backward elimination starts with the full model with k nontrivial vari-
ables, and the predictor that optimizes some criterion is deleted. Then there
are k − 1 variables left, and the predictor that optimizes some criterion is
deleted. This process continues for models with k − 2, k − 3, ..., 3 and 2
predictors.
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Forward selection starts with the model with 0 variables, and the pre-
dictor that optimizes some criterion is added. Then there is 1 variable in
the model, and the predictor that optimizes some criterion is added. This
process continues for models with 2, 3, ..., k − 1 and k predictors. Both for-
ward selection and backward elimination result in a sequence of k models
{x∗1}, {x∗1, x∗2}, ..., {x∗1, x∗2, ..., x∗k−1}, {x∗1, x∗2, ..., x∗k} = full model, and the two
sequences need not be the same.

All subsets variable selection can be performed with the following
procedure. Compute the LR ESP and the OLS ESP found by the OLS
regression of Y on x. Check that |corr(LR ESP, OLS ESP)| ≥ 0.95. This
high correlation will exist for many data sets. Then perform multiple linear
regression and the corresponding all subsets OLS variable selection with the
Cp(I) criterion. If the sample size n is large and Cp(I) ≤ 2(r + 1) where the
subset I has r + 1 variables including a constant, then corr(OLS ESP, OLS
ESP(I)) will be high by the proof of Proposition 3.2, and hence corr(ESP,
ESP(I)) will be high. In other words, if the OLS ESP and LR ESP are highly
correlated, then performing multiple linear regression and the corresponding
MLR variable selection (eg forward selection, backward elimination or all
subsets selection) based on the Cp(I) criterion may provide many interesting
submodels.

Know how to find good models from output. The following rules of thumb
(roughly in order of decreasing importance) may be useful. It is often not
possible to have all 10 rules of thumb to hold simultaneously. Let submodel I
have rI +1 predictors, including a constant. Do not use more predictors than
submodel II , which has no more predictors than the minimum AIC model.
It is possible that II = Imin = Ifull. Then the submodel I is good if
i) the ESS plot for the submodel looks like the ESS plot for the full model.
ii) Want corr(ESP,ESP(I)) ≥ 0.95.
iii) The plotted points in the EE plot cluster tightly about the identity line.
iv) Want the p-value ≥ 0.01 for the change in deviance test that uses I as
the reduced model.
v) Want rI + 1 ≤ min(N1, N0)/10.
vi) Want the deviance G2(I) close to G2(full) (see iv): G2(I) ≥ G2(full)
since adding predictors to I does not increase the deviance).
vii) Want AIC(I) ≤ AIC(Imin) + 7 where Imin is the minimum AIC model
found by the variable selection procedure.
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viii) Want hardly any predictors with p-values > 0.05.
ix) Want few predictors with p-values between 0.01 and 0.05.
x) Want G2(I) ≤ n− rI − 1 + 3

√
n − rI − 1.

Heuristically, backward elimination tries to delete the variable that will
increase the deviance the least. An increase in deviance greater than 4 (if the
predictor has 1 degree of freedom) may be troubling in that a good predictor
may have been deleted. In practice, the backward elimination program may
delete the variable such that the submodel I with j predictors has a) the
smallest AIC(I), b) the smallest deviance G2(I) or c) the biggest p–value
(preferably from a change in deviance test but possibly from a Wald test)
in the test Ho βi = 0 versus HA βi �= 0 where the model with j + 1 terms
from the previous step (using the j predictors in I and the variable x∗j+1) is
treated as the full model.

Heuristically, forward selection tries to add the variable that will decrease
the deviance the most. A decrease in deviance less than 4 (if the predictor has
1 degree of freedom) may be troubling in that a bad predictor may have been
added. In practice, the forward selection program may add the variable such
that the submodel I with j nontrivial predictors has a) the smallest AIC(I),
b) the smallest deviance G2(I) or c) the smallest p–value (preferably from a
change in deviance test but possibly from a Wald test) in the test Ho βi = 0
versus HA βi �= 0 where the current model with j terms plus the predictor
xi is treated as the full model (for all variables xi not yet in the model).

Suppose that the full model is good and is stored in M1. Let M2, M3,
M4 and M5 be candidate submodels found after forward selection, backward
elimination, et cetera. Make a scatterplot matrix of the ESPs for M2, M3,
M4, M5 and M1. Good candidates should have estimated sufficient predictors
that are highly correlated with the full model estimated sufficient predictor
(the correlation should be at least 0.9 and preferably greater than 0.95). For
binary logistic regression, mark the symbols (0 and +) using the response
variable Y .

The final submodel should have few predictors, few variables with large
Wald p–values (0.01 to 0.05 is borderline), a good ESS plot and an EE plot
that clusters tightly about the identity line. If a factor has I − 1 dummy
variables, either keep all I − 1 dummy variables or delete all I − 1 dummy
variables, do not delete some of the dummy variables.
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Example 10.8. The following output is for forward selection and back-
ward elimination. All models use a constant. For forward selection, the min
AIC model uses {F}LOC, TYP, AGE, CAN, SYS, PCO, and PH. Model II

uses {F}LOC, TYP, AGE, CAN, and SYS. Let model I use {F}LOC, TYP,
AGE, and CAN. This model may be good, so for forward selection, models
II and I are the first models to examine.

Forward Selection comment

Base terms: ({F}LOC TYP)

df Deviance Pearson X2 | k AIC > min AIC + 7

Add: AGE 195 141.873 187.84 | 5 151.873

Base terms: ({F}LOC TYP AGE)

df Deviance Pearson X2 | k AIC < min AIC + 7

Add: CAN 194 134.595 170.367 | 6 146.595

({F}LOC TYP AGE CAN) could be a good model

Base terms: ({F}LOC TYP AGE CAN)

df Deviance Pearson X2 | k AIC < min AIC + 2

Add: SYS 193 128.441 179.753 | 7 142.441

({F}LOC TYP AGE CAN SYS) could be a good model

Base terms: ({F}LOC TYP AGE CAN SYS)

df Deviance Pearson X2 | k AIC < min AIC + 2

Add: PCO 192 126.572 186.71 | 8 142.572

PCO not important since AIC < min AIC + 2

Base terms: ({F}LOC TYP AGE CAN SYS PCO)

df Deviance Pearson X2 | k AIC

Add: PH 191 123.285 191.264 | 9 141.285 min AIC

PH not important since AIC < min AIC + 2
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Backward Elimination

Current terms: (AGE CAN {F}LOC PCO PH PRE SYS TYP)

df Deviance Pearson X2| k AIC

Delete: PRE 191 123.285 191.264 | 9 141.285 min AIC model

Current terms: (AGE CAN {F}LOC PCO PH SYS TYP)

df Deviance Pearson X2 | k AIC < min AIC + 2

Delete: PH 192 126.572 186.71 |8 142.572 PH not important

Current terms: (AGE CAN {F}LOC PCO SYS TYP)

df Deviance Pearson X2 |k AIC < min AIC + 2

Delete: PCO 193 128.441 179.753 | 7 142.441 PCO not important

(AGE CAN {F}LOC SYS TYP) could be good model

Current terms: (AGE CAN {F}LOC SYS TYP)

df Deviance Pearson X2| k AIC < min AIC + 7

Delete: SYS 194 134.595 170.367 |6 146.595

SYS may not be important

(AGE CAN {F}LOC TYP) could be good model

Current terms: (AGE CAN {F}LOC TYP)

df Deviance Pearson X2 | k AIC > min AIC + 7

Delete: CAN 195 141.873 187.84 | 5 151.873 AIC

B1 B2 B3 B4
df 255 258 259 263

# of predictors 11 8 7 3
# with 0.01 ≤ Wald p-value ≤ 0.05 2 1 0 0

# with Wald p-value > 0.05 4 0 0 0
G2 233.765 237.212 243.482 278.787
AIC 257.765 255.212 259.482 286.787

corr(B1:ETA’U,Bi:ETA’U) 1.0 0.99 0.97 0.80
p-value for change in deviance test 1.0 0.328 0.045 0.000

Example 10.9. The above table gives summary statistics for 4 models
considered as final submodels after performing variable selection. One pre-
dictor was a factor, and a factor was considered to have a bad Wald p-value
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Figure 10.5: EE Plot Suggests Race is an Important Predictor

> 0.05 if all of the dummy variables corresponding to the factor had p-values
> 0.05. Similarly the factor was considered to have a borderline p-value with
0.01 ≤ p-value ≤ 0.05 if none of the dummy variables corresponding to the
factor had a p-value < 0.01 but at least one dummy variable had a p-value
between 0.01 and 0.05. The response was binary and logistic regression was
used. The ESS plot for the full model B1 was good. Model B2 was the min-
imum AIC model found. There were 267 cases: for the response, 113 were
0’s and 154 were 1’s.

Which two models are the best candidates for the final submodel? Explain
briefly why each of the other 2 submodels should not be used.

Solution: B2 and B3 are best. B1 has too many predictors with rather
large pvalues. For B4, the AIC is too high and the corr and pvalue are too
low.

Example 10.10. The ICU data studies the survival of 200 patients
following admission to an intensive care unit. The response variable was
STA (0 = Lived, 1 = Died). The 19 predictors were primarily indicator
variables describing the health of the patient at time of admission, but two
factors had 3 levels including RACE (1 = White, 2 = Black, 3 = Other). The
response plot showed that the full model using the 19 predictors was useful



CHAPTER 10. LOGISTIC REGRESSION 358

for predicting survival. Variable selection suggested a submodel using five
predictors. The EE plot of the submodel ESP vs. full model ESP is shown
in Figure 10.5. The plotted points in the EE plot should cluster tightly
about the identity line if the full model and the submodel are good. This
clustering did not occur in Figure 10.5. The lowest cluster of points and the
case on the right nearest to the identity line correspond to black patients.
The main cluster and upper right cluster correspond to patients who are not
black. When RACE is added to the submodel, all of the points cluster about
the identity line. Although variable selection did not suggest that RACE
is important, the above results suggest that RACE is important. Also the
RACE variable could be replaced by an indicator for black.

10.5 Complements

Collett (1999) and Hosmer and Lemeshow (2000) are excellent texts on lo-
gistic regression. See Christensen (1997) for a Bayesian approach and see
Cramer (2003) for econometric applications. Also see Allison (2001), Cox
and Snell (1989), Hilbe (2009), Kleinbaum and Klein (2005a) and Pampel
(2000).

The ESS plot is essential for understanding the logistic regression model
and for checking goodness and lack of fit if the estimated sufficient predictor

α̂+ β̂
T
x takes on many values. The ESS plot and OD plot are examined in

Olive (2009e). Some other diagnostics include Cook (1996), Eno and Terrell
(1999), Hosmer and Lemeshow (1980), Landwehr, Pregibon and Shoemaker
(1984), Menard (2000), Pardoe and Cook (2002), Pregibon (1981), Simonoff
(1998), Su and Wei (1991), Tang (2001) and Tsiatis (1980). Hosmer and
Lemeshow (2000) has additional references. Also see Cheng and Wu (1994),
Kauermann and Tutz (2001) and Pierce and Schafer (1986).

The ESS plot can also be used to measure overlap in logistic regression.
See Rousseeuw and Christmann (2003).

For Binomial regression and BBR, the OD plot can be used to complement
tests and diagnostics for overdispersion such as those given in Collett (1999,
ch. 6), Dean (1992), Ganio and Schafer (1992), Lambert and Roeder (1995).

Olive and Hawkins (2005) give the simple all subsets variable selection
procedure that can be applied to logistic regression using readily available
OLS software. The procedures of Lawless and Singhai (1978) and Nordberg
(1982) are much more complicated.
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Variable selection using the AIC criterion is discussed in Burnham and
Anderson (2004), Cook and Weisberg (1999) and Hastie (1987).

The existence of the logistic regression MLE is discussed in Albert and
Andersen (1984) and Santer and Duffy (1986).

Ordinary least squares (OLS) can also be useful for logistic regression.
The ANOVA F test, partial F test, and OLS t tests are often asymptotically
valid when the conditions in Definition 10.3 are met, and the OLS ESP and
LR ESP are often highly correlated. See Haggstrom (1983) and Theorem
10.1 below. Assume that Cov(x) ≡ Σx and that Cov(x, Y ) = Σx,Y . Let
µj = E(x|Y = j) for j = 0, 1. Let Ni be the number of Ys that are equal to
i for i = 0, 1. Then

µ̂i =
1

Ni

∑
j:Yj=i

xj

for i = 0, 1 while π̂i = Ni/n and π̂1 = 1− π̂0. Notice that Theorem 10.1 holds
as long as Cov(x) is nonsingular and Y is binary with values 0 and 1. The
LR and discriminant function models need not be appropriate.

Theorem 10.1. Assume that Y is binary and that Cov(x) = Σx is
nonsingular. Let (α̂OLS, β̂OLS) be the OLS estimator found from regressing
Y on a constant and x (using software originally meant for multiple linear
regression). Then

β̂OLS =
n

n− 1
Σ̂

−1

x Σ̂xY =
n

n− 1
π̂0π̂1Σ̂

−1

x (µ̂1 − µ̂0)

D→ βOLS = π0π1Σ
−1
x (µ1 − µ0) as n → ∞.

Proof. We have that

β̂OLS =
n

n− 1
Σ̂

−1

x Σ̂xY
D→ βOLS as n → ∞

and

Σ̂xY =
1

n

n∑
i=1

xiYi − x Y .

Thus

Σ̂xY =
1

n

 ∑
j:Yj=1

xj(1) +
∑

j:Yj=0

xj(0)

 − x π̂1 =
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1

n
(N1µ̂1) −

1

n
(N1µ̂1 +N0µ̂0)π̂1 = π̂1µ̂1 − π̂2

1µ̂1 − π̂1π̂0µ̂0 =

π̂1(1 − π̂1)µ̂1 − π̂1π̂0µ̂0 = π̂1π̂0(µ̂1 − µ̂0)

and the result follows. QED

The discriminant function estimator

β̂D =
n(n− 1)

N0N1

Σ̂
−1

Σ̂xβ̂OLS.

Now when the conditions of Definition 10.3 are met and if µ1 − µ0 is small
enough so that there is not perfect classification, then

βLR = Σ−1(µ1 −µ0).

Empirically, the OLS ESP and LR ESP are highly correlated for many LR
data sets where the conditions are not met, eg when some of the predictors
are factors. This suggests that βLR ≈ d Σ−1

x (µ1−µ0) for many LR data sets
where d is some constant depending on the data. Results from Haggstrom
(1983) suggest that if a binary regression model is fit using OLS software
for MLR, then a rough approximation is β̂LR ≈ β̂OLS/MSE. So a rough
approximation is LR ESP ≈ (OLS ESP)/MSE.

Although the logistic regression model is the most important model for
binary regression, several other models are also used. Notice that ρ(x) =
P (S|x) is the population probability of success S given x, while 1 − ρ(x) =
P (F |x) is the probability of failure F given x. In particular, for binary
regression,

ρ(x) = P (Y = 1|x) = 1 − P (Y = 0|x).

If this population proportion ρ = ρ(α + βT x), then the model is a 1D re-
gression model. The model is a generalized linear model if the link function
g is differentiable and monotone so that g(ρ(α + βTx)) = α + βT x and
g−1(α + βT x) = ρ(α + βTx). Usually the inverse link function corresponds
to the cumulative distribution function of a location scale family. For exam-
ple, for logistic regression, g−1(x) = exp(x)/(1 + exp(x)) which is the cdf of
the logistic L(0, 1) distribution. For probit regression, g−1(x) = Φ(x) which
is the cdf of the Normal N(0, 1) distribution. For the complementary log-log
link, g−1(x) = 1 − exp[− exp(x)] which is the cdf for the smallest extreme
value distribution. For this model, g(ρ(x)) = log[− log(1−ρ(x))] = α+βTx.
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10.6 Problems

PROBLEMS WITH AN ASTERISK * ARE USEFUL.

Output for problem 10.1: Response = sex

Coefficient Estimates

Label Estimate Std. Error Est/SE p-value

Constant -18.3500 3.42582 -5.356 0.0000

circum 0.0345827 0.00633521 5.459 0.0000

10.1. Consider trying to estimate the proportion of males from a popu-
lation of males and females by measuring the circumference of the head. Use
the above logistic regression output to answer the following problems.

a) Predict ρ̂(x) if x = 550.0.

b) Find a 95% CI for β.

c) Perform the 4 step Wald test for Ho : β = 0.

Output for Problem 10.2

Response = sex

Coefficient Estimates

Label Estimate Std. Error Est/SE p-value

Constant -19.7762 3.73243 -5.298 0.0000

circum 0.0244688 0.0111243 2.200 0.0278

length 0.0371472 0.0340610 1.091 0.2754

10.2∗. Now the data is as in Problem 10.1, but try to estimate the pro-
portion of males by measuring the circumference and the length of the head.
Use the above logistic regression output to answer the following problems.

a) Predict ρ̂(x) if circumference = x1 = 550.0 and length = x2 = 200.0.

b) Perform the 4 step Wald test for Ho : β1 = 0.

c) Perform the 4 step Wald test for Ho : β2 = 0.
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Output for problem 10.3

Response = ape

Terms = (lower jaw, upper jaw, face length)

Trials = Ones

Sequential Analysis of Deviance

All fits include an intercept.

Total Change

Predictor df Deviance | df Deviance

Ones 59 62.7188 |

lower jaw 58 51.9017 | 1 10.8171

upper jaw 57 17.1855 | 1 34.7163

face length 56 13.5325 | 1 3.65299

10.3∗. A museum has 60 skulls of apes and humans. Lengths of the
lower jaw, upper jaw and face are the explanatory variables. The response
variable is ape (= 1 if ape, 0 if human). Using the output above, perform
the four step deviance test for whether there is a LR relationship between
the response variable and the predictors.

Output for Problem 10.4.

Full Model

Response = ape

Coefficient Estimates

Label Estimate Std. Error Est/SE p-value

Constant 11.5092 5.46270 2.107 0.0351

lower jaw -0.360127 0.132925 -2.709 0.0067

upper jaw 0.779162 0.382219 2.039 0.0415

face length -0.374648 0.238406 -1.571 0.1161

Number of cases: 60

Degrees of freedom: 56

Pearson X2: 16.782

Deviance: 13.532

Reduced Model

Response = ape

Coefficient Estimates
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Label Estimate Std. Error Est/SE p-value

Constant 8.71977 4.09466 2.130 0.0332

lower jaw -0.376256 0.115757 -3.250 0.0012

upper jaw 0.295507 0.0950855 3.108 0.0019

Number of cases: 60

Degrees of freedom: 57

Pearson X2: 28.049

Deviance: 17.185

10.4∗. Suppose the full model is as in Problem 10.3, but the reduced
model omits the predictor face length. Perform the 4 step change in deviance
test to examine whether the reduced model can be used.

B1 B2 B3 B4
df 945 956 968 974

# of predictors 54 43 31 25
# with 0.01 ≤ Wald p-value ≤ 0.05 5 3 2 1

# with Wald p-value > 0.05 8 4 1 0
G2 892.96 902.14 929.81 956.92
AIC 1002.96 990.14 993.81 1008.912

corr(B1:ETA’U,Bi:ETA’U) 1.0 0.99 0.95 0.90
p-value for change in deviance test 1.0 0.605 0.034 0.0002

10.5∗. The above table gives summary statistics for 4 models considered
as final submodels after performing variable selection. (Several of the predic-
tors were factors, and a factor was considered to have a bad Wald p-value >
0.05 if all of the dummy variables corresponding to the factor had p-values >
0.05. Similarly the factor was considered to have a borderline p-value with
0.01 ≤ p-value ≤ 0.05 if none of the dummy variables corresponding to the
factor had a p-value < 0.01 but at least one dummy variable had a p-value
between 0.01 and 0.05.) The response was binary and logistic regression was
used. The ESS plot for the full model B1 was good. Model B2 was the
minimum AIC model found. There were 1000 cases: for the response, 300
were 0’s and 700 were 1’s.

a) For the change in deviance test, if the p-value ≥ 0.07, there is little
evidence that Ho should be rejected. If 0.01 ≤ p-value < 0.07 then there is
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moderate evidence that Ho should be rejected. If p-value < 0.01 then there
is strong evidence that Ho should be rejected. For which models, if any, is
there strong evidence that “Ho: reduced model is good” should be rejected.

b) For which plot is “corr(B1:ETA’U,Bi:ETA’U)” (using notation from
Arc) relevant?

c) Which model should be used as the final submodel? Explain briefly
why each of the other 3 submodels should not be used.

Response = pass Terms = (hscalc survey)

Coefficient Estimates

Label Estimate Std. Error Est/SE p-value

Constant 0.875469 0.532291 1.645 0.1000

hscalc 10.3274 54.7562 0.189 0.8504

survey -2.26176 1.23828 -1.827 0.0678

10.6. The response variable pass was a 1 if the Math 150 (intro calc)
student got a C or higher on the combined final and a 0 (withdrew, D or
F) otherwise. Data was collected at the beginning of the semester on 31
students who took a section of Math 150 in Fall, 2002. Here x1 = hscalc was
coded as a 1 if the student said that their last math class was high school
calculus and as a 0 otherwise. Here x2 = survey was coded as a 1 if the
student failed to turn in the survey, 0 otherwise.

a) Predict ρ̂(x) if hscalc = x1 = 1.0 and survey = x2 = 0.0.
b) Perform the 4 step Wald test for Ho : β1 = 0.
c) Perform the 4 step Wald test for Ho : β2 = 0.

Arc Problems

The following two problems use data sets from Cook and Weisberg (1999a).

10.7. Activate the banknote.lsp dataset with the menu commands
“File > Load > Data > Arcg > banknote.lsp.” Scroll up the screen to read
the data description. Twice you will fit logistic regression models and include
the coefficients in Word. Print out this output when you are done and include
the output with your homework.
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From Graph&Fit select Fit binomial response. Select Top as the predictor,
Status as the response and ones as the number of trials.

a) Include the output in Word.

b) Predict ρ̂(x) if x = 10.7.

c) Find a 95% CI for β.

d) Perform the 4 step Wald test for Ho : β = 0.

e) From Graph&Fit select Fit binomial response. Select Top and Diagonal
as predictors, Status as the response and ones as the number of trials. Include
the output in Word.

f) Predict ρ̂(x) if x1 = Top = 10.7 and x2 = Diagonal = 140.5.

g) Find a 95% CI for β1.

h) Find a 95% CI for β2.

i) Perform the 4 step Wald test for Ho : β1 = 0.

j) Perform the 4 step Wald test for Ho : β2 = 0.

10.8∗. Activate banknote.lsp in Arc. with the menu commands
“File> Load >Data > Arcg> banknote.lsp.” Scroll up the screen to read the
data description. From Graph&Fit select Fit binomial response. Select Top
and Diagonal as predictors, Status as the response and ones as the number
of trials.

a) Include the output in Word.

b) From Graph&Fit select Fit linear LS. Select Diagonal and Top for
predictors, and Status for the response. From Graph&Fit select Plot of and
select L2:Fit-Values for H, B1:Eta’U for V, and Status for Mark by. Include

the plot in Word. Is the plot linear? How are α̂OLS + β̂
T

OLSx and α̂logistic +

β̂
T

logisticx related (approximately)?

10.9∗. (ESS Plot): Activate cbrain.lsp in Arc with the menu commands
“File > Load > 3 1/2 Floppy(A:) > cbrain.lsp.” Scroll up the screen to read
the data description. From Graph&Fit select Fit binomial response. Select
brnweight, cephalic, breadth, cause, size, and headht as predictors, sex as the
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response and ones as the number of trials. Perform the logistic regression
and from Graph&Fit select Plot of. Place sex on V and B1:Eta’U on H. From
the OLS popup menu, select Logistic and move the slider bar to 1. From the
lowess popup menu select SliceSmooth and move the slider bar until the fit is
good. Include your plot in Word. Are the slice means (observed proportions)
tracking the logistic curve (fitted proportions) very well?

10.10∗. Suppose that you are given a data set, told the response, and
asked to build a logistic regression model with no further help. In this prob-
lem, we use the cbrain data to illustrate the process.

a) Activate cbrain.lsp in Arc with the menu commands
“File > Load > 1/2 Floppy(A:) > cbrain.lsp.” Scroll up the screen to read
the data description. From Graph&Fit select Scatterplot-matrix of. Select
age, breadth, cephalic, circum, headht, height, length, size, and sex. Also place
sex in the Mark by box.

Include the scatterplot matrix in Word.

b) Use the menu commands “cbrain>Transform” and select age and the
log transformation. Why was the log transformation chosen?

c) From Graph&Fit select Plot of and select size. Also place sex in the
Mark by box. A plot will come up. From the GaussKerDen menu (the
triangle to the left) select Fit by marks, move the sliderbar to 0.9, and include
the plot in Word.

d) Use the menu commands “cbrain>Transform” and select size and the
log transformation. From Graph&Fit select Fit binomial response. Select
age, log(age), breadth, cephalic, circum, headht, height, length, size, log(size),
as predictors, sex as the response and ones as the number of trials. This
is the full model. Perform the logistic regression and include the relevant
output for testing in Word.

e) From Graph&Fit select Plot of. Place sex on V and B1:Eta’U on
H. From the OLS popup menu, select Logistic and move the slider bar to 1.
From the lowess popup menu select SliceSmooth and move the slider bar until
the fit is good. Include your plot in Word. Are the slice means (observed
proportions) tracking the logistic curve (fitted proportions) fairly well?

f) From B1 select Examine submodels and select Add to base model (For-
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ward Selection). Include the output with df = 259 in Word.

g) From B1 select Examine submodels and select Delete from full model
(Backward Elimination). Include the output with df corresponding to the
minimum AIC model in Word. What predictors does this model use?

h) As a final submodel, use the model from f): from Graph&Fit select
Fit binomial response. Select age, log(age), circum, height, length, size, and
log(size) as predictors, sex as the response and ones as the number of trials.
Perform the logistic regression and include the relevant output for testing in
Word.

i) Put the EE plot H B2 ETA’U versus V B1 ETA’U in Word. Is the plot
linear?

j) From Graph&Fit select Plot of. Place sex on V and B2:Eta’U on H.
From the OLS popup menu, select Logistic and move the slider bar to 1.
From the lowess popup menu select SliceSmooth and move the slider bar until
the fit is good. Include your plot in Word. Are the slice means (observed
proportions) tracking the logistic curve (fitted proportions) fairly well?

k) Perform the 4 step change in deviance test using the full model in d)
and the reduced submodel in h).

Now act as if the final submodel is the full model.

l) From B2 select Examine submodels click OK and include the output
in Word. Then use the output to perform a 4 step deviance test on the
submodel.

10.11∗. In this problem you will find a good submodel for the ICU data
obtained from STATLIB. Get the file ICU.lsp from the text’s website.

a) Activate ICU.lsp in Arc with the menu commands
“File > Load > 1/2 Floppy(A:) > ICU.lsp.” Scroll up the screen to read the
data description.

b) Use the menu commands “ICU>Make factors” and select loc and race.

c) From Graph&Fit select Fit binomial response. Select STA as the re-
sponse and ones as the number of trials. The full model will use every
predictor except ID, LOC and RACE (the latter 2 are replaced by their fac-
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tors): select AGE, Bic, CAN, CPR, CRE, CRN, FRA, HRA, INF, {F}LOC ,
PCO, PH, PO2 , PRE , {F}RACE, SER, SEX, SYS and TYP as predictors.
Perform the logistic regression and include the relevant output for testing in
Word.

d) Make the ESS plot for the full model: from Graph&Fit select Plot of.
Place STA on V and B1:Eta’U on H. From the OLS popup menu, select
Logistic and move the slider bar to 1. From the lowess popup menu select
SliceSmooth and move the slider bar until the fit is good. Include your plot
in Word. Is the full model good?

e) Using what you have learned in class find a good submodel and include
the relevant output in Word.

(Hints: Create a full model. The full model has a deviance at least
as small as that of any submodel. Consider forward selection and backward
elimination. For each method, find the submodel Imin with the smallest AIC.
Let ∆(I) = AIC(I) − AIC(Imin), and find submodel II with the smallest
number of predictors such that ∆(II) ≤ 2, and also examine submodels I
with fewer predictors than II that have ∆(I) ≤ 7. The final submodel should
have an EE plot that clusters tightly about the identity line. As a rough rule
of thumb, a good submodel I has corr(ESP (I), ESP ) ≥ 0.95. Submodel II is
your initial candidate model. Fit this candidate model and look at the Wald
test p–values. Try to eliminate predictors with large p–values but make sure
that the deviance does not increase too much. WARNING: do not delete
part of a factor. Either keep all J − 1 factor dummy variables or delete all
J−1 factor dummy variables. You may have several models, B2, B3, B4 and
B5 to examine. Let B1 be the full model. Make the EE and ESS plots for
each model. WARNING: if an important factor is in the full model but not
the reduced model, then the plotted points in the EE plot may follow more
than 1 line. See part g) below.)

f) Make an ESS plot for your final submodel.

g) Suppose that B1 contains your full model and B5 contains your final
submodel. Make an EE plot for your final submodel: from Graph&Fit select
Plot of. Select B1:Eta’U for the V box and B5:Eta’U, for the H box. After
the plot appears, click on the options popup menu. A window will appear.
Type y = x and click on OK. This action adds the identity line to the plot.
Include the plot in Word.
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If the full model is good and the EE plot is good, then the plotted points
should cluster tightly about the identity line. If the full model is good and
an important factor is deleted, then the bulk of the data will cluster tightly
about the identity line, but some points may cluster about different lines. If
the deleted factor was important and had J levels, there could be clusters
about J lines, but there could be clusters about as few as two lines if only
two groups of levels differ. Such clustering in the EE plot suggests that the
deleted factor is probably important.

h) Using e), f), g) and any additional output that you desire (eg AIC(full),
AIC(min) and AIC(final submodel), explain why your final submodel is good.

10.12. In this problem you will examine the museum skull data.

a) Activate museum.lsp in Arc with the menu commands
“File > Load > 3 1/2 Floppy(A:) > museum.lsp.” Scroll up the screen to
read the data description.

b) From Graph&Fit select Fit binomial response. Select ape as the re-
sponse and ones as the number of trials. Select x5 as the predictor. Perform
the logistic regression and include the relevant output for testing in Word.

c) Make the ESS plot and place it in Word (the response variable is ape
not y). Is the LR model good?

Now you will examine logistic regression when there is perfect classifica-
tion of the sample response variables. Assume that the model used in d)–h)
is in menu B2.

d) From Graph&Fit select Fit binomial response. Select ape as the re-
sponse and ones as the number of trials. Select x3 as the predictor. Perform
the logistic regression and include the relevant output for testing in Word.

e) Make the ESS plot and place it in Word (the response variable is ape
not y). Is the LR model good?

f) Perform the Wald test for Ho : β = 0.

g) From B2 select Examine submodels and include the output in Word.
Then use the output to perform a 4 step deviance test on the submodel used
in part d).
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h) The tests in f) and g) are both testing Ho : β = 0 but give different
results. Why are the results different and which test is correct?

10.13. In this problem you will find a good submodel for the credit data
from Fahrmeir and Tutz (2001).

a) Activate credit.lsp in Arc with the menu commands
“File > Load > Floppy(A:) > credit.lsp.” Scroll up the screen to read the
data description. This is a big data set and computations may take several
minutes.

b) Use the menu commands “credit>Make factors” and select x1, x3, x4, x6,
x7, x8, x9, x10, x11, x12, x14, x15, x16, and x17. Then click on OK.

c) From Graph&Fit select Fit binomial response. Select y as the response
and ones as the number of trials. Select {F}x1, x2, {F}x3, {F}x4, x5, {F}x6,
{F}x7, {F}x8, {F}x9, {F}x10, {F}x11, {F}x12, x13, {F}x14, {F}x15, {F}x16,
{F}x17, x18, x19 and x20 as predictors. Perform the logistic regression and
include the relevant output for testing in Word. You should get 1000 cases,
df = 945, and a deviance of 892.957

d) Make the ESS plot for the full model: from Graph&Fit select Plot
of. Place y on V and B1:Eta’U on H. From the OLS popup menu, select
Logistic and move the slider bar to 1. From the lowess popup menu select
SliceSmooth and move the slider bar until the fit is good. Include your plot
in Word. Is the full model good?

e) Using what you have learned in class find a good submodel and include
the relevant output in Word.

See the hints give below Problem 10.11e.

f) Make an ESS plot for your final submodel.

g) Suppose that B1 contains your full model and B5 contains your final
submodel. Make an EE plot for your final submodel: from Graph&Fit select
Plot of. Select B1:Eta’U for the V box and B5:Eta’U, for the H box. Place
y in the Mark by box. After the plot appears, click on the options popup
menu. A window will appear. Type y = x and click on OK. This action adds
the identity line to the plot. Also move the OLS slider bar to 1. Include the
plot in Word.

h) Using e), f), g) and any additional output that you desire (eg AIC(full),
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AIC(min) and AIC(final submodel), explain why your final submodel is good.

R/Splus problems

Download functions with the command source(“A:/regpack.txt”).
See Preface or Section 17.1. Typing the name of the regpack function,
eg binrplot, will display the code for the function. Use the args command,
eg args(lressp), to display the needed arguments for the function.

10.14.
a) Obtain the function lrdata from regpack.txt. Enter the commands

out <- lrdata()

x <- out$x

y <- out$y

b) Obtain the function lressp from regpack.txt. Enter the commands
lressp(x,y) and include the resulting plot in Word.

The following problem uses SAS and Arc.

10.15∗. SAS–all subsets: On the webpage (www.math.siu.edu/olive/
students.htm) there are 2 files cbrain.txt and hwbrain.sas that will be used for
this problem. The first file contains the cbrain data (that you have analyzed
in Arc several times) without the header that describes the data.

a) Using Netscape or Internet Explorer, go to the webpage and click on
cbrain.txt. After the file opens, copy and paste the data into Notepad. (In
Netscape, the commands “Edit>Select All” and “Edit>copy” worked.) Then
open Notepad and enter the commands “Edit>paste” to make the data set
appear.

b) SAS needs an “end of file” marker to determine when the data ends.
SAS uses a period as the end of file marker. Add a period on the line after
the last line of data in Notepad and save the file as cbrain.dat on your disk
using the commands “File>Save as.” A window will appear, in the top box
make 3 1/2 Floppy (A:) appear while in the File name box type cbrain.dat.
In the Save as type box, click on the right of the box and select All Files.
Warning: make sure that the file has been saved as cbrain.dat, not
as cbrain.dat.txt.

c) As described in a), go to the webpage and click on hwbrain.sas. After
the file opens, copy and paste the data into Notepad. Use the commands
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“File>Save as.” A window will appear, in the top box make 3 1/2 Floppy
(A:) appear while in the File name box type hwbrain.sas. In the Save as type
box, click on the right of the box and select All Files, and the file will be
saved on your disk. Warning: make sure that the file has been saved
as hwbrain.sas, not as hwbrain.sas.txt.

d) Get into SAS, and from the top menu, use the “File>Open” command.
A window will open. Use the arrow in the NE corner of the window to navi-
gate to “3 1/2 Floppy(A:)”. (As you click on the arrow, you should see My
Documents, C: etc, then 3 1/2 Floppy(A:).) Double click on hwbrain.sas.
(Alternatively cut and paste the program into the SAS editor window.) To
execute the program, use the top menu commands “Run>Submit”. An out-
put window will appear if successful. Warning: if you do not have the
two files on A drive, then you need to change the infile command in
hwbrain.sas to the drive that you are using, eg change infile “a:cbrain.dat”;
to infile “f:cbrain.dat”; if you are using F drive.

e) To copy and paste relevant output into Word, click on the output
window and use the top menu commands “Edit>Select All” and then the
menu commands “Edit>Copy”.

The model should be good if C(p) ≤ 2k where k = “number in model.”
The only SAS output for this problem that should be included

in Word are two header lines (Number in model, R-square, C(p), Variables
in Model) and the first line with Number in Model = 6 and C(p) = 7.0947.
You may want to copy all of the SAS output into Notepad, and then cut and
paste the relevant two lines of output into Word.

f) Activate cbrain.lsp in Arc with the menu commands
“File > Load > Data > mdata > cbrain.lsp.” From Graph&Fit select Fit
binomial response. Select age = X2, breadth = X6, cephalic = X10, circum
= X9, headht = X4, height = X3, length = X5 and size = X7 as predictors,
sex as the response and ones as the number of trials. This is the full logistic
regression model. Include the relevant output in Word. (A better full model
was used in Problem 10.10.)

g) (ESS plot): From Graph&Fit select Plot of. Place sex on V and
B1:Eta’U on H. From the OLS popup menu, select Logistic and move the
slider bar to 1. From the lowess popup menu select SliceSmooth and move
the slider bar until the fit is good. Include your plot in Word. Are the slice
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means (observed proportions) tracking the logistic curve (fitted proportions)
fairly well?

h) From Graph&Fit select Fit binomial response. Select breadth = X6,
cephalic = X10, circum = X9, headht = X4, height = X3, and size = X7 as
predictors, sex as the response and ones as the number of trials. This is the
“best submodel.” Include the relevant output in Word.

i) Put the EE plot H B2 ETA’U versus V B1 ETA’U in Word. Is the plot
linear?

j) From Graph&Fit select Plot of. Place sex on V and B2:Eta’U on H.
From the OLS popup menu, select Logistic and move the slider bar to 1.
From the lowess popup menu select SliceSmooth and move the slider bar until
the fit is good. Include your plot in Word. Are the slice means (observed
proportions) tracking the logistic curve (fitted proportions) fairly well?
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Binomial Regression in SAS

options ls = 70;

data crabs;

* Agresti, p. 272;

input width cases satell;

cards;

22.69 14 5

23.84 14 4

24.77 28 17

25.84 39 21

26.79 22 15

27.74 24 20

28.67 18 15

30.41 14 14

;

proc logistic; model satell/cases = width;

output out = predict p = pi_hat;

proc print data = predict

run;

10.16. a) Enter the above SAS program (or get the program from the
webpage (www.math.siu.edu/olive/reghw.txt)). Then to copy and paste the
program into SAS and save it on your disk. Then run the program in SAS.
Click on the output window and use the top menu commands “Edit>Select
All” and then the menu commands “Edit>Copy”. In Word, use the com-
mands “Edit>Paste”. Most of the output is irrelevant. Then cut out all of
the output except the Model Fit Statistics the output for testing BETA = 0
and the coefficient estimates from Proc Logistic. (All of this output should
fit on about half a page.) Print out the output.

The crab data is from Agresti (1996, p. 105–107, 272). Use the estimates
from the output (which differ slightly from those in the text).

b) Predict ρ̂(x) if x = 21.0.

c) Find a 95% CI for β.

d) Perform the 4 step Wald test for Ho : β = 0.
(SAS output gives z2

o as the Wald chi-square. You need to use zo = β̂/se(β̂) =√
z2
o. Recall that z2 ∼ χ2

1 if z ∼ N(0, 1)).



Chapter 11

Poisson Regression

If the response variable Y is a count, then the Poisson regression model is
often useful. For example, counts often occur in wildlife studies where a
region is divided into subregions and Yi is the number of a specified type of
animal found in the subregion. The following definition makes simulation of
Poisson regression data simple. See Section 1.3.

11.1 Poisson Regression

Definition 11.1. The Poisson regression model states that Y1, ..., Yn are
independent random variables with

Yi ∼ Poisson(µ(xi)).

The loglinear Poisson regression (LLR) model is the special case where

µ(xi) = exp(α+ βTxi). (11.1)

Model (11.1) can be written compactly as Y |SP ∼ Poisson(exp(SP)). No-
tice that the conditional mean and variance functions are equal: E(Y |SP ) =
V (Y |SP ) = exp(SP ). For the LLR model, the Y are independent and

Y ≈ Poisson(exp(ESP)),

or Y |SP ≈ Y |ESP ≈ Poisson(µ̂(ESP)). For example, Y |(SP = 0) ∼
Poisson(1), and Y |(ESP = 0) ≈ Poisson(1).

375
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In the response plot for loglinear regression, the shape of the estimated
mean function µ̂(ESP ) = exp(ESP ) depends strongly on the range of the
ESP. The variety of shapes occurs because the plotting software attempts
to fill the vertical axis. Hence the range of the ESP is narrow, then the
exponential function will be rather flat. If the range of the ESP is wide, then
the exponential curve will look flat in the left of the plot but will increase
sharply in the right of the plot.

Definition 11.2. The estimated sufficient summary plot (ESSP) or re-

sponse plot, is a plot of the ESP = α̂ + β̂
T
xi versus Yi with the estimated

mean function
µ̂(ESP ) = exp(ESP )

added as a visual aid. A scatterplot smoother such as lowess is also added
as a visual aid.

This plot is very useful as a goodness of fit diagnostic. The lowess curve
is a nonparametric estimator of the mean function and is represented as a
jagged curve to distinguish it from the estimated LLR mean function (the
exponential curve) in Figure 1.9. If the number of predictors k < n/10, if
there is no overdispersion, and if the lowess curve follows the exponential
curve closely (except possibly for the largest values of the ESP), then the
LLR mean function may be a useful approximation for E(Y |x). A useful
lack of fit plot is a plot of the ESP versus the deviance residuals that are
often available from the software.

The deviance test described in Section 11.2 is used to test whether β = 0,
and is the analog of the ANOVA F test for multiple linear regression. If
the LLR model is a good approximation to the data but β = 0, then the
predictors x are not needed in the model and µ̂(xi) ≡ µ̂ = Y (the sample
mean) should be used instead of the LLR estimator

µ̂(xi) = exp(α̂+ β̂
T
xi).

If the exponential curve clearly fits the lowess curve better than the line
Y = Y , then Ho should be rejected, but if the line Y = Y fits the lowess
curve about as well as the exponential curve (which should only happen if the
exponential curve is approximately linear with a small slope), then Y may
be independent of the predictors. Figure 1.10 shows the ESSP when only X4

and X5 are used as predictors for the artificial data, and Y is independent of
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these two predictors by construction. It is possible to find data sets that look
like Figure 1.10 where the p–value for the deviance test is very small. Then
the LLR relationship is statistically significant, but the investigator needs to
decide whether the relationship is practically significant.

Warning: For many count data sets where the LLR mean function
is correct, the LLR model is not appropriate but the LLR MLE is still a
consistent estimator of β. The problem is that for many data sets where
E(Y |x) = µ(x) = exp(SP ), it turns out that V (Y |x) > exp(SP ). This phe-
nomenon is called overdispersion. Adding parametric and nonparametric
estimators of the standard deviation function to the response plot can be
useful. See Cook and Weisberg (1999a, p. 401-403). Alternatively, if the
response plot looks good and G2/(n − k − 1) ≈ 1, then the LLR model is
likely useful. Here the deviance G2 is described in Section 11.2.

A useful alternative to the LLR model is a negative binomial regression
(NBR) model. If Y has a (generalized) negative binomial distribution, Y ∼
NB(µ, κ), then the probability mass function of Y is

P (Y = y) =
Γ(y + κ)

Γ(κ)Γ(y + 1)

(
κ

µ+ κ

)κ (
1 − κ

µ + κ

)y

for y = 0, 1, 2, ... where µ > 0 and κ > 0. Then E(Y ) = µ and V(Y ) =
µ+µ2/κ. (This distribution is a generalization of the negative binomial (κ, ρ)
distribution with ρ = κ/(µ + κ) and κ > 0 is an unknown real parameter
rather than a known integer.)

Definition 11.3. The negative binomial regression (NBR) model
states that Y1, ..., Yn are independent random variables where

Yi ∼ NB(µ(xi), κ)

with µ(xi) = exp(α + βT xi). Hence Y |SP ∼ NB(exp(SP), κ), E(Y |SP ) =
exp(SP ) and

V (Y |SP ) = exp(SP )

(
1 +

exp(SP )

κ

)
.

The NBR model has the same mean function as the LLR model but allows
for overdispersion. As κ→ ∞, the NBR model converges to the LLR model.
Since the Poisson regression model is simpler than the NBR model, graphical
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diagnostics for the goodness of fit of the LLR model would be useful. The
following plot was suggested by Winkelmann (2000, p. 110).

Definition 11.4. To check for overdispersion, use the OD plot
of the estimated model variance V̂ (Y |SP ) versus the squared residuals V̂ =
[Y − Ê(Y |SP )]2. For the LLR model, V̂ (Y |SP ) = exp(ESP ) = Ê(Y |SP )
and V̂ = [Y − exp(ESP )]2.

Numerical summaries are also available. The deviance G2 is a statis-
tic used to assess the goodness of fit of the Poisson regression model much
as R2 is used for multiple linear regression. For Poisson regression, G2 is
approximately chi-square with n − p − 1 degrees of freedom. Since a χ2

d

random variable has mean d and standard deviation
√

2d, the 98th per-
centile of the χ2

d distribution is approximately d + 3
√
d ≈ d + 2.121

√
2d. If

G2 > (n− p− 1) + 3
√
n− p− 1, then a more complicated count model than

(11.1) may be needed. A good discussion of such count models is in Simonoff
(2003).

For model (11.1), Winkelmann (2000, p. 110) suggested that the plotted
points in the OD plot should scatter about the identity line through the
origin with unit slope and that the OLS line should be approximately equal
to the identity line if the LLR model is appropriate. But in simulations, it
was found that the following two observations make the OD plot much easier
to use for Poisson regression.

First, recall that a normal approximation is good for both the Poisson
and negative binomial distributions if the count Y is not too small. Notice
that if Y = E(Y |SP ) + 2

√
V (Y |SP ), then [Y − E(Y |SP )]2 = 4V (Y |SP ).

Hence if both the estimated mean and estimated variance functions are good
approximations, the plotted points in the OD plot for Poisson regression will
scatter about a wedge formed by the V̂ = 0 line and the line through the
origin with slope 4: V̂ = 4V̂ (Y |SP ). If the normal approximation is good,
only about 5% of the plotted points should be above this line.

Second, the evidence of overdispersion increases from slight to high as the
scale of the vertical axis increases from 5 to 10 times that of the horizontal
axis. (The scale of the vertical axis tends to depend on the few cases with
the largest V̂ (Y |SP ), and P [(Y − Ê(Y |SP ))2 > 10V̂ (Y |SP )] can be approx-
imated with a normal approximation or Chebyshev’s inequality.) There is
considerable evidence of overdispersion if the scale of the vertical axis is more
than 10 times that of the horizontal, or if the percentage of points above the
slope 4 line through the origin is much larger than 5%. Hence the identity
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line and slope 4 line are added to the OD plot as visual aids, and one should
check whether the scale of the vertical axis is more than 10 times that of the
horizontal.

Combining the response plot with the OD plot is a powerful method for
assessing the adequacy of the Poisson regression model. It is easier to use the
OD plot to check the variance function than the response plot since judging
the variance function with the straight lines of the OD plot is simpler than
judging two curves. Also outliers are often easier to spot with the OD plot.

For LLR Poisson regression, judging the mean function from the ESSP
may be rather difficult for large counts for two reasons. First, the mean func-
tion is curved. Secondly, for real and simulated Poisson regression data, it
was observed that scatterplot smoothers such as lowess tend to underestimate
the mean function for large ESP.

The basic idea of the following two plots for Poisson regression is to
transform the data towards a linear model, then make the response plot and
residual plot for the transformed data. The plots are based on weighted least
squares (WLS) regression. For the equivalent least squares (OLS) regression
without intercept of W on u, the ESSP is the (weighted fit) response plot
of Ŵ versus W . The mean function is the identity line and the vertical
deviations from the identity line are the WLS residualsW−Ŵ . Since P (Yi =
0) > 0, the estimators given in the following definition are useful. Let Zi = Yi

if Yi > 0, and let Zi = 0.5 if Yi = 0.

Definition 11.5. The minimum chi–square estimator of the param-
eters (α,β) in a loglinear regression model are (α̂M , β̂M ), and are found from
the weighted least squares regression of log(Zi) on xi with weights wi = Zi.
Equivalently, use the ordinary least squares (OLS) regression (without inter-
cept) of

√
Zi log(Zi) on

√
Zi(1,x

T
i )T .

The minimum chi–square estimator tends to be consistent if n is fixed
and all n counts Yi increase to ∞, while the loglinear regression maximum
likelihood estimator (α̂, β̂) tends to be consistent if the sample size n→ ∞.
See Agresti (2002, p. 611-612). However, the two estimators are often close
for many data sets. Use the OLS regression (without intercept) of

√
Zi log(Zi)

on
√
Zi(1,x

T
i )T . Then the plot of the “fitted values”

√
Zi(α̂M + β̂

T

Mxi) versus
the “response”

√
Zi log(Zi) should have points that scatter about the identity

line. These results and the equivalence of the minimum chi–square estimator
to an OLS estimator suggest the following diagnostic plots.
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Definition 11.6. For a loglinear Poisson regression model, a weighted

fit response plot is a plot of
√
ZiESP =

√
Zi(α̂+β̂

T
xi) versus

√
Zi log(Zi).

The weighted residual plot is a plot of
√
Zi(α̂+ β̂

T
xi) versus the “WLS”

residuals rWi =
√
Zi log(Zi) −

√
Zi(α̂ + β̂

T
xi).

If the loglinear regression model is appropriate and the LLR estimator
is good, then the plotted points in the weighted fit response plot should
follow the identity line. When the counts Yi are small, the “WLS” residuals
can not be expected to be approximately normal. Often the larger counts
are fit better than the smaller counts and hence the residual plots have a
“left opening megaphone” shape. This fact makes residual plots for Poisson
regression rather hard to use, but cases with large “WLS” residuals may not
be fit very well by the model. Both the weighted fit response and residual
plots perform better for simulated LLR data with many large counts than
for data where all of the counts are less than 10.

Example 11.1. For the Ceriodaphnia data of Myers, Montgomery and
Vining (2002, p. 136-139), the response variable Y is the number of Ceri-
odaphnia organisms counted in a container. The sample size was n = 70
and seven concentrations of jet fuel (x1) and an indicator for two strains
of organism (x2) were used as predictors. The jet fuel was believed to im-
pair reproduction so high concentrations should have smaller counts. Figure
11.1 shows the 4 plots for this data. In the response plot of Figure 11.1a,
the lowess curve is represented as a jagged curve to distinguish it from the
estimated LLR mean function (the exponential curve). The horizontal line
corresponds to the sample mean Y .

The OD plot in Figure 11.1b suggests that there is little evidence of
overdispersion since the vertical scale is less than ten times that of the hor-
izontal scale and all but one of the plotted points are close to the wedge
formed by the horizontal axis and slope 4 line. The plotted points scatter
about the identity line in Figure 11.1c and there are no unusual points in
Figure 11.1d. The four plots suggest that the LLR Poisson regression model
is a useful approximation to the data. Hence Y |ESP ≈ Poisson(exp(ESP)).
For example, when ESP = 1.61, Y ≈ Poisson(5) and when ESP = 4.5, Y ≈
Poisson(90). Notice that the Poisson mean can be roughly estimated by
finding the height of the exponential curve in Figure 11.1a.
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Figure 11.1: Plots for Ceriodaphnia Data
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Figure 11.2: Plots for Crab Data
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Figure 11.3: Plots for Popcorn Data

Example 11.2. Agresti (2002, p. 126-131) uses Poisson regression for
data where the response Y is the number of satellites (male crabs) near a
female crab. The sample size n = 173 and the predictor variables were
the color (2: light medium, 3: medium, 4: dark medium, 5: dark), spine
condition (1: both good, 2: one worn or broken, 3 both worn or broken),
carapace width in cm and weight of the female crab in grams.

The model used to produce Figure 11.2 used the ordinal variables color
and spine condition as coded. An alternative model would use spine con-
dition as a factor. Figure 11.2a suggests that there is one case with an
unusually large value of the ESP. Notice that the lowess curve does not track
the exponential curve very well. Figure 11.2b suggests that overdispersion is
present since the vertical scale is about 10 times that of the horizontal scale
and too many of the plotted points are large and higher than the slope 4
line. The lack of fit may be clearer in Figure 11.2c since the plotted points
fail to cover the identity line. Although the exponential mean function fits
the lowess curve better than the line Y = Y , alternative models suggested
by Agresti (2002) may fit the data better.

Example 11.3. For the popcorn data of Myers, Montgomery and Vining
(2002, p. 154), the response variable Y is the number of inedible popcorn
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kernels. The sample size was n = 15 and the predictor variables were tem-
perature (coded as 5, 6 or 7), amount of oil (coded as 2, 3 or 4) and popping
time (75, 90 or 105). One batch of popcorn had more than twice as many
inedible kernels as any other batch and is an outlier that is easily detected
in all four plots in Figure 11.3. Ignoring the outlier in Figure 11.3a suggests
that the line Y = Y will fit the data and lowess curve better than the ex-
ponential curve. Hence Y seems to be independent of the predictors. Notice
that the outlier sticks out in Figure 11.3b and that the vertical scale is well
over 10 times that of the horizontal scale. If the outlier was not detected,
then the Poisson regression model would suggest that temperature and time
are important predictors, and overdispersion diagnostics such as the deviance
would be greatly inflated.

11.2 Inference

This section gives a brief discussion of inference for the loglinear Poisson
regression (LLR) model. Inference for this model is very similar to inference
for the multiple linear regression, survival regression and logistic regression
models. For all of these models, Y is independent of the k × 1 vector of
predictors x = (x1, ..., xk)

T given the sufficient predictor α+ βTx:

Y x|(α+ βTx).

To perform inference for LLR, computer output is needed. The computer
output looks nearly identical to that needed for logistic regression.

Point estimators for the mean function are important. Given values of
x = (x1, ..., xk)

T , a major goal of loglinear regression is to estimate the mean
E(Y |x) = µ(x) with the estimator

µ̂(x) = exp(α̂+ β̂
T
x). (11.2)

Investigators also sometimes test whether a predictor Xj is needed in the
model given that the other k − 1 nontrivial predictors are in the model with
a 4 step Wald test of hypotheses:
i) State the hypotheses Ho: βj = 0 Ha: βj �= 0.

ii) Find the test statistic zo,j = β̂j/se(β̂j) or obtain it from output.
iii) The p–value = 2P (Z < −|zoj|) = 2P (Z > |zoj|). Find the p–value from
output or use the standard normal table.
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iv) State whether you reject Ho or fail to reject Ho and give a nontechnical
sentence restating your conclusion in terms of the story problem.

If Ho is rejected, then conclude that Xj is needed in the LLR model for
Y given that the other k− 1 predictors are in the model. If you fail to reject
Ho, then conclude that Xj is not needed in the LLR model for Y given that
the other k − 1 predictors are in the model. Note that Xj could be a very
useful LLR predictor, but may not be needed if other predictors are added
to the model.

The Wald confidence interval (CI) for βj can also be obtained from the

output: the large sample 100 (1 − δ) % CI for βj is β̂j ± z1−δ/2 se(β̂j).

The Wald test and CI tend to give good results if the sample size n
is large. Here 1 − δ refers to the coverage of the CI. Recall that a 90%
CI uses z1−δ/2 = 1.645, a 95% CI uses z1−δ/2 = 1.96, and a 99% CI uses
z1−δ/2 = 2.576.

For a LLR, often 3 models are of interest: the full model that uses all k of
the predictors xT = (xT

R,x
T
O), the reduced model that uses the r predictors

xR, and the saturated model that uses n parameters θ1, ..., θn where n is
the sample size. For the full model the k + 1 parameters α, β1, ..., βk are
estimated while the reduced model has r+1 parameters. Let lSAT (θ1, ..., θn)
be the likelihood function for the saturated model and let lFULL(α,β) be the
likelihood function for the full model. Let

LSAT = log lSAT (θ̂1, ..., θ̂n)

be the log likelihood function for the saturated model evaluated at the max-
imum likelihood estimator (MLE) (θ̂1, ..., θ̂n) and let

LFULL = log lFULL(α̂, β̂)

be the log likelihood function for the full model evaluated at the MLE (α̂, β̂).
Then the deviance

D = G2 = −2(LFULL − LSAT ).

The degrees of freedom for the deviance = dfFULL = n − k − 1 where n is
the number of parameters for the saturated model and k + 1 is the number
of parameters for the full model.
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The saturated model for loglinear regression states that Y1, ..., Yn are in-
dependent Poisson(µi) random variables where µ̂i = Yi. The saturated model
is usually not very good for Poisson data, but the saturated model may be
good if n is fixed and all of the counts Yi are large.

If X ∼ χ2
d then E(X) = d and VAR(X) = 2d. An observed value of

x > d + 3
√
d is unusually large and an observed value of x < d − 3

√
d is

unusually small.

When the saturated model is good, a rule of thumb is that the loglinear
regression model is ok if G2 ≤ n−k−1 (or if G2 ≤ n−k−1+3

√
n− k − 1).

The χ2
n−k+1 approximation for G2 may not be good even for large sample sizes

n. For LLR, the response and OD plots and G2 ≤ n − k − 1 + 3
√
n− k − 1

should be checked.

The Arc output below, shown in symbols and for a real data set, is used
for the deviance test described after the output. Assume that the estimated
sufficient summary plot has been made and that the loglinear regression
model fits the data well in that the lowess estimated mean function follows
the estimated model mean function closely. The deviance test is used to test
whether β = 0. If this is the case, then the predictors are not needed in the
LLR model. If Ho : β = 0 is not rejected, then for loglinear regression the
estimator µ̂ = Y should be used.

Response = Y
Terms = (X1, ..., Xk)
Sequential Analysis of Deviance

Total Change
Predictor df Deviance df Deviance

Ones n− 1 = dfo G2
o

X1 n− 2 1
X2 n− 3 1
...

...
...

...
Xk n− k − 1 = dfFULL G2

FULL 1

The 4 step deviance test follows.
i) Ho : β = 0 HA : β �= 0
ii) test statistic G2(o|F ) = G2

o −G2
FULL

iii) The p–value = P (χ2 > G2(o|F )) where χ2 ∼ χ2
k has a chi–square
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distribution with k degrees of freedom. Note that k = k + 1 − 1 = dfo −
dfFULL = n − 1 − (n− k − 1).

iv) Reject Ho if the p–value < δ and conclude that there is a LLR rela-
tionship between Y and the predictors X1, ..., Xk. If p–value ≥ δ, then fail
to reject Ho and conclude that there is not a LLR relationship between Y
and the predictors X1, ..., Xk.

The output shown on the following page, both in symbols and for a real
data set, can be used to perform the change in deviance test. If the re-
duced model leaves out a single variable Xi, then the change in deviance
test becomes Ho : βi = 0 versus HA : βi �= 0. This likelihood ratio test is a
competitor of the Wald test. The likelihood ratio test is usually better than
the Wald test if the sample size n is not large, but the Wald test is currently
easier for software to produce. For large n the test statistics from the two
tests tend to be very similar (asymptotically equivalent tests).

Response = Y Terms = (X1, ..., Xk) (Full Model)

Label Estimate Std. Error Est/SE p-value
Constant α̂ se(α̂) zo,0 for Ho: α = 0

x1 β̂1 se(β̂1) zo,1 = β̂1/se(β̂1) for Ho: β1 = 0
...

...
...

...
...

xk β̂k se(β̂k) zo,k = β̂k/se(β̂k) for Ho: βk = 0
Degrees of freedom: n - k - 1 = dfFULL

Deviance: D = G2
FULL

Response = Y Terms = (X1, ..., Xr) (Reduced Model)

Label Estimate Std. Error Est/SE p-value
Constant α̂ se(α̂) zo,0 for Ho: α = 0

x1 β̂1 se(β̂1) zo,1 = β̂1/se(β̂1) for Ho: β1 = 0
...

...
...

...
...

xr β̂r se(β̂r) zo,r = β̂k/se(β̂r) for Ho: βr = 0
Degrees of freedom: n - r - 1 = dfRED

Deviance: D = G2
RED

If the reduced model is good, then the EE plot of ESP (R) = α̂R+β̂
T

RxRi

versus ESP = α̂ + β̂
T
xi should be highly correlated with the identity line
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with unit slope and zero intercept.

After obtaining an acceptable full model where

SP = α+ β1x1 + · · · + βkxk = α+ βTx = α+ βT
RxR + βT

OxO

try to obtain a reduced model

SP = αR + βR1xR1 + · · · + βRrxRr = αR + βT
RxR

where the reduced model uses r of the predictors used by the full model and
xO denotes the vector of k − r predictors that are in the full model but not
the reduced model. For loglinear regression the reduced model is Yi|xRi ∼
independent Poisson(exp(βT

RxRi)) for i = 1, ..., n.

Assume that the full model looks good (so the response and OD plots
look good). Then we want to test Ho: the reduced model is good (can be
used instead of the full model) versus HA: use the full model (the full model
is significantly better than the reduced model). Fit the full model and the
reduced model to get the deviances G2

FULL and G2
RED.

The 4 step change in deviance test follows.
i) Ho: the reduced model is good HA: use the full model
ii) test statistic G2(R|F ) = G2

RED −G2
FULL

iii) The p–value = P (χ2 > G2(R|F )) where χ2 ∼ χ2
k−r has a chi–square

distribution with k degrees of freedom. Note that k is the number of non-
trivial predictors in the full model while r is the number of nontrivial pre-
dictors in the reduced model. Also notice that k − r = (k + 1) − (r + 1) =
dfRED − dfFULL = n− r − 1 − (n− k − 1).

iv) Reject Ho if the p–value < δ and conclude that the full model should
be used. If p–value ≥ δ, then fail to reject Ho and conclude that the reduced
model is good.

Interpretation of coefficients: if x1, ..., xi−1, xi+1, ..., xk can be held fixed,
then increasing xi by 1 unit increases the sufficient predictor SP by βi units.
In loglinear Poisson regression, increasing a predictor xi by 1 unit (while
holding all other predictors fixed) multiplies the estimated mean function by
a factor of exp(β̂i).
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Label Estimate Std. Error Est/SE p-value

Constant -0.406023 0.877382 -0.463 0.6435

bombload 0.165425 0.0675296 2.450 0.0143

exper -0.0135223 0.00827920 -1.633 0.1024

type 0.568773 0.504297 1.128 0.2594

Example 11.4. Use the above output to perform inference on the num-
ber of locations where aircraft was damaged. The output is from a loglinear
regression. The variable exper = total months of aircrew experience while
type of aircraft was coded as 0 or 1. There were n = 30 cases. Data is from
Montgomery, Peck and Vining (2001).

a) Predict µ̂(x) if bombload = x1 = 7.0, exper = x2 = 80.2 and type
= x3 = 1.0.

b) Perform the 4 step Wald test for Ho : β2 = 0.

c) Find a 95% confidence interval for β3.

Solution: a) ESP = α̂+ β̂1x1 + β̂2x2 + β̂3x3 = −0.406023+0.165426(7)−
0.0135223(80.2)+0.568773(1) = 0.2362. So µ̂(x) = exp(ESP ) = exp(0.2360) =
1.2665.

b) i) Ho β2 = 0 HA β2 �= 0
ii) t02 = −1.633.
iii) pval = 0.1024
iv) Fail to reject Ho, exper in not needed in the LLR model for number

of locations given that bombload and type are in the model.
c) β̂3 ± 1.96SE(β̂3) = 0.568773 ± 1.96(0.504297) = 0.568773 ± 0.9884 =

(−0.4196, 1.5572).

11.3 Variable Selection

This section gives some rules of thumb for variable selection for loglinear
Poisson regression. Before performing variable selection, a useful full model
needs to be found. The process of finding a useful full model is an iterative
process. Given a predictor x, sometimes x is not used by itself in the full
model.

The full model will often contain factors and interaction. If w is a nominal
variable with J levels, make w into a factor by using use J − 1 (indicator or)
dummy variables x1,w, ..., xJ−1,w in the full model. For example, let xi,w = 1 if
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w is at its ith level, and let xi,w = 0, otherwise. An interaction is a product
of two or more predictor variables. Interactions are difficult to interpret.
Often interactions are included in the full model, and then the reduced model
without any interactions is tested. The investigator is often hoping that the
interactions are not needed.

A scatterplot of x versus Y is used to visualize the conditional distri-
bution of Y |x. A scatterplot matrix is an array of scatterplots and is used
to examine the marginal relationships of the predictors and response. Place
Y on the top or bottom of the scatterplot matrix. Variables with outliers,
missing values or strong nonlinearities may be so bad that they should not be
included in the full model. Suppose that all values of the variable x are posi-
tive. The log rule says add log(x) to the full model if max(xi)/min(xi) > 10.

To make a full model, use the above discussion and then make the re-
sponse and OD plots to check that the full model is good. The number of
predictors in the full model should be much smaller than the number of data
cases n. For loglinear regression, a rough rule of thumb is that the full model
should use no more than n/5 predictors and the final submodel should use
no more than n/10 predictors.

Variable selection, also called subset or model selection, is the search for
a subset of predictor variables that can be deleted without important loss of
information. A model for variable selection for LLR can be described by

SP = α+ βTx = α+ βT
SxS + βT

ExE = α+ βT
SxS (11.3)

where x = (xT
S ,x

T
E)T is a k× 1 vector of nontrivial predictors, xS is a rS × 1

vector and xE is a (k − rS) × 1 vector. Given that xS is in the model,
βE = 0 and E denotes the subset of terms that can be eliminated given that
the subset S is in the model.

Since S is unknown, candidate subsets will be examined. Let xI be the
vector of r terms from a candidate subset indexed by I , and let xO be the
vector of the remaining terms (out of the candidate submodel). Then

SP = α + βT
I xI + βT

OxO. (11.4)
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Definition 11.7. The model with SP = α + βTx that uses all of the
predictors is called the full model. A model with SP = α + βT

I xI that only
uses the constant and a subset xI of the nontrivial predictors is called a
submodel. The full model is always a submodel.

Suppose that S is a subset of I and that model (11.3) holds. Then

SP = α + βT
SxS = α+ βT

SxS + βT
(I/S)xI/S + 0T xO = α+ βT

I xI (11.5)

where xI/S denotes the predictors in I that are not in S. Since this is true
regardless of the values of the predictors, βO = 0 if the set of predictors S is
a subset of I. Let (α̂, β̂) and (α̂I , β̂I) be the estimates of (α,β) obtained from
fitting the full model and the submodel, respectively. Denote the ESP from

the full model by ESP = α̂ + β̂
T
xi and denote the ESP from the submodel

by ESP (I) = α̂I + β̂IxIi.

Definition 11.8. An EE plot is a plot of ESP (I) versus ESP .

Variable selection is closely related to the change in deviance test for
a reduced model. You are seeking a subset I of the variables to keep in
the model. The AIC(I) statistic is used as an aid in backward elimination
and forward selection. The full model and the model Imin found with the
smallest AIC are always of interest. Burnham and Anderson (2004) suggest
that if ∆(I) = AIC(I)− AIC(Imin), then models with ∆(I) ≤ 2 are good,
models with 4 ≤ ∆(I) ≤ 7 are borderline, and models with ∆(I) > 10 should
not be used as the final submodel. Create a full model. The full model has
a deviance at least as small as that of any submodel. The final submodel
should have an EE plot that clusters tightly about the identity line. As a
rough rule of thumb, a good submodel I has corr(ESP (I), ESP ) ≥ 0.95.
Look at the submodel II with the smallest number of predictors such that
∆(II) ≤ 2, and also examine submodels I with fewer predictors than II with
∆(I) ≤ 7. Model II is a good initial submodel to examine.

Backward elimination starts with the full model with k nontrivial vari-
ables, and the predictor that optimizes some criterion is deleted. Then there
are k − 1 variables left, and the predictor that optimizes some criterion is
deleted. This process continues for models with k − 2, k − 3, ..., 3 and 2
predictors.

Forward selection starts with the model with 0 variables, and the pre-
dictor that optimizes some criterion is added. Then there is 1 variable in
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the model, and the predictor that optimizes some criterion is added. This
process continues for models with 2, 3, ..., k − 1 and k predictors. Both for-
ward selection and backward elimination result in a sequence of k models
{x∗1}, {x∗1, x∗2}, ..., {x∗1, x∗2, ..., x∗k−1}, {x∗1, x∗2, ..., x∗k} = full model. The two se-
quences found by forward selection and backward elimination need not be
the same.

All subsets variable selection can be performed with the following
procedure. Compute the LLR ESP and the OLS ESP found by the OLS
regression of Y on x. Check that |corr(LLR ESP, OLS ESP)| ≥ 0.95. This
high correlation will exist for many data sets. Then perform multiple linear
regression and the corresponding all subsets OLS variable selection with the
Cp(I) criterion. If the sample size n is large and Cp(I) ≤ 2(r + 1) where the
subset I has r + 1 variables including a constant, then corr(OLS ESP, OLS
ESP(I)) will be high by the proof of Proposition 3.2, and hence corr(LLR
ESP, LLR ESP(I)) will be high. In other words, if the OLS ESP and LLR
ESP are highly correlated, then performing multiple linear regression and
the corresponding MLR variable selection (eg forward selection, backward
elimination or all subsets selection) based on the Cp(I) criterion may provide
many interesting submodels.

Know how to find good models from output. The following rules of thumb
(roughly in order of decreasing importance) may be useful. It is often not
possible to have all 10 rules of thumb to hold simultaneously. Let submodel I
have rI +1 predictors, including a constant. Do not use more predictors than
submodel II , which has no more predictors than the minimum AIC model.
It is possible that II = Imin = Ifull. Then the submodel I is good if
i) the response plot for the submodel looks like the response plot for the full
model.
ii) Want corr(ESP,ESP(I)) ≥ 0.95.
iii) The plotted points in the EE plot cluster tightly about the identity line.
iv) Want the p-value ≥ 0.01 for the change in deviance test that uses I as
the reduced model.
v) Want rI + 1 ≤ n/10.
vi) Want the deviance G2(I) close to G2(full) (see iv): G2(I) ≥ G2(full)
since adding predictors to I does not increase the deviance).
vii) Want AIC(I) ≤ AIC(Imin) + 7 where Imin is the minimum AIC model
found by the variable selection procedure.
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viii) Want hardly any predictors with p-values > 0.05.
ix) Want few predictors with p-values between 0.01 and 0.05.
x) Want G2(I) ≤ n− rI − 1 + 3

√
n − rI − 1.

Heuristically, backward elimination tries to delete the variable that will
increase the deviance the least. An increase in deviance greater than 4 (if the
predictor has 1 degree of freedom) may be troubling in that a good predictor
may have been deleted. In practice, the backward elimination program may
delete the variable such that the submodel I with j predictors has a) the
smallest AIC(I), b) the smallest deviance G2(I) or c) the biggest p–value
(preferably from a change in deviance test but possibly from a Wald test)
in the test Ho βi = 0 versus HA βi �= 0 where the model with j + 1 terms
from the previous step (using the j predictors in I and the variable x∗j+1) is
treated as the full model.

Heuristically, forward selection tries to add the variable that will decrease
the deviance the most. A decrease in deviance less than 4 (if the predictor has
1 degree of freedom) may be troubling in that a bad predictor may have been
added. In practice, the forward selection program may add the variable such
that the submodel I with j nontrivial predictors has a) the smallest AIC(I),
b) the smallest deviance G2(I) or c) the smallest p–value (preferably from a
change in deviance test but possibly from a Wald test) in the test Ho βi = 0
versus HA βi �= 0 where the current model with j terms plus the predictor
xi is treated as the full model (for all variables xi not yet in the model).

Suppose that the full model is good and is stored in M1. Let M2, M3,
M4 and M5 be candidate submodels found after forward selection, backward
elimination, etc. Make a scatterplot matrix of the ESPs for M2, M3, M4, M5
and M1. Good candidates should have estimated sufficient predictors that
are highly correlated with the full model estimated sufficient predictor (the
correlation should be at least 0.9 and preferably greater than 0.95).

The final submodel should have few predictors, few variables with large
Wald p–values (0.01 to 0.05 is borderline), good response and OD plots, and
an EE plot that clusters tightly about the identity line. If a factor has I − 1
dummy variables, either keep all I − 1 dummy variables or delete all I − 1
dummy variables, do not delete some of the dummy variables.
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P1 P2 P3 P4
df 144 147 148 149

# of predictors 6 3 2 1
# with 0.01 ≤ Wald p-value ≤ 0.05 1 0 0 0

# with Wald p-value > 0.05 3 0 1 0
G2 127.506 131.644 147.151 149.861
AIC 141.506 139.604 153.151 153.861

corr(P1:ETA’U,Pi:ETA’U) 1.0 0.954 0.810 0.792
p-value for change in deviance test 1.0 0.247 0.0006 0.0

Example 11.5. The above table gives summary statistics for 4 models
considered as final submodels after performing variable selection. Poisson
loglinear regression was used. The response plot for the full model P1 was
good. Model P2 was the minimum AIC model found.

Which model is the best candidate for the final submodel? Explain briefly
why each of the other 3 submodels should not be used.

Solution: P2 is best. P1 has too many predictors with large pvalues and
more predictors than the minimum AIC model. P3 and P4 have corr and
pvalue too low and AIC too high.

11.4 Complements

Cameron and Trivedi (1998), Long (1997) and Winkelmann (2008) cover
Poisson regression. Also see Hilbe (2007) and texts on categorical data anal-
ysis and generalized linear models.

The response plot is essential for understanding the loglinear Poisson
regression model and for checking goodness and lack of fit if the estimated

sufficient predictor α̂ + β̂
T
x takes on many values. The response plot and

OD plot are examined in Olive (2009e). Goodness of fit is also discussed
by Cheng and Wu (1994), Kauermann and Tutz (2001), Pierce and Schafer
(1986), Spinelli, Lockart and Stephens (2002), Su and Wei (1991).

For Poisson regression, the OD plot can be used to complement tests and
diagnostics for overdispersion such as those given in Breslow (1990), Cameron
and Trevedi (1998), Dean (1992), Ganio and Schafer (1992), Lambert and
Roeder (1995), and Winkelmann (2008).

The same 4 plots for LLR Poisson regression can be used for NBR, but
the OD plot should use V̂ (Y |SP ) = exp(ESP )(1 + exp(ESP )/κ̂) on the
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horizontal axis. As overdispersion increases, larger sample sizes are needed
for the OD plot. The weighted fit response plot will be linear but the weights
wi = Zi will be suboptimal. For Example 11.2, the WFRP will again look
like Figure 11.2c, suggesting that the NBR model is not appropriate.

Olive and Hawkins (2005) give the simple all subsets variable selection
procedure that can be applied to Poisson regression using readily available
OLS software. The procedures of Lawless and Singhai (1978) and Nordberg
(1982) are much more complicated. Variable selection using the AIC criterion
is discussed in Burnham and Anderson (2004), Cook and Weisberg (1999)
and Hastie (1987).

Results from Cameron and Trivedi (1998, p. 89) suggest that if a loglinear
Poisson regression model is fit using OLS software for MLR, then a rough
approximation is β̂LLR ≈ β̂OLS/Y . So a rough approximation is LLR ESP
≈ (OLS ESP)/Y .

To motivate the weighted fit response plot and weighted residual plot,
assume that all n of the counts Yi are large. Then

log(µ(xi)) = log(µ(xi)) + log(Yi) − log(Yi) = α+ βTxi,

or
log(Yi) = α + βT xi + ei

where

ei = log

(
Yi

µ(xi)

)
.

The error ei does not have zero mean or constant variance, but if µ(xi) is
large

Yi − µ(xi)√
µ(xi)

≈ N(0, 1)

by the central limit theorem. Recall that log(1 + x) ≈ x for |x| < 0.1. Then,
heuristically,

ei = log

(
µ(xi) + Yi − µ(xi)

µ(xi)

)
≈ Yi − µ(xi)

µ(xi)
≈

1√
µ(xi)

Yi − µ(xi)√
µ(xi)

≈ N

(
0,

1

µ(xi)

)
.

This suggests that for large µ(xi), the errors ei are approximately 0 mean
with variance 1/µ(xi). If the µ(xi) were known, and all of the Yi were large,
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then a weighted least squares of log(Yi) on xi with weights wi = µ(xi) should
produce good estimates of (α,β). Since the µ(xi) are unknown, the estimated
weights wi = Yi could be used.

11.5 Problems

The following three problems use the possums data from Cook and Weisberg
(1999a).

Output for Problem 11.1

Data set = Possums, Response = possums

Terms = (Habitat Stags)

Coefficient Estimates

Label Estimate Std. Error Est/SE p-value

Constant -0.652653 0.195148 -3.344 0.0008

Habitat 0.114756 0.0303273 3.784 0.0002

Stags 0.0327213 0.00935883 3.496 0.0005

Number of cases: 151

Degrees of freedom: 148

Pearson X2: 110.187

Deviance: 138.685

11.1∗. Use the above output to perform inference on the number of
possums in a given tract of land. The output is from a loglinear regression.

a) Predict µ̂(x) if habitat = x1 = 5.8 and stags = x2 = 8.2.

b) Perform the 4 step Wald test for Ho : β1 = 0.

c) Find a 95% confidence interval for β2.

Output for Problem 11.2

Response = possums Terms = (Habitat Stags)

Total Change

Predictor df Deviance | df Deviance

Ones 150 187.490 |

Habitat 149 149.861 | 1 37.6289

Stags 148 138.685 | 1 11.1759
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11.2∗. Perform the 4 step deviance test for the same model as in Problem
11.1 using the output above.

Output for Problem 11.3

Terms = (Acacia Bark Habitat Shrubs Stags Stumps)

Label Estimate Std. Error Est/SE p-value

Constant -1.04276 0.247944 -4.206 0.0000

Acacia 0.0165563 0.0102718 1.612 0.1070

Bark 0.0361153 0.0140043 2.579 0.0099

Habitat 0.0761735 0.0374931 2.032 0.0422

Shrubs 0.0145090 0.0205302 0.707 0.4797

Stags 0.0325441 0.0102957 3.161 0.0016

Stumps -0.390753 0.286565 -1.364 0.1727

Number of cases: 151

Degrees of freedom: 144

Deviance: 127.506

11.3∗. Let the reduced model be as in Problem 11.1 and use the output
for the full model be shown above. Perform a 4 step change in deviance test.

Arc Problems

The following two problems use data sets from Cook and Weisberg (1999a).

11.4∗. a) Activate possums.lsp in Arc with the menu commands
“File > Load > Data > Arcg > possums.lsp.” Scroll up the screen to read
the data description.

From Graph&Fit select Fit Poisson response. Select y as the response
and select Acacia, bark, habitat, shrubs, stags and stumps as the predictors.
Include the output in Word. This is your full model

b) (Response plot): From Graph&Fit select Plot of. Select P1:Eta’U for
the H box and y for the V box. From the OLS popup menu select Poisson
and move the slider bar to 1. Move the lowess slider bar until the lowess
curve tracks the exponential curve well. Include the response plot in Word.

c) From Graph&Fit select Fit Poisson response. Select y as the response
and select bark, habitat, stags and stumps as the predictors. Include the
output in Word.
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d) (Response plot): From Graph&Fit select Plot of. Select P2:Eta’U for
the H box and y for the V box. From the OLS popup menu select Poisson
and move the slider bar to 1. Move the lowess slider bar until the lowess
curve tracks the exponential curve well. Include the response plot in Word.

e) Deviance test. From the P2 menu, select Examine submodels and click
on OK. Include the output in Word and perform the 4 step deviance test.

f) Perform the 4 step change of deviance test.

g) EE plot. From Graph&Fit select Plot of. Select P2:Eta’U for the H
box and P1:Eta’U for the V box. Move the OLS slider bar to 1. Click on
the Options popup menu and type “y=x”. Include the plot in Word. Is the
plot linear?

11.5∗. In this problem you will find a good submodel for the possums
data.

a) Activate possums.lsp in Arc with the menu commands
“File > Load > Data > Arcg> possums.lsp.” Scroll up the screen to read
the data description.

b) From Graph&Fit select Fit Poisson response. Select y as the response
and select Acacia, bark, habitat, shrubs, stags and stumps as the predictors.

In Problem 11.4, you showed that this was a good full model.

c) Using what you have learned in class find a good submodel and include
the relevant output in Word.

(Hints: Create a full model. The full model has a deviance at least
as small as that of any submodel. Consider forward selection and backward
elimination. For each method, find the submodel Imin with the smallest AIC.
Let ∆(I) = AIC(I) − AIC(Imin), and find submodel II with the smallest
number of predictors such that ∆(II) ≤ 2, and also examine submodels I
with fewer predictors than II that have ∆(I) ≤ 7. The final submodel should
have an EE plot that clusters tightly about the identity line. As a rough rule
of thumb, a good submodel I has corr(ESP (I), ESP ) ≥ 0.95. Submodel
II is your initial candidate model. Fit this candidate model and look at the
Wald test p–values. Try to eliminate predictors with large p–values but make
sure that the deviance does not increase too much. You may have several
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models, say P2, P3, P4 and P5 to look at. Make a scatterplot matrix of the
Pi:ETA’U from these models and from the full model P1. Make the EE and
response plots for each model. The correlation in the EE plot should be at
least 0.9 and preferably greater than 0.95. As a very rough guide for Poisson
regression, the number of predictors in the full model should be less than
n/5 and the number of predictors in the final submodel should be less than
n/10. WARNING: do not delete part of a factor. Either keep all J−1 factor
dummy variables or delete all J − 1 factor dummy variables. WARNING: if
an important factor is in the full model but not the reduced model, then the
plotted points in the EE plot may follow more than 1 line.)

d) Make a response plot for your final submodel, say P2. From Graph&Fit
select Plot of. Select P2:Eta’U for the H box and y for the V box. From
the OLS popup menu select Poisson and move the slider bar to 1. Move
the lowess slider bar until the lowess curve tracks the exponential curve well.
Include the response plot in Word.

e) Suppose that P1 contains your full model and P2 contains your final
submodel. Make an EE plot for your final submodel: from Graph&Fit select
Plot of. Select P1:Eta’U for the V box and P2:Eta’U, for the H box. After
the plot appears, click on the options popup menu. A window will appear.
Type y = x and click on OK. This action adds the identity line to the plot.
Also move the OLS slider bar to 1. Include the plot in Word.

f) Using c), d), e) and any additional output that you desire (eg AIC(full),
AIC(min) and AIC(final submodel), explain why your final submodel is good.

Warning: The following problems use data from the book’s web-
page. Save the data files on a disk. Get in Arc and use the menu com-
mands “File > Load” and a window with a Look in box will appear. Click
on the black triangle and then on 3 1/2 Floppy(A:). Then click twice on the
data set name.

11.6∗. a) This problem uses a data set from Myers, Montgomery and
Vining (2002). Activate popcorn.lsp in Arc with the menu commands
“File > Load > Floppy(A:) > popcorn.lsp.” Scroll up the screen to read the
data description. From Graph&Fit select Fit Poisson response. Use oil, temp
and time as the predictors and y as the response. From Graph&Fit select
Plot of. Select P1:Eta’U for the H box and y for the V box. From the OLS
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popup menu select Poisson and move the slider bar to 1. Move the lowess
slider bar until the lowess curve tracks the exponential curve. Include the
EY plot in Word.

b) From the P1 menu select Examine submodels, click on OK and include
the output in Word.

c) Test whether β1 = β2 = β3 = 0.
d) From the popcorn menu, select Transform and select y. Put 1/2 in the

p box and click on OK. From the popcorn menu, select Add a variate and type
yt = sqrt(y)*log(y) in the resulting window. Repeat three times adding the
variates oilt = sqrt(y)*oil, tempt = sqrt(y)*temp and timet = sqrt(y)*time.
From Graph&Fit select Fit linear LS and choose y1/2, oilt, tempt and timet
as the predictors, yt as the response and click on the Fit intercept box to
remove the check. Then click on OK. From Graph&Fit select Plot of. Select
L2:Fit-Values for the H box and yt for the V box. A plot should appear.
Click on the Options menu and type y = x to add the identity line. Include
the weighted fit response plot in Word.

e) From Graph&Fit select Plot of. Select L2:Fit-Values for the H box and
L2:Residuals for the V box. Include the weighted residual plot in Word.

f) For the plot in e), highlight the case in the upper right corner of the
plot by using the mouse to move the arrow just above and to the left the
case. Then hold the rightmost mouse button down and move the mouse to
the right and down. From the Case deletions menu select Delete selection
from data set, then from Graph&Fit select Fit Poisson response. Use oil,
temp and time as the predictors and y as the response. From Graph&Fit
select Plot of. Select P3:Eta’U for the H box and y for the V box. From
the OLS popup menu select Poisson and move the slider bar to 1. Move the
lowess slider bar until the lowess curve tracks the exponential curve. Include
the response plot in Word.

g) From the P3 menu select Examine submodels, click on OK and include
the output in Word.

h) Test whether β1 = β2 = β3 = 0.

i) From Graph&Fit select Fit linear LS. Make sure that y1/2, oilt, tempt
and timet are the predictors, yt is the response, and that the Fit intercept
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box does not have a check. Then click on OK From Graph&Fit select Plot
of. Select L4:Fit-Values for the H box and yt for the V box. A plot should
appear. Click on the Options menu and type y = x to add the identity line.
Include the weighted fit response plot in Word.

j) From Graph&Fit select Plot of. Select L4:Fit-Values for the H box and
L4:Residuals for the V box. Include the weighted residual plot in Word.

k) Is the deleted point influential? Explain briefly.

l) From Graph&Fit select Plot of. Select P3:Eta’U for the H box and
P3:Dev-Residuals for the V box. Include the deviance residual plot in Word.

m) Is the weighted residual plot from part j) a better lack of fit plot than
the deviance residual plot from part l)? Explain briefly.

R/Splus problems

Download functions with the command source(“A:/regpack.txt”).
See Preface or Section 17.1. Typing the name of the regpack function,
eg llressp, will display the code for the function. Use the args command, eg
args(llressp), to display the needed arguments for the function.

11.7. a) Obtain the function llrdata from regpack.txt. Enter the
commands

out <- llrdata()

x <- out$x

y <- out$y

b) Obtain the function llressp from regpack.txt. Enter the commands
llressp(x,y) and include the resulting plot in Word.

c) Obtain the function llrwtfrp from regpack.txt. Enter the com-
mands llrwtfrp(x,y) and include the resulting plot in Word.



Chapter 12

Generalized Linear Models

12.1 Introduction

Generalized linear models are an important class of parametric 1D regression
models that include multiple linear regression, logistic regression and loglin-
ear Poisson regression. Assume that there is a response variable Y and a
k × 1 vector of nontrivial predictors x. Before defining a generalized linear
model, the definition of a one parameter exponential family is needed. Let
f(y) be a probability density function (pdf) if Y is a continuous random
variable and let f(y) be a probability mass function (pmf) if Y is a discrete
random variable. Assume that the support of the distribution of Y is Y and
that the parameter space of θ is Θ.

Definition 12.1. A family of pdfs or pmfs {f(y|θ) : θ ∈ Θ} is a
1-parameter exponential family if

f(y|θ) = k(θ)h(y) exp[w(θ)t(y)] (12.1)

where k(θ) ≥ 0 and h(y) ≥ 0. The functions h, k, t, and w are real valued
functions.

In the definition, it is crucial that k and w do not depend on y and that
h and t do not depend on θ. The parameterization is not unique since, for
example, w could be multiplied by a nonzero constant m if t is divided by
m. Many other parameterizations are possible. If h(y) = g(y)IY(y), then
usually k(θ) and g(y) are positive, so another parameterization is

f(y|θ) = exp[w(θ)t(y) + d(θ) + S(y)]IY(y) (12.2)

401
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where S(y) = log(g(y)), d(θ) = log(k(θ)), and the support Y does not depend
on θ. Here the indicator function IY(y) = 1 if y ∈ Y and IY(y) = 0, otherwise.

Definition 12.2. Assume that the data is (Yi,xi) for i = 1, ..., n. An
important type of generalized linear model (GLM) for the data states
that the Y1, ..., Yn are independent random variables from a 1-parameter ex-
ponential family with pdf or pmf

f(yi|θ(xi)) = k(θ(xi))h(yi) exp

[
c(θ(xi))

a(φ)
yi

]
. (12.3)

Here φ is a known constant (often a dispersion parameter), a(·) is a known
function, and θ(xi) = η(α + βT xi). Let E(Yi) ≡ E(Yi|xi) = µ(xi). The
GLM also states that g(µ(xi)) = α + βTxi where the link function g is a
differentiable monotone function. Then the canonical link function uses
the function c given in (12.3), so g(µ(xi)) ≡ c(µ(xi)) = α + βT xi, and
the quantity α + βT x is called the linear predictor and the sufficient
predictor (SP).

The GLM parameterization (12.3) can be written in several ways. By
Equation (12.2),

f(yi|θ(xi)) = exp[w(θ(xi))yi + d(θ(xi)) + S(y)]IY(y)

= exp

[
c(θ(xi))

a(φ)
yi − b(c(θ(xi))

a(φ)
+ S(y)

]
IY(y)

= exp

[
νi

a(φ)
yi − b(νi)

a(φ)
+ S(y)

]
IY(y)

where νi = c(θ(xi)) is called the natural parameter, and b(·) is some known
function.

Notice that a GLM is a parametric model determined by the 1-parameter
exponential family, the link function, and the linear predictor. Since the link
function is monotone, the inverse link function g−1(·) exists and satisfies

µ(xi) = g−1(α + βT xi). (12.4)

Also notice that the Yi follow a 1-parameter exponential family where

t(yi) = yi and w(θ) =
c(θ)

a(φ)
,
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and notice that the value of the parameter θ(xi) = η(α + βT xi) depends
on the value of xi. Since the model depends on x only through the linear
predictor α+βTx, a GLM is a 1D regression model. Thus the linear predictor
is also a sufficient predictor.

The following three sections illustrate three of the most important gener-
alized linear models. After selecting a GLM, the investigator will often want
to check whether the model is useful and to perform inference. Several things
to consider are listed below.

i) Show that the GLM provides a simple, useful approximation for the
relationship between the response variable Y and the predictors x.

ii) Estimate α and β using maximum likelihood estimators.
iii) Estimate µ(xi) = diτ (xi) or estimate τ (xi) where the di are known

constants.
iv) Check for goodness of fit of the GLM with an estimated sufficient

summary plot = response plot.
v) Check for lack of fit of the GLM (eg with a residual plot).
vi) Check for overdispersion with an OD plot.
vii) Check whether Y is independent of x; ie, check whether β = 0.
viii) Check whether a reduced model can be used instead of the full model.
ix) Use variable selection to find a good submodel.
x) Predict Yi given xi.

12.2 Multiple Linear Regression

Suppose that the response variable Y is quantitative. Then the multiple
linear regression model is often a very useful model and is closely related to
the GLM based on the normal distribution. To see this claim, let f(y|µ) be
the N(µ, σ2) family of pdfs where −∞ < µ <∞ and σ > 0 is known. Recall
that µ is the mean and σ is the standard deviation of the distribution. Then
the pdf of Y is

f(y|µ) =
1√
2πσ

exp

(−(y − µ)2

2σ2

)
.

Since

f(y|µ) =
1√
2πσ

exp(
−1

2σ2
µ2)︸ ︷︷ ︸

k(µ)≥0

exp(
−1

2σ2
y2)︸ ︷︷ ︸

h(y)≥0

exp(
µ

σ2︸︷︷︸
c(µ)/a(σ2)

y),
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this family is a 1-parameter exponential family. For this family, θ = µ =
E(Y ), and the known dispersion parameter φ = σ2. Thus a(σ2) = σ2 and
the canonical link is the identity link c(µ) = µ.

Hence the GLM corresponding to the N(µ, σ2) distribution with canonical
link states that Y1, ..., Yn are independent random variables where

Yi ∼ N(µ(xi), σ
2) and E(Yi) ≡ E(Yi|xi) = µ(xi) = α + βT xi

for i = 1, ..., n. This model can be written as

Yi ≡ Yi|xi = α+ βTxi + ei

where ei ∼ N(0, σ2).
When the predictor variables are quantitative, the above model is called a

multiple linear regression (MLR) model. When the predictors are categorical,
the above model is called an analysis of variance (ANOVA) model, and when
the predictors are both quantitative and categorical, the model is called an
MLR or analysis of covariance model.

As a GLM, the MLR model states that Y |SP ∼ N(SP, σ2), and the
assumption that σ2 is known is too strong. As a semiparametric model, the
MLR model states that Y = SP + e where the ei are iid with zero mean and
unknown constant variance σ2. The semiparametric model is much more
important than the GLM because the theory is similar for both models but
the semiparametric model does not need the error distribution to be known.
The semiparametric MLR model is discussed in detail in Chapters 2 and
3. Semiparametric ANOVA models also have theory similar to the normal
GLM, and these models are discussed in Chapters 5 to 9.

12.3 Logistic Regression

Multiple linear regression is used when the response variable is quantitative,
but for many data sets the response variable is categorical and takes on two
values: 0 or 1. The occurrence of the category that is counted is labelled as
a 1 or a “success,” while the nonoccurrence of the category that is counted
is labelled as a 0 or a “failure.” For example, a “success” = “occurrence”
could be a person who contracted lung cancer and died within 5 years of
detection. For a binary response variable, a binary regression model is often
appropriate.
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Definition 12.3. The binomial regression model states that Y1, ..., Yn

are independent random variables with

Yi ∼ binomial(mi, ρ(xi)).

The binary regression model is the special case where mi ≡ 1 for i =
1, ..., n while the logistic regression (LR) model is the special case of
binomial regression where

P (success|xi) = ρ(xi) =
exp(α+ βTxi)

1 + exp(α+ βTxi)
. (12.5)

If the sufficient predictor SP = α + βTx, then the most used binomial
regression models are such that Y1, ..., Yn are independent random variables
with

Yi ∼ binomial(mi, ρ(α+ βTxi)),

or
Yi|SPi ∼ binomial(mi, ρ(SPi)). (12.6)

Note that the conditional mean function E(Yi|SPi) = miρ(SPi) and the
conditional variance function V (Yi|SPi) = miρ(SPi)(1 − ρ(SPi)). Note that
the LR model has

ρ(SP ) =
exp(SP )

1 + exp(SP )
.

To see that the binary logistic regression model is a GLM, assume that
Y is a binomial(1, ρ) random variable. For a one parameter family, take
a(φ) ≡ 1. Then the pmf of Y is

f(y) = P (Y = y) =

(
1

y

)
ρy(1 − ρ)1−y =

(
1

y

)
︸︷︷︸
h(y)≥0

(1 − ρ)︸ ︷︷ ︸
k(ρ)≥0

exp[log(
ρ

1 − ρ
)︸ ︷︷ ︸

c(ρ)

y].

Hence this family is a 1-parameter exponential family with θ = ρ = E(Y )
and canonical link

c(ρ) = log

(
ρ

1 − ρ

)
.
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This link is known as the logit link, and if g(µ(x)) = g(ρ(x)) = c(ρ(x)) =
α+ βTx then the inverse link satisfies

g−1(α+ βTx) =
exp(α + βT x)

1 + exp(α + βT x)
= ρ(x) = µ(x).

Hence the GLM corresponding to the binomial(1, ρ) distribution with canon-
ical link is the binary logistic regression model.

Although the logistic regression model is the most important model for
binary regression, several other models are also used. Notice that ρ(x) =
P (S|x) is the population probability of success S given x, while 1 − ρ(x) =
P (F |x) is the probability of failure F given x. In particular, for binary
regression,

ρ(x) = P (Y = 1|x) = 1 − P (Y = 0|x).

If this population proportion ρ = ρ(α + βT x), then the model is a 1D re-
gression model. The model is a GLM if the link function g is differentiable
and monotone so that g(ρ(α + βT x)) = α + βT x and g−1(α + βT x) =
ρ(α + βTx). Usually the inverse link function corresponds to the cumula-
tive distribution function of a location scale family. For example, for logistic
regression, g−1(x) = exp(x)/(1 + exp(x)) which is the cdf of the logistic
L(0, 1) distribution. For probit regression, g−1(x) = Φ(x) which is the cdf
of the Normal N(0, 1) distribution. For the complementary log-log link,
g−1(x) = 1 − exp[− exp(x)] which is the cdf for the smallest extreme value
distribution. For this model, g(ρ(x)) = log[− log(1 − ρ(x))] = α + βT x.

Binomial logistic regression models are discussed in detail in Chapter 10.

12.4 Poisson Regression

If the response variable Y is a count, then the Poisson regression model is
often useful. For example, counts often occur in wildlife studies where a
region is divided into subregions and Yi is the number of a specified type of
animal found in the subregion.

Definition 12.4. The Poisson regression model states that Y1, ..., Yn

are independent random variables with

Yi ∼ Poisson(µ(xi)).
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The loglinear Poisson regression model is the special case where

µ(xi) = exp(α+ βTxi). (12.7)

To see that the loglinear regression model is a GLM, assume that Y is
a Poisson(µ) random variable. For a one parameter family, take a(φ) ≡ 1.
Then the pmf of Y is

f(y) = P (Y = y) =
e−µµy

y!
= e−µ︸︷︷︸

k(µ)≥0

1

y!︸︷︷︸
h(y)≥0

exp[log(µ)︸ ︷︷ ︸
c(µ)

y]

for y = 0, 1, . . . , where µ > 0. Hence this family is a 1-parameter exponential
family with θ = µ = E(Y ), and the canonical link is the log link

c(µ) = log(µ).

Since g(µ(x)) = c(µ(x)) = α+ βTx, the inverse link satisfies

g−1(α+ βT x) = exp(α+ βTx) = µ(x).

Hence the GLM corresponding to the Poisson(µ) distribution with canonical
link is the loglinear regression model.

Poisson regression models are discussed in detail in Chapter 11.

12.5 Inference and Variable Selection

This section gives a brief discussion of inference and variable selection for
GLMs with emphasis on the logistic regression (LR) and loglinear regression
(LLR) models. See Chapters 10 and 11 for more details. Inference for these
two models is very similar to inference for the multiple linear regression
(MLR) model and survival regression models. For all of these models, Y
is independent of the k × 1 vector of predictors x = (x1, ..., xk)

T given the
sufficient predictor α + βT x:

Y x|(α+ βTx).

To perform inference for LR and LLR, computer output is needed. Point
estimators for the mean function are important. Given x = (x1, ..., xk)

T , a
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major goal of binary logistic regression is to estimate the success probability
P (Y = 1|x) = ρ(x) with the estimator

ρ̂(x) =
exp(α̂ + β̂

T
x)

1 + exp(α̂+ β̂
T
x)
. (12.8)

Similarly, a major goal of loglinear regression is to estimate the mean
E(Y |x) = µ(x) with the estimator

µ̂(x) = exp(α̂+ β̂
T
x). (12.9)

Investigators also sometimes test whether a predictor Xj is needed in the
model given that the other k − 1 nontrivial predictors are in the model with
the following 4 step Wald test of hypotheses.
i) State the hypotheses Ho: βj = 0 Ha: βj �= 0.

ii) Find the test statistic zo,j = β̂j/se(β̂j) or obtain it from output.
iii) The p–value = 2P (Z < −|zoj|) = 2P (Z > |zoj|). Find the p–value from
output or use the standard normal table.
iv) State whether you reject Ho or fail to reject Ho and give a nontechnical
sentence restating your conclusion in terms of the story problem.

If Ho is rejected, then conclude that Xj is needed in the GLM model for
Y given that the other k− 1 predictors are in the model. If you fail to reject
Ho, then conclude that Xj is not needed in the GLM model for Y given that
the other k − 1 predictors are in the model. Note that Xj could be a very
useful GLM predictor, but may not be needed if other predictors are added
to the model.

The Wald confidence interval (CI) for βj can also be obtained from the

output: the large sample 100 (1 − δ) % CI for βj is β̂j ± z1−δ/2 se(β̂j).

For a GLM, often 3 models are of interest: the full model that uses all k
of the predictors xT = (xT

R,x
T
O), the reduced model that uses the r predic-

tors xR, and the saturated model that uses n parameters θ1, ..., θn where
n is the sample size. For the full model the k+ 1 parameters α, β1, ..., βk are
estimated while the reduced model has r+1 parameters. Let lSAT (θ1, ..., θn)
be the likelihood function for the saturated model and let lFULL(α,β) be the
likelihood function for the full model. Let

LSAT = log lSAT (θ̂1, ..., θ̂n)
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be the log likelihood function for the saturated model evaluated at the max-
imum likelihood estimator (MLE) (θ̂1, ..., θ̂n) and let

LFULL = log lFULL(α̂, β̂)

be the log likelihood function for the full model evaluated at the MLE (α̂, β̂).
Then the deviance

D = G2 = −2(LFULL − LSAT ).

The degrees of freedom for the deviance = dfFULL = n − k − 1 where n is
the number of parameters for the saturated model and k + 1 is the number
of parameters for the full model.

The saturated model for logistic regression states that Y1, ..., Yn are in-
dependent binomial(mi, ρi) random variables where ρ̂i = Yi/mi. The sat-
urated model for loglinear regression states that Y1, ..., Yn are independent
Poisson(µi) random variables where µ̂i = Yi.

Assume that the response plot has been made and that the logistic or
loglinear regression model fits the data well in that the nonparametric step
or lowess estimated mean function follows the estimated model mean function
closely and there is no evidence of overdispersion. The deviance test is used
to test whether β = 0. If this is the case, then the predictors are not needed
in the GLM model. If Ho : β = 0 is not rejected, then for loglinear regression
the estimator µ̂ = Y should be used while for logistic regression

ρ̂ =

n∑
i=1

Yi/

n∑
i=1

mi

should be used. Note that ρ̂ = Y for binary logistic regression.

The 4 step deviance test follows.
i) Ho : β = 0 HA : β �= 0
ii) test statistic G2(o|F ) = G2

o −G2
FULL

iii) The p–value = P (χ2 > G2(o|F )) where χ2 ∼ χ2
k has a chi–square

distribution with k degrees of freedom. Note that k = k + 1 − 1 = dfo −
dfFULL = n − 1 − (n− k − 1).

iv) Reject Ho if the p–value < δ and conclude that there is a GLM
relationship between Y and the predictors X1, ..., Xk. If p–value ≥ δ, then
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fail to reject Ho and conclude that there is not a GLM relationship between
Y and the predictors X1, ..., Xk.

If the reduced model leaves out a single variable Xi, then the change in
deviance test becomes Ho : βi = 0 versus HA : βi �= 0. This change in
deviance test is usually better than the Wald test if the sample size n is not
large, but for large n the test statistics from the two tests tend to be very
similar (asymptotically equivalent tests).

If the reduced model is good, then the EE plot of ESP (R) = α̂R+β̂
T

RxRi

versus ESP = α̂ + β̂
T
xi should be highly correlated with the identity line

with unit slope and zero intercept.

After obtaining an acceptable full model where

SP = α+ β1x1 + · · · + βkxk = α+ βTx = α+ βT
RxR + βT

OxO

try to obtain a reduced model

SP = α+ βR1xR1 + · · · + βRrxRr = αR + βT
RxR

where the reduced model uses r of the predictors used by the full model and
xO denotes the vector of k − r predictors that are in the full model but not
the reduced model. For logistic regression, the reduced model is Yi|xRi ∼
independent Binomial(mi, ρ(xRi)) while for loglinear regression the reduced
model is Yi|xRi ∼ independent Poisson(µ(xRi)) for i = 1, ..., n.

Assume that the response plot looks good and that there is no evidence
of overdispersion. Then we want to test Ho: the reduced model is good (can
be used instead of the full model) versus HA: use the full model (the full
model is significantly better than the reduced model). Fit the full model and
the reduced model to get the deviances G2

FULL and G2
RED.

The 4 step change in deviance test is
i) Ho: the reduced model is good HA: use the full model
ii) test statistic G2(R|F ) = G2

RED −G2
FULL

iii) The p–value = P (χ2 > G2(R|F )) where χ2 ∼ χ2
k−r has a chi–square

distribution with k degrees of freedom. Note that k is the number of non-
trivial predictors in the full model while r is the number of nontrivial pre-
dictors in the reduced model. Also notice that k − r = (k + 1) − (r + 1) =
dfRED − dfFULL = n− r − 1 − (n− k − 1).
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iv) Reject Ho if the p–value < δ and conclude that the full model should
be used. If p–value ≥ δ, then fail to reject Ho and conclude that the reduced
model is good.

Next some rules of thumb are given for GLM variable selection. Before
performing variable selection, a useful full model needs to be found. The
process of finding a useful full model is an iterative process.

The full model will often contain factors and interactions. If w is a nom-
inal variable with J levels, make w into a factor by using use J − 1 (indica-
tor or) dummy variables x1,w, ..., xJ−1,w in the full model. For example, let
xi,w = 1 if w is at its ith level, and let xi,w = 0, otherwise. An interaction
is a product of two or more predictor variables. Interactions are difficult to
interpret. Often interactions are included in the full model, and then the
reduced model without any interactions is tested.

A scatterplot of x versus Y is used to visualize the conditional distri-
bution of Y |x. A scatterplot matrix is an array of scatterplots and is used
to examine the marginal relationships of the predictors and response. Place
Y on the top or bottom of the scatterplot matrix. Variables with outliers,
missing values or strong nonlinearities may be so bad that they should not be
included in the full model. Suppose that all values of the variable x are posi-
tive. The log rule says add log(x) to the full model if max(xi)/min(xi) > 10.
For the binary logistic regression model, it is often useful to mark the plotted
points by a 0 if Y = 0 and by a + if Y = 1.

To make a full model, use the above discussion and then make a response
plot to check that the full model is good. The number of predictors in the
full model should be much smaller than the number of data cases n. Suppose
that the Yi are binary for i = 1, ..., n. Let N1 =

∑
Yi = the number of 1’s and

N0 = n−N1 = the number of 0’s. A rough rule of thumb is that the full model
should use no more than min(N0, N1)/5 predictors and the final submodel
should have r predictor variables where r is small with r ≤ min(N0, N1)/10.
For loglinear regression, a rough rule of thumb is that the full model should
use no more than n/5 predictors and the final submodel should use no more
than n/10 predictors.

Variable selection, also called subset or model selection, is the search for
a subset of predictor variables that can be deleted without important loss of
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information. A model for variable selection for a GLM can be described by

SP = α + βT x = α + βT
SxS + βT

ExE = α + βT
SxS (12.10)

where x = (xT
S ,x

T
E)T is a k× 1 vector of nontrivial predictors, xS is a rS × 1

vector and xE is a (k − rS) × 1 vector. Given that xS is in the model,
βE = 0 and E denotes the subset of terms that can be eliminated given that
the subset S is in the model.

Since S is unknown, candidate subsets will be examined. Let xI be the
vector of r terms from a candidate subset indexed by I , and let xO be the
vector of the remaining terms (out of the candidate submodel). Then

SP = α + βT
I xI + βT

OxO. (12.11)

Definition 12.5. The model with SP = α + βTx that uses all of the
predictors is called the full model. A model with SP = α + βT

I xI that only
uses the constant and a subset xI of the nontrivial predictors is called a
submodel. The full model is always a submodel.

Suppose that S is a subset of I and that model (12.10) holds. Then

SP = α + βT
SxS = α+ βT

SxS + βT
(I/S)xI/S + 0T xO = α+ βT

I xI (12.12)

where xI/S denotes the predictors in I that are not in S. Since this is true
regardless of the values of the predictors, βO = 0 if the set of predictors S is
a subset of I. Let (α̂, β̂) and (α̂I , β̂I) be the estimates of (α,β) and (α,βI)
obtained from fitting the full model and the submodel, respectively. Denote

the ESP from the full model by ESP = α̂+ β̂
T
xi and denote the ESP from

the submodel by ESP (I) = α̂I + β̂IxIi.

Definition 12.6. An EE plot is a plot of ESP (I) versus ESP .

Variable selection is closely related to the change in deviance test for
a reduced model. You are seeking a subset I of the variables to keep in
the model. The AIC(I) statistic is used as an aid in backward elimination
and forward selection. The full model and the model Imin found with the
smallest AIC are always of interest. Burnham and Anderson (2004) suggest
that if ∆(I) = AIC(I)− AIC(Imin), then models with ∆(I) ≤ 2 are good,
models with 4 ≤ ∆(I) ≤ 7 are borderline, and models with ∆(I) > 10 should
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not be used as the final submodel. Create a full model. The full model has
a deviance at least as small as that of any submodel. The final submodel
should have an EE plot that clusters tightly about the identity line. As a
rough rule of thumb, a good submodel I has corr(ESP (I), ESP ) ≥ 0.95.
Look at the submodel II with the smallest number of predictors such that
∆(II) ≤ 2, and also examine submodels I with fewer predictors than II with
∆(I) ≤ 7. Submodel II is the initial submodel to examine.

Backward elimination starts with the full model with k nontrivial vari-
ables, and the predictor that optimizes some criterion is deleted. Then there
are k − 1 variables left, and the predictor that optimizes some criterion is
deleted. This process continues for models with k − 2, k − 3, ..., 2 and 1
predictors.

Forward selection starts with the model with 0 variables, and the pre-
dictor that optimizes some criterion is added. Then there is 1 variable in the
model, and the predictor that optimizes some criterion is added. This pro-
cess continues for models with 2, 3, ..., k − 1 and k predictors. Both forward
selection and backward elimination result in a sequence, often different, of k
models {x∗1}, {x∗1, x∗2}, ..., {x∗1, x∗2, ..., x∗k−1}, {x∗1, x∗2, ..., x∗k} = full model.

All subsets variable selection can be performed with the following
procedure. Compute the ESP of the GLM and compute the OLS ESP found
by the OLS regression of Y on x. Check that |corr(ESP, OLS ESP)| ≥ 0.95.
This high correlation will exist for many data sets. Then perform multiple
linear regression and the corresponding all subsets OLS variable selection
with the Cp(I) criterion. If the sample size n is large and Cp(I) ≤ 2(r + 1)
where the subset I has r + 1 variables including a constant, then corr(OLS
ESP, OLS ESP(I)) will be high by the proof of Proposition 3.2, and hence
corr(ESP, ESP(I)) will be high. In other words, if the OLS ESP and GLM
ESP are highly correlated, then performing multiple linear regression and
the corresponding MLR variable selection (eg forward selection, backward
elimination or all subsets selection) based on the Cp(I) criterion may provide
many interesting submodels.

Know how to find good models from output. Neither the full model nor
the final submodel should show evidence of overdispersion. The following
rules of thumb (roughly in order of decreasing importance) may be useful. It
is often not possible to have all 10 rules of thumb to hold simultaneously. Let
submodel I have rI + 1 predictors, including a constant. Do not use more
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predictors than submodel II , which has no more predictors than the minimum
AIC model. It is possible that II = Imin = Ifull. Then the submodel I is
good if i) the response plot for the submodel looks like the response plot for
the full model.
ii) Want corr(ESP,ESP(I)) ≥ 0.95.
iii) The plotted points in the EE plot cluster tightly about the identity line.
iv) Want the p-value ≥ 0.01 for the change in deviance test that uses I as
the reduced model.
v) Want rI + 1 ≤ n/10, but for binary LR want rI + 1 ≤ min(N1, N0)/10
where N0 is the number of 0s and N1 is the number of 1s.
vi) Want the deviance G2(I) close to G2(full) (see iv): G2(I) ≥ G2(full)
since adding predictors to I does not increase the deviance).
vii) Want AIC(I) ≤ AIC(Imin) + 7 where Imin is the minimum AIC model
found by the variable selection procedure.
viii) Want hardly any predictors with p-values > 0.05.
ix) Want few predictors with p-values between 0.01 and 0.05.
x) Want G2(I) ≤ n− rI − 1 + 3

√
n − rI − 1.

Suppose that the full model is good and is stored in M1. Let M2, M3,
M4 and M5 be candidate submodels found after forward selection, backward
elimination, et cetera. Make a scatterplot matrix of the ESPs for M2, M3,
M4, M5 and M1. Good candidates should have estimated sufficient predictors
that are highly correlated with the full model estimated sufficient predictor
(the correlation should be at least 0.9 and preferably greater than 0.95). For
binary logistic regression, mark the symbols (0 and +) using the response
variable Y .

The final submodel should have few predictors, few variables with large
Wald p–values (0.01 to 0.05 is borderline), a good response plot, no evidence
of overdispersion and an EE plot that clusters tightly about the identity line.
If a factor has J−1 dummy variables, either keep all J−1 dummy variables or
delete all J−1 dummy variables, do not delete some of the dummy variables.

12.6 Complements

GLMs were introduced by Nelder and Wedderburn (1972). Most of the mod-
els in the first 12 chapters of this text are GLMs. Other books on generalized
linear models (in roughly decreasing order of difficulty) include McCullagh
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and Nelder (1989), Fahrmeir and Tutz (2001), Myers, Montgomery and Vin-
ing (2002), Dobson and Barnett (2008). Also see Fox (2008), Hardin and
Hilbe (2007), Hoffman (2003), Hutcheson and Sofroniou (1999) and Lindsey
(2000). Cook and Weisberg (1999a, ch. 21-23) also has an excellent dis-
cussion. Texts on categorical data analysis that have useful discussions of
GLMs include Agresti (2002), Le (1998), Lindsey (2004), Simonoff (2003)
and Powers and Xie (2000) who give econometric applications.

Barndorff-Nielsen (1982) is a very readable discussion of exponential fam-
ilies. Also see Olive (2008, 2009b).

The response plot of the ESP versus Y is crucial for visualizing the GLM.
The estimated mean function and a scatterplot smoother (a nonparametric
estimator of the mean function) can be added as visual aids. Model and non-
parametric estimators estimated SD function can also be computed. Then
the estimated mean function ± the estimated SD function can be plotted.

Olive and Hawkins (2005) give a simple all subsets variable selection
procedure that can be applied to generalized linear models, such as logistic
regression and Poisson regression, using readily available OLS software.

12.7 Problems

PROBLEMS WITH AN ASTERISK * ARE USEFUL.
12.1. Draw a typical response plot for the following models.
a) multiple linear regression
b) logistic regression for a binary response variable
c) loglinear Poisson regression



Chapter 13

Theory for Linear Models

Theory for linear models is used to show that linear models have good sta-
tistical properties. This chapter needs a lot more work.

Suppose the linear model is Y = Xβ + e where X is an n× p matrix, β
is a p× 1 vector and e and Y are n × l vectors.

Assume that the ei are iid with zero mean and variance V(ei) = σ2.
Linear model theory previously proved in the text includes Propositions

2.1, 2.2, 2.3, 2.10, 3.1, 3.2, 3.3, and 4.1. Some matrix manipulations are
illustrated in Example 4.1.

Unproved results include Propositions 2.4, 2.5, 2.9, 2.11, Theorems 2.6,
2.7, and 2.8. Also see Equation (2.23).

Also assume that the model includes all possible terms so may overfit but
does not underfit. Then Ŷ = HY and Cov(Ŷ ) = σ2HIHT = σ2H . Thus

1

n

∑
i=1

V (Ŷi) =
1

n
tr(σ2H) =

σ2

n
tr((XT X)−1XT X =

σ2p

n

where tr(A) is the trace operation. Hence if only k parameters are needed
and p >> k, then serious overfitting occurs and increases 1

n

∑
i=1 V (Ŷi). This

result implies Equation (3.7).

13.1 Complements

Texts on the theory of linear models include Christensen (2002), Freedman
(2005), Graybill (2000), Guttman (1982), Hocking (2003), Porat (1993), Rao

416
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(1973), Ravishanker and Dey (2002), Rencher and Schaalje (2008), Scheffé
(1959), Searle (1971) and Seber and Lee (2003).

13.2 Problems

Problems with an asterisk * are especially important.

13.1. Suppose Yi = xT
i β + ei where the errors are iid double exponential

(0, σ) where σ > 0. Then the likelihood function is

L(β, σ) =
1

2n

1

σn
exp(

−1

σ

n∑
i=1

|Yi − xT
i β|).

Suppose that β̃ is a minimizer of
∑n

i=1 |Yi − xT
i β|.

a) By direct maximization, show that β̃ is an MLE of β regardless of the
value of σ.

b) Find an MLE of σ by maximizing

L(σ) ≡ L(β̃, σ) =
1

2n

1

σn
exp(

−1

σ

n∑
i=1

|Yi − xT
i β̃|).

13.2. Consider the model Yi = β0+β1Xi,1+· · ·+βp−1Xi,p−1+εi = xT
i β+εi.

The least squares estimator β̂ minimizes

QOLS(η) =
n∑

i=1

(Yi − xT
i η)2

and the weighted least squares estimator minimizes

QWLS(η) =
n∑

i=1

wi(Yi − xT
i η)2

where the wi, Yi and xi are known quantities. Show that

n∑
i=1

wi(Yi − xT
i η)2 =

n∑
i=1

(Ỹi − x̃T
i η)2

by identifying Ỹi and x̃i. (Hence the WLS estimator is obtained from the
least squares regression of Ỹi on x̃i without an intercept.)
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13.3. Find the vector b such that bTY is an unbiased estimator for E(Yi)
if the usual linear model holds.

13.4. Write the following quantities as bT Y or Y T AY or AY .

a) Y

b)
∑

i(Yi − Ŷi)
2

c)
∑

i(Ŷi)
2

d) β̂

e) Ŷ

13.5. Show that I − H = I − X(XT X)−1XT is idempotent, that is,
show that (I − H)(I − H) = (I − H)2 = I − H .

13.6. Let A and B be matrices with the same number of rows. If C
is another matrix such that A = BC, is it true that rank(A) = rank(B)?
Prove or give a counterexample.

13.7. Let x be an n× 1 vector and let B be an n×n matrix. Show that
xTBx = xT BT x.

(The point of this problem is that if B is not a symmetric n× n matrix,

then xTBx = xT Ax where A =
B + BT

2
is a symmetric n× n matrix.)



Chapter 14

Multivariate Models

Definition 14.1. An important multivariate location and dispersion model
is a joint distribution with joint pdf

f(z|µ,Σ)

for a p×1 random vector x that is completely specified by a p×1 population
location vector µ and a p×p symmetric positive definite population dispersion
matrix Σ. Thus P (x ∈ A) =

∫
A
f(z)dz for suitable sets A.

The multivariate location and dispersion model is in many ways similar
to the multiple linear regression model. The data are iid vectors from some
distribution such as the multivariate normal (MVN) distribution. The lo-
cation parameter µ of interest may be the mean or the center of symmetry
of an elliptically contoured distribution. Hyperellipsoids will be estimated
instead of hyperplanes, and Mahalanobis distances will be used instead of
absolute residuals to determine if an observation is a potential outlier.

Assume that X1, ...,Xn are n iid p × 1 random vectors and that the
joint pdf of X1 is f(z|µ,Σ). Also assume that the data X i = xi has been
observed and stored in an n× p matrix

W =

 xT
1
...

xT
n

 =


x1,1 x1,2 . . . x1,p

x2,1 x2,2 . . . x2,p
...

...
. . .

...
xn,1 xn,2 . . . xn,p

 =
[

w1 w2 . . . wp
]

where the ith row of W is xT
i and the jth column is wj . Each column wj of

W corresponds to a variable. For example, the data may consist of n visitors

419
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to a hospital where the p = 2 variables height and weight of each individual
were measured.

There are some differences in the notation used in multiple linear regres-
sion and multivariate location dispersion models. Notice that W could be
used as the design matrix in multiple linear regression although usually the
first column of the regression design matrix is a vector of ones. The n × p
design matrix in the multiple linear regression model was denoted by X and
Xi ≡ xi denoted the ith column of X. In the multivariate location dispersion
model, X and X i will be used to denote a p×1 random vector with observed
value xi, and xT

i is the ith row of the data matrix W . Johnson and Wichern
(1988, p. 7, 53) uses X to denote the n× p data matrix and a n× 1 random
vector, relying on the context to indicate whether X is a random vector or
data matrix. Software tends to use different notation. For example, R/Splus
will use commands such as

var(x)

to compute the sample covariance matrix of the data. Hence x corresponds
to W , x[,1] is the first column of x and x[4, ] is the 4th row of x.

14.1 The Multivariate Normal Distribution

Definition 14.2: Rao (1965, p. 437). A p × 1 random vector X has
a p−dimensional multivariate normal distribution Np(µ,Σ) iff tT X has a
univariate normal distribution for any p× 1 vector t.

If Σ is positive definite, then X has a pdf

f(z) =
1

(2π)p/2|Σ|1/2
e−(1/2)(z−µ)TΣ−1

(z−µ) (14.1)

where |Σ|1/2 is the square root of the determinant of Σ. Note that if p = 1,
then the quadratic form in the exponent is (z − µ)(σ2)−1(z − µ) and X has
the univariate N(µ, σ2) pdf. If Σ is positive semidefinite but not positive
definite, then X has a degenerate distribution. For example, the univariate
N(0, 02) distribution is degenerate (the point mass at 0).

Definition 14.3. The population mean of a random p × 1 vector X =
(X1, ..., Xp)

T is
E(X) = (E(X1), ..., E(Xp))

T
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and the p× p population covariance matrix

Cov(X) = E(X − E(X))(X − E(X))T = ((σi,j)).

That is, the ij entry of Cov(X) is Cov(Xi, Xj) = σi,j.

The covariance matrix is also called the variance–covariance matrix and
variance matrix. Sometimes the notation Var(X) is used. Note that Cov(X)
is a symmetric positive semidefinite matrix. If X and Y are p× 1 random
vectors, a a conformable constant vector and A and B are conformable
constant matrices, then

E(a + X) = a + E(X) and E(X + Y ) = E(X) + E(Y ) (14.2)

and
E(AX) = AE(X) and E(AXB) = AE(X)B. (14.3)

Thus
Cov(a + AX) = Cov(AX) = ACov(X)AT . (14.4)

Some important properties of MVN distributions are given in the follow-
ing three propositions. These propositions can be proved using results from
Johnson and Wichern (1988, p. 127-132).

Proposition 14.1. a) If X ∼ Np(µ,Σ), then E(X) = µ and

Cov(X) = Σ.

b) If X ∼ Np(µ,Σ), then any linear combination tTX = t1X1 + · · · +
tpXp ∼ N1(t

Tµ, tT Σt). Conversely, if tTX ∼ N1(t
Tµ, tT Σt) for every p× 1

vector t, then X ∼ Np(µ,Σ).

c) The joint distribution of independent normal random vari-
ables is MVN. If X1, ..., Xp are independent univariate normal N(µi, σ

2
i )

random vectors, then X = (X1, ..., Xp)
T is Np(µ,Σ) where µ = (µ1, ..., µp)

and Σ = diag(σ2
1, ..., σ

2
p) (so the off diagonal entries σi,j = 0 while the diag-

onal entries of Σ are σi,i = σ2
i ).

d) If X ∼ Np(µ,Σ) and if A is a q×pmatrix, then AX ∼ Nq(Aµ,AΣAT ).
If a is a p× 1 vector of constants, then a + X ∼ Np(a + µ,Σ).
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It will be useful to partition X, µ, and Σ. Let X1 and µ1 be q × 1
vectors, let X2 and µ2 be (p− q)× 1 vectors, let Σ11 be a q × q matrix, let
Σ12 be a q × (p− q) matrix, let Σ21 be a (p− q)× q matrix, and let Σ22 be
a (p− q)× (p− q) matrix. Then

X =

(
X1

X2

)
, µ =

(
µ1

µ2

)
, and Σ =

(
Σ11 Σ12

Σ21 Σ22

)
.

Proposition 14.2. a) All subsets of a MVN are MVN: (Xk1 , ..., Xkq)
T

∼ Nq(µ̃, Σ̃) where µ̃i = E(Xki) and Σ̃ij = Cov(Xki , Xkj ). In particular,
X1 ∼ Nq(µ1,Σ11) and X2 ∼ Np−q(µ2,Σ22).

b) If X1 and X2 are independent, then Cov(X1,X2) = Σ12 =
E[(X1 − E(X1))(X2 −E(X2))

T ] = 0, a q × (p− q) matrix of zeroes.

c) If X ∼ Np(µ,Σ), then X1 and X2 are independent iff Σ12 = 0.

d) If X1 ∼ Nq(µ1,Σ11) and X2 ∼ Np−q(µ2,Σ22) are independent, then(
X1

X2

)
∼ Np

( (
µ1

µ2

)
,

(
Σ11 0
0 Σ22

) )
.

Proposition 14.3. The conditional distribution of a MVN is
MVN. If X ∼ Np(µ,Σ), then the conditional distribution of X1 given
that X2 = x2 is multivariate normal with mean µ1 + Σ12Σ

−1
22 (x2 −µ2) and

covariance Σ11 −Σ12Σ
−1
22 Σ21. That is,

X1|X2 = x2 ∼ Nq(µ1 + Σ12Σ
−1
22 (x2 − µ2),Σ11 − Σ12Σ

−1
22 Σ21).

Example 14.1. Let p = 2 and let (Y,X)T have a bivariate normal
distribution. That is,(

Y
X

)
∼ N2

( (
µY

µX

)
,

(
σ2

Y Cov(Y,X)
Cov(X, Y ) σ2

X

) )
.

Also recall that the population correlation between X and Y is given by

ρ(X, Y ) =
Cov(X, Y )√

VAR(X)
√

VAR(Y )
=

σX,Y

σXσY

if σX > 0 and σY > 0. Then Y |X = x ∼ N(E(Y |X = x),VAR(Y |X = x))
where the conditional mean

E(Y |X = x) = µY + Cov(Y,X)
1

σ2
X

(x− µX) = µY + ρ(X, Y )

√
σ2

Y

σ2
X

(x− µX)
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and the conditional variance

VAR(Y |X = x) = σ2
Y −Cov(X, Y )

1

σ2
X

Cov(X, Y )

= σ2
Y − ρ(X, Y )

√
σ2

Y

σ2
X

ρ(X, Y )
√
σ2

X

√
σ2

Y

= σ2
Y − ρ2(X, Y )σ2

Y = σ2
Y [1 − ρ2(X, Y )].

Also aX + bY is univariate normal with mean aµX + bµY and variance

a2σ2
X + b2σ2

Y + 2ab Cov(X, Y ).

Remark 14.1. There are several common misconceptions. First, it is
not true that every linear combination tT X of normal random vari-
ables is a normal random variable, and it is not true that all uncor-
related normal random variables are independent. The key condition
in Proposition 14.1b and Proposition 14.2c is that the joint distribution of
X is MVN. It is possible that X1, X2, ..., Xp each has a marginal distribution
that is univariate normal, but the joint distribution of X is not MVN. The
following example is from Rohatgi (1976, p. 229). Suppose that the joint
pdf of X and Y is a mixture of two bivariate normal distributions both with
EX = EY = 0 and VAR(X) = VAR(Y ) = 1, but Cov(X, Y ) = ±ρ. Hence
f(x, y) =

1

2

1

2π
√

1 − ρ2
exp(

−1

2(1 − ρ2)
(x2 − 2ρxy + y2)) +

1

2

1

2π
√

1 − ρ2
exp(

−1

2(1 − ρ2)
(x2 + 2ρxy + y2)) ≡ 1

2
f1(x, y) +

1

2
f2(x, y)

where x and y are real and 0 < ρ < 1. Since both marginal distributions of
fi(x, y) are N(0,1) for i = 1 and 2 by Proposition 14.2 a), the marginal dis-
tributions of X and Y are N(0,1). Since

∫ ∫
xyfi(x, y)dxdy = ρ for i = 1 and

−ρ for i = 2, X and Y are uncorrelated, but X and Y are not independent
since f(x, y) �= fX(x)fY (y).

Remark 14.2. In Proposition 14.3, suppose that X = (Y,X2, ..., Xp)
T .

Let X1 = Y and X2 = (X2, ..., Xp)
T . Then E[Y |X2] = β1+β2X2+· · ·+βpXp

and VAR[Y |X2] is a constant that does not depend on X2. Hence Y =
β1 + β2X2 + · · · + βpXp + e follows the multiple linear regression model.
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14.2 Elliptically Contoured Distributions

Definition 14.4: Johnson (1987, p. 107-108). A p×1 random vector X
has an elliptically contoured distribution, also called an elliptically symmetric
distribution, if X has density

f(z) = kp|Σ|−1/2g[(z − µ)TΣ−1(z − µ)], (14.5)

and we say X has an elliptically contoured ECp(µ,Σ, g) distribution.

If X has an elliptically contoured (EC) distribution, then the character-
istic function of X is

φX (t) = exp(itTµ)ψ(tTΣt) (14.6)

for some function ψ. If the second moments exist, then

E(X) = µ (14.7)

and
Cov(X) = cXΣ (14.8)

where
cX = −2ψ′(0).

Definition 14.5. The population squared Mahalanobis distance

U ≡ D2 = D2(µ,Σ) = (X − µ)T Σ−1(X − µ) (14.9)

has density

h(u) =
πp/2

Γ(p/2)
kpu

p/2−1g(u). (14.10)

For c > 0, an ECp(µ, cI, g) distribution is spherical about µ where I is
the p×p identity matrix. The multivariate normal distribution Np(µ,Σ) has
kp = (2π)−p/2, ψ(u) = g(u) = exp(−u/2) and h(u) is the χ2

p density.

The following lemma is useful for proving properties of EC distributions
without using the characteristic function (14.6). See Eaton (1986) and Cook
(1998, p. 57, 130).
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Lemma 14.4. Let X be a p × 1 random vector with 1st moments; ie,
E(X) exists. Let B be any constant full rank p× r matrix where 1 ≤ r ≤ p.
Then X is elliptically contoured iff for all such conforming matrices B,

E(X|BT X) = µ + MBBT (X −µ) = aB + MBBTX (14.11)

where the p× 1 constant vector aB and the p× r constant matrix MB both
depend on B.

To use this lemma to prove interesting properties, partition X, µ, and
Σ. Let X1 and µ1 be q×1 vectors, let X2 and µ2 be (p− q)×1 vectors. Let
Σ11 be a q× q matrix, let Σ12 be a q× (p− q) matrix, let Σ21 be a (p− q)× q
matrix, and let Σ22 be a (p− q)× (p− q) matrix. Then

X =

(
X1

X2

)
, µ =

(
µ1

µ2

)
, and Σ =

(
Σ11 Σ12

Σ21 Σ22

)
.

Also assume that the (p+1)× 1 vector (Y,XT )T is ECp+1(µ,Σ, g) where Y
is a random variable, X is a p× 1 vector, and use(

Y
X

)
, µ =

(
µY

µX

)
, and Σ =

(
ΣY Y ΣY X

ΣXY ΣXX

)
.

Another useful fact is that aB and MB do not depend on g:

aB = µ −MBBTµ = (Ip − MBBT )µ,

and
MB = ΣB(BT ΣB)−1.

See Problem 14.11. Notice that in the formula for MB, Σ can be replaced
by cΣ where c > 0 is a constant. In particular, if the EC distribution has
2nd moments, Cov(X) can be used instead of Σ.

Proposition 14.5. Let X ∼ ECp(µ,Σ, g) and assume that E(X) exists.

a) Any subset of X is EC, in particular X1 is EC.

b) (Cook 1998 p. 131, Kelker 1970). If Cov(X) is nonsingular,

Cov(X|BTX) = dg(B
TX)[Σ− ΣB(BTΣB)−1BT Σ]

where the real valued function dg(B
TX) is constant iff X is MVN.
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Proof of a). Let A be an arbitrary full rank q×r matrix where 1 ≤ r ≤ q.
Let

B =

(
A
0

)
.

Then BTX = AT X1, and

E[X|BT X] = E[

(
X1

X2

)
|ATX1] =

(
µ1

µ2

)
+

(
M 1B

M 2B

) (
AT 0T

) (
X1 − µ1

X2 − µ2

)
by Lemma 14.4. HenceE[X1|ATX1] = µ1+M 1BAT (X1−µ1). Since A was
arbitrary, X1 is EC by Lemma 14.4. Notice that MB = ΣB(BT ΣB)−1 =(

Σ11 Σ12

Σ21 Σ22

) (
A
0

)
[
(

AT 0T
)( Σ11 Σ12

Σ21 Σ22

)(
A
0

)
]−1

=

(
M 1B

M 2B

)
.

Hence
M 1B = Σ11A(ATΣ11A)−1

and X1 is EC with location and dispersion parameters µ1 and Σ11. QED

Proposition 14.6. Let (Y,XT )T be ECp+1(µ,Σ, g) where Y is a random
variable.

a) Assume that E[(Y,XT )T ] exists. Then E(Y |X) = α + βTX where
α = µY − βT µX and

β = Σ−1
XXΣXY .

b) Even if the first moment does not exist, the conditional median

MED(Y |X) = α + βT X

where α and β are given in a).

Proof. a) The trick is to choose B so that Lemma 14.4 applies. Let

B =

(
0T

Ip

)
.
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Then BTΣB = ΣXX and

ΣB =

(
ΣY X

ΣXX

)
.

Now

E[

(
Y
X

)
| X] = E[

(
Y
X

)
| BT

(
Y
X

)
]

= µ + ΣB(BTΣB)−1BT

(
Y − µY

X − µX

)
by Lemma 14.4. The right hand side of the last equation is equal to

µ +

(
ΣY X

ΣXX

)
Σ−1

XX(X − µX) =

(
µY − ΣY XΣ−1

XXµX + ΣY XΣ−1
XXX

X

)
and the result follows since

βT = ΣY XΣ−1
XX .

b) See Croux, Dehon, Rousseeuw and Van Aelst (2001) for references.

Example 14.2. This example illustrates another application of Lemma
14.4. Suppose that X comes from a mixture of two multivariate normals
with the same mean and proportional covariance matrices. That is, let

X ∼ (1 − γ)Np(µ,Σ) + γNp(µ, cΣ)

where c > 0 and 0 < γ < 1. Since the multivariate normal distribution is
elliptically contoured

E(X|BT X) = (1 − γ)[µ + M1B
T (X − µ)] + γ[µ + M2B

T (X − µ)]

= µ + [(1 − γ)M 1 + γM 2]B
T (X − µ) ≡ µ + MBT (X − µ).

Since MB only depends on B and Σ, it follows that M 1 = M 2 = M = MB.
Hence X has an elliptically contoured distribution by Lemma 14.4.
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14.3 Sample Mahalanobis Distances

In the multivariate location and dispersion model, sample Mahalanobis dis-
tances play a role similar to that of residuals in multiple linear regression.
The observed data X i = xi for i = 1, ..., n is collected in an n× p matrix W
with n rows xT

1 , ...,x
T
n . Let the p × 1 column vector T (W ) be a multivari-

ate location estimator, and let the p × p symmetric positive definite matrix
C(W ) be a covariance estimator.

Definition 14.6. The ith squared Mahalanobis distance is

D2
i = D2

i (T (W ),C(W )) = (xi − T (W ))T C−1(W )(xi − T (W )) (14.12)

for each point xi. Notice that D2
i is a random variable (scalar valued).

Notice that the population squared Mahalanobis distance is

D2
x(µ,Σ) = (x − µ)T Σ−1(x − µ) (14.13)

and that the term Σ−1/2(x − µ) is the p−dimensional analog to the z-score
used to transform a univariate N(µ, σ2) random variable into a N(0, 1) ran-
dom variable. Hence the sample Mahalanobis distance Di =

√
D2

i is an
analog of the absolute value |zi| of the sample z-score zi = (xi −X)/σ̂. Also
notice that the Euclidean distance of xi from the estimate of center T (W )
is Di(T (W ), Ip) where Ip is the p× p identity matrix.

Example 14.3. The contours of constant density for the Np(µ,Σ) dis-
tribution are ellipsoids defined by x such that (x − µ)TΣ−1(x − µ) = a2.
An α−density region Rα is a set such that P (X ∈ Rα) = α, and for the
Np(µ,Σ) distribution, the regions of highest density are sets of the form

{x : (x− µ)TΣ−1(x −µ) ≤ χ2
p(α)} = {x : D2

x(µ,Σ) ≤ χ2
p(α)}

where P (W ≤ χ2
p(α)) = α if W ∼ χ2

p. If the X i are n iid random vectors
each with a Np(µ,Σ) pdf, then a scatterplot of Xi,k versus Xi,j should be
ellipsoidal for k �= j. Similar statements hold if X is ECp(µ,Σ, g), but the
α-density region will use a constant Uα obtained from Equation (14.10).

The classical Mahalanobis distance corresponds to the sample mean and
sample covariance matrix

T (W ) = x =
1

n

n∑
i=1

xi,
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and

C(W ) = S =
1

n− 1

n∑
i=1

(xi − x)(xi − x)T

and will be denoted by MDi. When T (W ) and C(W ) are estimators other
than the sample mean and covariance, Di =

√
D2

i will sometimes be denoted
by RDi.

14.4 Complements

Johnson and Wichern (1988) and Mardia, Kent and Bibby (1979) are good
references for multivariate statistical analysis based on the multivariate nor-
mal distribution. The elliptically contoured distributions generalize the mul-
tivariate normal distribution and are discussed in Johnson (1987). Cambanis,
Huang and Simons (1981), Chmielewski (1981) and Eaton (1986) are also im-
portant references.

14.5 Problems

14.1∗. Suppose that
X1

X2

X3

X4

 ∼ N4




49
100
17
7

 ,


3 1 −1 0
1 6 1 −1
−1 1 4 0
0 −1 0 2


 .

a) Find the distribution of X2.

b) Find the distribution of (X1, X3)
T .

c) Which pairs of random variables Xi and Xj are independent?

d) Find the correlation ρ(X1, X3).

14.2∗. Recall that if X ∼ Np(µ,Σ), then the conditional distribution of
X1 given that X2 = x2 is multivariate normal with mean µ1 +Σ12Σ

−1
22 (x2−

µ2) and covariance matrix Σ11 − Σ12Σ
−1
22 Σ21.
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Let σ12 = Cov(Y,X) and suppose Y and X follow a bivariate normal
distribution (

Y
X

)
∼ N2

( (
49
100

)
,

(
16 σ12

σ12 25

) )
.

a) If σ12 = 0, find Y |X. Explain your reasoning.

b) If σ12 = 10 find E(Y |X).

c) If σ12 = 10, find Var(Y |X).

14.3. Let σ12 = Cov(Y,X) and suppose Y and X follow a bivariate
normal distribution(

Y
X

)
∼ N2

( (
15
20

)
,

(
64 σ12

σ12 81

) )
.

a) If σ12 = 10 find E(Y |X).

b) If σ12 = 10, find Var(Y |X).

c) If σ12 = 10, find ρ(Y,X), the correlation between Y and X.

14.4. Suppose that

X ∼ (1 − γ)ECp(µ,Σ, g1) + γECp(µ, cΣ, g2)

where c > 0 and 0 < γ < 1. Following Example 14.2, show that X has
an elliptically contoured distribution assuming that all relevant expectations
exist.

14.5. In Proposition 14.5b, show that if the second moments exist, then
Σ can be replaced by Cov(X).

crancap hdlen hdht Data for 14.6

1485 175 132

1450 191 117

1460 186 122

1425 191 125

1430 178 120

1290 180 117

90 75 51
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14.6∗. The table (W ) above represents 3 head measurements on 6 people
and one ape. Let X1 = cranial capacity, X2 = head length and X3 = head
height. Let x = (X1, X2, X3)

T . Several multivariate location estimators,
including the coordinatewise median and sample mean, are found by applying
a univariate location estimator to each random variable and then collecting
the results into a vector. a) Find the coordinatewise median MED(W ).

b) Find the sample mean x.

14.7. Using the notation in Proposition 14.6, show that if the second
moments exist, then

Σ−1
XXΣXY = [Cov(X)]−1Cov(X, Y ).

14.8. Using the notation under Lemma 14.4, show that if X is elliptically
contoured, then the conditional distribution of X1 given that X2 = x2 is
also elliptically contoured.

14.9∗. Suppose Y ∼ Nn(Xβ, σ2I). Find the distribution of
(XTX)−1XTY if X is an n× p full rank constant matrix.

14.10. Recall that Cov(X,Y ) = E[(X − E(X))(Y − E(Y ))T ]. Using
the notation of Proposition 14.6, let (Y,XT )T be ECp+1(µ,Σ, g) where Y is
a random variable. Let the covariance matrix of (Y,XT ) be

Cov((Y,XT )T ) = c

(
ΣY Y ΣY X

ΣXY ΣXX

)
=

(
VAR(Y ) Cov(Y,X)

Cov(X, Y ) Cov(X)

)
where c is some positive constant. Show that E(Y |X) = α + βT X where

α = µY − βTµX and

β = [Cov(X)]−1Cov(X, Y ).

14.11. (Due to R.D. Cook.) Let X be a p × 1 random vector with
E(X) = 0 and Cov(X) = Σ. Let B be any constant full rank p× r matrix
where 1 ≤ r ≤ p. Suppose that for all such conforming matrices B,

E(X|BT X) = MBBT X

where MB a p× r constant matrix that depend on B.
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Using the fact that ΣB = Cov(X,BTX) = E(XXTB) =
E[E(XXTB|BTX)], compute ΣB and show that MB = ΣB(BTΣB)−1.
Hint: what acts as a constant in the inner expectation?

R/Splus Problems

Use the command source(“A:/regpack.txt”) to download the func-
tions and the command source(“A:/regdata.txt”) to download the data.
See Preface or Section 17.2. Typing the name of the regpack function,
eg maha, will display the code for the function. Use the args command, eg
args(maha), to display the needed arguments for the function.

14.12. a) Download the maha function that creates the classical Maha-
lanobis distances.

b) Enter the following commands and check whether observations 1–40
look like outliers.

> simx2 <- matrix(rnorm(200),nrow=100,ncol=2)

> outx2 <- matrix(10 + rnorm(80),nrow=40,ncol=2)

> outx2 <- rbind(outx2,simx2)

> maha(outx2)

14.13∗. a) Assuming that you have done the two source commands above
Problem 14.12 (and in R the library(MASS) command), type the command
ddcomp(buxx). This will make 4 DD plots (see Section 3.6) based on the
DGK, FCH, FMCD and median ball estimators. The DGK and median ball
estimators are the two attractors used by the FCH estimator. With the
leftmost mouse button, move the cursor to each outlier and click. This data
is the Buxton (1920) data and cases with numbers 61, 62, 63, 64, and 65
were the outliers with head lengths near 5 feet. After identifying the outliers
in each plot, hold the rightmost mouse button down (and in R click on Stop)
to advance to the next plot. When done, hold down the Ctrl and c keys to
make a copy of the plot. Then paste the plot in Word.

b) Repeat a) but use the command ddcomp(cbrainx). This data is the
Gladstone (1905-6) data and some infants are multivariate outliers.

c) Repeat a) but use the command ddcomp(museum[,-1]). This data
is the Schaaffhausen (1878) skull measurements and cases 48–60 were apes
while the first 47 cases were humans.



Chapter 15

1D Regression

... estimates of the linear regression coefficients are relevant to the linear
parameters of a broader class of models than might have been suspected.

Brillinger (1977, p. 509)
After computing β̂, one may go on to prepare a scatter plot of the points

(β̂xj, yj), j = 1, ..., n and look for a functional form for g(·).
Brillinger (1983, p. 98)

Regression is the study of the conditional distribution Y |x of the response
Y given the (p− 1) × 1 vector of nontrivial predictors x. The scalar Y is a
random variable and x is a random vector. A special case of regression is
multiple linear regression. In Chapter 2 the multiple linear regression model
was Yi = wi,1η1 +wi,2η2 + · · ·+wi,pηp + ei = wT

i η+ ei for i = 1, . . . , n. In this
chapter, the subscript i is often suppressed and the multiple linear regression
model is written as Y = α+ x1β1 + · · · + xp−1βp−1 + e = α + βTx + e. The
primary difference is the separation of the constant term α and the nontrivial
predictors x. In Chapter 2, wi,1 ≡ 1 for i = 1, ..., n. Taking Y = Yi, α = η1,
βj = ηj+1, and xj = wi,j+1 and e = ei for j = 1, ..., p − 1 shows that the
two models are equivalent. The change in notation was made because the
distribution of the nontrivial predictors is very important for the theory of
the more general regression models.

Definition 15.1: Cook and Weisberg (1999a, p. 414). In a 1D
regression model, the response Y is conditionally independent of x given a
single linear combination βT x of the predictors, written

Y x|βT x or Y x|(α+ βTx). (15.1)

433
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The 1D regression model is also said to have 1–dimensional structure or
1D structure. An important 1D regression model, introduced by Li and Duan
(1989), has the form

Y = g(α+ βTx, e) (15.2)

where g is a bivariate (inverse link) function and e is a zero mean error that
is independent of x. The constant term α may be absorbed by g if desired.

Special cases of the 1D regression model (15.1) include many important
generalized linear models (GLMs) and the additive error single index model

Y = m(α+ βTx) + e. (15.3)

Typically m is the conditional mean or median function. For example if all
of the expectations exist, then

E[Y |x] = E[m(α+ βTx)|x] + E[e|x] = m(α+ βTx).

The multiple linear regression model is an important special case where m is
the identity function: m(α + βTx) = α + βT x. Another important special
case of 1D regression is the response transformation model where

g(α+ βTx, e) = t−1(α+ βTx + e) (15.4)

and t−1 is a one to one (typically monotone) function. Hence

t(Y ) = α + βT x + e.

Chapter 16 shows that many survival models are 1D regression models, in-
cluding the Cox (1972) proportional hazards model. Li and Duan (1989, p.
1014) note that the class of 1D regression models also includes binary re-
gression models, censored regression models, and certain projection pursuit
models.

Definition 15.2. Regression is the study of the conditional distribution
of Y |x. Focus is often on the mean function E(Y |x) and/or the variance
function VAR(Y |x). There is a distribution for each value of x = xo such
that Y |x = xo is defined. For a 1D regression,

E(Y |x = xo) = E(Y |βT x = βTxo) ≡ M(βTxo)

and
VAR(Y |x = xo) = VAR(Y |βT x = βTxo) ≡ V (βTxo)
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where M is the kernel mean function and V is the kernel variance function.

Notice that the mean and variance functions depend on the same linear
combination if the 1D regression model is valid. This dependence is typical
of GLMs where M and V are known kernel mean and variance functions
that depend on the family of GLMs. See Cook and Weisberg (1999a, section
23.1). A heteroscedastic regression model

Y = M(βT
1 x) +

√
V (βT

2 x) e (15.5)

is a 1D regression model if β2 = cβ1 for some scalar c.

In multiple linear regression, the difference between the response Yi and

the estimated conditional mean function α̂+ β̂
T
xi is the residual. For more

general regression models this difference may not be the residual, and the

“discrepancy” Yi−M(β̂
T
xi) may not be estimating the error ei. To guarantee

that the residuals are estimating the errors, the following definition is used
when possible.

Definition 15.3: Cox and Snell (1968). Let the errors ei be iid with
pdf f and assume that the regression model Yi = g(xi,η, ei) has a unique
solution for ei :

ei = h(xi,η, Yi).

Then the ith residual
êi = h(xi, η̂, Yi)

where η̂ is a consistent estimator of η.

Example 15.1. Let η = (α,βT )T . If Y = m(α + βT x) + e where m is

known, then e = Y −m(α + βTx). Hence êi = Yi −m(α̂ + β̂
T
xi) which is

the usual definition of the ith residual for such models.

Dimension reduction can greatly simplify our understanding of the con-
ditional distribution Y |x. If a 1D regression model is appropriate, then the
(p − 1)–dimensional vector x can be replaced by the 1–dimensional scalar
βT x with “no loss of information about the conditional distribution.” Cook
and Weisberg (1999a, p. 411) define a sufficient summary plot (SSP) to be a
plot that contains all the sample regression information about the conditional
distribution Y |x of the response given the predictors.
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Definition 15.4: If the 1D regression model holds, then Y x|(a+cβTx)
for any constants a and c �= 0. The quantity a + cβTx is called a sufficient
predictor (SP), and a sufficient summary plot is a plot of any SP versus Y .

An estimated sufficient predictor (ESP) is α̂+ β̂
T
x where β̂ is an estimator

of cβ for some nonzero constant c. A response plot or estimated sufficient
summary plot (ESSP) is a plot of any ESP versus Y .

If there is only one predictor x, then the plot of x versus Y is both a
sufficient summary plot and a response plot, but generally only a response
plot can be made. Since a can be any constant, â = 0 is often used. The
following section shows how to use the OLS regression of Y on x to obtain
an ESP.

15.1 Estimating the Sufficient Predictor

Some notation is needed before giving theoretical results. Let x, a, t, and β
be (p− 1) × 1 vectors where only x is random.

Definition 15.5: Cook and Weisberg (1999a, p. 431). The predic-
tors x satisfy the condition of linearly related predictors with 1D structure
if

E[x|βT x] = a + tβT x. (15.6)

If the predictors x satisfy this condition, then for any given predictor xj,

E[xj|βTx] = aj + tjβ
Tx.

Notice that β is a fixed (p− 1)× 1 vector. If x is elliptically contoured (EC)
with 1st moments, then the assumption of linearly related predictors holds
since

E[x|bTx] = ab + tbb
Tx

for any nonzero (p − 1) × 1 vector b (see Lemma 14.4). The condition of
linearly related predictors is impossible to check since β is unknown, but the
condition is far weaker than the assumption that x is EC. The stronger EC
condition is often used since there are checks for whether this condition is
reasonable, eg use the DD plot. The following proposition gives an equivalent
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definition of linearly related predictors. Both definitions are frequently used
in the dimension reduction literature.

Proposition 15.1. The predictors x are linearly related iff

E[bT x|βTx] = ab + tbβ
Tx (15.7)

for any (p − 1) × 1 constant vector b where ab and tb are constants that
depend on b.

Proof. Suppose that the assumption of linearly related predictors holds.
Then

E[bT x|βT x] = bTE[x|βTx] = bT a + bT tβT x.

Thus the result holds with ab = bT a and tb = bT t.
Now assume that Equation (15.7) holds. Take bi = (0, ..., 0, 1, 0, ..., 0)T ,

the vector of zeroes except for a one in the ith position. Then by Definition
15.5, E[x|βT x] = E[Ip−1x|βTx] =

E[

 bT
1 x
...

bT
p−1x

 | βT x] =

 a1 + t1β
T x

...
ap−1 + tp−1β

Tx

 ≡ a + tβTx.

QED

Following Cook (1998a, p. 143-144), assume that there is an objective
function

Ln(a, b) =
1

n

n∑
i=1

L(a + bT xi, Yi) (15.8)

where L(u, v) is a bivariate function that is a convex function of the first
argument u. Assume that the estimate (â, b̂) of (a, b) satisfies

(â, b̂) = arg min
a,b

Ln(a, b). (15.9)

For example, the ordinary least squares (OLS) estimator uses

L(a+ bT x, Y ) = (Y − a− bTx)2.

Maximum likelihood type estimators such as those used to compute GLMs
and Huber’s M–estimator also work, as does the Wilcoxon rank estima-
tor. Assume that the population analog (α∗,β∗) is the unique minimizer of
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E[L(a+bTx, Y )] where the expectation exists and is with respect to the joint
distribution of (Y,xT )T . For example, (α∗,β∗) is unique if L(u, v) is strictly
convex in its first argument. The following result is a useful extension of
Brillinger (1977, 1983).

Theorem 15.2 (Li and Duan 1989, p. 1016): Assume that the x are
linearly related predictors, that (Yi,x

T
i )T are iid observations from some joint

distribution with Cov(xi) nonsingular. Assume L(u, v) is convex in its first
argument and that β∗ is unique. Assume that Y x|βTx. Then β∗ = cβ
for some scalar c.

Proof. See Li and Duan (1989) or Cook (1998a, p. 144).

Remark 15.1. This theorem basically means that if the 1D regression
model is appropriate and if the condition of linearly related predictors holds,
then the (eg OLS) estimator b̂ ≡ β̂

∗ ≈ cβ. Li and Duan (1989, p. 1031)
show that under additional conditions, (â, b̂) is asymptotically normal. In
particular, the OLS estimator frequently has a

√
n convergence rate. If the

OLS estimator (α̂, β̂) satisfies β̂ ≈ cβ when model (15.1) holds, then the
response plot of

α̂ + β̂
T
x versus Y

can be used to visualize the conditional distribution Y |(α + βT x) provided
that c �= 0.

Remark 15.2. If b̂ is a consistent estimator of β∗, then certainly

β∗ = cxβ + ug

where ug = β∗ − cxβ is the bias vector. Moreover, the bias vector ug = 0
if x is elliptically contoured under the assumptions of Theorem 15.2. This
result suggests that the bias vector might be negligible if the distribution of
the predictors is close to being EC. Often if no strong nonlinearities are
present among the predictors, the bias vector is small enough so that

b̂
T
x is a useful ESP.

Remark 15.3. Suppose that the 1D regression model is appropriate and
Y x|βTx. Then Y x|cβT x for any nonzero scalar c. If Y = g(βT x, e)
and both g and β are unknown, then g(βT x, e) = ha,c(a+ cβTx, e) where

ha,c(w, e) = g(
w − a

c
, e)
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for c �= 0. In other words, if g is unknown, we can estimate cβ but we can
not determine c or β; ie, we can only estimate β up to a constant.

A very useful result is that if Y = m(x) for some function m, then m
can be visualized with both a plot of x versus Y and a plot of cx versus
Y if c �= 0. In fact, there are only three possibilities, if c > 0 then the two
plots are nearly identical: except the labels of the horizontal axis change.
(The two plots are usually not exactly identical since plotting controls to
“fill space” depend on several factors and will change slightly.) If c < 0,
then the plot appears to be flipped about the vertical axis. If c = 0, then
m(0) is a constant, and the plot is basically a dot plot. Similar results hold
if Yi = g(α+ βTxi, ei) if the errors ei are small. OLS often provides a useful
estimator of cβ where c �= 0, but OLS can result in c = 0 if g is symmetric
about the median of α+ βTx.

Definition 15.6. If the 1D regression model (15.1) holds, and a specific
estimator such as OLS is used, then the ESP will be called the OLS ESP
and the response plot will be called the OLS response plot.

Example 15.2. Suppose that xi ∼ N3(0, I3) and that

Y = m(βT x) + e = (x1 + 2x2 + 3x3)
3 + e.

Then a 1D regression model holds with β = (1, 2, 3)T . Figure 1.11 shows the
sufficient summary plot of βTx versus Y , and Figure 1.12 shows the sufficient
summary plot of −βTx versus Y . Notice that the functional form m appears
to be cubic in both plots and that both plots can be smoothed by eye or with
a scatterplot smoother such as lowess. The two figures were generated with
the following R/Splus commands.

X <- matrix(rnorm(300),nrow=100,ncol=3)

SP <- X%*%1:3

Y <- (SP)^3 + rnorm(100)

plot(SP,Y)

plot(-SP,Y)

We particularly want to use the OLS estimator (α̂, β̂) to produce an
estimated sufficient summary plot. This estimator is obtained from the usual
multiple linear regression of Yi on xi, but we are not assuming that the
multiple linear regression model holds; however, we are hoping that the 1D



CHAPTER 15. 1D REGRESSION 440

regression model Y x|βT x is a useful approximation to the data and that
β̂ ≈ cβ for some nonzero constant c. In addition to Theorem 15.2, nice
results exist if the single index model is appropriate. Recall that

Cov(x,Y ) = E[(x− E(x))((Y − E(Y ))T ].

Definition 15.7. Suppose that (Yi,x
T
i )T are iid observations and that

the positive definite (p − 1) × (p − 1) matrix Cov(x) = ΣX and the (p −
1)× 1 vector Cov(x, Y ) = ΣX,Y . Let the OLS estimator (α̂, β̂) be computed

from the multiple linear regression of Y on x plus a constant. Then (α̂, β̂)
estimates the population quantity (αOLS,βOLS) where

αOLS = E(Y ) − βT
OLSE(x) and βOLS = Σ−1

X ΣX,Y. (15.10)

The following notation will be useful for studying the OLS estimator.
Let the sufficient predictor z = βTx and let w = x − E(x). Let r =
w − (ΣXβ)βTw.

Theorem 15.3. In addition to the conditions of Definition 15.7, also
assume that Yi = m(βTxi) + ei where the zero mean constant variance iid
errors ei are independent of the predictors xi. Then

βOLS = Σ−1
X ΣX,Y = cm,Xβ + um,X (15.11)

where the scalar
cm,X = E[βT (x − E(x)) m(βTx)] (15.12)

and the bias vector
um,X = Σ−1

X E[m(βTx)r]. (15.13)

Moreover, um,X = 0 if x is from an EC distribution with nonsingular ΣX,
and cm,X �= 0 unless Cov(x, Y ) = 0. If the multiple linear regression model
holds, then cm,X = 1, and um,X = 0.

The proof of the above result is outlined in Problem 15.2 using an ar-
gument due to Aldrin, Bφlviken, and Schweder (1993). If the 1D regression
model is appropriate, then typically Cov(x, Y ) �= 0 unless βT x follows a
symmetric distribution and m is symmetric about the median of βTx.

Definition 15.8. Let (α̂, β̂) denote the OLS estimate obtained from the
OLS multiple linear regression of Y on x. The OLS view is a response plot

of a + β̂
T
x versus Y . Typically a = 0 or a = α̂.
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Remark 15.4. All of this awkward notation and theory leads to a rather
remarkable result, perhaps first noted by Brillinger (1977, 1983) and called
the 1D Estimation Result by Cook and Weisberg (1999a, p. 432). The result
is that if the 1D regression model is appropriate, then the OLS view will
frequently be a useful estimated sufficient summary plot (ESSP). Hence the

OLS predictor β̂
T
x is a useful estimated sufficient predictor (ESP).

Although the OLS view is frequently a good ESSP if no strong nonlinear-
ities are present in the predictors and if cm,X �= 0 (eg the sufficient summary
plot of βTx versus Y is not approximately symmetric), even better estimated
sufficient summary plots can be obtained by using ellipsoidal trimming. This
topic is discussed in the following section and follows Olive (2002) closely.

15.2 Visualizing 1D Regression

If there are two predictors, even with a distribution that is not EC, Cook
and Weisberg (1999a, ch. 8) demonstrate that a 1D regression can be visual-
ized using a three–dimensional plot with Y on the vertical axes and the two
predictors on the horizontal and out of page axes. Rotate the plot about the
vertical axes. Each combination of the predictors gives a two dimensional
“view.” Search for the view with a smooth mean function that has the small-
est possible variance function and use this view as the estimated sufficient
summary plot.

For higher dimensions, Cook and Nachtsheim (1994) and Cook (1998a, p.
152) demonstrate that the bias um,X can often be made small by ellipsoidal
trimming. To perform ellipsoidal trimming, an estimator (T,C) is computed
where T is a (p − 1) × 1 multivariate location estimator and C is a (p −
1) × (p − 1) symmetric positive definite dispersion estimator. Then the ith
squared Mahalanobis distance is the random variable

D2
i = (xi − T )TC−1(xi − T ) (15.14)

for each vector of observed predictors xi. If the ordered distances D(j) are
unique, then j of the xi are in the hyperellipsoid

{x : (x − T )TC−1(x − T ) ≤ D2
(j)}. (15.15)

The ith case (Yi,x
T
i )T is trimmed if Di > D(j). Thus if j ≈ 0.9n, then about

10% of the cases are trimmed.
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We suggest that the estimator (T,C) should be the classical sample mean
and covariance matrix (x,S) or a robust estimator such as covfch. When
j ≈ n/2, the covfch estimator attempts to make the volume of the hyperel-
lipsoid given by Equation (15.15) small.

Ellipsoidal trimming seems to work for at least three reasons. The trim-
ming divides the data into two groups: the trimmed cases and the remaining
cases (xM , YM ) where M% is the amount of trimming, eg M = 10 for 10%
trimming. If the distribution of the predictors x is EC then the distribution
of xM still retains enough symmetry so that the bias vector is approximately
zero. If the distribution of x is not EC, then the distribution of xM will
often have enough symmetry so that the bias vector is small. In particular,
trimming often removes strong nonlinearities from the predictors and the
weighted predictor distribution is more nearly elliptically symmetric than
the predictor distribution of the entire data set (recall Winsor’s principle:
“all data are roughly Gaussian in the middle”). Secondly, under heavy trim-
ming, the mean function of the remaining cases may be more linear than the
mean function of the entire data set. Thirdly, if |c| is very large, then the bias
vector may be small relative to cβ. Trimming sometimes inflates |c|. From
Theorem 15.3, any of these three reasons should produce a better estimated
sufficient predictor.

Example 15.3. Cook and Weisberg (1999a, p. 351, 433, 447) gave a
data set on 82 mussels sampled off the coast of New Zealand. The variables
are the muscle mass M in grams, the length L and height H of the shell
in mm, the shell width W and the shell mass S. The robust and classical
Mahalanobis distances were calculated, and Figure 15.1 shows a scatterplot
matrix of the mussel data, the RDi’s, and the MDi’s. Notice that many
of the subplots are nonlinear. The cases marked by open circles were given
weight zero by the cov.mcd algorithm, and the linearity of the retained cases
has increased. Note that only one trimming proportion is shown and that
a heavier trimming proportion would increase the linearity of the cases that
were not trimmed.

The two ideas of using ellipsoidal trimming to reduce the bias and choos-
ing a view with a smooth mean function and smallest variance function can
be combined into a graphical method for finding the estimated sufficient sum-
mary plot and the estimated sufficient predictor. Trim the M% of the cases
with the largest Mahalanobis distances, and then compute the OLS estima-
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Figure 15.1: Scatterplot for Mussel Data, o Corresponds to Trimmed Cases
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tor (α̂M , β̂M ) from the cases that remain. Use M = 0, 10, 20, 30, 40, 50, 60,

70, 80, and 90 to generate ten plots of β̂
T

Mx versus Y using all n cases. In
analogy with the Cook and Weisberg procedure for visualizing 1D structure
with two predictors, the plots will be called “trimmed views.” Notice that
M = 0 corresponds to the OLS view.

Definition 15.9. The best trimmed view is the trimmed view with a
smooth mean function and the smallest variance function and is the estimated
sufficient summary plot. If M∗ = E is the percentage of cases trimmed that

corresponds to the best trimmed view, then β̂
T

Ex or α̂E+β̂
T

Ex is the estimated
sufficient predictor.

The following examples illustrate the R/Splus regpack function trviews

that is used to produce the ESSP. If R is used instead of Splus, the command

library(MASS)

needs to be entered to access the function cov.mcd called by trviews. The
robust estimators cov.fch and cov.mbacan also be used. The function
trviews is used in Problem 15.6. The estimator can be used to simultane-
ously detect whether the data is following a multiple linear regression model

or some other single index model. Plot α̂E + β̂
T

Ex versus Y and add the iden-
tity line. If the plotted points follow the identity line then the MLR model is
reasonable, but if the plotted points follow a nonlinear mean function, then
a nonlinear single index model may be reasonable.

Example 15.2 continued. The command

trviews(X, Y)

produced the following output.

Intercept X1 X2 X3

0.6701255 3.133926 4.031048 7.593501

Intercept X1 X2 X3

1.101398 8.873677 12.99655 18.29054

Intercept X1 X2 X3

0.9702788 10.71646 15.40126 23.35055

Intercept X1 X2 X3

0.5937255 13.44889 23.47785 32.74164
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Intercept X1 X2 X3

1.086138 12.60514 25.06613 37.25504

Intercept X1 X2 X3

4.621724 19.54774 34.87627 48.79709

Intercept X1 X2 X3

3.165427 22.85721 36.09381 53.15153

Intercept X1 X2 X3

5.829141 31.63738 56.56191 82.94031

Intercept X1 X2 X3

4.241797 36.24316 70.94507 105.3816

Intercept X1 X2 X3

6.485165 41.67623 87.39663 120.8251

The function generates 10 trimmed views. The first plot trims 90% of the
cases while the last plot does not trim any of the cases and is the OLS view.
To advance a plot, press the right button on the mouse (in R, highlight
stop rather than continue). After all of the trimmed views have been
generated, the output is presented. For example, the 5th line of numbers in

the output corresponds to α̂50 = 1.086138 and β̂
T

50 where 50% trimming was
used. The second line of numbers corresponds to 80% trimming while the

last line corresponds to 0% trimming and gives the OLS estimate (α̂0, β̂
T

0 ) =
(â, b̂). The trimmed views with 50% and 90% trimming were very good.
We decided that the view with 50% trimming was the best. Hence β̂E =
(12.60514, 25.06613, 37.25504)T ≈ 12.5β. The best view is shown in Figure
15.2 and is nearly identical to the sufficient summary plot shown in Figure
1.11. Notice that the OLS estimate = (41.68, 87.40, 120.83)T ≈ 42β. The
OLS view is shown in Figure 1.13, and is again very similar to the sufficient
summary plot, but it is not quite as smooth as the best trimmed view.

The plot of the estimated sufficient predictor versus the sufficient predic-
tor is also informative. Of course this plot can usually only be generated for
simulated data since β is generally unknown. If the plotted points are highly
correlated (with |corr(ESP,SP)| > 0.95) and follow a line through the origin,
then the estimated sufficient summary plot is nearly as good as the sufficient
summary plot. The simulated data used β = (1, 2, 3)T , and the commands

SP <- X %*% 1:3

ESP <- X %*% c(12.60514, 25.06613, 37.25504)

plot(ESP,SP)
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generated the plot shown in Figure 15.3.

Example 15.4. An artificial data set with 200 trivariate vectors xi

was generated. The marginal distributions of xi,j are iid lognormal for
j = 1, 2, and 3. Since the response Yi = sin(βT xi)/β

Txi where β =
(1, 2, 3)T , the random vector xi is not elliptically contoured and the func-

tion m is strongly nonlinear. Figure 15.5 shows the OLS view where β̂
T

0 =
(0.0032, 0.0011, 0.0047)T and Figure 15.4 shows the best trimmed view where

β̂
T

90 = (0.086, 0.182, 0.338)T ≈ 0.1β, roughly. Notice that it is difficult to vi-
sualize the mean function with the OLS view, and notice that the correlation
between Y and the ESP is very low. By focusing on a part of the data where
the correlation is high, it may be possible to improve the estimated sufficient
summary plot. For example, in Figure 15.4, temporarily omit cases that
have ESP less than 0.3 and greater than 0.75. From the untrimmed cases,
obtained the ten trimmed estimates β̂90, ..., β̂0. Then using all of the data,
obtain the ten views. The best view could be used as the ESSP.

Application 15.1. Suppose that a 1D regression analysis is desired on
a data set, use the trimmed views as an exploratory data analysis technique
to visualize the conditional distribution Y |βT x. The best trimmed view is
an estimated sufficient summary plot. If the single index model (15.3) holds,
the function m can be estimated from this plot using parametric models
or scatterplot smoothers such as lowess. Notice that Y can be predicted
visually using up and over lines.

Application 15.2. The best trimmed view can also be used as a diag-
nostic for linearity and monotonicity.

For example in Figure 15.2, if ESP = 0, then Ŷ = 0 and if ESP = 100,
then Ŷ = 500. Figure 15.2 suggests that the mean function is monotone but
not linear, and Figure 15.4 suggests that the mean function is neither linear
nor monotone.

Application 15.3. Assume that a known 1D regression model is as-
sumed for the data. Then the best trimmed view can be used as a diagnostic
for whether the assumed model is appropriate.

The trimmed views are sometimes useful even when the assumption of
linearly related predictors fails. OLS frequently performs well if there are no
strong nonlinearities present in the predictors.
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15.3 Predictor Transformations

As a general rule, inferring about the distribution of Y |X from a lower
dimensional plot should be avoided when there are strong nonlinearities

among the predictors.
Cook and Weisberg (1999b, p. 34)

Even if the multiple linear regression model is valid, a model based on a
subset of the predictor variables depends on the predictor distribution. If the
predictors are linearly related (eg EC), then the submodel mean and vari-
ance functions are generally well behaved, but otherwise the submodel mean
function could be nonlinear and the submodel variance function could be
nonconstant. For 1D regression models, the presence of strong nonlinearities
among the predictors can invalidate inferences. A necessary condition for
x to have an EC distribution (or for no strong nonlinearities to be present
among the predictors) is for each marginal plot of the scatterplot matrix of
the predictors to have a linear or ellipsoidal shape if n is large.

One of the most useful techniques in regression is to remove gross nonlin-
earities in the predictors by using predictor transformations. Power trans-
formations are particularly effective. A multivariate version of the Box–Cox
transformation due to Velilla (1993) can cause the distribution of the trans-
formed predictors to be closer to multivariate normal, and the Cook and
Nachtsheim (1994) procedure can cause the distribution to be closer to ellip-
tical symmetry. Marginal Box-Cox transformations also seem to be effective.
Power transformations can also be selected with slider bars in Arc.

There are several rules for selecting marginal transformations visually.
(Also see discussion in Section 3.1.) First, use theory if available. Suppose
that variable X2 is on the vertical axis and X1 is on the horizontal axis and
that the plot of X1 versus X2 is nonlinear. The unit rule says that if X1 and
X2 have the same units, then try the same transformation for both X1 and
X2.

Power transformations are also useful. Assume that all values of X1 and
X2 are positive. Let λ be the power of the transformation. Then the following
four rules are often used.

The log rule states that positive predictors that have the ratio between
their largest and smallest values greater than ten should be transformed to
logs. See Cook and Weisberg (1999a, p. 87).

Secondly, if it is known that X2 ≈ Xλ
1 and the ranges of X1 and X2 are
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such that this relationship is one to one, then

Xλ
1 ≈ X2 and X

1/λ
2 ≈ X1.

Hence either the transformation Xλ
1 or X

1/λ
2 will linearize the plot. This

relationship frequently occurs if there is a volume present. For example let
X2 be the volume of a sphere and let X1 be the circumference of a sphere.
The plot of log(X1) versus log(X2) will also be linear.

Thirdly, the bulging rule states that changes to the power of X2 and the
power of X1 can be determined by the direction that the bulging side of the
curve points. If the curve is hollow up (the bulge points down), decrease the
power of X2. If the curve is hollow down (the bulge points up), increase the
power of X2 If the curve bulges towards large values of X1 increase the power
of X1. If the curve bulges towards small values of X1 decrease the power of
X1. See Tukey (1977, p. 173–176).

Finally, Cook and Weisberg (1999a, p. 86) give the following rule.
To spread small values of a variable, make λ smaller.
To spread large values of a variable, make λ larger.

For example, in Figure 15.10c, small values of Y and large values of FESP
need spreading, and using log(Y ) would make the plot more linear.

15.4 Variable Selection

A standard problem in 1D regression is variable selection, also called subset or
model selection. Assume that model (15.1) holds, that a constant is always
included, and that x = (x1, ..., xp−1)

T are the p − 1 nontrivial predictors,
which we assume to be of full rank. Then variable selection is a search for
a subset of predictor variables that can be deleted without important loss of
information. This section follows Olive and Hawkins (2005) closely.

Variable selection for the 1D regression model is very similar to variable
selection for the multiple linear regression model (see Section 3.4). To clarify
ideas, assume that there exists a subset S of predictor variables such that
if xS is in the 1D model, then none of the other predictors are needed in
the model. Write E for these (‘extraneous’) variables not in S, partitioning
x = (xT

S ,x
T
E)T . Then

SP = α + βT x = α + βT
SxS + βT

ExE = α+ βT
SxS. (15.16)
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The extraneous terms that can be eliminated given that the subset S is in
the model have zero coefficients.

Now suppose that I is a candidate subset of predictors, that S ⊆ I and
that O is the set of predictors not in I . Then

SP = α+ βTx = α+ βT
SxS = α + βT

SxS + βT
(I/S)xI/S + 0TxO = α+ βT

I xI ,

(if I includes predictors from E, these will have zero coefficient). For any
subset I that contains the subset S of relevant predictors, the correlation

corr(α + βTxi, α + βT
I xI,i) = 1. (15.17)

This observation, which is true regardless of the explanatory power of
the model, suggests that variable selection for 1D regression models is simple
in principle. For each value of j = 1, 2, ..., p− 1 nontrivial predictors, keep
track of subsets I that provide the largest values of corr(ESP,ESP(I)). Any
such subset for which the correlation is high is worth closer investigation
and consideration. To make this advice more specific, use the rule of thumb
that a candidate subset of predictors I is worth considering if the sample
correlation of ESP and ESP(I) satisfies

corr(α̂+ β̂
T
xi, α̂I + β̂

T

I xI,i) = corr(β̂
T
xi, β̂

T

I xI,i) ≥ 0.95. (15.18)

The difficulty with this approach is that fitting all of the possible sub-
models involves substantial computation. An exception to this difficulty is
multiple linear regression where there are efficient “leaps and bounds” algo-
rithms for searching all subsets when OLS is used (see Furnival and Wilson
1974). Since OLS often gives a useful ESP, the following all subsets procedure
can be used for 1D models when p < 20.

• Fit a full model using the methods appropriate to that 1D problem to

find the ESP α̂ + β̂
T
x.

• Find the OLS ESP α̂OLS + β̂
T

OLSx.

• If the 1D ESP and the OLS ESP have “a strong linear relationship”
(for example |corr(ESP,OLS ESP)| ≥ 0.95), then infer that the 1D
problem is one in which OLS may serve as an adequate surrogate for
the correct 1D model fitting procedure.
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• Use computationally fast OLS variable selection procedures such as
forward selection, backward elimination and the leaps and bounds al-
gorithm along with the Mallows (1973) Cp criterion to identify pre-
dictor subsets I containing k variables (including the constant) with
Cp(I) ≤ min(2k, p).

• Perform a final check on the subsets that satisfy the Cp screen by using
them to fit the 1D model.

For a 1D model, the response, ESP and vertical discrepancies V =
Y −ESP are important. When the multiple linear regression (MLR) model
holds, the fitted values are the ESP: Ŷ = ESP , and the vertical discrepancies
are the residuals.

Definition 15.10. a) The plot of α̃I + β̃
T

I xI,i versus α̃ + β̃
T
xi is called

an EE plot (often called an FF plot for MLR).

b) The plot of discrepancies Yi − α̃I − β̃
T

I xI,i versus Yi − α̃ − β̃
T
xi is called

a VV plot (often called an RR plot for MLR).

c) The plots of α̃I + β̃
T

I xI,i versus Yi and of α̃ + β̃
T
xi versus Yi are called

estimated sufficient summary plots or response plots.

Many numerical methods such as forward selection, backward elimination,
stepwise and all subset methods using the Cp criterion (Jones 1946, Mallows
1973), have been suggested for variable selection. The four plots in Definition
15.10 contain valuable information to supplement the raw numerical results
of these selection methods. Particular uses include:

• The key to understanding which plots are the most useful is the obser-
vation that a wz plot is used to visualize the conditional distribution
of z given w. Since a 1D regression is the study of the conditional
distribution of Y given α + βTx, the response plot is used to visual-
ize this conditional distribution and should always be made. A major
problem with variable selection is that deleting important predictors
can change the functional form m of the model. In particular, if a mul-
tiple linear regression model is appropriate for the full model, linearity
may be destroyed if important predictors are deleted. When the single
index model (15.3) holds, m can be visualized with a response plot.
Adding visual aids such as the estimated parametric mean function
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m(α̂+ β̂
T
x) can be useful. If an estimated nonparametric mean func-

tion m̂(α̂ + β̂
T
x) such as lowess follows the parametric curve closely,

then often numerical goodness of fit tests will suggest that the model is
good. See Chambers, Cleveland, Kleiner, and Tukey (1983, p. 280) and
Cook and Weisberg (1999a, p. 425, 432). For variable selection, the
response plots from the full model and submodel should be very similar
if the submodel is good.

• Sometimes outliers will influence numerical methods for variable selec-
tion. Outliers tend to stand out in at least one of the plots. An EE plot
is useful for variable selection because the correlation of ESP(I) and
ESP is important. The EE plot can be used to quickly check that the
correlation is high, that the plotted points fall about some line, that
the line is the identity line, and that the correlation is high because the
relationship is linear, rather than because of outliers.

• Numerical methods may include too many predictors. Investigators can
examine the p–values for individual predictors, but the assumptions
needed to obtain valid p–values are often violated; however, the OLS t
tests for individual predictors are meaningful since deleting a predictor
changes the Cp value by t2 − 2 where t is the test statistic for the
predictor. See Section 15.5, Daniel and Wood (1980, p. 100-101) and
the following two remarks.

Remark 15.5. Variable selection with the Cp criterion is closely related
to the partial F test that uses test statistic FI. Suppose that the full model
contains p predictors including a constant and the submodel I includes k pre-
dictors including a constant. If n ≥ 10p, then the submodel I is “interesting”
if Cp(I) ≤ min(2k, p).

To see this claim notice that the following results are properties of OLS
and hold even if the data does not follow a 1D model. If the candidate model
of xI has k terms (including the constant), then

FI =
SSE(I)− SSE

(n− k) − (n− p)
/
SSE

n − p
=
n − p

p− k

[
SSE(I)

SSE
− 1

]
where SSE is the “residual” sum of squares from the full model and SSE(I)
is the “residual” sum of squares from the candidate submodel. Then

Cp(I) =
SSE(I)

MSE
+ 2k − n = (p− k)(FI − 1) + k (15.19)
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where MSE is the “residual” mean square for the full model. Let ESP(I) =

α̂I + β̂
T

I xI be the ESP for the submodel and let VI = Y − ESP (I) so that

VI,i = Yi − α̂I + β̂
T

I xI,i. Let ESP and V denote the corresponding quantities
for the full model. Using Proposition 3.2 and Remark 3.2 with corr(r, rI)
replaced by corr(V, VI), it can be shown that

corr(V, VI ) =

√
SSE

SSE(I)
=

√
n− p

Cp(I) + n− 2k
=

√
n− p

(p− k)FI + n− p
.

It can also be shown that Cp(I) ≤ 2k corresponds to corr(V, VI) ≥ dn where

dn =

√
1 − p

n
.

Notice that for a fixed value of k, the submodel Ik that minimizes Cp(I) also
maximizes corr(V, VI ). If Cp(I) ≤ 2k and n ≥ 10p, then 0.948 ≤ corr(V, VI),
and both corr(V, VI) → 1.0 and corr(OLS ESP, OLS ESP(I)) → 1.0 as
n→ ∞. Hence the plotted points in both the VV plot and the EE plot will
cluster about the identity line (see Proposition 3.2).

Remark 15.6. Suppose that the OLS ESP and the standard ESP are
highly correlated: |corr(ESP,OLS ESP)| ≥ 0.95. Then often OLS variable
selection can be used for the 1D data, and using the p–values from OLS
output seems to be a useful benchmark. To see this, suppose that n > 5p
and first consider the model Ii that deletes the predictor Xi. Then model Ii

has k = p − 1 predictors including the constant, and the test statistic is ti
where

t2i = FIi.

Using (15.19) and Cp(Ifull) = p, it can be shown that

Cp(Ii) = Cp(Ifull) + (t2i − 2).

Using the screen Cp(I) ≤ min(2k, p) suggests that the predictor Xi should
not be deleted if

|ti| >
√

2 ≈ 1.414.

If |ti| <
√

2 then the predictor can probably be deleted since Cp decreases.
More generally, it can be shown that Cp(I) ≤ 2k iff

FI ≤ p

p− k
.
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Now k is the number of terms in the model including a constant while p− k
is the number of terms set to 0. As k → 0, the partial F test will reject Ho:
βO = 0 (ie, say that the full model should be used instead of the submodel
I) unless FI is not much larger than 1. If p is very large and p − k is very
small, then the change in SS F test will tend to suggest that there is a model
I that is about as good as the full model even though model I deletes p− k
predictors.

The Cp(I) ≤ k screen tends to overfit. We simulated multiple linear
regression and single index model data sets with p = 8 and n = 50, 100, 1000
and 10000. The true model S satisfied Cp(S) ≤ k for about 60% of the
simulated data sets, but S satisfied Cp(S) ≤ 2k for about 97% of the data
sets.

In many settings, not all of which meet the Li–Duan sufficient conditions,
the full model OLS ESP is a good estimator of the sufficient predictor. If
the fitted full 1D model Y x|(α + βT x) is a useful approximation to the
data and if β̂OLS is a good estimator of cβ where c �= 0, then a subset I
will produce a response plot similar to the response plot of the full model
if corr(OLS ESP, OLS ESP(I)) ≥ 0.95. Hence the response plots based on
the full and submodel ESP can both be used to visualize the conditional
distribution of Y .

Assuming that a 1D model holds, a common assumption made for variable
selection is that the fitted full model ESP is a good estimator of the sufficient
predictor, and the usual numerical and graphical checks on this assumption
should be made. To see that this assumption is weaker than the assumption
that the OLS ESP is good, notice that if a 1D model holds but β̂OLS estimates
cβ where c = 0, then the Cp(I) criterion could wrongly suggest that all
subsets I have Cp(I) ≤ 2k. Hence we also need to check that c �= 0.

There are several methods are for checking the OLS ESP, including: a) if
an ESP from an alternative fitting method is believed to be useful, check that
the ESP and the OLS ESP have a strong linear relationship: for example
that |corr(ESP, OLS ESP)| ≥ 0.95. b) Often examining the OLS response
plot shows that a 1D model is reasonable. For example, if the data are tightly
clustered about a smooth curve, then a single index model may be appro-
priate. c) Verify that a 1D model is appropriate using graphical techniques
given by Cook and Weisberg (1999a, p. 434-441). d) Verify that x has an
EC distribution with nonsingular covariance matrix and that the mean func-
tion m(α + βT x) is not symmetric about the median of the distribution of
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α+ βTx. Then results from Li and Duan (1989) suggest that c �= 0.
Condition a) is both the most useful (being a direct performance check)

and the easiest to check. A standard fitting method should be used when
available (eg, for parametric 1D models such as GLMs). Conditions c) and
d) need x to have a continuous multivariate distribution while the predictors
can be factors for a) and b). Using trimmed views results in an ESP that
can sometimes cause condition b) to hold when d) is violated.

To summarize, variable selection procedures, originally meant for MLR,
can often be used for 1D data. If the fitted full 1D model Y x|(α + βTx)
is a useful approximation to the data and if β̂OLS is a good estimator of cβ
where c �= 0, then a subset I is good if corr(OLS ESP, OLS ESP(I)) ≥ 0.95.
If n is large enough, Remark 15.5 implies that this condition will hold if
Cp(I) ≤ 2k or if FI ≤ 1. This result suggests that within the (large) subclass
of 1D models where the OLS ESP is useful, the OLS partial F test is robust
(asymptotically) to model misspecifications in that FI ≤ 1 correctly suggests
that submodel I is good. The OLS t tests for individual predictors are also
meaningful since if |t| < √

2 then the predictor can probably be deleted since
Cp decreases while if |t| ≥ 2 then the predictor is probably useful even when
the other predictors are in the model. Section 15.5 provides related theory,
and the following examples help illustrate the above discussion.

Example 15.5. This example illustrates that the plots are useful for
general 1D regression models such as the response transformation model.
Cook and Weisberg (1999a, p. 351, 433, 447, 463) describe a data set on 82
mussels. The response Y is the muscle mass in grams, and the four predictors
are the logarithms of the shell length, width, height and mass. The logarithm
transformation was used to remove strong nonlinearities that were evident
in a scatterplot matrix of the untransformed predictors. The Cp criterion
suggests using log(width) and log(shell mass) as predictors. The EE and VV
plots are shown in Figure 15.6ab. The response plots based on the full and
submodel are shown in Figure 15.6cd and are nearly identical, but not linear.

When log(muscle mass) is used as the response, the Cp criterion suggests
using log(height) and log(shell mass) as predictors (the correlation between
log(height) and log(width) is very high). Figure 15.7a shows the RR plot
and 2 outliers are evident. These outliers correspond to the two outliers in
the response plot shown in Figure 15.7b. After deleting the outliers, the Cp

criterion still suggested using log(height) and log(shell mass) as predictors.
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Figure 15.6: Mussel Data with Muscle Mass as the Response

SRES

F
R

E
S

-1.0 -0.8 -0.6 -0.4 -0.2 0.0 0.2 0.4

-1
.0

-0
.6

-0
.2

0.
2

a) RR Plot with Two Outliers

SFIT

Y

1.0 1.5 2.0 2.5 3.0 3.5 4.0

0
1

2
3

4

b) Linear Response Plot

Figure 15.7: Mussel Data with log(Muscle Mass) as the Response
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Figure 15.8: Response and Residual Plots for Boston Housing Data

The p–value for including log(height) in the model was 0.03, and making the
FF and RR plots after deleting log(height) suggests that log(height) may not
be needed in the model.

Example 15.6 According to Li (1997), the predictors in the Boston
housing data of Harrison and Rubinfeld (1978) have a nonlinear quasi–helix
relationship which can cause regression graphics methods to fail. Neverthe-
less, the graphical diagnostics can be used to gain interesting information
from the data. The response Y = log(CRIM) where CRIM is the per capita
crime rate by town. The predictors used were x1 = proportion of residential
land zoned for lots over 25,000 sq.ft., log(x2) where x2 is the proportion of
non-retail business acres per town, x3 = Charles River dummy variable (= 1
if tract bounds river; 0 otherwise), x4 = NOX = nitric oxides concentration
(parts per 10 million), x5 = average number of rooms per dwelling, x6 =
proportion of owner-occupied units built prior to 1940, log(x7) where x7 =
weighted distances to five Boston employment centers, x8 = RAD = index
of accessibility to radial highways, log(x9) where x9 = full-value property-tax
rate per $10,000, x10 = pupil-teacher ratio by town, x11 = 1000(Bk − 0.63)2

where Bk is the proportion of blacks by town, log(x12) where x12 = % lower
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Figure 15.9: Relationships between NOX, RAD and Y = log(CRIM)

status of the population, and log(x13) where x13 = median value of owner-
occupied homes in $1000’s. The full model has 506 cases and 13 nontrivial
predictor variables.

Figure 15.8ab shows the response plot and residual plot for the full model.
The residual plot suggests that there may be three or four groups of data,
but a linear model does seem plausible. Backward elimination with Cp

suggested the “min Cp submodel” with the variables x1, log(x2), NOX, x6,
log(x7), RAD, x10, x11 and log(x13). The full model had R2 = 0.878 and σ̂ =
0.7642. The Cp submodel had Cp(I) = 6.576, R2

I = 0.878, and σ̂I = 0.762.
Deleting log(x7) resulted in a model with Cp = 8.483 and the smallest coeffi-
cient p–value was 0.0095. The FF and RR plots for this model (not shown)
looked like the identity line. Examining further submodels showed that NOX
and RAD were the most important predictors. In particular, the OLS coeffi-
cients of x1, x6 and x11 were orders of magnitude smaller than those of NOX
and RAD. The submodel including a constant, NOX, RAD and log(x2) had
R2 = 0.860, σ̂ = 0.811 and Cp = 67.368. Figure 15.8cd shows the response
plot and residual plot for this submodel.

Although this submodel has nearly the same R2 as the full model, the
residuals show more variability than those of the full model. Nevertheless,
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Figure 15.10: Boston Housing Data: Nonlinear 1D Regression Model

we can examine the effect of NOX and RAD on the response by deleting
log(x2). This submodel had R2 = 0.842, σ̂ = 0.861 and Cp = 138.727. Figure
15.9a shows that the response plot for this model is no longer linear. The
residual plot (not shown) also displays curvature. Figure 15.9a shows that
there are two groups, one with high Y and one with low Y . There are
three clusters of points in the plot of NOX versus RAD shown in Figure
15.9b (the single isolated point in the southeast corner of the plot actually
corresponds to several cases). The two clusters of high NOX and high RAD
points correspond to the cases with high per capita crime rate.

The tiny filled in triangles if Figure 15.9a represent the fitted values for
a quadratic. We added NOX2, RAD2 and NOX ∗ RAD to the full model
and again tried variable selection. Although the full quadratic in NOX and
RAD had a linear response plot, the submodel with NOX, RAD and log(x2)
was very similar. For this data set, NOX and RAD seem to be the most
important predictors, but other predictors are needed to make the model
linear and to reduce residual variation.

Example 15.7. In the Boston housing data, now let Y = CRIM. Since
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log(Y ) has a linear relationship with the predictors, Y should follow a nonlin-
ear 1D regression model. Consider the full model with predictors log(x2), x3,
x4, x5, log(x7), x8, log(x9) and log(x12). Regardless of whether Y or log(Y )
is used as the response, the minimum Cp model from backward elimination
used a constant, log(x2), x4, log(x7), x8 and log(x12) as predictors. If Y is the
response, then the model is nonlinear and Cp = 5.699. Remark 15.5 suggests
that if Cp ≤ 2k, then the points in the VV plot should tightly cluster about
the identity line even if a multiple linear regression model fails to hold. Fig-
ure 15.10 shows the VV and EE plots for the minimum Cp submodel. The
response (EY) plots for the full model and submodel are also shown. Note
that the clustering in the VV plot is indeed higher than the clustering in the
EE plot. Note that the response plots are highly nonlinear but are nearly
identical.

15.5 Inference

This section follows Chang and Olive (2010) closely. Inference can be per-
formed for trimmed views if M is chosen without using the response, eg if
the trimming is done with a DD plot, and the dimension reduction (DR)
method such as OLS is performed on the data (YMi,xMi) that remains after
trimming M% of the cases with ellipsoidal trimming based on the MBA or
FCH estimator.

First we review some theoretical results for OLS as a DR method and
give the main theoretical result for OLS. Let

Cov(x) = E[(x− E(x))(x − E(x))T] = Σx

and Cov(x, Y ) = E[(x− E(x))(Y − E(Y ))] = ΣxY . Let the OLS estimator
be (α̂OLS, β̂OLS). Then the population coefficients from an OLS regression of
Y on x are

αOLS = E(Y ) − βT
OLSE(x) and βOLS = Σ−1

x ΣxY. (15.20)

Let the data be (Yi,xi) for i = 1, ..., n. Let the p×1 vector η = (α,βT )T ,
let X be the n × p OLS design matrix with ith row (1,xT

i ), and let Y =
(Y1, ..., Yn)

T . Then the OLS estimator η̂ = (XT X)−1XTY . The sample co-
variance of x is

Σ̂x =
1

n− 1

n∑
i=1

(xi − x)(xi − x)T where the sample mean x =
1

n

n∑
i=1

xi.
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Similarly, define the sample covariance of x and Y to be

Σ̂xY =
1

n

n∑
i=1

(xi − x)(Yi − Y ) =
1

n

n∑
i=1

xiYi − x Y .

The first result shows that η̂ is a consistent estimator of η.
i) Suppose that (Yi,x

T
i )T are iid random vectors such that Σ−1

x and ΣxY

exist. Then
α̂OLS = Y − β̂

T

OLSx
D→ αOLS

and
β̂OLS =

n

n− 1
Σ̂

−1

x Σ̂xY
D→ βOLS as n → ∞.

The following OLS results need some notation. Many 1D regression mod-
els have an error e with

σ2 = Var(e) = E(e2). (15.21)

Let ê be the error residual for e. Let the population OLS residual

v = Y − αOLS − βT
OLSx (15.22)

with
τ 2 = E[(Y − αOLS − βT

OLSx)2] = E(v2), (15.23)

and let the OLS residual be

r = Y − α̂OLS − β̂
T

OLSx. (15.24)

Typically the OLS residual r is not estimating the error e and τ 2 �= σ2, but
the following results show that the OLS residual is of great interest for 1D
regression models.

Assume that a 1D model holds, Y x|(α+ βT x), which is equivalent to
Y x|βTx. Then under regularity conditions, results ii) – iv) below hold.

ii) Li and Duan (1989): βOLS = cβ for some constant c.
iii) Li and Duan (1989) and Chen and Li (1998):

√
n(β̂OLS − cβ)

D→ Np−1(0,COLS) (15.25)

where

COLS = Σ−1
x E[(Y − αOLS − βT

OLSx)2(x −E(x))(x− E(x))T ]Σ−1
x . (15.26)
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iv) Chen and Li (1998): Let A be a known full rank constant k× (p− 1)
matrix. If the null hypothesis Ho: Aβ = 0 is true, then

√
n(Aβ̂OLS − cAβ) =

√
nAβ̂OLS

D→ Nk(0,ACOLSAT )

and
ACOLSAT = τ 2AΣ−1

x AT . (15.27)

Notice that COLS = τ 2Σ−1
x if v = Y − αOLS − βT

OLSx x or if the MLR
model holds. If the MLR model holds, τ 2 = σ2.

To create test statistics, the estimator

τ̂ 2 = MSE =
1

n − p

n∑
i=1

r2
i =

1

n − p

n∑
i=1

(Yi − α̂OLS − β̂
T

OLSxi)
2

will be useful. The estimator ĈOLS =

Σ̂
−1

x

[
1

n

n∑
i=1

[(Yi − α̂OLS − β̂
T

OLSxi)
2(xi − x)(xi − x)T ]

]
Σ̂

−1

x (15.28)

can also be useful. Notice that for general 1D regression models, the OLS
MSE estimates τ 2 rather than the error variance σ2.

v) Result iv) suggests that a test statistic for Ho : Aβ = 0 is

WOLS = nβ̂
T

OLSAT [AΣ̂
−1

x AT ]−1Aβ̂OLS/τ̂
2 D→ χ2

k, (15.29)

the chi–square distribution with k degrees of freedom.

Before presenting the main theoretical result, some results from OLS
MLR theory are needed. Let the p× 1 vector η = (α,βT )T , the known k× p
constant matrix Ã = [a A] where a is a k × 1 vector, and let c be a known
k × 1 constant vector. Following Seber and Lee (2003, p. 99–106), the usual
F statistic for testing Ho : Ãη = c is

F0 =
(SSE(Ho) − SSE)/k

SSE/(n− p)
= (15.30)

(Ãη̂ − c)T [Ã(XTX)−1Ã
T
]−1(Ãη̂ − c)/(kτ̂ 2)
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where MSE = τ̂ 2 = SSE/(n− p), SSE =
∑n

i=1 r
2
i and

SSE(Ho) =

n∑
i=1

r2
i (Ho)

is the minimum sum of squared residuals subject to the constraint Ãη = c.
Recall that if Ho is true, the MLR model holds and the errors ei are iid
N(0, σ2), then Fo ∼ Fk,n−p, the F distribution with k and n − p degrees of
freedom. Also recall that if Zn ∼ Fk,n−p, then

Zn
D→ χ2

k/k (15.31)

as n→ ∞.
The main theoretical result of this section is Theorem 15.4 below. This

theorem and (15.31) suggest that OLS output, originally meant for testing
with the MLR model, can also be used for testing with many 1D regression
data sets. Without loss of generality, let the 1D model Y x|(α+ βTx) be
written as

Y x|(α+ βT
RxR + βT

OxO)

where the reduced model is Y x|(αR + βT
RxR) and xO denotes the terms

outside of the reduced model. Notice that OLS ANOVA F test corresponds
to Ho: β = 0 and uses A = Ip−1. The tests for Ho: βi = 0 use A =
(0, ..., 0, 1, 0, ..., 0) where the 1 is in the ith position and are equivalent to the
OLS t tests. The test Ho: βO = 0 uses A = [0 I j] if βO is a j×1 vector, and
the test statistic (15.30) can be computed by running OLS on the full model
to obtain SSE and on the reduced model to obtain SSE(R) ≡ SSE(Ho).

In the theorem below, it is crucial that Ho: Aβ = 0. Tests for Ho:
Aβ = 1, say, may not be valid even if the sample size n is large. Also,
confidence intervals corresponding to the t tests are for cβi, and are usually
not very useful when c is unknown.

Theorem 15.4. Assume that a 1D regression model (15.1) holds and
that Equation (15.29) holds when Ho : Aβ = 0 is true. Then the test
statistic (15.30) satisfies

F0 =
n− 1

kn
WOLS

D→ χ2
k/k

as n→ ∞.
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Proof. Notice that by (15.29), the result follows if F0 = (n−1)WOLS/(kn).
Let Ã = [0 A] so that Ho:Ãη = 0 is equivalent to Ho:Aβ = 0. Following
Seber and Lee (2003, p. 106),

(XTX)−1 =

(
1
n

+ xTD−1x −xTD−1

−D−1x D−1

)
(15.32)

where the (p− 1) × (p− 1) matrix

D−1 = [(n− 1)Σ̂x]−1 = Σ̂
−1

x /(n − 1). (15.33)

Using Ã and (15.32) in (15.30) shows that F0 =

(Aβ̂OLS)T

[
[0 A]

(
1
n

+ xTD−1x −xT D−1

−D−1x D−1

)(
0T

AT

)]−1

Aβ̂OLS/(kτ̂
2),

and the result follows from (15.33) after algebra. QED

Ellipsoidal trimming can be used to create outlier resistant 1D methods
that can give useful results when the assumption of linearly related predictors
(15.6) is violated. To perform ellipsoidal trimming, a robust estimator of
multivariate location and dispersion (T,C) is computed and used to create
the Mahalanobis distances Di(T,C). The ith case (Yi,xi) is trimmed if
Di > D(j). For example, if j ≈ 0.9n, then about M% = 10% of the cases are
trimmed, and OLS can be computed from the cases that remain.

For theory and outlier resistance, the choice of (T,C) and M are im-
portant. The MBA estimator (TMBA,CMBA) will be used for (T,C) (al-
though the FCH estimator may be a better choice because of its combination
of speed, robustness and theory). The classical Mahalanobis distance uses
(T,C) = (x, Σ̂x). Denote the robust distances by RDi and the classical dis-
tances by MDi. Then the DD plot of the MDi versus the RDi can be used
to choose M . The plotted points in the DD plot will follow the identity line
with zero intercept and unit slope if the predictor distribution is multivariate
normal (MVN), and will follow a line with zero intercept but non–unit slope
if the distribution is elliptically contoured with nonsingular covariance ma-
trix but not MVN. Delete M% of the cases with the largest MBA distances
so that the remaining cases follow the identity line (or some line through the
origin) closely. Let (YMi,xMi) denote the data that was not trimmed where
i = 1, ..., nM . Then apply OLS on these nM cases.
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As long as M is chosen only using the predictors, OLS theory will apply
if the data (YM ,xM) satisfies the regularity conditions. For example, if the
MLR model is valid and the errors are iid N(0, σ2), then the OLS estimator

η̂M = (XT
MXM )−1XT

MY M ∼ Np(η, σ
2(XT

MXM)−1).

More generally, let φM = limn→∞ n/nM , let cM be a constant and let β̂M

denote the OLS estimator applied to (YMi,xMi) with

√
n(β̂M − cMβ) =

√
n√
nM

√
nM (β̂M − cMβ)

D→ Np−1(0, φMCM ). (15.34)

If Ho : Aβ = 0 is true and ĈM is a consistent estimator of CM , then

WM = nM β̂
T

MAT [AĈMAT ]−1Aβ̂M/τ̂
2
M

D→ χ2
k.

Notice that M = 0 corresponds to the full data set and n0 = n.

A tradeoff is that low amounts of trimming may not work while large
amounts of trimming may be inefficient if low amounts of trimming work
since n/nM ≥ 1 and the diagonal elements of CM typically become larger
with M .

Trimmed views can also be used to select M ≡ MTV . If the MLR model
holds and OLS is used, then the resulting trimmed views estimator β̂M,TV is√
n consistent, but need not be asymptotically normal.
Adaptive trimming can be used to obtain an asymptotically normal esti-

mator that may avoid large efficiency losses. First, choose an initial amount
of trimming MI by using, eg, MI = 50 or the DD plot. Let β̂ denote

the first direction of the DR method. Next compute |corr(β̂T

Mx, β̂
T

MI
x)| for

M = 0, 10, ..., 90 and find the smallest value MA ≤MI such that the absolute
correlation is greater than 0.95. If no such value exists, then use MA = MI .
The resulting adaptive trimming estimator is asymptotically equivalent to
the estimator that uses 0% trimming if β̂0 is a consistent estimator of c0β
and if β̂MI

is a consistent estimator of cMI
β.

The following example and Tables 15.1 and 15.2 show that ellipsoidal
trimming can be useful for 1D regression when x is not EC. There is a myth
that transforming predictors is free, but using a log transformation for the
example below will destroy the 1D structure.
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Figure 15.11: Trimmed Views

Example 15.8. An artificial data set was generated with Y = (α +
βT x)3 + e where n = 100, α = 0,β = (1, 2, 3)T , e ∼ N(0, 1) and xi ∼
lognormal(0, 1) for i = 1, 2, 3 where the xi are iid. Figure 15.11 shows the
trimmed views for M = 0, 10, 30 and 90. Table 15.1 shows the values of β̂M .
Notice that the 30% and 90% trimmed views capture the cubic function
much better then the OLS = 0% trimmed view. Notice that β̂30 ≈ 205β and
β̂90 ≈ 86β.

Table 15.1: Trimming with Non-EC Predictors, β = c(1, 2, 3)T

M β̂1 β̂2 β̂3

0 346.034 3394.260 9000.226
10 292.575 731.751 1616.625
30 191.516 421.577 616.201
90 86.024 160.877 258.987
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Table 15.2: Trimming with Outlier Percentage = γ, β = c(1, 0, 0, 0)T

γ M β̂1 β̂2 β̂3 β̂4

0 0 5.974 .0083 −.0221 .0008
0 50 4.098 .0166 .0017 −.0016
49 0 2.269 −.7509 −.7390 −.7625
49 50 5.647 .0305 .0011 .0053

In a small simulation, the clean data Y = (α + βT x)3 + e where n =
1000, α = 1, β = (1, 0, 0, 0)T , e ∼ N(0, 1) and x ∼ N4(0, I4). The outlier
percentage γ was either 0% or 49%. The 2 clusters of outliers were about
the same size with Y ∼ N(0, 1) and x ∼ N4(±10(1, 1, 1, 1)T , I4). Table 15.2
records the averages of β̂i over 100 runs where OLS used M = 0 or M = 50%
trimming. When outliers were present, the average of β̂50 ≈ c(1, 0, 0, 0)T .

The following simulation study is extracted from Chang (2006) who used
eight types of predictor distributions: d1) x ∼ Np−1(0, Ip−1), d2) x ∼
0.6Np−1(0, Ip−1) + 0.4Np−1(0, 25Ip−1), d3) x ∼ 0.4Np−1(0, Ip−1) +
0.6Np−1(0, 25Ip−1), d4) x ∼ 0.9Np−1(0, Ip−1) + 0.1Np−1(0, 25Ip−1), d5) x ∼
LN(0, I) where the marginals are iid lognormal(0,1), d6) x ∼ MV Tp−1(3),
d7) x ∼MV Tp−1(5) and d8) x ∼ MV Tp−1(19). Here x has a multivariate t

distribution xi ∼ MV Tp−1(ν) if xi = zi/
√
Wi/ν where zi ∼ Np−1(0, Ip−1)

is independent of the chi–square random variable Wi ∼ χ2
ν . Of the eight

distributions, only d5) is not elliptically contoured. The MVT distribution
gets closer to the MVN distribution d1) as ν → ∞. The MVT distribution
has first moments for ν ≥ 3 and second moments for ν ≥ 5. See Johnson and
Kotz (1972, pp. 134-135). All simulations used 1000 runs.

The simulations for single index models used α = 1. Let the sufficient
predictor SP = α + βTx. Then the seven models considered were m1) Y =
SP + e, m2) Y = (SP )2 + e, m3) Y = exp(SP ) + e, m4) Y = (SP )3 + e,
m5) Y = sin(SP )/SP + 0.01e, m6) Y = SP + sin(SP ) + 0.1e and m7)
Y =

√|SP | + 0.1e where e ∼ N(0, 1). Models m2), m3) and m4) can result
in large |Y | values which can cause numerical difficulties for OLS if x is heavy
tailed.

For single index models with EC x, OLS can fail if m is symmetric about
the median θ of the distribution of SP = α + βTx. If m is symmetric
about a, then OLS may become effective as |θ − a| gets large. This fact is
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often overlooked in the literature and is demonstrated by models m7), m5)
and m2) where Y = (SP )2 + e with θ = α = 1. OLS has trouble with
Y = (SP −a)2+e as a gets close to θ = 1 for the EC distributions. The type
of symmetry where OLS fails is easily simulated, but may not occur often in
practice.

First, coefficient estimation was examined with β = (1, 1, 1, 1)T , and for
OLS the sample standard deviation (SD) of each entry β̂Mi,j of β̂M,j was
computed for i = 1, 2, 3, 4 with j = 1, ..., 1000. For each of the 1000 runs, the
formula

SEcl(β̂Mi) =

√
n−1

M (ĈM )ii

was computed where

ĈM = Σ̂
−1

xM

[
1

nM

nM∑
i=1

[(YMi − α̂M − β̂
T

MxMi)
2(xMi − xM )(xMi − xM)T ]

]
Σ̂

−1

xM

is the estimate (15.28) applied to (YM ,xM ). The average of β̂M and of√
nSEcl were recorded as well as

√
nSD of β̂Mi,j under the labels βM ,√

n SEcl and
√
nSD. Under regularity,

√
n SEcl ≈

√
nSD ≈

√
1

1 − M
100

diag(CM)

where CM is (15.26) applied to (YM ,xM).

For MVN x, MLR and 0% trimming, all three recorded quantities were
near (1,1,1,1) for n = 60, 500, and 1000. For 90% trimming and n = 1000, the
results were β90 = (1.00, 1.00, 1.01, 0.99),

√
n SEcl = (7.56, 7.61, 7.60, 7.54)

and
√
nSD = (7.81, 8.02, 7.76, 7.59), suggesting that β̂90 is asymptotically

normal but inefficient.
For other distributions, results for 0 and 10% trimming were recorded as

well as a “good” trimming value MB. Results are “good” if all of the entries
of both βMB

and
√
n SEcl were approximately equal, and if the theoretical√

n SEcl was close to the simulated
√
nSD. The results were good for MVN x

and all seven models, and the results were similar for n = 500 and n = 1000.
The results were good for models m1 and m5 for all eight distributions. Model
m6 was good for 0% trimming except for distribution d5 and model m7 was
good for 0% trimming except for distributions d5, d6 and d7. Trimming
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Table 15.3: OLS Coefficient Estimation with Trimming

m x M βM

√
nSEcl

√
nSD

m2 d1 0 2.00,2.01,2.00,2.00 7.81,7.79,7.76,7.80 7.87,8.00,8.02,7.88
m5 d4 0 −.03,−.03,−.03,−.03 .30,.30,.30,.30 .31,.32,.33,.31
m6 d5 0 1.04,1.04,1.04,1.04 .36,.36,.37,.37 .41,.42,.42,.40
m7 d6 10 .11,.11,.11,.11 .58,.57,.57,.57 .60,.58,.62,.61

usually helped for models m2, m3 and m4 for distributions d5 – d8. For
n = 500, Table 15.3 shows that β̂M estimates cMβ and the average of the
Chen and Li (1998) SE is often close to the simulated SD.

Next testing was considered. Let FM denote the OLS statistic (15.30)
applied to the nM cases (YM ,xM) that remained after trimming. Ho was
rejected for OLS if FM > Fk,nM−p(0.95). Let p̂ be the proportion of runs
where H0 was rejected. Since 1000 runs were used, the count 1000p̂ ∼ bi-
nomial(1000, 1 − δn) where 1 − δn converges to the true large sample level
1 − δ. The standard error for the proportion is

√
p̂(1 − p̂)/1000 ≈ 0.0069

for p = 0.05. An observed coverage p̂ ∈ (0.03, 0.07) suggests that there is no
reason to doubt that the true level is 0.05.

Suppose a 1D model holds but Y x. Then the Yi are iid and the model
reduces to Y = E(Y )+ e = cα + e where e = Y −E(Y ). As a special case, if
Y = m(α+βT x)+e and if Y x, then Y = m(α)+e. For the corresponding
test H0 : β = 0 versus H1 : β �= 0, the OLS F statistic (15.30) is invariant
with respect to a constant. This test is interesting since if Ho holds, then the
results do not depend on the 1D model (15.1), but only on the distribution
of x and the distribution of e. Since βOLS = cβ, power can be good if
c �= 0. The OLS test is equivalent to the ANOVA F test from MLR of Y on
x. Under H0, the test should perform well provided that the design matrix
is nonsingular and the error distribution and sample size are such that the
central limit theorem holds. For the simulated data with β = 0, the model
is linear and normal, and the exact OLS level is 0.05 for n > p. Table 15.4
illustrates this claim for n = 100 and n = 500.

Next the test Ho : β2 = 0 was considered. The OLS test is equivalent
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Table 15.4: Rejection Proportions for H0: β = 0

x n F n F
d1 100 0.041 500 0.050
d2 100 0.050 500 0.045
d3 100 0.047 500 0.050
d4 100 0.045 500 0.048
d5 100 0.055 500 0.061
d6 100 0.042 500 0.036
d7 100 0.054 500 0.047
d8 100 0.044 500 0.060

Table 15.5: Rejection Proportions for Ho: β2 = 0

m x 70 60 50 40 30 20 10 0 ADAP
1 1 .061 .056 .062 .051 .046 .050 .044 .043 .043
5 1 .019 .023 .019 .019 .020 .022 .027 .037 .029
2 2 .023 .024 .026 .070 .183 .182 .142 .166 .040
4 3 .027 .058 .096 .081 .071 .057 .062 .123 .120
6 4 .026 .024 .030 .032 .028 .044 .051 .088 .088
7 5 .058 .058 .053 .054 .046 .044 .051 .037 .037
3 6 .021 .024 .019 .025 .025 .034 .080 .374 .036
6 7 .027 .032 .023 .041 .047 .053 .052 .055 .055
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to the t test from MLR of Y on x. The true model used α = 1 and β =

(1, 0, 1, 1)T . To simulate adaptive trimming, |corr(β̂T

Mx,βTx)| was computed
for M = 0, 10, ..., 90 and the initial trimming proportion MI maximized this
correlation. This process should be similar to choosing the best trimmed view
by examining 10 plots. The rejection proportions were recorded for M =
0, ..., 90 and for adaptive trimming. The seven models, eight distributions
and sample sizes n = 60, 150, and 500 were used.

The test that used adaptive trimming had proportions ≤ 0.072 except for
model m4 with distributions d2, d3, d4, d6, d7 and d8; m2 with d4, d6 and
d7 for n = 500 and d6 with n = 150; m6 with d4 and n = 60, 150; m5 with
d7 and n = 500 and m7 with d7 and n = 500. With the exception of m4,
when the adaptive p̂ > 0.072, then 0% trimming had a rejection proportion
near 0.1. Occasionally adaptive trimming was conservative with p̂ < 0.03.
The 0% trimming worked well for m1 and m6 for all eight distributions and
for d1 and d5 for all seven models. Models m2 and m3 usually benefited
from adaptive trimming. For distribution d1, the adaptive and 0% trimming
methods had identical p̂ for n = 500 except for m3 where the values were
0.038 and 0.042. Table 15.5 used n = 150 and supports the claim that the
adaptive trimming estimator can be asymptotically equivalent to OLS (0%
trimming) and that trimming can greatly improve the type I error.

15.6 Complements

For 1D regression models, suppose that |corr(β̂T

OLSx, β̂
T
x)| ≥ 0.95 where β̂

is a good estimator of dβ for d �= 0, or that the 1D regression can be visualized
with the OLS response plot. For example, the plotted points cluster tightly
about the mean function m. Then OLS should be a useful 1D estimator
and output originally meant for MLR is also often useful for 1D regression
(1DR) data. In particular, i) β̂OLS estimates β for MLR and cβ for 1DR.
ii) The F test statistics tend to have a χ2

k/k limiting distribution for MLR,
and the Fk,n−p cutoffs tend to be useful for exploratory purposes for 1DR. iii)
Variable selection with the Cp statistic is effective. iv) The MSE estimates
σ2 for MLR and τ 2 for 1DR. v) The OLS response plot is a very effective
tool for visualizing the regression and outlier detection. The estimated mean
function for MLR is the unit slope line through the origin, but tends to be
nonlinear for 1DR. vi) Resistant

√
n consistent estimators based on OLS and

ellipsoidal trimming exist for both MLR and 1DR. vii) Cook’s distance is a
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useful influence diagnostic.
To see vii) for 1DR, notice that the ith Cook’s distance

CDi =
(Ŷ (i) − Ŷ )T (Ŷ (i) − Ŷ )

pσ̂2
=

‖ESP (i) − ESP‖2

(p + 1)MSE

where ESP (i) = XT η̂(i) and η̂(i) is computed without the ith case, and the

estimated sufficient predictor ESP = XT η̂ estimates αOLS+c βTxj for some
constant c and j = 1, ..., n. Thus Cook’s distances give useful information on
cases that influence the OLS ESP.

Fast exploratory analysis with OLS can be used to complement alternative
1D methods, especially if tests and variable selection for the 1D method are
slow or unavailable from the software.

An excellent introduction to 1D regression and regression graphics is Cook
and Weisberg (1999a, ch. 18, 19, and 20) and Cook and Weisberg (1999b).
More advanced treatments are Cook (1998a) and Li (2000). Important papers
include Brillinger (1977, 1983), Li and Duan (1989) and Stoker (1986). Xia,
Tong, Li and Zhu (2002) provides a method for single index models (and
multi–index models) that does not need the linearity condition.

The response plot is crucial for checking the goodness of fit of the model.
Also see Stute and Zhu (2005) and Xia, Li, Tong and Zhang (2004). One goal
for future research is to develop better methods for visualizing 1D regression.
Trimmed views seem to become less effective as the number of predictors
k = p − 1 increases. Consider the sufficient predictor SP = x1 + · · · + xk.
With the sin(SP)/SP data, several trimming proportions gave good views
with k = 3, but only one of the ten trimming proportions gave a good
view with k = 10. In addition to problems with dimension, it is not clear
which regression estimator and which multivariate location and dispersion
(MLD) estimator should be used. We suggest using the FCH = covfchMLD
estimator or classical MLD estimator with OLS as the regression estimator.
See Olive (2009a,

∮
10.7).

There are many ways to estimate 1D models, including maximum likeli-
hood for parametric models. The literature for estimating cβ when model
(15.1) holds is growing, and OLS frequently performs well if there are no
strong nonlinearities present in the predictors. In addition to OLS, spe-
cialized methods for 1D models with an unknown inverse link function (eg
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models (15.2) and (15.3)) have been developed, and often the focus is on
developing asymptotically efficient methods. See the references in Cavanagh
and Sherman (1998), Delecroix, Härdle and Hristache (2003), Härdle, Hall
and Ichimura (1993), Horowitz (1998), Hristache, Juditsky, Polzehl, and
Spokoiny (2001), Stoker (1986), Weisberg and Welsh (1994), Xia (2006) and
Xia, Tong, Li and Zhu (2002).

Some of these methods standardize β̂ so β̂1 = 1. This standardization
may cause problems for testing β = 0 and β1 = 0.

Several papers have suggested that outliers and strong nonlinearities need
to be removed from the predictors. See Brillinger (1991), Cook (1998a, p.
152), Cook and Nachtsheim (1994) and Li and Duan (1989, p. 1011, 1041,
1042). Trimmed views were introduced by Olive (2002, 2004b). Li, Cook
and Nachtsheim (2004) find clusters, fit OLS to each cluster and then pool
the OLS estimators into a final estimator. This method uses all n cases
while trimmed views gives M% of the cases weight zero. The trimmed views
estimator will often work well when outliers and influential cases are present.

Section 15.4 follows Olive and Hawkins (2005) closely. The literature
on numerical methods for variable selection in the OLS multiple linear re-
gression model is enormous, and the literature for other given 1D regression
models is also growing. Li, Cook and Nachtsheim (2005) give an alternative
method for variable selection that can work without specifying the model.
Also see, for example, Claeskins and Hjort (2003), Efron, Hastie, Johnstone
and Tibshirani (2004), Fan and Li (2001, 2002), Hastie (1987), Kong and
Xia (2007), Lawless and Singhai (1978), Leeb and Pötscher (2006), Naik and
Tsai (2001), Nordberg (1982) and Tibshirani (1996). For generalized linear
models, forward selection and backward elimination based on the AIC crite-
rion are often used. See Chapters 11, 12 and 13, Agresti (2002, p. 211-217),
Cook and Weisberg (1999a, p. 485, 536-538). Again, if the variable selection
techniques in these papers are successful, then the estimated sufficient pre-
dictors from the full and candidate model should be highly correlated, and
the EE, VV and response plots will be useful. Survival regression models
also use AIC. See Chapter 16.

The variable selection model with x = (xT
S ,x

T
E)T and SP = α + βT x =

α + βT
SxS is not the only variable selection model. Burnham and Anderson

(2004) note that for many data sets, the variables can be ordered in decreasing
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importance from x1 to xp−1. The “tapering effects” are such that if n >> p,
then all of the predictors should be used, but for moderate n it is better to
delete some of the least important predictors.

Section 15.5 followed Chang and Olive (2010) closely. More examples
and simulations are in Chang (2006). Severini (1998) discusses when OLS
output is relevant for the Gaussian additive error single index model. Li and
Duan (1989) and Li (1997) suggest that OLS F tests are asymptotically valid
if x is multivariate normal and if βOLS = Σ−1

x ΣxY �= 0. Freedman (1981),

Brillinger (1983) and Chen and Li (1998) also discuss Cov(β̂OLS). Formal
testing procedures for the single index model are given by Simonoff and Tsai
(2002) and Gao and Liang (1997). Chang and Olive (2007) shows how to
apply ellipsoidal trimming to general 1D methods, including OLS.

The mussel data set is included as the file mussel.lsp in the Arc software
and can be obtained from the web site (http://www.stat.umn.edu/arc/).
The Boston housing data can be obtained from the text website or from the
STATLIB website (http://lib.stat.cmu.edu/datasets/boston).

15.7 Problems

15.1. Refer to Definition 15.3 for the Cox and Snell (1968) definition for
residuals, but replace η by β.

a) Find êi if Yi = µ + ei and T (Y ) is used to estimate µ.
b) Find êi if Yi = xT

i β + ei.
c) Find êi if Yi = β1 exp[β2(xi − x̄)]ei where the ei are iid exponential(1)

random variables and x̄ is the sample mean of the x′is.
d) Find êi if Yi = xT

i β + ei/
√
wi.

15.2∗. (Aldrin, Bφlviken, and Schweder 1993). Suppose

Y = m(βTx) + e (15.35)

where m is a possibly unknown function and the zero mean errors e are inde-
pendent of the predictors. Let z = βTx and let w = x −E(x). Let Σx,Y =
Cov(x, Y ), and let Σx =Cov(x) = Cov(w). Let r = w − (Σxβ)βT w.

a) Recall that Cov(x,Y ) = E[(x − E(x))(Y − E(Y ))T ] and show that
Σx,Y = E(wY ).
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b) Show that E(wY ) = Σx,Y = E[(r + (Σxβ)βT w) m(z)] =

E[m(z)r] + E[βT w m(z)]Σxβ.

c) Using βOLS = Σ−1
x Σx,Y , show that βOLS = c(x)β + u(x) where the

constant
c(x) = E[βT (x − E(x))m(βTx)]

and the bias vector u(x) = Σ−1
x E[m(βT x)r].

d) Show that E(wz) = Σxβ. (Hint: Use E(wz) = E[(x−E(x))xTβ] =
E[(x− E(x))(xT − E(xT ) + E(xT ))β].)

e) Assume m(z) = z. Using d), show that c(x) = 1 if βT Σxβ = 1.

f) Assume that βTΣxβ = 1. Show that E(zr) = E(rz) = 0. (Hint: Find
E(rz) and use d).)

g) Suppose that βT Σxβ = 1 and that the distribution of x is multivariate
normal. Then the joint distribution of z and r is multivariate normal. Using
the fact that E(zr) = 0, show Cov(r, z) = 0 so that z and r are independent.
Then show that u(x) = 0.

(Note: the assumption βT Σxβ = 1 can be made without loss of gen-
erality since if βTΣxβ = d2 > 0 (assuming Σx is positive definite), then
y = m(d(β/d)T x) + e ≡ md(η

T x) + e where md(u) = m(du), η = β/d and
ηTΣxη = 1.)

15.3. Suppose that you have a statistical model where both fitted values
and residuals can be obtained. For example this is true for time series and
for nonparametric regression models such as Y = f(x1, ..., xp) + e where

ŷ = f̂(x1, ..., xp) and the residual ê = Y − f̂(x1, ..., xp). Suggest graphs for
variable selection for such models.
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Output for Problem 15.4.

BEST SUBSET REGRESSION MODELS FOR CRIM

(A)LogX2 (B)X3 (C)X4 (D)X5 (E)LogX7 (F)X8 (G)LogX9 (H)LogX12

3 "BEST" MODELS FROM EACH SUBSET SIZE LISTED.

ADJUSTED

k CP R SQUARE R SQUARE RESID SS MODEL VARIABLES

-- ----- -------- -------- --------- ---------------

1 379.8 0.0000 0.0000 37363.2 INTERCEPT ONLY

2 36.0 0.3900 0.3913 22744.6 F

2 113.2 0.3025 0.3039 26007.8 G

2 191.3 0.2140 0.2155 29310.8 E

3 21.3 0.4078 0.4101 22039.9 E F

3 25.0 0.4036 0.4059 22196.7 F H

3 30.8 0.3970 0.3994 22442.0 D F

4 17.5 0.4132 0.4167 21794.9 C E F

4 18.1 0.4125 0.4160 21821.0 E F H

4 18.8 0.4117 0.4152 21850.4 A E F

5 10.2 0.4226 0.4272 21402.3 A E F H

5 10.8 0.4219 0.4265 21427.7 C E F H

5 12.0 0.4206 0.4252 21476.6 A D E F

6 5.7 0.4289 0.4346 21125.8 A C E F H

6 9.3 0.4248 0.4305 21279.1 A C D E F

6 10.3 0.4237 0.4294 21319.9 A B E F H

7 6.3 0.4294 0.4362 21065.0 A B C E F H

7 6.3 0.4294 0.4362 21066.3 A C D E F H

7 7.7 0.4278 0.4346 21124.3 A C E F G H

8 7.0 0.4297 0.4376 21011.8 A B C D E F H

8 8.3 0.4283 0.4362 21064.9 A B C E F G H

8 8.3 0.4283 0.4362 21065.8 A C D E F G H

9 9.0 0.4286 0.4376 21011.8 A B C D E F G H

15.4. The output above is for the Boston housing data from software
that does all subsets variable selection. The full model is a 1D transformation
model with response variable Y = CRIM and uses a constant and variables
A, B, C, D, E, F, G and H. (Using log(CRIM) as the response would give an
MLR model.) From this output, what is the best submodel? Explain briefly.
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15.5∗. a) Show that Cp(I) ≤ 2k if and only if FI ≤ p/(p− k).

b) Using (15.19), find E(Cp) and Var(Cp) assuming that an MLR model
is appropriate and that Ho (the reduced model I can be used) is true.

c) Using (15.19), Cp(Ifull) = p and the notation in Section 15.4, show
that

Cp(Ii) = Cp(Ifull) + (t2i − 2).

R/Splus Problems

Warning: Use the command source(“A:/regpack.txt”) to download
the programs. See Preface or Section 17.2. Typing the name of the
regpack function, eg trviews, will display the code for the function. Use the
args command, eg args(trviews), to display the needed arguments for the
function.

15.6. Use the following R/Splus commands to make 100 N3(0, I3) cases
and 100 trivariate non-EC cases.

n3x <- matrix(rnorm(300),nrow=100,ncol=3)

ln3x <- exp(n3x)

In R, type the command library(MASS).

a) Using the commands pairs(n3x) and pairs(ln3x) and include both scat-
terplot matrices in Word. (Click on the plot and hit Ctrl and c at the same
time. Then go to file in the Word menu and select paste.) Are strong
nonlinearities present among the MVN predictors? How about the non-EC
predictors? (Hint: a box or ball shaped plot is linear.)

b) Make a single index model and the sufficient summary plot with the
following commands

ncy <- (n3x%*%1:3)^3 + 0.1*rnorm(100)

plot(n3x%*%(1:3),ncy)

and include the plot in Word.
c) The command trviews(n3x, ncy) will produce ten plots. To advance the

plots, click on the rightmost mouse button (and in R select stop) to advance
to the next plot. The last plot is the OLS view. Include this plot in Word.
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d) After all 10 plots have been looked at the output will show 10 estimated
predictors. The last estimate is the OLS (least squares) view and might look
like

Intercept X1 X2 X3

4.417988 22.468779 61.242178 75.284664

If the OLS view is a good estimated sufficient summary plot, then the
plot created from the command (leave out the intercept)

plot(n3x%*%c(22.469,61.242,75.285),n3x%*%1:3)

should cluster tightly about some line. Your linear combination will be dif-
ferent than the one used above. Using your OLS view, include the plot using
the command above (but with your linear combination) in Word. Was this
plot linear? Did some of the other trimmed views seem to be better that
the OLS view, that is, did one of the trimmed views seem to have a smooth
mean function with a smaller variance function than the OLS view?

e) Now type the R/Splus command

lncy <- (ln3x%*%1:3)^3 + 0.1*rnorm(100).

Use the command trviews(ln3x,lncy) to find the best view with a smooth
mean function and the smallest variance function. This view should not be
the OLS view. Include your best view in Word.

f) Get the linear combination from your view, say (94.848, 216.719, 328.444)T ,
and obtain a plot with the command

plot(ln3x%*%c(94.848,216.719,328.444),ln3x%*%1:3).

Include the plot in Word. If the plot is linear with high correlation, then
your response plot in e) should be good.

15.7. (At the beginning of your R/Splus session, use the
source(“A:/regpack.txt”) command (and library(MASS) in R.))

a) Perform the commands

> nx <- matrix(rnorm(300),nrow=100,ncol=3)

> lnx <- exp(nx)

> SP <- lnx%*%1:3

> lnsincy <- sin(SP)/SP + 0.01*rnorm(100)
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For parts b), c) and d) below, to make the best trimmed view with
trviews, ctrviews or lmsviews, you may need to use the function twice.
The first view trims 90% of the data, the next view trims 80%, etc. The last
view trims 0% and is the OLS view (or lmsreg view). Remember to advance
the view with the rightmost mouse button (and in R, highlight “stop”). Then
click on the plot and next simultaneously hit Ctrl and c. This makes a copy
of the plot. Then in Word, use the menu commands “Copy>paste.”

b) Find the best trimmed view with OLS and covfch with the following
commands and include the view in Word.

> trviews(lnx,lnsincy)

(With trviews, suppose that 40% trimming gave the best view. Then
instead of using the procedure above b), you can use the command

> essp(lnx,lnsincy,M=40)

to make the best trimmed view. Then click on the plot and next simultane-
ously hit Ctrl and c. This makes a copy of the plot. Then in Word, use the
menu commands “Copy>paste”. Click the rightmost mouse button (and in
R, highlight “stop”) to return the command prompt.)

c) Find the best trimmed view with OLS and (x,S) using the following
commands and include the view in Word. See the paragraph above b).

> ctrviews(lnx,lnsincy)

d) Find the best trimmed view with lmsreg and cov.mcd using the fol-
lowing commands and include the view in Word. See the paragraph above
b).

> lmsviews(lnx,lnsincy)

e) Which method or methods gave the best response plot? Explain briefly.
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Survival Analysis

In the analysis of “time to event” data, there are n individuals and the time
until an event is recorded for each individual. Typical events are failure of
a product or death of a person or reoccurrence of cancer after surgery, but
other events such as first use of cigarettes or the time that baboons come
down from trees (early in the morning) can also be modeled. The data is
typically right skewed and censored data is often present.

Censoring occurs because of time and cost constraints. A product such as
light bulbs may be tested for 1000 hours. Perhaps 30% fail in that time but
the remaining 70% are still working. These are censored: they give partial
information on the lifetime of the bulbs because it is known that about
70% last longer than 1000 hours. Handling censoring and time dependent
covariates is what makes the analysis of time to event data different from
other fields of statistics.

Reliability analysis is used in engineering to study the lifetime (time until
failure) of manufactured products while survival analysis is used in actuarial
sciences, statistics and biostatistics to study the lifetime (time until death)
of humans, often after contracting a deadly disease. In the social sciences,
the study of the time until the occurrence of an event is called the analysis of
event time data or event history analysis. In economics, the study is called
duration analysis or transition analysis. Hence reliability data = failure time
data = lifetime data = survival data = event time data.

This chapter will begin with univariate survival analysis: there is a re-
sponse but no predictors. This model introduces terms also used in the 1D
regression models for survival analysis. The survival regression 1D models

481
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differ from the multiple linear regression, experimental design models, gen-
eralized linear models and single index models in that the conditional mean
function is no longer of primary interest. Instead, the conditional survival
function and the conditional hazard functions are of interest.

16.1 Univariate Survival Analysis

In this text log(t) = ln(t) = loge(t) while exp(t) = et. One of the difficulties
with survival analysis is that the response Y = survival time is usually not
observed, instead the a censored response is observed. In this chapter the
data will be right censored, and “right” will often be omitted. In the following
definition, note that both T ≥ 0 and Y ≥ 0 are nonnegative.

Definition 16.1. Let Y ≥ 0 be the time until an event occurs. Then Y
is called the survival time. The survival time is censored if the event of
interest has not been observed. Let Yi be the ith survival time. Let Zi be
the time the ith observation (possibly an individual or machine) leaves the
study for any reason other than the event of interest. Then Zi is the time
until the ith observation is censored. Then the right censored survival
time Ti of the ith observation is Ti = min(Yi, Zi). Let δi = 0 if Ti is (right)
censored (Ti = Zi) and let δi = 1 if Ti is not censored (Ti = Yi). Then the
univariate survival analysis data is (T1, δ1), (T2, δ2), ..., (Tn, δn). Alternatively,
the data is T1, T

∗
2 , T3, ..., T

∗
n−1, Tn where the * means that the case was (right)

censored. Sometimes the asterisk * is replaced by a plus +, and Yi, yi or ti
can replace Ti.

In this chapter we will assume that the censoring mechanism is indepen-
dent of the time to event: Yi and Zi are independent.

For example, in a study breast cancer patients who receive a lumpectomy,
suppose the researchers want to keep track of 100 patients for five years
after receiving a lumpectomy (tumor removal). The response is time until
death after a lumpectomy. Patients who are lost to the study (move or
eventually refuse to cooperate) and patients who are still alive after the study
are censored.Perhaps 15% die, 5% move away and so leave the study and 80%
are still alive after 5 years. Then 85% of the cases are (right) censored. The
actual study may take two years to recruit patients, follow each patient for
5 years, but end 5 years after the end of the two year recruitment period. So
patients enter the study at different times, but the censored response is the
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time until death or censoring from the time the patient entered the study.

Definition 16.2. i) The distribution function (df) of Y is F (t) =
P (Y ≤ t). Since Y ≥ 0, F (0) = 0, F (∞) = 1, and F (t) is nondecreasing.

ii) The probability density function (pdf) of Y is f(t) = F ′(t).
iii) The survival function of Y is S(t) = P (Y > t). S(0) = 1, S(∞) = 0

and S(t) is nonincreasing.

iv) The hazard function of Y is h(t) =
f(t)

1 − F (t)
for t > 0 and F (t) < 1.

Note that h(t) ≥ 0 if F (t) < 1.
v) The cumulative hazard function of Y isH(t) =

∫ t

0
h(u)du for t > 0.

It is true that H(0) = 0, H(∞) = ∞, and H(t) is nondecreasing.

Given one of F (t), f(t), S(t), h(t) or H(t), the following proposition shows
how to find the other 4 quantities for t > 0. In reliability analysis, the
reliability function R(t) = S(t), and in economics, Mill’s ratio = 1/h(t).

Proposition 16.1.
A) F (t) =

∫ t

0
f(u)du = 1−S(t) = 1−exp[−H(t)] = 1−exp[− ∫ t

0
h(u)du].

B) f(t) = F ′(t) = −S ′(t) = h(t)[1−F (t)] = h(t)S(t) = h(t) exp[−H(t)] =
H ′(t) exp[−H(t)].

C) S(t) = 1 − F (t) = 1 − ∫ t

0
f(u)du =

∫∞
t
f(u)du = exp[−H(t)] =

exp[− ∫ t

0
h(u)du].

D)

h(t) =
f(t)

1 − F (t)
=
f(t)

S(t)
=

F ′(t)
1 − F (t)

=
−S ′(t)
S(t)

= − d

dt
log[S(t)] = H ′(t).

E) H(t) =
∫ t

0
h(u)du = − log[S(t)] = − log[1 − F (t)].

Tips: i) If F (t) = 1 − exp[G(t)] for t > 0, then H(t) = −G(t) and
S(t) = exp[G(t)].

ii) For S(t) > 0, note that S(t) = exp[log(S(t))] = exp[−H(t)]. Finding
exp[log(S(t))] and setting H(t) = − log[S(t)]is easier than integrating h(t).

Next an interpretation for the hazard function is given. Suppose the time
until event is the time until death. Note that

P [t < Y < t+ ∆t|Y > t] =
P [t < Y ≤ t+ ∆t]

P (Y > t)
=
F (t+ ∆t) − F (t)

1 − F (t)
.
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So

lim
∆t→0

1

∆t
P [t < Y ≤ t+ ∆t|Y > t] = lim

∆t→0

F (t+∆t)−F (t)
∆t

1 − F (t)

=
f(t)

1 − F (t)
= h(t).

So for small ∆t, it follows that h(t)∆t ≈ P [t < Y < t+∆t|Y > t] ≈ P(person
dies in interval (t, t+ ∆t] given that the person has survived up to time t).
Larger h(t) implies that the hazard of death is higher. The hazard function
takes into account the aging of the observation (person or product).

For example, an 80 year old white male has about a 50% chance of living
to 85 while a 100 year old white male has about a 50% chance of living to
101, although the percentage of white males living to 101 is tiny.

Example 16.1. Suppose Y ∼ EXP (λ) where λ > 0, then h(t) = λ for
t > 0, f(t) = λe−λt for t > 0, F (t) = 1− e−λt for t > 0, S(t) = e−λt for t > 0,
H(t) = λt for t > 0 and E(T ) = 1/λ. The exponential distribution can
be a good model if failures are due to random shocks that follow a Poisson
process (light bulbs, electrical components), but constant hazard means that
a used product is as good as a new product: aging has no effect on the
probability of failure of the product. Derive H(t), S(t), F (t) and f(t) from
the constant hazard function h(t) = λ for t > 0 and some λ > 0.

Solution: H(t) =
∫ t

0
h(u)du =

∫ t

0
λdu = λt for t > 0.

S(t) = e−H(t) = e−λt, for t > 0.
F (t) = 1 − S(t) = 1 − e−λt for t > 0.
Finally, f(t) = h(t)S(t) = λe−λt = F ′(t) for t > 0.

Suppose the observed survival times T1, ..., Tn are a censored data set
from an exponential EXP (λ) distribution. Let Ti = Y ∗

i . Let δi = 0 if the
case is censored and let δi = 1, otherwise. Let r =

∑n
i=1 δi = the number

of uncensored cases. Then the MLE λ̂ = r/
∑n

i=1 Ti. So λ̂ = r/
∑n

i=1 Y
∗
i . A

95% CI for λ is λ̂± 1.96λ̂/
√
r.

Example 16.2. If Y ∼ Weibull(λ, γ) where λ > 0 and γ > 0, then h(t) =
λγtγ−1 for t > 0, f(t) = λγtγ−1 exp(−λtγ) for t > 0, F (t) = 1 − exp(−λtγ)
for t > 0, S(t) = exp(−λtγ) for t > 0, H(t) = λtγ for t > 0. The Weibull(
λ, γ = 1) distribution is the EXP(λ) distribution. The hazard function can be
increasing, decreasing or constant. Hence the Weibull distribution often
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fits reliability data well, and the Weibull distribution is the most important
distribution in reliability analysis. Derive H(t), S(t), F (t) and f(t) if Y ∼
Weibull(λ, γ).

Solution:

H(t) =

∫ t

0

h(u)du =

∫ t

0

λγuγ−1du = λγ
uγ

γ

∣∣∣∣t
0

= λtγ for t > 0.

S(t) = exp[−H(t)] = exp[−λtγ], for t > 0.
F (t) = 1 − S(t) = 1 − exp[−λtγ] for t > 0.
Finally, f(t) = h(t)S(t) = λγtγ−1 exp[−λtγ] for t > 0.

Recall from the central limit theorem that the sample mean X =∑n
i=1 Xi/n is approximately normal for many distributions. For many dis-

tributions, min(X1, ..., Xn) is approximately Weibull. Suppose a product is
made of m components with iid failure times Xim. Suppose the product fails
as soon as one of the components fails, eg a chain of links fails when the
weakest link fails. Then often the failure time Yi = min(Xim, ..., Xim) is
approximately Weibull.

Notation: The set {t : f(t) > 0} is the support of Y . Often the support
of Y is (0,∞) = t > 0, and the formulas will omit the t > 0.

Notation: Let the indicator variable Ia(Yi) = 1 if Yi ∈ A and Ia(Yi) = 0
otherwise. Often write I(t,∞)(Yi) as I(Yi > t).

Definition 16.3. If none of the survival times are censored, then the
empirical survival function ŜE(t) = (number of individual with survival
times > t)/(number of individuals) = a/n. So

ŜE(t) =
1

n

n∑
i=1

I(Yi > t) = p̂t =

sample proportion of lifetimes > t.

Assume Y1, ..., Yn are iid with Yi ≥ 0. Fix t > 0. Then I(Yi > t) are iid
binomial(1,p = P (Yi > t)). So nŜE(t) ∼ binomial(n,p = P (Yi > t)). Hence
E[nŜE(t)] = nP (Y > t) and V [nŜE(t)] = nS(t)F (t). Thus E[ŜE(t)] = S(t)
and V [ŜE(t)] = S(t)F (t)/n = [S(t)(1−S(t))]/n ≤ 0.25/n. Thus SD[ŜE(t)] =√
V [ŜE(t)] ≤ 0.5/

√
n. So need n ≈ 100 for SD[ŜE(t)] < 0.05.
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Let t(1) ≤ t(2) ≤ · · · ≤ t(n) be the observed ordered survival times (=
lifetimes = death times). Let t0 = 0 and let 0 < t1 < t2 < · · · < tm be the
distinct survival times. Let di = number of deaths at time ti. If m = n and
di = 1 for i = 1, ..., n then there are no ties. If m < n and some di ≥ 2,
then there are ties.

Then ŜE(t) is a step function with ŜE(0) = 1 and ŜE(t) = ŜE(ti−1) for
ti−1 ≤ t < ti. Note that

∑m
i=1 di = n. Know how to compute and plot ŜE(t)

given the t(i) or given the ti and di. Use a table like the one below. Let
a0 = n and ai =

∑n
k=1 I(Ti > ti) = # of cases t(j) > ti for i = 1, ..., m. Then

ŜE(ti) = ai/n =
∑n

k=1 I(Ti > ti)/n = ŜE(ti−1) − di

n
.

ti di ŜE(ti) = ŜE(ti−1) − di

n

t0 = 0 ŜE(0) = 1 =
n

n
=
a0

n

t1 d1 ŜE(t1) = ŜE(t0) − d1

n
=
a0 − d1

n
=
a1

n

t2 d2 ŜE(t2) = ŜE(t1) − d2

n
=
a1 − d2

n
=
a2

n

...
...

...

tj dj ŜE(tj) = ŜE(tj−1) − dj

n
=
aj−1 − dj

n
=
aj

n

...
...

...

tm−1 dm−1 ŜE(tm−1) = ŜE(tm−2) − dm−1

n
=
am−2 − dm−1

n
=
am−1

n

tm dm ŜE(tm) = 0 = ŜE(tm−1) − dm

n
=
am−1 − dm

n
=
am

n

Let Ŝ(t) be the estimated survival function. Let t(p) be the pth percentile
of Y : P (Y ≤ t(p)) = F (t(p)) = p so 1 − p = S(t(p)) = P (Y > t(p)). Then
t̂(p), the estimated time when 100 p % have died, can be estimated from a
graph of Ŝ(t) with “over” and “down” lines. a) Find 1−p on the vertical axis
and draw a horizontal “over” line to Ŝ(t). Draw a vertical “down” line until
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it intersects the horizontal axis at t̂(p). Usually want p = 0.5 but sometimes
p = 0.25 and p = 0.75 are used.

Example 16.3. Smith (2002, p. 68) gives steroid induced remission
times for leukemia patients. The t(j), t− i and di are given in the following

table. The ai and ŜE(t) needed to be computed. Note that ai = # of cases
with t(j) > ti.

ai t(j) ti di ŜE(ti) = ŜE(ti−1) − di

n
21 t0 = 0 ŜE(0) = 1 = 21/21

1

19 1 t1 = 1 2 ŜE(1) = (21 − 2)/21 = 19/21
2

17 2 t2 = 2 2 ŜE(2) = (19 − 2)/21 = 17/21

16 3 t3 = 3 1 ŜE(3) = (17 − 1)/21 = 16/21
4

14 4 t4 = 4 2 ŜE(4) = (16 − 2)/21 = 14/21
5

12 5 t5 = 5 2 ŜE(5) = (14 − 2)/21 = 12/21
8
8
8

8 8 t6 = 8 4 ŜE(8) = (12 − 4)/21 = 8/21
11

6 11 t7 = 11 2 ŜE(11) = (8 − 2)/21 = 6/21
12

4 12 t8 = 12 2 ŜE(12) = (6 − 2)/21 = 4/21

3 15 t9 = 15 1 ŜE(15) = (4 − 1)/21 = 3/21

2 17 t10 = 17 1 ŜE(17) = (3 − 1)/21 = 2/21

1 22 t11 = 22 1 ŜE(22) = (2 − 1)/21 = 1/21

0 23 t12 = 23 1 ŜE(23) = (1 − 1)/21 = 0

The 2nd column t(j) gives the 21 ordered survival times. The 3rd column
ti gives the distinct ordered survival times. Often just the number is given,
so t1 = 1 would be replaced by 1. The 4th column di tells how many events
(remissions) occurred at time ti and the last column computes ŜE(ti). A good
check is that the 1st column entry divided by n is equal to ai/n = ŜE(ti) =
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last column entry. A graph of the estimated survival function would be a
step function with times 0, 1, ..., 23 on the horizontal axis and ŜE(t) on the
vertical axis. A convention is to draw vertical lines at the jumps (at the ti).
So the step function would be 1 on (0,1), 19/21 on (1,2), ..., 1/21 on (22,23)
and 0 for t > 23. The vertical lines connecting the steps are at t = 1, 2, ..., 23.

Example 16.4. If di = 1, 1, 1, 1 and if ti = 1, 3, 5, 7, then a1 = 3, a2 = 2
and a3 = 1. Hence ŜE(1) = 0.75, ŜE(3) = 0.5, ŜE(5) = 0.25, and ŜE(7) = 0,
and the estimated survival function is graphed as below.

^

S_E(t)

___

| |____

| |_____

| |_____

|____________________|_ t

1 2 3 4 5 6 7

Let t1 ≤ t < tm. Then the classical large sample 95% CI for S(tc)
based on ŜE(t) is

ŜE(tc) ± 1.96

√
ŜE(tc)[1 − ŜE(tc)]

n
= ŜE(tc) ± 1.96SE[ŜE(tc)].

Let 0 < t. Let

p̃tc =
nŜE(tc) + 2

n+ 4
.

Then the plus four 95% CI for S(tc) based on ŜE(t) is

p̃tc ± 1.96

√
p̃tc [1 − p̃tc ]

n+ 4
= p̃tc ± 1.96SE[p̃tc ].

The 95% large sample CI ŜE(tc) ± 1.96SE[p̃tc ] is also interesting.

Example 16.5. Let n = 21 and ŜE(12) = 4/21.
a) Find the 95% classical CI for ŜE(12).
b) Find the 95% plus four CI for ŜE(12).
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Solution: a)

4

21
+ 1.96

√
4
21

(1 − 4
21

)

21
=

4

21
± 0.16795 = (0.0225, 0.3584).

b)

p̃12 =
21 4

21
+ 2

21 + 4
=

6

25
.

So the 95% CI is

6

25
+ 1.96

√
6
25

(1 − 6
25

)

25
=

6

25
± 0.16742 = (0.0726, 0.4074).

Note that the CIs are not very short since n = 21 is small.

Let Yi = time to event for ith person. Ti = min(Yi, Zi) where Zi is the
censoring time for the ith person (the time the ith person is lost to the study
for any reason other than the time to event under study). The censored data
is y1, y2+, y3, ..., yn−1, yn+ where yi means the time was uncensored and yi+
means the time was censored. t(1) ≤ t(2) ≤ · · · ≤ t(n) are the ordered survival
times (so if y4+ is the smallest survival time, then t(1) = y4+). A status
variable will be 1 if the time was uncensored and 0 if censored.

Let [0,∞) = I1 ∪ I2 ∪ · · · ∪ Im = [t0, t1) ∪ [t1, t2) · · · ∪ [tm−1, tm) where
to = 0 and tm = ∞. It is possible that the 1st interval will have left endpoint
> 0 (t0 > 0) and the last interval will have finite right endpoint (tm < ∞).
Suppose that the following quantities are known: dj = # deaths in Ij,
cj = # of censored survival times in Ij, and
nj = # at risk in Ij = # who were alive and not yet censored at the start
of Ij (at time tj−1). Note that n1 = n and nj = nj−1 − dj−1 − cj−1 for j > 1.
This equation shows how those at risk in th (j − 1)th interval propagate to
the jth interval.

Let n′
j = nj − cj

2
= average number at risk in Ij.

Definition 16.4. The lifetable estimator or actuarial method estima-
tor of SY (t) takes ŜL(0) = 1 and

ŜL(tk) =
k∏

j=1

n′
j − dj

n′
j

=
k∏

j=1

p̃j
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for k = 1, ..., m − 1. If tm = ∞, ŜL(t) is undefined for t > tm−1. Suppose
tm �= ∞. Then take ŜL(t) = 0 for t ≥ tm if cm = 0. If cm > 0, then ŜL(t) is
undefined for t ≥ tm. (Some programs use ŜL(t) = 0 for t ≥ tm if tm �= ∞.)

To graph ŜL(t), use linear interpolation (connect the dots). If n′
j = 0,

take p̃j = 0. Note that

ŜL(tk) = ŜL(tk−1)
n′

k − dk

n′
k

for k = 1, ...,m− 1.

The lifetable estimator is used to estimate SY (t) = P (Y > t) when
there is censoring. Also, the actual event or censoring times are unknown,
but the number of event and censoring times in each interval Ij is known
for j = 1, ..., m. Let pj = P(surviving through Ij| alive at the start of

Ij) = P (Y > tj|Y > tj−1) =
P (Y > tj, Y > tj−1)

P (Y > tj−1)
=

S(tj)

S(tj−1)
. Now p1 =

S(t1)/S(t0) = S(t1) since S(0) = S(t0) = 1. Writing S(tk) as a telescoping
product gives

S(tk) = S(t1)
S(t2)

S(t1)

S(t3)

S(t2)
· · · S(tk−1)

S(tk−2)

S(tk)

S(tk−1)
= p1p2 · · · pk =

k∏
j=1

pj .

Let p̂j = 1− (number dying in Ij)/(number with potential to die in Ij). Then
p̃j = 1− dj/n

′
j is the estimate of pj used by the lifetable estimator, assuming

that the censoring is roughly uniform over each interval.

Know how to get the lifetable estimator and SE(ŜL(ti)) from output.

(left output) (right output)

interval survival survival SE or interval survival survival SE

0 50 1.00 0 0 50 0.7594 0.0524

50 100 0.7594 0.0524 50 100 0.5889 0.0608

100 200 0.5889 0.0608 100 200 0.5253 0.0602

Since ŜL(0) = 1, ŜL(t) is for the left endpoint for the “left output”, and
for the right endpoint for the “right output.” For both cases, ŜL(50) = 0.7594
and SE(ŜL(50)) = 0.0524.

A 95% CI for SY (ti) based on the lifetable estimator is

ŜL(ti) ± 1.96 SE[ŜL(ti)].
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Know how to compute ŜL(t) with a table like the one below. The first 4
entries need to be given but the last 3 columns may need to be filled in. On
an exam you may be given a table with all but a few entries filled.

Ij, dj, cj, nj n′
j

n′
j−dj

n′
j

ŜL(t)

[t0 = 0, t1), d1, c1, n1 n1 − c1
2

n′
1−d1

n′
1

ŜL(to) = ŜL(0) = 1

[t1, t2), d2, c2, n2 n2 − c2
2

n′
2−d2

n′
2

ŜL(t1) = ŜL(t0)
n′

1−d1

n′
1

[t2, t3), d3, c3, n3 n3 − c3
2

n′
3−d3

n′
3

ŜL(t2) = ŜL(t1)
n′

2−d2

n′
2

...
...

...
...

[tk−1, tk), dk, ck, nk nk − ck

2

n′
k−dk

n′
k

ŜL(tk−1) =

ŜL(tk−2)
n′

k−1−dk−1

n′
k−1

...
...

...
...

[tm−2, tm−1), dm−1, cm−1, nm−1 nm−1 − cm−1

2

n′
m−1−dm−1

n′
m−1

ŜL(tm−2) =

ŜL(tm−3)
n′

m−2−dm−2

n′
m−2

[tm−1, tm = ∞), dm, cm, nm nm − cm

2
n′

m−dm

n′
m

ŜL(tm−1) =

ŜL(tm−2)
n′

m−1−dm−1

n′
m−1

Also get a 95% CI from output like that below. So the 95% CI for S(50)
is (0.65666,0.86213).

time survival SDF_LCL SDF_UCL

0 1.0 1.0 1.0

50 0.7594 0.65666 0.86213

Example 16.6. Allison (1995, p. 49-51) gives time until death after
heart transplant for 68 patients. The 1st 5 columns are given, but the last 3
columns need to be computed. Use 4 digits in the computations.
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n′
j = p̃j = ŜL(tj) =

Ij tj dj cj nj nj − cj/2
n′

j−dj

n′
j

ŜL(tj−1)p̃j

[0,50) 0 16 3 68 66.5 0.7594 Ŝ(0) = 1

[50,100) 50 11 0 49 49 0.7755 Ŝ(50) = 0.7594

[100,200) 100 14 2 38 37 0.8919 Ŝ(100) = 0.5889

[200,400) 200 5 4 32 30 0.8333 Ŝ(0) = 0.5252

[400,700) 400 2 6 23 20 0.90 Ŝ(400) = 0.4376

[700,1000) 700 4 3 15 13.5 0.7037 Ŝ(700) = 0.7037

[1000,1300) 1000 1 2 8 7 0.8571 Ŝ(1000) = 0.2771

[1300,1600) 1300 1 3 5 3.5 0.7143 Ŝ(1300) = 0.2375

[1600,∞) 1600 0 1 1 0.5 1.0 Ŝ(1600) = 0.1696

Greenwood’s formula is

SE[ŜL(tj)] = ŜL(tj)

√√√√ j∑
i=1

1 − p̃i

p̃in′
i

where j = 1, ..., m− 1. The formula is best computed using software.

Now suppose the data is censored but the event and censoring times are
known. Let Y ∗

i = Ti = min(Yi, Zi) where Yi and Zi are independent. Let
δi = I(Yi ≤ Zi) so δi = 1 if Ti is uncensored and δi = 0 if Ti is censored. Let
t(1) ≤ t(2) ≤ · · · ≤ t(n) be the observed ordered survival times. Let γj = 1 if
t(j) is uncensored and 0, otherwise. Let t0 = 0 and let 0 < t1 < t2 < · · · < tm
be the distinct survival times corresponding to the t(j) with γj = 1. Let di =
number of events (deaths) at time ti. If m = n and di = 1 for i = 1, ..., n
then there are no ties. If m < n and some di ≥ 2, then there are ties. Let
ni =

∑n
j=1 I(t(j) ≥ ti) = # at risk at ti = # alive and not yet censored just

before ti.

Definition 16.5. The Kaplan Meier estimator = product limit
estimator of SY (ti) = P (Y > ti) is ŜK(0) = 1 and

ŜK(ti) =
i∏

k=1

(1 − dk

nk
) = ŜK(ti−1)(1 − di

ni
).

ŜK(t) is a step function with ŜK(t) = ŜK(ti−1) for ti−1 ≤ t < ti and i =
1, ..., m. If t(n) is uncensored then tm = t(n) and ŜK(t) = 0 for t > tm. If t(n)
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is censored, then ŜK(t) = ŜK(tm) for tm ≤ t ≤ t(n), but ŜK(t) is undefined
for t > t(n).

Know how to compute and plot Ŝk(ti) given the t(j) and γj or given
the ti, ni and di. Use a table like the one below. Let n0 = n. If fi−1 =
number of events (deaths) and number censored in time interval [ti−1, ti),
then ni = ni−1 − fi−1 = number of t(j) ≥ ti.

ti ni di ŜK(t)

t0 = 0 ŜK(0) = 1

t1 n1 d1 ŜK(t1) = ŜK(t0)[1 − d1

n1
]

t2 n2 d2 ŜK(t2) = ŜK(t1)[1 − d2

n2
]

...
...

...
...

tj nj dj ŜK(tj) = ŜK(tj−1)[1 − dj

nj
]

...
...

...
...

tm−1 nm−1 dm−1 ŜK(tm−1) = ŜK(tm−2)[1 − dm−1

nm−1
]

tm nm dm ŜK(tm) = 0 = ŜK(tm−1)[1 − dm

nm

]

Example 16.7. Modifying Smith (2002, p. 113) slightly, suppose that
the ordered censored survival times in days until repair of n = 13 street lights
is 36, 38, 38, 38+, 78 112, 112, 114+, 162+, 189, 198, 237, 487+.
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fj t(j) γj ti ni di Ŝ(t)

Ŝ(0) = 1

1 36 1 36 13 1 Ŝ(36) = 0.9231

3 38 1 38 12 2 Ŝ(38) = 0.7692
38 1
38 0

1 78 1 78 9 1 Ŝ(78) = 0.6837

4 112 1 112 8 2 Ŝ(112) = 0.5128
112 1
114 0
162 0

1 189 1 189 4 1 Ŝ(189) = 0.3846

1 198 1 198 3 1 Ŝ(198) = 0.2564

1 237 1 237 2 1 Ŝ(36) = 0.1282
489 0

Know how to find a 95% CI for SY (ti) based on ŜK(ti) using output: the
95% CI is ŜK(ti)±1.96 SE[ŜK(ti)]. The R output below gives ti, ni, di, ŜK(ti),
SE(ŜK(ti)) and the 95% CI for SY (36) is (0.7782, 1).

time n.risk n.event survival std.err lower 95% CI upper 95% CI

36 13 1 0.923 0.0739 0.7782 1.000

In general, a 95% CI for SY (ti) is Ŝ(ti) ± 1.96 SE[Ŝ(ti)]. If the lower
endpoint of the CI is negative, round it up to 0. If the upper endpoint of the
CI is greater than 1, round it down to 1. Do not use impossible values
of SY (t).

Let P (Y ≤ t(p)) = p for 0 < p < 1. Be able to get t(p) and 95% CIs for
t(p) from SAS output for p = 0.25, 0.5, 0.75. For the output below, the CI
for t(0.75) is not given. The 95% CI for t(0.50) ≈ 210 is (63,1296). The 95%
CI for t(0.25) ≈ 63 is (18,195).

Quartile estimates

Percent point estimate lower upper

75 . 220.0 .

50 210.00 63.00 1296.00

25 63.00 18.00 195.00
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R plots the KM survival estimator along with the pointwise 95% CIs
for SY (t). If we guess a distribution for Y , say Y ∼ W, with a formula for
SW (t), then the guessed SW (ti) can be added to the plot. If roughly 95%
of the SW (ti) fall within the bands, then Y ∼ W may be reasonable. For
example, if W ∼ EXP (1), use SW (t) = exp(−t). If W ∼ EXP (λ), then
SW (t) = exp(−λt). Recall that E(W ) = 1/λ.

If limt→∞ tSY (t) → 0, then E(Y ) =
∫ ∞

0
tfY (t)dt =

∫ ∞
0
SY (t)dt. Hence an

estimate of the mean Ê(Y ) can be obtained from the area under Ŝ(t).
Greenwood’s formula is

SE[ŜK(tj)] = ŜK(tj)

√√√√ j∑
i=1

dj

nj(nj − dj)

where j = 1, ..., m− 1. The formula is best computed using software.

16.2 Proportional Hazards Regression

Definition 16.6. The Cox proportional hazards regression (PH)
model is

hi(t) = hYi|xi
(t) = h

Yi|β
T
xi

(t) = exp(βTxi)h0(t)

where h0(t) is the unknown baseline function and exp(βT xi) is the haz-
ard ratio. The sufficient predictor SP = βTxi =

∑p
j=1 βjxij.

The Cox PH model is a 1D regression model since the conditional distri-
bution Y |x is completely determined by the hazard function, and the hazard
function only depends on x through βTx. Inference for the PH model uses
computer output that is used almost exactly as the output for generalized
linear models such as the logistic and Poisson regression models. The Cox
PH model is semiparametric: the conditional distribution Y |x depends on
the sufficient predictor βT x, but the parametric form of the hazard function
hY |x(t) is not specified. The Cox PH model is the most widely used survival
regression in survival analysis.

Regression models are used to study the conditional distribution Y |x
given the p×1 vector of nontrivial predictors x. In survival regression, Y is the
time until an event such as death. For many of the most important survival
regression models, the nonnegative response variable Y is independent of x
given βT x, written Y x|βT x. Let the sufficient predictor SP = βTx, and
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the estimated sufficient predictor ESP = β̂
T
x. The ESP is sometimes called

the estimated risk score.
The conditional distribution Y |x is completely determined by the prob-

ability density function fx(t), the distribution function Fx(t), the survival
function

Sx(t) ≡ SY |SP (t) = P (Y > t|SP = βTx),

the cumulative hazard functionHx(t) = − log(Sx(t)) for t > 0, or the hazard
function hx(t) = d

dt
Hx(t) = fx(t)/Sx(t) for t > 0. High hazard implies low

survival times while low hazard implies long survival times.
Survival data is usually right censored so Y is not observed. Instead, the

survival time Ti = min(Yi, Zi) where Yi Zi and Zi is the censoring time.
Also δi = 0 if Ti = Zi is censored and δi = 1 if Ti = Yi is uncensored. Hence
the data is (Ti, δi,xi) for i = 1, ..., n.

The Cox proportional hazards regression model (Cox 1972) is a semipara-
metric model with SP = βT

Cx and

hx(t) ≡ hY |SP (t) = exp(βT
Cx)h0(t) = exp(SP )h0(t)

where the baseline hazard function h0(t) is left unspecified. The survival
function is

Sx(t) ≡ SY |SP (t) = [S0(t)]
exp(βT

Cx) = [S0(t)]
exp(SP ). (16.1)

If x = 0 is within the range of the predictors, then the baseline survival and
hazard functions correspond to the survival and hazard functions of x = 0.
First βC is estimated by the maximum partial likelihood estimator β̂C, then
estimators ĥ0(t) and Ŝ0(t) can be found (see Breslow 1974), and

Ŝx(t) = [Ŝ0(t)]
exp(

ˆβ
T

Cx) = [Ŝ0(t)]
exp(ESP ). (16.2)

16.2.1 Visualizing the Cox PH Regression Model

Grambsch and Therneau (1994) give a useful graphical check for whether the
PH model is a reasonable approximation for the data. Suppose the ith case
had an uncensored survival time ti. Let the scaled Schoenfeld residual for
the ith observation and jth variable xj be r∗P,j(ti). For each variable, plot

the ti versus the r∗P,j(ti) + β̂j and add the loess curve. If the loess curve
is approximately horizontal for each of the p plots, then the proportional
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hazards assumption is reasonable. Alternatively, fit a line to each plot and
test that each of the p slopes is equal to 0. The R/Splus function cox.zph

makes both the plots and tests. See MathSoft (1999, pp. 267, 275). Hosmer
and Lemeshow (1999, p. 211) suggest also testing whether the interactions
xi log(t) are significant for i = 1, ..., p.

Definition 16.7. The slice survival plot divides the ESP into J groups
of roughly the same size. For each group j, Ŝj(t) is computed using an x
corresponding to the middle ESP of the group. (The “middle ESP” is the
kth order statistic of the ESP in group j, where k = 1 + floor[(nj − 1)/2]

and nj is the number of cases in group j.) Let ŜKMj(t) be the Kaplan Meier
estimator computed from the survival times (Yi, δi) in the jth group. For
each group, Ŝj(t) is plotted and ŜKMj(ti) as circles at the uncensored event
times ti. The survival regression model is reasonable if the circles “track the
curve well” in each of the J plots.

If the slice widths go to zero, but the number of cases per slice increases
to ∞ as n→ ∞, then the Kaplan Meier estimator and the model estimator
converge to SY |SP (t) if the model holds. Simulations suggest that the two
curves are “close” for moderate n and nine slices. For small n and skewed
predictors, some slices may be too wide in that the model is correct but
ŜKMj(t) is not a good approximation of SY |SP (t) where SP corresponds to

the x used to compute Ŝj(t).
For the Cox model, if pointwise confidence interval (CI) bands are added

to the plot, then ŜKMj “tracks Ŝj well” if most of the plotted circles do not
fall very far outside the pointwise CI bands since these pointwise bands are
not as wide as simultaneous bands. Collett (2003, pp. 241-243) places several
observed Kaplan Meier curves with fitted curves on the same plot.

Survival regression is the study of the conditional survival SY |SP (t), and
the slice survival plot is a crucial tool for visualizing SY |SP (t) in the back-
ground of the data. Suppose the jth slice is narrow so that ESP ≈ wj. If
the model is reasonable, ESP ≈ SP , and the number of uncensored cases in
the jth slice is not too small, then SY |SP=wj

(t) ≈ Ŝj(t) ≈ ŜKMj(t). (These

quantities approximate [Ŝ0(t)]
exp(wj) for the Cox model.) Thus the nonpara-

metric Kaplan Meier estimator is used to check the model estimator Ŝj(t) in
each slice.

The slice survival plot tailored to the Cox model is closely related to the
May and Hosmer (1998) test, and the plot has been suggested by several
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Figure 16.1: Censored Response Plot for R Lung Cancer Data

authors with x divided into J groups instead of the ESP. For example, see
Miller (1981, p. 168). Hosmer and Lemeshow (1999, pp. 141–145) suggests
making plots based on the quartiles of the ith predictor xi, and note that a
problem with Cox survival curves (16.2) is that they may use inappropriate
extrapolation. Using the ESP results in narrow slices with many cases, and
adding Kaplan Meier curves shows if there is extrapolation. The main use
of the next plot is to check for cases with unusual survival times.

Definition 16.7. A censored response plot is a plot of the ESP
versus T with plotting symbol 0 for censored cases and + for uncensored
cases. Slices in this plot correspond to the slices used in the slice survival
plot.

Suppose the ESP is a good estimator of the SP. Consider a narrow vertical
slice taken in the censored response plot about ESP = w. The points in
the slice are a censored sample with SY |SP (t) ≈ SY |w(t). For proportional
hazards models, hY |SP (t) ≈ exp(ESP )h0(t), and the hazard increases while
the survival decreases as the ESP increases.
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Figure 16.2: Slice Survival Plots for R Lung Cancer Data

Example 16.8 R and Splus contain a data set lung where the response
variable Y is the time until death for patients with lung cancer. See MathSoft
(1999, p. 268). Consider the data set for males with predictors ph.ecog =
Ecog performance score 0-4, ph.karno = a competitor to ph.ecog, pat.karno
= patient’s assessment of their karno score and wt.loss = weight loss in last 6
months. Figure 16.1 shows the censored response plot. Notice that the sur-
vival times decrease rapidly as the ESP increases and that there is one time
that is unusually large for ESP ≈ 1.8. If the Cox regression model is a good
approximation to the data, then the response variables corresponding to the
cases in a narrow vertical strip centered at ESP = w are approximately a cen-
sored sample from a distribution with hazard function hx(t) ≈ exp(w)h0(t).
Figure 16.2 shows the slice survival plots. The ESP was divided into 4
groups and correspond to the upper left, upper right, lower right and lower
left corners of the plot where Ŝ(400) ≈ (0.70, 0.60, 0.55, 0.30). The circles
corresponding to the Kaplan Meier estimator are “close” to the Cox survival
curves in that the circles do not fall very far outside the pointwise CI bands.
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Figure 16.3: Grambsch and Therneau Plots for NWTCO Data

Example 16.9. R contains a data set nwtco where the response variable
Y is the time until relapse with n = 4028. The model used predictors histol
= tumor histology from central lab, instit = tumor histology from local
institution, age in months, and stage of disease from 1 to 4 (treated as an
continuous variable). Figure 16.3 shows the Grambsch and Therneau (1994)
plots which look fairly flat, but with such a large sample, all slopes are
significantly different from zero, and the global test has p-value ≈ 5.66 ×
10−11. The slice survival plot in Figure 16.4 shows that the Cox survival
estimators and Kaplan Meier estimators are nearly identical in the six slices,
suggesting that the Cox model is a reasonable approximation to the data.
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Figure 16.4: Slice Survival Plot for NWTCO Data: Horizontal Axis is the
Estimated Survival Function S(t)
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16.2.2 Testing and Variable Selection

variable Est. SE Est./SE or (Est/SE)2 pvalue for

x1 β̂1 se(β̂1) zo,1 = β̂1/se(β̂1) X2
o,1 = z2

o,1 Ho β1 = 0
...

...
...

...
...

...

xp β̂p se(β̂p) zo,p = β̂p/se(β̂p) X2
o,p = z2

o,p Ho βp = 0

SAS Wald pr >

variable df Estimate SE chi square chisqu

age 1 0.1615 0.0499 10.4652 0.0012

ecog.ps 1 0.0187 0.5991 0.00097 0.9800

R coef exp(coef) se(coef) z p

age 0.1615 1.18 0.0499 3.2350 0.0012

ecog.ps 0.0187 1.02 0.5991 0.0312 0.9800

Likelihood ratio test=14.3 on 2 df, p=0.000787 n= 26

Shown above is output in symbols from and SAS and R . The estimated
coefficient is β̂j. The Wald chi square = X2

o,j while p and “pr > chisqu” are
both p-values. Sometimes “Std. Err.” replaces “SE.”

The estimated sufficient predictor ESP = β̂
′
xj =

∑p
i=1 β̂ixij. Given β̂

from output and given x, be able to find ESP and ĥi(t) = exp(ESP )ĥ0(t) =

exp(β̂
′
x)ĥo(t) where exp(β̂

′
x) is the estimated hazard ratio.

For tests, the p–value is an important quantity. Recall that Ho is rejected
if the p–value < δ. A p–value between 0.07 and 1.0 provides little evidence
that Ho should be rejected, a p–value between 0.01 and 0.07 provides moder-
ate evidence and a p–value less than 0.01 provides strong statistical evidence
that Ho should be rejected. Statistical evidence is not necessarily practical
evidence, and reporting the p–value along with a statement of the strength
of the evidence is more informative than stating that the p–value is less
than some chosen value such as δ = 0.05. Nevertheless, as a homework
convention, use δ = 0.05 if δ is not given.
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The Wald confidence interval (CI) for βj can also be obtained from the
output: the large sample 95% CI for βj is

β̂j ± 1.96 se(β̂j).

Investigators also sometimes test whether a predictor Xj is needed in the
model given that the other k − 1 nontrivial predictors are in the model with
a 4 step Wald test of hypotheses:
i) State the hypotheses Ho: βj = 0 Ha: βj �= 0.

ii) Find the test statistic zo,j = β̂j/se(β̂j) or X2
o,j = z2

o,j or obtain it from
output.

iii) The p–value = 2P (Z < −|zoj|) = P (χ2
1 > X2

o,j). Find the p–value from
output or use the standard normal table.
iv) State whether you reject Ho or fail to reject Ho and give a nontechnical
sentence restating your conclusion in terms of the story problem.

If Ho is rejected, then conclude that Xj is needed in the PH survival
model given that the other p − 1 predictors are in the model. If you fail
to reject Ho, then conclude that Xj is not needed in the PH survival model
given that the other p−1 predictors are in the model. Note that Xj could be
a very useful PH survival predictor, but may not be needed if other predictors
are added to the model.

For a PH, often 3 models are of interest: the full model that uses all p of
the predictors xT = (xT

R,x
T
O), the reduced model that uses the r predictors

xR, and the null model that uses none of the predictors.
The partial likelihood ratio test (PLRT) is used to test whether β = 0.

If this is the case, then the predictors are not needed in the PH model (so
survival times Y x). If Ho : β = 0 is not rejected, then the Kaplan Meier
estimator should be used. If Ho is rejected, use the PH model.

Know that the 4 step PLRT is
i) Ho : β = 0 HA : β �= 0
ii) test statistic X2(N |F ) = [−2 logL(none)] − [−2 logL(full)] is often

obtained from output
iii) The p–value = P (χ2

p > X2(N |F )) where χ2
p has a chi–square distribu-

tion with p degrees of freedom. The p–value is often obtained from output.
iv) Reject Ho if the p–value < δ and conclude that there is a PH survival

relationship between Y and the predictors x. If p–value ≥ δ, then fail to
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reject Ho and conclude that there is not a PH survival relationship between
Y and the predictors x.

R output for the PLRT uses a line like
Likelihood ratio test=14.3 on 2 df, p=0.000787.
Some SAS output for the PLRT is shown next.

SAS Testing Global Null Hypotheses: BETA = 0

without with

criterion covariates covariates model Chi-square

-2 LOG L 596.651 551.1888 45.463 with 3 DF (p=0.0001)

Let the full model be

SP = β1x1 + · · · + βpxp = βT x = α + βT
RxR + βT

OxO.

let the reduced model

SP = βR1xR1 + · · · + βRrxRr = βT
RxR

where the reduced model uses r of the predictors used by the full model and
xO denotes the vector of p− r predictors that are in the full model but not
the reduced model.

Assume that the full model is useful. Then we want to test Ho: the
reduced model is good (can be used instead of the full model, so xO is not
needed in the model given xR is in the model) versus HA: use the full model
(the full model is significantly better than the reduced model). Fit the full
model and the reduced model to get X2(N |F ) and X2(N |R) where X2(N |F )
is used in the PLRT to test whether β = 0 and X2(N |R) is used in the
PLRT to test whether βR = 0 (treating the reduced model as the model in
the PLRT).

Shown below in symbols is output for the full model and output for the
reduced model. The output shown on can be used to perform the change
in PLR test. For simplicity, the reduced model used in the output is xR =
(x1, ..., xr)

T .

Notice that X2(R|F ) ≡ X2(N |F ) −X2(N |R) =

[−2 logL(none)] − [−2 logL(full)] − ([−2 logL(none)] − [−2 logL(red)]) =

[−2 logL(red)] − [−2 logL(full)] = −2 log

(
L(red)

L(full)

)
.
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variable Est. SE Est/SE or (Est/SE)2 pvalue for

x1 β̂1 se(β̂1) zo,1 = β̂1/se(β̂1) X2
o,1 = z2

o,1 Ho β1 = 0
...

...
...

...
...

...

xp β̂p se(β̂p) zo,p = β̂p/se(β̂p) X2
o,p = z2

o,p Ho βp = 0

R: Likelihood ratio test = X2(N |F ) on p df

SAS: Testing Global Null Hypotheses: BETA = 0

Test Chi-Square DF Pr > Chisq

Likelihood ratio X2(N |F ) p pval for Ho: β = 0

variable Est. SE Est/SE or (Est/SE)2 pvalue for

x1 β̂1 se(β̂1) zo,1 = β̂1/se(β̂1) X2
o,1 = z2

o,1 Ho: β1 = 0
...

...
...

...
...

...

xr β̂r se(β̂r) zo,r = β̂r/se(β̂r) X2
o,r = z2

o,r Ho: βr = 0

R: Likelihood ratio test = X2(N |R) on r df

SAS: Testing Global Null Hypotheses: BETA = 0

Test Chi-Square DF Pr > Chisq

Likelihood ratio X2(N |R) r pval for Ho: βR = 0

Know that the 4 step change in PLR test is
i) Ho: the reduced model is good HA: use the full model
ii) test statistic X2(R|F ) = X2(N |F ) − X2(N |R) = [−2 logL(red)] −

[−2 logL(full)]
iii) The p–value = P (χ2

p−r > X2(R|F )) where χ2
p−r has a chi–square

distribution with p− r degrees of freedom.
iv) Reject Ho if the p–value < δ and conclude that the full model should

be used. If p–value ≥ δ, then fail to reject Ho and conclude that the reduced
model is good.

If the reduced model leaves out a single variable xi, then the change in
PLR test becomes Ho : βi = 0 versus HA : βi �= 0. This change in partial
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likelihood ratio test is a competitor of the Wald test. The change in PLRT
is usually better than the Wald test if the sample size n is not large, but
the Wald test is currently easier for software to produce. For large n the
test statistics from the two tests tend to be very similar (asymptotically
equivalent tests).

If the reduced model is good, then the EE plot of ESP (R) = β̂
T

RxRi

versus ESP = β̂
T
xi should be highly correlated with the identity line with

unit slope and zero intercept.

A factor A is a variable that takes on a categories called levels. Suppose
A has a categories c1, ..., ca. Then the factor is incorporated into the PH
model by using a − 1 indicator variables xjA = 1 if A = cj and xAj = 0
otherwise, where the 1st indicator variable is omitted, eg, use x2A, ..., xaA.
Each indicator has 1 degree of freedom. Hence the degrees of freedom of the
a− 1 indicator variables associated with the factor is a− 1.

The xj corresponding to variates (variables that take on numerical values)
or to indicator variables from a factor are called main effects.

An interaction is a product of two or more main effects, but for a factor
include products for all indicator variables of the factor.

If an interaction is in the model, also include the corresponding main
effects. For example, if x1x3 is in the model, also include the main effects x1

and x2.
A scatterplot is a plot of xi versus xj. A scatterplot matrix is an

array of scatterplots. It is used to examine the marginal relationships of the
predictors. Variables with outliers, missing values or strong nonlinearities
may be so bad that they should not be included in the full model.

Suppose that all values of the variable x are positive. The log rule says
add log(x) to the full model if max(xi)/min(xi) > 10.

Variable selection is closely related to the change in PLR test for a
reduced model. You are seeking a subset I of the variables to keep in the
model. The AIC(I) statistic is used as an aid in backward elimination and
forward selection. The full model and the model with the smallest AIC are
always of interest. Create a full model. The full model has a −2 log(L) at
least as small as that of any submodel. The full model is a submodel.

Backward elimination starts with the full model with p variables and
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the predictor that optimizes some criterion is deleted. Then there are p− 1
variables left and the predictor that optimizes some criterion is deleted. This
process continues for models with p− 2, p− 3, ..., 3 and 2 predictors.

Forward selection starts with the model with 0 variables and the pre-
dictor that optimizes some criterion is added. Then there is p variable in
the model and the predictor that optimizes some criterion is added. This
process continues for models with 2, 3, ..., p− 2 and p − 1 predictors. Both
forward selection and backward elimination result in a sequence of p models
{x∗1}, {x∗1, x∗2}, ..., {x∗1, x∗2, ..., x∗p−1}, {x∗1, x∗2, ..., x∗p} = full model.

Consider models I with rI predictors. Often the criterion is the minimum
value of −2 log(L(β̂I)) or the minimum AIC(I) = −2 log(L(β̂I)) + 2rI .

Heuristically, backward elimination tries to delete the variable that will
increase the −2 log(L) the least. An increase in −2 log(L) greater than 4
(if the predictor has 1 degree of freedom) may be troubling in that a good
predictor may have been deleted. In practice, the backward elimination
program may delete the variable such that the submodel I with k predictors
has 1) the smallest AIC(I), 2) the smallest −2 log(L(β̂I)) or 3) the biggest
p–value (preferably from a change in PLR test but possibly from a Wald
test) in the test Ho βi = 0 versus HA βi �= 0 where the current model with
k + 1 variables is treated as the full model.

Heuristically, forward selection tries to add the variable that will decrease
the −2 log(L) the most. An decrease in −2 log(L) less than 4 (if the predictor
has 1 degree of freedom) may be troubling in that a bad predictor may have
been added. In practice, the forward selection program may add the variable
such that the submodel I with k predictors has 1) the smallest AIC(I), 2) the
smallest −2 log(L(β̂I)) or 3) the smallest p–value (preferably from a change
in PLR test but possibly from a Wald test) in the test Ho βi = 0 versus
HAβi �= 0 where the current model with k − 1 terms plus the predictor xi is
treated as the full model (for all variables xi not yet in the model).

If an interaction (eg x3x7x9) is in the submodel, then the main effects
(x3, x7, and x9) should be in the submodel.

If xi+1, xi+2, ..., xi+a−1 are the a − 1 indictor variables corresponding to
factor A, submodel I should either contain none or all of the a − 1 indictor
variables.
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Given a list of submodels along with the number of predictors and AIC,
be able to find the “best starting submodel” Io. Let Imin be the minimum
AIC model. Then Io is the submodel with the fewest predictors such that
AIC(Io) ≤ AIC(Imin)+2 (for a given number of predictors rI , only consider
the submodel with the smallest AIC). Also look at models Ij with fewer
predictors than Io such that AIC(Ij) ≤ AIC(Imin) + 7.

Submodels I with more predictors than Imin should not be used.

Submodels I with AIC(I) > AIC(Imin) + 7 should not be used.

Assume n > 5p, that the full PH model is reasonable and all predictors
are equally important. The following rules of thumb for a good PH submodel
I are in roughly decreasing order of importance.
i) Do not use more predictors than the min AIC model Imin.
ii) The slice survival plots for I looks like the slice survival plot for the full
model.
iii) corr(ESP,ESP(I))≥ 0.95.
iv) The plotted points in the EE plot of ESP(I) vs ESP cluster tightly about
the identity line.
v) Want pvalue ≥ 0.01 for the change in PLR test that uses I as the reduced
model. (So for variable selection use δ = 0.01 instead of δ = 0.05.)
vi) Want the number of predictors rI ≤ n/10.
vii) Want −2 log(L(β̂I)) ≥ −2 log(L(β̂full)) but close.
viii) Want AIC(I) ≤ AIC(Imin) + 7.
ix) Want hardly any predictors with pvalues > 0.05.
x) Want few predictors with pvalues between 0.01 and 0.05.

But for factors with a− 1 indicators, modify ix) and x) so that the indi-
cator with the smallest pvalue is examined.

Suppose that the full model is good and is stored in M1. Let M2, M3,
M4, and M5 be candidate submodels found after forward selection, backward
elimination, etc. Typically one of the submodels is the min(AIC) model.
Given a list of properties of each submodel, be able to pick out the “best
starting submodel.”
Tips: i) submodels with more predictors then the min(AIC) submodel have
too many predictors.
ii) The best starting submodel Io has AIC(Io) ≤ AIC(Imin) + 2.
iii) Submodels I with AIC(I) > AIC(Imin) + 2 are not the best starting
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submodel.
iv) Submodels I with a pvalue < 0.01 for the change in PLR test have too
few predictors.
v) The full model may be the best starting submodel if it is the min(AIC)
model and M2–M5 satisfy iii). Similarly, then min(AIC) model may be the
best starting submodel.

In addition to the best starting submodel Io, submodels I with fewer
predictors than Io and AIC(I) ≤ AIC(Imin) + 7 are worth considering.

If there are important predictors such as treatment that must be in the
submodel, either force the variable selection procedures to contain the im-
portant predictors or do variable selection on the less important predictors
and then add the important predictors to the submodel.

Suppose the PH model contains x1, ..., xp. Leave out xj, find the martin-
gale residuals rm(j), plot xj vs rm(j) and add the lowess or loess curve. If the
curve is linear then xj has the correct functional form. If the curve looks like
t(xj) (eg (xj)

2), then replace xj by t(xj), find the martingale residuals, plot
t(xj) vs the residuals and check that the loess curve is linear.

16.3 Weibull and Exponential Regression

Definition 16.8. For parametric proportional hazards regression mod-
els, the baseline function is parametric and the parameters are estimated via
maximum likelihood. Then as a 1D regression model, SP = βT

Px, and

hY |SP (t) ≡ hx(t) = exp(βT
P x)h0,P (t) = exp(SP )h0,P (t)

where the parametric baseline function depends on k unknown parameters
but does not depend on the predictors x. The survival function is

Sx(t) ≡ SY |SP (t) = [S0,P (t)]exp(βT

Px) = [S0,P(t)]exp(SP ), (16.3)

and

Ŝx(t) = [Ŝ0,P (t)]exp(
ˆβ

T

Px) = [Ŝ0,P(t)]exp(ESP ). (16.4)

The following univariate results will be useful for Exponential and Weibull
regression. If Y has a Weibull distribution, Y ∼ W (γ, λ), then SY (t) =
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exp(−λtγ) where t, λ and γ are positive. If γ = 1, then Y has an Exponen-
tial distribution, Y ∼ EXP (λ) where E(Y ) = 1/λ. Now V has a smallest
extreme value distribution, V ∼ SEV (θ, σ), if

SV (v) = P (V > t) = exp

(
− exp

(
v − θ

σ

))
where σ > 0 while v and θ are real. If Z ∼ SEV (0, 1), then V = θ +
σZ ∼ SEV (θ, σ) since the SEV distribution is a location scale family. Also,
V = log(Y ) ∼ SEV (θ = −σ log(λ), σ = 1/γ), and Y = eV ∼ W (γ =
1/σ, λ = e−θ/σ).

If Yi follows a Weibull regression model, then log(Yi) follows an accel-
erated failure time model: log(Yi) = α + βT

Axi + σei where the ei are iid
SEV (0, 1), and log(Y |x) ∼ SEV (α+ βT

Ax, σ). See Section 16.3.

Definition 16.9. The Weibull proportional hazards regression
(WPH) model or Weibull regression model is a parametric proportional
hazards model with Y ∼ W (γ = 1/σ, λx) where

λx = exp

[
−

(
α

σ
+

βT
Ax

σ

)]
= λ0 exp(βT

Px)

with λ0 = exp(−α/σ) and βP = −βA/σ. Thus for t > 0, P (Y > t|x) =

Sx(t) = exp(−λxtγ) = exp(−λ0 exp(βT
Px)tγ) = [exp(−λ0t

γ)]exp(βT

Px) =

[S0,P(t)]exp(βT

P x).

As a 1D regression model, Y |SP ∼ W (γ, λ0 exp(SP )). Also,

hi(t) = hYi|xi
(t) = h

Yi|β
T

Pxi
(t) = exp(βT

Pxi)h0(t)

where h0(t) = h0(t|θ) = λ0γt
γ−1 is the Weibull baseline function. Expo-

nential regression is the special case of Weibull regression where σ = 1.
Hence Y |x ∼ W (1, λx) ∼ EXP (λx).

Definition 16.10. Let Ti = min(Yi, Zi) be the censored survival times,

and let log(Ti) = α̂ + β̂
T

Axi + ri. For accelerated failure time models, a

log censored response (LCR) plot is a plot of α̂ + β̂
T

Axi versus log(Ti)
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with plotting symbol 0 for censored cases and + for uncensored cases. The
identity line with unit slope and zero intercept is added to the plot, and the
vertical deviations from the identity line = ri. Collett (2003, p. 231) defines
a standardized residual rSi = ri/σ̂.

The least squares line based on the +’s could be added to the plot and
should have slope not too far from 1, especially if γ ≥ 1 for the Weibull
AFT. The plotted points should be linear with roughly constant variance.
The censoring and long left tails of the smallest extreme value distribution
make judging linearity and detecting outliers from the left tail difficult. Try
to ignore the bottom of the plot where there are few cases when assessing
linearity.

Definition 16.11. For parametric proportional hazards models, an EE

plot is a plot of the parametric ESP β̂
T

Px versus the Cox semiparametric

ESP β̂
T

Cx.

If the parametric proportional hazards model is good, then the plotted
points in the EE plot should track the identity line with unit slope and zero
intercept. As n → ∞, the correlation of the plotted points goes to 1 in
probability for any finite interval, e.g., from the 1st percentile to the 99th

percentile of β̂
T

Cx. Lack of fit is suggested if the plotted points do not cluster
tightly about the identity line.

Software typically fits Exponential and Weibull regression models as ac-
celerated failure time models: log(Yi) = α+βT

Axi +σei. For the Exponential
regression model, σ = 1 and βC = −βA, and the Exponential EE plot is a
plot of

ESPE = −β̂
T

Ax versus ESPC = β̂
T

Cx.

For the Weibull regression model, βC = −βA/σ, and the Weibull EE plot is
a plot of

ESPW =
−1

σ̂
β̂

T

Ax versus ESPC = β̂
T

Cx.

Suppose the plotted points cluster tightly about the identity line in the

EE plot with corr(β̂
T

Cxi, β̂
T

P xi) > 0.99. Thus β̂
T

Cx ≈ β̂
T

P x for the observed
xi, and slicing on the Cox ESP is nearly the same as slicing on the parametric
ESP. Make the slice survival plot for the Cox model and add the estimated
parametric survival function (16.4) as crosses. If the parametric proportional
hazards model holds, then (16.1) = (16.3). Thus if (16.2) ≈ (16.4) for any
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Figure 16.5: LCR Plot for Ovarian Cancer Data

xi, then S0,P (t) ≈ S0(t), (16.2) ≈ (16.4) for all xi, and the parametric
proportional hazards model is reasonable.

Thus checking parametric proportional hazards models has 3 steps: i)
check that the proportional hazards assumption is reasonable with the slice
survival plot for the Cox model, ii) check that the parametric and semipara-

metric ESPs are approximately the same, β̂
T

Px ≈ β̂
T

Cx with the EE plot, and
iii) using the slice survival plot, check that (16.2) ≈ (16.4) for the x used in
each of the J slices.

This technique avoids the mistake of comparing quantities from the semi-
parametric and parametric proportional hazards models without checking
that the proportional hazards assumption is reasonable. The slice survival
plot for the Cox model is used because of the ease of making pointwise CI
bands.

Example 16.10. The ovarian cancer data is from Collett (2003, p. 187-
190) and Edmunson et al. (1979). The response variable is the survival
time of n = 26 patients in days with predictors age in years and treat (1 for
cyclophosphamide alone and 2 for cyclophosphamide combined with adri-
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Figure 16.6: EE Plots for Ovarian Cancer Data

amycin). Figure 16.5 shows that most of the plotted points in the LCR plot
for the ovarian cancer data are below the identity line. If a Weibull regres-
sion model is a good approximation to the data, then the plotted points in a

narrow vertical slice centered at α̂+ β̂
T
x = w are approximately a censored

sample from an SEV (w, σ̂) distribution. Figure 16.6 shows the Weibull and
Exponential regression EE plots. Notice that the estimated risk scores from
the Cox regression and Weibull regression are nearly the same with corre-
lation = 0.997. The points from the Exponential regression do not cluster
about the identity line. Hence Exponential regression should not be used.
Figure 16.7 gives the slice survival plot for the Cox model with the Weibull

survival function Ŝx(t) = exp[− exp(−γ̂β̂T

Ax) exp(−γ̂α̂) tγ̂ ] represented by
crosses where γ̂ = 1/σ̂. Notice that the Weibull and Cox estimated survival
functions are close and thus similar. Again the circles corresponding to the
Kaplan Meier estimator are “close” to the Cox survival curves in that the
circles do not fall very far outside the pointwise CI bands.

Output for the Weibull and Exponential regression models is shown be-
low. The output is often from software for accelerated failure time models.
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Figure 16.7: Slice Survival Plots for Ovarian Cancer Data

For SAS or R

variable Est. SE Est/SE or (Est/SE)2 pvalue for
intercept

x1 β̂1 se(β̂1) zo,1 = β̂1/se(β̂1) X2
o,1 = z2

o,1 Ho: β1 = 0
...

...
...

...
...

xp β̂p se(β̂p) zo,p = β̂p/se(β̂p) X2
o,p = z2

o,p Ho: βp = 0
scale or log scale

Weibull shape or scale
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For SAS only.
log likelihood log L(none)

variable Est. SE Est/SE or (Est/SE)2 pvalue
intercept

scale
Weibull shape

For the full model, SAS will have Log Likelihood = log L(full).
For the full model, R will have log L(full), log L (none) and

chisq = [-2 log L(none)] - [-2 log L(full)] on p degrees of freedom with pvalue

Replace full by reduced for the reduced model.

The SAS and R log likelihood, log L, differ by a constant.

SAS Log Likelihood = -29.7672 null model

variable df Estimate SE chi square pr > chisqu

intercept 1 7.1110 0.2927 590.12 < 0.0001

Weibull Scale 1 1225.4 358.7

Weibull Shape 1 1.1081 0.2810

SAS Log Likelihood = -29.1775 reduced model

variable df Estimate SE chi square pr > chisqu

intercept 1 7.3838 0.4370 285.45 < 0.0001

treat 1 -0.5593 0.5292 1.12 0.2906

Scale 1 0.8857 0.2227

Weibull Shape 1 1.1291 0.2840

SAS Log Likelihood = -20.5631 full model

variable df Estimate SE chi square pr > chisqu

intercept 1 11.5483 1.1970 93.07 < 0.0001

age 1 -0.0790 0.0198 15.97 < 0.0001

treat 1 -0.5615 0.3399 2.73 0.0986

Scale 1 0.5489 0.1291

Weibull Shape 1 1.8218 0.4286
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R reduced model Value Std. Error z p

(Intercept) 7.384 0.437 16.895 4.87e-64

treat -0.559 0.529 -1.057 2.91e-01

Log(scale) -0.121 0.251 -0.483 6.29e-01

Scale= 0.886

Loglik(model)= -97.4 Loglik(intercept only)= -98

Chisq= 1.18 on 1 degrees of freedom, p= 0.28

R full model Value Std. Error z p

(Intercept) 11.548 1.1970 9.65 5.04e-22

treat -0.561 0.3399 -1.65 9.86e-02

age -0.079 0.0198 -4.00 6.43e-05

Log(scale) -0.600 0.2353 -2.55 1.08e-02

Scale= 0.549

Loglik(model)= -88.7 Loglik(intercept only)= -98

Chisq= 18.41 on 2 degrees of freedom, p= 1e-04

Shown above is output in symbols from and SAS and R . The estimated
coefficient is β̂j. The Wald chi square = X2

o,j while p and “pr > chisqu” are
both p-values.

16.4 Accelerated Failure Time Models

Definition 16.12. For a parametric accelerated failure time model,

log(Yi) = α+ βT
Axi + σei (16.5)

where the ei are iid from a location scale family. Let SP = βT
Ax. Then as

a 1D regression model, log(Y )|SP = α+ SP + e. The parameters are again
estimated by maximum likelihood and the survival function is

Sx(t) ≡ SY |x(t) = S0

(
t

exp(βT
Ax)

)
,

and

Ŝx(t) = Ŝ0

(
t

exp(β̂
T

Ax)

)
where Ŝ0(t) depends on α̂ and σ̂.
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For the AFT model, hi(t) = e−SPho(t/e
SP ) and Si(t) = S0(t/ exp(SP )).

If Sx(tx(ρ)) = 1− ρ for 0 < ρ < 1, then tx(ρ) is the ρth percentile. For the
accelerated failure time model,

tx(ρ) = t0(ρ) exp(βT
Ax)

where t0(ρ) = exp(σei(ρ) + α) and Sei(ei(ρ)) = P (ei > ei(ρ)) = 1 − ρ. Note
that the estimated percentile ratio is free of ρ, σ̂ and α̂

t̂x1(ρ)

t̂x2(ρ)
= exp(β̂

T

A(x1 − x2)).

The LCR plot of Definition 16.10 is still useful for finding influential
cases for AFT models. If the Weibull PH regression model holds for Yi, then
log(Yi) = α + βT

Axi + ei where ei ∼ SEV (0, 1). Thus log(Y )|x ∼ SEV (α +
βT

Ax, σ), and the log(Yi) follows a parametric accelerated failure time model.
Thus the Weibull AFT satisfies log(Y )|(α+βT

Ax) ∼ SEV (α+βT
Ax, σ). Thus

points in a narrow vertical slice about α̂ + β̂
T

Ax = w are approximately a
censored sample from an SEV (w, σ̂) distribution if the fitted model is a good
approximation to the data.

Censoring causes the bulk of the data to be below the identity line in the
LCR plot. For example, Hosmer and Lemeshow (1998, p. 226) state that for
the Exponential regression model, α̂ forces

n∑
i=1

δi =
n∑

i=1

Ti

exp(α̂+ β̂
T

Axi)
.

Hence T̂i = exp(α̂ + β̂
T

Axi) ≈ (n/
∑n

i=1 δi)Ti (roughly). With no censoring,
the bulk of the data will still be lower than the identity line if the ei are left
skewed as for the Weibull regression model where the ei ∼ SEV (0, 1).

For Weibull and Exponential regression, instead of fitting a PH model, R
and SAS fit an accelerated failure time model log(Yi) = α+βT

Axi +σei where
the ei are iid from a smallest extreme value distribution. The Exponential
AFT is the special case of the Weibull AFT with σ = 1. As in Definition 16.9,
λ0 = exp(−α/σ) and βP = −βA/σ where βP is the vector of coefficients for
the WPH model and βA is the vector of coefficients for the Weibull AFT
model. Since the AFT is parametric, α̂ and β̂A are MLEs found from the
censored data (Ti, δi,xi) not from (Yi,xi).
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If the Yi|xi are Weibull, the ei are from a smallest extreme value distribu-
tion. The statement that “the Weibull regression model is both a proportional
hazards model and an accelerated failure time model” means that the Yi|xi

follow a Weibull PH model while the log(Yi)|bxi follow a Weibull AFT (al-
though the log(Yi) are actually from a smallest extreme value distribution.
If a Weibull or Exponential AFT is a useful model for the log(Yi)|xi, then
the Weibull or Exponential PH model is a good approximation for the Yi|xi.
Hence to check the goodness of fit for the Weibull AFT, transform the Weibull
AFT into the Weibull PH model. Then use the LCR, EE and slice survival
plots as in Example 16.10.

Similarly, R and SAS Weibull AFT programs do not have a variable
selection option, but the WPH model is a PH model, so use SAS Cox PH
variable selection to suggest good submodels. Then fit each candidate with
WPH software and check the WPH assumptions. Then transform the PH
model to a Weibull AFT.

In addition to the Weibull and Exponential AFTs, there are lognormal
and loglogistic AFT models. If the Yi|xi are lognormal, the ei are normal.
If the Yi|xi are loglogistic, the ei are logistic. The loglogistic and lognormal
AFT models are not PH models. The loglogistic AFT is a proportional odds
model.

Inference for the AFT model is performed exactly in the same way as
for the WPH = Weibull AFT. See points Section 16.2. But the conclusions
change slightly if the AFT is not the Weibull AFT. Change (if necessary)
“Weibull survival model” to the appropriate model, eg “lognormal survival
model”. Change (if necessary) “WPH” to the appropriate model, eg “log-
normal AFT”. Given β̂ ≡ β̂A from output and given x, know how to find

ESP = β̂
T
x =

∑p
i=1 β̂ixi = β̂1x1 + · · · + β̂pxp.

A large sample 95% CI for βj is β̂j ± 1.96 se(β̂j).

Know how to do the 4 step Wald test of hypotheses:
i) State the hypotheses Ho: βj = 0 Ha: βj �= 0.

ii) Find the test statistic zo,j = β̂j/se(β̂j) or X2
o,j = z2

o,j or obtain it from
output.

iii) The p–value = 2P (Z < −|zoj|) = P (χ2
1 > X2

o,j). Find the p–value from
output or use the standard normal table.
iv) If pval < δ, reject Ho and conclude that Xj is needed in the Weibull
survival model given that the other p − 1 predictors are in the model. If
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pval ≥ δ, fail to reject Ho and conclude that Xj is not needed in the Weibull
survival model given that the other p− 1 predictors are in the model.

Know how to do the 4 step likelihood ratio test LRT:
i) Ho : β = 0 HA : β �= 0
ii) test statistic X2(N |F ) = [−2 logL(none)] − [−2 logL(full)] is often

obtained from output
iii) The p–value = P (χ2

p > X2(N |F )) where χ2
p has a chi–square distribu-

tion with p degrees of freedom. The p–value is often obtained from output.
iv) Reject Ho if the p–value < δ and conclude that there is a WPH

survival relationship between Y and the predictors x. If p–value ≥ δ, then
fail to reject Ho and conclude that there is not a WPH survival relationship
between Y and the predictors x.

Know how to do the 4 step change in LR test:
i) Ho: the reduced model is good HA: use the full model
ii) test statistic X2(R|F ) = X2(N |F ) − X2(N |R) = [−2 logL(red)] −

[−2 logL(full)]
iii) The p–value = P (χ2

p−r > X2(R|F )) where χ2
p−r has a chi–square

distribution with p− r degrees of freedom.
iv) Reject Ho if the p–value < δ and conclude that the full model should

be used. If p–value ≥ δ, then fail to reject Ho and conclude that the reduced
model is good.

16.5 Stratified Proportional Hazards Regres-

sion

Definition 16.12. The stratified proportional hazards regression
(SPH) model is

hx,j(t) = hYi|x,j(t) = h
Yi|β

′xi
(t) = exp(β′xi)h0,j(t)

where h0,j(t) is the unknown baseline function for the jth stratum, j =
1, ..., J where J ≥ 2.

A SPH model is not a PH model, but a PH model is fit to each of the
J strata. The same β is used for each group = stratum, but the baseline
hazard functions differ. Stratification can be useful if there are clusters of
cases such that the observations within the clusters are not independent. A
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common example is the variable study sites and the stratification should be
on site. Sometimes stratification is done on a categorical variable such as
gender.

Inference is done almost exactly as done for the PH model. Except the
conclusion is changed slightly: replace “PH” by “SPH”.

16.6 Summary

Let Y ≥ 0 be a nonnegative random variable.
Then the distribution function (df) F (t) = P (Y ≤ t). Since Y ≥ 0,

F (0) = 0, F (∞) = 1, and F (t) is nondecreasing.
The probability density function (pdf) f(t) = F ′(t).
The survival function S(t) = P (Y > t). S(0) = 1, S(∞) = 0 and S(t)

is nonincreasing.

The hazard function h(t) =
f(t)

1 − F (t)
for t > 0 and F (t) < 1. Note that

h(t) ≥ 0 if F (t) < 1.
The cumulative hazard function H(t) =

∫ t

0
h(u)du for t > 0. It is true

that H(0) = 0, H(∞) = ∞, and H(t) is nondecreasing.

1) Given one of F (t), f(t), S(t), h(t) or H(t), be able to find the other 4
quantities for t > 0.

A) F (t) =
∫ t

0
f(u)du = 1−S(t) = 1−exp[−H(t)] = 1−exp[− ∫ t

0
h(u)du].

B) f(t) = F ′(t) = −S ′(t) = h(t)[1−F (t)] = h(t)S(t) = h(t) exp[−H(t)] =
H ′(t) exp[−H(t)].

C) S(t) = 1 − F (t) = 1 − ∫ t

0
f(u)du =

∫∞
t
f(u)du = exp[−H(t)] =

exp[− ∫ t

0
h(u)du].

D)

h(t) =
f(t)

1 − F (t)
=
f(t)

S(t)
=

F ′(t)
1 − F (t)

=
−S ′(t)
S(t)

= − d

dt
log[S(t)] = H ′(t).

E) H(t) =
∫ t

0
h(u)du = − log[S(t)] = − log[1 − F (t)].
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Tip: if F (t) = 1 − exp[G(t)] for t > 0, then H(t) = −G(t) and S(t) =
exp[G(t)].

Tip: For S(t) > 0, note that S(t) = exp[log(S(t))] = exp[−H(t)]. Finding
exp[log(S(t))] and setting H(t) = − log[S(t)]is easier than integrating h(t).

Know that if Y ∼ EXP (λ) where λ > 0, then h(t) = λ for t > 0,
f(t) = λe−λt for t > 0, F (t) = 1 − e−λt for t > 0, S(t) = e−λt for t > 0,
H(t) = λt for t > 0 and E(T ) = 1/λ. The exponential distribution can
be a good model if failures are due to random shocks that follow a Poisson
process, but constant hazard means that a used product is as good as a new
product.

2) Suppose the observed survival times T1, ..., Tn are a censored data set
from an exponential (λ) distribution. Let Ti = Y ∗

i . Let δi = 0 if the case
is censored and let δi = 1, otherwise. Let r =

∑n
i=1 δi = the number of

uncensored cases. Then the MLE λ̂ = r/
∑n

i=1 Ti. So λ̂ = r/
∑n

i=1 Y
∗
i . A 95%

CI for λ is λ̂± 1.96λ̂/
√
r.

Know that if Y ∼ Weibull(λ, γ) where λ > 0 and γ > 0, then h(t) =
λγtγ−1 for t > 0, f(t) = λγtγ−1 exp(−λtγ) for t > 0, F (t) = 1 − exp(−λtγ)
for t > 0, S(t) = exp(−λtγ) for t > 0, H(t) = λtγ for t > 0. The
Weibull(λ, γ = 1) distribution is the EXP(λ) distribution. The hazard func-
tion can be increasing, decreasing or constant. Hence the Weibull distri-
bution often fits reliability data well, and the Weibull distribution is the
most important distribution in reliability analysis.

3) Let Ŝ(t) be the estimated survival function. Let t(p) be the pth per-
centile of Y : P (Y ≤ t(p)) = F (t(p)) = p so 1 − p = S(t(p)) = P (Y > t(p)).
Then t̂(p), the estimated time when 100 p % have died, can be estimated
from a graph of Ŝ(t) with “over” and “down” lines. a) Find 1−p on the ver-
tical axis and draw a horizontal “over” line to Ŝ(t). Draw a vertical “down”
line until it intersects the horizontal axis at t̂(p). Usually want p = 0.5 but
sometimes p = 0.25 and p = 0.75 are used.

The indicator function IA(x) ≡ I(x ∈ A) = 1 if x ∈ A and 0, otherwise.
Sometimes an indicator function such as I(0,∞)(y) will be denoted by I(y > 0).

If none of the survival times are censored, then the empirical survival
function = (number of individual with survival times > t)/(number of in-
dividuals) = a/n =
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ŜE(t) =
1

n

n∑
i=1

I(Ti > t) = p̂t = sample proportion of lifetimes > t.

Let t(1) ≤ t(2) ≤ · · · ≤ t(n) be the observed ordered survival times (=
lifetimes = death times). Let t0 = 0 and let 0 < t1 < t2 < · · · < tm be the
distinct survival times. Let di = number of deaths at time ti. If m = n and
di = 1 for i = 1, ..., n then there are no ties. If m < n and some di ≥ 2,
then there are ties.

ŜE(t) is a step function with ŜE(0) = 1 and ŜE(t) = ŜE(ti−1) for ti−1 ≤
t < ti. Note that

∑m
i=1 di = n.

4) Know how to compute and plot ŜE(t) given the t(i) or given the ti and
di. Use a table like the one below. Let a0 = n and ai =

∑n
k=1 I(Ti > ti) = #

of cases t(j) > ti for i = 1, ..., m. Then ŜE(ti) = ai/n =
∑n

k=1 I(Ti > ti)/n =

ŜE(ti−1) − di

n
.

ti di ŜE(ti) = ŜE(ti−1) − di

n

t0 = 0 ŜE(0) = 1 = n
n

= a0

n

t1 d1 ŜE(t1) = ŜE(t0) − d1

n
= a0−d1

n
= a1

n

t2 d2 ŜE(t2) = ŜE(t1) − d2

n
= a1−d2

n
= a2

n

...
...

...

tj dj ŜE(tj) = ŜE(tj−1) − dj

n
=

aj−1−dj

n
=

aj

n

...
...

...

tm−1 dm−1 ŜE(tm−1) = ŜE(tm−2) − dm−1

n
= am−2−dm−1

n
= am−1

n

tm dm ŜE(tm) = 0 = ŜE(tm−1) − dm

n
= am−1−dm

n
= am

n

5) Let t1 ≤ t < tm. Then the classical large sample 95% CI for S(tc)
based on ŜE(t) is

ŜE(tc) ± 1.96

√
ŜE(tc)[1 − ŜE(tc)]

n
= ŜE(tc) ± 1.96SE[ŜE(tc)].
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6) Let 0 < t. Let

p̃tc =
nŜE(tc) + 2

n+ 4
.

Then the plus four 95% CI for S(tc) based on ŜE(t) is

p̃tc ± 1.96

√
p̃tc [1 − p̃tc ]

n+ 4
= p̃tc ± 1.96SE[p̃tc ].

Let Yi = time to event for ith person. Ti = min(Yi, Zi) where Zi is the
censoring time for the ith person (the time the ith person is lost to the study
for any reason other than the time to event under study). The censored data
is y1, y2+, y3, ..., yn−1, yn+ where yi means the time was uncensored and yi+
means the time was censored. t(1) ≤ t(2) ≤ · · · ≤ t(n) are the ordered survival
times (so if y4+ is the smallest survival time, then t(1) = y4+). A status
variable will be 1 if the time was uncensored and 0 if censored.

Let [0,∞) = I1 ∪ I2 ∪ · · · ∪ Im = [t0, t1) ∪ [t1, t2) · · · ∪ [tm−1, tm) where
to = 0 and tm = ∞. It is possible that the 1st interval will have left endpoint
> 0 (t0 > 0) and the last interval will have finite right endpoint (tm < ∞).
Suppose that the following quantities are known: dj = # deaths in Ij,
cj = # of censored survival times in Ij,
nj = # at risk in Ij = # who were alive and not yet censored at the start of
Ij (at time tj−1).
Let n′

j = nj − cj

2
= average number at risk in Ij.

7) The lifetable estimator or actuarial method estimator of SY (t) takes
ŜL(0) = 1 and

ŜL(tk) =
k∏

j=1

n′
j − dj

n′
j

=
k∏

j=1

p̃j

for k = 1, ..., m − 1. If tm = ∞, ŜL(t) is undefined for t > tm−1. Suppose
tm �= ∞. Then take ŜL(t) = 0 for t ≥ tm if cm = 0. If cm > 0, then ŜL(t) is
undefined for t ≥ tm. To graph ŜL(t), use linear interpolation (connect the
dots). If n′

j = 0, take p̃j = 0. Note that

ŜL(tk) = ŜL(tk−1)
n′

k − dk

n′
k

for k = 1, ...,m− 1.

8) Know how to get the lifetable estimator and SE(ŜL(ti)) from output.
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(left output) (right output)

interval survival survival SE or interval survival survival SE

0 50 1.00 0 0 50 0.7594 0.0524

50 100 0.7594 0.0524 50 100 0.5889 0.0608

100 200 0.5889 0.0608 100 200 0.5253 0.0602

Since ŜL(0) = 1, ŜL(t) is for the left endpoint for the “left output,” and
for the right endpoint for the “right output.” For both cases, ŜL(50) = 0.7594
and SE(ŜL(50)) = 0.0524.

9) A 95% CI for SY (ti) based on the lifetable estimator is

ŜL(ti) ± 1.96 SE[ŜL(ti)].

10) Know how to compute ŜL(t) with a table like the one below. The
first 4 columns need to be given but the last 3 columns may need to be filled
in. On an exam you may be given a table with all but a few entries filled.

Ij, dj, cj, nj n′
j

n′
j−dj

n′
j

ŜL(t)

[t0 = 0, t1), d1, c1, n1 n1 − c1
2

n′
1−d1

n′
1

ŜL(to) = ŜL(0) = 1

[t1, t2), d2, c2, n2 n2 − c2
2

n′
2−d2

n′
2

ŜL(t1) = ŜL(t0)
n′

1−d1

n′
1

[t2, t3), d3, c3, n3 n3 − c3
2

n′
3−d3

n′
3

ŜL(t2) = ŜL(t1)
n′

2−d2

n′
2

...
...

...
...

[tk−1, tk), dk, ck, nk nk − ck

2

n′
k−dk

n′
k

ŜL(tk−1) =

ŜL(tk−2)
n′

k−1−dk−1

n′
k−1

...
...

...
...

[tm−2, tm−1), dm−1, cm−1, nm−1 nm−1 − cm−1

2

n′
m−1−dm−1

n′
m−1

ŜL(tm−2) =

ŜL(tm−3)
n′

m−2−dm−2

n′
m−2

[tm−1, tm = ∞), dm, cm, nm nm − cm

2
n′

m−dm

n′
m

ŜL(tm−1) =

ŜL(tm−2)
n′

m−1−dm−1

n′
m−1

11) Also get a 95% CI from output like that below. So the 95% CI for
S(50) is (0.65666,0.86213).
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time survival SDF_LCL SDF_UCL

0 1.0 1.0 1.0

50 0.7594 0.65666 0.86213

Let Y ∗
i = Ti = min(Yi, Zi) where Yi and Zi are independent. Let δi =

I(Yi ≤ Zi) so δi = 1 if Ti is uncensored and δi = 0 if Ti is censored. Let
t(1) ≤ t(2) ≤ · · · ≤ t(n) be the observed ordered survival times. Let γj = 1 if
t(j) is uncensored and 0, otherwise. Let t0 = 0 and let 0 < t1 < t2 < · · · < tm
be the distinct survival times corresponding to the t(j) with γj = 1. Let di =
number of deaths at time ti. If m = n and di = 1 for i = 1, ..., n then there
are no ties. If m < n and some di ≥ 2, then there are ties.

12) Let ni =
∑n

j=1 I(t(j) ≥ ti) = # at risk at ti = # alive and not yet
censored just before ti. Let di = # of events (deaths) at ti. The Kaplan
Meier estimator = product limit estimator of SY (ti) = P (Y > ti) is
ŜK(0) = 1 and ŜK(ti) =

∏i
k=1(1 − dk

nk
) = ŜK(ti−1)(1 − di

ni
). ŜK(t) is a step

function with ŜK(t) = ŜK(ti−1) for ti−1 ≤ t < ti and i = 1, ..., m. If t(n) is

uncensored then tm = t(n) and ŜK(t) = 0 for t > tm. If t(n) is censored, then

ŜK(t) = ŜK(tm) for tm ≤ t ≤ t(n), but ŜK(t) is undefined for t > t(n).

13) Know how to compute and plot Ŝk(ti) given the t(j) and γj or given
the ti, ni and di. Use a table like the one below.

ti ni di ŜK(t)

t0 = 0 ŜK(0) = 1

t1 n1 d1 ŜK(t1) = ŜK(t0)[1 − d1

n1
]

t2 n2 d2 ŜK(t2) = ŜK(t1)[1 − d2

n2
]

...
...

...
...

tj nj dj ŜK(tj) = ŜK(tj−1)[1 − dj

nj
]

...
...

...
...

tm−1 nm−1 dm−1 ŜK(tm−1) = ŜK(tm−2)[1 − dm−1

nm−1
]

tm nm dm ŜK(tm) = 0 = ŜK(tm−1)[1 − dm

nm
]
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14) Know how to find a 95% CI for SY (ti) based on ŜK(ti) using out-
put: the 95% CI is ŜK(ti) ± 1.96 SE[ŜK(ti)]. The R output below gives
ti, ni, di, ŜK(ti), SE(ŜK(ti)) and the 95% CI for SY (36) is (0.7782, 1).

time n.risk n.event survival std.err lower 95% CI upper 95% CI

36 13 1 0.923 0.0739 0.7782 1.000

15) In general, a 95% CI for SY (ti) is Ŝ(ti) ± 1.96 SE[Ŝ(ti)]. If the lower
endpoint of the CI is negative, round it up to 0. If the upper endpoint of the
CI is greater than 1, round it down to 1. Do not use impossible values
of SY (t).

16) Let P (Y ≤ t(p)) = p for 0 < p < 1. Be able to get t(p) and 95% CIs
for t(p) from SAS output for p = 0.25, 0.5, 0.75. For the output below, the
CI for t(0.75) is not given. The 95% CI for t(0.50) ≈ 210 is (63,1296). The
95% CI for t(0.25) ≈ 63 is (18,195).

Quartile estimates

Percent point estimate lower upper

75 . 220.0 .

50 210.00 63.00 1296.00

25 63.00 18.00 195.00

17) R plots the KM survival estimator along with the pointwise 95% CIs
for SY (t). If we guess a distribution for Y , say Y ∼ W, with a formula for
SW (t), then the guessed SW (ti) can be added to the plot. If roughly 95%
of the SW (ti) fall within the bands, then Y ∼ W may be reasonable. For
example, if W ∼ EXP (1), use SW (t) = exp(−t). If W ∼ EXP (λ), then
SW (t) = exp(−λt). Recall that E(W ) = 1/λ.

18) If limt→∞ tSY (t) → 0, then E(Y ) =
∫∞

0
tfY (t)dt =

∫∞
0
SY (t)dt. Hence

an estimate of the mean Ê(Y ) can be obtained from the area under Ŝ(t).

19) The Cox proportional hazards regression (PH) model is

hi(t) = hYi|xi
(t) = h

Yi|β
T xi

(t) = exp(βTxi)h0(t)

where h0(t) is the unknown baseline function and exp(βT xi) is the haz-
ard ratio.

For now, assume that the PH model is appropriate, although
this assumption should be checked before performing inference.
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20) The sufficient predictor SP = βT xj =
∑p

i=1 βixij.

variable Est. SE Est./SE or (Est/SE)2 pvalue for

x1 β̂1 se(β̂1) zo,1 = β̂1/se(β̂1) X2
o,1 = z2

o,1 Ho β1 = 0
...

...
...

...
...

...

xp β̂p se(β̂p) zo,p = β̂p/se(β̂p) X2
o,p = z2

o,p Ho βp = 0

SAS Wald pr >

variable df Estimate SE chi square chisqu

age 1 0.1615 0.0499 10.4652 0.0012

ecog.ps 1 0.0187 0.5991 0.00097 0.9800

R coef exp(coef) se(coef) z p

age 0.1615 1.18 0.0499 3.2350 0.0012

ecog.ps 0.0187 1.02 0.5991 0.0312 0.9800

Likelihood ratio test=14.3 on 2 df, p=0.000787 n= 26

Shown above is output in symbols from and SAS and R. The estimated
coefficient is β̂j. The Wald chi square = X2

o,j while p and “pr > chisqu” are
both p-values.

21) The estimated sufficient predictor ESP = β̂
T
xj =

∑p
i=1 β̂ixij. Given

β̂ from output and given x, be able to find ESP and ĥi(t) = exp(ESP )ĥ0(t) =

exp(β̂
T
x)ĥo(t) where exp(β̂

′
x) is the estimated hazard ratio.

For tests, the p–value is an important quantity. Recall that Ho is rejected
if the p–value < δ. A p–value between 0.07 and 1.0 provides little evidence
that Ho should be rejected, a p–value between 0.01 and 0.07 provides moder-
ate evidence and a p–value less than 0.01 provides strong statistical evidence
that Ho should be rejected. Statistical evidence is not necessarily practical
evidence, and reporting the p–value along with a statement of the strength
of the evidence is more informative than stating that the p–value is less
than some chosen value such as δ = 0.05. Nevertheless, as a homework
convention, use δ = 0.05 if δ is not given.

22) The Wald confidence interval (CI) for βj can also be obtained from
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the output: the large sample 95% CI for βj is

β̂j ± 1.96 se(β̂j).

23) Investigators also sometimes test whether a predictor Xj is needed in
the model given that the other k − 1 nontrivial predictors are in the model
with a 4 step Wald test of hypotheses:
i) State the hypotheses Ho: βj = 0 Ha: βj �= 0.

ii) Find the test statistic zo,j = β̂j/se(β̂j) or X2
o,j = z2

o,j or obtain it from
output.

iii) The p–value = 2P (Z < −|zoj|) = P (χ2
1 > X2

o,j). Find the p–value from
output or use the standard normal table.
iv) State whether you reject Ho or fail to reject Ho and give a nontechnical
sentence restating your conclusion in terms of the story problem.

If Ho is rejected, then conclude that Xj is needed in the PH survival
model given that the other p − 1 predictors are in the model. If you fail
to reject Ho, then conclude that Xj is not needed in the PH survival model
given that the other p−1 predictors are in the model. Note that Xj could be
a very useful PH survival predictor, but may not be needed if other predictors
are added to the model.

For a PH, often 3 models are of interest: the full model that uses all p of
the predictors xT = (xT

R,x
T
O), the reduced model that uses the r predictors

xR, and the null model that uses none of the predictors.
The partial likelihood ratio test (PLRT) is used to test whether β = 0.

If this is the case, then the predictors are not needed in the PH model (so
survival times Y x). If Ho : β = 0 is not rejected, then the Kaplan Meier
estimator should be used. If Ho is rejected, use the PH model.

24) The 4 step PLRT is
i) Ho : β = 0 HA : β �= 0
ii) test statistic X2(N |F ) = [−2 logL(none)] − [−2 logL(full)] is often

obtained from output
iii) The p–value = P (χ2

p > X2(N |F )) where χ2
p has a chi–square distribu-

tion with p degrees of freedom. The p–value is often obtained from output.
iv) Reject Ho if the p–value < δ and conclude that there is a PH survival

relationship between Y and the predictors x. If p–value ≥ δ, then fail to
reject Ho and conclude that there is not a PH survival relationship between
Y and the predictors x.



CHAPTER 16. SURVIVAL ANALYSIS 529

Some SAS output for the PLRT is shown next. R output is above 20).

SAS Testing Global Null Hypotheses: BETA = 0

without with

criterion covariates covariates model Chi-square

-2 LOG L 596.651 551.1888 45.463 with 3 DF (p=0.0001)

Let the full model be

SP = β1x1 + · · · + βpxp = βT x = α + βT
RxR + βT

OxO.

let the reduced model

SP = βR1xR1 + · · · + βRrxRr = βT
RxR

where the reduced model uses r of the predictors used by the full model and
xO denotes the vector of p− r predictors that are in the full model but not
the reduced model.

Assume that the full model is useful. Then we want to test Ho: the
reduced model is good (can be used instead of the full model, so xO is not
needed in the model given xR is in the model) versus HA: use the full model
(the full model is significantly better than the reduced model). Fit the full
model and the reduced model to get X2(N |F ) and X2(N |R) where X2(N |F )
is used in the PLRT to test whether β = 0 and X2(N |R) is used in the
PLRT to test whether βR = 0 (treating the reduced model as the model in
the PLRT).

variable Est. SE Est/SE or (Est/SE)2 pvalue for

x1 β̂1 se(β̂1) zo,1 = β̂1/se(β̂1) X2
o,1 = z2

o,1 Ho β1 = 0
...

...
...

...
...

...

xp β̂p se(β̂p) zo,p = β̂p/se(β̂p) X2
o,p = z2

o,p Ho βp = 0

R: Likelihood ratio test = X2(N |F ) on p df

SAS: Testing Global Null Hypotheses: BETA = 0

Test Chi-Square DF Pr > Chisq
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Likelihood ratio X2(N |F ) p pval for Ho: β = 0

variable Est. SE Est/SE or (Est/SE)2 pvalue for

x1 β̂1 se(β̂1) zo,1 = β̂1/se(β̂1) X2
o,1 = z2

o,1 Ho: β1 = 0
...

...
...

...
...

...

xr β̂r se(β̂r) zo,r = β̂r/se(β̂r) X2
o,r = z2

o,r Ho: βr = 0

R: Likelihood ratio test = X2(N |R) on r df

SAS: Testing Global Null Hypotheses: BETA = 0

Test Chi-Square DF Pr > Chisq

Likelihood ratio X2(N |R) r pval for Ho: βR = 0

The output shown above in symbols, can be used to perform the change
in PLR test. For simplicity, the reduced model used in the output is xR =
(x1, ..., xr)

T .

Notice that X2(R|F ) ≡ X2(N |F ) −X2(N |R) =

[−2 logL(none)] − [−2 logL(full)] − ([−2 logL(none)] − [−2 logL(red)]) =

[−2 logL(red)] − [−2 logL(full)] = −2 log

(
L(red)

L(full)

)
.

25) The 4 step change in PLR test is
i) Ho: the reduced model is good HA: use the full model
ii) test statistic X2(R|F ) = X2(N |F ) − X2(N |R) = [−2 logL(red)] −

[−2 logL(full)]
iii) The p–value = P (χ2

p−r > X2(R|F )) where χ2
p−r has a chi–square

distribution with p− r degrees of freedom.
iv) Reject Ho if the p–value < δ and conclude that the full model should

be used. If p–value ≥ δ, then fail to reject Ho and conclude that the reduced
model is good.

If the reduced model leaves out a single variable xi, then the change in
PLR test becomes Ho : βi = 0 versus HA : βi �= 0. This change in partial
likelihood ratio test is a competitor of the Wald test. The change in PLRT
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is usually better than the Wald test if the sample size n is not large, but
the Wald test is currently easier for software to produce. For large n the
test statistics from the two tests tend to be very similar (asymptotically
equivalent tests).

26) If the reduced model is good, then the EE plot of ESP (R) = β̂
T

RxRi

versus ESP = β̂
T
xi should be highly correlated with the identity line with

unit slope and zero intercept.

A factor A is a variable that takes on a categories called levels. Suppose
A has a categories c1, ..., ca. Then the factor is incorporated into the PH
model by using a − 1 indicator variables xjA = 1 if A = cj and xAj = 0
otherwise, where the 1st indicator variable is omitted, eg, use x2A, ..., xaA.
Each indicator has 1 degree of freedom. Hence the degrees of freedom of the
a− 1 indicator variables associated with the factor is a− 1.

The xj corresponding to variates (variables that take on numerical values)
or to indicator variables from a factor are called main effects.

An interaction is a product of two or more main effects, but for a factor
include products for all indicator variables of the factor.

If an interaction is in the model, also include the corresponding main
effects. For example, if x1x3 is in the model, also include the main effects x1

and x2.
A scatterplot is a plot of xi vs. xj. A scatterplot matrix is an

array of scatterplots. It is used to examine the marginal relationships of the
predictors. Variables with outliers, missing values or strong nonlinearities
may be so bad that they should not be included in the full model.

27) Suppose that all values of the variable x are positive. The log rule
says add log(x) to the full model if max(xi)/min(xi) > 10.

Variable selection is closely related to the change in PLR test for a
reduced model. You are seeking a subset I of the variables to keep in the
model. The AIC(I) statistic is used as an aid in backward elimination and
forward selection. The full model and the model with the smallest AIC are
always of interest. Create a full model. The full model has a −2 log(L) at
least as small as that of any submodel. The full model is a submodel.

Backward elimination starts with the full model with p variables and
the predictor that optimizes some criterion is deleted. Then there are p− 1
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variables left and the predictor that optimizes some criterion is deleted. This
process continues for models with p− 2, p− 3, ..., 3 and 2 predictors.

Forward selection starts with the model with 0 variables and the pre-
dictor that optimizes some criterion is added. Then there is p variable in
the model and the predictor that optimizes some criterion is added. This
process continues for models with 2, 3, ..., p− 2 and p − 1 predictors. Both
forward selection and backward elimination result in a sequence of p models
{x∗1}, {x∗1, x∗2}, ..., {x∗1, x∗2, ..., x∗p−1}, {x∗1, x∗2, ..., x∗p} = full model.

Consider models I with rI predictors. Often the criterion is the minimum
value of −2 log(L(β̂I)) or the minimum AIC(I) = −2 log(L(β̂I)) + 2rI .

Heuristically, backward elimination tries to delete the variable that will
increase the −2 log(L) the least. An increase in −2 log(L) greater than 4
(if the predictor has 1 degree of freedom) may be troubling in that a good
predictor may have been deleted. In practice, the backward elimination
program may delete the variable such that the submodel I with k predictors
has 1) the smallest AIC(I), 2) the smallest −2 log(L(β̂I)) or 3) the biggest
p–value (preferably from a change in PLR test but possibly from a Wald
test) in the test Ho βi = 0 versus HA βi �= 0 where the current model with
k + 1 variables is treated as the full model.

Heuristically, forward selection tries to add the variable that will decrease
the −2 log(L) the most. An decrease in −2 log(L) less than 4 (if the predictor
has 1 degree of freedom) may be troubling in that a bad predictor may have
been added. In practice, the forward selection program may add the variable
such that the submodel I with k predictors has 1) the smallest AIC(I), 2) the
smallest −2 log(L(β̂I)) or 3) the smallest p–value (preferably from a change
in PLR test but possibly from a Wald test) in the test Ho βi = 0 versus
HAβi �= 0 where the current model with k − 1 terms plus the predictor xi is
treated as the full model (for all variables xi not yet in the model).

28) If an interaction (eg x3x7x9) is in the submodel, then the main effects
(x3, x7, and x9) should be in the submodel.

29) If xi+1, xi+2, ..., xi+a−1 are the a − 1 indictor variables corresponding
to factor A, submodel I should either contain none or all of the a−1 indictor
variables.
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30) Given a list of submodels along with the number of predictors and
AIC, be able to find the “best starting submodel” Io. Let Imin be the min-
imum AIC model. Then Io is the submodel with the fewest predictors such
that AIC(Io) ≤ AIC(Imin) + 2 (for a given number of predictors rI , only
consider the submodel with the smallest AIC). Also look at models Ij with
fewer predictors than Io such that AIC(Ij) ≤ AIC(Imin) + 7.

31) Submodels I with more predictors than Imin should not be used.

32) Submodels I with AIC(I) > AIC(Imin) + 7 should not be used.

33) Let the survival times Ti = min(Yi, Zi), and let γi = 1 if Ti = Yi

(uncensored) and γi = 0 if Ti = Zi (censored). For PH models, an censored
response plot is a plot of the ESP vs T with plotting symbol 0 for censored
cases and + for uncensored cases. If the ESP is a good estimator of the SP
and hSP (t) = exp(SP )h0(t), then the hazard increases and survival decreases
as the ESP increases.

34) The slice survival plot divides the ESP into J groups of roughly the
same size. For each group j, ŜPHj(t) is computed using the x corresponding
to the largest ESP in the 1st J − 1 groups and the x corresponding to the
smallest ESP in the Jth group. The Kaplan Meier estimator ŜKMj(t) is

computed from the survival times in the jth group. For each group, ŜPHj(t)

is plotted and ŜKMj(ti) as circles at the deaths ti. The proportional hazards
assumption is reasonable if the circles track the curve well in each of the J
plots. If pointwise CI bands are added to the plot, then ŜKMj tracks ŜPHj

well if most of the plotted circles do not fall very far outside the pointwise
CI bands.

35) Assume n > 5p, that the full PH model is reasonable and all predictors
are equally important. The following rules of thumb for a good PH submodel
I are in roughly decreasing order of importance.
i) Do not use more predictors than the min AIC model Imin.
ii) The slice survival plots for I looks like the slice survival plot for the full
model.
iii) corr(ESP,ESP(I))≥ 0.95.
iv) The plotted points in the EE plot of ESP(I) vs ESP cluster tightly about
the identity line.
v) Want pvalue ≥ 0.01 for the change in PLR test that uses I as the reduced
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model. (So for variable selection use δ = 0.01 instead of δ = 0.05.)
vi) Want the number of predictors rI ≤ n/10.
vii) Want −2 log(L(β̂I)) ≥ −2 log(L(β̂full)) but close.
viii) Want AIC(I) ≤ AIC(Imin) + 7.
ix) Want hardly any predictors with pvalues > 0.05.
x) Want few predictors with pvalues between 0.01 and 0.05.

But for factors with a− 1 indicators, modify ix) and x) so that the indi-
cator with the smallest pvalue is examined.

36) Suppose that the full model is good and is stored in M1. Let M2, M3,
M4, and M5 be candidate submodels found after forward selection, backward
elimination, etc. Typically one of the submodels is the min(AIC) model.
Given a list of properties of each submodel, be able to pick out the “best
starting submodel.”
Tips: i) submodels with more predictors then the min(AIC) submodel have
too many predictors.
ii) The best starting submodel Io has AIC(Io) ≤ AIC(Imin) + 2.
iii) Submodels I with AIC(I) > AIC(Imin) + 2 are not the best starting
submodel.
iv) Submodels I with a pvalue < 0.01 for the change in PLR test have too
few predictors.
v) The full model may be the best starting submodel if it is the min(AIC)
model and M2–M5 satisfy iii). Similarly, then min(AIC) model may be the
best starting submodel.

37) In addition to the best starting submodel Io, submodels I with fewer
predictors than Io and AIC(I) ≤ AIC(Imin) + 7 are worth considering.

If there are important predictors such as treatment that must be in the
submodel, either force the variable selection procedures to contain the im-
portant predictors or do variable selection on the less important predictors
and then add the important predictors to the submodel.

38) Suppose the PH model contains x1, ..., xp. Leave out xj, find the
martingale residuals rm(j), plot xj vs rm(j) and add the lowess or loess curve.
If the curve is linear then xj has the correct functional form. If the curve looks
like t(xj) (eg (xj)

2), then replace xj by t(xj), find the martingale residuals,
plot t(xj) vs the residuals and check that the loess curve is linear.
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39) Let the scaled Schoenfeld residual for the jth variable xj be r∗pj + β̂j.
Plot the death times ti vs the scaled residuals and add the loess curve. If the
loess curve is approximately horizontal for each of the p plots, then the PH
assumption is reasonable. Alternatively, fit a line to each plot and test that
each of the p slopes is equal to 0. The R function cox.zph makes both the
plots and tests.

40) The Weibull proportional hazards regression (WPH) model
is

hi(t) = hYi|xi
(t) = h

Yi|β
T

Pxi
(t) = exp(βT

Pxi)h0(t)

where h0(t) = h0(t|θ) = λγtγ−1 is the baseline function. So Y |SP ∼
W (γ, λ0 exp(SP ), ).

Assume that the WPH model is appropriate.

For SAS only.
log likelihood log L(none)

variable Est. SE Est/SE or (Est/SE)2 pvalue
intercept

scale
Weibull shape

For SAS or R

variable Est. SE Est/SE or (Est/SE)2 pvalue for
intercept

x1 β̂1 se(β̂1) zo,1 = β̂1/se(β̂1) X2
o,1 = z2

o,1 Ho: β1 = 0
...

...
...

...
...

xp β̂p se(β̂p) zo,p = β̂p/se(β̂p) X2
o,p = z2

o,p Ho: βp = 0
scale or log scale

Weibull shape or scale
For the full model, SAS will have Log Likelihood = log L(full).
For the full model, R will have log L(full), log L (none) and

chisq = [-2 log L(none)] - [-2 log L(full)] on p degrees of freedom with pvalue

Replace full by reduced for the reduced model.
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The SAS and R log likelihood, log L, differ by a constant.

SAS Log Likelihood = -29.7672 null model

variable df Estimate SE chi square pr > chisqu

intercept 1 7.1110 0.2927 590.12 < 0.0001

Weibull Scale 1 1225.4 358.7

Weibull Shape 1 1.1081 0.2810

SAS Log Likelihood = -29.1775 reduced model

variable df Estimate SE chi square pr > chisqu

intercept 1 7.3838 0.4370 285.45 < 0.0001

treat 1 -0.5593 0.5292 1.12 0.2906

Scale 1 0.8857 0.2227

Weibull Shape 1 1.1291 0.2840

SAS Log Likelihood = -20.5631 full model

variable df Estimate SE chi square pr > chisqu

intercept 1 11.5483 1.1970 93.07 < 0.0001

age 1 -0.0790 0.0198 15.97 < 0.0001

treat 1 -0.5615 0.3399 2.73 0.0986

Scale 1 0.5489 0.1291

Weibull Shape 1 1.8218 0.4286

R reduced model Value Std. Error z p

(Intercept) 7.384 0.437 16.895 4.87e-64

treat -0.559 0.529 -1.057 2.91e-01

Log(scale) -0.121 0.251 -0.483 6.29e-01

Scale= 0.886

Loglik(model)= -97.4 Loglik(intercept only)= -98

Chisq= 1.18 on 1 degrees of freedom, p= 0.28

R full model Value Std. Error z p

(Intercept) 11.548 1.1970 9.65 5.04e-22

treat -0.561 0.3399 -1.65 9.86e-02

age -0.079 0.0198 -4.00 6.43e-05

Log(scale) -0.600 0.2353 -2.55 1.08e-02
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Scale= 0.549

Loglik(model)= -88.7 Loglik(intercept only)= -98

Chisq= 18.41 on 2 degrees of freedom, p= 1e-04

Shown above is output in symbols from and SAS and R . The estimated
coefficient is β̂j. The Wald chi square = X2

o,j while p and “pr > chisqu” are
both p-values.

41) Instead of fitting the WHP model of 40), R and SAS fit an accelerated
failure time model log(Yi) = α+ β′xi + σεi where Var(εi) = 1 and the εi are
iid from a smallest extreme value distribution. Also β �= βW from 40).

α̂ and β̂ are MLEs found from the censored data (Ti, δi,xi) not from
(Yi,xi).

42) Let log(Ti) = α̂+ β̂
T

Axi + ri. A log censored response (LCR) plot is a

plot of α̂+ β̂
T

Axi vs log(Ti) with plotting symbol 0 for censored cases and +
for uncensored cases. The vertical deviations from the identity line = ri. The
least squares line based on the +’s can be added to the plot, and should have
slope not too far from 1 for the Weibull AFT if γ ≥ 1. The plotted points
should be linear with roughly constant variance. The censoring and long left
tails of the smallest extreme value distribution make judging linearity and
detecting outliers from the left tail difficult. Try to ignore the bottom of the
plot where there are few cases when assessing linearity.

43) Given β̂ from output and given x, be able to find ESP = β̂
′
x =∑p

i=1 β̂ixi = β̂1x1 + · · · + β̂pxp.

44) A large sample 95% CI for βj is β̂j ± 1.96 se(β̂j).

45) 4 step Wald test of hypotheses:
i) State the hypotheses Ho: βj = 0 Ha: βj �= 0.

ii) Find the test statistic zo,j = β̂j/se(β̂j) or X2
o,j = z2

o,j or obtain it from
output.

iii) The p–value = 2P (Z < −|zoj|) = P (χ2
1 > X2

o,j). Find the p–value from
output or use the standard normal table.
iv) If pval < δ, reject Ho and conclude that Xj is needed in the Weibull
survival model given that the other p − 1 predictors are in the model. If
pval ≥ δ, fail to reject Ho and conclude that Xj is not needed in the Weibull
survival model given that the other p− 1 predictors are in the model.

46) The 4 step likelihood ratio test LRT is
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i) Ho : β = 0 HA : β �= 0
ii) test statistic X2(N |F ) = [−2 logL(none)] − [−2 logL(full)] is often

obtained from output
iii) The p–value = P (χ2

p > X2(N |F )) where χ2
p has a chi–square distribu-

tion with p degrees of freedom. The p–value is often obtained from output.
iv) Reject Ho if the p–value < δ and conclude that there is a WPH

survival relationship between Y and the predictors x. If p–value ≥ δ, then
fail to reject Ho and conclude that there is not a WPH survival relationship
between Y and the predictors x.

47) The 4 step change in LR test is
i) Ho: the reduced model is good HA: use the full model
ii) test statistic X2(R|F ) = X2(N |F ) − X2(N |R) = [−2 logL(red)] −

[−2 logL(full)]
iii) The p–value = P (χ2

p−r > X2(R|F )) where χ2
p−r has a chi–square

distribution with p− r degrees of freedom.
iv) Reject Ho if the p–value < δ and conclude that the full model should

be used. If p–value ≥ δ, then fail to reject Ho and conclude that the reduced
model is good.

48) R and SAS programs do not have a variable selection option, but the
WPH model is a PH model, so use SAS Cox PH variable selection to suggest
good submodels. Then fit each candidate with WPH software and check the
WPH assumptions.

49) The accelerated failure time (AFT) model has log(Yi) = α +
βT

Axi + σei where the ei are iid from a location scale family.

If the Yi are Weibull, the ei are from a smallest extreme value distribution.
The Weibull regression model is often said to be “both a proportional hazards
model and an accelerated failure time model.” Actually the Yi follow a PH
models and the log(Yi) follow an AFT model.

If the Yi are lognormal, the ei are normal.
If the Yi are loglogistic, the ei are logistic.

50) Still use the log censored response (LCR) plot of 42). The LCR plot
is easier to use when the εi are normal or logistic since these are symmetric
distributions.

51) For the AFT model, hi(t) = e−SPho(t/e
SP ) and Si(t) = S0(t/ exp(SP )).
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52) Inference for the AFT model is performed exactly in the same way as
for the WPH = Weibull AFT. See points 43) – 47). But the conclusion change
slightly if the AFT is not the Weibull AFT. In point 45, change (if necessary)
“Weibull survival model” to the appropriate model, eg “lognormal survival
model”. In point 46, change (if necessary) “WPH” to the appropriate model,
eg “lognormal AFT”.

In principle, the slice survival plot can be made for parametric AFT
models, but the programming may be difficult.

The loglogistic and lognormal AFT models are not PH models. The
loglogistic AFT is a proportional odds model.

53) Let βC correspond to the Cox regression and βA correspond to the
AFT. An EE plot is a plot of the parametric ESP vs a semiparamtric ESP
with the identity line added as a visual aid. The plotted points should follow
the identity line with a correlation tending to 1.0 as n→ ∞.

54) For the Exponential regression model, σ = 1, and βC = −βA. The

Exponential EE plot is a plot of −ESPE = −β̂
′
Ax vs ESPC = β̂

′
Cx.

55) For the Weibull regression model, σ = 1, and βC = −βA/σ. The
Weibull EE plot is a plot of

−ESPW/σ̂ = − 1

σ̂
β̂

′
Ax vs ESPC = β̂

′
Cx.

56) The stratified proportional hazards regression (SPH) model
is

hx,j(t) = hYi|x,j(t) = h
Yi|β

′
xi

(t) = exp(β′xi)h0,j(t)

where h0,j(t) is the unknown baseline function for the jth stratum, j =
1, ..., J where J ≥ 2.

A SPH model is not a PH model, but a PH model is fit to each of the
J strata. The same β is used for each group = stratum, but the baseline
hazard functions differ. Stratification can be useful if there are clusters of
cases such that the observations within the clusters are not independent. A
common example is the variable study sites and the stratification should be
on site. Sometimes stratification is done on a categorical variable such as
gender.

57) Inference is done exactly as for the PH model. See points 21), 22),
23), 24), and 25). Except the conclusion is changed slightly: in 23) and 24)
replace “PH” by “SPH”.
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16.7 Complements

Excellent texts on survival analysis include Allison (1995), Collett (2003),
Klein and Moeschberger (1998), Kleinbaum and Klein (2005b), Hosmer and
Lemeshow (1999) and Smith (2002). Graduate level texts include Kalbfleisch
and Prentice (2002) and Lawless (2002). A review is given by Freedman
(2008). Oakes (2000) notes that the proportional hazards model is not pre-
served when variables are added or deleted from the model, eg by variable
selection.

From the CRAN website, eg (www.stathy.com/cran/), click on packages,
then survival, then survival.pdf to obtain the R reference manual on the
survival package. Much of this material is also in MathSoft (1999b, Ch.
8–13).

For SAS, see the SAS/STAT User’s Guide (1999). The chapters on
PHREG, LIFEREG and LIFETEST procedures are useful. These chapters
can be found on line at (www.google.com) with a search of the keywords
SAS/STAT User’s Guide.

The most used survival regression models satisfy Y x|SP , and the slice
survival plot is useful for visualizing SY |SP (t) in the background of the data.
Simultaneous or pointwise CI bands are needed to determine whether the
nonparametric Kaplan Meier estimator is close to the model estimator. If
the two estimators are close for each slice, then the graph suggests that the
model is giving a useful approximation to SY |SP (t) for the observed data if
the number of uncensored cases is large compared to the number of predictors
p. The plots are also useful for teaching survival regression to students and
for explaining the models to consulting clients.

The slice survival and EE plots are due to Olive (2009c). Emphasis was
on proportional hazards models since pointwise CI bands are available for
the Cox proportional hazards model. Thus the slice survival plot can be
made for the Cox model, and then the estimated survival function from
a parametric proportional hazards model can be added as crosses for each
slice if points in the EE plot cluster tightly about the identity line. Stratified
proportional hazards models can be checked by making one slice survival plot
per stratum. EE plots can be made for parametric models if software for a
semiparametric analog is available. See Bennett (1983), Yang and Prentice
(1999), Wei (1992) and Zeng and Lin (2007).

The censored response plot and LCR plot can be regarded as special cases
of the model checking plots of Cook and Weisberg (1997) applied to censored
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data.
If pointwise bands are not available for the parametric or semiparametric

model, but the number of cases in each slice is large, then simultaneous or
pointwise CI bands for the Kaplan Meier estimator could be added for each
slice.

Plots were made in R and the function coxph produces the survival
curves for Cox regression. The collection of R functions regpack available
from (www.math.siu.edu/olive/regpack.txt) contains functions for reproduc-
ing simulations and some of the plots. The functions vlung2, vovar and
vnwtco were used to produce plots in Examples 1, 2 and 3. The function
bphsim3 shows that the Kaplan Meier estimator was close to the Cox sur-
vival curves for 2 groups (a single binary predictor) when censoring was light
and n = 10.

Zhou (2001) shows how to simulate Cox proportional hazards regression
data. Simulated Weibull proportional hazards regression data was made
following Zhou (2001) but with three iid N(0,1) covariates. The function
phsim5 showed that for 9 groups and p = 3, the Kaplan Meier and Cox
curves were close (with respect to the pointwise CI bands) for n ≥ 80. The
function wphsim showed a similar result for Kaplan Meier curves (circles),
and the function wregsim2 shows that for n ≥ 30, the plotted points in an
EE plot cluster tightly about the identity line with correlation greater than
0.99 with high probability.

16.8 Problems

Problems with an asterisk * are especially important.

16.1. Suppose H(t) =
λ

θ
[eθt − 1] for t > 0 where λ > 0 and θ > 0. Find

a)h(t), b)S(t), c) F (t) and d) f(t) for t > 0.

16.2. Suppose T ∼ EXP(λ). Show P (T > t+ s|T > s) = P (T > t) for
any t > 0 and s > 0. This property is known as the memoryless property
and implies that the future survival of the product does not depend on the
past if the lifetime T of the product is exponential.

16.3. Suppose F (t) = 1− exp[−at− (bt)2] where a > 0, b > 0 and t > 0.
Find a)S(t), b)f(t), c) h(t) and d) H(t) for t > 0.

16.4. Suppose F (t) = 1− exp[−at− (ct)3] where a > 0, c > 0 and t > 0.
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Find the following quantities for t > 0.

a) S(t)

b)f(t)

c) h(t)

d) H(t)

16.5. Suppose H(t) = α+ βt2 for t > 0 where α > 0 and β > 0.

a) Find h(t).

b) Find S(t).

c) Find F (t).

16.6. Suppose

F (t) = 1 − exp

(−t2
2σ2

)
where σ > 0 and t > 0. Find the following quantities for t > 0.

a) S(t)

b)f(t)

c) h(t)

d) H(t)

16.7. Eleven death times from Collett (2003, p. 16) are given below.
The patients had malignant bone tumours.

11 13 13 13 13 13 14 14 15 15 17

a) Following Example 16.3, make a table with headers
t(j), ti, di, ŜE(t) =

∑
(Ti > t)/n.

b) Plot ŜE(t).

c) Find the 95% classical CI for S(13) based on ŜE(t).

d) Find the 95% plus four CI for S(13) based on ŜE(t).

16.8. Find the 95% classical CI for SY (32) if n = 9 and ŜE(32) = 4/9.

16.9. Find the 95% plus four CI for SY (32) if n = 9 and ŜE(32) = 4/9.

16.10. Find the 95% plus four CI for SY (32) if n = 9 and ŜE(32) = 6/9.

16.11. Find the 95% classical CI for SY (32) if n = 9 and ŜE(32) = 6/9.
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16.12. Survival times for nine electrical components are given below.
8, 8, 23, 32, 32, 46, 57, 88, 109
Compute the empirical survival function ŜE(ti) by filling in the table below.
Then plot the function.

t(j) ti di ŜE(t)

t0 = 0 ŜE(0) = 1 = 9
9

8

8 8 2 ŜE(8) =

23 ŜE(23) =

32

32 ŜE(32) =

46 ŜE(46) =

57 ŜE(57) =

88 ŜE(88) =

109 ŜE(109) =
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16.13. The Klein and Moeschberger (1997, p. 141-142) data set consists
of information from 927 1st born children to mothers who chose to breast
feed their child. The event was time in weeks until weaned (instead of death).
Complete the following table used to produce the lifetable estimator (on a
separate sheet of paper).

Ij dj cj nj n′
j

n′
j−dj

n′
j

ŜL(t)

[0, 2) 77 2 927 926 0.9168 1.0000
[2, 3) 71 3 848 846.5 0.9161 0.9168
[3, 5) 119 6 774 771 0.8457 0.8399
[5, 7) 75 9 649 644.5 0.8836 0.7103
[7, 11) 109 7 565 561.5 0.8059 0.6276
[11, 17) 148 5 449 446.5 0.6685 0.5058
[17, 25) 107 3 296 0.3381
[25, 37) 74 0 186
[37, 53) 85 0 112
[53,∞) 27 0 27

time n.risk n.event survival std.err lower 95% CI upper 95% CI

9 11 1 0.909 0.0867 0.7392 1.000

13 10 1 0.818 0.1163 0.5903 1.000

18 8 1 0.716 0.1397 0.4422 0.990

23 7 1 0.614 0.1526 0.3145 0.913

31 5 1 0.491 0.1642 0.1691 0.813

34 4 1 0.368 0.1627 0.0494 0.687

48 2 1 0.184 0.1535 0.0000 0.485

16.14. The length of times of remission (time until relapse) in acute
myelogeneous leukemia under maintenance chemotherapy for 11 patients is
9, 13, 13+, 18, 23, 28+, 31, 34, 45+, 48, 161+. See Miller (1981, p. 49). From
the output above what is the 95% CI for SY (34)?
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16.15. The Lindsey (2004, p. 280) data set is for survival times for 110
women with stage 1 cervical cancer studied over a 10 year period. Use the life
table estimator to compute the estimated survival function ŜL(ti) by filling
in the table below. Then plot the function.

Ij dj cj nj n′
j

n′
j−dj

n′
j

ŜL(t)

[0, 1) 5 5 110 107.5 0.9535 1.0000
[1, 2) 7 7 100 96.5 0.9275 0.9535
[2, 3) 7 7 86 82.5 0.9152 0.8843
[3, 4) 3 8 72 68 0.9559 0.8093
[4, 5) 0 7 61 57.5 1.0 0.7736
[5, 6) 2 10 54 49 0.9591 0.7736
[6, 7) 3 6 42 39 0.9230 0.7420

[7, 8) 0 5 33

[8, 9) 0 4 28

[9, 10) 1 8 24

[10,∞) 15 0 15
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16.16. Survival times for 13 women with tumors from breast cancer that
were negatively stained with HPA are given below.
23, 47, 69, 70+, 71+, 100+, 101+, 148, 181, 198+, 208+, 212+, 224+
See Collett (2003, p. 6). Compute the Kaplan Meier survival function ŜK(ti)
by filling in the table below. Then plot the function.

t(j) γj ti ni di ŜK(t)

t0 = 0 ŜK(0) = 1

23 1 23 13 1 ŜK(23) =

47 1 47 ŜK(47) =

69 1 69 ŜK(69) =

70 0

71 0

100 0

101 0

148 1 148 ŜK(148) =

181 1 181 ŜK(181) =

198 0

208 0

212 0

224 0
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16.17. The Lindsey (2004, p. 280) data is for survival times for 234
women with stage 2 cervical cancer studied over a 10 year period. Use the
life table estimator to compute the estimated survival function ŜL(ti) by
filling in the table below. Show what you multiply to find ŜL(ti). Then plot
the function.

Ij dj cj nj n′
j

n′
j−dj

n′
j

ŜL(t)

[0, 1) 24 3 234 232.5 0.8968 1.0000
[1, 2) 27 11 207 201.5 0.8660 0.8968
[2, 3) 31 9 169 164.5 0.8116 0.7766
[3, 4) 17 7 129 125.5 0.8645 0.6302
[4, 5) 7 13 105 98.5 0.9289 0.5448
[5, 6) 6 6 85 82 0.9268 0.5061
[6, 7) 5 6 73 70 0.9286 0.4691

[7, 8) 3 10 62

[8, 9) 2 13 49

[9, 10) 4 6 34

[10,∞) 24 0 24



CHAPTER 16. SURVIVAL ANALYSIS 548

16.18. Times (in weeks) until relapse below are for 12 patients with acute
myelogeneous leukemia who reached a state of remission after chemotherapy.
See Miller (1981, p. 49).
5, 5, 8, 8, 12, 16+, 23, 27, 30, 33, 43, 45
Compute the Kaplan Meier survival function ŜK(ti) by filling in the table
below. Show what you multiply to find Ŝk(ti). Then plot the function.

t(j) γj ti ni di ŜK(t)

t0 = 0 ŜK(0) = 1

5 1 5 12 2 ŜK(5) =

5 1

8 1 8 ŜK(8) =

8 1

12 1 12 ŜK(12) =

16 0

23 1 23 ŜK(23) =

27 1 27 ŜK(27) =

30 1 30 ŜK(30) =

33 1 33 ŜK(33) =

43 1 43 ŜK(43) =

45 1 45 ŜK(45) =
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16.19. Suppose that a proportional hazards model holds so that hx(t) =
exp(βTx)h0(t) where h0(t) is the baseline hazard function. Let f0(t), S0(t)
F0(t) and H0(t) denote the baseline pdf, survival function, distribution func-
tion and cumulative hazard function.

a) Show
Hx(t) = exp(βT x)H0(t).

b) Show

Sx(t) = [S0(t)]
exp(βT x).

c) Show

fx(t) = f0(t) exp(βT x)[S0(t)]
exp(β

T
x) − 1.

16.20. Suppose that h0(t) = 1 for t > 0. This corresponds to the ex-
ponential proportional hazards model hx(t) = exp(βTx)h0(t) = exp(βTx).

a) Find H0(t).

b) Find Hx(t).

Data for 16.21

Variables in model -2 log L

none 36.349

size 29.042

size, index 23.533

size, index, treatment 22.572

16.21. The Collett (2003, p. 86) data studies the time until death from
prostate cancer from the date the patient was randomized to a treatment.
The variable treatment was a 0 for a placebo and a 1 for DES (a drug). The
variable size was tumor size, and index the Gleason index. Let the full model
contain size, index and treatment. Use the table above.

a) If the reduced model uses size and index, test whether the reduced
model is good.

b) If the reduced model uses size, test whether the reduced model is good.
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data for 16.22

full model coef exp(coef) se(coef) z p

age 0.00318 1.003 0.0111 0.285 0.78

sex -1.48314 0.227 0.3582 -4.140 0.000035

diseaseGN 0.08796 1.092 0.4064 0.216 0.83

diseaseAN 0.35079 1.420 0.3997 0.878 0.38

diseasePKD -1.43111 0.239 0.6311 -2.268 0.023

Likelihood ratio test=17.6 on 5 df, p=0.00342 n= 76

reduced model coef exp(coef) se(coef) z p

age 0.00203 1.002 0.00925 0.220 0.8300

sex -0.82931 0.436 0.29895 -2.774 0.0055

Likelihood ratio test=7.12 on 2 df, p=0.0285 n= 76

16.22. The R kidney data is on the recurrence times Y to infection, at
the point of insertion of the catheter, for kidney patients. Predictors are age,
sex (M=1,F=2), and the factor disease (0=GN, 1=AN, 2=PKD, 3=Other).

a) For the reduced model, test β = 0.

b) For the reduced model, test β = 0 using δ = 0.01.

c) Test whether the reduced model is good.

Output for 16.23

coef exp(coef) se(coef) z p

rxLev -0.0423 0.959 0.1103 -0.384 0.70000

rxLev+5FU -0.3787 0.685 0.1189 -3.186 0.00140

extent 0.4930 1.637 0.1117 4.412 0.00001

node4 0.9154 2.498 0.0968

Likelihood ratio test=122 on 4 df, p=0 n= 929

16.23. The R colon data from one of the first successful trials of adjuvant
chemotherapy for colon cancer. Levamisole is a low-toxicity compound, 5-
FU is a moderately toxic chemotherapy agent. The treatment was nothing,
levamisole, or levamisole and 5-FU. Y is time until death. The 4 predictors
are x1 = 1 if treatment was levamisole, x2 = 1 if the treatment was levamisole
and 5-FU, extent of local spread (treated as a variate with 1=submucosa,
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2=muscle, 3=serosa, 4=contiguous structures), and node4 = 1 for more than
4 positive lymph nodes.

a) Find the ESP and ĥi(t) if x = (0, 1, 2, 1).

b) Find a 95% CI for β1.

c) Do a 4 step test for Ho : β1 = 0.

d) Do a 4 step test for Ho : β4 = 0.

Output for 16.24.

full model coef exp(coef) se(coef) z p

trt 0.295 1.343 0.20755 1.4194 0.16

celltypesmallcell 0.862 2.367 0.27528 3.1297 0.017

celltypeadeno 1.20 3.307 0.30092 3.9747 0.000

celltypelarge 0.401 1.494 0.28269 1.4196 0.16

karno -0.0328 0.968 0.00551 -5.9580 0.000

diagtime 0.000081 1.000 0.00914 0.0089 0.99

age -0.00871 0.991 0.00930 -0.9361 0.35

prior 0.00716 1.007 0.02323 0.3082 0.76

Likelihood ratio test=62.1 on 8 df, p=1.8e-10 n= 137

reduced model coef exp(coef) se(coef) z p

trt 0.2617 1.30 0.20092 1.30 0.19

celltypesmallcell 0.8250 2.28 0.26891 3.07 0.022

celltypeadeno 1.1540 3.17 0.29504 3.91 0.0009

celltypelarge 0.3946 1.48 0.28224 1.40 0.16

karno -0.0313 0.97 0.00517 -6.05 0.000

Likelihood ratio test=61.1 on 5 df, p=7.3e-12 n= 137

16.24. The R veteran lung cancer data has Y = survival time. The
predictors are trt (1=standard, 2=test), the factor celltype (1=squamous,
2=smallcell, 3=adeno, 4=large), karno = Karnofsky performance score
(100=good), diagtime = months from diagnosis to randomization, age in
years, and prior = prior therapy (0=no, 1=yes).

a) For the full model, test Ho β = 0.

b) Test whether the reduced model is good.



CHAPTER 16. SURVIVAL ANALYSIS 552

Full model Output for 16.25

variable coef std._err. z pval

age -0.029 0.008 -3.53 0.000

bectota 0.008 0.005 1.68 0.094

ndrugtx 0.028 0.008 3.42 0.001

herco_2 0.065 0.150 0.44 0.663

herco_3 -0.094 0.166 -0.57 0.572

herco_4 0.028 0.160 0.18 0.861

ivhx_2 0.174 0.139 1.26 0.208

ivhx_3 0.281 0.147 1.91 0.056

race -0.203 0.117 -1.74 0.082

treat -0.240 0.094 -2.54 0.011

site -0.102 0.109 -0.94 0.348

Likelihood ratio test = 24.436 on 11 df, p = 0.011

Reduced model

variable coef std._err. z pval

age -0.026 0.008 -3.25 0.001

bectota 0.008 0.005 1.70 0.090

ndrugtx 0.029 0.008 3.54 0.000

ivhx_3 0.256 0.106 2.41 0.016

race -0.224 0.115 -1.95 0.051

treat -0.232 0.093 -2.48 0.013

site -0.087 0.108 -0.80 0.422

Likelihood ratio test = 21.038 on 7 df, p = 0.004

16.25. The Hosmer and Lemeshow (1999, p. 165 - 170) data studies time
until illegal drug use relapse. Variables were age, becktota, ndrugtx, herco2 =
1 if heroin user and 0 else, herco3 = 1 if cocaine user and 0 else, herco4 = 1
if used neither heroin nor cocaine and 0 else, ivhx2 = 1 if previous but not
recent IV drug use and 0 else, ivhx3 = 1 if recent IV drug use and 0 else, race
= 1 for white and 0 else, treat = 1 for short treatment and 0 for long and
site.

Using the output for the full and reduced model above, test whether the
reduced model is good.
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variables AIC

trt sex race pburn bhd bbut btor bupleg blowleg bresp 439.470

trt sex race pburn bhd bbut btor bupleg blowleg 437.479

trt sex race pburn bbut btor bupleg blowleg 435.540

trt sex race pburn bbut bupleg blowleg 433.677

trt sex race bbut bupleg blowleg 431.952

trt sex race bbut bupleg 430.281

trt sex race bbut 429.617

trt sex race 428.708

trt race 429.704

race 431.795

16.26. Data from Klein and Moeschberger (1997, p. 7) is on severely
burned patients. The response variable is time until infection. Predictors
include treatment (0-routine bathing 1-Body cleansing), sex (0=male 1=fe-
male), race (0=nonwhite 1=white), pburn = percent of body burned. The
remaining variables are burn cite indicators. For example, bhd is head (1 yes
0 no). Results from backward elimination are shown.

a) What is the minimum AIC submodel Imin?

b) What is the best starting submodel I0?

c) Are there any other candidate submodels? Explain briefly.

M1 M2 M3 M4
# of predictors 10 3 2 1

# with 0.01 ≤ p-value ≤ 0.05 2 2 1 1
# with p-value > 0.05 8 1 0 0

−2 log(L) 419.470 422.708 425.704 429.795
AIC(I) 439.470 428.708 429.704 431.795

p-value for change in PLR test 1.0 0.862 0.304 0.325

16.27. Data from Klein and Moeschberger (1997, p. 7) is on severely
burned patients. The above table gives summary statistics for 4 PH regres-
sion models considered as final submodels after performing variable selection.
Assume that the PH assumptions hold for all 4 models. The full model was
M1, and M2 was the minimum AIC model found. Which model should be
considered as the first starting submodel I0? Explain briefly why each of the
other 3 submodels should not be used as the starting submodel.
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16.28. Suppose that the survival times are plotted versus the scaled
Schoenfeld residuals for variable x1. Sketch the loess curve if the PH as-
sumption is reasonable.

16.29. Leemis (1995, p. 190, 205-6) gives data on n = 21 leukemia
patients taking the drug 6-MP. Suppose that the remission times given below
follow an exponential (λ) distribution.

6, 6, 6, 6+, 7, 9+, 10, 10+, 11+, 13, 16, 17+,
19+, 20+, 22, 23, 25+, 32+, 32+, 34+, 35+

a) Find λ̂.

b) Find a 95% CI for λ.

16.30. Suppose that the lifetimes of a certain brand of lightbulb follow
an exponential (λ) distribution. 20 light bulbs are tested for 1000 hours. The
failure times are below.

71, 88, 254, 339, 372, 403, 498, 499, 593, 774, 935,
1000+, 1000+, 1000+, 1000+, 1000+, 1000+, 1000+, 1000+, 1000+

a) Find λ̂.

b) Find a 95% CI for λ.

16.31. The following output is from a Weibull Regression for the Allison
(1995, p. 270) recidivism data. The response variable week is time in weeks
until arrest after release from prison (right censored if week = 52). The 7
variables are Fin (1 for those who received financial aid, 0 else), Age at time
of release, Race (1 if black, 0 else), Wexp(1 if inmate had full time work
experience prior to conviction, 0 else), Mar (1 if married at time of release,
0 else), Paro (1 if released on parole, 0 else), Prio (the number of prior
convictions).

a) For the reduced model, find a 95% CI for β1.

b) Test whether the reduced model is good.
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Output for Problem 16.31 Null Model

Log Likelihood -336.08436 Standard 95% Confidence Chi-

Parameter DF Estimate Error Limits Square Pr>ChiSq

Intercept 1 4.8177 0.1079 4.6062 5.0291 1994.47 <.0001

Scale 1 0.7325 0.0661 0.6138 0.8742

Weib Scale 1 123.6771 13.3417 100.1072 152.7964

Weib Shape 1 1.3651 0.1232 1.1438 1.6293

Full Model Log Likelihood -319.3765238

Standard 95% Confidence Chi-

Parameter DF Estimate Error Limits Square Pr>ChiSq

Intercept 1 3.9901 0.4191 3.1687 4.8115 90.65 <.0001

fin 1 0.2722 0.1380 0.0018 0.5426 3.89 0.0485

age 1 0.0407 0.0160 0.0093 0.0721 6.47 0.0110

race 1 -0.2248 0.2202 -0.6563 0.2067 1.04 0.3072

wexp 1 0.1066 0.1515 -0.1905 0.4036 0.49 0.4820

mar 1 0.3113 0.2733 -0.2244 0.8469 1.30 0.2547

paro 1 0.0588 0.1396 -0.2149 0.3325 0.18 0.6735

prio 1 -0.0658 0.0209 -0.1069 -0.0248 9.88 0.0017

Scale 1 0.7124 0.0634 0.5983 0.8482

Weib. Shape 1 1.4037 0.1250 1.1789 1.6713

Reduced Model Log Likelihood -321.5012378

Standard 95% Confidence Chi-

Parameter DF Estimate Error Limits Square Pr>ChiSq

Intercept 1 3.7738 0.3581 3.0720 4.4755 111.08 <.0001

fin 1 0.2495 0.1372 -0.0194 0.5184 3.31 0.0690

age 1 0.0478 0.0154 0.0176 0.0779 9.66 0.0019

prio 1 -0.0698 0.0201 -0.1092 -0.0304 12.08 0.0005

Scale 1 0.7141 0.0637 0.5995 0.8506

Weib. Shape 1 1.4004 0.1250 1.1756 1.6681
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Output for Problem 16.32

Log Likelihood -321.50124 Standard 95% Confidence Chi-

Parameter DF Estimate Error Limits Square Pr>ChiSq

Intercept 1 3.7738 0.3581 3.0720 4.4755 111.08 <.0001

fin 1 0.2495 0.1372 -0.0194 0.5184 3.31 0.0690

age 1 0.0478 0.0154 0.0176 0.0779 9.66 0.0019

prio 1 -0.0698 0.0201 -0.1092 -0.0304 12.08 0.0005

Scale 1 0.7141 0.0637 0.5995 0.8506

Weibull Shape 1 1.4004 0.1250 1.1756 1.6681

16.32. Above is output from a Weibull Regression for the Allison (1995,
p. 270) recidivism data described in problem 16.31. The full model has 3
predictors, fin, age and prio.

a) Suppose that the log likelihood for the null model is −336.08436. Test
whether β = 0.

b) Test whether β1 = 0.

c) Test whether β2 = 0.

Output for 16.33

Value Std. Error z p

(Intercept) 5.32632 0.66298 8.03 9.44e-16

age -0.00891 0.00711 -1.25 0.210

sex 0.37019 0.12796 2.89 0.00382

ph.karno 0.00926 0.00446 2.08 0.0379

Log(scale) -0.28085 0.06171 -4.55 5.33e-06

Scale= 0.755

Weibull distribution

Loglik(model)= -1138.7 Loglik(intercept only)= -1147.5

Chisq= 17.59 on 3 degrees of freedom, p= 0.00053

n=227 (1 observation deleted due to missingness)

16.33. A Weibull regression model was fit to the R lung data resulting
in the above output.

a) Test whether β = 0.

b) Test whether β1 = 0.
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c) Test whether β2 = 0.

d) Sketch the Weibull EE plot if the Weibull model is good.

Output for 16.34, n = 26

coef exp(coef) se(coef) z p full model

age 0.121 1.13 0.0484 2.500 0.012

resid.ds 0.792 2.21 0.8078 0.980 0.330

ecog.ps 0.087 1.09 0.6592 0.132 0.890

Likelihood ratio test= 13.7 on 3 df, p=0.00333

coef exp(coef) se(coef) z p reduced model

age 0.137 1.15 0.0474 2.9 0.0038

Likelihood ratio test= 12.7 on 1 df, p=0.000368

16.34. The R ovarian data gives survival times for patients with ovar-
ian cancer. Predictors are age in years, resid.ds (residual disease present
1=no,2=yes), and ecog.ps (ECOG performance status: 1 is better than 2). A
stratified proportional hazards model is fit where the stratification variable
rx is the treatment group.

a) Test whether β3 = 0.

b) Test whether β = 0 for the full model.

c) Test whether the reduced model is good.

16.35. The R lung cancer data has the time until death or censoring.
ph.ecog = Ecog performance score 0-4, pat.karno = patient’s assessment of
their karno score and wt.loss = weight loss in last 6 months. A stratified
proportional hazards model is used and stratification is on sex.

a) Find the ESP and ĥi(t) if x = (1.0, 80.0, 7.0) and sex = F .

b) Find a 95% CI for β2.

c) Do a 4 step test for Ho : β2 = 0.

d) Do a 4 step test for Ho : β3 = 0.
e) R output says Likelihood ratio test=22.8.
Do a 4 step test for Ho : β = 0.
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output for f)

coef exp(coef) se(coef) z p

age 0.01444 1.01 0.010508 1.374 0.17

meal.cal -0.00016 1.00 0.000240 -0.666 0.51

Likelihood ratio test=2.97 on 2 df, p=0.227 n=181

(47 observations deleted due to missingness)

f) Now the SPH model uses the predictors age and meal.cal = calories
consumed at meals excluding beverages and snacks.

Do a 4 step test for Ho : β = 0.

SAS Problems

SAS is a statistical software package that will be used in this course. You
will need a disk. There are SAS manuals and books at the library, but they
are not needed in this course. To use SAS on windows (PC), use the following
steps.

i) Double click on the Math Progs icon and after a window appears, double
click on the SAS icon. If your computer does not have SAS, go to another
computer.

ii) A window should appear with 3 icons. Double click on The SAS System
for ....

iii) Like Minitab a window with a split screen will open. The top screen
says
Log-(Untitled) while the bottom screen says Editor-Untitled1. Press the
spacebar and an asterisk appears: Editor-Untitled1*.

iv) Go to the webpage (www.math.siu.edu/olive/reghw.txt) to copy and
paste the program for Problem 16.36 into Notepad. The ls stands for linesize
so l is a lowercase L, not the number one. Save your file as h16d36.sas on
your diskette (A: drive). (On the top menu of the editor, use the commands
“File > Save as”. A window will appear. Use the upper right arrow to locate
“31/2 Floppy A” and then type the file name in the bottom box. Click on
OK.)

v) Get back into SAS, and from the top menu, use the “File>Open” com-
mand. A window will open. Use the arrow in the NE corner of the window to
navigate to “31/2 Floppy(A:)”. (As you click on the arrow, you should see My
Documents, C: etc, then 31/2 Floppy(A:).) Double click on hw16d36.sas.
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(Alternatively cut and paste the program into the SAS editor window.) To
execute the program, use the top menu commands “Run>Submit”. An out-
put window will appear if successful.

If you were not successful, look at the log window for hints on errors.
A single typo can cause failure. Reopen your file in Word or Notepad and
make corrections. Occasionally you can not find your error. Then find your
instructor or wait a few hours and reenter the program. Word seems to make
better looking tables, and copying from Notepad to Word can completely ruin
the table.

vi) To copy and paste relevant output into Word, click on the output
window and use the top menu commands “Edit>Select All” and then the
menu commands “Edit>Copy”.

(In Notepad use the commands “Edit>Paste”. Then use the mouse to
highlight the relevant output (the table and statistics for the table).
Then use the commands “Edit>Copy”.)

Finally, in Word, use the commands “Edit>Paste”.

You may want to save your SAS output as the file hw16d36.doc

vii) This point explains the SAS commands. The semicolon “;” is used to
end SAS commands and the “options ls = 70;” command makes the output
readable. (An “*” can be used to insert comments into the SAS program.
Try putting an * before the options command and see what it does to the
output.) The next step is to get the data into SAS. The command “data
heart;” gives the name “heart” to the data set. The command “input time
status number;” says the first entry is the censored variable time, the 2nd
variable status (0 if censored 1 if uncensored) and the third variable number
(= number of deaths or number of cases censored, depending on status).
The command “cards;” means that the data is entered below. Then the data
in entered and the isolated semicolon indicates that the last case has been
entered. The next 4 lines make perform the lifetable estimates for S(t) and
the corresponding confidence intervals. Also plots of the estimated survival
and hazard functions are given. The command “run;” tells SAS to execute
the program.

It may be easier to save output from each problem as a Word document,
but you get an extra page printed whenever you use the printer.

16.36. The following problem gets the lifetable estimator using SAS. The
data is on 68 patients that received heart transplants at about the time when
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getting a heart transplant was new. See Allison (1995, p. 49-50).

a) Do i) through v) above. But instead of vi), click on the SAS output,
then click on the printer icon. This will produce 2 pages of output. Then
click on the graph of the survival function and click on the printer icon.

Include these 3 pages of output as part of your homework.

b) From the 1st page of output, Number Failed = di, Number Censored
= ci, Effective Sample Size = n′

i, Survival = ŜL(ti−1) = estimated survival for
the left endpoint of the interval and Survival Standard Error = SE[ŜL(ti−1)].

What is SE[ŜL(200)]?

c) From the 2nd page of output, SDF LCL SDF UCL gives a 95% CI for
S(ti−1).

What is the 95% CI for S(200) using output?

d) Compute the 95% CI for S(200) using the formula and SE[ŜL(200)].

e) The SAS program (with plots(s,h)) plots both the survival and the
hazard function (scroll down!). From the 2nd page of output, plot MID-
POINT vs HAZARD (so the first point is (25,0.0055)) by hand. Connect
the dots to make an estimated hazard function. Notice that the estimated
hazard function decreases sharply to about 200 days after surgery and then
is fairly stable.

16.37. This problem examines the Allison (1995, p. 31-34) myelomatosis
data (a cancer causing tumors in the bone marrow) with SAS using the
Kaplan Meier product limit estimator. Obtain the SAS program for this
problem from (www.math.siu.edu/olive/reghw.txt). Obtain the output from
the program in the same manner as i) through v) above Problem 16.36.

a) But instead of vi), click on the SAS output, then click on the printer
icon. This will produce 3 pages of output (perhaps). Then click on the graph
of the survival function and click on the printer icon.

Include these 4 pages of output as part of your homework.

b) From the summary statistics of the first page of output, about when
do 50% of the patients die?

c) From the first page of output (perhaps), what is the 95% CI for the
time when 50% of the patients die?

d) From the 3rd page of output (perhaps), what is the 95% CI for SY (13).
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e) Check this CI using ŜK(13) and SE(ŜK(13)) obtained from the 1st
page of output (perhaps). If the interval is (L,U), use (max(0, L),min(U, 1))
as the final interval.

f) SAS does not compute a hazard estimator for the KM estimator, but
from the plot of ŜK(t), briefly explain survival for days 0–250 and for days
250–2250.

16.38. This Miller (1981, p. 49-50) data set is on remission times in
weeks for leukemia patients. Twenty patients received treatment A and 20
received treatment B. The predictor group was 0 for A and 1 for B.

a) Obtain the SAS program for this problem from
(www.math.siu.edu/olive/reghw.txt). Obtain the output from the program
in the same manner as i) through vi) above Problem 16.36.

But instead of vi), click on the SAS output, then click on the printer icon.
This will produce 1 page of output.

b) Do a 4 step test for Ho : β = 0.

c) Do a 4 step PLRT for Ho : β = 0 (for β = 0). (The PLRT is better
than the Wald test in b).)

16.39. Data is from SAS/STAT User’s Guide (1999) and is from a study
on multiple myeloma (bone cancer) in which researchers treated 65 patients
with alkylating agents. The variable Time is the survival time in months
from diagnosis. The predictor variables are LogBUN (blood urea nitrogen),
HGB (hemoglobin at diagnosis), Platelet (platelets at diagnosis: 0=abnor-
mal, 1=normal), Age at diagnosis in years, LogWBC, Frac (fractures at diag-
nosis: 0=none, 1=present), LogPBM (log percentage of plasma cells in bone
marrow), Protein (proteinuria at diagnosis), and SCalc (serum calcium at
diagnosis).

a) Obtain the SAS program for this problem from
(www.math.siu.edu/olive/reghw.txt).

b) First backward elimination is considered. From the SAS output win-
dow, copy and paste the output for the full model that uses all 9 variables
into Word. That is, scroll to the top of the output and copy and paste the
following output.

Step 0. The model contains the following variables:

LogBUN HGB Platelet Age LogWBC Frac LogPBM Protein SCalc
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.

.

.

SCalc 1 0.12595 0.10340 1.4837 0.2232 1.134

c) At step 7 of backward elimination, the final model considered uses
LogBUN and HGB. Copy and paste the output for this model (similar to the
output for b) into Word.

d) Backward elimination will consider 8 models. Write down the variables
used for each model as well as the AIC. The first two models are shown below.

variables AIC

LogBUN HGB Platelet Age LogWBC Frac LogPBM Protein SCalc 310.588

LogBUN HGB Age LogWBC Frac LogPBM Protein SCalc 308.827

e) Repeat d) for the 4 models considered by forward selection.

f) Repeat d) for the 4 models considered by stepwise selection.

g) For all subsets selection, complete the following table.

variables chisq

2 LogBUN HGB

9 full

h) Perform a change in PLR test if the full model uses 9 variables and the
reduced model uses LogBUN and HGB. (Use the output from b) and c).)

i) Are there any other good candidate models?
16.40. Data is from Allison (1995, p. 270). The response variable week

is time in weeks until arrest after release from prison (right censored if week
= 52). The 7 variables are Fin (1 for those who received financial aid, 0 else),
Age at time of release, Race (1 if black, 0 else), Wexp(1 if inmate had full
time work experience prior to conviction, 0 else), Mar (1 if married at time
of release, 0 else), Paro (1 if released on parole, 0 else), Prio (the number of
prior convictions).

a) This is a large data file. SAS needs an “end of file” marker to de-
termine when the data ends. SAS uses a period as the end of file marker,
and the period has already been added to the file. Obtain the file from
(www.math.siu.edu/olive/recid.txt) and save the file as recid.txt using the
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commands “File>Save as.” A window will appear, in the top box make 3
1/2 Floppy (A:) appear while in the File name box type recid.txt.

b) Obtain the SAS program for this problem from
(www.math.siu.edu/olive/reghw.txt). To execute the program, use the top
menu commands “Run>Submit”. An output window will appear if success-
ful. Warning: if you do not have the recid.txt file on A drive, then
you need to change the infile command in the SAS code to the drive that
you are using, eg change infile “a:redic.txt”; to infile “f:recid.txt”; if you are
using F drive.

c) First backward elimination is considered. Scroll to the top of the copy
and paste the 1st 2 pages of output for the full model into Word.

d) Backward elimination will consider 5 models. Write down the variables
used for each model as well as the AIC. The first two models are shown below.

variables AIC

fin age race wexp mar paro prio 1332.241

fin age race wexp mar prio 1330.429

e) Repeat d) for the 4 models considered by forward selection.

f) Repeat d) for the 5 models considered by stepwise selection.

g) For all subsets selection, complete the following table.

variables chisq

3 fin age prio

7 full

16.41. This problem considers the ovarian data from Collett (2003, p.
344-346).

a) Obtain the SAS program for this problem from
(www.math.siu.edu/olive/reghw.txt). Print the output.

b) Find the ESP if age = 40 and treat 1 = 1. (Comment: treatment
takes on 2 levels so only one indicator is needed. SAS output includes a 2nd
indicator treat 2 but its coefficient is β̂3 = 0 and hence can be ignored. In
general if the category takes on J levels, SAS will give nonzero output for
the first J − 1 levels and a line of 0s for the Jth level. This means level J
was omitted and the line of 0s should be ignored.)
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c) Give a 95% CI for β1 corresponding to age from output and the CI
using the formula.

d) Give a 95% CI for β2 corresponding to treat 1 from output and the CI
using the formula.

e) If the model statement in the SAS program is changed to
model survtime*status(0)=;
then the null model is fit and the SAS output says
Log Likelihood −29.76723997.

Test β = 0 with the LR test.
(Hint: The full model log likelihood log(L) = −20.56313339. Want −2 log(L)
for both the full and null models for the LR test.)

f) Suppose the reduced model does not include treat. Then SAS output
says Log Likelihood −21.7830. Test whether the reduced model is good.
(Hint: The log likelihood for the full model is log(L) = −20.56313339. Want
−2 log(L) for the full and reduced models for the change in LR test.)

16.42. Copy and paste commands for this problem from
(www.math.siu.edu/olive/reghw.txt) for this problem into SAS. The myelo-
matosis data is from Allison (1995, p. 31, 158-161, 269). The 25 patients
have tumours in the bone marrow. The patients were randomly assigned 2
drug treatments treat. The variable renal is 1 if renal (kidney) functioning is
normal and 0 otherwise.

A stratified proportional hazards (SPH) model makes sense if the effect
of Renal varies with time since randomization (if there is a time–Renal in-
teraction). In this situation the PH model would be inappropriate since
time–variable interactions are not allowed in the PH model. Notice that the
results in a) and b) below are different. The analysis does need to control
for the variable Renal to obtain good estimates of the treatment effect, but
both the SPH model in a) and the PH model in c) may be adequate

a) The SAS program produces output for 3 models. The first model
is a SPH model with stratification on Renal. Perform a Wald test on β1

corresponding to treat. (In the output, β̂1 = 1.463986.)

b) The 2nd model is a PH model with the predictor treat. Perform a
Wald test on β1 corresponding to treat. (In the output, β̂1 = 0.56103.)

c) The 3rd model is a PH model with the predictors treat and Renal.
Perform a Wald test on β1 corresponding to treat. (In the output, β̂1 =
1.22191.)
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R Problems
R is the free version of Splus. The website (www.stat.umn.edu) has a link

under the icon Rweb. The icon other links has the link Cran that gives R
support. Click on the Rgui icon to get into R. Then typing q() gets you out
of R.

16.43. Miller (1981, p. 49) gives the length of times of remission (time
until relapse) in acute myelogeneous leukemia under maintenance chemother-
apy for 11 patients is
9, 13, 13+, 18, 23, 28+, 31, 34, 45+, 48, 161+.

a) Following Example 16.3, make a table with headers t(j), γj, ti, ni, di

and ŜK(ti). Then compute the Kaplan Meier estimator. (You can check it
with the R output obtained in b).)

b) Get into R. Copy and paste commands for this problem from
(www.math.siu.edu/olive/reghw.txt) into R. Hit Enter and a plot should
appear. Copy and paste the R output with header (time ... upper 95% CI)
into Word. Following the R handout, click on the plot and hold down the Ctrl
and c buttons simultaneously. Then in the Word Edit menu, select “paste.”

Include this output with the homework. The center step function is the
Kaplan Meier estimator ŜK(t) while the lower and upper limits correspond
to the confidence interval for SY (t).

c) Write down the 95% CI for SY (23) and then verify the CI by computing
ŜK(23) ± 1.96SE(ŜK(23)).

16.44. Copy and paste commands for parts a) and b) for this problem
from (www.math.siu.edu/olive/reghw.txt) into R.

The commands make the KM estimator for censored data T = min(Y, Z)
where Y ∼ EXP (1). The KM estimator attempts to estimate SY (t) =
exp(−t). The points in the plot are SY (t(j)) = exp(−t(j)), and the points
should be within the confidence intervals roughly 95% of the time (actually,
if you make many plots the points should be in the intervals about 95% of
the time, but for a given plot you could get a “bad data set” and then the
rather more than 5% of the points are outside of the intervals).

a) Copy and paste the commands for a) and hit Enter. Then copy and
paste the plot into Word.

b) Copy and paste the commands for b) and hit Enter. Then copy and
paste the plot into Word.

c) As the sample size increases from n = 20 to n = 200, the CIs should
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become more narrow. Can you see this in the two plots? Are about 95% of
the plotted points within the CIs?

16.45. Go to (www.math.siu.edu/olive/regpack.txt) and cut and paste
the program kmsim2 into R. a) Type the command kmsim2(n=10), hit Enter
and include the output in Word.

This program computes censored data T = min(Y, Z) where Y ∼ EXP (1).
Then a 95% CI is made for SY (t(j)) for each of the n = 10 t(j). This is done
for 100 data sets and the program counts how many times the CI contains
SY (t(j)) = exp(−t(j)). The scaled lengths are also computed. The ccov is the

count for the classical Ŝ ± 1.96SE(Ŝ) interval while p4cov is for the plus 4
CI. The lcov is based on a CI that uses log(Ŝ) and llcov is based on a CI that
uses log(−log(Ŝ)). The 1st 3 CIs are not made if the last case is censored so
NA is given. The plus 4 CI seems to be good at t(1) and t(n).

16.46. This data is from a study on ovarian cancer. There were 26
patients. The variable futime was the time until death or censoring in days,
the variable fustat was 1 for death and 0 for censored, age is age and ecog.ps
is a measure of status ranging from 0 (fully functional) to 4 (completely
disabled). Level 4 subjects are usually considered too ill to enter a study
such as this one.

a) Copy and paste commands for this problem from
(www.math.siu.edu/olive/reghw.txt) into R. Hit Enter and a plot should
appear. Copy and paste the R output into Word. The output is similar to
that of Problem 16.47 but also contains the variable ecog.ps.

Click on the plot and hold down the Ctrl and c buttons simultaneously.
Then in the Word Edit menu, select “paste.” The plot is the Cox regression
estimated survival function at the average age (56.17) and average ecog.ps
(1.462).

b) Now copy and paste the command for b) and place the plot in Word as
described in a). This plot p is the Cox regression estimated survival function
at the (age,ecog.ps) = (66,4). Is survival better for (56.17,1.462) or (66,4)?

c) Find the ESP and ĥi(t) if x = (56.17, 1.462).

d) Find the ESP and ĥi(t) if x = (66, 4).

e) Find a 95% CI for β1.

f) Find a 95% CI for β2.

g) Do a 4 step test for Ho : β1 = 0.
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h) Do a 4 step test for Ho : β2 = 0.

i) Do a 4 step PLRT for Ho : β = 0.

coef exp(coef) se(coef) z p

age 0.162 1.18 0.0497

Likelihood ratio test=14.3

16.47. Use the output above which is for the same data as in 16.46 but
only the predictor age is used.

a) Find a 95% CI for β.

b) Do a 4 step test for Ho : β = 0.

c) Do a 4 step PLRT for Ho : β = 0 (for β = 0). (The PLRT is better
than the Wald test in b).)

16.48. The R lung cancer data has the time until death or censoring and
status = 0 for censored and 1 for uncensored. Then the covariates are age,
sex = 1 for M and 2 for F, ph.ecog = Ecog performance score 0-4, ph.karno
= a competitor to ph.ecog, pat.karno = patient’s assessment of their karno
score, meal.cal = calories consumed at meals excluding beverages and snacks
and wt.loss = weight loss in last 6 months. A stratified proportional hazards
model with stratification on sex will be used.

a) Copy and paste commands for this problem from
(www.math.siu.edu/olive/reghw.txt) into R.

Type zfull, then zred1 then zred2. Copy and paste the resulting output
into Word. The full model uses age, ph.ecog, ph.karno, pat.karno and wt.loss.

b) Test whether the reduced model that omits age can be used.

c) Test whether the reduced model that omits age and ph.karno can be
used.

16.49. Go to (www.math.siu.edu/olive/regpack.txt) and cut and paste
the program bphgfit into R.

Alternatively, suppose that you download regpack.txt onto a disk. (Use
File and Save Page as.) Enter R and wait for the curser to appear. Then go
to the File menu and drag down Source R Code. A window should appear.
Navigate the Look in box until it says 3 1/2 Floppy(A:). In the Files of
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type box choose All files(*.*) and then select regpack.txt. The following line
should appear in the main R window.

> source("A:/regpack.txt")

a) Copy and paste commands for this problem from
(www.math.siu.edu/olive/reghw.txt) into R. Copy and paste the output into
Word.

b) Click on the plot and hold down the Ctrl and c buttons simultaneously.
Then in the Word Edit menu, select “paste.”

c) The data is remission time in weeks for leukemia patients receiving
treatments A (x = 0) or B (x = 1). See Smith (2002, p. 174). The indicator
variable x (leuk[,3]) is the single covariate. Do a PLRT to test whether β = 0.
Is there a difference in the effectiveness of the 2 treatments?

d) The solid lines in the plot correspond to the estimated PH survival
function for each treatment group. The plotted points correspond to the
estimated Kaplan Meier estimator for each group. If the PH model is good,
then the plotted points should track the solid lines fairly well. Is the PH
model good? (When β = 0, the PH model for this data is h0(t) = h1(t),
but the PH model could fail, eg if the survival function for treatment A is
higher than that of treatment B until time tA and then the survival function
for treatment B is higher: the survival functions cross at exactly one point
tA > 0.)

16.50. An extension of the PH model is the stratified PH model where
hx,j = exp(βTx)h0,j(t) for j = 1, ..., K where K ≥ 2 is the number of strata
(groups). Testing is done in exactly the same manner as for the PH model,
and the same β is used for each strata, only the baseline function changes.
The regression in problem 16.48 used gender, male and female, as strata.
If the model was good, then a PH model should hold for males and a PH
model should hold for females. For the lung cancer data, females had a higher
survival curve than males for x set to the average values.

An estimated sufficient summary plot (ESSP) is a plot of the ESP = β̂
′
x

versus T , the survival times, where the symbol “0” means the time was
censored and “+” uncensored. If the PH model holds, the variability of the
plotted points should decrease rapidly as ESP increases.

a) Copy and paste commands from (www.math.siu.edu/olive/reghw.txt)
for this problem into R. Click on the plot and hold down the Ctrl and c
buttons simultaneously. Then in the Word Edit menu, select “paste.”
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b) Repeat a) except use the commands for 16.50b.
How does the variability in the plot for a narrow vertical strip at ESP =

0.5 compare to the variability for a narrow vertical strip at ESP = −1.5?

c) Go to (www.math.siu.edu/olive/regpack.txt) and cut and paste the
program vlung2 into R. Type the following two commands and include the
resulting plot in Word.

vlung2(1)

title("males")

d) Type the following two commands and include the resulting plot in
Word.

vlung2(2)

title("females")

e) The plots in c) and d) divide the ESP into 4 slices. The estimated PH
survival function is evaluated at the last point in the first 3 slices and at the
first point in the 4th slice. Pointwise confidence intervals are also included
(dashed upper and lower lines). The plotted circles correspond to the Kaplan
Meier estimator for the points in each slice. The 1st slice is in the NW corner,
the 2nd slice in the NE, the 3rd slice in the SW and the 4th slice in the SE.
Confidence bands that would include an entire reasonable survival function
would be much wider. Hence if the plotted circles are not very far outside
the pointwise CI bands, then the PH model is reasonable.

Is the PH model reasonable for males? Is the PH model reasonable for
females?

16.51. The lung cancer data is the same as that described in 16.48, but
the PH model is stratified on sex with variables ph.ecog, ph.karno, pat.karno
and wt.loss.

a) Copy and paste commands for this problem from
(www.math.siu.edu/olive/reghw.txt) into R. Click on the left window and
hit Enter. Then 4 plots should appear. Include the plot in Word.

b) The plots are of xj versus the martingale residuals when xj is omitted.
The loess curve should be roughly linear (or at least not taking on some
simple shape such as a quadratic) if xj is the correct functional form. If
the loess curve looks like t(xj) for some simple t (eg t(xj) = x2

j), then t(xj)
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should be used instead of xj. Are the loess curves in the 4 plots roughly
linear?

c) Copy and paste commands for this problem from
(www.math.siu.edu/olive/RMLRhw.txt) into R. Click on the left window
and hit Enter. Then 4 plots should appear. Include the plot in Word. Also
include the output from cox.zph(lungfit2) in Word.

d) The plots are of survival times vs scaled Schoenfeld residuals for each
of the 4 variables. The loess curves should be approximately horizontal (0
slope) lines if the PH assumption is reasonable. Alternatively, the pvalue
for Ho slope = 0 from cox.zph should be greater than 0.05 for each of the 4
variables. Is the PH assumption is reasonable? Explain briefly.

16.52. Copy and paste the programs from
(www.math.siu.edu/olive/regpack.txt) into R.

Alternatively, suppose that you download regpack.txt onto a disk. (Use
File and Save Page as.) Enter R and wait for the curser to appear. Then go
to the File menu and drag down Source R Code. A window should appear.
Navigate the Look in box until it says 3 1/2 Floppy(A:). In the Files of
type box choose All files(*.*) and then select regpack.txt. The following line
should appear in the main R window.

> source("A:/regpack.txt")

a) In R, type “library(survival)” if necessary. Then type “phsim(k=1)”.
Hit the up arrow to repeat this command several times. Repeat for “ph-
sim(k=0.5)” and “phsim(k=5)” to make ET plots. The simulated data fol-
lows a PH Weibull regression model with h0(t) = ktk−1. For k = 1 the data
follows a PH exponential regression model. Did the survival times decrease
rapidly as ESP increases?

b) The function phsim2 slices the ESP into 9 groups and computes the
Kaplan Meier estimator for each group. If the PH model is reasonable and n
is large enough, the 9 plots should have approximately the same shape. Type
“phsim2(n=100,k=1)”, then “phsim2(n=100,k=1)” and keep increasing n by
100 until the nine plots look similar (assuming survival decreases from 1 to 0,
and ignoring the labels on the horizontal axis and the + signs that correspond
to censored times). We will say that the plots look similar if n = 800. What
value of n did you get?
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c) The function bphsim3 makes the slice survival plots when the single
covariate is an indicator for 2 groups. The PH assumption is reasonable if
the plotted circles corresponding to the Kaplan Meier estimator track the
solid line corresponding to the PH estimated survival function. Type “bph-
sim3(n=10,k=1)” and repeat several times (use the up arrow). Do the plotted
circle track the solid line fairly well?

d) The function phsim5 is similar but the ESP takes on many values and is
divided into 9 groups. Type “phsim5(n=50,k=1)”, then “phsim5(n=60,k=1)”
and keep increasing n by 10 until the circles track the solid lines well. We will
say that the circles track the solid lines well if they are not very far outside
the pointwise CI bands. What value of n do you get?

16.53. This problem considers the ovarian data from Collett (2003, p.
344-346).

a) Obtain the R code for this problem from
(www.math.siu.edu/olive/reghw.txt). Click on the left screen then hit Enter.
Copy and paste both the output into Word. Also copy and paste the plot
into Word.

b) The plot is a log censored response plot. The top line is the identity
line and the bottom line the least squares line. Is the slope of the least
squares line near 1?

16.54. Copy and paste the programs phdata, weyp and wregsim from
(www.math.siu.edu/olive/regpack.txt) into R (or download regpack on a
disk and use the source command as in Problem 16.52).

Make the left window small by moving the cursor to the lower right corner
of the window, then hold the right mouse button down and drag the window
to the left.

The program wregsim generates Weibull proportional hazards regression
data with baseline hazard function h0(t) = ktk−1.

a) Type the command wregsim(k=1) 5 times (or use the “up arrow”
after typing the command once). This gives 5 simulated Weibull regression
data sets with k = 1. Hence the Weibull regression is also an exponential
regression. Include the last plot in Word.

b) Type the command wregsim(k=5) 5 times. To judge linearity, ignore
the cases on the bottom of the plot with low density (points with log(time)
less than −2). (These tend to be censored cases because time Y = W 1/k



CHAPTER 16. SURVIVAL ANALYSIS 572

where W ∼ EXP (λ = exp(SP )) where E(W ) = 1/λ. Z ∼ EXP (.1) has
mean 10 and if Zi < Yi then Zi is usually very small.) Do the plots seem
linear ignoring the cases on the bottom of the plot?

c) Type the command wregsim(k=0.5) 5 times. (Now censored cases
tend to be large because time Y = W 1/k = W 2 where W ∼ EXP (λ).
Z ∼ EXP (.1) has mean 10 and if Zi < Yi then Yi > 10, usually.) Do the
plots seem linear (ignoring cases on the bottom of the plot)?

16.55. This problem considers the ovarian data from Collett (2003, p.
189, 344-346).

a) Obtain the R code for this problem from
(www.math.siu.edu/olive/reghw.txt). Copy and paste the plot into Word.

b) Now obtain the R code for this problem and put the plot into Word.

c) Can the Exponential regression model be used or should the more
complicated Weibull regression model be used?

16.56. Copy and paste the programs phdata and wregsim2 from
(www.math.siu.edu/olive/regpack.txt) into R (or download regpack on a
disk and use the source command as in 16.52).

Make the left window small by moving the cursor to the lower right corner
of the window, then hold the right mouse button down and drag the window
to the left.

The program wregsim2 generates Weibull proportional hazards regression
data with baseline hazard function h0(t) = ktk−1.

a) Type the command wregsim2(n=10, k=1) 5 times (or use the “up
arrow” after typing the command once). This gives 5 simulated Weibull
regression data sets with k = 1. Increase n by 10 until the plotted points
cluster tightly about the identity line in at least 4 out of 5 times. How big is
n?

b) Type the command wregsim2(n =10, k=5) 5 times. Increase n by 10
until the plotted points cluster tightly about the identity line in at least 4
out of 5 times. How big is n?

c) Type the command wregsim2(n=10, k=0.5) 5 times. Increase n by 10
until the plotted points cluster tightly about the identity line in at least 4
out of 5 times. How big is n?
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16.57. Copy and paste the programs phdata and wregsim3 from
(www.math.siu.edu/olive/regpack.txt) into R (or download regpack on a
disk and use the source command as in 16.52).

Make the left window small by moving the cursor to the lower right corner
of the window, then hold the right mouse button down and drag the window
to the left.

The program wregsim3 generates Weibull proportional hazards regression
data with baseline hazard function h0(t) = ktk−1. This is also an AFT model
with α = 0, β′ = −(1/k, ..., 1/k) and σ = 1/k. The program generate 100
Weibull AFT data sets and for each run i computes α̂i, β̂i and σ̂i. Then
the averages are reported. Want mnint ≈ 0, mncoef ≈ −(1/k, ..., 1/k) and
mnscale ≈ 1/k.

a) Make a table (by hand) with headers

n k mnint mncoef mnscale

Fill in the table for n = 20, k = 1;n = 100, k = 1;n = 200, k = 1;n =
20, k = 5;n = 100, k = 5;n = 200, k = 5;n = 20, k = 0.5;n = 100, k =
0.5;n = 200, k = 0.5 by using the commands wregsim3(n=20, k=1), ...,
wregsim3(n=200, k=0.5).

b) Are the estimators close to parameters α,β and σ for n = 20? How
about for n = 100?

16.58. Copy and paste the programs wphsim and swhat from
(www.math.siu.edu/olive/regpack.txt) into R (or download regpack on a
disk and use the source command as in 16.52). Type the command wph-
sim(n=999) to make a slice survival plot based on the WPH survival func-
tion. Are the KM curve and Weibull estimated survival function close for
the plot in the bottom right corner? Include the plot in Word.



CHAPTER 16. SURVIVAL ANALYSIS 574

16.59. The R lung cancer data has the time until death or censoring and
status = 0 for censored and 1 for uncensored. Then the covariates are age,
sex = 1 for M and 2 for F, ph.ecog = Ecog performance score 0-4, ph.karno
= a competitor to ph.ecog, pat.karno = patient’s assessment of their karno
score, meal.cal = calories consumed at meals excluding beverages and snacks
and wt.loss = weight loss in last 6 months. The R output will use a stratified
proportional hazards model that is stratified on sex with variables ph.ecog,
pat.karno and wt.loss.

a) Copy and paste commands for this problem from
(www.math.siu.edu/olive/reghw.txt) into R. Click on the left window and
hit Enter. Include the plot in Word. Also include the R output in Word.

b) Test whether β = 0.

c) Based on the plot, do females or males appear to have better survival
rates?



Chapter 17

Stuff for Students

17.1 R/Splus and Arc

R is the free version of Splus. The website (http://www.stat.umn.edu) has
useful links for Arc which is the software developed by Cook and Weisberg
(1999a). The website (http://www.stat.umn.edu) also has a link to Cran
which gives R support. As of June 2009, the author’s personal computer has
Version 2.4.1 (December 18, 2006) of R, Splus–2000 (see Mathsoft 1999ab)
and Version 1.03 (August 2000) of Arc. Many of the text R/Splus functions
and figures were made in the middle 1990’s using Splus on a workstation.

Downloading the book’s data.lsp files into Arc
Many homework problems use data files for Arc contained in the book’s

website (www.math.siu.edu/olive/regbk.htm). As an example, open cbrain.lsp
file with Notepad. Then use the menu commands “File>Save As”. A window
appears. On the top “Save in” box change what is in the box to “Floppy(A:)”
in order to save the file on a disk. Then in Arc activate the cbrain.lsp file
with the menu commands “File > Load > 3 1/2 Floppy(A:) > cbrain.lsp.”

Alternatively, open cbrain.lsp file with Notepad. Then use the menu com-
mands “File>Save As”. A window appears. On the top “Save in” box
change what is in the box to “My Documents”. Then go to Arc and use the
menu commands “File>Load”. A window appears. Change “Arc” to “My
Documents” and open cbrain.lsp.

Downloading the book’s R/Splus functions regpack.txt into R or
Splus:

575
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Many of the homework problems use R/Splus functions contained in the
book’s website (www.math.siu.edu/olive/regbk.htm) under the file name reg-
pack.txt. Suppose that you download regpack.txt onto a disk. Enter R and
wait for the cursor to appear. Then go to the File menu and drag down
Source R Code. A window should appear. Navigate the Look in box until it
says 3 1/2 Floppy(A:). In the Files of type box choose All files(*.*) and then
select regpack.txt. The following line should appear in the main R window.

> source("A:/regpack.txt")

Type ls(). About 70 R/Splus functions from regpack.txt should appear.
When you finish your R/Splus session, enter the command q(). A window

asking “Save workspace image?” will appear. Click on No if you do not want
to save the programs in R. (If you do want to save the programs then click
on Yes.)

If you use Splus, the command

> source("A:/regpack.txt")

will enter the functions into Splus. Creating a special workspace for the
functions may be useful.

This section gives tips on using R/Splus, but is no replacement for books
such as Becker, Chambers, and Wilks (1988), Chambers (1998), Crawley
(2005, 2007), Fox (2002) or Venables and Ripley (2003). Also see Mathsoft
(1999ab) and use the website (www.google.com) to search for useful websites.
For example enter the search words R documentation.

The command q() gets you out of R or Splus.
Least squares regression is done with the function lsfit.
The commands help(fn) and args(fn) give information about the function

fn, eg if fn = lsfit.
Type the following commands.

x <- matrix(rnorm(300),nrow=100,ncol=3)

y <- x%*%1:3 + rnorm(100)

out<- lsfit(x,y)

out$coef

ls.print(out)



CHAPTER 17. STUFF FOR STUDENTS 577

The first line makes a 100 by 3 matrix x with N(0,1) entries. The second
line makes y[i] = 0+1∗x[i, 1]+2∗x[i, 2]+3∗x[i, 2]+ewhere e is N(0,1). The
term 1:3 creates the vector (1, 2, 3)T and the matrix multiplication operator is
%∗%. The function lsfit will automatically add the constant to the model.
Typing “out” will give you a lot of irrelevant information, but out$coef and
out$resid give the OLS coefficients and residuals respectively.

To make a residual plot, type the following commands.

fit <- y - out$resid

plot(fit,out$resid)

title("residual plot")

The first term in the plot command is always the horizontal axis while the
second is on the vertical axis.

To put a graph in Word, hold down the Ctrl and c buttons simultane-
ously. Then select “paste” from the Word Edit menu.

To enter data, open a data set in Notepad or Word. You need to know
the number of rows and the number of columns. Assume that each case is
entered in a row. For example, assuming that the file cyp.lsp has been saved
on your disk from the webpage for this book, open cyp.lsp in Word. It has
76 rows and 8 columns. In R or Splus, write the following command.

cyp <- matrix(scan(),nrow=76,ncol=8,byrow=T)

Then copy the data lines from Word and paste them in R/Splus. If a curser
does not appear, hit enter. The command dim(cyp) will show if you have
entered the data correctly.

Enter the following commands

cypy <- cyp[,2]

cypx<- cyp[,-c(1,2)]

lsfit(cypx,cypy)$coef

to produce the output below.

Intercept X1 X2 X3 X4

205.40825985 0.94653718 0.17514405 0.23415181 0.75927197

X5 X6

-0.05318671 -0.30944144
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To check that the data is entered correctly, fit LS in Arc with the re-
sponse variable height and the predictors sternal height, finger to ground,
head length, nasal length, bigonal breadth, and cephalic index (entered in
that order). You should get the same coefficients given by R or Splus.

Making functions in R and Splus is easy.

For example, type the following commands.

mysquare <- function(x){

# this function squares x

r <- x^2

r }

The second line in the function shows how to put comments into functions.
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Modifying your function is easy.

Use the fix command.
fix(mysquare)

This will open an editor such as Notepad and allow you to make changes.
In Splus, the command Edit(mysquare) may also be used to modify the

function mysquare.

To save data or a function in R, when you exit, click on Yes when the
“Save worksheet image?” window appears. When you reenter R, type ls().
This will show you what is saved. You should rarely need to save anything
for the material in the first thirteen chapters of this book. In Splus, data
and functions are automatically saved. To remove unwanted items from the
worksheet, eg x, type rm(x),
pairs(x) makes a scatterplot matrix of the columns of x,
hist(y) makes a histogram of y,
boxplot(y) makes a boxplot of y,
stem(y) makes a stem and leaf plot of y,
scan(), source(), and sink() are useful on a Unix workstation.
To type a simple list, use y <− c(1,2,3.5).
The commands mean(y), median(y), var(y) are self explanatory.

The following commands are useful for a scatterplot created by the com-
mand plot(x,y).
lines(x,y), lines(lowess(x,y,f=.2))
identify(x,y)
abline(out$coef), abline(0,1)

The usual arithmetic operators are 2 + 4, 3 − 7, 8 ∗ 4, 8/4, and

2^{10}.

The ith element of vector y is y[i] while the ij element of matrix x is
x[i, j]. The second row of x is x[2, ] while the 4th column of x is x[, 4]. The
transpose of x is t(x).

The command apply(x,1,fn) will compute the row means if fn = mean.
The command apply(x,2,fn) will compute the column variances if fn = var.
The commands cbind and rbind combine column vectors or row vectors with
an existing matrix or vector of the appropriate dimension.
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Downloading the book’s R/Splus data sets robdata.txt into R or
Splus is done in the same way for downloading rpack.txt. Use the command

> source("A:/robdata.txt")

For example the command

> lsfit(belx,bely)

will perform the least squares regression for the Belgian telephone data.

Transferring Data to and from Arc and R or Splus.
For example, suppose that the Belgium telephone data (Rousseeuw and Leroy
1987, p. 26) has the predictor year stored in x and the response number of
calls stored in y in R or Splus. Combine the data into a matrix z and then
use the write.table command to display the data set as shown below. The

sep=’ ’

separates the columns by two spaces.

> z <- cbind(x,y)

> write.table(data.frame(z),sep=’ ’)

row.names z.1 y

1 50 0.44

2 51 0.47

3 52 0.47

4 53 0.59

5 54 0.66

6 55 0.73

7 56 0.81

8 57 0.88

9 58 1.06

10 59 1.2

11 60 1.35

12 61 1.49

13 62 1.61

14 63 2.12

15 64 11.9

16 65 12.4
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17 66 14.2

18 67 15.9

19 68 18.2

20 69 21.2

21 70 4.3

22 71 2.4

23 72 2.7073

24 73 2.9

To enter a data set into Arc, use the following template new.lsp.

dataset=new

begin description

Artificial data.

Contributed by David Olive.

end description

begin variables

col 0 = x1

col 1 = x2

col 2 = x3

col 3 = y

end variables

begin data

Next open new.lsp in Notepad. (Or use the vi editor in Unix. Sophisti-
cated editors like Word will often work, but they sometimes add things like
page breaks that do not allow the statistics software to use the file.) Then
copy the data lines from R/Splus and paste them below new.lsp. Then mod-
ify the file new.lsp and save it on a disk as the file belg.lsp. (Or save it in
mdata where mdata is a data folder added within the Arc data folder.) The
header of the new file belg.lsp is shown below.

dataset=belgium

begin description

Belgium telephone data from

Rousseeuw and Leroy (1987, p. 26)

end description

begin variables
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col 0 = case

col 1 = x = year

col 2 = y = number of calls in tens of millions

end variables

begin data

1 50 0.44

. . .

. . .

. . .

24 73 2.9

The file above also shows the first and last lines of data. The header file
needs a data set name, description, variable list and a begin data command.
Often the description can be copied and pasted from source of the data, eg
from the STATLIB website. Note that the first variable starts with Col 0.

To transfer a data set from Arc to R or Splus, select the item
“Display data” from the dataset’s menu. Select the variables you want to
save, and then push the button for “Save in R/Splus format.” You will be
prompted to give a file name. If you select bodfat, then two files bodfat.txt and
bodfat.Rd will be created. The file bodfat.txt can be read into either R or Splus
using the read.table command. The file bodfat.Rd saves the documentation
about the data set in a standard format for R.

As an example, the following command was used to enter the body fat
data into Splus. (The mdata folder does not come with Arc. The folder
needs to be created and filled with files from the book’s website. Then the
file bodfat.txt can be stored in the mdata folder.)

bodfat <- read.table("C:\\ARC\\DATA\\MDATA\\BODFAT.TXT",header=T)

bodfat[,16] <- bodfat[,16]+1

The last column of the body fat data consists of the case numbers which
start with 0 in Arc. The second line adds one to each case number.

As another example, use the menu commands
“File>Load>Data>Arcg>forbes.lsp” to activate the forbes data set. From
the Forbes menu, select Display Data. A window will appear. Double click
on Temp and Pressure. Click on Save Data in R/Splus Format and save as
forbes.txt in the folder mdata.

Enter Splus and type the following command.
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forbes<-read.table("C:\\ARC\\DATA\\ARCG\\FORBES.TXT",header=T)

The command forbes will display the data set.

Getting information about a library in R
In R, a library is an add–on package of R code. The command library()

lists all available libraries, and information about a specific library, such as
lqs for robust estimators like cov.mcd or ts for time series estimation, can
be found, eg, with the command library(help=lqs).

Downloading a library into R
Many researchers have contributed a library of R code that can be down-

loaded for use. To see what is available, go to the website
(http://cran.us.r-project.org/) and click on the Packages icon. Suppose you
are interested the Weisberg (2002) dimension reduction library dr. Scroll
down the screen and click on dr. Then click on the file corresponding to your
type of computer, eg dr 2.0.0.zip for Windows. My unzipped files are stored
in my directory

C:\unzipped.

The file

C:\unzipped\dr

contains a folder dr which is the R library. Cut this folder and paste it into
the R library folder. (On my computer, I store the folder rw1011 in the file

C:\R-Gui.

The folder

C:\R-Gui\rw1011\library

contains the library packages that came with R.) Open R and type the fol-
lowing command.

library(dr)
Next type help(dr) to make sure that the library is available for use.
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17.2 Hints for Selected Problems

Chapter 1

1.1 βT x = xT β
Chapter 2

2.1 Fo = 0.904, p–value > 0.1, fail to reject Ho, so the reduced model is
good

2.2 a) 25.970

b) Fo = 0.600, p–value > 0.5, fail to reject Ho, so the reduced model is
good

2.3 a) (1.229, 3.345)

b) (1.0825, 3.4919)

2.4 c) Fo = 265.96, pvalue = 0.0, reject Ho, there is a MLR relationship
between the response variable height and the predictors sternal height and
finger to ground.

2.6 No, the relationship should be linear.

2.7 No, since 0 is in the CI. X could be a very useful predictor for Y , eg
if Y = X2.

2.11 a) 7 + βXi

b) b =
∑

(Yi − 7)Xi/
∑
X2

i

2.14 a) b3 =
∑
X3i(Yi−10−2X2i)/

∑
X2

3i. The second partial derivative
=

∑
X2

3i > 0.

2.21 d) The first assumption to check would be the constant variance
assumption.

Chapter 3

3.1 The model uses constant, finger to ground and sternal height. (You
can tell what the variable are by looking at which variables are deleted.)

3.2 Use L3. L1 and L2 have more predictors and higher Cp than L3 while
L4 does not satisfy the Cp ≤ 2k screen.

3.3 a) L2.
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b) Use L3 since L1 has too many predictors while L4 does not satisfy the
Cp ≤ 2k screen.

3.4 Use a constant, A, B and C since this is the only model that satisfies
the Cp ≤ 2k screen.

b) Use the model with a constant and B since it has the smallest Cp and
the smallest k such that the Cp ≤ 2k screen is satisfied.

3.7 a) The plot looks roughly like the SW corner of a square.

b) No, the plot is nonlinear.

c) Want to spread small values of y, so make λ smaller. Hence use y(0) =
log(y).

3.8 Several of the marginal relationships are nonlinear, includingE(M |H).

3.9 This problem has the student reproduce Example 5.1. Hence log(Y )
is the appropriate response transformation.

3.10 Plots b), c) and e) suggest that log(ht) is needed while plots d), f)
and g) suggest that log(ht) is not needed. Plots c) and d) show that the
residuals from both models are quite small compared to the fitted values.
Plot d) suggests that the two models produce approximately the same fitted
values. Hence if the goal is prediction, the expensive log(ht) measurement
does not seem to be needed.

3.11 h) The submodel is ok, but the response and residual plots found in
f) for the submodel do not look as good as those for the full model found in
d). Since the submodel residuals do not look good, more terms are probably
needed in the model.

3.12 b) Forward selection gives constant, (size)1/3, age, sex, breadth and
cause.

c) Backward elimination gives constant, age, cause, cephalic, headht,
length and sex.

d) Forward selection is better because it has fewer terms and a smaller
Cp.

e) The variables are highly correlated. Hence backward elimination quickly
eliminates the single best predictor (size)1/3 and can not get a good model
that only has a few terms.
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f) Although the model in c) could be used, a better model uses constant,
age, sex and (size)1/3.

j) The FF and RR plots are good and so are the response and residual
plots if you ignore the good leverage points corresponding to the 5 babies.

8.3. See Example 8.6.
9.3. See Example 9.2.
10.2 a) ESP = 1.11108, exp(ESP ) = 3.0376 and ρ̂ = exp(ESP )/(1 +

exp(ESP )) = 3.0376/(1 + 3.0376) = 0.7523.

10.3 G2(O|F ) = 62.7188 − 13.5325 = 49.1863, df = 3, p–value = 0.00,
reject Ho, there is a LR relationship between ape and the predictors lower
jaw, upper jaw and face length.

10.4 G2(R|F ) = 17.1855−13.5325 = 3.653, df = 1, 0.05 < p–value < 0.1,
fail to reject Ho, the reduced model is good.

10.5 a) B4

b) EE plot
c) B3 is best. B1 has too many predictors with large Wald p–values, B2

still has too many predictors (want ≤ 300/10 = 30 predictors) while B4 has
too small of a p–value for the change in deviance test.

10.10 b) Use the log rule: (max age)/(min age) = 1400 > 10.

e) The slice means track the logistic curve very well if 8 slices are used.

i) The EE plot is linear.

j) The slice means track the logistic curve very well if 8 slices are used.

n) The slice form −0.5 to 0.5 is bad since the symbol density is not
approximately constant from the top to the bottom of the slice.

10.11 c) Should have 200 cases, df = 178 and deviance = 112.168.

d) The ESS plot with 12 slices suggests that the full model is good.

h) The submodel I1 that uses a constant, AGE, CAN, SYS, TYP and
FLOC and the submodel I2 that is the same as I1 but also uses FRACE
seem to be competitors. If the factor FRACE is not used, then the EY plot
follows 3 lines, one for each race. The Wald p–values suggest that FRACE
is not needed, but the EE plot suggests that FRACE is needed. I think that
the EE plot is generally more trustworthy, so use model I2.
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10.12 b) The ESS plot (eg with 4 slices) is bad, so the LR model is bad.

d) Now the ESS plot (eg with 12 slices) is good in that slice smooth and
the logistic curve are close where there is data (also the LR model is good at
classifying 0’s and 1’s).

f) The MLE does not exist since there is perfect classification (and the
logistic curve can get close to but never equal a discontinuous step function).
Hence Wald p–values tend to have little meaning; however, the change in
deviance test tends to correctly suggest that there is an LR relationship
when there is perfect classification.

For this problem, G2(O|F ) = 62.7188 − 0.00419862 = 62.7146, df = 1,
p–value = 0.00, so reject Ho and conclude that there is an LR relationship
between ape and the predictor x3.

10.14 The ESS plot should look ok, but the function uses a default num-
ber of slices rather than allowing the user to select the number of slices using
a “slider bar” (a useful feature of Arc).

10.15 a)

Number in Model Rsquare C(p) Variables in model

6 0.2316 7.0947 X3 X4 X6 X7 X9 X10

c) The slice means follow the logistic curve fairly well with 8 slices.

e) The EE plot is linear.

f) The slice means follow the logistic curve fairly well with 8 slices.

11.1a ESP = 0.2812465 and µ̂ = exp(ESP ) = 1.3248.

11.2 G2(O|F ) = 187.490 − 138.685 = 48.805, df = 2, p–value = 0.00,
reject Ho, there is a LLR relationship between possums and the predictors
habitat and stags.

11.5 a) A good submodel uses a constant, Bar, Habitat and Stags as
predictors.

d) The EY and EE plots are good as are the Wald p–values. Also
AIC(full) = 141.506 while AIC(sub) = 139.644.

11.6 k) The deleted point is certainly influential. Without this case,
there does not seem to be a LLR relationship between the predictors and the
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response.

m) The weighted residual plot suggests that something is wrong with the
model since the plotted points scatter about a line with positive slope rather
than a line with 0 slope. The deviance residual plot does not suggest that
anything is wrong with the model.

11.7 a) Since this is simulated LLR data, the EY plot should look ok, but
the function uses a default lowess smoothing parameter rather than allowing
the user to select smoothing parameter using a “slider bar” (a useful feature
of Arc).

b) The data should the identity line in the weighted forward response
plots. In about 1 in 20 plots there will be a very large count that looks
like an outlier. The weighted residual plot based on the MLE usually looks
better than the plot based on the minimum chi-square estimator (the MLE
plot tend to have less of a “left opening megaphone shape”).

Chapter 14

14.1 a) X2 ∼ N(100, 6).

b) (
X1

X3

)
∼ N2

( (
49
17

)
,

(
3 −1
−1 4

) )
.

c) X1 X4 and X3 X4.

d)

ρ(X1, X2) =
Cov(X1, X3)√

VAR(X1)VAR(X3)
=

−1√
3
√

4
= −0.2887.

14.2 a) Y |X ∼ N(49, 16) since Y X. (Or use E(Y |X) = µY +
Σ12Σ

−1
22 (X − µx) = 49 + 0(1/25)(X − 100) = 49 and VAR(Y |X) = Σ11 −

Σ12Σ
−1
22 Σ21 = 16 − 0(1/25)0 = 16.)

b) E(Y |X) = µY +Σ12Σ
−1
22 (X−µx) = 49+10(1/25)(X−100) = 9+0.4X.

c) VAR(Y |X) = Σ11 − Σ12Σ
−1
22 Σ21 = 16 − 10(1/25)10 = 16 − 4 = 12.

14.4 The proof is identical to that given in Example 10.2. (In addition,
it is fairly simple to show that M1 = M2 ≡ M . That is, M depends on Σ
but not on c or g.)
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14.6 a) Sort each column, then find the median of each column. Then
MED(W ) = (1430, 180, 120)T .

b) The sample mean of (X1, X2, X3)
T is found by finding the sample mean

of each column. Hence x = (1232.8571, 168.00, 112.00)T .

14.11 ΣB = E[E(X|BT X)XTB)] = E(MBBT XXT B) = MBBT ΣB.
Hence MB = ΣB(BTΣB)−1.

14.13 The 4 plots should look nearly identical with the five cases 61–65
appearing as outliers.

Chapter 15

15.1
a) êi = Yi − T (Y ).
b) êi = Yi − xT

i β̂.
c)

êi =
Yi

β̂1 exp[β̂2(xi − x̄)]
.

d) êi =
√
wi(Yi − xT

i β̂).

15.2
a) Since Y is a (random) scalar and E(w) = 0, Σx,Y = E[(x−E(x))(Y −

E(Y ))T ] = E[w(Y −E(Y ))] = E(wY ) −E(w)E(Y ) = E(wY ).

b) Using the definition of z and r, note that Y = m(z) + e and
w = r + (Σxβ)βT w. Hence E(wY ) = E[(r + (Σxβ)βTw)(m(z) + e)] =
E[(r +(Σxβ)βT w)m(z)] +E[r+(Σxβ)βTw]E(e) since e is independent of
x. Since E(e) = 0, the latter term drops out. Since m(z) and βTwm(z) are
(random) scalars, E(wY ) = E[m(z)r] + E[βT w m(z)]Σxβ.

c) Using result b), Σ−1
x Σx,Y = Σ−1

x E[m(z)r] + Σ−1
x E[βTw m(z)]Σxβ =

E[βT w m(z)]Σ−1
x Σxβ+Σ−1

x E[m(z)r] = E[βT w m(z)]β+Σ−1
x E[m(z)r] and

the result follows.

d) E(wz) = E[(x−E(x))xT β] = E[(x−E(x))(xT −E(xT )+E(xT ))β]
= E[(x− E(x))(xT − E(xT ))]β + E[x − E(x)]E(xT )β = Σxβ.

e) If m(z) = z, then c(x) = E(βT wz) = βTE(wz) = βTΣxβ = 1 by
result d).



CHAPTER 17. STUFF FOR STUDENTS 590

f) Since z is a (random) scalar, E(zr) = E(rz) = E[(w − (Σxβ)βT w)z]
= E(wz)−(Σxβ)βTE(wz). Using result d), E(rz) = Σxβ−ΣxββTΣxβ =
Σxβ −Σxβ = 0.

g) Since z and r are linear combinations of x, the joint distribution of
z and r is multivariate normal. Since E(r) = 0, z and r are uncorrelated
and thus independent. Hence m(z) and r are independent and u(x) =
Σ−1

x E[m(z)r] = Σ−1
x E[m(z)]E(r) = 0.

15.4 The submodel I that uses a constant and A, C, E, F, H looks best
since it is the minimum Cp(I) model and I has the smallest value of k such
that Cp(I) ≤ 2k.

15.6 a) No strong nonlinearities for MVN data but there should be some
nonlinearities present for the non–EC data.

b) The plot should look like a cubic function.

c) The plot should use 0% trimming and resemble the plot in b), but may
not be as smooth.

d) The plot should be linear and for many students some of the trimmed
views should be better than the OLS view.

e) The EY plot should look like a cubic with trimming greater than 0%.

f) The plot should be linear.

15.7 b) and c) It is possible that none of the trimmed views look much
like the sinc(ESP) = sin(ESP)/ESP function.

d) Now at least one of the trimmed views should be good.

e) More lms trimmed views should be good than the views from the other
2 methods, but since simulated data is used, one of the plots from b) or c)
could be as good or even better than the plot in d).
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17.3 Tables

Tabled values are F(k,d, 0.95) where P (F < F (k, d, 0.95) = 0.95.
00 stands for ∞. Entries produced with the qf(.95,k,d) command in R.
The numerator degrees of freedom are k while the denominator degrees of
freedom are d.

k 1 2 3 4 5 6 7 8 9 00

d

1 161 200 216 225 230 234 237 239 241 254

2 18.5 19.0 19.2 19.3 19.3 19.3 19.4 19.4 19.4 19.5

3 10.1 9.55 9.28 9.12 9.01 8.94 8.89 8.85 8.81 8.53

4 7.71 6.94 6.59 6.39 6.26 6.16 6.09 6.04 6.00 5.63

5 6.61 5.79 5.41 5.19 5.05 4.95 4.88 4.82 4.77 4.37

6 5.99 5.14 4.76 4.53 4.39 4.28 4.21 4.15 4.10 3.67

7 5.59 4.74 4.35 4.12 3.97 3.87 3.79 3.73 3.68 3.23

8 5.32 4.46 4.07 3.84 3.69 3.58 3.50 3.44 3.39 2.93

9 5.12 4.26 3.86 3.63 3.48 3.37 3.29 3.23 3.18 2.71

10 4.96 4.10 3.71 3.48 3.33 3.22 3.14 3.07 3.02 2.54

11 4.84 3.98 3.59 3.36 3.20 3.09 3.01 2.95 2.90 2.41

12 4.75 3.89 3.49 3.26 3.11 3.00 2.91 2.85 2.80 2.30

13 4.67 3.81 3.41 3.18 3.03 2.92 2.83 2.77 2.71 2.21

14 4.60 3.74 3.34 3.11 2.96 2.85 2.76 2.70 2.65 2.13

15 4.54 3.68 3.29 3.06 2.90 2.79 2.71 2.64 2.59 2.07

16 4.49 3.63 3.24 3.01 2.85 2.74 2.66 2.59 2.54 2.01

17 4.45 3.59 3.20 2.96 2.81 2.70 2.61 2.55 2.49 1.96

18 4.41 3.55 3.16 2.93 2.77 2.66 2.58 2.51 2.46 1.92

19 4.38 3.52 3.13 2.90 2.74 2.63 2.54 2.48 2.42 1.88

20 4.35 3.49 3.10 2.87 2.71 2.60 2.51 2.45 2.39 1.84

25 4.24 3.39 2.99 2.76 2.60 2.49 2.40 2.34 2.28 1.71

30 4.17 3.32 2.92 2.69 2.53 2.42 2.33 2.27 2.21 1.62

00 3.84 3.00 2.61 2.37 2.21 2.10 2.01 1.94 1.88 1.00
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Tabled values are td,δ where P (t < td,δ) = δ where t has a t distribution
with d degrees of freedom. If d > 30 use the N(0, 1) cutoffs given in the
second to last line with d = Z = ∞.

delta 0.95 0.975 0.995

d

1 6.314 12.706 63.657

2 2.920 4.303 9.925

3 2.353 3.182 5.841

4 2.132 2.776 4.604

5 2.015 2.571 4.032

6 1.943 2.447 3.707

7 1.895 2.365 3.499

8 1.860 2.306 3.355

9 1.833 2.262 3.250

10 1.812 2.228 3.169

11 1.796 2.201 3.106

12 1.782 2.179 3.055

13 1.771 2.160 3.012

14 1.761 2.145 2.977

15 1.753 2.131 2.947

16 1.746 2.120 2.921

17 1.740 2.110 2.898

18 1.734 2.101 2.878

19 1.729 2.093 2.861

20 1.725 2.086 2.845

21 1.721 2.080 2.831

22 1.717 2.074 2.819

23 1.714 2.069 2.807

24 1.711 2.064 2.797

25 1.708 2.060 2.787

26 1.706 2.056 2.779

27 1.703 2.052 2.771

28 1.701 2.048 2.763

29 1.699 2.045 2.756

30 1.697 2.042 2.750

Z 1.645 1.960 2.576

CI 90% 95% 99%
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